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Log In to TWS
Before you can log into TWS, you must download and install the TWS software. Downloads are accessed
using the Login button in the top right corner of the web site.
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Download Software
From the TWS Software page, choose from any of the software versions in the top row. Simply click a
version to go to the Download page. Follow the simple instructions to install.
Once you install any version, you will have access to all of the other TWS versions when you log in. See
instructions below to switch between versions.
To log in to TWS
Double-click the Trader Workstation icon that was placed on your desktop during installation.
Choose between Live and Paper trading by clicking the desired button. If you choose Live Trading the login
box is dark blue. If you choose Paper Trading the login box is dark red.
Enter your User name and Password and click Log In.
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Change Versions and Other Options
You can switch between stable, Latest and Beta TWS versions of the application without having to
download additional software. Use More Options to also change the color theme, select a new application
language, specify settings directory, host and port if needed, and more.
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Feature

Description

Version

Choose from Stable,
Latest, or Beta TWS
versions. Click Apply &
Restart after selecting a
new version.

Color Theme

Choose from Classic,
Dark, or Light colored
theme. You can also
change the theme when
logged in, from Global
Configuration.

Select Language

Choose a language for the
application.

Region

Select a region if needed.

Time Zone

Select a time zone if
needed.

Settings directory

Change the settings
directory if needed.

Host

Set the host if needed.

Port

Define a specific port if
needed.

Browser Path

Specify a browser path if
needed.

Use/store settings

If checked, upon login

on server

your settings from your
previous session will be
restored, and upon log out
your settings from this
session will be saved.
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Checking this allows you to
log in from any internetenabled machine and
always have the same
settings.
Attempt to

If checked, upon login the

migrate settings

system will attempt to
migrate settings saved
under a different user
name.

No Internet

Check if you are not

connectivity

connected to the Internet
or if you're behind a
firewall and don't know the
proxy server settings. This
could result in better
performance as the
system will not continually
attempt to connect to the
Internet.

Connect through

Check to select a

private WAN

designate server to
connect through a private
WAN connection.

Offline TWS
To use a version that does not update automatically but requires manual updating for new features,
download the Offline TWS installer from the TWS Software page.
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The Mosaic Interface
The Mosaic workspace provides comprehensive order entry and order management functionality that
includes charts, watchlists, quote details, market scanners, and your portfolio. It's completely customizable,
with a drag and snap functionality that lets you easily align new windows to the default workspace.
Find out more:
1. New Window drop-down menu
2. IBot
3. IB FYIs
4. Change font
5. Lock, unlock and edit layouts
6. Search
7. Windows linking
8. Order Entry
9. The Portfolio window
10. Watchlists
11. Quote Details
12. Charts
13. News
14. Orders and Trades
15. Layout Library
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IBot: The Natural Way to Trade
IBot's text-based interface helps you to complete key trading tasks without having to navigate anywhere
else. IBot's text entry field accepts commands you enter in plain English, and responds by presenting you
with the data or information you requested. Get quote details, create and submit orders (including complex
algos!), look at account values, find website information, complete Account Management-based tasks,
open a chart and much, much more, all from the convenience of IBot's intuitive interface.
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To use IBot
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From the Mosaic menu, click IBOT.
Enter a command in the text box at the bottom of the IBot interface using everyday language.
Interact as needed with IBot's response, for example if you check the latest price of aapl, you may decide to
buy it.
To find out more about IBot, visit the IBot Feature in Focus page.

Custom Layouts
Use the Layout Library to quickly create a custom workspace layout. Simply peruse the Layout Library and
select a layout, for example "Option Trading" or "Futures Spreads." Add it to your platform with a single
click, and easily toggle between layouts by clicking the tab along the bottom of the TWS frame.

To use the Layout Library
Click the Add Tab "+" icon at the end of the tabset along the bottom of the frame.
Select "Layout Library."
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Browse layouts and click Details to find out more about any layout.
Click Add Layout to create the layout. It will appear as a new, named tab along the bottom of TWS.

Use the layout as-is, or unlock and edit it to make it your own. You can add, remove and re-size tools, and
use windows linking to link tools within the layout. Modify background and font colors, included fields and
the order of fields on most windows.
Add as many layouts as you need. Alternatively, create a layout from scratch by selecting "Create a New
Custom Layout" instead of "Open the Layout Library."
To find out more see the TWS Layout Library feature page.

The Anchor Window
The Anchor Window is the control center of the workspace.
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Use the New Window drop down list to open more tools.
Access IBot, our automated response interface, to quickly complete a trading action, find information,
and more.
See recent orders and trades, and click the badge to go directly to the Orders and Trades Monitor.
Click the FYI button to see new notifications and to configure FYIs. The red badge tells you how many
new notifications are waiting.
Quickly adjust the font size across the entire interface.
Unlock the workspace to make changes like adding, removing and rearranging windows.
Use the Integrated Search Tool to find tickers from the contract database and to find tools within the
application.

The Mosaic workspace is a grouped selection of tiles and tools that, by default, function as a unit within the
layout.
Windows within the workspace cannot be inadvertently closed or repositioned. You must unlock the
workspace to make changes.
When the workspace is re-sized all included windows will re-size and scale appropriately within the layout.
Use the font size adjustor to make the font larger or smaller within the entire workspace.
Maximize windows inside the workspace by double-clicking the titlebar, with no need to unlock the interface first. For example, you may want a better look at your chart. Double-click to see a large version,
then double-click again to put the chart back into its spot.
The Mosaic has two editing modes: Locked and Unlocked.
By default, the Mosaic workspace is in "locked" mode when you launch the tool. When the workspace is
locked, it acts as a single, grouped unit. You cannot add, remove, re-size or move any component
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windows, but you can re-size the entire workspace, and each component within will be scaled accordingly.
Note that you can, however, modify windows grouping assignments. We lock the workspace by default to
avoid potential issues of inadvertently deleting and moving individual components.
If you want to rearrange the windows, add or remove windows, or re-size individual component windows,
click the Lock icon to unlock the workspace.

Layout Locked
When the Mosaic layout is locked, the workspace is outlined in black and the lock label indicates the status.
Keep the layout locked until you need to add, remove or resize individual windows.
To unlock the layout for editing
Click the "lock" icon located to the left of the search field.

Layout Unlocked
When the Mosaic layout is unlocked, the workspace is outlined in green and the lock icon appears to be
open to indicate the status. When unlocked, windows within the workspace frame act as separate,
ungrouped windows, and you are able to remove them, re-size them, and add new windows to the layout
frame.
Be sure to always lock the workspace when you have finished editing to avoid unwanted changes or
deletions to the Mosaic. You will not be allowed to exit the application if the workspace is unlocked.
To lock the layout
Click the "lock" icon

Mosaic Fonts
Quickly make the Mosaic windows font larger or smaller.
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To adjust font size throughout Mosaic
From Mosaic menu, click the Font Size Adjustment icon.
Click "Smaller" or "Larger" to change the font size. Notice that the font size changes in Mosaic as you click.
Check "Adjust window & column widths" to keep the font-to-window size ratio the same. If unchecked, all
windows will remain the same size and only the font size will change.

Create TWS Color Grouping
Assign tools and tiles to a "color group" to link instrument selection actions. You assign a window to a group
using the colored links on the top right of a window's title bar. All windows with the same color link are part
of the same group. When you change focus on one of the group's "Source" windows, all destination
windows in the group reflect the change.
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A window can be part of only one group at a time, but if you open multiple windows you can link each to a
different color group. For example, you could open three different Option Chain windows and assign a
different group to each, and then link these windows to three separate quote pages.
The window's designation is displayed in a mouse-over tooltip when you hover over the Group icon. A
window can be a:
Source - this is a controlling window and can only SEND instructions.
Destination - this is a receiving window, and can only RECEIVE instructions from a window with Source
privileges.
Source/Destination - this is a multi-tasking window which can both SEND instructions to and RECEIVE
instructions from other windows in the group.
Create a linked color group
1. Click the "chain link" icon in the top right of a window's title bar and select a colored number from the
dropdown list.
2. For windows that you want to include in this group, select the same group number/color from the
Group list.
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Add and Remove Fields
You can quickly add and remove fields from most windows by holding your mouse over the field name to
invoke the insert/remove column commands.

To add or remove columns from a window
1. Hold your mouse over a field to invoke the quick insert/remove commands.
2. Click the “+” icon to insert a column to the left of the selected column. Pick from the drop-down picklist that appears when you click "Insert Column."
3. Click the “x” icon to remove the selected column from the window. You can re-add it at any time.
You can choose not to see these icons by deselecting the feature "Quickly insert/remove columns from
column headers" from the Display>Settings page in Global Configuration.

Use the Integrated Search Tool
The Integrated Search Tool in the top right corner of the anchor window lets you search for tools and
features in the application as well as for contracts in our database to add to your trading pages. Check
"Application" and select from the list of findings to go directly to your destination. Check "Contracts" and
select to add an instrument directly to your trading page.
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Search for a feature or instrument
1. Enter the name of the feature, instrument or type of instrument you are looking for.
2. Check Application, Contract or both.
3. Click the return that matches your search criteria.
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When you use the The search will open and focus in on the feature, or begin adding the instrument to the
trading page.

Use Snapshot Market Data
Benefit from lower market data costs by paying only for the quotes you need with Snapshot Market Data
requests. These single-use requests provide a real-time quote for a specific product, offering a more costeffective way for clients to understand where the market is at the time of trade without paying for monthly
streaming data subscriptions.
Single-use Snapshot Quotes are automatically enabled; there is no need for any special subscription or
sign-up. If you don't subscribe to market data, you'll see the Snapshot button in the Order Entry panel
(Mosaic) or the Ticker Action column (Classic) when available for the selected asset.

To use Snapshot data
Click the Snapshot button to get a live quote that remains visible until you close the window or move to
another product.
Refreshing a quote constitutes another single snapshot request for data.
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Tracking and Cost

Snapshot requests are calculated monthly. and the counter is reset each new calendar month. US equities
are USD 0.01 (or the equivalent) per quote; all other quotes are USD 0.03 (or the equivalent). All clients
receive a USD 3.00 waiver for the first two months, and a USD 1.00 waiver for all subsequent months. If
you decide to subscribe to streaming market data at any point, you will only be charged for that month's
streaming data subscription and not for any prior snapshot requests.
To learn more see the IB Knowledge Base article and the Account Management Users' Guide.

The Order Entry Panel
Use the Order Entry panel to create and then Submit or Save an order. It's linked via windows color
grouping to other windows, which means that when you choose an instrument from another window in the
group, the Order Entry panel is "loaded" with that instrument and ready to submit an order. It's easy to
change the asset by selecting from the drop down list of previously used instruments, or typing in a new
one manually. To set up an option order, click the Option Chain button to easily pick an option contract.
Use the Advanced panel to include additional order attributes and to create OCO, profit-taking or hedging
orders.
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The Order Entry tile supports different modes, and you can modify the mode to fit your trading style. The
above image shows the panel in Interactive mode.
To change the Order Entry mode
Click the configuration gear icon in the top right corner of the panel's title bar and select Settings.
Select the Order Entry tool style. Choose from:
Interactive: Enables the click-able "Position" and "Bid/Mid/Ask" ruler to fill in order parameters.
Simplified: Smaller display with fewer selections.
Rapid Transmit: Quickly submit the order by clicking the Sell or Buy button. This version does not
include a "Submit" button.

Monitor Orders & Trades
The Mosaic Orders and Trades panels in the ACTIVITY panel provide a running list of all live, canceled and
completed orders and trades.

Click the display drop-down (ALL in the above image) to specify which order types to display in the Orders
window. Choose from:
ALL ORDERS
LIVE ORDERS
CANCELED ORDERS
COMPLETED ORDERS
View filled orders in the Trades tab. Drill down per trade to view detailed price and quantity information.
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The Portfolio
The Mosaic Portfolio window, which is included in the grouping of Monitor Panel tabs along with the Mosaic
Market Scanners and the Watchlists, provides key account information.
The Portfolio window is a "source" for windows grouping, which means that when you select an asset all
linked windows will display that asset.

To open the Portfolio for the first time
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From the Monitor panel, click "+" sign to add a new page.
From the drop down list, select Portfolio.
Once you add the Portfolio to your Monitor list, it will be available as a tab. If you can't see it displayed along
the top of the Monitor panel, scroll through tabs using the left and right arrow icons to view all available
tabs.

Use Continuous Sort in Your Portfolio
You can elect to sort your Portfolio by continuous or one-time sort by right-clicking a column in your
portfolio and making a selection.

Continuous Sort automatically keeps the sort up-to-date when changes occur in your portfolio.
Portfolio columns that support Continuous Sort are:
Market Value
% of Market Value
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Daily PnL
Unrealized PnL
Realized PnL
Avg Price
Position
Notes:
If you click the column header while in Continuous Sort, it changes to a one-time sort.
"Absolute" sort does not take into account the sign.
An ascending absolute sort for -1, -3, -5, 2, 6, 9 would be: -1, 2, -3, -5, 6, 9.
A regular ascending sort for that set of numbers would be: -5, -3, -1, 2, 6, 9

Mosaic Market Scanners
Create, customize, edit and view Mosaic Market Scanners from within the Mosaic layout. You can create a
new custom scanner, or choose a Predefined Mosaic Market Scanner.
To create a Mosaic Market Scanner
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From within Mosaic, click the "add new window" icon in the Monitor window and select Mosaic Market
Scanner.
Select Create new custom scan... and enter a title for the scan.
Define the scan "Universe" including the product(s), region(s), exchange(s), instrument type(s), indicies,
and optional industry filters. You can see the market scanner results in the scanner pane as you define the
universe.
Use the Fields section to add, remove, and manage each displayed value. Use Dual Sort on one field to
show the scanner sorted in both directions on the selected field. To change the order in which fields are
displayed in the scan, drag and drop fields into the desired order.
Each field provides a "Display" and "Sort" selection. Use these selectors to customize and organize scan
data.

"Display" Field Information
The Display selections let you specify how and if you want the values in the field displayed. Use the "Bar"
and "Gradient" graphical indicators to provide at-a-glance information on the on the tickers in your market
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scan. Choose from the following:
Values - This selection will show the expected numerical value appropriate for the field. This is the
default display.
Gradient - The Gradient uses a filled, colored circle with different shades to provide information on the
field value. Red shades identify a downward move and green shows upward movement. Hold your
mouse over a gradient to see the color-shading key.
Bar - The Bar chart displays the field value graphically using a colored bar to indicate the direction and
degree of change. Red indicates negative and green indicates positive. The length of the bar indicates
the degree of change (the value). Bars that have values outside the hand-picked range will display a
very bright section at the end of the bar to signify values outside the range.
Line The Line chart displays the field value graphically using a colored line. You can elect to view up to
three fields that use the Line chart view. Mouse over the "Lines ?" display in the scanner to see the key
to the Line colors.
Values + Gradient - Displays two fields for a single value; one with the numerical value and one with
the gradient.
Values + Bar - Displays two fields for a single value; one with the numerical value and one with the bar
chart.
Values + Line - Displays two fields for a single value; one with the numerical value and one with the
line chart.
None - The value for the field will not display. You can use the combination of a "none" value with a sort
specification for a field to have the scanner search on and sort by a field without showing the field value,
for example, Market Cap. If you set the sort to descending, the scan will return tickers with the highest
market cap but will not show you the actual market cap.

"Sort" Field Information
The Sort field allows you to specify sort criteria AND determine the field on which the scan will be based.
You can only select sort criteria for ONE field. Sort selections include:
Unsorted - This means that the field values are not ordered and that this field does not drive the scan.
Low to High - This means that the fields values are sorted ascending from lowest to highest, and that
the scanner is driven by this field.
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High to Low - This means that the fields values are sorted descending from highest to lowest, and that
the scanner is driven by this field.
Dual Sort - This selection splits the scanner into two columns, with one column showing values sorted
from Low to High, and the other showing values sorted
Click Done to complete the scan. Click Edit Scanner at the top right of the scan window to modify any
Mosaic Market Scanner at any time.
To open or edit an existing scanner
1. Hold your mouse over the tab set to show all available tabs.
2. Click a scanner tab on the Monitor window.

You can export the scan results to an Excel spreadsheet to allow you to use and manipulate the data.
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To export scanner results

Complete defining the scanner criteria (or "Edit" the scanner).
At the bottom of the scanner edit window, click Export Results.
Enter a name for the file, and modify the Save in location if desired. Click Save.
The scan data is now saved in a .csv file. \

Mosaic Charts
Charts are part of the default Mosaic layout. Double-click the title bar (or click the Maximize icon) to enlarge
the chart size, and click again to reduce. Find out more about customizing charts, setting parameters,
applying indicators and more.
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Mosaic chart tips:
Click the current time period to view the drop-down list and change the display type, time period and
more.
To add studies and change parameters, use the Edit menu and select Studies or Chart Parameters.
To view the chart in full size, double-click the title bar (or use the Maximize icon). Double-click again to
restore original size.
Instantly add a volume chart to the bottom by clicking the Volume icon on the bottom left.
Use the slider along the bottom of the chart to expand and reduce the time period.
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Watchlists
Watchlists help you track performance at a glance, and are synched automatically across all of your trading
platforms. Colored tick dots indicate up/down values. Use the right-click menu from any symbol to access
trading and analytical tools, and to edit the Watchlist.

To add instruments to a Watchlist
Entering a symbol in a blank row, then select the asset type.
To create a new Watchlist
Click "+" in the top right corner and select Watchlist.
At the bottom of the Browse Lists page, select New Watchlist.
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Watchlists created in Client Portal, IBKR Mobile and TWS are all saved to the Cloud and available for
display across all platforms. Once you include an available Watchlist in your platform, its contents are
synced automatically across all platforms.
To add a "synced" Watchlist created in another trading platform
Click "+" in the top right corner and select Watchlist.
Select a Watchlist from the Available section.
Review the Watchlist contents, then click Add to add it to your Watchlist window.
To open a Watchlist in Classic
From the Trading Tools menu select Watchlist to open a standalone Monitor window with one tab.
To change the tab name, right-click the Watchlist tab and select Rename Watchlist. By default Watchlists
are named Watchlist1, Watchlist2 etc.
Follow instructions above the add instruments and add more Watchlist tabs.
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Mosaic Tools and Tiles
The default Mosaic includes a subset of tools and tiles, but you can add and rearrange the existing tiles,
and open tools as standalone windows.
Trade in Mosaic

88

Option Chains

89

Strategy Builder

90

Advanced Orders Panel

94

Pause Execution

118

Roll Multi-Leg Strategies

119

Quotes and Data in Mosaic

121

Predefined Watchlists

121

Market Depth

122

Time & Sales Data

123

Price History Window

127

Option Selector

128

The Quote Details Window

129

FX Matrix

131

SLB (Stock Loan Borrow) Rates

133

Technical Analytics

134

Portfolio Builder

135

Portfolio Performance Profile

138

Predefined Mosaic Market Scanners

139
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Mosaic Market Statistics

143

Advanced Market Scanner

145

Complex Orders and Trades Scanner

146

Mutual Fund/ETF Replicator

147

Options Analysis

149

Implied Volatility Tab

150

Historical Volatility Tab

152

Industry Comparison

153

Portfolio Analyst

179

Wall Street Horizon Data

179

The Toolbox

181

Information System

182

Trader's Journal

183

Event Calendars

184

Daily Lineup

186

Mosaic News Panel

187

Fundamentals

197

Analyst Research

210

Trade in Mosaic
The Mosaic trading tools make it easy to create, submit and modify orders.
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Option Chains
The versatile Option Chains window lets you easily view and create options orders that you submit via the
Order Entry panel, and compare and create two-legged option spreads and multi-leg complex strategies
using the embedded Strategy Builder with a single click.
To create an options order
Open an Option Chain:
From the Mosaic New Window drop-down, select Option Chain from the Quote section, or
Select an instrument, and use the right-click menu to choose Trading Tools > Option Chain
Use settings along the top of the chain to view a different expiration date, include or exclude
weeklies/quarterlies, change the view (between Tabbed and List), change number of strikes, exchange
and trading class (as needed).
Click the Bid price (to create a Sell order) or the Ask price (to create a buy order) from the Calls or Puts side
of the Option Chain. The Mosaic Order Entry panel is populated with the selected options contract.
In the Order Entry panel, modify the option price, quantity and order type as needed and click Submit to
transmit the order.
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Create complex multi-leg strategies using the Strategy Builder.

Strategy Builder
Use the Strategy Builder section of the Option Chains to quickly build complex, multi-leg strategies directly
from the option chain display.
Use the traditional "Calls and Puts" layout to manually add legs to the Strategy Builder by clicking the
desired bid or ask price in the option chain.
Pick a named strategy from the Strategy Builder pick list to automatically create a strategy when you
pick the first leg.
Select a Spread Template to populate a simple grid interface. Easily compare similar spreads and then
click a tile to load the Strategy Builder with the desired spread.
Regardless of the method you use to create a strategy, you can modify legs, parameters or complete
strategies easily from within the Strategy Builder, and then trade the strategy, and/or add it to a Watchlist.
To open Strategy Builder
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From within Mosaic, select an instrument and use the New Window drop-down to select Strategy
Builder. The Option Chain opens for the instrument with Strategy Builder turned on.
Or, from within the Option Chain window, toggle on Strategy Builder below the chains to the right.

To use Spread Templates
From the Option Chain "blade" (to the right of the symbol), click Calls and Puts, then select a Spread
Template (Horizontal, Vertical or Diagonal).
Within the grid interface, use scroll bars to compare spreads. Tiles cleanly display the expiration and strike,
bid and ask, delta, and gamma so you can compare spreads on price, spread width, and risk/return at a
glance.
Click a tile to load the selected spread into the Strategy Builder.
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To modify a leg within the Strategy Builder, use the drop-down list from any parameter to select a new
one.
Remove a leg from the spread by clicking the red "x" to the left of any leg.
Click “Profile” to see the Performance Profile sidecar for the strategy.
Save the spread to a Watchlist to trade it later by clicking "Add to Watchlists."
Click "Clear All Legs" to start over.

To manually create a strategy leg-by-leg
1. Toggle the Strategy Builder on if it's not already enabled.
2. Add legs to the Strategy Builder from the CALLS (to the left of the strike) or PUTS (to the right of the
strike). Click a bid price to create a SELL leg or an ask price to create a BUY leg.
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To modify a leg in the strategy from the option chain, click, hold and drag the leg in the option chain to a
new strike or side.
To modify a leg within the Strategy Builder, use the drop-down list from any parameter to select a new
one.
To modify the entire strategy, hold down the Shift key, then click and drag one of the legs to a new
strike or side. The remaining leg(s) will adjust automatically.
Remove a leg from the strategy by clicking the red "x" to the left of any leg.
Click “Profile” to see the Performance Profile sidecar for the strategy.
Save the spread to a Watchlist to trade it later by clicking "Add to Watchlists."
Click "Clear All Legs" to start over.

To create a named strategy
Use the "Strategies" pick list on the right side of the Strategy Builder to select a named complex strategy.
Hold your mouse cursor over the first leg. All potential legs of the strategy are highlighted.
Use the mouse scroll button to modify the spread between potential legs.
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Click a bid price to make the first leg a SELL leg, or an ask price to make the first leg a BUY leg. The rest of
the strategy automatically populates the Strategy Builder.
To modify a leg in the strategy from the option chain, click, hold and drag the leg in the option chain to a
new strike or change from long to short by dragging the leg to the CALLS or PUTS side.
To modify a leg within the Strategy Builder, use the drop-down list from any parameter to select a new
one.
To modify the entire strategy, hold down the Shift key, then click and drag one of the legs to a new
strike or side. The remaining leg(s) will adjust automatically.
Remove a leg from the strategy by clicking the red "x" to the left of any leg.
Click “Profile” to see the Performance Profile sidecar for the strategy.
Save the spread to a Watchlist to trade it later by clicking "Add to Watchlists."
Click "Clear All Legs" to start over.
Once your strategy is complete, use the Order Entry panel to set order parameters, and click the Submit
button to transmit the order.

Advanced Orders Panel
Click the "advanced" icon from the Order setup line to use stop loss, profit taker and bracket orders, set up
Iceberg, One Cancels Other and hedge orders, and apply other advanced order attributes.
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Routing
Iceberg Orders
Order Reference
All or None Attribute
Stop Loss
Bracket
Profit Taker
OCO (One Cancels Other)
Hedge Order
Check Margin
See Performance Profile

Use the Advanced Orders panel to:

What?
Routing

Select a new routing destination.

How?
Click SMART
and choose a
destination from
the drop-down
list.

Back to top
Iceberg

Create an iceberg order, which displays only a user-specified order size to the
market.

Click in the
field and enter
a partial quantity of the order.
This quantity
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What?

How?
will be displayed to the
market.

Back to top
Order Reference

Add a reference number that helps you track the order through its lifecycle.

Click in the
field to make it
editable then
enter a reference number.

Back to top
All or None Attribute

Specify that either all of the order executes or none of it executes.

Check to apply
the "All or
None" attribute
to the order.

Back to top
Attach a Stop Loss

Attach a Stop Loss order to the original order.

Click "Attach
Stop Loss/Profit
Taker/Bracket."
Check the "Stop
Loss" box only.
In the STOP
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What?

How?
field, modify the
stop type (stop,
stop limit or
trailing stop) as
needed.
In the STP PRC
field enter the

Back to top

stop price.
In the DAY field
modify the time in
force as needed.
Click "more" to
modify the
routing
destination
and/or add an
order reference.

Attach a Bracket

Attach a Bracket order to the original order. This brackets the order with two
opposite-side orders, and is designed to help limit loss and lock in a profit.

Click "Attach
Stop Loss/Profit
Taker/Bracket."
Check "Bracket."
The Profit Taker
and Stop Loss
boxes will be
checked
automatically.
Modify the child
orders.

Back to top
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What?

How?
Profit Taker
Child
Specify Limit or
Relative as the
opposite-side
Profit Taker
order type.
Enter a limit
price. For a
relative order,
this is the price
cap.
For relative
orders, enter the
offset if desired.
Specify the time
and force and
other parameters
as needed.
Stop Loss
Child
In the STOP
field, modify the
stop type (stop,
stop limit or
trailing stop) as
needed.
In the STP PRC
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What?

How?
field enter the
stop price.
In the DAY field
modify the time in
force as needed.
Click "more" to
modify the
routing
destination
and/or add an
order reference.

Attach a Profit Taker

Attach a profit taker child order to the original order. The profit taker is an
opposite-side limit or relative order.

Click "Attach
Stop Loss/Profit
Taker/Bracket."
Check the "Profit
Taker" box.
Specify Limit or
Relative as the
opposite-side
Profit Taker
order type.

Back to top

Enter a limit
price. For a
relative order,
this is the price
cap.
For relative
orders, enter the
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What?

How?
offset if desired.
Specify the time
and force and
other parameters
as needed.

One Cancels Other

Include the order in a one-cancels-other order group.

Click "One
Cancels Other"
to expand the
panel.
Change the
order side if
necessary. By
default, the order
side is the same
as that of the
original order.
Click "Contract"
and enter the
underlying.
Specify the order
type, quantity,
price and time in
force.

Back to top

To add more
orders to the
group, click +Add
Order and follow
steps 2 - 4 above.
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What?

How?
If an order
completely fills,
other orders in
the group are
canceled. The
On Fill: box
instructs TWS
what to do if an
order in the
group is partially
filled. Use the
drop down
selector to
choose the
action:
Ra.
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What?

How?
educe
other
orders
:
Redu-
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What?

How?
ces
the
quantity
of
other
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What?

How?
s
in
the
group
by
the
parti-
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What?

How?
ease
note
that
using
this
opti-
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What?

How?
without
overfill
protection
will
likely
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What?

How?

result
in
multiple
orders
being
r-
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What?

How?

in
turn
result
in
an
overfill,
or
in
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What?

How?

b.

Reduce
other
orders,
overfill
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What?

How?
protection
:
Designed
to
reduce
quantity
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What?

How?

of
other
orders
in
the
group
by
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What?

How?

of
the
order,
and
specifies
that
only
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What?

How?
fill).
Cc- a. ncel
other
orders
:
All
orders
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What?

How?

in
the
group
will
be
canceled.
When
selected,

TWS Guide

114

Chapter 1

One Cancels Other

What?

How?
rotection"
is
automatically
enabled
to
prevent
an
overfill.
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What?

Attach Hedging Order

Attach a hedging order to the parent order. Choose from Beta, FX, or Pair
Trade hedge. The hedging order will transmit when the parent order fills.

How?

Click "Hedge" to
expand the
panel.
In the drop down
list, select the
hedge type and
check the box
next to the order
type field.
a. Beta
Hedge specify the
hedging
contract,

Back to top

the order
type (limit,
market or
relative),
the beta
(change
default
beta if
required),
and the
time in
force.
b. FX Order specify the
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What?

How?
forex pair,
the order
type (limit,
market or
relative),
and the
time in
force.
c. Pair Trade
- specify
the
hedging
contract,
the order
type (limit,
market relative, or
RPI (available if the
contract is
listed on
NYSE),
the offset
(required
for
RPI order), the ratio
(the original contract is "1"
so if you
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What?

How?
enter "2"
the
hedging
order
quantity
will be
twice that
of the original
order, or
2:1) and
the time in
force.

Check Margin

Check the margin requirements for the order before you submit it.

Click "Check
Margin."

Back to top

Pause Execution
When you pause a working order, a cancel request is submitted to the exchange and the order is put into
an inactive state but remains available on the Orders panel (Mosaic) or Quote Monitor (Classic) for you to
resubmit at any time.
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To pause execution on an order
Right-click a working order and select Pause Execution.
Use the DTC time in force to deactivate a day order that has not executed by the close of the market.

Roll Multi-Leg Strategies
Use the Mosaic Roll Builder tool to roll a multi-leg option or stock/option combination position to a new
expiry. If all or part of your existing multi-leg combination position is about to expire, or if you just prefer to
open the position in another expiry, you can easily roll the entire, intact strategy using the Roll Builder tool.
The full combination is routed to reduce execution leg risk, and may receive price improvement versus
submitting the order using individual legs. And if a leg has become worthless and you prefer to let it expire,
simply leave it out of the “roll into” construction.
To roll a multi-leg combo
1. Select a complex combination position from your Portfolio.
2. From the right-click menu, click the “Roll” button to open the RollBuilder tool.
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In the Roll Builder tool, the current multi-leg position appears at the top and shows each individual leg. For
each highlighted leg of the combination, select the contract you want to roll into from the option chains
displayed above the Roll Builder. For convenience, current legs are also highlighted in the Option Chains,
in red for sells and blue for buys, and are marked with a filled-in circle. The new legs are identified by an
empty circle.
As you build the new combination, it is shown below the current combo position in the “Open” section of the
Roll Builder. As you add new legs to roll into, you can modify any element (action, ratio, last trade day,
strike or type) by clicking in the desired field and selecting or entering a new value. When adding new legs,
we pre-select the buy/sell action to logically match your original combination. Note that the ratio is always
set to 1. Additionally, the order price is updated and the Margin Impact is shown in the Order Entry line.
Click Margin Impact to also view the “Estimated Combo Premium,” “Estimated Existing Combo Premium,”
and “Roll to Estimated Combo Premium.”
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This tool is available for futures options, options and covered stock strategies that include up to four legs.
Note that the maximum number of legs might be lower depending on the destination.

Quotes and Data in Mosaic
Depth and breadth of quotes across our myriad Mosaic tools.
Predefined Watchlists

121

Market Depth

122

Time & Sales Data

123

Price History Window

127

Option Selector

128

The Quote Details Window

129

FX Matrix

131

SLB (Stock Loan Borrow) Rates

133

Predefined Watchlists
The Predefined Watchlists function lets you create a new ticker Watchlist that is populated from a userselected scanner. The list of tickers is automatically refreshed each time you log in.
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Watch a short video to see how to create a Predefined Watchlist!

Market Depth
The Market Depth window is a minimized version of the full TWS Market Depth Trader. Note that when
you open the Market Depth from within the Mosaic, it is automatically linked to the primary Mosaic windows
group and is populated with that underlying. To unlink or link to other tools, use Windows Grouping.
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To open the Market Depth
Mosaic: From the New Window drop down select Market Depth.
TWS: From the Trading Tools menu select Market Depth.
Market Depth lines are shaded by price group for easy distinction. It's easy to create an order at a specific
price level by simply clicking a price in the Bid (left) or Ask (right) column.
To create a Market Depth order
1. Click a Bid or Ask price. In the Order Entry window, the order line is populated with the default Bid or
Ask price.
2. Select Buy or Sell and modify the order parameters as desired.
3. Click Submit to transmit the order.

Time & Sales Data
You can elect to view the Time & Sales for any underlying.
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To use Time & Sales
1. Open the Time & Sales window.
From Mosaic - From the New Window drop down select Time & Sales.
From Classic TWS - From the Analytical Tools menu select Time & Sales.
2. To change the underlying, select a new ticker in a grouped window, or enter the ticker symbol in the
entry field.
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Select from chart
From the Time & Sales Search menu, choose Select from chart. The chart for the active underlying opens
with the cursor in "Time and Sales" mode.
Click on the time/date you want reflected in the Time & Sales window.
To search for a date and time from a chart, use the "Select from chart" from the Search button.
See Trade Conditions
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In addition to using the mouse over feature, you can elect to add the Exchange and Conditions field to
the Time & Sales window to show trade conditions when available.
To configure the Time & Sales window or add/remove fields, access the Settings configuration page by
clicking the wrench icon.
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Price History Window
The Price History shows the Open, High, Low, Close and Volume by date, with the first line corresponding
to today's date and using real-time market data. Use the scroll bars on the right side to scroll up and down
by date, and use the "Options" button at the bottom of the scroll bar to go to a specific date/time, export the
current table to Excel, and show splits/dividends by opening the Adjustments field.
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Option Selector
The contract selector for options, which is invoked when you add an option ticker to a page, has been
drastically redesigned. Add an underlying and select "Option" to open the Option Selector. Available
expiries are listed in a tabset across the top. By default the next four quarterly expirations are listed in a
white font. Click on the tab titled 'more' to the right to display all available expirations, and a final selection
box where weeklies and quarterly expirations are available. When selected, the next four weekly
expirations will populate the tabs in yellow. Deselect the weeklies/quarterly check box from the 'more' tab
to return to the regular quarterly expiration series.

The current underlying last price and change are in the top right corner and the available, selectable
options-per-expiry are listed vertically.
The IV reading for the selected weekly or monthly contract is displayed in the upper right.
Use the 'Smart' dropdown to select a specific exchange if needed.
In-the-money contracts are highlighted using a default grayscale. Lighter shades of gray relate to outof-the-money calls and puts while darker shades reflect closer to-the-money contracts.
Hovering over the strike price reveals a popup box detailing the Standard Deviation relating to the
required movement from the prevailing price of the underlying to reach the strike price. (Note that
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Standard Deviations can also be plotted on IB interactive charts using the selection in the Chart Parameters box).
Strike price color-coding can be configured to fall colors (orange and brown) by clicking on the wrench
icon and changing from grayscale to fall.
Configure further according to sensitivity to stock price movement. Choose between 1, 2 and 3 Standard Deviations or 1.0, 1.5, 2.0, 2.5 and 3.0 SDs.
Click on any call or put to add it to a main TWS page. Each line added will be color-coded in either
green or pink to designate in-and out-of-the-money options, respectively.

The Quote Details Window
The Mosaic Quote Details window provides quick-glance data on a specific underlying.
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Get even more data from the Advanced Quote Details window. Access Advance Quotes by clicking the
blue arrow wherever you see it.
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More data, including Comparison to Historical, Comparison to Peers and ESG scores.
Provides a vibrant, graphical display that's easy to read.
Context-sensitive to show instrument-relative data, for example you'll see different information for
ETFs than for stocks or bonds.
When relevant, use the link to launch a useful tool (see Probability Lab link in above image).
For more information on the Mosaic, see The Mosaic Interface topic.

FX Matrix
The FX Matrix provides a convenient way to view FOREX pairs in bulk. The tool comes preloaded with a
set of currencies and the currency list is customizable. Currencies are listed down the left and across the
top; find the intersect of the desired currencies for the most current fx price.
To open the FX Matrix
From within Mosaic - From the New Window drop-down select FX Matrix.
From within Classic TWS - From the Trading Tools menu select FX Matrix.
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To create orders using the FX Matrix
Click a box at the intersection of two currencies.
The FX order populates the Order Entry panel. Specify order parameters and click Submit.
For an all-in-one FX trading experience, use the FXTrader.
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SLB (Stock Loan Borrow) Rates
The SLB Rates window provides charted daily rate history and intraday time & sales of stock loan fees.

TWS Guide

133

Chapter 1

Technical Analytics

Technical Analytics
Find market scanners, charts, labs and more in our robust offering of technical analytics.
Portfolio Builder
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Portfolio Builder
Use Portfolio Builder to create investment strategies based on fundamentals data and top-tier research,
back-test and adjust as needed and then invest in the strategy and tracks its performance within your
existing portfolio.
To open Portfolio Builder
From the Mosaic New Window dropdown, select Portfolio Builder.
Select a pre-defined strategy in the Portfolio Builder Library sidecar to get started, and then click the
Customize button to modify settings. Or click Create New Strategy and then click the Edit Rules button to
modify settings. In the sidecar setup page, define the Portfolio Builder specifications. Results are reflected
immediately in the main Portfolio Builder page as you create your portfolio strategy.
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Choose from pre-defined templates including:
Closely Held - The universe of equities for this strategy includes stocks that have strong balance sheets
(where Total Long Term Debt/Total Shareholder equity for most recent period is under 50) and high insider
ownership (over 20%), and is sorted based on equally-weighted ratings from all analysts. After sorting, the
10 highest-ranked of these stocks comprise the long portion of the portfolio, and the 10 lowest-ranked
comprise the short portion. The investment amount you allot to the strategy is allocated using a long/short
ratio of 130%/50%, and is set to rebalance monthly.
Growth - The universe of equities for this strategy includes stocks that are regarded as "Growth" stocks
(with an Earnings Per Share change over the last 12 months greater than 5%) at attractive valuations
(price-to-earnings ratio under 12), and is sorted based on equally-weighted ratings from all analysts. After
sorting, the 10 highest-ranked of these stocks comprise the long portion of the portfolio, and the 10 lowestranked comprise the short portion. The investment amount you allot to the strategy is allocated using a
long/short ratio of 130%/50%, and is set to rebalance monthly.
High Yield - The universe of equities for this strategy includes stocks that are regarded as "High Yield"
(with a dividend yield over the last 12 months greater than 3%) at attractive valuations (price-to-earnings
ratio under 15), and is sorted based on equally-weighted ratings from all analysts. After sorting, the 10
highest-ranked of these stocks comprise the long portion of the portfolio, and the 10 lowest-ranked
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comprise the short portion. The investment amount you allot to the strategy is allocated using a long/short
ratio of 130%/50%, and is set to rebalance monthly.
Overvalued - The universe of equities for this strategy includes stocks that are regarded as "Highly
Valued" (with a price-to-earnings ratio greater than 10) with strong performance (a year-to-date change
greater than 10%), and is sorted by market capitalization. After sorting, the 10 lowest-ranked of these
stocks comprise the long portion of the portfolio, and the 10 highest-ranked comprise the short portion. The
investment amount you allot to the strategy is allocated using a long/short ratio of 130%/50%, and is set to
rebalance monthly.
Define investment amount, universe and more.
Investment Amount and Long/Short Leverage -Specify an investment amount that will be used to
calculate simulated historical performance, and then specify the percentage of that amount you want to
allocate to creating long (up to 500%) and short (up to 300%) positions. Select Filter by Industry to display
the Industry Filter. Specify industries to include in your hypothetical portfolio, and set limits on how much of
each industry to include as long and/or short positions. Optionally define restrictions on all or specific
stocks.
Universe - Define the universe of equities for the strategy to invest in by filtering by index and last price.
Use the Add Additional Filters drop down list to choose from a myriad of other filter criteria including
High/Low/Volume/History, Dividends, Fundamentals and Short Selling. Set a Minimum/Maximum range
for all filters, and view the filter and min/max range graphically in the filter's histogram chart.
Investment Strategy - Sort the stocks in your investment universe by Market Capitalization, Analyst
Ratings by top research providers, and more than 40 Other Criteria, four of which we select for you to get
you started. Specify how the strategy should determine the long and short positions to include (i.e. go long
in the top 10 ranked equities and short in the bottom 10), how positions should be sized and when to send a
rebalance notification.
Backtest Settings - Set the time period over which back testing results are displayed and the index
against which performance is charted. Elect to optimize the weight of positions based on highest return,
lowest variance or highest Sharpe ratio, and the weight of ranking providers.
See results displayed in the tool to the right of the sidecar as you make your selections. Use the toggle
switch next to the Simulated Historical Performance title to toggle the performance data display between
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percent of the initial investment and an absolute dollar value. Portfolio Builder scans are saved as individual
tabs in the Monitor panel and in the scan library. You can close the scan tabs, but will always be able to
open a saved scan at any time and recreate the tab from with the library. Edit the strategy at any time by
selecting Edit Strategy at the top of the scan. Once you're satisfied with your investment rules and
backtesting results, click the Invest button to create orders and invest in your custom portfolio. Once you've
invested, the purple "H" badge changes to a green "I" badge.
For more details about creating the ideal custom portfolio strategy, see the Portfolio Builder Feature in
Focus.

Portfolio Performance Profile
This what-if feature allows you to toggle the Mosaic Portfolio window into "what-if" mode and add or
remove hypothetical positions to and from your existing portfolio to see how these changes will affect key
portfolio metrics, including P&L, Delta and the Greeks and Value at Risk. If you like the performance results
from the hypothetical adding or removing of any positions, you can create and submit real orders to add
these positions to your actual portfolio.

To open the Performance Portfolio Profile
From the Monitor panel of the Mosaic, navigate to or open the Portfolio page.
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Click the Profile button at the top of the page to put the Portfolio into "what-if" mode.
To use the Performance Portfolio Profile

Use this what-if tool to hypothetically remove positions from your existing portfolio, add new positions, or
change the position quantity and see how key performance metrics are affected.
To hypothetically remove positions
Uncheck any of your actual positions to remove them from the risk calculations.
To hypothetically add new positions
Click the "Add Test Trade" button.
Add the contract like you're adding it to any TWS window.
Set the side and quantity. The hypothetical position is now established.
To add hypothetical positions to your actual portfolio
Click Create Orders under the Test Trades section. All of your test trades are set up as actual live orders.
Discard any orders that you don't want to transmit.
Modify order parameters for remaining orders.
Click Submit.

Predefined Mosaic Market Scanners
Delete this text and replace it with your own content.
To create a Predefined Scanner
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From within Mosaic, click the "+" sign on the Watchlist Plus window and select Mosaic Market Scanner.

In the Predefined Scans section of the Scanner Library, select a region and choose a predefined scan, or
use the Search field to find scans based on a keyword. Available scans are shown below:
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Stock Scanners
Future Scanners
Index Scanners
Option Scanners

US
US Movers
A dual-sorted scan that displays stocks with
the greatest negative percent change (left
side) and greatest positive percent change
(right side).

US Active

Europe
Europe Movers
A dual-sorted scan that
displays stocks with the

Asia Movers
A dual-sorted scan that
displays stocks with the

greatest negative percent

greatest negative percent

change (left side) and

change (left side) and

greatest positive percent

greatest positive percent

change (right side).

change (right side).

Europe Active

Asia Active

Displays stocks with the greatest daily volume, Displays stocks with the
today.

Asia

Displays stocks with the

greatest daily volume, today. greatest daily volume,

today.
US ROE
Scans for major US corporations with the
strongest return on equity over the past 12
months.
US FUT Movers

Europe FUT Movers

Asia FUT Movers

A dual-sorted scan that displays futures with

A dual-sorted scan that

A dual-sorted scan that

the greatest negative percent change (left

displays futures with the

displays futures with the

side) and greatest positive percent change

greatest negative percent

greatest negative percent

(right side).

change (left side) and
greatest positive percent
change (right side).
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US
US INDEX Movers

Europe

Asia

Europe INDEX Movers Asia INDEX Movers

A dual-sorted scan that displays indexes with A dual-sorted scan that

A dual-sorted scan that

the greatest negative percent change (left

displays indexes with the displays indexes with the

side) and greatest positive percent change

greatest negative percent greatest negative percent

(right side).

change (left side) and

change (left side) and

greatest positive percent greatest positive percent
change (right side).

change (right side).

Dividend Yield
Lists equities with the richest dividend yields.
Imbalance
A dual-sorted scan that lists the largest
auction imbalances to buy and sell. Only
displays values during NYSE and NASDAQ
auctions.
Reg Imbalance
A dual-sort scan listing the largest ratio of
Regulatory Imbalance to Average Daily
Volume. Only displays values during NYSE
closing auctions.
Russia ET
Displays the set of US ETFs whose holdings
focus solely on Russian equities.
P/C Volume
A dual-sorted scan that displays equities with
the highest and lowest put/call ratios.
IV/HV
A dual-sorted scan that identifies equities
whose options currently have the highest and
lowest implied volatilities vs. their historical 30day volatilities.
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US

Europe

Asia

Alternative Energy
Displays the list of US publicly traded
corporations in the alternative energy industry.
Option Volume
Displays equities with the highest option
volume today.
IPO Stocks

IPO Stocks

Displays equities sorted by their IPO date.

Displays equities sorted Displays equities sorted
by their IPO date.

IPO Stocks

by their IPO date.

Complex Orders and Trades
Returns all complex strategies on a specific underlying that have a native
bid/ask quote or that have traded today.
To find the strategy that has traded the
most today, sort the results by Volume
(click on the Volume column to sort).

Mosaic Market Statistics
Market Statistics are sorted by exchange and display:
Advancing, declining and unchanged issues
Up, down, unchanged and total volume
TRIN and TICK indicators
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To run Market Statistics
From the Mosaic Monitor panel, click the "+" sign to add a window.
Select Market Statistics. A new tab named "Market Statistics" is created.

Advanced Market Scanner
The Advanced Market Scanners quickly scan of relevant markets and return the top contracts based on the
instrument, parameter and filtering criteria you define. In addition, you can transmit orders directly from a
scanner, and save a scan as a template for later use.

To create an Advanced Market Scanner
From Mosaic - From the New Window drop down select Advanced Market Scanner.
From Classic TWS - From the Analytical Tools menu select Advanced Market Scanner. Use the
icons to the far right of the command to open the scanner as a new window (recommended) or as a
new tab.
Define Scan Criteria
1. Select an instrument type from the Instrument list. Note that the scan title changes with each selection to reflect the criterion you select.
2. Instruments are defined by region. “Global” scanners can scan an instrument across global markets.
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3. Choose the location/exchange whose data will be included in the market scan. The valid locations
change in response to the instrument you selected in Step 1.
4. Use the Filter fields to narrow the contracts that will be returned in your query by characteristic. For
example, you may only want to see the Top% US Stock Gainers within a certain P/E range, or with a
capitalization above 2,000,000.
5. Choose a Scanner parameter, such as Top% Gainers, Hot Contracts by Price or Top Option Implied
Volatility in the Parameter field.
6. Click Search to return the top contracts that meet your search criteria. Data is updated every 60
seconds.
Most scans return the top 50 contracts by default. You can specify the maximum number of returns using
the Max results field.
To save a scanner template
1. After you have defined the scan criteria, click the "Save" disk icon to the right of the Max Results
field.
2. Select Save Template.
3. Enter a descriptive file name and click Save.
To use a saved scanner template
1. From within a Market Scanner page, click the "Save" disk icon to the right of the Max Results field.
2. Select Load Template.
3. Select the scanner file you want to use and click Open.

Complex Orders and Trades Scanner
You can create this scanner individually, or as a tab in the Predefined Mosaic Market Scanners . The
Complex Orders and Trades scan returns all complex combination strategies on a specific underlying that
have a a native bid/ask quote or that have traded today. To find the strategy that has traded the most today,
sort the results by Volume (click on the Volume column to sort).
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To open the Complex Orders and Trades scanner
From Mosaic - From the New Window drop down select Complex Orders and Trades Scanner.
From Classic TWS - From the Analytical Tools menu, select Complex Orders and Trades Scanner.

Mutual Fund/ETF Replicator
The Mutual Fund/ETF Replicator finds a single or compound ETF whose performance parallels that of a
user-specified Mutual Fund or ETF, but whose fees are generally lower. Once you enter the contract or
symbol and the investment amount, the replicator scans the market and returns the top single and
compound ETFs in the recommended quantity (based on the investment amount) whose performance
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most closely follows that of your submitted asset. The Performance Analysis and Return Comparison
panels display performance correlation characteristics including the correlation, tracking error and a
comparison of management fees.

Use the Mutual Fund/ETF Replicator
Open the Mutual Fund/ETF Replicator.
From Mosaic - From the New Window drop down select Mutual Fund/ETF Replicator.
From Classic TWS - From the Analytical Tools menu select Mutual Fund/ETF Replicator.
Enter the fund or ETF symbol, or click Browse Mutual Funds to search by fund family.
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Modify the investment amount, if desired.
View comparison between returned ETF(s) and the original entered contract.
This comparison is intended for information purposes only, and does not constitute a recommendation or
solicitation to buy or sell securities. There is no guarantee that any correlation displayed within this tool will
continue into the future, or that the displayed ETFs will have a similar investment return into the future as
the entered fund or ETF. Customers are solely responsible for their own trading decisions.

Options Analysis
Use or options labs to create the best strategies for your portfolio.

Volatility Lab
Comprehensive toolkit of volatility tools the provide a snapshot of past and future readings for vol on a
stock, its industry peers and soem measure of the broad market.

Volatility Lab

A comprehensive toolkit of volatility tools providing a snapshot of past and future readings for: volatility on a
stock, its industry peers and some measure of the broad market.The Volatility Lab comprises three tabbed
workspace snapshots for Implied Volatility, Historical Volatility and Industry Comparison.
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To open the Volatility Lab
From within Mosaic, use the New Window drop down.
From within TWS, use the Trading Tools window.

Implied Volatility Tab
The Volatility Lab opens to the Implied Volatility layout by default. Move between layouts (Implied Volatility,
Historical Volatility, Industry Comparison) using the tabset along the bottom frame. The Implied Volatility
layout comprises five windows:

Implied Volatility Window
This displays the measure of anticipated volatility of the stock using the prevailing option premium. The plot
allows the user to display the IV reading for as many or as few of the available last trading days. Each is
color-coded with the reading for implied volatility measured on the right axis and the stock price is traced
using the grey line. This look-back view of IV can be plotted for 1 week, one, two and six months, one year
or a custom period. The user may be able to immediately tell from the readings whether or not implied
volatility is relatively high in any given month, possibly caused by expected earnings announcements or
uncertainty over possible changes to dividend payments.
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Volatility Profile Window
Shows the Historical and Implied readings of volatility side-by-side, over time. Either measure can be
removed from the screen by clicking on the checkbox. Compare actual stock volatility to the forward
measure apparent through option premium, and gauge how far the two measures deviate over time in
response to market shocks, or as the underlying share prices track higher or lower. The window allows the
user to look back over a one-year period. Use the Configure Wrench icon to change modes. In the Volatility
Profile window the default view compares historic and implied readings of volatility but the alternate mode,
Volatility Profile Comparison, shows the readings of implied volatility on industry comparable stocks.

Multi-Expiry Skew
Displays the “volatility smile” created by the premium paid for options at selected expirations. Because an
option’s premium is significantly comprised of the reading of implied volatility, an option trader is concerned
by the respective cost of calls and puts at strike prices above and below the prevailing price of the
underlying shares. When investors are more willing to pay higher premiums for in-the-money calls or outthe-money puts, the volatility curve may show a skew to price points below the prevailing share price.
Conversely if options are priced higher for out-of-the-money calls and in-the-money puts, the volatility
curve might be skewed higher to points above the prevailing share price. Use the Configure Wrench icon to
change between Multi-expiry Skew, Time Lapse Skew (described in #4 below) and Skew Comparison
(which allows the user to view the skew on a specified expiration date for the ticker and its industry
comparables, any of which can be unchecked above the plot. Because we could be viewing stocks or an
index with hugely different prices, the x-axis defaults to Moneyness rather than any individual share price).
You change the display for Multi-expiry and Time Lapse skews to compare Moneyness or Strike.
Moneyness is the position of the strike to the underlying, while the Strike option will display the actual set of
available strike prices on the x-axis. Use the Custom Calendar drop-down menu in the upper right of the
screen to drive the same view to any available prior date. The user can then compare how long a particular
condition may have been in place. Note also that the display can be changed between Moneyness and
Strike using the Configure Wrench icon.

Time lapse Skew
An option trader may be interested in knowing how such a price skew has evolved. By using the Time
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Lapse Skew panel, the user can plot the current volatility skew for a selected expiration and compare to
any prior period reading of one day, one, two and three weeks and one month ago. This allows investors to
identify changing conditions in the option market or perhaps to identify a catalyst that caused skew to occur
or disappear.

Open Interest
view current or historic open interest for available contract months and strikes. Choose any available expiry
and view the combined put and call reading of open interest. The plot can be restricted to specific strikes or
will default to open interest across all strikes. Open interest measures investor enthusiasm for a particular
stock and also identifies strikes where most or least liquidity might be available. Note also that in the upper
right corner there is a calendar drop-down menu that allows the user to view open interest on chosen
months or strikes from prior dates. Just pick the time period and select that date.
Use the Configure Wrench icon to change modes between Open Interest and Option Volume. The Chart
allows the user to determine whether to see volume or open interest for Puts and Calls combined in one
chart (Puts + Calls) or broken out into bull and bear contracts in two charts (Puts & Calls). Use the calendar
dropdown to review activity or positioning from any prior calendar date.

Historical Volatility Tab
This tab comprises the Historical Volatility window, along with the Volatility Profile and Time Lapse Skew,
both of which are described above (#2 and #4).
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Historical Volatility
This plot defaults to the 30-day reading of both implied and historical volatility plotted against the share
price over a custom period. By clicking on the plus arrow the user can select from an array of calculations to
view historical volatilities. Investors may want to see how high and for how long volatility measures rise or
fall when they suffer significant swings driven by aberrations to the trend for the underlying share price. The
grey line in the background plots the reading for the underlying share price.

Industry Comparison
The five-window Industry Comparison workspace provides comparison of a stock’s volatility
measures against those of comparable companies in the same industry group.
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Custom Comps
The company is grouped in the upper pane along with its competitors with a share price and volatility
comparison. Check related companies to see their data reflected across all windows.

Implied Volatility Comparison
The measure of volatility for each of the selected companies appears below in the Implied Volatility
Comparison window along with the share price of the company under analysis, which is plotted as a gray
line in the background. Click the "+" sign to add competitors or the comparison to the S&P 500 index. Note
also that you can add a company that is not considered a competitor by TWS by entering its ticker symbol
into either of the Custom input fields. This feature allows you to compare the implied volatility display on an
industry against that of a stock in another field. The default time frame for this chart is two-months. Use the
Time Period drop-down menu to choose from the available time frames to tailor the view. Use the
Configure Wrench icon to change modes.
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Underlying Price
In addition to displaying volatility comparisons, this tab allows the user to compare the share price
performance of the chosen underlying with its peer group, the S&P 500 index, and other custom-defined
companies. Any tickers you may have entered in the Volatility Comparison plot will show up here, but these
can be removed by deselecting them above the chart. Note also that the time period is configurable by
selecting the drop-down menu in the upper right of the chart.

Skew Comparison
This plot is discussed above.

Volatility Profile Comparison
This plot is discussed above.

Volatility Over Time

Implied Volatility Window
This displays the measure of anticipated volatility of the stock using the prevailing option premium. The plot
allows the user to display the IV reading for as many or as few of the available last trading days. Each is
color-coded with the reading for implied volatility measured on the right axis and the stock price is traced
using the grey line. This look-back view of IV can be plotted for 1 week, one, two and six months, one year
or a custom period. The user may be able to immediately tell from the readings whether or not implied
volatility is relatively high in any given month, possibly caused by expected earnings announcements or
uncertainty over possible changes to dividend payments.
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Historical Volatility
This plot defaults to the 30-day reading of both implied and historical volatility plotted against the share
price over a custom period. By clicking on the plus arrow the user can select from an array of calculations to
view historical volatilities. Investors may want to see how high and for how long volatility measures rise or
fall when they suffer significant swings driven by aberrations to the trend for the underlying share price. The
grey line in the background plots the reading for the underlying share price.
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See the complete Volatility Lab.

Volatility Skew

Multi-Expiry Skew
Displays the “volatility smile” created by the premium paid for options at selected expirations. Because an
option’s premium is significantly comprised of the reading of implied volatility, an option trader is concerned
by the respective cost of calls and puts at strike prices above and below the prevailing price of the
underlying shares. When investors are more willing to pay higher premiums for in-the-money calls or outthe-money puts, the volatility curve may show a skew to price points below the prevailing share price.
Conversely if options are priced higher for out-of-the-money calls and in-the-money puts, the volatility
curve might be skewed higher to points above the prevailing share price. Use the Configure Wrench icon to
change between Multi-expiry Skew, Time Lapse Skew (described in #4 below) and Skew Comparison
(which allows the user to view the skew on a specified expiration date for the ticker and its industry
comparables, any of which can be unchecked above the plot. Because we could be viewing stocks or an
index with hugely different prices, the x-axis defaults to Moneyness rather than any individual share price).
You change the display for Multi-expiry and Time Lapse skews to compare Moneyness or Strike.
Moneyness is the position of the strike to the underlying, while the Strike option will display the actual set of
available strike prices on the x-axis. Use the Custom Calendar drop-down menu in the upper right of the
screen to drive the same view to any available prior date. The user can then compare how long a particular
condition may have been in place. Note also that the display can be changed between Moneyness and
Strike using the Configure Wrench icon.
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Time lapse Skew
An option trader may be interested in knowing how such a price skew has evolved. By using the Time
Lapse Skew panel, the user can plot the current volatility skew for a selected expiration and compare to
any prior period reading of one day, one, two and three weeks and one month ago. This allows investors to
identify changing conditions in the option market or perhaps to identify a catalyst that caused skew to occur
or disappear.
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See the complete Volatility Lab.

Probability LabSM (Patent Pending)
Use the Probability Lab to customize the Probability Distribution based on your price or volatility forecast
for the underlying ticker. Analyze and trade any of the option combinations suggested from your probability
distribution.
To open the Probability Lab
From within Mosaic, use the New Window drop down.
From within TWS, use the Trading Tools window.

To use the Probability Lab
Enter a ticker and select a last trading day. The market defined Probability Distribution (PD) is built.
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In the Probability Distribution Builder, grab the red bar in any price interval and pull it up if you believe
there is a higher probability of the stock price ending up in that price interval at the expiration date specified.
Pull it down if you believe there is a lesser probability of the stock price ending up in that interval at the
expiration date specified.
All probabilities must add up to 1.00 so you will see the other levels adjust when you make changes in any
price interval.
You can also adjust the probability using the up/down arrow icons near the values, or by dragging the hand
icon to the left or right within the distribution graph.
When you are satisfied with your custom PD, specify desired parameters, select the minimum number of
legs you want in your option strategy and click Build Strategy.
a. Roll Existing Positions - When applicable, allows you to select existing positions in the
underlying to include in the strategy. The Strategy Builder will attempt to create a
strategy that gets you out of the selected position. Only positions that expire before the
selected last trading day will be displayed, and only two positions can be rolled. If the
user-defined max number of legs below is too small, it will be adjusted. Cannot be used
in conjunction with Incorporate Existing Positions feature.
b. Incorporate Existing Positions - Check to have your existing positions in the underlying included in the computation used to build a strategy. Once you have built the
strategies, you can view the data for the strategies both with and without the selected
existing positions being included by checking/unchecking the "Existing Positions" feature
in the blade of the Strategy Scanner. Cannot be used in conjunction with Roll Existing
Positions feature.
c. Delta Neutral - Check to only build strategies that are delta neutral.
d. Include Stock Leg - Check to have the underlying stock included as a leg in the
returned strategies.
The Strategy Scanner (in the panel below the PD Builder) will display three potential combination option
strategies that complement your customized PD. For each strategy (and based on your custom PD) the
selector displays the Expected Profit, Sharpe ratio (which shows the ratio of expected profit to variability of
outcome), net debit or credit, percent likelihood of profit, max potential profit and loss and the associated
probabilities, and the margin requirement if you were to trade the strategy.
To create an order, in the Strategy Scanner select the strategy. To view color-coded representations in
the Strategy Performance Detail graph, check the strategy.
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Option Strategy Lab

a. Probability Basis - Choose the probability basis for calculations using the drop down
selector.
b. Existing Positions - If you have elected to Include Existing Positions when building
strategies, you now have the option to view data (including P&L in the performance
details graph and data point in the strategy scanner) both including and excluding your
existing positions in the underlying using the Existing Positions checkbox that will display
next to the Probability Basis drop down list. Check to include; uncheck to exclude.
In the Strategy Adjustment/Order Entry panel, adjust any parts of the strategy by clicking in a field in the
leg you want to modify. For any leg, you can modify the action, ratio, last trading day, strike or type.
Once the legs are defined, use the Order Entry line to modify any order parameters. Use the advanced
order area to create a hedging stock order and to attach order attributes including iceberg and all or none.
When the order is ready to be sent, click Submit.
Use the Strategy Performance Detail graph to see the predicted profit or loss that would result from the
selected trade if your forecast is accurate, along with the associated probability that corresponds to each
price point. Use the drop down list to select Delta, Gamma, Vega, Theta or Rho for display.

Option Strategy Lab
Enter your price or volatility forecasts for an underlying and the Option Strategy Lab will return a list of
single and complex option strategies that will potentially profit based on the forecast.
To open the Option Strategy Lab
From within Mosaic, use the New Window drop-down and select Option Analysis and then Option
Strategy Lab.
From within Classic TWS, use the Trading Tools menu and select Option Strategy Lab.
When you first open the Option Strategy Lab, the Strategy Scanner opens to allow you to enter your
forecast data.
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Option Strategy Lab

To populate the Option Strategy Lab
In the Strategy Scanner, enter the underlying.
Define your forecast, including:
The range, between now and a selected last trading day.
Price or Volatility as the forecast driver.
The predicted action of the price or volatility. Choose from:
Drop
Rise
Be rangebound
Move at least
The increment and unit (choose from value or percentage)
If desired, filter your results by Premium, Delta, Strike or Last Trading Day. You can select multiple filters
and define multiple values within each filter.
Click Done to populate the lab.
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Order Entry

Order Entry

The strategy selected in the scanner populates the Order Entry panel. Each time you select a new strategy
the Order Entry panel is repopulated.
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Analyze Strategies in the Scanner

Modify order parameters in the Order Entry section at the bottom of the panel, and click Submit to trade the
strategy. Before you submit the order, you can analyze the forecast-based strategy using the charts and
graphs.
Analyze Strategies in the Scanner

Based on your forecast, the scanner returns a list of options or complex option strategies that will
potentially be profitable if your forecast is correct. Some fields in the scanner include:

Expected Profit
Sharpe Ratio - the measure of excess return (the risk premium) per unit of deviation for the strategy.
Return/Risk Ratio - the ratio of the max potential gain to the max potential loss.
Probability of Profit - the market implied probability of any gain.
Maximum Potential Gain
Maximum Potential Gain as a Percentage of your Investment
Maximum Potential Loss
Maximum Potential Loss as a Percentage of your Investment
Break Even Point - the underlying price(s) required for a strategy to break even.
Hold your mouse over a value in any field to see the definition. Add more fields by clicking the Configure
wrench icon and then selecting Configure Columns.
Analyze the Price Target

The Price Target chart shows the current underlying price highlighted in yellow, and the target price based
on your forecast in red.
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Compare Strategy Performance

The blue shaded area represents the estimated price range to one standard deviation. Drag the dotted line
to change the expiration date.
Compare Strategy Performance

Each strategy checked in the scanner is represented in the comparison chart.
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Strategy Detail

By default the chart is set to today's date, but you can choose the last trading day you specified in your
forecast or any date between today and the last trading day.
Strategy Detail

The Performance Details charts provide a close-up look at the option or strategy selected in the scanner.
Use the selector to change the comparison category.
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Option Activity

The last trading day is driven by the date in your forecast, and can be changed by changing the date in the
Performance Comparison, or by dragging the date line in the Price Target chart.

Option Activity
Open Interest and Option Volume
view current or historic open interest for available contract months and strikes. Choose any available expiry
and view the combined put and call reading of open interest. The plot can be restricted to specific strikes or
will default to open interest across all strikes. Open interest measures investor enthusiasm for a particular
stock and also identifies strikes where most or least liquidity might be available. Note also that in the upper
right corner there is a calendar drop-down menu that allows the user to view open interest on chosen
months or strikes from prior dates. Just pick the time period and select that date.
To view Open Interest/Option Volume
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Option Activity

From the New Window dropdown, select Option Analysis then select Option Activity and then Open
Interest/Option Volume by Strike.

Use the Configure Wrench icon to change modes between Open Interest and Option Volume. The Chart
allows the user to determine whether to see volume or open interest for Puts and Calls combined in one
chart (Puts + Calls) or broken out into bull and bear contracts in two charts (Puts & Calls). Use the calendar
dropdown to review activity or positioning from any prior calendar date.
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Option Analytics
The Option Analytics window displays values that reflect the rate of change of an option's price with
respect to a unit change in each of a number of risk dimensions.
The contract price plots display the static set of contract prices determined during the price scan. Each
point associates an underlying price on the horizontal axis with the corresponding contract price on the
vertical axis. Note that the contract price is expressed as the price per underlying unit (just as it is
represented on an order line or in the execution window). The top plot displays calls, the bottom plot
displays puts, for whichever option(s) your have highlighted in the list.
Move your mouse over the curves to highlight the current value. Also, note that the current underlying price
is highlighted on the bottom axis, and the close price is marked by a light gray vertical line.
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Option Analytics

Use the Plus sign to specify the close value. Use the Vol+15%, Vol-15% and Time-1d raise the implied
volatility by 15% in relative change*, reduce the implied volatility by 15% in relative change*, and reduce the
time to expiry by one calendar day. Use the Date Scenario section to create dynamic curve scenarios.
To view the Option Analytics window
From Mosaic - Use the New Window drop down and select Option Analysis > Interactive Analytics >
Option Analytics.
From Classic TWS - Use the Analytical Tools menu and select Option Analysis > Interactive Analytics >Option Analytics from the Technical section.

*For an example of a relative percent change, if the current implied volatility of an option is 10%, a 15%
relative change would result in an implied volatility of 11.5%, calculated as follows:
10% * (1 + 0.15) = 11.5%.
Additionally you can open just the option Greeks or just the Put & Call P&L by selecting:
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Option Analytics

Option Analysis > Interactive Analytics > Greeks
Option Analysis > Interactive Analytics >Put+Call P&L
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Option Analytics Greeks

Option Analytics Greeks
You can elect to open only the Greeks section of the Option Analytics window.
To open the Greeks
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Option Analytics P&L

From Mosaic - From the New Window drop down select Option Analysis > Interactive Analytics >
Greeks.
From Classic TWS - From the Analytical Tools menu, select Option Analysis > Interactive Analytics >
Greeks.

Option Analytics P&L
You can elect to open only the P&L section of the Option Analytics window.
To open the Option P&L
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Option Analytics

From Mosaic - From the New Window drop down select Option Analysis > Interactive Analytics > Put
+ Call P&L.
From Classic TWS - From the Analytical Tools menu, select Option Analysis > Interactive Analytics >
Put + Call P&L.

Option Analytics
The Option Analytics window displays values that reflect the rate of change of an option's price with
respect to a unit change in each of a number of risk dimensions.
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Option Analytics

The contract price plots display the static set of contract prices determined during the price scan. Each
point associates an underlying price on the horizontal axis with the corresponding contract price on the
vertical axis. Note that the contract price is expressed as the price per underlying unit (just as it is
represented on an order line or in the execution window). The top plot displays calls, the bottom plot
displays puts, for whichever option(s) your have highlighted in the list.
Move your mouse over the curves to highlight the current value. Also, note that the current underlying price
is highlighted on the bottom axis, and the close price is marked by a light gray vertical line.

Use the Plus sign to specify the close value. Use the Vol+15%, Vol-15% and Time-1d raise the implied
volatility by 15% in relative change*, reduce the implied volatility by 15% in relative change*, and reduce the
time to expiry by one calendar day. Use the Date Scenario section to create dynamic curve scenarios.
To view the Option Analytics window
From Mosaic - Use the New Window drop down and select Option Analysis > Interactive Analytics >
Option Analytics.
From Classic TWS - Use the Analytical Tools menu and select Option Analysis > Interactive Analytics >Option Analytics from the Technical section.
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Option Analytics

*For an example of a relative percent change, if the current implied volatility of an option is 10%, a 15%
relative change would result in an implied volatility of 11.5%, calculated as follows:
10% * (1 + 0.15) = 11.5%.
Additionally you can open just the option Greeks or just the Put & Call P&L by selecting:
Option Analysis > Interactive Analytics > Greeks
Option Analysis > Interactive Analytics >Put+Call P&L
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Strategy Performance Graph

Strategy Performance Graph
Displays the P&L (or any of the Greeks) as a function of the underlying price. The graph is displayed as part
of the Performance Profile, and can also be opened as its own window.
To open the Strategy Performance Graph

TWS Guide

177

Chapter 1

Strategy Performance Graph

From Mosaic - From the New Window drop down list select Option Analysis and then Strategy Performance Graph.
From Classic TWS - From the Analytical Tools menu, select Option Analysis and then Strategy Performance Graph.
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Portfolio Analyst

Portfolio Analyst
PortfolioAnalyst allows you to evaluate the performance of your IB portfolio by creating and saving reports
based on a set of measurement criteria and optionally comparing their data to selected industry
benchmarks. Once you create and save reports, you can run, edit or delete them.
Portfolio Analyst is part of Account Management. For details, please see the Portfolio Analyst section of the
Account Management.

Wall Street Horizon Data
Subscribe to Wall Street Horizon to see ticker-specific events calendars and industry-related events for
thousands of companies worldwide. The Events Calendars display dates for earnings announcements,
shareholder meetings, investor conferences and other events, and provides links to Seeking Alpha
transcripts whenever available.
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Wall Street Horizon Data

To access the WSH Corporate Events Calendar
From Mosaic - From the New Window drop down select WSH Corporate Events Calendar.
From Classic TWS - From the Analytical Tools menu select WSH Corporate Events
Calendar.Then select My Portfolio to see events for companies in your portfolio, or Selected company
to see events for the company selected in the Quote Monitor. See below for detailed instructions on
company-specific display.
If you don't see this command listed in the Fundamentals section of the Analytical Tools men, use the
Expand arrow at the bottom of the list to display hidden menu items.
Select a future event in either table and click Set Alert to create a message or order action alert.
Click the blue hypertext to access a transcript.
You can also view the Events Calendar for one or multiple tickers.
To view Events for specific tickers
1. Start in the Classic TWS interface.
2. From a Quote Monitor, select a ticker or select multiple tickers by holding down the Ctrl key and clicking the market data lines.
3. From the WSH Corporate Events Calendar menu command choose Selected company.
You can also view recent events for your portfolio, which comprises all of your current positions.
To view a Portfolio Events Calendar
1. From the Analytical Tools menu, select Event Calendar and then My Portfolio.
Note: If you have a large portfolio, it may take several minutes for all of the data to load. You may
want to consider viewing events for a subset of tickers using the procedure above.
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The Toolbox

Recent events are listed in the Events table, sorted by date.
Click the Underlying field heading to re-sort the table by underlying. Click any other field to re-sort by
that field.
Hold your mouse over the Earnings Call Information icon to see dates for upcoming Earnings calls.
Select a line and click the Company Fundamentals button to open that tool for a single underlying.

The Toolbox
The Mosaic Toolbox includes a predefined list of quick links to useful tools that use windows grouping to
link them to the primary Mosaic group. Click an item to open the tool populated with the currently selected
underlying.
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Information System

To display the toolbox
From Mosaic - From the New Window drop down select Toolbox.
From Classic TWS - From the Analytical Tools menu in the Technical section select Toolbox.

Information System
News and fundamentals abound throughout the Information System.
Trader's Journal

183

Event Calendars

184

Daily Lineup

186

Mosaic News Panel

187

Fundamentals

197

Analyst Research

210
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Trader's Journal

Trader's Journal
Trader's Journal is a convenient note-taking feature that lets you record and save trading notes and ideas
on any product in TWS. Notes on an asset are displayed on any tool that lists the product, and are saved
and will be available the next time you log in to TWS. In addition to text notes, you can also capture screen
shots of various open tools in TWS including charts, and save them as part of your note. Assets that have a
note associated with them display a notepaper icon next to them. Hold your mouse over the note icon to
read the note. To edit the note, use the right-click menu and select Show Notes.
You can also open the full journal view from the New Window drop down to view and manage all notes.

To add a note on an asset
Right-click an asset and select Add New Note.
Trader's Journal notepads opens with the editor window. Type your note in the editor.
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Event Calendars

You can modify the look of the text in the editor, add a hyperlink to the text and include a snapshot of a chart
or other open window.
Make text larger or smaller - Click the T+ or T- icons to make the selected note text larger or smaller,
respectively.
Make text bold or italicized - Click the B or I icon to respectively bold or italicize the selected text.
Add a snapshot to a note - Click the image icon and select an open window from the drop down list.
The image is saved as a thumbnail image in the note and can be enlarged by clicking it.
To edit an existing note
Right-click the note icon on an asset and select Show Notes. Or, hold your mouse over the note until you
see the note text, then click the note. You'll see all notes for the selected asset.
Double-click a note to open the editor.
Edit the note and click Done when finished. Add or delete notes, or close the note.

To manage all notes
From the New Window drop down, select Trader's Journal from the Information System section.
Manage notes by:
Adding a new note - Click New Note along the top of the journal and select an asset to create the note.
Deleting a note - Select a note and click Delete Note from the top of the journal. Confirm that you want
to delete.
Sorting notes - Click Sort By to sort notes by date or symbol.
Add to an existing note - Select a note to open it in the right panel. Click in the editing area to modify the
note. The updated text is saved automatically.

Event Calendars
View Corporate Earnings, Corporate Events, Economic Events, Dividends, Splits and IPO/Secondary
Offerings from the unified Events Calendar.
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Event Calendars

To open the Event Calendar
From the Mosaic Anchor Window, click the Event Calendar button.
The left side of the display provides filters to streamline the displayed data shown on the right. By default
the view opens to today's date, but you can click any date on the calendar widget to view events for that
day. Other filters include:
Filter by Company: Enter a symbol to filter out all data but for the specified company.
Only Show My Companies
If on, companies displayed in the individual sections are in your portfolio, a Watchlist, were recently
held by you, or are competitor companies of these. Filter further by unchecking any of the four "my
companies" selections.
If off, you will see full data including all companies returned by Thomson Reuters Street Events.
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Daily Lineup

Corporate Actions
If on, all four sections of the Corporate Actions umbrella are displayed. Filter further by unchecking
one or more of the Corporate Action sub-categories.
Corporate Events - Toggle on or off to display or hide Corporate Events.
Economic Events - Toggle on or off to display or hide Economic Events.
Option Last Trade Dates - Toggle on or off to display or hide the Option Last Trade Dates section.
Region - Use the drop down selector box to view data for US, America Non-US, Europe, Asia, or all
regions.
The results of your filters are displayed in the large frame on the right side of the Calendars window.
Click an event to see more details.
Use the DAY/WEEK/MONTH buttons on the top right to view results for the selected day, week, or month.
Events shown in weekly or monthly view are identified by colored dots. Use the calendar widget in the Filter
section to select a different day, week or month.

Daily Lineup
Designed to be viewed first thing in the morning, the Daily Lineup provides a birds-eye view of upcoming
market events. IBIS subscribers will see the Daily Lineup when they first log in, and can view the summary
at any time during the day by selecting Daily Lineup from the New Window > Information System menu.
The Daily Lineup updates in realtime throughout the day. Thumbnail charts in the World Markets change
based on the selected contract. In the News sections, click a headline to view the full story.
To view Daily Lineup
From Mosaic - From the New Window drop down select Daily Lineup.
From Classic TWS - From the Analytical Tools menu select Daily Lineup.
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Mosaic News Panel

Mosaic News Panel
The News panel groups all of your news feeds into a single window. To include a feed in your News panel,
simply click and pick.
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Company Specific News

Many of the feeds require a paid subscription. If you are not subscribed, you will not see the selection in
your news list.

Company Specific News
Displays real-time streaming news headlines for the selected company.
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Filtered News

To view Company Specific News
From the Mosaic News panel, click the "+" sign and select Company Specific News.
From the Classic interface, use the Analytical Tools menu and select Company Specific News.
We include Sentiment and Confidence ranking data from Alexandria Contextual Text Analytics™ Engine
(ACTA™) which is shown in the Rank column. The column uses color along with a number to indicate a
positive, neutral or negative sentiment and the degree of confidence of the ranking.
Green indicates positive sentiment, and displays a number between 0 and 1, where "1" indicates the
highest confidence in the ranking.
Red indicates negative sentiment, and displays a number between -1 and 0, where "-1" indicates the
highest confidence in the ranking.
Additionally, many headlines now include the sentiment in the headline after the symbol, for example,
"12:13 SS XYZ Positive - Company XYZ Price Target Raised to $120."

Filtered News
View real-time streaming general news that you can filter by subject. Add Market Signals as part of your
integrated news headlines. Note that the Filtered News window cannot be part of a windows group.
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Filtered News

To view Filtered News
From Mosaic - From the News panel, click the "+" sign and select Filtered News. Or, from the News
button, select Filtered News.
From Classic TWS - From the Analytical Tools menu select Filtered News.
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Portfolio or Watchlist News

Portfolio or Watchlist News
Show news for:
Companies in your portfolio, plus news relating to competitors or those companies.
All companies listed in your Watchlists and in the Quote Monitor in TWS, plus news relating to competitors of those companies.
A custom-defined list of companies.

To view Portfolio or Watchlist News
From Mosaic
1. From the News panel, click the "+" sign and select Portfolio or Watchlist News. Or, from the
News button, select Portfolio or Watchlist News to create a separate window.
2. In the settings dialog to indicate which tickers to use for headlines. Check one or multiple selections.
From Classic TWS
1. From the Analytical Tools menu select Portfolio or Watchlist News.
2. In the settings dialog to indicate which tickers to use for headlines. Check one or multiple selections.
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Broad Tape News

Broad Tape News
Displays news from all subscribed news wires.

To view Broad Tape News
From Mosaic - From the News panel, click the "+" sign and select Broad Tape News. Or, from the
News button, select Broad Tape News to create a separate window.
From Classic TWS - From the Analytical Tools menu select Broad Tape News.

Today's Top Ten News
View the top ten news stories from Dow Jones or the StreetInsider by adding Today's Top Ten to your
News panel.
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Bloomberg TV News Feed

Click a top news headline to view the full content.

Bloomberg TV News Feed
Watch live TV from the Bloomberg TV news feed.

To watch Bloomberg TV
From within the Mosaic News panel, click the icon to add a page, located at the end of the current tabset.
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IBKR Traders' Insight and IBKR Quant Blog

Select Bloomberg TV from the drop down list of news feeds.
Click the “Play” icon to watch news.
Note: Use the “Expand” function or double-click the title bar to enlarge the Bloomberg TV viewing screen.

IBKR Traders' Insight and IBKR Quant Blog
The IB Traders' Insight, designed to give traders an edge with daily global market commentary written by
traders and industry contributors, is available as a news feed in TWS. Additionally, you can view Traders'
Insight videos and content from the IBKR Quant Blog by selecting these features from the list of feeds.

To add Traders’ Insight, Traders' Insight Videos and IBKR Quant to News
From within the Mosaic News panel, click the icon to add a page, located at the end of the current tabset.
Select Traders’ Insight, Traders' Insight Videos, or IBKR Quant from the drop down list of news feeds.
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Market Signals

Market Signals
IB's data servers continuously scan the markets for irregular price and volume actions and transmit these
notifications directly to your TWS in the form of Market Signal alerts. Available market signals include price
spikes, irregular volume spikes, new 52 week highs/lows, put/call ratio spikes, trading halts and more.
Market Signals can be integrated into the general news headlines in the Filtered News window, or viewed
as a separate feed in the Market Signals window. By default, the Market Signal alert "Gap On Open" is
active in the Filtered News window.

To add Market Signals to Filtered News
From the Filtered News title bar, click the Configure wrench icon.
Ensure that Filtered News is selected in the left pane.
In the right pane, select General News and click Configure Subject Filter next to IB Market Signals.
Select the signals to add using the checkboxes and apply.
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Social Sentiment

To use the Market Signals window
From the News panel, click the "+" sign and select Market Signals.
From the Market Signals title bar, click the wrench-shaped Configure icon and then click Settings.
In the right pane of Global Configuration under Market Signals, click Configure Subject Filter.
Select the signals to add using the checkboxes, and apply.

Social Sentiment
Social Sentiment is included in the Filtered Feed. Social Sentiment news headlines are identified by the
prefix SS. You can also created a Social Sentiment news tab or floating window.
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StockTwits News Feed

To view Social Sentiment
From Mosaic - From the News panel, click the "+" sign and select Social Sentiment. Or, from the
News button, select Social Sentiment to create a separate window.
From Classic TWS - From the Analytical Tools menu select Social Sentiment.

StockTwits News Feed
Add the StockTwits news feed to your Mosaic news panel to find out what real traders and investors are
saying. Real headlines in real language.

Add the StockTwits news feed
From within the Mosaic News panel, click the icon to add a page, located at the end of the current tabset.
Select StockTwits from the drop down list of news feeds to create the news feed tab.

Fundamentals
Customers who subscribe to Wall Street Horizon have access to comprehensive high-quality financial
information on thousands of companies, in the form of company and portfolio events.
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Company Overview

To access Company Fundamentals
1. Select an underlying symbol.
2. Use the right-click menu to select Analytical Tools, and then select Company Fundamentals.
3. Use the drop-down list in the title bar to change windows. Availability is based on your subscriptions.
Choose from the company Summary, Financial Summary, WSH Corporate Event Calendar,
Dividend Calendar, Analyst Recommendations, Financial Ratios, Financial Statements, Analyst
Forecasts, Similar Products, SEC Filings, and Insider Trading.

Company Overview
Open from the New Window > Fundamentals section for a specific underlying.
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Financial Summary

Financial Summary
Open from the New Window > Fundamentals section for a specific underlying.
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Ownership Tear Sheet

Ownership Tear Sheet
Detailed insider and institutional ownership statistics and graphs to incorporate into your investment
strategies. The Insider and Institutional Ownership tear sheet provides detailed institutional and insider
ownership rosters with a graph of ownership percentage over time, and an insider trade log.

TWS Guide

200

Chapter 1

Ownership Tear Sheet

To view Ownership Tear Sheet
From within Mosaic, use the New Window drop down to select Fundamentals then Ownership).
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Dividend Calendar

Dividend Calendar
Open from the New Window > Fundamentals section for a specific underlying.
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Analyst Ratings (Details)

Analyst Ratings (Details)
Find a high-level Analyst Recommendation Summary for a selected instrument along with a list of current
news headlines in the Details tab, plus TipRanks data in the Price Targets & News tab.
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Analyst Ratings (Summary)

To view Analyst Ratings (Detail) page
From within Mosaic, use the New Window drop down to select Fundamentals then Analyst Ratings
(Detail).

Analyst Ratings (Summary)
Our sell-side Analyst Rating Summary tear sheet provides summary rating and price target statistics, along
with upgrade/downgrade history and TipRanks fundamental analysis. The Summary tab graphs mean
ratings history, price target history and rating distribution over time. The Coverage tab displays TipRanks
Analyst Consensus and its breakdown, the Analyst Price Target, and a list of analysts.
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Analyst Ratings (Summary)

To view Analyst Ratings (Summary)
From within Mosaic, use the New Window drop down to select Fundamentals then Analyst Ratings
(Summary).
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Ratios

Ratios
Open from the New Window > Fundamentals section for a specific underlying.
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Financial Statements

Financial Statements
Open from the New Window > Fundamentals section for a specific underlying.
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Analyst Forecasts

Analyst Forecasts
Estimates trends and consensus estimates powered by Thomson Reuters.
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Similar Products

To view Analyst Forecasts
From within Mosaic, use the New Window drop down to select Fundamentals then Analyst Forecasts.
Select Consensus Estimates or Estimates Trend from the drop down selector in the top left corner.

Similar Products
Scan for similar products to your selected instrument.
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Analyst Research

To view Similar Products
From within Mosaic, use the New Window drop down to select Fundamentals then Similar Products.

Analyst Research
Research and analysis from top providers.

Analyst Actions
The top panel summarizes upgrade/downgrade activity for companies including those in your watchlist and
portfolio and competitors of those companies. The lower panel provides upgrade/downgrade details.
Yellow tick dot identifies Watchlist or portfolio companies; blue tick dot identifies category competitors.
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Recent Publications

To open the Analyst Actions window
From Mosaic - From the New Window drop down select Analyst Research and then Analyst
Actions.
From Classic TWS - From the Analytical Tools menu, select Analyst Research and then Analyst
Actions.

Recent Publications
Recent headlines from all or any of your subscribed publications are listed.
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Analyst Research

To open Recent Publications
From Mosaic - From the New Window drop down select Analyst Research and then Recent Publications.
From Classic TWS - From the Analytical Tools menu select Analyst Research and then Recent
Publications.

Analyst Research
See Analyst Actions, Recent Publications, or choose from our extensive list of premium research and
analytics content. Those to which you already subscribe are listed first. Available subscriptions are also
displayed. Click to subscribe through Account Management.

TWS Guide

212

Chapter 1

Analyst Research

To view Analyst Research
From Mosaic - From the New Window drop down select Analyst Research and then choose a specific report.
From Classic TWS - From the Analytical Tools menu select Analyst Research and then choose a
specific report.
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To subscribe to any subscription- based report, select the report and click More Info to open the
Subscription Manager in Account Management.
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Classic TWS
Add Market Data

215

Create an Order

219

Modify an Order

221

Transmit an Order

222

Cancel an Order

224

Add a Quote Monitor

226

Add Market Data
When you first open the Classic TWS interface, a sample Quote Monitor displays several sample lines of
data. Before you trade an asset, you’ll want to be able to see streaming data for the asset. A market data
line represents an individual ticker, and displays the product type, order destination, ask and bid prices, and
any other defining attributes. You can add a market data line by typing a symbol directly into the
Contract column of the Quote Monitor.
Enter security definitions by entering the exchange contract class or contract symbol in the Contract field.
Enter forex pairs using the syntax xxx.yyy in the Contract field.
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To add market data to the Quote Monitor
1. Click in the Contract field in an empty row.
2. Enter an underlying symbol and press ENTER.
3. Select an asset type from the picklist on the trading screen.
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If you choose Smart as the exchange (rather than selecting Directed and then picking a destination)
the market data is aggregated and the default order routing is Smart. From a display perspective,
ticker lines that use aggregated Smart data do not display Smart in the data line. TWSwill only show
the exchange if you elect to direct route. When you create an order, regardless of the market data
selection you can modify the order routing destination on a per-order basis using the
Destination field.

Snapshot Quotes
For NYSE, AMEX and NASDAQ listed US equity products, clients have the option to either:
a) Subscribe to streaming data - Elect to subscribe to streaming data for one, two or all three listing
exchanges at the monthly fee.
b) Use Snapshot quotes - View delayed market data, and only pay for the current NBBO when making a
trading decision.
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Snapshots are typically used by traders who want to keep costs as low as possible and who only need to
know the NBBO (National Best Bid and Offer) for a specific moment to make their trading decisions.
Pricing for snapshot quotes is 0.01 USD (or the equivalent) capped at the price of the streaming
subscription.
Once the number of snapshot quotes per month equals the cost of a streaming service, clients will be
switched to the streaming quote service for the remainder of the calendar month. At the close of the month,
the streaming service will terminate and the snapshot counter will be reset. Each listing exchange is
capped independently.
If you use Snapshots, the system will react as if you are trading blind without a valid quote. It will limit the
'speed' tools you can use (like the sliding price ruler) and may require that you submit orders from the order
ticket.

Option Selector

4. In the Contract Selection box, select a contract(s) and click OK. For assets requiring right, expiry
and strike price, use the Selector box. In-the-money contracts are highlighted. Use the Smart dropdown to choose a single exchange.
Notes about Market Data use
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A market data line is considered “active” when visible.
Each alarm that you set always uses one line of market data whether or not you are viewing the asset
that contains the alarm.
Market data requested through an API has top priority, followed by data requested by alarms, and
finally basic market data display. This means that if you are viewing a trading page that includes 100
lines of market data, and you also have price-activated alarms set for 6 other contracts, those 6 contracts will receive market data, and your trading page will only show data for 94 contracts.
The option chains in the OptionTrader do not count against available market data lines.
For details on market data fees and allocation rules, see the Market Data and News Subscriptions
overview on the IB web site.
Note: If you add a market data line for a derivative instrument, will ask if you want the underlying
symbol added to the page. If you answer yes, it will be included above its derivative.

Create an Order
There are many ways to create an order in TWS. This topic shows you how to create and transmit an order
directly from a ticker line in the Quote Monitor.
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To create and transmit an order from the Quote Monitor
1. Click the Ask or Bid in a market data line to create an order line directly below the selected ticker.
Click the Ask to create a Buy order.
Click the Bid to create a Sell order.
2. On the Order line, modify the order parameters including Time in Force, Action, Quantity, Price,
Order Type, or Destination, if needed.
Note: To trade more efficiently by using default values, create order Preset strategies using
the Order Presets in Global Configuration.
3. To transmit your order, click “Transmit” (or “T” if you have reduced the size of the Transmit field).
Show Orders
By default, a working order will display on any page that has the ticker. You can modify where you want
working orders to display using the Page settings.
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4. Right click a tabbed title and select Settings.
Show only orders created on this page - Regardless of the tickers, only the orders you create from this
page will display on this page.
Show inactive orders only, move active orders to Pending page - Shows deactivated or non-transmitted orders only. Working orders created from this page will only display on the Pending page.

Modify an Order
You can modify an order up until the time it fills. Until this occurs, the order remains visible and editable.

Using Mosaic
Working orders appear in the Orders panel, and can be edited by clicking the appropriate field.

Using Advanced Order Entry
The order line appears below the ticker on the page on which it was created, and on the Pending page. An
order is “working” if the order status is green.
VWAP orders are accepted immediately and cannot be modified.
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To modify a working order
1. On an order line, click in the field you want to modify, and make your change.
Orders that have child orders associated with them, such as bracket or scale orders, cannot have the
order side flipped. Orders than can be flipped will note this using (Reverse) next to the opposite-side
action in the Action drop-down. When you flip the order side, a cancel request is sent for the original
order and both the original with the cancel request and the new reversed order are displayed.

2. Click Update in the Transmit column to transmit your modified order.
To undo changes before you transmit, right-click and choose Discard Modifications.
Note: You may receive a fill on the original order before your modified order has replaced it on the
exchange. Please see the Customer Agreement for specific details on modifying and canceling
orders.

Transmit an Order
Once you have verified the order parameters on an order management line, you are ready to transmit your
order.
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To transmit an order
Click Transmit (or “T” if you have reduced the size of the field) in the Transmit field, or
Use the right-click menu on the order line and select Transmit.
When an order is accepted at the destination, it becomes a “working” order. All working orders appear on
the Pending page. A red tab title indicates that the page holds a working order.
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To transmit multiple orders
From the Trade menu select Transmit, and then select:
Transmit Selected Orders to submit the orders you have selected on the current page
Transmit All Orders on Page to send all of the orders on the current page. The dollar value in parenthesis reflects the total value of all orders on the page.
Transmit All Orders to submit all orders in TWS.

Cancel an Order
For a working order, the Cancel command sends a cancellation request to the order destination. See the
Order Status Colors page for the meaning of status colors on an order management line.
For a non-transmitted order, use the right-click Discard command to delete the selected order(s) from
your trading screen.
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You can cancel any working order up until the time it has been executed at an order destination. You can
also choose to cancel all orders on a page or all orders on your workstation.

To cancel a working order
1. From the Trade menu select Cancel, and then select:
Cancel Selected Orders to submit a cancel request for the order(s) you have selected on the current page
Cancel All Orders on Page to cancel all working and non-submitted orders on the current page.
Cancel All Orders to submit a cancel request for all orders in TWS.
Or,
2. Click Cancel (or “C” if you have reduced the field size) in the Cancel field.
For information on the colors displayed in the Status field, see the Order Status Colorstopic.
Note: Your working order is not confirmed CANCELED until the status field turns red. Please see
the appropriate Customer Agreement for further information on order confirmation/cancellation.
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Add a Quote Monitor
There is no limit to the number of Quote Monitors you can create in TWS. You can enter as many lines of
market data as you want, but at any one time you will only be able to see 100 active market data lines at a
time. For details, see Notes about Market Data use. Use the Quote Monitors to sort your assets by
instrument type, exchange, or your own trading system categories. You can navigate through the tabbed
pages without the mouse by using the Ctrl key along with the Page Up and Page Down keys.
To detach a page, simply click the tab and drag the page away from the tabset.
To create a new page, click the “+” sign and select Quote Monitor
To delete a page, click the X.
To rename a page, right-click the page title and select Rename Page.

You can also use a page-level feature called Quick Stock Entry, which will automatically complete a market
data line for a stock using the set of order destinations you set up.
To add a Portfolio Page
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You can create a system-maintained Quote Monitor that includes a data line for each position in your
portfolio. Use the right-click menu from the “+” sign and select Portfolio Window. The portfolio page can
only be created once.
This creates a page with the same positions that are displayed in the Portfolio section of the Account
window. Each time you take a position, the Portfolio page is automatically updated to include market data
for the new position. When you zero out a position, the market data line remains on your Portfolio page.
You can remove zero position tickers from this and other pages using the right-click menu on a page and
selecting Clear Zero Position Rows.
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Trading Tools
TWS provides a comprehensive collection of specialized trading tools that function separately as standalone windows, and in conjunction with other TWS tools. Our expanding family of order management
applications include:
BasketTrader

233

Open BasketTrader

233

Upload a File to BasketTrader

235

Transmit a Basket Order

235

Create a Basket File in TWS

237

Manually Create a Basket File

238

Basket Fields

240

BookTrader

244

Open BookTrader

245

Trade with BookTrader

247

BookTrader Quantity Multipliers

249

BookTrader Order Handling

250

BookTrader Hotkeys

253

BookTrader Colors

258

BookTrader Buttons

261

ChartTrader

262

Open ChartTrader

263

Create and Transmit Chart Orders

264
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Trading Tools

266

About Combination Orders

266

Create a Combination Order

270

Using the ComboTrader

274

Advanced Combo Routing

278

Transmit a Combination Order

281

Notes on Combination Orders

282

EFPs

283

Relevant EFPs

283

EFP Futures Spreads

285

FXTrader

286

The FXTrader Window

287

The FXTrader Trading Cell

288

Using the FXTrader

289

Cash Quantity Stock Orders

291

Cash Quantity for Forex Orders

292

The Integrated Stock Window

293

Quote Panel

294

Book Data Panel

295

ISW Buttons Panel

297

Order Entry Panel (OEP)

298

Auto Orders

299
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Market Depth

Trading Tools

301
303

Market Depth Trader

303

Market Depth Trader for Bonds

305

Market Depth Buttons Panel

306

Create an Order

312

Merger Arbitrage Window

314

OptionTrader

316

Using the OptionTrader

317

Loading Option Chains

319

OptionTrader Strategy Builder

320

The Button Panel

322

OptionTrader Statistics

323

OptionTrader

325

The Order Ticket

328

Basic

328

Advanced Combo Routing

335

Adjustable Orders

338

Scale Orders

341

Pegged Orders

345

Volatility Trading

346

Conditional

350
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Pre-Borrow Shares for Shorting

Trading Tools

352
356

About Pre-Borrows

356

Create a Pre-Borrow Order

357

Pre-Borrow Returns

359

Order Quantity Calculator

360

Determine Order Quantity

360

Calculate Order Quantity

361

Rapid Order Entry

364

Enter Orders using Rapid Order Entry

364

Update Multiple Orders

366

Create "Instantaneous Transmit" Hot Key

368

Rebalance Your Portfolio

369

The Rebalance Window

370

Import and Export Positions to Rebalance

371

Rebalance for Advisors

375

SpreadTrader

377

Create Futures Spreads with SpreadTrader

377

EFP Futures Spreads

380

Create Option Spreads in SpreadTrader

382

TWS Blotter
Using the TWS Blotter
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Understand the Blotter Interface

386

Manual Ticket Entry

388

Advisor Allocations

391

Receive Electronic Tickets

391

Use Color Grouping to Link Blotter Windows

394

Using the Tickets Panel

395

Using The Orders Panel

397

What is an Away Destination?

399

Manage Orders with TWS Algos and Tools

403

Reading the Trades Panel

404

Display Orders by Filter Criteria

404

Order Sharing Modes

406

Configure the Blotter Panels

408

Trade Volatility

411

Volatility Trading

411

Attach a Delta Hedge Order

414

Volatility Trading

416

Write and Roll Options

419

Write Options

419

Write/Roll Options: Option Chains

421

Rollover Options

422
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BasketTrader
Use BasketTrader to manage groups of orders on one or multiple products.
Open BasketTrader

233

Upload a File to BasketTrader

235

Transmit a Basket Order

235

Create a Basket File in TWS

237

Manually Create a Basket File

238

Basket Fields

240

Open BasketTrader
Use BasketTrader to manage large groups of orders on multiple products.
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To open BasketTrader
From the New Window dropdown, scroll down to More Advanced Tools and then select BasketTrader.
Alternatively, type BasketTrader in the New Window Search field.
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Upload a File to BasketTrader
Upload a .csv file of orders to BasketTrader, where you can modify, transmit and otherwise manage them.

To upload a basket file
From within BasketTrader, click the Browse button.
In the file list, choose a file to upload.
Click Open to load the file.
Use the BasketTrader features to modify and transmit the basket of orders.

Transmit a Basket Order
Once you have uploaded a basket of orders, you can modify them before you transmit by adding or
removing instruments, changing the multiplier, reversing the order sides, and electing to convert limit
orders to market, relative, or RPI orders.
You can modify the basket quantity in the Execute Basket section. By default, the quantity is 100%.
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Change the percentage. This will be applied to each order in the basket. For example, if you change
the quantity to 50%, the total quantity for each instrument is reduced by half.
Set a dollar amount. Switch the Quantity unit to "USD" and enter a value. By default, the system will
divide the number of instruments in the basket by the dollar value and allocate the same amount to
each, so a basket of 20 instruments with a quantity of 15,000 USD would allot 750 USD to determine
the number of shares to transact, regardless of the current price of the instrument. To modify this
default, check "Use per-contract quantity percentage," and in the "%" field for each individual instrument, specify the percent to allot to that instrument. The total must equal 100%. If you do not see the
"%" field, add it by holding your mouse over an existing field and selecting "Insert Column." From the
Basket category select "%".
Note that the system cannot guarantee the basket quantity when it is other than 100% due to exchange
required order size rounding. This means that the value of the basket could be significantly higher than
expected.
When you transmit a basket order, each order in the basket is cleared individually. If your account does not
meet margin requirements, it is possible that only a portion of the basket order will fill.

TWS Guide

236

Chapter 1

Create a Basket File in TWS

Create a Basket File in TWS
TWS will automatically create a basket file from a group of non-transmitted orders on a trading page. When
you want to trade or manage baskets, open the basket file from the BasketTrader. You can also create a
basket file manually and upload it into BasketTrader.

Note: TWS creates a basket file from orders on a single trading page. You can easily combine
orders from multiple files into one using MS Excel.
To automatically create a basket file
From within the Classic TWS interface:
1. Create orders to include in the basket file.
Click the Ask Price on a market data line to create a BUY order.
Click the Bid Price on a market data line to create a SELL order.
2. Modify order parameters and define order attributes.
3. On the Trade menu, select Save Orders as Basket.
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If Save Orders as Basket is not visible, click the Hidden Features arrow at the bottom of the menu to display
the command.
4. In the dialog box, review or rename the file and use a .csv extension (i.e. stocks.csv) and click OK.
The system uses the Trading page name as the default basket name.
5. Cancel the orders you created. Use the Trade menu and select Cancel then Cancel All Orders on
Page.
The BasketTrader supports Bracket orders, but baskets that include brackets will have the Reverse and
Cancel and Reverse features disabled. Remember to create the bracket order(s) on the Quote Monitor
and then save the brackets as a basket file. You cannot create bracket orders within the BasketTrader
itself.

Manually Create a Basket File
A valid basket file will have a clean relationship between the header row and order rows. The header fields
can occur in any order as long as the values in the order rows correspond to the Header field.
Format the basket file as shown below, where the top row is the Header row, and subsequent rows are
order rows. The Header Row includes field titles for each order value. The Order Row includes order
values that correspond with the appropriate Header Row field title for that order type.
Field 1

Field 2

Field 3

Field 4

Field 5

Field 6

value

value

value

value

value

value

value

value

value

value

value

value

value

value

value

value

Field 7

Field 8
value

value

value

value

value

For example:
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Notes about creating basket files:
For derivatives, if you use the format YYYYMM, we understand you are using the last trading day. If
you use the format YYYYMM we understand you are identifying the contract month. Both formats are
accepted in column E LastTradingDayorContractMonth.
Valid Header Row fields include all TWS fields. For a starter list of some basic fields, see the Basket
Fields topic.
Child values in the order row fields must match the fields in the parent Header Row in content. For
example, if your Header Row field is Symbol and you enter the value STK in that field of the order row,
your file will not be readable.
Basket files created in a text editor must be saved as a .csv (preferred) or .bsk file.
Although not recommended for new files, the .bsk file extension is still supported in the new basket layout.
For basket files created in a text editor, do not leave a space between a value and its comma, or TWS
will not be able to read the file.
If you create your basket file in Excel, enter only one value (or no value) per cell and DO NOT use commas.
Save your Excel basket file as a .csv file.
Fields in the Header Row need not be in any specific order as long as they have a corresponding correct value in the order row field.
If the order does not require a field value, that field can be left blank.
The major differences between the original and improved basket file formats include:
Old Basket File

New Basket File

Old version supported only limited

New version supports all TWS fields.

number of pre-defined fields.
Old version required you to enter

New version does not require any specific order

order values in a specific sequence.

sequence for fields.

Old version required only order

New version requires a header row with order-

values (since the "header" fields

specific field titles. Use multiple header rows in a

were hard-coded into TWS).

single basket for order types that require
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different field values.

Old version required blank

New version requires an exact one-to-one

placeholders for values that were

relationship between a header field and an order

not required.

value; you cannot leave an order field blank if
there is a header field defined.

Old version was saved as .bsk

New version uses .csv (generic) file extension.

(TWS-specific) file.

Basket Fields
The table below lists many of the fields and values you can specify in your basket order. BasketTrader
recognizes all fields supported in TWS.
Some Basket File Header Fields/Order Values
Header Field

Order Values

Symbol

e.g. IBM, AMZN

SecType

The security type including stk, opt, fut, fop, war, cash, fund,
efp, bag*
*Use the bag security type for spreads and combination
orders.

Last Trading Day

YYYYMM
e.g. 201510 (for last trading day in Oct. 2015 )

Strike

e.g. 42.5 or 37.0

Right

P or C

Currency

e.g. USD

Exchange

Any valid destination, e.g. Smart, or NYSE or PHLX or
VWAP or IBEFP.

TWS Guide

240

Chapter 1

Basket Fields

Note: To clarify any ambiguity for Smart routed contracts,
include the primary exchange along with Smart for the
destination, for example: Smart/NYSE.
For Jefferies and CSFB algos, enter JEFFALGO or
CSFBALGO as the Exchange and use the Algo Strategy
field to enter the algo, i.e. VWAP or seek.
Header Field

Order Values

Action

BUY or SELL

Quantity

e.g. 100 or 1

OrderType

As defined in TWS Type field, e.g. LMT, REL, VWAP, STP
LMT.

LmtPrice

e.g. 96.47 or 96
For EFPs, use a decimal number for the raw price, or a
percent value followed by A or C to designate Annualized or
Compounded rate, for example 5.200%A.

AuxPrice

e.g. .05 or 1.25 or 2

PercentOffset

Any decimal value between 0 and 1, e.g. .05

BasketTag

Any unique string of alpha or numeric characters used to
identify the basket order. This tag appears in the Order
Reference field of the Trade report.

Time in Force Fields
Header Field

Order Values

TimeInForce

e.g. day, gtc, gtd, ioc, fok, opg, auc

GoodTilDate

YYYYMMDD hh:mm:ss [zzz] where zzz is an optional time
zone. If you do not designate a time zone, TWS uses the
time zone from which the order originated.
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YYYYMMDD hh:mm:ss [zzz] where zzz is an optional time
zone. If you do not designate a time zone, TWS uses the
time zone from which the order originated.

Advisor Fields
Header Field

Order Values

Account

Existing account number.

Group

Existing Account Group name.

Method

Allocation Method, valid if a Group is named.
• PctChange
• AvailableEquity
• NetLiq
• EqualQuantity
• PctOfPortfolio

Percent

Use if Method = PctChange.

Profile

Existing Allocation Profile name.

Non-Cleared Fields
Header Field

Order Values

Account

Account number.

OpenClose

e.g. open, close

ShortLocation

MPID of third party

ShortSale

-1 (cust. has shares)
-2 (shares are with 3rd party)

Clearing

Identify your clearing choice.

ClearingAccount

Identity of the true beneficiary of the order.
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Volatility Fields
Header Field

Order Values

ReferencePriceType

A (average of best bid/ask) or B (NBB when buying a call or
selling a put; NBO when selling a call or buying a put)

HedgeOrderType

Lmt, Mkt or Rel

HedgeAuxPrice

Use to set the price if HedgeOrderType is used.

StockRangeLower

Low stock price of the range used to cancel the order if the
underlying price falls below.

StockRangeUpper

High stock price of the range used to cancel the order if the
underlying price goes above.

ContinuousUpdate

True. If you don't want to use continuous update do not
include the field in the header row.

Miscellaneous Fields
Header Field

Order Values

Algo Strategy

Vwap, Twap, etc.
To use Jefferies or CSFB algo, you must enter the
appropriate Exchange.

Algo maxPctVol

Max percent of volume for option algo.

Algo riskAversion

Get done, Aggressive, Neutral, Passive

Algo

True or False

forceCompletion
Algo NoTakeLiq

True or False. Do not take liquidity. Valid for IB Algos

Algo

True or False. Let the IB Algo run past the close.

AllowPastEndTime
Algo Speedup
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approaches the limit price.
DiscretionaryAmt

Price off the limit price to create Discretionary order.

DisplaySize

Defines the quantity of the order to be made public, creates
an Iceberg order.

OutsideRth

True to allow order to trigger or fill outside regular trading
hours.

BlockOrder

True

SweepToFill

True

Hidden

True

AllOrNone

True

Minimum Quantity

Number for minimum acceptable fill quantity for order to
execute.

OcaGroup

Value that identifies the order as part of a group.

BookTrader
Create an order at any price, including the best bid and ask, with a single click in the BookTrader price
ladder.
To use the BookTrader to manage blotter orders, right-click a blotter ticket and select Trading Tools and
then select BookTrader.
Open BookTrader

245

Trade with BookTrader

247

BookTrader Quantity Multipliers

249

BookTrader Order Handling

250

BookTrader Hotkeys

253
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BookTrader Colors

258

BookTrader Buttons

261

Open BookTrader
Create an order at any price, including the best bid and ask, with a single click in the BookTrader price
ladder. BookTrader displays as a separate window for whichever contract you select. It shows a series of
prices above and below the best bid and ask in the price ladder.
To open BookTrader
1. Select a contract on the trading page.
2. Right click and select Trading Tools, then select BookTrader.
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Orders transmitted from BookTrader are displayed on the Pending page and in the Orders panel of the
BookTrader.
NOTES:
The number of deep book data windows that you can display at one time (including BookTrader, ISW
and Market Depth) is equal to 1 for every 100 allowed lines of market data, with a minimum of three
and a maximum of 30. Market data allowance is based on commissions, available equity and other criteria. So a client with the minimum allowance of 100 lines of market data will be able to open 3 deep
book windows. A client with an allowance of 500 lines of market data will be able to open 5 unique deep
book windows.
For details on how market data allowances are calculated, see the Market Data and News overview
page on the IB website.
When subscription deep book data is at its window limit, additional windows will display aggregated top
level data, and the Deep Button panel will be hidden.
By default, BookTrader uses specific colors to convey information. You can customize these colors by
clicking the Configure button on the toolbar, and then selecting BookTrader Colors.
The current Cumulative Bid and Ask sizes are displayed at the top of the Bid Size and Ask Size
columns. To turn this feature off, use the Configure > Settings page.
When the inside market (or last trade price) moves outside the display area, the ladder will automatically re-center on the inside market (or last trade price). When the user is scrolling the ladder using
either the Up/Down arrow keys or the scrollbars, and the inside market (or last trade price) falls outside
of the display area, auto-recentering will occur five seconds after the user has completed scrolling. This
five-second time period is counted down visually using an optional animated progress bar which is configurable in the Re-center panel of the BookTrader Settings page.
By default, clicking in any size field initiates an order. If the order hasn't filled and you click another size,
the current unexecuted order is canceled and replaced with the new order. You can modify the way
multiple same-side orders are handled from the Settings page in BookTrader configuration.
You can open a blank BookTrader window by clicking the BookTrader icon on the trading toolbar. Use
the Underlying field to initiate contract selection.
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Trade with BookTrader
To trade with BookTrader, click the Bid Size or Ask Size at a certain price level in the price ladder. The first
time you submit an order, you will be asked to confirm the order parameters. In this box you have the option
not to show the confirmation box again, and if you elect this option your orders will transmit instantaneously
from that point forward.
Default mouse actions are described below. You can modify the default settings that control how orders
are handled using the Settings page in BookTrader configuration.
By default, the option to Use context cursors in armed mode is activated on the BookTrader Settings
configuration page. This feature displays helpful order-related information when you hold your cursor over
the Bid Size or Ask Size field in the price ladder.

To create a SELL Limit order in BookTrader
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In the price ladder, click the Ask Size at the desired price level.
A limit order is created at the selected price level. You can manage the transmitted order from the Orders
panel at the top of the price ladder.
To create a BUY Limit order in BookTrader
In the price ladder, click the Bid Size at the desired price level.
A limit order is created at the selected price level. You can manage the transmitted order from the Orders
panel at the top of the price ladder.
Use the BookTrader Quantity Multiples to create a series of quick-click buttons at different size multiples of
the default order quantity.
BookTrader Default Click Actions
The bullets below define the mouse click actions based on where you click:
Click on any Bid size to create a Buy Limit order at the selected price.
Click on any Ask size to create a Sell Limit order at the selected price.
Right-click on any Bid size to create a Buy Stop order.
Right-click on any Ask size to create a Sell Stop order.
Hold the Alt key and click on any Bid or Ask size to create a Bracket order.
Note: Note: The default click actions do not apply IF you have selected one of the BookTrader
Order Type Select buttons.
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For details on all system-configured BookTrader shortcuts, open the BookTrader Hotkeys window in
Global Configuration.
Default order information comes from the active order presets for the contract or instrument. For
information on using presets, see the Configure Order Defaults and Presets topic.

BookTrader Quantity Multipliers
To help speed order placement, you can define size multipliers in the order Preset that will create multiples
of the default order size and display them as quick-click order buttons in the BookTrader price ladder.
To set up BookTrader multipliers, use the Timing and Size section of the Order Presets. You can quickly
access this page by clicking the Configure wrench at the bottom right of the BookTrader Configure menu.
Activate the feature within BookTrader by selecting Display size multiple in Price Ladder from the
BookTrader Configure menu.
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The size multiple creates and submits instantaneous orders in the amounts specified x lot size. In the above
image for a stock, clicking the "6" multiple will create an order for 600 shares (6 x 100).

BookTrader Order Handling
Use the Configure>Settings area in BookTrader to change the way orders are handled and how the
order status is displayed. For details see the Configure BookTrader topic.
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When you select Show separate status column for each order in the Price Ladder Status Column area
of the Settings configuration page, BookTrader works in Advanced Mode. This enables several key
features:
First, it allows you to control BookTrader using only your keyboard. The mouse will still work to navigate, but for users who don't want to take the time to move from the keyboard to the mouse and back
again, advanced mode gives you 100% keyboard control.
Second, when you create an order, a new Order column is created in which all parts of the order (parent and child orders) are visible and can be modified. The new Order column appears to the right of the
price column for SELL orders (which you initiate by clicking in the Ask Size field) and to the left of the
price column for BUY orders (which you initiate by clicking in the Bid Size field).
Third, the order type select buttons become available for activation.
Note: You can click in the Order column to create child orders that belong to the parent order in the
Order column.
For example, if you create a buy Limit order, and then select the Target Limit order type button,
when you click at a different price level in the Order column (rather than in the Size column) the
target limit order is created as a child of the original limit order. If you click the Ask Size or Bid Size
column, a new Order column is created with another order.
Each new Order column may contain up to 4 elements:
The parent order (LMT)
The stop order (STP)
The stop limit (SLMT)
The target limit order (TLMT) - this is the limit order created as part of a bracket order, or a stand-alone
opposite-side limit order.
There are three ways to modify the price of an order; via the keyboard, by dragging with the mouse, or by
using the mouse click.
To modify order price via the keyboard
1. Tab through the application until you are in the Price Ladder.
2. Use the up/down arrows to highlight the order line in the price ladder.
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3. Use the left/right arrow keys to navigate to the order you want to modify.
4. Depress the Shift key to grab the order, and use the up/down arrow keys to move the order to a new
price level.
5. Release the Shift key to transmit the new order.
To move parent and child orders together, for example a bracket or stop limit order, depress and hold the
Alt key instead of the Shift key.
To modify order price by dragging with the mouse
1. Hold the mouse over the order until it becomes a two-headed arrow.
2. Click the order or suborder and drag it to a new price level.
3. Release the mouse key to create the order.
To move parent and child orders together, for example a bracket or stop limit order, press and hold the Alt
key while you click and drag.
To modify order price with a mouse click
1. Click the order and press and hold the Shift key.
2. Click in the desired price level and release the Shift key to create the order.
To move parent and child orders together, for example a bracket or stop limit order, press and hold the Alt
key instead of the Shift key in 1) above.
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The size of the order can be modified in the Order Confirmation box, or by clicking in the row header and
entering a new quantity as shown above.
Suborders can be canceled by right clicking on them (default) or using a hotkey. The bracket can be can
canceled by clicking the C on the row header.

BookTrader Hotkeys
This topic discusses the hotkeys that are specific to BookTrader or that have customizable options specific
to BookTrader.
For information on hotkeys that appear in the BookTrader hotkeys box but are available to all TWS
windows, see the general Hotkeys topic.
Hotkey Action

Description

BookTrader
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This hotkey will cancel an order in the Price Ladder.

Order
Decrease

Set a left or right mouse-click event for a specific field that will decrease

BookTrader

the order size of any BookTrader order by whatever number of ticks you

Order Size

define.

Increase

Set a left or right mouse-click event for a specific field that will increase

BookTrader

the order size of any BookTrader order by whatever number of ticks you

Order Size

define.

Re-center

Set a hotkey to recenter the focus to either the last traded price, or the
midpoint bid/ask price. Set the re-center focus using the Settings page
in the BookTrader configuration area.

Create Orders
Add Auto

Attaches an opposite-side stop order to the selected order.

Stop Order
Add Trailing

Attaches an opposite-side trailing stop order to the selected order.

Stop Order
Attach

Attaches a pair of orders (a limit and a stop order) to bracket the

Bracket

selected order.

Orders
Buy

Creates a buy order for the selected asset.

Buy or Sell

Create a hotkey to buy or sell a specific product with it's own default

Specific

order type, limit price, stop offset, time in force. etc. Use the Customize

Product

tab of the Configure Hotkey box to set product-specific details.
If you select BookTrader Price for any of the price configurations, you
will only be able to set a mouse-click shortcut since using the
BookTrader Price requires you to click on a price in the price ladder.

Close Position

Creates an opposite-side order to close out the position on the selected
contract.
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Reverse

Creates an opposite-side order to reverse the position on the selected

Position

contract. By default you need to transmit the order manually, but you
can elected to have this hotkey transmit reverse position orders
instantaneously by checking the feature in the Customize area of the
Configure Hotkey box.

Sell

Creates a sell order for the selected asset.

Modify/Transmit Orders
Change Order

Changes the order type of the selected order to a market order.

to Market
Decrease

Decreases the order price or order quantity by a specified value.

Price or Size
Increase Price

Increases the order price or order quantity by a specified value.

or Size
Modify Order

Displays the Type dropdown list to let you select a different order type

Type

for the active order.

Modify Time-

Displays the Time in Force dropdown list to let you select a different

in-Force

Time in Force for the active order.

Order Ticket

Opens the Order Ticket. If you've highlighted a ticker, the order ticket will
be populated with that product.

Transmit

Transmits the selected order.

Order
Update Limit

Updates the limit price of the active, unexecuted order to reflect the

Prices

price/offset you define on the Customize page of the Configure
Hotkey box.

Cancel Orders
Cancel All

Cancels all orders on all pages in TWS.

Orders
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Cancels all orders associated with a specific asset.

Contract's
Orders
Cleanup

Removes orders from the page. Use the customize area of the

orders

configure Hotkey box to define whether to remove cancelled, filled
and/or untransmitted (including deactivated) orders from either the
active pages or all pages.

Deactivate

A deactivated order is cancelled but remains on the page ready to be
transmitted.

Delete

This hotkey can be configured to either delete rows, or delete and

Rows/Cancel

cancel orders.

Orders
Tools
Add to

Used to add a contract to the Rebalance window. This hotkey does not

Rebalance

open, close or adjust any positions.

Window
Arbitrage

Opens the Arbitrage Meter for the active index market data line.

Meter
Integrated

Opens the ISW.

Stock Window
Show

Opens the FX Trader module.

FXTrader
Show Market

Opens the Market Depth module.

Depth
Show

Opens the OptionTrader.

OptionTrader
Show

Opens the portfolio Rebalance window.

Rebalance

TWS Guide

256

Chapter 1

BookTrader Hotkeys

Window
Show

Opens the SpreadTrader.

SpreadTrader
Realtime Activity Monitoring
Alarms

Opens the Alarm Settings box for the active contract.

View Alerts

Opens the Alerts window where you can view, edit or create an alert.

Analysis
Model

Opens the Model Navigator window.

Navigator
Show

Opens a Reuters Fundamentals page for the contract.

Fundamentals
Show IB Risk

Opens the IB Risk NavigatorSM, our real-time price/risk analytics tool.

NavigatorSM
Show Option

Opens the Option Analytics with focus on the selected options contract.

Analytics
Show real-

When you have a contract selected, this opens the New Chart window

time charts

where you can set parameters for the active contract to create a realtime chart.

Miscellaneous
Clear Log

Clears the Log panel.

Configure

Opens the Presets configuration page for the active strategy.

Order Presets
Help Chat

Opens the customer service Chat area of the Account Management
screen.

Minimize all

Minimizes all open windows and puts them on the bottom of the status

windows

bar.
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Msg Center

Opens the customer service message center.

Request

Logs you into the Customer Service area of the Account Management

Trade

screen.

Cancellation
Search TWS

Displays the Search field which you can use to find contract and
application information.

Show

Displays the Description box for the selected contract.

Description
Show Details

Displays contract details for the selected contract.

Show

For the selected contract, displays the Earnings estimate.

Earnings
Estimate
Show

For the selected contract, shows the account number and the current

Positions

position.

View Account

Opens the Account window.

View Trades

Opens the Trades window.

BookTrader Colors
BookTrader displays a lot of information in a small space using colors and numbers.
Market Data Colors
The market data colors display after BookTrader is armed but before any order is transmitted.
The Bid Size column shows marketable bid prices in yellow. Values in this column represent the size
of an order at the specific price, and help show market depth.
The Ask Size column shows marketable ask prices in green. When a size appears in an ask size field,
this indicates the current best ask.
The Status field remains gray until you submit an order.
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Price Field - Background Colors
The current best bid price is shown by a Yellow background, with the size next to it in the Bid Size
field.
The current best ask price is shown by a Green background, with the size next to it in the Ask Size
field
The Last transaction is highlighted by a Slate Blue background.
The High price is highlighted by a Bright Blue background.
The Low price is highlight by a Red background.
The Average Cost (including commissions) is indicated by a highlight across the entire row. You'll
only see this if you hold a position in the active contract.

BookTrader Colors
Column

Possible Color

Notes

Name
Status

Once you transmit an order, the status colors change. See Order
Status Colors table below.

Bid Size

Indicates the size of the current best bid.

Indicates that a limit order has been transmitted (by clicking in the
field).
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Indicates a stop order has been transmitted (by right-clicking in
the field).

Price

No color

One in a range of prices displayed for the contract.
The current best bid price.

The current best ask price.

The price at which the last order executed, and the size of the
order.

The current high price.

The current low price.
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Indicates the size of the current best ask.

Indicates that a limit order has been transmitted (by clicking in the
field).

Indicates a stop order has been transmitted (by right-clicking in
the field).

BookTrader Buttons
Order Type Select buttons

When you configure the Price Ladder Status Column to Show separate status column for each
order from the Settings configuration page, the Order type select buttons function becomes available.

These buttons override the default mouse click functions of BookTrader to create only the order type
selected. For example, if you click the LMT order type select button, any mouse click you perform in the
price ladder, even a right-click, creates a limit order.
To release the order type function and return to the default click actions, click None.
Basic Buttons panel

The BookTrader toolbar also includes a basic buttons panel.
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Cancel All - cancels all orders on the active BookTrader.
Clear Log - clears all order information from the white log area just above the buttons.
Re-center- click to keep the best bid/ask price or last traded price always visible in the center of the
BookTrader screen. Use the Configure menu to elect to have the ladder recenter around the midpoint
of the bid/ask, or the last price.
Configure- opens the Configuration dialog box.
Hotkey Details - displays a list of all current hotkeys for BookTrader.
Default size - displays the default order size based on the Preset for the instrument, and allows you to
change the default order size for BookTrader orders without re-configuring the Preset.
Deep Book buttons

Use the Deep Book Buttons to filter out market data from the price ladder. De-select a button to filter out
that data.

The Others button includes data from exchanges that don’t offer deep data; Level I data from deep
exchanges you have elected to filter out, and Level I data for exchanges that offer deep data but to which
you do not subscribe. Hold your mouse over the button to see the exchange’s data included.

ChartTrader
Use the ChartTrader to create and send orders directly from within any real-time chart.
To use the ChartTrader to manage blotter orders, right-click a blotter ticket and select Trading Tools and
then select ChartTrader.
Open ChartTrader
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Create and Transmit Chart Orders

264

Open ChartTrader
You can trade directly from a real-time chart using ChartTrader, which you display from the ChartTrader
menu from within a chart. Send instantaneous orders by clicking directly in the chart, or create and modify
an order from the Quote panel.

To open ChartTrader
1. First open a real-time chart by selecting a contract on the trading screen and using the right-click
menu to select Charts, then New Chart.
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2. From the View menu, select ChartTrader.
3. The ChartTrader is activated and displays the Orders, Log, Trades and Portfolio panels.

Create and Transmit Chart Orders
ChartTrader is designed to instantaneously transmit orders created with a single click within the chart.
Order parameters are picked up from the active order preset. Button actions and order defaults can be set
from the Chart configuration page

Instantaneously transmit an order
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1. Open the chart Configuration page, and choose Buttons.
2. Select a button and click Edit.
3. Check the red Transmit order instantaneously checkbox and click OK.
4. On the button panel, click the button you set up for instantaneous transmit to arm your cursor.
Any buttons set for instantaneous transmit will have an asterisk (*) next to their name.
5. Move your cursor into the chart and position the broken blue (for Buy) or red (for Sell) line at the
order price you want. Note that your exact price is displayed along the price axis.
6. Click to transmit an order. Your order appears in the Quote panel, and the broken line becomes
solid.
You can also create orders that do not transmit instantaneously.
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Create a Non-Instantaneous Order
From the Quote panel, click Bid (sell) or Ask (buy) to create an order in the Orders panel.
Note that you can also configure the ChartTrader buttons to create a modifiable order by unchecking the
red Transmit order instantaneously checkbox on the button configuration page.

ComboTrader
Create combination orders that include options, stock and futures legs. Note that only US option-stock and
option-option combo orders are guaranteed by IB to fill.
About Combination Orders

266

Create a Combination Order

270

Using the ComboTrader

274

Advanced Combo Routing

278

Transmit a Combination Order

281

Notes on Combination Orders

282

About Combination Orders
Create combination orders that include options, stock and futures legs (stock legs can be included if the
order is routed through SmartRouting). Although a combination/spread order is constructed of separate
legs, it is executed as a single transaction if it is routed directly to an exchange. For combination orders that
are SmartRouted, each leg may be executed separately to ensure best execution. You can also create a
futures EFP (Exchange of Futures for Physical) spread.
For details on using the VOL order type for combination orders, see the list of criteria in the Volatility
Trading topic.
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You can create a unique combination by manually defining an order leg by leg on the Pair of Leg-by-Leg
tab, or create an order or group of orders with a named strategy using a template, on either the Multiple or
Strategy tab. You can find a template to construct the following named combination strategies:
Box - An order to simultaneously purchase and sell two synthetics in identical numbers at different
strike prices.
For example: Buy 1 April02 95 call, Sell 1 April02 95 put, Sell 1 April02 100 call, Buy 1 April02 100 put.
Butterfly - An order to simultaneously purchase an option with one strike price, purchase an option
with a second strike price, and sell two options with a third strike price that is midway between the
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prices of the first two options. The ratio for a butterfly is always 1 x 2 x 1.
For example: Buy 10 March02 95 calls, Sell 20 March02 100 calls, Buy 10 March02 105 calls.
Buy Write - An order to simultaneously purchase (sell) a stock and sell (purchase) a call option of the
same underlying.
Purchase a Buy Write: Sell 1 XYZ April06 95 call, Buy 100 shares XYZ
Sell a Buy Write: Buy 1 XYZ April06 95 call, Sell 100 shares XYZ
Calendar spread - An order to simultaneously purchase and sell options with different expiration
dates, where both have the same underlying, right (call or put) and strike price. This spread is sometimes referred to as a time spread. A calendar spread whose options have different expiration dates
and different strike prices is sometimes referred to as a diagonal spread.
For example: Buy 1 June15 100 call, Sell 1 March15 100 call.
Collar - An order to simultaneously buy (or sell) a put option and sell (or purchase) a call option in
identical numbers where both have the same underlying and expiration date, but the call generally has
a higher strike price, and buy (or sell) the underlying stock.
Purchase a collar: Sell 1 XYZ APR 17 '14 190 CALL, Buy 1 XYZ APR 17 '14 185 PUT, Buy 100 share
of XYX
Sell a collar: Buy 1 XYZ APR 17 '14 190 CALL, Sell 1 XYZ APR 17 '14 185 PUT, Sell 100 share of
XYX
Conversion - An order to simultaneously sell (or purchase) a call option and purchase (or sell) a put
option in identical numbers where both have the same underlying, expiration date and strike price, and
purchase stock of the same underlying.
Purchase a conversion: Sell 1 XYZ April04 75 call, Buy 1 XYZ April04 75 put, Buy 100 shares XYZ
Sell a conversion: Buy 1 XYZ April04 75 call, Sell 1 XYZ April04 75 put, Sell 100 shares XYZ
Delta Neutral - An order to simultaneously buy (or sell) options contracts and sell (or buy) a delta
amount of the underlying. The quoted price is calculated as follows: effectiveOptionPrice = optionPrice
+ delta x (inputStockPrice - stockPrice).
Diagonal spread - An order to simultaneously purchase and sell options with different expiration
dates and different strike prices, where both have the same underlying and right (call or put).
For example: Buy 1 June03 100 call, Sell 1 Sept03 105 call.
Iron Condor - An order to simultaneously purchase an out-of-the-money put bull spread, and sell an
out-of-the-money call bear spread, where all legs have the same expiry.
Purchase an iron condor: Buy 1 XYX JAN08 25.0 PUT, Sell 1 XYZ JAN08 27.5 PUT, Sell 1 JAN08
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30.0 Call, Buy 1 JAN08 32.5 Call.
Sell an iron condor: Sell 1 XYX JAN08 25.0 PUT, Buy 1 XYZ JAN08 27.5 PUT, Buy 1 JAN08 30.0
Call, Sell 1 JAN08 32.5 Call.
Reversal- An order to simultaneously purchase (or sell) a call option and sell (or purchase) a put
option in identical numbers where both have the same underlying, expiration date and strike price, and
sell stock of the same underlying.
Purchase a reversal: Buy 1 XYZ April04 75 call, Sell 1 XYZ April04 75 put, Sell 100 shares XYZ
Sell a reversal: Sell 1 XYZ April04 75 call, Buy 1 XYZ April04 75 put, Buy 100 shares XYZ
Risk Reversal- An order to simultaneously purchase (or sell) a put option and sell (or purchase) a call
option in identical numbers where both have the same underlying and expiration date, but the call generally has a higher strike price.
Purchase a risk reversal: Buy 1 XYZ April04 75 put, Sell 1 XYZ April04 95 call
Sell a risk reversal: Sell 1 XYZ April04 75 put, Buy 1 XYZ April04 95 call
SSF/OPT - An order to simultaneously buy (or sell) one contract of a single stock future (SSF) and buy
(or sell) a stock option of the same underlying.
For example: Sell 1 Oct06 60.0 call, Sell 1 Aug06 SSF.
Straddle - An order to simultaneously purchase (or sell) a call and a put in identical numbers, where
both have the same underlying, expiration date and strike price.
For example: Sell 1 Dec02 90 call, Sell 1 Dec02 90 put.
Strangle - An order to simultaneously purchase a call and a put with different strike prices, where both
have the same underlying and expiration date. In the case where both the call and the put are out of the
money, this order is referred to as an inside strangle.
For example: Buy 1 June02 95 put, Buy 1 June02 105 call.
Stk/Opt - An order to simultaneously purchase (or sell) one stock contract and purchase (or sell) one
options contract.
For example: Sell 1 Jan07 55.0 put, Sell 100 shares of the underlying.
Synthetic - An order to simultaneously purchase a call and sell a put in identical numbers (or sell a call
and purchase a put in identical numbers), where both have the same underlying, expiration date and
strike price.
Purchase a synthetic: Buy 1 April02 100 call, Sell 1 April02 100 put.
Sell a synthetic: Sell 1 April02 100 call, Buy 1 April02 100 put.
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Synthetic Put - An order to simultaneously purchase (or sell) a call option and sell (or purchase) stock
where both have the same underlying.
Purchase a synthetic put: Buy 1 XYZ April03 75 call, Sell 100 shares XYZ
Sell a synthetic put: Sell 1 XYZ April03 75 call, Buy 100 shares XYZ.
Synthetic Call - An order to simultaneously purchase (or sell) a put option and purchase (or sell) stock
where both have the same underlying.
Purchase a synthetic call: Buy 1 XYZ April03 75 put, Buy 100 shares XYZ
Sell a synthetic put: Sell 1 XYZ April03 75 put, Sell 100 shares XYZ.
Vertical spread - An order to simultaneously purchase and sell options at different strike prices,
where both have the same underlying, right (call or put) and expiration date. This spread is sometimes
referred to as a price spread.
Call vertical spread example: Buy 1 June02 100 call, Sell 1 June02 105 call.
Put vertical spread example: Buy 1 March02 105 put, Sell 1 March02 95 put
For more information on combination orders and margin requirements for combination orders, see U.S.
Equity Options Margin Requirements on the IB website.

Create a Combination Order
You can create any kind of combination spread order using the Combination Composition box,
including multiple leg combos, futures spreads and EFPs, and inter-market Smart combos.
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To create a combo order
1. Enter an underlying on a blank line and select Combinations, then choose from the available combo
selection types, including Smart option combos, Futures Spreads and EFPs.
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2. From the Pair or Leg-by-Leg tab, define each leg.
3. After you have added all desired legs click OK, and the spread appears as a market data line on your
quote monitor.
The implied price is calculated based on the underlying price of each leg, and changes with variations in the
price of each underlying. Based on the implied price, SmartRouting will route each leg of the order
separately to get the best price.
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Note: To see individual leg prices for a combination or spread order, open the Execution reports
window by clicking the Trades icon on the Trading Toolbar. Double-click the desired combination
execution report line in the Execution window (or right-click on the line and select Show Legs) to
open the Execution Window for Legs.
To create an EFP combo
1. Enter an underlying on a blank line and select Combinations, then select EFPs.
2. Click the Single tab at the top of Combo Selection box.

3. Choose Futures as the leg type, and Future EFP as the strategy.
4. Select the last trading day on the futures leg and click OK.
Note: EFP combos created using the template are Smart-routed.
To create a combination strategy
1. Right-click on a blank line and select Generic Combo, or create a market data line with the instrument type Comb.
2. In the Leg Query section, enter the underlying symbol for the first leg of the order.
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3. Use the Combo Template tab to select a strategy.
4. Select data for all legs of the order and click OK. The combination order strategy appears on your
trading screen as a market data line.
Guaranteed and Non-Guaranteed Combo Orders

IB supports both guaranteed (where executions are guaranteed to be delivered simultaneously for each
leg and in proportion to the leg ratio) and non-guaranteed combo orders. To understand the differences
between guaranteed and non-guaranteed combination orders, please see the knowledgebase article.
Notes on using Futures legs
Intermarket combos that contain futures legs are supported for contracts on the following exchanges:
Globex, One Chicago, CFE, EurexUS.
Only US contracts are supported for Smart combos.

Using the ComboTrader
ComboTrader provides three tabbed interfaces to help you create multi-legged spreads for futures and
options.
Multiple combos

Use the Multiple tab to create a group of individual combination orders on the same underlying at the
same time. For certain strategies including Diagonals, boxes, Strangles, Risk Reversals, and Vertical
Spreads you can filter by Point Spread.

TWS Guide

274

Chapter 1

Strategy combo

Strategy combo

Use the Strategy tab to select a recognized combination order and define the necessary parameters. Note
that for exchanges that list both American and European style options, a Trading Class field presents a
dropdown list of available classes.
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Strategy combo

Description

Name
Underlying

Enter the underlying symbol.

Type

Select the instrument type for the strategy. Choose Options or Futures.

Strategy

Combination strategies are listed based on the Leg Type you selected. For
descriptions of all combination strategies, see the Combination Orders topic.
Use the Help button for strategy descriptions.

Multiplier

Select the contract multiplier.

Worksheet

Select Sell Combo or Buy Combo in the graph drop-down to see what the
combination order looks like.
The worksheet categories display drop-down list boxes each time you need
to make a selection. Move through the worksheet and select choices as
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needed.

Reset

Click Reset to start over, either by selecting another strategy or editing the
legs of the chosen strategy.

Request

Check to create a market data line for each leg of the order, to be displayed

market

on the trading screen.

data for
legs
Pair or Leg-by-Leg Combo
Use the Pair or Leg-by-Leg tab to create the combination one leg at a time.
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Advanced Combo Routing
Advanced combo routing (defined from the Basic tab of the Order Ticket) lets you control how each leg of
a complex combination order is handled. Define advanced combo routing for both guaranteed and nonguaranteed combination orders routed to Smart. Selections displayed are based on the combo
composition and order type.
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To use advanced combo routing
1. Create the Smart combination strategy.
2. From the combo line on the Quote Monitor, click the Bid or Ask price to create a (sell or buy) order.
3. Right-click the order line and select Modify then select Order Ticket.
Based on the combo composition and the Order Type, the Advanced Combo Routing selections are
displayed. You can monitor the progress of the combo order by holding your mouse over the Status field of
the order line.
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on selected Order Type):

Advanced Combo Routing Fields (available based on selected Order Type):

Field Name
Order Type

Description
Choose from the basic order types as well
as: Relative + Market, Limit + Market, Trailing Relative + Market and Trailing Limit +
Market.

Select leg to fill first

For orders that are being legged-in, the chance
exists that only the first leg of the combo will fill
and you will be left with one unexecuted leg. Use
this field to specify which leg is submitted and
potentially filled first. Use the dropdown list to pick.

Maximum leg-in combo size:

The order is submitted in pieces, or segments. This is the maximum size of each
segment.

Do not start next leg-in if

Specify whether or not the system should

previous leg-in did not finish:

attempt to fill the next segment before the
current segment fills.

Convert second leg order to These settings allow you to specify when (if
market order if...

ever) the second leg should be changed to
a market order to fill right away, in cases
where the first leg fills and the second leg
does not and ends up sitting as a non-marketable limit order at the exchange,

...or if the price backs off by... Provides a way to specify a stop-loss to fill
the unexecuted leg of a combo by changing
the leg to a market order if the price backs
off by the specified amount.
Discretionary Amt

In cases where one leg fills and the other
doesn't, the discretionary amount indicates
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Field Name

Description
how much you are willing to pay to fill the
combo.

Transmit a Combination Order
To create a combination order
Before you transmit a combination order, carefully review your order parameters on the order
management line, or from the Order Ticket window by clicking Accept.

1. From the market data line, click the "Ask" or "Bid" price for the combination order you want to create.
Click the Ask Price to create a Buy order.
Click the Bid Price to create a Sell order.
2. On the Order Management line, modify order parameters, if needed.
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Note on Pricing: If you buy a spread and you owe cash (debit spread), enter a positive limit price. If
you buy a spread and you receive cash (a credit spread), you must enter a negative limit price.
Conversely, if you sell a spread and receive cash, enter a positive limit price. If you sell a spread and
owe cash, you must enter a negative limit price.
For example, an April 20 xyz call shows a BID price of 6.60 and an ASK price of 6.70. An April 30
xyz call shows a BID price of 0.15 and an ASK price of 0.20.
If you buy a "debit" call vertical spread with the following legs:
Buy 1 OPT APR02 20.0 CALL (6.70)
Sell 1 OPT APR02 30.0 CAL L (0.15)
For this transaction you pay: 6.55 (a debit transaction)
If you buy a "credit" call vertical spread with the following legs:
Sell 1 OPT APR02 20.0 CALL (6.60)
Buy 1 OPT APR02 30.0 CALL (0.20)
For this transaction you receive 6.40 (a credit transaction; enter a negative limit price).
3. Transmit the order.

Notes on Combination Orders
This page contains notes and tips on creating and transmitting combination orders.
Use SmartRouting to execute legs separately to ensure you get the best price on all legs of your order.
Some exchanges that currently support native combination orders (which means they execute the legs
together as one transaction) include:
ISE
ONE
DTB (Euro)
Note on pricing: If you buy a spread and you owe cash (debit spread), enter a positive limit price. If
you buy a spread and you receive cash (a credit spread), you must enter a negative limit price.
Conversely, if you sell a spread and receive cash, enter a positive limit price. If you sell a spread and
owe cash, you must enter a negative limit price.
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For example, an April 20.0 xyz call shows a BID price of 6.60 and an ASK price of 6.70. An April 30 xyz call
shows a BID price of 0.15 and an ASK price of 0.20.
If you buy a "debit" call vertical spread with the following legs:
Buy 1 OPT APR02 20.0 CALL (6.70),
Sell 1 OPT APR02 30.0 CALL (0.15)
For this transaction you pay: 6.55 (a debit transaction)
If you invert the legs and buy a "credit" call vertical spread with the following legs:
Sell 1 OPT APR02 20.0 CALL (6.60)
Buy 1 OPT APR02 30.0 CALL (0.20)
For this transaction you receive 6.40 (a credit transaction, enter a negative price)
Before you transmit a combination order, carefully review the order parameters from the Order Management line.

EFPs
Enter Exchange for Physical (EFP) spreads.
Relevant EFPs

283

EFP Futures Spreads

285

Relevant EFPs
Introduction

Using an Exchange of Futures for Physical (EFP), which allows the swap of a long or short stock position
for a Single Stock Future (SSF) could help to reduce your trading costs. The Relevant EFPs Market
Scanner scans the US market and returns all EFPs relevant to you based on the stock and single stock
futures positions you currently hold. You can access this tool from the toolbar, or by selecting US EFPs as
the Instrument and Relevant EFPs as the Parameter in the Market Scanner page.
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For more details on how using EFPs could reduce your trading costs, see the EFPs Product Highlights.
To view Relevant EFPs
1. On the trading toolbar, click the Relevant EFPs icon.
The Relevant EFPs scanner page opens with all fields populated with the correct EFP selection.
2. Click Search if no values have been returned.
Note that this page is for display only. To trade one of these EFPs, click and hold, then drag it onto your
trading page, or right-click and select Edit then select Copy. Open a trading page and use the right-click
menu to select Edit then select Paste.
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EFP Futures Spreads
An EFP (Exchange for Physical) is a combination order to sell/buy stock and buy/sell an SSF (single stock
future).

To create an EFP in SpreadTrader
1. From the Trading Tools menu select SpreadTrader.
2. Enter a symbol in the underlying field and hit Enter.
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3. Select EFPs for xxx and then select the routing destination, either SMART, IBEFP or ONE.

The spread matrix at the bottom of the window is populated with a list of all single stock futures legs
on the left, and the stock across the top.
4. Click a bid or ask price at the intersection of two legs to create the EFP spread.
5. To transmit the order, click the "T" in the Status field of the Orders panel.
Note: Please note that smart-routed EFPs are not guaranteed.

FXTrader
Designed specifically for Forex traders, the customizable FXTrader window displays quote pairs with the
emphasis on the key price component.
The FXTrader Window
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The FXTrader Trading Cell

288

Using the FXTrader

289

The FXTrader Window
FXTrader displays a 3x3 grid of "trading cells" designed to complement the way an FXTrader operates,
with the standard elements of our order management modules (Orders, Log, Execution and Portfolio
pages) provided at the top. The page is completely customizable, allowing you to increase or decrease the
number of cells in the grid, invert a quote, change colors, and modify the way price and size is shown.
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To configure the FX Trader, click the Configure icon in the toolbar or in any trading cell.
For details on the many levels of configuration you can set for the FXTrader, see the FX Trader
Configuration topic.

The FXTrader Trading Cell
The trading cell in FXTrader includes many helpful features, including color coding to distinguish between
upward and downward price and size movement; a cancel icon to cancel all orders for the currency pair,
quick access to the FX Trader configuration windows, quick-click to view inverted quotes, a message line
to describe order details, a book icon with mouse-over information that displays when there is a price
improvement opportunity for small orders, optional display of position and P&L information, and access to
right-click TWS features from the Contract Label area.
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To open the FX Trader
1. Click the FXTrader icon on the Trading toolbar.

2. FXTrader displays populated with the most common FX pairs.

Using the FXTrader
When you select a trading cell, that currency pair populates the Quote Panel at the top of the window. You
can create an order using the traditional TWS method of clicking the Bid or Ask from the Quote Panel. You
can also create an order from within the trading cell.
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To create an order from the trading cell
1. Click the Bid to create an order to sell the base (and buy the quote). Click the Ask to create an order
to buy the base (and sell the quote).
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Cash Quantity Stock Orders
Now specify the cash amount you want to spend or receive for your stock orders using the Cash Quantity
feature. When you specify a cash value for your order, that value in conjunction with the instrument price
drives the number of shares purchased or sold. If the price moves, the number of shares is adjusted to
accommodate the entered cash value.

To create a cash quantity order
From the Quantity field (in the Mosaic Order Entry panel or Classic order line) click to display the Size
Wand.
Toggle from Shares to USD (or your base currency).
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Modify order parameters as needed and submit the order.
The approximate share equivalent for the specified cash quantity is displayed below the Mosaic QTY field.
This value may change if the price changes before the order is completely filled.
Available for stock orders only, all currencies and most order types.

Cash Quantity for Forex Orders
You can have the system calculate the order quantity for Forex orders based on a monetary value that you
specify.
To use this “Cash Quantity” feature, set up your currency pair order, then click the Quantity field (in the
Order Entry panel for Mosaic or on the order line in Classic). The default minimum quantity is display.
Toggle the quantity from the default currency to the alternate currency as needed. For example, if the forex
pair you’re trading is EUR.USD, the default currency is EUR and the quantity displayed is in euros. When
you toggle to the alternate currency (in this case USD) the value will default to the equivalent USD value
based on the current exchange rate. Modify the USD quantity as needed and submit the order.

Toggling between currencies only displays the equivalent values in both. It doesn't invert the currency pair.
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When you submit the order, the system will attempt to buy or sell a quantity based on the specified amount
you want to spend or receive.
Because the price may move before the order fills, we apply a “Cash Quantity Estimate Factor” when
calculating the order quantity. This factor, set at 25% by default, increases the calculated order quantity to
try to achieve the desired monetary outcome in cases where the price drops (for a buy order) or rises (for a
sell order) by allowing more units to be bought or sold. You can change the estimate factor in the Size
section of the Forex Preset in Global Configuration.

The Integrated Stock Window
Trade, see charts, market data and deep data all from a single integrated window.
Quote Panel

294

Book Data Panel

295

ISW Buttons Panel

297
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Order Entry Panel (OEP)

298

Auto Orders

299

ISW Order Entry Sub Panels

301

Quote Panel
The Quote Panel displays market data for the selected stock symbol. By default, the Quote Panel uses the
single-row view. You can use the toggle button to switch from single-row view to ticker view.
To hide the Quote panel, on the View menu uncheck Quote Panel.
Use the Switch View icon in the top left corner of the panel to toggle between single-row view and
ticker view.
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To add a symbol to the Quote Panel
1. Enter a symbol in the Underlying field and hit Enter.
2. Select a stock from the contract list.

Book Data Panel
The Book Data Panel displays both Level I and Level II subscription and non-subscription quotes on either
side of a real-time, configurable chart. Click a button to add data from a market center the book data panel.
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To add data, click a market center button. Bids are displayed to the left of the chart, asks to the right.
See your own order highlighted in the depth by checking Show pending orders in the book on the ISW
Configuration Settings page.

When you click a bid/ask price from the Book Data components, the price data is reflected in the Order
Entry Panel order line, from which you transmit orders.
Modify the chart parameters using the Chart menu. Select Chart Parameters to change the time
period, bar intervals and other data options.
If you elect to display the Others button, click it to include Level I data from market centers that don’t
offer Level II data, market centers to which you don’t hold Level II subscriptions, and subscribed
exchanges whose buttons are not currently selected. Show or hide the “Others” button from the Deep
Book Buttons section of the Settings page.
The number of deep book data windows that you can display at one time (including BookTrader, ISW
and Market Depth) is equal to 1 for every 100 allowed lines of market data, with a minimum of three
and a maximum of 30. Market data allowance is based on commissions, available equity and other criteria. So a client with the minimum allowance of 100 lines of market data will be able to open 3 deep
book windows. A client with an allowance of 500 lines of market data will be able to open 5 unique deep
book windows . For details on how market data allowances are calculated, see the Market Data and
News overview page on the IB website.
When subscription deep book data is at its window limit, additional windows will display aggregated top
level data, and the Deep Button panel will be hidden.
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ISW Buttons Panel
The ISW includes three Button panels which you can hide or display using the View menu. The Left panel
creates new order in the order line of the OEP, the Right panel provides single-click access to other TWS
order tools, and the lower panel is used to modify orders, both new and working, in the order line. All
buttons are configurable and can be armed for Instantaneous Transmit by clicking the Armed checkbox
and agreeing with the warning disclosure.

Note: Buttons names include an asterisk (*) when they are set to Instantaneously Transmit the
order when clicked. To remove this attribute, de-select the Armed checkbox in the button panel.
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Order Entry Panel (OEP)
Enter orders by clicking a price level in the Level II panels then using the BUY or SELL buttons to transmit.
Use the Order Entry Panel to:
Create and submit basic orders;
Modify a working order;
Apply order attributes such as hidden, discretionary, OCA;
Create and submit advanced orders such as algo, scale, adjustable and bracket.

To create an order in ISW
1. Click a price level in one of the Level II components.
2. Edit the order parameters using the dropdown boxes and text entry fields below the order line.
3. Click the BUY or SELL button to transmit the order.
To modify a working order
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1. Select the order you want to modify using the dropdown list on the order line.

2. Modify order parameters using the dropdown lists and text entry fields or the bump Buttons.
3. Click Rep to cancel and replace the current working order with the modified order.

Auto Orders
Use the Auto order in the Type field to have TWS select the order type based on the price values you enter.
This feature is a short-cut to save you the step of having to choose the order type first and then define the
price criteria.
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By default, the (Auto) order appears in the Type field. Click to view the current list of supported auto order
types from which TWS will choose. The chosen order type will display in the order description line. It is
important to note the following:
Only the order types listed under the (Auto) entry are eligible to be selected as an Auto order. All other
order types must be selected manually from the Type dropdown list.
The Auto order appears in the Type field only for NEW orders. Working orders will display the actual
order type in the Type field.
The Auto order type selection is made according to the rules as illustrated in the image below.
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ISW Order Entry Sub Panels
Use the sub-panels to create advanced orders and apply order attributes. Use the Destination list to select
an algo exchange and define an algo order.
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To use the sub-panels
1. Click the sub-panels drop down to display the list of available attributes and advanced order types.
Note that this menu is context-sensitive, so that only the order types that are valid for the order parameters
you have defined will be shown. For example, if your order type is Stop, the Scale sub-panel will not be
shown in the dropdown list for that order since the Scale attributes can only be applied to Limit and Relative
orders.
2. Check the order attributes you want to apply to open the sub-panel(s) for that order type.
3. Enter values for the selected order type.
To enter an algo order
1. From the DEST drop-down list, select an algo destination under the Algorithms section.
2. In the new algo-specific panel, enter algo parameters.
See the TWS Users’ Guide topics for details on setting up algo orders:
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IBAlgos
CSFB Algos
Jefferies Algos

Market Depth
View the alternative bids and offers away from the inside quote to help you better gauge market liquidity.
When using the Market Depth Trader for bonds, see the best bid and offer from away platforms (using
Total Price) along with the best bid and ask from the IB book.
To use Market Depth to manage blotter orders, right-click a blotter ticket and select Trading Tools and
then select Market Depth.
Market Depth Trader

303

Market Depth Trader for Bonds

305

Market Depth Buttons Panel

306

Create an Order

312

Market Depth Trader
The aggregated Market Depth window displays the alternative bids and offers away from the inside quote
to allow you to better gauge market liquidity. Create an order by clicking a price level in the Bid or Ask
column. Transmit orders from the Orders panel.
Add or remove Level II data using the Deep Book Buttons. The Others buttons displays Level I data from
exchanges that don’t offer deep data, for which you don’t have market data permissions, or for those to
which you subscribe but haven’t selected.
Modify and create custom buttons in the Buttons panel in Global Configuration.
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To create an order
Create an order by clicking the Price in the Bid column (for a sell) or the Ask Column (for a buy).
Use the Orders tab to modify and transmit the order.
NOTES

The number of deep book data windows that you can display at one time (including BookTrader, ISW
and Market Depth) is equal to 1 for every 100 allowed lines of market data, with a minimum of three
and a maximum of 60. Market data allowance is based on commissions, available equity and other criteria. So a client with the minimum allowance of 100 lines of market data will be able to open 3 deep
book windows. A client with an allowance of 500 lines of market data will be able to open 5 unique deep
book windows . For details on how market data allowances are calculated, see the Market Data and
News overview page on the IB website.
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When subscription deep book data is at its window limit, additional windows will display aggregated top
level data, and the Deep Button panel will be hidden.
We cannot guarantee that every price quoted for a particular security/commodity will be displayed in
the Market Depth window.
Cumulative size represents the total contract size available at a particular price or better.
Average Price is the average execution price received when transacting the cumulative contract size.
You receive multiple executions as your order goes through the order book. Executions will appear in
the Trades panel.
Use the Market Depth Trader for bond trading to view the minimum trade size for net bond prices and
calculate net bond prices based on your desired size.

Market Depth Trader for Bonds
Use the Market Depth trader to see the minimum trade size for net bond prices and calculate net bond
prices based on your desired size.

To take advantage of the Minimum Trade Size data and Quantity calculator, you need to configure bond
pricing to use Net pricing mode. The Market Depth Trader shows the Minimum Trade Size available for a
given price level and side in the market data. It also displays a Quantity field above the aggregated market
depth data. Enter a quantity at which you would like to see the net prices calculated. This information may
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help you to control execution costs by showing the market data in net price terms at the size you would like
to trade.
To open Market Depth Trader
From the Trading Tools menu, select Market Depth Trader.

Market Depth Buttons Panel
The buttons panel provides action buttons that allow you to:
Close Position - select an underlying in the quote panel, and click Close Position to have an opposite
side closing order automatically created in the Orders panel. Transmit the order or modify any order
parameters and then transmit.
Reverse Position - create an opposite side order with sufficient quantity to reverse your position from
long to short or short to long.
View Account - opens the Account Information window.
You can set the buttons to transmit the order instantaneously by arming the button panel. Buttons with
instantaneous transmit on will display an asterisk in their title.

To activate Instantaneous Transmit
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1. Check the Armed checkbox on the top right corner of the Buttons panel.
2. Read and agree to the disclosure message.
The asterisk in the button title indicates that these action buttons will instantaneously transmit an order
when used.
Create Market Depth Trader Custom Action Buttons

Increase trading speed by creating custom Market Depth Trader order buttons. Create buttons that are
available for all instruments, for a specific asset type, or even for a specific instrument. Buttons are
accessible from the Buttons: Set pick list in the Market Depth Trader Buttons panel.

To create custom buttons
From the Buttons panel in the Aggregated Market Depth window, click the wrench icon to open button
Configuration.
Elect to create an asset-type button set, a generic button set or an instrument-specific button set.
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Use custom button sets in Market Depth Trader by choosing from the Set dropdown.
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Create a Generic Button Set

Create a set of buttons that can be used across all instrument types.
Click Create Custom and enter a name, for example Custom Buttons. The new set is displayed in the
right pane and by default includes the Close Position, Reverse Position View account buttons.
Click Add Button to create a button for the set.
Select the action, and in the Button Appearance section optionally un-check Generate label to customize
the button label using the Button text field.
Click OK to add the button to the set.
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Easily Duplicate, Edit, Delete and rearrange buttons by holding your mouse over a button and using the
displayed menu. To reorder a button, click and hold the move icon and drag the button to its new location in
the list. Back in Market Depth Trader use the Button Set drop down to select the set and display custom
buttons for use.

Create an Asset-Type Specific "Auto" Button Set

Create a set of buttons that can be used for a specific asset type, for example stocks.
Click Create New Set for... and pick an asset type. The new set is created and by default includes the
Close Position, Reverse Position and View Account buttons.
Click Add Button to create a button for the set.
Select the action, and in the Button Appearance section optionally un-check Generate label to customize
the button label in the Button text field.
Click OK to add the button to the set.
Easily Duplicate, Edit, Delete and rearrange buttons by holding your mouse over a button and using the
displayed menu. To reorder buttons, click and hold the move icon and drag the button to its new location in
the list.
Use buttons in Market Depth Trader. Use the Button Set drop down to select Auto. If you have selected a
stock instrument, this asset-type set of buttons will automatically be displayed.
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Create an Instrument-Specific Button Set

Create a set of buttons that can be used for a specific instrument, for example AAPL stock.
Click Create New Set for... and select the asset type, for example Stocks. If you have already created a
button set for the asset type, select it.
Click Create Ticker-Specific and enter a symbol, for example AAPL. The new set is created and by
default includes the Close Position, Reverse Position and View Account buttons.
Click Add Button.
Select the action, and in the Button Appearance section optionally un-check Generate label to customize
the button label in the Button text field.
Click OK to add the button to the set.
Easily Duplicate, Edit, Delete and rearrange buttons by holding your mouse over a button and using the
displayed menu. To reorder a button, click and hold the move icon and drag the button to its new location in
the list.
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Use buttons in Market Depth Trader. Use the Button Set drop down to select Auto. If you have selected a
matching instrument, in this example AAPL stock, the instrument-specific set of buttons will automatically
be displayed.

Create an Order
Create orders from the Market Depth window by clicking the bid/ask at a specified price level. Be sure to
confirm the order size before transmitting a Market Depth order.
The order size is based on default settings associated with the contract’s Preset. If the preset uses the Use
cumulative size for Market Depth, the order size equals the cumulative size on that line x default order size.
For example, if the default order size is 100 and you click the ISE $12.03 price level (below), the order size
will be 10,600. If you click the same price level at the ARCA line, the order size will be 6,300. If the above
box is not checked, the order size will be the default order size. You can modify the order size before
transmitting the order.
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To create an order from Market Depth
1. Click on a price level in the Bid column for a Sell order, in the Ask column for a Buy order.
2. The order displays in the Orders panel. Modify parameters if necessary and transmit by clicking the
“T” in the status column.
3. To transmit your order, click the "T" in the Status field of the order line.
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Merger Arbitrage Window
Use the Merger Arbitrage window to create a combination order for an anticipated merger between two
companies.

To create a Merger Arb combo
1. From the Trading Tools menu, select Merger Arbitrage.
2. Enter contract conversion information in the Contract Selection area.
3. In the Order Selection area, enter the desired profit as an absolute amount or a percent of the last
price of the stock of the company being acquired (the acquiree).
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Pink fields are required.
4. Click Create Order to create a combination order line on the trading screen. You can also choose to
manage your order from within one of our advanced algo trading tools, Accumulate Distribute or the
ScaleTrader.

TWS Guide

315

Chapter 1

OptionTrader

The Scale market and order display feature scales the market data to display the price of the combination
per share of acquiree, and the order price will also be entered and displayed in these units. This is checked
by default. Note that if the calculated size of the acquiree is one, this checkbox has no effect.
The combo order as entered above, and then opened in Accumulate/Distribute looks like this:

The remainder of the Accumulate Distribute window allows you to specify detailed and sophisticated order
management criteria to help ensure that you receive the best price without being noticed.

OptionTrader
This configurable standalone screen shows market data for the underlying, lets you set up option chains
based on the underlying, gives you access to your options orders, executions and portfolio information,
drives the data for the Model Navigator and Options Analytics windows, and lets you create combination
Spread orders.
Using the OptionTrader

317

Loading Option Chains
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OptionTrader Strategy Builder

320
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The Button Panel

322

OptionTrader Statistics
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OptionTrader

325

Using the OptionTrader
OptionTrader is a robust trading tool that lets you view and trade options on an underlying. Display option
chains on the underlying based on the criteria you define, including strike, expiry and exchange, and view
the Greeks for each option. Use the Strategy Builder to create multi-leg combination orders by clicking
displayed option chains.
To open OptionTrader
By default, the OptionTrader tool (and all other tools that allow windows grouping) is linked to Group 4 (the
green chain link icon). When you open the tool, it will default to the selected underlying that is currently
active in that group.
From within Mosaic, use the New Window dropdown to select More Advanced Tools at the bottom
of the list, then OptionTrader.
From with Classic TWS, use the Trading Tools menu and select OptionTrader.
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The OptionTrader opens displaying the linked/selected underlying. The toolbar,statistics panel and
buttons panel can be hidden using the toggle buttons in the top right corner. Panels can also be
contracted/expanded using the down/up arrows. The different sections are identified in the image above
which corresponds to the following list:
1. The toolbar. Hide by clicking the "T" in the toggle set.
2. The toggle set. Display and hide features by clicking the buttons. "T" controls the toolbar. "B" controls
the Buttons panel, and "S" controls the Statistics panel.
3. The Quote Panel which shows the underlying asset. You can create orders on the underlying by
clicking the Bid (sell) or Ask from the Quote Panel. New orders will be displayed in the Orders tab of
the Trading panel.
4. The Statistics panel, which displays option-related statistical data.
5. The Buttons panel, which holds custom action buttons that you can use to initiate common actions.
Once you arm the panel, any button that you had defined for instantaneous transmit in the button
panel will be identified by an asterisk (*) next to the button name.
6. The Trading Panel which includes tabbed pages for orders, activity log, filled trades for the day on
that underlying, the Portfolio for the underlying, and the Strategy Builder.
7. The Strategy Builder, which lets you create multi-leg complex spread orders without leaving the
OptionTrader.
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8. Option chains for the underlying. These can be loaded using Tabbed View (shown) or List View,
which shows all Last Trading Days in a list rather than as tabbed section.
9. Load My Chains will load option chains for positions in your portfolio.
For information on loading option chains and configuring buttons and panels, see the TWS Users' Guide
topics.

Loading Option Chains
You can see option chains in the OptionTrader, or download chains on their own using the Option Chain
tool.
To load Option Chains
Mosaic: Use the New Window drop down and select Option Chain.
Classic: From the Trading Tools menu select Option Chain from the Options Focus category.
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Open Strategy Builder to easily create a multi-leg complex spread.

OptionTrader Strategy Builder
Use the Strategy Builder tab within OptionTrader to define and submit complex multi-leg orders that use
stock and option legs, based on the current OptionTrader underlying.
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To create a combo order
Select Strategy Builder from the Trading tabset.
Add legs by clicking the desired option in the Option Chains area.
Click on the right "Call" side to add calls. Click on the left "Put" side to add puts.
Click the Bid price to add a Sell leg; click the Ask price to add a Buy leg.
You can quickly modify the Action, Last Trading Day, Strike or Put/Call designation using the drop-down
arrow in the Combo window.
Use the optional feature buttons as needed:
Use "Add Stock" to add a stock leg.
Use "Make Delta Neutral" to add a stock leg with the delta quantity based on the system generated
delta.
Use "Add to Quote Panel" to set up the quote line for transmission at a later time.
Use "Transmit" to submit the combo order using the order parameters shown.
To make the combo delta neutral
Click Make Delta Neutral at the top of the Strategy Builder window.
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The stock leg is added at the bottom of the window, and the hedging quantity is generated automatically
using the system calculated delta. If you modify the delta the stock leg quantity will change, and if you
modify the stock leg quantity the delta value will update.
Modify the prices if needed. The Net Option Price is the limit price for the combo's option legs only. The
Stock Price is displayed separately.
Choose to Transmit the delta neutral combo, or add the combo line to the Quote Panel.

The Button Panel
Many of the trading tools provide a configurable Buttons panel that you can elect to hide or display, and
which lets you create new and edit buttons that perform the defined trading action with a single click.

To configure the buttons panel
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1. From within the current tool, click the configure wrench to open Global Configuration for the tool.
2. Select Buttons in the left pane.
The existing buttons and their actions are displayed at the top of the page.
3. Click Newto create a new button/action, or select a button and click Editto modify an existing button.
4. Use the Button Appearance section to change the label, the text color and the background color.
5. Select an action to associate with the button using the Select Action dropdown.
6. Fine-tune the action by entering data in the Customize Action area. For example, for the action
Increase price or size, you can specify the price or size field to which the button applies, and set the
interval by which to increase the field value.
Note: NOTE: If you check the instantaneous transmit feature, the button will display an asterisk
next to its name in the Buttons panel.

OptionTrader Statistics
An optional Statistics panel displays option-related statistical data for contracts with a stock underlying.
You can elect to display the following statistics:

Field

Description

Name
Bid Exch

Identifies the exchange(s) that are posting the best bid price on the options contract.

Model

The option model price is calculated using the underlying price, the interest rate,
dividends and other data using the Model Navigator.
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Ask Exch

Identifies the exchange(s) posting the best ask price on the options contract.

Historical

Displays the 30-day historical volatility for an option. Right-click the field header to

Vol

toggle between Daily or Annual,

Opt

A prediction of how volatile an underlying will be in the future. The IB 30-day volatility

Implied

is the at-market volatility estimated for a maturity thirty calendar days forward of the

Vol

current trading day, and is based on option prices from two consecutive expiration
months.

Opt

Charts the total number of options that were not closed.

Open
Interest
Opt

The total number of contracts traded over a specified time period.

Volume
Vol

Change in volatility from the previous day's close.

Change
Opt

Change in option volume from the previous day's close.

Volume
Change
Put/Call

Put option volume for the day divided by call option volume for the day.

Volume
Call/Put

Call option volume for the day divided by put option volume for the day.

Volume
Put/Call

Put option open interest for the day divided by call option open interest for the day.

Open
Interest
Call/Put

Call option open interest for the day divided by put option open interest for the day.

Open
Interest
Open
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Interest
Change

To display the OptionTrader Statistics panel
Click the "s" icons in the toggle panel located in the top right corner of the OptionTrader.

OptionTrader
Use the OptionTrader configuration page to define basic settings, order presets, hotkeys, buttons and to
control the visibility of column fields.
To define OptionTrader configuration settings
1. Click the Configure wrench from any window.
2. Click OptionTrader in the left pane and then click Settings.
3. Use the right pane to set these parameters:
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Settings

Components
Display menu - Check to see the OptionTrader menu.
Display or hide toolbar - Check to see the Option Trader toolbar.
Display Quote panel - check to display the Quote Panel, which displays a single line of market data
for the asset. You can create an order from the Quote panel by click the bid or ask price.
Display user-configurable buttons - hide or display buttons you create using the Buttons panel.
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Display or hide Statistics - a configurable, optional panel that shows option-related data and statistics.
Miscellaneous
Jump to order- automatically puts the cursor on the newly created order in the Orders panel.
Allow multiple untransmitted orders - if checked, you can create more than one order in the
Underlying panel. Otherwise, only one untransmitted order is allowed.
Show all orders - check to view all orders for the underlying.
Show option prices in volatility - check to view volatility instead of dollar prices.
Show last trading day headers - check to sort option chains using a single header for the Last Trading Day followed by a list of strike prices. This helps save room in the option chain Description column.
Link option chains to windows groups - If checked, the Mosaic Option Chains window (not full
OptionTrader) will be linked to the windows group allowing selected option chain contracts to act as the
source and change focus in all grouped windows.
Auto refresh chains after updating filters - If checked, option chains update immediately when any
filter criteria (strike, right etc) are changed. If unchecked, you must manually update chains using the
Load Chains button.
Order Ref - A user-defined reference name to help identify where the order originated.
Order Presets - OptionTrader-specific default order settings. The OptionTrader preset is linked to the
selected Order Ref. above. Create a preset for both Stock and Options with the same title and link to
the Order Ref by selecting it or by creating a new preset. These presets will control the default order
parameters for any stock and options orders created from the OptionTrader. If you do not create a
stock preset for the OptionTrader, the default stock preset will be used for stock orders created in the
OptionTrader.
Auto-Loading
OptionTrader automatically loads option chains based on the criteria you set in this area.
Assume underlying is a SMART stock - Uses Smart instead of a specific exchange.
Quick stock entry - Check to auto load stock and bring up the exchange dialog immediately when you
enter an underlying.
Load the closest N strikes to the money - Choose a number to limit how many options load in the
chain.
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Load the nearest N expiries - Only shows you those options with the N closest expiries.
Load specific months - Specify the exact months' options you want to see.
Auto-resize columns on load - When checked, data columns will resize appropriately to accommodate revised data.

The Order Ticket
To use the Order Ticket to manage blotter orders, right-click a blotter ticket and select Trading Tools and
then select Order.
The Order Ticket is available as an alternative form of order entry for users who prefer to set all order
attributes from a single tabbed window.
Basic

328

Advanced Combo Routing

335

Adjustable Orders

338

Scale Orders

341

Pegged Orders

345

Volatility Trading

346

Conditional

350

Miscellaneous

352

Basic
The Basic tab includes the basic order and time in force information, all based on the financial instrument
shown in the Quote Panel. The fields are context-sensitive, which means that only valid selections will be
active. For example, if the ticket specifies a LIMIT order, the order type field will be inactive and LIMIT will
be shown. if you select TRAIL LIMIT as the order type, the Stop Price, Trailing amount and Lmt Offset
fields become active. In addition, selections you make on this page affect the composition of the tabset. For
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example, if you select a stop or trailing order type, the Adjust tab becomes available; if you choose VOL as
the order type, the Volatility tab is displayed, etc.
For combo orders, the Basic tab also includes Advanced Combo Routing.
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To remove tabs and view all fields on a single large page, select theComprehensive view.
Field

Description

Action

Choose Buy or Sell.

Notes

Quantity
Quantity

Specify the number of units in the
order.

Display size

Enter a display size to create an
Iceberg order.
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Basic

Enter the minimum quantity that

For options routed through

must be available for the order to

Smart.

execute.
Order Description
Order Type

Select an order type. Valid order
types are determined by the
underlying, exchange and
security type selected.

Limit Price

Enter the limit price if the order
type requires it.

Aux. Price

For Stop and Stop limit orders,
this is the Stop election price.
For Options relative to stock
orders, this is the starting price.
For trailing stop orders, this is the
trailing amount.

Trailing amount

The amount used along with the
market price to calculate the initial
stop price.

Percent Offset
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offset amount based on a
percentage of the bid price for
Buy orders or the Ask price for sell
orders.
Discretionary

The amount off the limit price at

Enter an amount to create a

Amount

which the order is still eligible to

Discretionary order.

execute.
Destination

Specifies the order destination.

To create CSFB or Jefferies
algo, select CSFBALGO or
JEFFALGO from this list.

Field

Description

Notes

Time in Force

The time period during which your

Only valid Times in Force

order will remain active. Choose

are displayed per order,

from the selections presented,

based on the product, order

including:

type and destination.

•

DAY (day order). See more

about DAY orders below the
table.
•

GTC (order remains active

until it is cancelled)
•

OPG (market or limit at the

open order)
•

IOC (immediate or cancel)

•

GTD (order remains working

until the date/time specified in the
End Time field below.)
•

DTC (day 'till cancelled, is

cancelled at the end of day like a
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day order, but remains on your
trading screen deactivated to let
you resubmit easily).

Start Time

Set the start time (and date) for
the order.

End Time

Set the end time and date for the

Only valid for GTD times in

order.

force.

Trading Hour Attributes

The next three settings allow you to specify the hours during which orders are eligible to
execute. By default, orders are set to trade during Regular Trading Hours only.
Note:

Elections to trade outside regular trading hours may not be available

for particular products that are not listed on an exchange. Clients are solely
responsible for ensuring that these parameter are valid for the product(s)
involved.

Allow this order to

Check this box if you want to allow

You can also set this feature

be filled outside of

orders to trigger or fill outside of

from the TIF dropdown on

regular trading

regular hours.

an order line in the trading

hours.

window.
Valid for US stocks listed on
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major exchanges. Not
available for IOC, OPG
(MOO and LOO), FOK,
MOC or LOC orders.

Allow order to be

Check to allow orders to

Can be applied to orders set

routed and

participate in the pre-open

for Regular Trading Hours

executed during

session from 4:00 - 9:30 am.

only.

Ignore opening

Check to ignore the opening

Can be applied to orders set

auction.

auction which takes place at the

for Regular Trading Hours

open.

only.

pre-open session.

This attribute cannot be
used if you have configured
Smart Routing to participate
in Pre-open Re-route.

VWAP Time

Modify the VWAP cut-off time if

VWAP orders are

desired by clicking the

automatically routed and

Calendar selection tool.

accepted immediately after

Otherwise, the Soonest cut-off

being transmitted. VWAP

time is used.

orders cannot be cancelled.

DAY - Using "Day" as the time in force for a Regular Trading Hours ("RTH") Only order
specifies that the order will work throughout the trading day during regular trading hours
until it is filled, is canceled by the user, or expires at the end of the trading day. (By default,
the time in force for orders is set to "Day." Orders for some products are entered with a
default restriction of Regular Trading Hours (RTH) Only to prevent orders from being
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executed during the pre- and post-market sessions).

A day order that is submitted after regular trading hours* with the order attribute of RTH will
be held in the system and begin to work at the start of the next trading day. The order will
be active during the next trading day until it is filled, is canceled by the user, or expires at
the end of the trading day. IMPORTANT NOTE: You can add order attributes to any
order or change default settings to specify that orders be activated, triggered, or
filled outside of regular trading hours.
You can add order attributes to any order or change default settings to specify that orders be activated,
triggered, or filled outside of regular trading hours.
* For TWS: Day orders submitted with “RTH ONLY” will be canceled between 4:00-4:05 pm. Day orders
submitted after 4:05 pm with “RTH ONLY” will be queued for the next day.
For FIX connections: Day orders submitted with “RTH ONLY” will be canceled between 4:00 – 5:00 pm.
Day orders submitted after 5 pm with “RTH ONLY” will be queued for the next day. Contracts with short
close-to-open time, such as Forex and CME futures, have a shorter window.

Advanced Combo Routing
Advanced combo routing (defined from the Basic tab of the Order Ticket) lets you control how each leg of
a complex combination order is handled. Define advanced combo routing for both guaranteed and nonguaranteed combination orders routed to Smart. Selections displayed are based on the combo
composition and order type.
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To use advanced combo routing
1. Create the Smart combination strategy.
2. From the combo line on the Quote Monitor, click the Bid or Ask price to create a (sell or buy) order.
3. Right-click the order line and select Modify then select Order Ticket.
Based on the combo composition and the Order Type, the Advanced Combo Routing selections are
displayed. You can monitor the progress of the combo order by holding your mouse over the Status field of
the order line.
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Advanced Combo Routing Fields (available based on selected Order Type):

Field Name
Order Type

Description
Choose from the basic order types as well
as: Relative + Market, Limit + Market, Trailing Relative + Market and Trailing Limit +
Market.

Select leg to fill first

For orders that are being legged-in, the chance
exists that only the first leg of the combo will fill
and you will be left with one unexecuted leg. Use
this field to specify which leg is submitted and
potentially filled first. Use the dropdown list to pick.

Maximum leg-in combo size:

The order is submitted in pieces, or segments. This is the maximum size of each
segment.

Do not start next leg-in if

Specify whether or not the system should

previous leg-in did not finish:

attempt to fill the next segment before the
current segment fills.

Convert second leg order to These settings allow you to specify when (if
market order if...

ever) the second leg should be changed to
a market order to fill right away, in cases
where the first leg fills and the second leg
does not and ends up sitting as a non-marketable limit order at the exchange,

...or if the price backs off by... Provides a way to specify a stop-loss to fill
the unexecuted leg of a combo by changing
the leg to a market order if the price backs
off by the specified amount.
Discretionary Amt

In cases where one leg fills and the other
doesn't, the discretionary amount indicates
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Field Name

Description
how much you are willing to pay to fill the
combo.

Adjustable Orders
Use the Adjust tab to define a one-time adjustment to a stop, stop limit, trailing stop or trailing stop limit
order. This tab will only become active if one of those orders types is selected.
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To remove tabs and view all fields on a single large page, select the Comprehensive view.

Field

Description

Notes

Adjust to

When you select an

The following example continues to unfold for each

Order

adjusted order type, the

field.

Type

stop order you're
adjusting will not trigger

TWS Guide
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when the stop price is hit.

This means that if the price hits $30.00, TWS will send

Instead, it will be changed

a sell market order to the exchange.

to this order type, and use
the other parameters
below.

Now let's modify this scenario. In addition to the
above Stop order, you decide to create an adjustable
Stop Limit order to help lock in a profit if the stock

Select one of the stop

price begins to rise. Now imagine the price starts

order types. When your

going up. When it hits the trigger price (see next field

current stop price is

below) TWS will cancel the Stop order and create a

penetrated, it will change

new Stop Limit order with the characteristics you set

to this order type and use

in the following fields.

the instructions you set in
the following fields.
Trigger

This price will trigger the

Price

adjusted order you

Set the adjustable trigger price to $34.00

defined in the Adjusted
Order Type.
Adjusted

When the trigger price is

Set the adjusted Stop Price to $33.50. When the

Stop

hit, the adjusted stop price

stock rises above the $34.00 trigger price you set

Price

is implemented for the

above, you original Stop order is cancelled and

new order.

replaced with a Stop Limit order with a stop trigger
price of $33.50.

Adjusted

Used for Stop Limit and

Set the Stop Limit to $33.00 to ensure your order will

Stop

Trailing Stop Limit orders.

not execute below this price.

Limit

This value will be the limit

Price

price of the order if it is
triggered and submitted.

Adjusted

Used for Trailing Stop

If you had a trailing stop order with a trailing amount of

Trailing

and Trailing Stop Limit

$1.00, you could set the adjusted trailing amount to

Amount

orders. This value will

$.50. If the adjustment trigger is hit, the trailing

replace the original

amount is modified.
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trailing amount if the
adjusted order is
triggered.

Scale Orders
Scale orders are designed to help prevent larger sized trades from being subject to increasingly
deteriorating prices by scaling your order into smaller, incrementally priced components based on userspecified price and size instructions. In addition to scaling your order, you can also define a profit
offset amount which instructs the system to automatically submit opposite-side profit taking orders against
the individual components of the original order.
Use the ScaleTrader tool to set all scale parameters.
Click Open ScaleTrader from the Scale tab to set all scale parameters.
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Set time in force parameters for the Scale order. See the Basic page for details.
See the ScaleTrader topic for details on creating a scale order.
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Pegged Orders
Select from the available fields to create an order. The fields are context-sensitive, which means that only
valid selections will be active. For example, if you are creating any kind of order other than a Pegged to
Stock options order routed through BOX, this page will be inactive.

Field

Description

Notes

Stock Ref

Enter a stock price.

If you do not enter

Price

a value, the
midpoint of the
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NBBO at the time
of the order is
used.
Underlying

Define the lower portion of the stock range

Range

outside of which your order will be cancelled.

(Lower)
Underlying

Define the higher portion of the stock range

Range

outside of which your order will be cancelled.

(Higher)
Delta

Enter a value (which will be used as a percent,
ie. ".5" equal 50%) that will be multiplied by the
change in the underlying stock price. The
product is added to the starting price to
determine the option price.

Volatility Trading
The VOL order type allows you to trade volatility, and provides ways to dynamically manage your options
orders.
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To trade Volatility
1. From the Trading Tools menu, select Volatility Trader. The fields used to define and dynamically
manage volatility orders are on the new page.
2. Create market data lines. Note that Bid and Ask price fields display in volatility rather than as a dollar
amount. Market data for stock tickers will still display the bid and ask price.
3. Select Annual or Daily volatility using the Volatility Type dropdown list.
4. Create an order by clicking the Ask volatility for a Buy order, or the Bid volatility for a Sell order. The
order type defaults to VOL.
Note: You can use the VOL order type for equity options, index options and combination
orders. Hold your cursor over the option's volatility to see the option price, based on that
volatility.
Please note the following requirements for transmitting a VOL combination order:
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Combo VOL orders must be Smart-routed.
All legs must be on the same underlying, and each leg must independently be eligible to use the
VOL order type. For example, a BuyWrite order could not be sent as a VOL order since its stock
leg would not allow this order type.
All VOL orders must be DAY orders.
You can elect to price a Smart-routed Index Option order using reverse futures premium
calculations by selecting a futures contract from the Reference Contract field.
If you have changed the reference contract in the Model Navigator, VolatilityTrader will used the
new contract as the default reference contract.
5. To have the workstation calculate a limit price for the option or combination order based on your
volatility input, enter a value in the Order Volatility field. The value shown in the Imp Vol field is calculated via the Model Navigator.
6. To transmit the order, click the "T" in the Transmit field, or the Transmit icon on the trading toolbar.

Field

Description

Volatility

If desired, enter a volatility to use in calculating a limit price for the option. If blank,
the calculation will use the volatility derived via Option Analytics.

Volatility

Select from Daily or Annual volatility.

Type
Hedge

Select an order type. The application will send an order against the executed

Order Type

option trade to maintain a delta neutral position. Use the Hedge Aux. Price field to
set a price for orders that require one. Note that for index options, you will need to
select a futures contract for use in a hedge delta trade.
Alternately, you can use the right-click menu to attach a Delta Hedge order and set
the hedging attributes from the new order line.
Please note that if you select Continuous Update, the system will use the delta
associated with the parent order, which is calculated from the user-defined Implied
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Volatility specified at the time of the most recent order modification or price update,
instead of using the current delta of the option based on market data at the time of
trade.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the
time the parent order fills, and the best available price is used as the limit price
(best ask for a buy and best bid for a sell).
Hedge Aux.

Used in conjunction with the Hedge Order Type field. If you have selected an order

Price

type that requires you to define a price, for example a relative order, use this field to
set the price.

Continuous

Check this selection to continuously update the price of the order if the price of the

Update

underlying instrument changes significantly. Note that you can only check
Continuous Update for three active orders at a time.

Reference

Elect to use the NBB (bid) when buying a call or selling a put; the NBO (ask) when

Price Type

selling a call or buying a put; or the average of the best Bid and Ask. This price is
also used to compute the limit price sent to an exchange (whether or not
Continuous Update is selected), and for stock range price monitoring.

Stock Price

Undrl. Range (Low) - enter a low end acceptable stock price relative to the

Monitoring

selected option order. If the price of the underlying instrument falls BELOW the
lower stock range price, the option order will be cancelled. Merely touching the
price does not cancel the order.
Undrl. Range (High) - enter a high end acceptable stock price relative to the
selected option order. If the price of the underlying instrument rises ABOVE the
upper stock range price, the option order will be cancelled. Merely touching the
watermark does not cancel the order.

Reference

Used for smart-routed Index Option volatility orders. This field allows you to select

Contract

the futures contract to use for calculating the implied volatility. To activate this
feature, use the Volatility and Analytics page in Global Configuration and
selectPrice index options relative to futures contract.
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For a more detailed description of Trailing Stop orders visit the Order Types information page.

Conditional
A conditional order is an order that will automatically be submitted or cancelled ONLY IF specified criteria
for one or more defined contracts are met. You can use stocks, options, futures or security indexes to
trigger a conditional order.
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To create a conditional order
1. Select an order line.
2. From the right-click menu, select Modify and then select Condition.
3. From the Conditional tab on the order ticket click Add Condition.
4. Enter contract information for the contingent asset in the Conditional Order box.
5. Enter the trigger information for the contingent asset:
Select the trigger method.
Select whether the price of the contingent asset should be less than or equal to (<=) or
greater than or equal to (>=) the trigger price.
Enter the trigger price.
If you select the double bid/ask trigger method, the greater than or equal to operator (>=) will
use the BID price and the less than or equal to operator (<=) will use the ASK price.
6. Click OK. The condition appears in the Current Conditions list.
To set multiple conditions, use the Add Condition button and click AND or OR in the Current
Conditions area.
Field/Button

Description

Add Condition

Invokes the Conditional Order entry box.

Delete

Deletes the selected condition.

Modify

Opens the Conditional Order entry box for the selected
condition to allow you to make changes.

Allow condition

Lets the selected condition activate the order if it is satisfied

to be satisfied...

outside of regular trading hours.

Action to take...

If selected conditional order is satisfied, you can elect to have
the primary order submitted OR cancelled.
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Miscellaneous
Use the Miscellaneous order fields to apply individual order attributes and set specific rules for OCA
groups.
All fields are not always visible. Only fields that apply to the current order will be shown.
Note: OCA group names must be unique to ensure proper handling of OCA orders. Once you use
a name, you cannot use it again even after the order fills or is canceled.

Note:
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Note:

Field

Description

Allocation

Choose an account, model or portfolio strategy to receive allocation.

Order Ref

An identifying number you create to track your order.

Trigger

Select a new trigger method for the order.

Method

Trigger
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Miscellaneous

left unchecked order will deactivate at the end of the day and will not trigger unless trigger conditions are met. For simulated orders only.

ISE Midpoint

Choose from Standard or SOI for an ISE MPM order.

Match

Routing

Select a Smart routing strategy.

Strategy
Req Market

Check to request market data for the order.

Data
Block Order

Check to create a block order.

Sweep to Fill

Check to create a sweep-to-fill order.

Hidden

Check to create a hidden order.

Auto-can-

For orders with a parent-child pair, check to have the parent order can-

cel parent

celed when the child order is canceled.

All or None

Check to create an All or None order.

Non-

Checking this box indicates that you will take all the risk for partially-executed

Guaranteed

Smart routed combination orders. Note: Only Smart-routed US stock-option
and option-option combinations are guaranteed.

Consider

If checked, Smart routing will consider the total cost of executing the order,

Cost

including commissions and other fees, when deciding where to route the order. If
unchecked, only the exchange price is considered.
For smart-routed European stocks.

Preserve

Check to keep your order in the queue and prohibit from canceling and

Time Priority

resubmitting orders intermittently. This feature is used on exchanges that charge
a handling fee for orders that remain on the order book for a specified period of
time.

Hide

When checked, hides the penny pricing of your options order.

Pennies
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If checked, when there is non-displayed liquidity at the same price point, the order
price is adjusted low (for a buy) or higher (for a sell) by one penny to avoid taking
that liquidity. If the order comes in at a price higher (for a buy) or lower (for a sell)
than an order already sitting on the book, it becomes an IOC (immediate-orcancel) order at the better price.

Deactivate

Check to deactivate the order, which cancels the order

Seek Price

If checked, Smart routed orders sweep certain exchanges for hidden liquidity at

Improvement

more favorable prices, then checks the dark pools as usual before routing to an
exchange. Note that activating this feature may result in slower executions.

Imbalance

Submits the order only to take the imbalance from an opening or closing auction.

only
OCA Group
Group Name

If the order is part of a one-cancels-all order, enter the OCA name in this field. All
orders with the same name in the OCA field become part of an OCA order. Once
you use a name, you cannot use that name again even after the order executes or
is canceled.

Partially filled
instructions

Set instructions on how to behave when order is partially filled.
Reduced in size: Reduces the quantity of other orders in the group by the
partially filled quantity of the order. Please note that using this option without
overfill protection may likely result in multiple orders being routed to an exchange.
This may result in an overfill, or in a rejection in the case of multiple sell orders
where one is tagged as "short sale."
Reduced in size (Overfill Protection): Designed to reduce quantity of other
orders in the group by the partially-filled quantity of the order, and specifies that
only one order at a time will be submitted to an exchange to avoid multiple orders
filling (overfill).
Cancelled: All orders in the group will be canceled. When selected, "overfill
protection" is automatically enabled to prevent an overfill.
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Overfill

Dictates that only one order in the group will be routed to an exchange at a time.

Protection

This completely removes the possibility of an overfill.

Pre-Borrow Shares for Shorting
If you plan on putting on a short sale, you can choose to pre-borrow shares to decrease your chances of
being bought in on settlement date.
About Pre-Borrows

356

Create a Pre-Borrow Order

357

Pre-Borrow Returns

359

About Pre-Borrows
Eligibility

Pre-Borrow for Shorting is only available for Portfolio Margin customers.
To enable this program, you must log into Account Management and check Pre-Borrow Program in
the Trading Programs section of the Trading Permissions area.
The Pre-Borrow Market

Pre-borrow orders are accepted from 6:45 - 14:45 ET.
Generally the most active time for pre-borrows occurs between 9:00 and 11:00 a.m.
Rates and Fees

The indicative rate displays in the data line for the stock in the Lend field. The actual rate to borrow that
stock (our standard borrow rate) is computed at the end of the day and will be available on your activity
statement.
Rates are subject to change based on availability of the underlying stock. Standard borrow rates are
computed each night and will be available on your activity statement.
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You will pay additional borrow fees for any stock held in excess of your short position.
The borrow rate is applied to the collateral to calculate the daily borrow fee.
The borrower is responsible for the daily borrow fee and for collateral on the transaction. The collateral
is equal to the settlement price x quantity. The settlement price is 102% x mark price rounded up to the
nearest 1.00 with a 1.00 minimum.
Collateral is returned to the borrower when the borrowed shares have been returned to the lender.
In the case of dividend-paying shares, since shares are only being lent (not sold) by the lender,
dividends paid during the borrow belong to the lender who actually owns the shares. The borrower of
the shares must pay dividends to the lender in what is called Payment in Lieu of Dividends.
Transaction Information

A pre-borrow is presumed to anticipate a short sale. If no short sale trade executes within three days of
the pre-borrow transaction, a non-purpose borrow results and the shares are returned.
If the pre-borrow is not followed by a short sale and a previous short on the same underlying exists, the
pre-borrow will be applied to the existing short on the following day.
Only US stocks are available to pre-borrow.
Orders are only eligible to fill during regular trading hours.
There is an order minimum of 10,000 USD for all pre-borrow transactions.
Only market orders are supported for pre-borrow orders.

Create a Pre-Borrow Order
You can initiate a pre-borrow order from US stock market data line or directly from within the Stock/Borrow
Loan window.
Before you can pre-borrow you will need to enroll in the program via the Trading Programs area in Account
Management.
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To create a pre-borrow order
Right-click the stock underlying you want to pre-borrow and select Trade then select Pre-borrow shares
for Shorting.
Select the contract/destination as xyz SBL@PREBORROW.
Answer "Yes" to the message offering to change the order type to MARKET. You will receive this message
for every pre-borrow order if you have the default order type set to any type other than MARKET.
For the pre-borrow order you can only modify the quantity, which should correspond to the anticipated
short sale.
Transmit the order.
Short Sales on a Pre-Borrow

Once the pre-borrow order is contracted, the quantity available to short will be shown in the Private
Locate field.

Display the Private Locate field
Hold your mouse over any market data field until the "Insert Column" option appears. Click "Insert Column"
and select Stock Borrow/Loan and then Private Locate.

For details on using the pre-borrow feature, see the About Pre-Borrows topic.
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Pre-Borrow Returns
The Return/Recall panel displays any returns and recall requests (you must be logged in), and allows you
to send return requests.
Once you borrow shares, you can return them using the Return order function, or the lender can recall the
shares at any time. When borrowed shares are recalled, they are removed from your account, you are
notified in the Return/Recall panel of TWS, and the recall will show up in the Borrow Activity section of your
Activity Statement.
Please note that if you have borrowed to cover a short position and then purchase the shares and no
longer need to maintain the borrow position, the borrowed shares are not automatically returned; you must
return the shares. Returns cannot be made the same day (you can return the next day), and must be
entered by 10:50 am.
To view the Return/Recall panel, click the Show Return/Recall Requests icon on the right-hand tab of the
trading page.

To return borrowed shares
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1. Right-click the ticker and select Trade then select Return Shares.
2. Confirm the order parameters and transmit the order by clicking the ‘T’ in the Status field.

Order Quantity Calculator
Calculate the order size based on currency, deliverable value, percent of Net Liquidation or percent
change in position.
Determine Order Quantity

360

Calculate Order Quantity

361

Determine Order Quantity
When you create an order, you can define the order size several different ways. You can set a general
default order size that is used for all orders. You can set specific default sizes for instrument types, for
example a quantity of 500 for all stock orders. You can even get more specific and set the default order size
for a specific contract, for example set the quantity for all stock orders for underlying XYZ to 1000.
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Alternatively, you can set a default currency amount that will be used to calculate the order size. For
example, set the default amount for stocks to $5000.00. The order quantity is then calculated based on the
stock price, and is rounded to the nearest 100 for U.S. stocks.
You can also have the workstation calculate the order quantity by Deliverable value amount, a percent of
your Net Liquidation value, or based on a percentage of your current position.

Calculate Order Quantity
Use the Quantity Type and Quantity Value fields to calculate your order quantity based on:
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Currency- assumes the base currency
DLV Amount - See Deliverable Value (DLV) Calculation for more information.
% of NLV - percent of Net Liquidation Value
% Change in Position - percent of the change for your position in the underlying.
For example, say you have a Net Liquidation Value of 40,000. XYZ shows a current ask price of 80.00. If
you create a buy order for XYZ, select "% of NLV" as the Quantity Type and enter "20" in the Quantity
Value field, you're telling the application to calculate the number of shares you could buy for 20% of
$40,000 or $8000.00, based on the Ask price of $80.00. The calculated Order Quantity value of "100" is
then displayed in the Quantity field.
To display the Quantity Type and Quantity Value fields
1. Right-click on any column name in the Order Management section of the trading screen, and click
Customize Layout.
2. Click the Order Columns tab. In the Available Columns list in the Quantity section select Quantity
Type and Quantity Value and Add them to the Shown columns list.
To calculate order quantity by currency
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1. Create an Order by clicking the bid or ask price.
2. In the Quantity Type field, select the currency type. This field assumes the base currency.
3. In the Quantity Value field, enter a currency amount. For a buy order, enter the amount you want to
spend. For a sell order, enter the amount you want to make. Based on the current bid/ask, your
value gets rounded up or down.
The order quantity is calculated and displayed in the Quantity field.
To calculate order quantity by Deliverable Value (DLV Amount)
1. Create an Order by clicking the bid or ask price. See Deliverable Value (DLV) Calculation for
more information.
2. In the Quantity Type field, select DLV Amount.
3. In the Quantity Value field, enter the dollar amount of your deliverable value you want to use to calculate the order quantity.
The order quantity is calculated and displayed in the Quantity field.
To calculate order quantity as a % of your Net Liquidation Value (% NLV )
1. Create an Order by clicking the bid or ask price.
2. In the Quantity Type field, select % NLV The Net Liquidation value is the first value in the upper left
Balance area of the Account window.
3. In the Quantity Value field, enter a percent value that will multiplied by your NLV to calculate a dollar amount.
The order quantity is calculated and displayed in the Quantity field.
To calculate order quantity as a % of position change
1. Create an Order by clicking the bid or ask price.
2. In the Quantity Type field, select % Change in Position.If you do not hold a position in the selected
underlying, you will not see this selection.
3. In the Quantity Value field, enter a percent value that will multiplied by your position to calculate the
order quantity.
If your position is negative, you must enter a negative percent value to calculate a positive order quantity.
The order quantity is displayed in the Quantity field.
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Rapid Order Entry
Enter orders more quickly with defaults and quick-click fields.
Enter Orders using Rapid Order Entry

364

Update Multiple Orders

366

Create "Instantaneous Transmit" Hot Key

368

Enter Orders using Rapid Order Entry
The Rapid Order Entry panel, which is visible by default at the top of each trading page, allows you to
quickly transmit an order without having to open an order ticket or click in a market data line. You simply tab
through the fields, enter your order parameters, and click Trade. You can also enter the local or root
underlying symbol, just as you can on the trading screen.
Note: Rapid order entry can be set for Stocks, Options, Stocks/Options, Stocks/Futures and
Combo orders.
To use the Rapid Order Entry panel
1. If the panel is hidden, from the View menu select Rapid Order Entry.
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The panel displays the instrument setting in the title, for example (Stocks). With this setting, you can only
create stock orders.
To change the instrument type
1. Right-click in the panel, and select Rapid Order Entry, then select the instrument type setting. Select
Stocks/Options or Stock/Futures to enter either asset type.
Once you have transmitted an order using Rapid Order Entry, the details of the order appear in the Order
Management panel of the trading page. Any modifications to your order must be made on this order
management line.
Using the Stock/Options or Stock/Futures Settings
You can choose to set the panel to Stocks/Options or Stock/Futures if you trade both asset types.
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If you enter the Last Trading Day, Strike, and P/C fields, the Rapid Order Entry panel assumes you're
creating an option or futures order and the limit price defaults to the correct price. If you leave these fields
blank, it assumes a stock order and the limit price defaults to the stock price.
For the Option and Stock/Option layouts, you can set a default in Global Configuration to populate with the
nearest at-the-money option , but if you set this for the Stock/Options layout you will always need to delete
information to create a stock order since the Last Trading Day and Strike fields will auto-populate.

Update Multiple Orders
Automatically update order type, limit price, time in force and more for a specific group of orders.
Automatically update the limit price to coincide with the ask, bid, midpoint, closing or last price.
Update multiple orders
1. On the Trade menu select Modify Multiple Orders.
2. Set update parameters:
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Which orders

All selections apply only to orders on the active trading page. Specify whether to update attributes for:
All orders on the page - Including working orders, non-transmitted orders, etc
Open orders only - This includes all orders working on the current page.
Selected orders - This includes all orders (working or not) on the active page that you deliberately select.
Inactive orders - This includes all orders on the active page that are created but have not yet been
transmitted.
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Set Type and Time in Force

For the subset of orders specified above, specify changes to the current order type and time in force.
Check Convert Market to Limit to have all market orders automatically changed to limit orders. Buy limit
orders will use the Ask as the default limit price; sell limit orders will use the Bid as the default limit price.
Set Price Parameters

Define the update price parameters for Buy orders and include an offset amount if desired.
Set the update price parameters for Sell orders. If you check Mirror image of buy orders, parameters are
set reversed from the Buy orders selections. The mirror images of Midpoint, Last and Close would be the
negative values for each of these prices.
Validation

If one or more of the orders marked for update cannot be updated, the Validation selection checked here
will be used.

Create "Instantaneous Transmit" Hot Key
You use hot keys to perform common trading functions, such as creating specific order types. Once you
have created an order, you must still select Transmit to send the order. You now have the option to
enhance the Buy and Sell hot keys by adding "instantaneous transmit" functionality.
To add instantaneous transmit functionality to a hotkey
On the Edit menu, select Global Configuration and then select Hotkeys in the left pane.
1. In the Configured Shortcuts table, select the Buy or Sell action.
2. Click Configure, and open the Customize tab.
3. At the bottom of the page check Transmit the order instantaneously and click OK.
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Note: To use this feature, you will be asked to sign an agreement stating that you understand its
implications. Under the terms of the Customer agreement, you are responsible for all orders
entered in your account. Consider carefully whether setting a hot key to instantaneously transmit
orders is the best for the way you trade.

Rebalance Your Portfolio
Use the Rebalance window to redistribute percentages of positions in your portfolio that make up your
current (signed) net liquidation value.
The Rebalance Window

370

Import and Export Positions to Rebalance

371
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Rebalance for Advisors

375

The Rebalance Window
Use the Rebalance window to assign application automatically creates orders to rebalance your portfolio
based on target percentages you enter.

To rebalance your portfolio
1. From the Trading Tools menu, select Rebalance Portfolio.
2. The Rebalance Portfolio window shows three columns that are different from those on your trading screen:
Deliverable Value - this is the deliverable value of the position. For stocks, this is the value of the
stock, which is the same as the Market Value for the position shown in the Portfolio section of the
Account window. For options, futures, and single stock futures (SSFs) it is the underlying stock
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or index value.
Current % - this is the current signed percent of the position to your net liquidation value shown in
the Balance section of the Account window. This figure is calculated by dividing the DLV by the
NLV (Net Liq. Value).
Rebalance % - use this field to enter a new percentage of the NLV that you want the position to
have.
3. In the Rebal % field for one or multiple positions, enter the percent of the Net Liquidation Value that
you want the position to have.
4. Click the Create Orders button to instruct the application to automatically create the orders to
achieve the percent change.
5. Use the Transmit All button to send all orders, or click "T" on an order line to transmit a single order.
Note: For options, the rebalance % is based on the value of the underlying stock prices.
To open positions from the Rebalance window
1. Click Add Line from the buttons panel, and enter an underlying symbol into the blank row and hit
Enter. Define the contract.
2. Enter a value in the Rebal % column and click the Create Orders button.
3. Transmit the order.

Import and Export Positions to Rebalance
Customers who prefer to work in Excel can export the Rebalance file and modify the current percentage to
reflect the percent of net liquidation they want to their positions to have, then import the modified file back
into Rebalance Portfolio.
Advisors can also use this feature to import a modified file to a new account to easily bring this account to
the new percentages.
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To export a portfolio
1. Click the Export icon at the top of the Rebalance Portfolio window.
2. Modify the location and file name if desired (leaving the .csv extension), and click OK. You may want
to modify the generic file name to help identify it.
For example, you could change the default C:\jts\rebalance.csv to C:\clients\smithPortfolio.csv.
3. Click OK from the file export confirmation message.
The directory path must exist for the Export functionality to work. You cannot create a new folder while
exporting.
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To rebalance the position’s percent of NLV from Excel
1. Open the exported .csv file in MS Excel.
Note that each line of the spreadsheet represents a position. The last column represents the current
percent of Net Liquidation Value that the position holds. This exported value is equivalent to the
value in the Current % field of the Rebalance Portfolio window.
2. Change the current % of NLV to the new percent you want. Do this for as many lines as needed and
click Save.
For example, if you want to rebalance your portfolio so that AAPL STK holds 5% of NLV instead of
16.20478 as shown above in line 2, you would change 16.20478 to 5.0. This modified value is imported in
the Rebalance Portfolio as the new Rebal % value.
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To import a rebalance portfolio
1. Click the Import icon at the top of the Rebalance Portfolio window.
2. Navigate to the modified .csv file you want to import and click Open. You will see the new Rebal %
values in the modified position lines.
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To complete the rebalance, create and transmit the orders.

Rebalance for Advisors
Advisors can elect to have TWS automatically Rebalance ALL accounts, a single subaccount, or a userdefined Account Group, which includes a subset of accounts, by redistributing percentages of positions in
their subportfolio(s) that make up the current (signed) net liquidation value. TWS opens and closes
positions to rebalance the selected accounts' portfolio based on the new percentages you enter. You can
add contracts and create orders just as you would from the main trading screen.
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Rebalance a SubPortfolio
1. Open the Rebalance window by clicking the Rebalance icon on the trading toolbar.
2. In the Account dropdown, select: All to rebalance All accounts; Master to rebalance the master
account, an account number to rebalance that account, or an Account Group to rebalance all
accounts in the group.
3. The Rebalance window shows three columns that are different from those on your trading screen:
Deliv Value - this is the deliverable value of the position, which is the same as the Market Value
for the position shown in the Portfolio section of the Account window.
Current % - this is the current signed percent of the position to your net liquidation value shown in
the Balance section of the Account window. This figure is calculated by dividing the DLV by the
NLV (Net Liq. Value).
Rebal% - Percentages are entered in terms of deliverable value.
Note: Please note that puts have a negative deliverable value since they deliver a short
position. Consequently, to increase your put position, you must enter a negative deliverable
value percentage.
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4. In the Rebal % field, enter the new percent of the Net Liquidation Value that you want the position to
have.
If you have selected "All" in the Account dropdown, the rebalance percent for the instrument will be
applied to all of your sub accounts' portfolios.
5. Click the Create Orders button to instruct the application to automatically create the orders to
achieve the percent change.
6. Use the Transmit All button to send all orders, or click "Transmit" on an order line to transmit a
single order.
Note: For options, the rebalance% is based on the value of the underlying stock price.
Open positions from the Rebalance window
1. First, add a ticker line to the Rebalance window by selecting the market data line on your trading
screen, and then clicking the selection arrow attached to the Rebalance icon on the trading toolbar.
Click Add to Rebalance Window. Or, enter an underlying symbol into a blank row on the
Rebalance screen as you would on the main trading window.
2. Enter a value in the Rebal % column and click the Create Orders button.
3. Transmit the order.

SpreadTrader
Easily create complex multi-leg futures and options spreads with SpreadTrader.
Create Futures Spreads with SpreadTrader

377

EFP Futures Spreads

380

Create Option Spreads in SpreadTrader

382

Create Futures Spreads with SpreadTrader
Use the SpreadTrader to quickly create and trade calendar spreads for futures.
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Create a futures spread
1. Open SpreadTrader by right-clicking a contract on the trading screen and selecting Tools and then
SpreadTrader.
2. Enter the underlying symbol and and then select Futures Spreads for xxx, then choose the routing.
3. In the SpreadTrader leg matrix at the bottom of the screen, click a bid or ask price at the intersection
of two legs to create the calendar spread.
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The SpreadTrader matrix automatically structures the spread to sell the nearby month and buy the
distant month.
4. Transmit the order from the Orders panel by clicking "T" in the Status field.
Background Colors in Quote Panel
The colors in the Description field of the Quote panel show you how far out from the current year the
contract's maturity date is, at a glance. Industry-standard colors are defined below:
Number of Years Out

Background Color

>1

White

2nd

Red

3rd

Green

4th

Blue

5th

Gold

6th

Purple

7th

Orange

8th

Pink

9th

Silver

10th

Copper

EFP Futures Spreads
An EFP (Exchange for Physical) is a combination order to sell/buy stock and buy/sell an SSF (single stock
future).
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To create an EFP in SpreadTrader
1. From the Trading Tools menu select SpreadTrader.
2. Enter a symbol in the underlying field and hit Enter.
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3. Select EFPs for xxx and then select the routing destination, either SMART, IBEFP or ONE.

The spread matrix at the bottom of the window is populated with a list of all single stock futures legs
on the left, and the stock across the top.
4. Click a bid or ask price at the intersection of two legs to create the EFP spread.
5. To transmit the order, click the "T" in the Status field of the Orders panel.
Note: Please note that smart-routed EFPs are not guaranteed.

Create Option Spreads in SpreadTrader
Use the option combo facility in SpreadTrader to create a matrix of variations on an option strategy for a
single underlying, from which you can create and transmit multiple combination orders with two clicks of the
mouse. The Option Wizard helps you to define exactly how you want the combo lines displayed in the
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matrix by allowing you to assign either a column position, row position or fixed value to each parameter.
You can also use filters to help specify exactly which contracts you want to display in the matrix.
To create an Options Spread Matrix
1. Open the SpreadTrader by clicking the SpreadTrader icon on the trading toolbar.
2. Enter an underlying symbol in the Underlying field and hit Enter.
3. With your mouse, select Options Combos for XXX, and then select an exchange/currency.
4. In the Option Spreads window, select a combination strategy. Once you do this, every available
spread for that underlying is displayed in the right panel.
The number of parameters shown under the Filter section; Some have two (such as a conversion or Buy
Write) while others, like the Butterfly, have 5 or more. You can use these filters to limit the number of
combinations that appear in the right panel.
5. Hit the Next button at the bottom of the window to see the Configure Table Variables box.
Each variable is represented by a section in the box, with Column Variable, Row Variable or Fixed
Value choices. A variable means that the combination parameter can use multiple valid values. For
example, for a Calendar spread there are two variables for the right: put and call. If you select Call
(which filters out the puts) it's no longer a variable, it's a fixed value. In that case, you won't see P/C
in the variables list.
6. For each variable, check a radio box to instruct it to display as a row or column, or be used as a fixed
value. Checking Row will create a row for every possible combination of row variables. Checking
Column will display a column for every possible combination of column variables. Checking Fixed
value will invoke another selection box where you choose a single value for the parameter.
For example, our Calendar spread has five parameters: Front month, Back month, P/C, Duration, and
Strike. We filter out all but two Front months (20061020 and 20061117) and two Back months (20061117
and 20070119) and all but six potentially valid strike prices, and leave everything else as is. Since the only
valid duration is one month, the Duration parameter is no longer considered a variable. That leaves two
variables in the P/C category (put and call) and multiple strike variables.
Hit Next to lay out our matrix using the four variables, and choose Column Variable for the Front month
and the Strike, and Row Variable for the Back month and the right. When you click Finish you'll see
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something like this, where the Back month and the rights comprise the rows, and the Front month and
Strikes comprise the columns.

What are you looking at?
Each row is divided into sections of market data for the column variables you picked, in this case for the
front month and strike. If you could scroll across in this picture, you'd see the first of two Front months we
picked (20061020) occurring in six blocks, once with each different strike price. Then you'd see the second
front month, again once with each different strike price.
You see all the rows that are available, since our variables included only two back months and call/put. If
you want to make any changes to the layout and combinations displayed, click the Options Wizard button
on the toolbar.
Note: If you receive a message saying you have too many combos to subscribe to market data,
and you don't go in and filter your results further, the prices will not update, and the matrix title will
read "...Snapshot" instead of "...Realtime."

TWS Blotter
The Blotter integrates seamlessly with TWS to provide a more robust OMS system.
Using the TWS Blotter
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Using the TWS Blotter
The Blotter is part of our suite of specialized order management tools, and is the foundation of the IB OMS.
Log into TWS to access the Blotter and other OMS functionality.

TWS Guide

385

Chapter 1

Understand the Blotter Interface

To open the Blotter
1. Log in to TWS.
From the Trading menu, select Blotter.
Or, click the Blotter icon on the trading toolbar.

Understand the Blotter Interface
Traders use the Blotter window to receive and create tickets, and to create and manage orders.
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The Blotter comprises these main sections:
The Manual Ticket Entry/Rapid Ticket Entry panel, used to manually create new tickets.
The Tickets panel which displays manually created and electronic tickets, and the ongoing order
status.
The Orders panel, used to modify and submit client orders.
The Trades panel, which displays summary and drill-down execution reports.

Electronic tickets via FIX are accepted via a pop-up notification box, and other tickets can be entered
manually by the trader using the Manual Ticket Entry panel. Once an order is accepted or added, you can
manage all aspects of your clients’ orders from this single Blotter window.
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Manual Ticket Entry
You can enter manual tickets from the Blotter by typing an underlying or contract symbol in the Underlying
field of the Manual Ticket Entry panel. You can also enable ticket entry from other TWS windows, or add
tickets to the Manual Ticket Entry panel from the right-click menu on a market data line.
To enter a manual ticket from the Blotter
1. Enter the underlying symbol in the Contract field, and hit Enter.

2. Use the Contract Selection list and Contract Selection box to define the contract.
3. In the Account field, select the beneficial account for the order. Select the Action (BUY or SELL),
the Quantity and the order Type (Limit or Market for the parent order).
4. Click Add to put the order into the Tickets panel.
If you know the contract symbol you can enter a ticket quickly using symbol shorthand.
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To enter a ticket using symbol entry
In the Underlying field, enter the contract symbol and routing choice as: symbol#routing
You can also instruct TWS to create blotter tickets for orders you initiate on other TWS windows.

To enable ticket entry from other TWS windows
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1. From the Edit menu select Global Configuration.
2. In the left pane, select Orders.
3. In the right pane, check Create ticket for all orders.
Checking this feature tells TWSto send all of your orders to the Blotter for order management, regardless
of the window from which the order originated.

To create a manual ticket entry from the right-click menu in another window
1. Select the market data line for which you want to create a ticket.
2. From the right-click menu, select Trading Tools and then select Blotter.
The Manual Ticket Entry panel of the Blotter now displays the contract.
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Advisor Allocations
An allocation method can be defined during manual ticket entry, and this designation is retained with the
order and applied when the order fills.

To allocate shares
1. From the Manual Ticket Entry panel, create a ticket.
2. In the Allocation field, use the drop-down picklist to choose an allocation group, profile, or a single
account.
As the order is processed, the assigned allocation remains and is applied when the order fills.

Receive Electronic Tickets
You are notified of incoming FIX tickets by a pop-up order notification window.
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Click Accept for a single order to put a single ticket into the Tickets panel.
Click Accept All to put all tickets into the Tickets panel.
Click Reject to cancel a single ticket.
Click Reject All to cancel all tickets.
If you are not logged in when a ticket is received, it is sent to the next available trader.
You can assign sounds to specific events to help you recognize receipt of an electronic ticket, modification
request of a electronic ticket, and a cancel request for an electronic ticket.
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To assign sounds to events
1. On the Configure menu select Global Configuration.
2. In the left pane select Sound Manager, and in the right panel check the events to which you want to
assign a notification sound.
3. Use the down arrow to display and select from available system sounds. Use the Browse button to
find a sound file to apply.
Click the “Play” arrow to hear the sound you have chosen.
4. In the Repeat Count field, modify the default setting if you want to notification to play more than once.

TWS Guide

393

Chapter 1

Use Color Grouping to Link Blotter Windows

Use Color Grouping to Link Blotter Windows
Creating a windows group that includes the Blotter provides a shortcut for creating manual tickets. For
example, assume you want to create an options order on IBM. Without grouping, you’d need to create the
line in the Manual Ticket Entry of the Blotter, then enter IBM into the OptionTrader to get the option chains.
With the windows, grouped, as soon as you enter IBM in the Blotter, the OptionTrader receives this entry
and is populated with IBM chains automatically.

Assign windows to a "group" to link order and ticker actions. You assign a window to a group using the
colored blocks on the top right of the title bar. All windows with the same color are part of the same group.
When you change focus on one of the group's "Source" windows, all destination windows in the group
reflect the change.
Any window that can be part of a group will display the blocks. A window can be part of one group at a time.
When you close the window, its group affiliation is erased.
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The window's designation is displayed in a mouse-over tooltip when you hover over the Group icon. A
window can be a:
Source - this is a controlling window and can only SEND instructions. The Blotter window is a source-only
window.
Destination - this is a receiving window, and can only RECEIVE instructions from a window with Source
privileges.
Source/Destination - this is a multi-tasking window which can both SEND instructions to and RECEIVE
instructions from other windows in the group. The OptionTrader window is both a Source and Destination
window.
Create a Blotter group
1. From the top corner of the Blotter window, display the Group dropdown and select a group.
2. Open a window you want to group, for example the OptionTrader, and select the same group number/color.
The OptionTrader and Blotter windows are now grouped. Open the windows side-by-side. In the Blotter,
enter an underlying in the Manual Ticket Entry panel, and see how the OptionTrader data automatically
changes to reflect the Blotter entry.

Using the Tickets Panel
Accepted electronic orders are staged in the Tickets panel. Only limit and market orders can be accepted.
You create orders from the ticket lines in the Tickets panel.
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To create an order from a ticket
1. Right-click a ticket and select Create Order, or
2. Click the Action (Buy or Sell) on the ticket line.
You can open other TWS trading tools from the ticket and modify order parameters within the other tool.
Manage Orders
Orders are created from the Tickets panel and display in the Orders panel for modification and
transmission. These orders are "child orders" of the original ticket, and must stay within any price, type or
Time in Force limitations defined in the parent order.
Cancel the entire ticket.
Cancel all child orders associated with the ticket WITHOUT cancelling the ticket.
Monitor the order status for each ticket.
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Orders are displayed in the Orders panel (see below) with a default Quantity. You can modify the quantity
per order, and change the default for specific products using the Order Preset Strategies in Global
Configuration.

To cancel a ticket
Right-click the ticket line and select Cancel this ticket, or
Click the yellow “C” in the Cancel field and then click Cancel this ticket.
Canceling from the Tickets panel cancels the entire client order and any working components. Clients
receive a cancelled order notice. To cancel a single child component of the order, cancel directly from the
child order in the Orders panel.
To cancel all child orders
Right-click the ticket line and select Cancel open orders for this ticket.
The child orders are canceled but the original order ticket is not canceled.

Using The Orders Panel
The Orders panel is where you actively manage orders.
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Note: The relationship between parent/child orders is shown via the Key field in the Tickets,
Orders and Trades panels . Every new child order is numbered sequentially and colored to indicate
its relationship to the original order.
You can modify the following parameters for a child order:
Order Quantity, which can be modified to be equal to or less than the quantity in the Leaves status
field for the order in the Tickets panel.
Limit Price (with restrictions) - you cannot adjust the price to be more aggressive than the client’s original price, i.e. you cannot increase the price for a buy order, or decrease the price for a sell order.
Order Type (with restrictions) including:
Limit tickets can only be sent as a limit or relative orders.
Market orders can be submitted as: market, limit, stop, stop limit, trailing stop, trailing stop limit and
volatility. For more information on IB order types, see the Order Types page on the web site.
Time in Force - use the drop-down menu to choose from Day, GTC, OPG, IOC or GTD.
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You must set the TIF for a child order equal to or shorter than that of the parent. Otherwise, the TIF of the
parent order will override that of the child order.
Destination - choose a new routing destination for the order, create a new “Away” destination, or
route to another desk within your firm.
To transmit an order
1. Modify order parameters by clicking in the appropriate field and selecting or entering a new value.
Use the price or size “wand” to set a parameter by clicking and holding the mouse button in a field.

2. Click the “T” in the red Status field to transmit the order.
To cancel an order
Transmitted child orders show a “C” in the yellow Status field. Click to cancel the order.
Note: To create a new order, right-click the original ticket in the Tickets panel.

What is an Away Destination?
For order management purposes, the Blotter allows you to manually create “Away” destinations and to
manually report trades executed away from IB. This data will be reflected in the order status fields and the
Trade reports.
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To create an Away destination
1. From an order in the Orders panel, click the Destination field dropdown.
2. Choose Add/Edit destination at the bottom of the list.
3. In the Away Destinations box, enter the title that will display in the Destination list, and the
Exchange/Destination to which the order will be sent.
4. Click OK. The new destination now appears in the dropdown list and is the selected destination for
the current order.
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The order quantity transmitted to your away exchange is reflected in the order status columns of the
Tickets panel. In the example above, a quantity of 12 was routed to the best ex away exchange. The status
reflects 12 routed, 25 still left, and 12 working.
It is important to note that orders “transmitted” to your away destinations are not handled by IB. An away
destination is simply an order-management tool that allows a place-holder within the Blotter for orders you
will manage away from IB.
Add “Away Trade” Data to Blotter
To help manage your orders, the Blotter allows you to manually include trade data from orders filled away
from IB.
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To report away trades
1. Highlight the Away trade order line in the Orders panel. Note that you will only see the Report Trade
command if you are on an Away trade order line.
2. From the right-click menu, select Report Trade.
3. In the Report Trade box, enter the quantity, price, destination, exchange and time of execution.
This information will be used by the Blotter to display trade data.
4. Click Accept. The information you specified is now incorporated into both the Order Status data in
the Tickets panel and the execution data in the Trades panel.
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Manage Orders with TWS Algos and Tools
Manage client orders using sophisticated TWStrading tools and algos. The IB OMS supports order
management using the following tools and algos:

Accumulate Distribute (for stocks)
ScaleTrader (for stocks and options; market orders only; no support for profit taking child orders)
IB Stock algos including Arrival Price, Percentage of Volume Strategy, TWAP and VWAP
IB Option algos including Balance Impact and Risk, and Minimize Impact
BookTrader
Market Depth
ChartTrader
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The Integrated Stock Window (ISW)
The Order Ticket

To manage a Blotter ticket from a different tool
1. Select the ticket and use the right-click menu to select Trading Tools.
2. Choose the trading tool. The tool will open, populated with the selected ticket information.

Reading the Trades Panel
Filled sub orders are removed from the Orders panel, and the parent order is removed from the Tickets
panel once the entire order has filled. The Trades panel displays real time trade reports with a drill-down
feature to view a breakdown of executions at each price level.

Use the Filter panel to view only those orders that meet the filter criteria.
Check Show filled and canceled orders to display these orders.

Display Orders by Filter Criteria
Although associated orders are visually linked by color and number Key, as shown in the picture below,
you may want to have only a single order family on the screen, or you may need to view a specific subset of
orders based on other criteria, for example all orders for Client A, or all orders on underlying ABC. The
Blotter provides two filtering strategies:
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To filter out all orders except for one order family, the Key field for the relevant child order in the
Orders panel. Click the child key again to clear the filter and show all order families.
To filter out all orders except those that meet other criteria, use the Filter panel to specify display criteria.

Find the Filter panel at the bottom of the Blotter window. Use these fields to filter by criteria other than a
group of associated orders (the Key). Filtering criteria applies across order information in all panels,
including the Tickets, Orders and Trades panels.

To use the filter panel
1. Enter the filter criteria, such as a client name, underlying symbol or action, and hit Enter.
2. To remove the filter and see all orders, click Clear Filter.
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Order Sharing Modes
Depending on the sharing properties defined for your trading group, you may have permission to view and
manage orders received by other traders as well as manage your own orders. You may be enabled for one
of three possible modes:
Full sharing - this mode displays all orders for all traders in the Orders panel of your blotter. Display the
Submitter field to see who last touched each order.
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To display the Submitter field
1. In the Orders panel, right-click in the column headings and select Customize Layout.
2. Click the Order Columns tab, and in the Available Columns list expand the Status category.
3. Select Submitter and use the “Add +” button to move the field to the Shown Columns list.
Note: Use the Up and Down arrows to position the location of the field relative to the other order fields.
Login sharing - this mode requires you to log in to another user’s Blotter before you can access their
orders. A separate tab is created for each login, and that users orders are displayed only on their tab.
No sharing - this mode only allows you to view and manage the orders you accepted or created.
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To log into another user’s Blotter
1. Right-click the My Blotter tab.
2. Select Open Blotter for Another User, and enter the user’s IB username.
Click OK. The other user’s interface opens under a new tab in your Blotter window.

Configure the Blotter Panels
You can hide or display columns in the Blotter panels using the panel-specific layout manager in Global
Configuration.

To show or hide Blotter columns
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1. From the top left of any panel, click the Configure wrench icon.
2. In the right pane, select the tab for the columns you want to modify. You can choose Market Data
Columns or Order Columns.

3. Field in the Shown Columns list are visible on your trading panel. To display other fields on your trading panel, select from the Available list and add to the Shown list.
4. To remove columns from the trading panel, select fields from the Shown list and remove to the Available list.
Bolded titles indicate columns that cannot be removed from the panel display.
You can change the order in which the fields are presented on a panel using the vertical up and down
arrows in the Shown Columns list. In the picture below, I’ve moved the Key field to the right on my Tickets
panel so that it displays next to the Total Quantity field.
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To change the column order
1. In the Shown Columns list, click on the field that you want to move.
2. Click the arrows to move the column:
Moving the field UP in the list moves it to the left on the screen.
Moving the field DOWN in the list moves it to the right on the screen.
Panels that use the double-row layout can also be moved directly from the screen by dragging and
dropping a column to a new location.
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Trade Volatility
Trade volatility with our volatility tools and algos.
Volatility Trading

411

Attach a Delta Hedge Order

414

Volatility Trading

416

Volatility Trading
The VOL order type allows you to trade volatility, and provides ways to dynamically manage your options
orders.

To trade Volatility
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1. From the Trading Tools menu, select Volatility Trader. The fields used to define and dynamically
manage volatility orders are on the new page.
2. Create market data lines. Note that Bid and Ask price fields display in volatility rather than as a dollar
amount. Market data for stock tickers will still display the bid and ask price.
3. Select Annual or Daily volatility using the Volatility Type dropdown list.
4. Create an order by clicking the Ask volatility for a Buy order, or the Bid volatility for a Sell order. The
order type defaults to VOL.
Note: You can use the VOL order type for equity options, index options and combination
orders. Hold your cursor over the option's volatility to see the option price, based on that
volatility.
Please note the following requirements for transmitting a VOL combination order:
Combo VOL orders must be Smart-routed.
All legs must be on the same underlying, and each leg must independently be eligible to use the
VOL order type. For example, a BuyWrite order could not be sent as a VOL order since its stock
leg would not allow this order type.
All VOL orders must be DAY orders.
You can elect to price a Smart-routed Index Option order using reverse futures premium
calculations by selecting a futures contract from the Reference Contract field.
If you have changed the reference contract in the Model Navigator, VolatilityTrader will used the
new contract as the default reference contract.
5. To have the workstation calculate a limit price for the option or combination order based on your
volatility input, enter a value in the Order Volatility field. The value shown in the Imp Vol field is calculated via the Model Navigator.
6. To transmit the order, click the "T" in the Transmit field, or the Transmit icon on the trading toolbar.

Field

Description

Volatility

If desired, enter a volatility to use in calculating a limit price for the option. If blank,
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Option Analytics.
Volatility

Select from Daily or Annual volatility.

Type
Hedge

Select an order type. The application will send an order against the executed

Order Type

option trade to maintain a delta neutral position. Use the Hedge Aux. Price field to
set a price for orders that require one. Note that for index options, you will need to
select a futures contract for use in a hedge delta trade.
Alternately, you can use the right-click menu to attach a Delta Hedge order and set
the hedging attributes from the new order line.
Please note that if you select Continuous Update, the system will use the delta
associated with the parent order, which is calculated from the user-defined Implied
Volatility specified at the time of the most recent order modification or price update,
instead of using the current delta of the option based on market data at the time of
trade.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the
time the parent order fills, and the best available price is used as the limit price
(best ask for a buy and best bid for a sell).

Hedge Aux.

Used in conjunction with the Hedge Order Type field. If you have selected an order

Price

type that requires you to define a price, for example a relative order, use this field to
set the price.

Continuous

Check this selection to continuously update the price of the order if the price of the

Update

underlying instrument changes significantly. Note that you can only check
Continuous Update for three active orders at a time.

Reference

Elect to use the NBB (bid) when buying a call or selling a put; the NBO (ask) when

Price Type

selling a call or buying a put; or the average of the best Bid and Ask. This price is
also used to compute the limit price sent to an exchange (whether or not
Continuous Update is selected), and for stock range price monitoring.
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Stock Price

Undrl. Range (Low) - enter a low end acceptable stock price relative to the

Monitoring

selected option order. If the price of the underlying instrument falls BELOW the
lower stock range price, the option order will be cancelled. Merely touching the
price does not cancel the order.
Undrl. Range (High) - enter a high end acceptable stock price relative to the
selected option order. If the price of the underlying instrument rises ABOVE the
upper stock range price, the option order will be cancelled. Merely touching the
watermark does not cancel the order.

Reference

Used for smart-routed Index Option volatility orders. This field allows you to select

Contract

the futures contract to use for calculating the implied volatility. To activate this
feature, use the Volatility and Analytics page in Global Configuration and
selectPrice index options relative to futures contract.

For a more detailed description of Trailing Stop orders visit the Order Types information page.

Attach a Delta Hedge Order
Attach a delta hedge order to an options order, and as an alternative to setting a hedge order attribute in
the original Volatility order line.
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To attach a Delta Hedge order
1. From the right-click menu, select Attach and then select Delta Hedge.
A new linked delta hedge order line displays. The link between the parent and child orders is
illustrated in the Key field.
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2. Select an order type for the hedging order (Limit, Market or Relative).
Please note that when you attach a delta hedge order to a Volatility order with Continuous Update or to a
Relative/Pegged-to-Stock order, the system will use the delta associated with the parent order instead of
using the current delta of the option based on market data at the time of trade. For Volatility orders, this
delta is calculated from the user-defined Implied Volatility specified at the time of the most recent order
modification or price update. For Relative/Pegged-to-Stock orders, this is the delta specified by the user.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the time the parent order fills,
and the best available price is used as the limit price (best ask for a buy and best bid for a sell).

Volatility Trading
The Volatility order type lets you create option orders where the limit price is calculated as a function of an
option volatility that you can modify. If you did not create the order from the VolatilityTrader, you can
activate the Volatility tab by selecting VOL as the order type on the Basic tab. If you have attached a delta
hedge order from the trading window, you can view the order parameters on the Hedging tab.
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To remove tabs and view all fields on a single large page, select the Comprehensive view.
Field

Description

Volatility

Displays the volatility used to calculate a limit price for the option. The value shown
in the Imp Vol field is calculated via the Model Navigator.

Continuously

When checked, the option price is automatically updated as the underlying stock

Update Limit

price moves.

Price
Precautionary
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Settings

remains within an acceptable distance from the market.

Volatility

Elect to view daily or annual volatility.

Type
Hedge Delta

Select a Hedge Order Type. An order will be submitted against the executed option
trade to maintain a delta neutral position.
For index options, you can define the Hedging, or reference, contract. If you have
modified the reference contract in the Model Navigator, the modified contract will be
used as the new default reference contract for the order.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the
time the parent order fills, and the best available price is used as the limit price (best
ask for a buy and best bid for a sell).
Use the Hedge Auxiliary Price field to set an auxiliary price for orders that require
one, such as the offset for a Relative order.

Reference

Bid or Ask - If selected, use the NBB (bid) when buying a call or selling a put and the

Price Type

NBO (ask) when selling a call or buying a put.
Average - uses average of the best Bid and Ask. This price is also used to compute
the limit price sent to an exchange (whether or not Continuous Update is selected),
and for underlying range price monitoring

Reference

Select a futures contract to use in calculating the index value. The order price is

Contract

then derived from this index value.

Underlying

Underlying Range (Low) - enter a low end acceptable stock price relative to the

Price

selected option order. If the price of the underlying instrument falls BELOW the

Monitoring

lower stock range price, the option order will be cancelled. Merely touching the
price does not cancel the order.
Underlying Range (High) - enter a high end acceptable stock price relative to the
selected option order. If the price of the underlying instrument rises ABOVE the
upper stock range price, the option order will be cancelled. Merely touching the
watermark does not cancel the order.
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Write and Roll Options
Use the Write Options tool to sell calls against long stock positions and sell puts against your short stock
positions. Use the Rollover Options tool to roll over options that are about to expire to a similar option with a
later expiration date.
Write Options

419

Write/Roll Options: Option Chains

421

Rollover Options

422

Write Options
Advisors can use the Write Options tool to quickly see all of their sub-account’s long and short positions and
to write options orders against their uncovered stock.
Open the Write Options tool
From Mosaic: Use the New Window drop down and select More Advanced Tools and then select Write
Options.
From Classic TWS: From the Trading Tools menu, scroll to the Options Focus section and select
Write Options.
Advisors will see the Select Account dropdown that lists all of their Account Groups and individual subaccounts.
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To use the Write Options tool
1. Select an Account Group, an individual sub-account, a Model or All accounts.
2. Describe the options to buy and sell:
If you are writing covered calls on your long stock positions, note that you can also choose to buy
protective puts to create a collar combo.
If you are writing covered puts on short positions, you can also elect to buy protective calls to create a collar combo.
3. Confirm or modify any conditions on the options and click Refresh to update the list of options to
write.
4. The Review Options to Write list includes any positions for the account(s) you selected, the quantity of the position that is uncovered (has no options written against it) and the options that meet the
criteria specified. Note that all options are selected by default. Click a check box to deselect the
option for any account.
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5. Click the pencil icon next to the option to open the Option Chains and select a different option to buy
or sell.
6. Review or change the Order Type and price information and click Create Orders.
7. Orders will display in the Orders panel; click Transmit All to submit, or submit one order at a time
using the Transmit button in the Status field.

Write/Roll Options: Option Chains
To select different options to buy or sell in the Write Options tool, click the pencil icon on the line you want to
change and use the Option Chains to select a new contract.

To select a new option to buy or sell
1. From the Review Options to Write list, click the pencil icon on the far right of the option line you
want to change.
The Option Chains window opens with the currently selected call and/or put contracts highlighted.
Calls display to the left of the Description column and puts display to the right.
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2. To select a new call option, click the desired description on the left side. You will see the call option
highlighted. To select a put, click the description on the right side.
3. Click OK when the new options have been selected.

Rollover Options
Quickly see all of your sub-account’s options that are about to expire and roll them over to the next month's
contract
To roll over options
1. Open the Rollover Options tool:
From Mosaic: Use the New Window drop down and select More Advanced Tools and then
select Rollover Options.
From Classic TWS: From the Trading Tools menu, scroll to the Options Focus section and
select Rollover Options.
Advisors will see the Select Account dropdown that lists all of their Account Groups and individual subaccounts.
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To use the Roll Options tool
1. Advisors Only: Select an Account Group, an individual sub-account, or All accounts.
2. Choose whether you want to write calls on long stock positions, or write puts on short stock positions.
3. Use the default description or modify any conditions on the options, and click Refresh.
The list of Options to Roll includes any option positions for the account(s) you selected and the roll-to option
that meets the criteria specified.
4. Click the pencil icon next to the option to open the Option Chains and select a different option to buy
or sell.
5. Review or change the order information and click Create Orders.
6. Orders will display in the Orders panel; click Transmit All to submit.
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Algorithmic Trading
Algos can help to balance market impact with risk to get the best price for large volume orders. Our growing
family of algos includes the following:
About IB Algos
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Adaptive Algo

430

Arrival Price

431

Close Price Strategy

433

Dark Ice
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Percentage of Volume Strategy

435

Price Variant Percentage of Volume Strategy
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Size Variant Percentage of Volume Strategy

438

Time Variant Percentage of Volume Strategy

439

TWAP

440

VWAP

441

Minimize Impact
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Balance Impact and Risk
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Accumulate Distribute Algo
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Get Started
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Define the Algorithm
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Basic Algorithm Example
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Using Templates
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Define Algo Conditions

452
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Create Multiple Algo Orders

454

Transmit and Modify the Algo

455

Monitor the Order Progress

456

Fox River Algos

456

Dark Sweep

458

Fox Alpha

459

Fox Blaster™

462

Fox Dark Attack™

463

Fox River Pyramid™

465

Fox Smart Order Router

469

Fox Spotlight™

471

Percent of Volume (POV)

473

Fox TWAP

474

TWAP (Fox River)

477

Fox VWAP

479

VWAP (Fox River)

481

CSFB Algos

483

CSFB Auction

484

CSFB Blast

485

CSFB Close

486

CSFB Crossfinder+

487

CSFB Float

489
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CSFB Float Guerrilla

492

CSFB Guerrilla

494

CSFB Price Inline

497

CSFB I Would

499

CSFB Lightpool

502

CSFB Pathfinder

503

CSFB Pre/Post

504

CSFB Reserve

505

CSFB Sniper

508

CSFB Tex

510

CSFB TWAP

512

CSFB Volume Inline

515

CSFB VWAP
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Jefferies Algos

520

Jefferies Blitz

521

Jefferies DarkSeek

522

Jefferies Finale

525

Jefferies Multi Scale

527

Jefferies Opener

530

Jefferies Pairs - Net Returns

533

Jefferies Pairs - Ratio

534

Jefferies Pairs - Risk Arb

536
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Jefferies Patience

538

Jefferies Portfolio

541

Jefferies Post

544

Jefferies Seek

546

Jefferies Strike

550

Jefferies Trader

553

Jefferies TWAP

554

Jefferies Volume Participation

558

Jefferies VWAP

561

QB Algos

564

QB Bolt

564

QB Strobe

567

QB Closer

569

QB Octane

571

Option Portfolio

573

Get Started
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Define and Submit the Query
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Constrain the Query Results

582

Evaluate the Solution

583

View What-if Risk in the IB Risk NavigatorSM
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ScaleTrader
About ScaleTrader
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Basic Scale Orders
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Example 1: Basic Scale Order

594

Basic Scale with Profit Orders
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Example 2: Scale order with Profit-Taking Orders
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Scale Profit Orders with Initial Component
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Example 3: Scale with Profit and Initial Component size
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Scale Profit with Restore Size
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Example 4: Scale order with Restore Size
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Example 5: Restart ScaleTrader
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Example 6: Restart ScaleTrader with Filled Initial Component Size
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ScaleTrader for Pairs

612

Use the ScaleChart

614

View Scale Progress
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Scale Order Examples
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Combo Orders

618

ScaleTrader Summary
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About IB Algos
Our proprietary IB Algos are designed to help balance market impact with risk on your large volume orders.
A brief overview of our expanding family of IB Algos is shown below. Click an algo to find out more:
Adaptive: Attempts to achieve the fastest fill at the lowest all-in price.
Arrival Price: Attempts to achieve the bid/ask midpoint at the time that the order was submitted.
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Balance Impact and Risk: Balances the market impact of trading the option with the risk of price change
over the time horizon of the order.
Close Price: Designed to minimize slippage with respect to the closing price by slicing orders into smaller
quantities and executing them in the continuous market just before the close.
Dark Ice: Like an Iceberg/Reserve order, Dark Ice exposes only a fixed, small amount of the total order
quantity at a time, but the Dark Ice algo also randomizes the display size based on the probability of the
price moving favorably.
Minimize Impact: Lets you control participation in the Average Daily Options Volume, and tries to minimize
market impact by slicing the order over time to achieve a market average without going over the userdefined Max Percentage value.
Percentage of Volume: Helps clients limit the contribution of their orders to the overall average daily
volume, thereby minimizing the impact that their orders have on the price of the instrument .
Price Variant Percentage of Volume: This algo lets you participate in the average daily volume at a userdefined rate that varies over time, depending on the market price of the security.
Size Variant Percentage of Volume: This algo lets you participate in volume at a user-defined rate that
varies over time, depending on the remaining size of the order.
TWAP: Aims to achieve the time-weighted average price calculated from the time you submit the order to
the time it completes. Incomplete orders at the end of the stated completion time can continue to fill if the
box 'allow trading past end time' is checked.
Time Variant Percentage of Volume: A customizable IB algo that lets you participate in the Average Daily
Volume at a user-defined rate that varies with time. You define the target percent "rate of participation" at
the start and end time, and the algo calculates the participation rate over time between the two. This allows
your order to work more aggressively at the start and less so at the end, or vice versa.
VWAP: The best-efforts VWAP algo seeks to achieve the Volume-Weighted Average Price calculated
from the time you submit the order to the close of the market. The best-efforts VWAP algo is a lower-cost
alternative to the Guaranteed VWAP.
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Adaptive Algo
This algo can be used with a limit or market order, and is designed to achieve better than average cost
efficiency over basic limit and market orders by attempting to trade market and aggressive limit orders
between the spread. You can specify how urgently you want the order to fill using the "priority/urgency"
selector in the algo window.
To create an Adaptive algo market order
In the Mosaic Order Entry panel, click the Adaptive button.
Select the side (BUY or SELL).
To change the fill priority (which by default is set to "Normal") click advanced to open the algo parameters
and use the drop down selector list:

Urgent: Scans available prices most quickly to fill, and so provides lowest chance of price improvement, and lowest chance of price variance.
Normal (default): Scans available prices less quickly than "Urgent," and so provides a good chance of
price improvement and an average chance of price variance.
Patient: Scans available prices most slowly to fill, and so provides the highest chance of price improvement and also the highest chance of price variance.
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Click Submit to send.

To create an Adaptive algo limit order
In the Mosaic Order Entry panel, click the Adaptive button.
Use the Price Line, "% of Spread" wheel or "+/- Tick" wheel to quickly set a limit price within the spread.
Select the side (BUY or SELL).
To change the fill priority (which by default is set to "Normal") click advanced to open the algo parameters
and use the drop down selector list:
Urgent: Scans available prices most quickly to fill, and so provides lowest chance of price improvement, and lowest chance of price variance.
Normal (default): Scans available prices less quickly than "Urgent," and so provides a good chance of
price improvement and an average chance of price variance.
Patient: Scans available prices most slowly to fill, and so provides the highest chance of price improvement and also the highest chance of price variance.
Click Submit to send.
See the Adaptive Order Types page to find out more about Adaptive Algo orders.

Arrival Price
This strategy is designed to achieve or outperform the bid/ask midpoint price at the time the order is
submitted, taking into account the user-assigned level of market risk which defines the pace of the
execution, and the user-defined target percent of volume.
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To create an Arrival Price algo
Set up the order in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select Arrival Price.
Complete the algo parameters and click Submit to send the order.
Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.
Urgency/Risk Aversion - select from the most aggressive Get Done to the least aggressive Passive.
This value determines the pace at which the order will be executed. High urgency may result in greater
market impact.
Start time/End time - change the default times at which the submitted order will start to work and be
canceled using the Start/End Time fields. The End Time supersedes the time in force. Note that the
algo will stop at the designated end time regardless of whether the entire quantity has filled unless you
check Allow trading past end time.
Allow trading past end time - if checked, the algo will attempt completion by the specified end time, but
will continue to work past the end time to execute any unfilled portion. This feature only applies when
an End Time has been specified.
Attempt completion by EOD - if checked your order will be execute by the end of day if possible. Please
note that a portion of your order may be left un-executed if the risk of the price changing overnight is
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less than the extra cost of executing the whole order today regardless of whether the EOD box is
checked.
For more information on IBAlgos, see the IB Order Types and Algospage.

Close Price Strategy
The Close Price algo is designed to minimize slippage with respect to the closing price by slicing orders into
smaller quantities and executing them in the continuous market just before the close. It considers the userassigned level of market risk, the user-defined target percentage of volume, and the volatility of the stock in
determining how long before the close it should start executing the trade, and the pace at which the trade
should be executed.
This strategy is especially useful when the volume to be executed is large relative to the average close
auction volume and submitting the entire order into the close auction via an MOC or LOC order would
adversely impact the closing price.

To create a Close Price algo
Set up the order in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select Close Price.
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Complete the algo parameters and click Submit to send the order.
Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.
Urgency/Risk Aversion - select from the most aggressive Get Done to the least aggressive Neutral.
This value determines the pace at which the order will be executed. High urgency may result in greater
market impact.
Start time/End time - change the default times at which the submitted order will start to work and be
canceled using the Start/End Time fields. The End Time supersedes the time in force. Note that the
algo will stop at the designated end time regardless of whether the entire quantity has filled unless you
check Allow trading past end time.
Attempt completion by EOD - if checked your order will be execute by the end of day if possible. Please
note that a portion of your order may be left un-executed if the risk of the price changing overnight is
less than the extra cost of executing the whole order today regardless of whether the EOD box is
checked.

Dark Ice
The Dark Ice algo is similar to an iceberg or reserve order, as it allows the user to specify a display size
different from the order size, which is shown in the market. Additionally, the algo randomized the display
size +/- 50%, and based on the calculated probability of the price moving favorably, it decides whether to
place the order at the limit price or one tick lower than the current offer for buy orders and one tick higher
than the current bid for sell orders.
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To create a Dark Ice algo
Set up the order in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select Dark Ice.
Complete the algo parameters and click Submit to send the order.
Display Size - enter a size that you want displayed to the market. Note that the algo will randomize the size by 50% on either side.
Start time/End time - change the default times at which the submitted order will start to work
and be cancelled using the Start/End Time fields. The End Time supersedes the time in
force. Note that the algo will stop at the designated end time regardless of whether the
entire quantity has filled unless you check Allow trading past end time.
Allow trading past end time - if checked, the algo will attempt completion by the specified
end time, but will continue to work past the end time to execute any unfilled portion. This feature only applies when an End Time has been specified.
For more information on IBAlgos, see the IB Order Types and Algos page.

Percentage of Volume Strategy
Allows you to participate in volume at a user-defined rate. Order quantity and volume distribution over the
day is determined using the target percent of volume you entered along with continuously updated volume
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forecasts calculated from TWS market data.

To create a Percentage of Volume algo
Set up the order in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select Percentage of Volume.
Complete the algo parameters and click Submit to send the order.
Target Percentage - enter the target percentage of participation in average daily volume.
Start time/End time - change the default times at which the submitted order will begin to work and be
cancelled using the Start/End Time fields. Note that the algo will stop at the designated end time
regardless of whether the entire quantity has filled.
Attempt to never take liquidity - check to ensure the algo order will not hit the bid or lift the offer if possible. This may help to avoid liquidity-taker fees, and could result in liquidity-adding rebates. However,
it may also result in greater deviations from the benchmark.
IB will use best efforts not to take liquidity, however, there will be times that it can not be avoided.
For more information on IBAlgos, see the IB Order Types and Algospage.
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Price Variant Percentage of Volume Strategy
This algo allows you to participate in volume at a user-defined rate that varies over time based on the price
of the security. It lets you buy more aggressively when the price is low and less aggressively as the price
increases, and just the opposite for sell orders.
To recalculate the percent of volume applied with each price change:
Target Percentage - 100 x Order Side x Target Percentage Change Rate x
Percent change in price
where Order Side = 1 for buy, -1 for sell.

To submit a Price Variant Percent of Volume Order
Set up the order in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select Price Variant Percentage of Volume.
Complete the algo parameters and click Submit to send the order.
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Initial Target Percentage of the average volume to start off the order. Enter "1" for 1% etc.
Target Percentage Change Rate will control how the target percent of volume will be adjusted with
respect to price changes to the underlying. Each price change triggers a new calculation for the current
percent of volume.
Specify a Minimum and Maximum target percentage if desired.
Specify the start time and end time if needed. Otherwise the algo will start when you transmit the order
and end at the market's close.
Attempt to never take liquidity - If checked the order is guaranteed not to hit the opposite side, and
it will trade at a price better than or equal to the limit price.

Size Variant Percentage of Volume Strategy
This algo strategy allows your order to work more aggressively at the start and less aggressively towards
the end, or vice versa. It lets you participate via volume at a user-defined rate that varies with time based on
the remaining order quantity.

To submit a Size Variant Percent of Volume Order
Set up the order in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select Size Variant Percentage of Volume.
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Complete the algo parameters and click Submit to send the order.
Initial Target Percentage of the average volume to start off the order. Enter "1" for 1% etc.
Set the Terminal (or ending) Target Percentage of the average volume to end the algo. The system
will calculate the target percentage rates between the initial and terminal rates as the algo progresses.
Specify a start and end time if needed. Otherwise the algo will start when you transmit the order and
end at the market's close.
Attempt to never take liquidity - If checked the order is guaranteed not to hit the opposite side, and
it will trade at a price better or equal to the limit price.

Time Variant Percentage of Volume Strategy
This algo strategy allows your order to work more aggressively at the start and less aggressively towards
the end, or vice versa. It lets you participate via volume at a user-defined rate that varies with time based on
the initial and terminal participation rates that you specify. The algo will then calculate the rate of
participation between the start and end times.

To submit a Time Variant Percent of Volume Order
Set up the order in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select Time Variant Percentage of Volume.
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Complete the algo parameters and click Submit to send the order.
Initial Target Percentage of the average volume to start off the order. Enter "1" for 1% etc.
Set the Terminal (or ending) Target Percentage of the average volume to end the algo. The system
will calculate the target percentage rates between the initial and terminal rates as the algo progresses.
Specify a start and end time if needed. Otherwise the algo will start when you transmit the order and
end at the market's close.
Attempt to never take liquidity - If checked the order is guaranteed not to hit the opposite side, and
it will trade at a price better or equal to the limit price.

TWAP
Designed to achieve the time-weighted average price calculated from the time the order is submitted to the
close of the market.

To create a TWAP algo
Specify the order side (buy/sell) and quantity in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select TWAP.
Define parameters:
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Trade when - select from:
Marketable - the default value indicates that the order will be submitted when it is marketable, based on
your limit price.
Matching Midpoint - the order will be submitted when the limit price = midpoint of the bid/ask.
Matching Same Side - the order will be submitted when the limit price = the price on the same side as
your order (either the bid or the ask).
Matching Last - the order will be submitted when the limit price = last price.
Start time/End time - change the default times at which the submitted order will start to work and be
cancelled using the Start/End Time fields. The End Time supersedes the time in force. Note that the
algo will stop at the designated end time regardless of whether the entire quantity has filled unless you
check Allow trading past end time.
Allow trading past end time - if checked, the algo will attempt completion by the specified end time, but
will continue to work past the end time to execute any unfilled portion. This feature only applies when
an End Time has been specified.
For more information on IBAlgos, see the IB Order Types and Algos page.

VWAP
Designed to achieve or outperform the VWAP price, calculated from the time you submit the order to the
close of the market.
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To create a VWAP algo
Specify the order side (buy/sell) and quantity in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then select VWAP.
Define parameters:
Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.
Start time/End time - change the default times at which the submitted order will start to work and be
cancelled using the Start/End Time fields. The End Time supersedes the time in force. Note that the
algo will stop at the designated end time regardless of whether the entire quantity has filled unless you
check Allow trading past end time.
Allow trading past end time - if checked, the algo will attempt completion by the specified end time,
but will continue to work past the end time to execute any unfilled portion. This feature only applies
when an End Time has been specified.
If you specify and Start and End time, TWS confirms that acceptability of the time period using yesterday’s
trading volume. If the time period you define is too short, you will receive a message with recommended
time adjustments.
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Attempt to never take liquidity - Check to ensure the algo order will not hit the bid or lift the offer if
possible. This may help to avoid liquidity-taker fees, and could result in liquidity-adding rebates.
However, it may also result in greater deviations from the benchmark.
IB will use best efforts not to take liquidity, however, there will be times that it can not be avoided.
Speed up when market approaches limit price - When checked, this feature will increase the rate
of trading when the order is marketable and the market price closes the gap toward the order's limit
price, since the chance of a market move resulting in the order becoming non-marketable is high.
Checking this feature for relatively small order sizes may help to ensure a better fill rate.

Minimize Impact
Designed to minimize market impact by slicing the order over time as defined by the Max Percentage
value. This algo applies to Options only.

Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.
For more information on IBAlgos, see the IB Order Types and Algos page.
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Balance Impact and Risk
Balances the market impact of trading the option with the risk of price change over the time horizon of the
order by taking into account the user-assigned level of market risk which defines the pace of the execution,
and the user-defined target percent of volume.
This algo is for options only.

To create a Balance Impact and Risk algo
Set up the order in the Mosaic Order Entry panel.
From the LMT type field, select IBALGO and then Balance Impact and Risk.
Complete the algo parameters and click Submit to send the order.
Max Percentage - enter a max percentage of the average daily volume from 1% to 50%.
Urgency/Risk Aversion - select from the most aggressive Get Done to the least aggressive Passive.
This value determines the pace at which the order will be executed. High urgency may result in greater
market impact.
This feature is designed to affect large orders that affect a significant percentage of the average daily
volume.
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Attempt completion by EOD - if checked your order will be executed by the end of day if possible. If not
checked, a portion of your order may be left unfilled if the risk of the price changing overnight is less
than the extra cost of executing the whole order today.
For more information on IBAlgos, see the IB Order Types and Algos page.

Accumulate Distribute Algo
Use the Accumulate/Distribute algo to buy or sell large quantities in smaller, random sized increments over
time, minimizing market impact. This algo supports multiple asset classes including stocks, options, futures,
forex, and combination orders.
Customize the basic algo with conditions to meet your specific views on the market. Multi-account users
will see the Account selection list at the top of the algo page.
Orders submitted via Accumulate/Distribute currently are active only while you are logged into TWS and
stop when you log out. When you log back into TWS, answer “Yes” when asked if you want to reactivate
the algo. If you answer “No” your Accumulate/Distribute algo orders are deleted.
Get Started
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Get Started
The Accumulate/Distribute algo works to get the best price for your large volume orders while attempting to
minimize market impact. It achieves this by slicing large orders into smaller components, and accumulating
or distributing over time based on your pre-defined order parameters.

The algo window is divided into four major sections:
The Algorithm area, where you define the basic parameters of the order.
The Conditions area, where you specify conditions about price, position and market behavior that
must remain true for your order to be valid.
The order Summary, which displays continuous real-time order progress.
The Control buttons, which you use to start and stop the algo and apply changes.
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It also includes the Orders, Trades and Log panels, and the Quote panel to define the instrument .

To open the Accumulate/Distribute window
From the New Window dropdown scroll to the More Advanced Tools menu and then scroll up to
Accumulate/Distribute.
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Define the Algorithm
The Algorithm area is where you set up basic parameters of the algo. Fields shaded pink are required.

Numbered descriptions below correspond to the numbered fields in the image above.
1. Select the action, BUY or SELL.
2. Enter the total order quantity, for example 1,000,000.
3. Define the size component for each increment. For example, you may want to trade the 1,000,000
share order in 500-share increments.
4. Specify the timing of order submission for the components, in seconds, minutes, or hours. For
example, you may want to accumulate 1,000,000 shares in 500 share increments every 30 seconds.
5. Select the order type. The fields to set the price depend on the order type you select. For stock
orders, choose from:
Market - the order will attempt to fill at the current market price.
Limit - set a limit price with an optional offset amount which must be met or bettered for the order
to fill.
Relative - Set an optional offset amount, and specify a cap. The quote adjusts automatically
based on your criteria as the market moves.
RPI (Retail Price Improvement) - For stocks only. This order type is similar to a Relative order
but requires an offset of higher than zero.
6. Select time in force.
7. Set order price to ...(for RELATIVE orders) For BUY orders, use the bid plus any amount. For
SELL, use the ask minus any amount. To use only the bid/ask with no offset you must enter “0.” This
field is only visible for REL orders only and works with the following field:
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8. ...but not higher than - For RELATIVE orders, this is the price cap, which works in conjunction
with the price calculation set in the previous field.
- For LMT orders, the field is “Set limit price to:...”
- For MKT this field does not display.
Choose from the following calculations to ensure the limit price will not be set higher than (for a buy)
or lower than (for a sell):
None - for REL orders only. There is no cap on the price.
Value - opens a field to set an absolute limit price.
Mark Price - this is a static value shown in parentheses plus or minus an offset. This price will not
move with the order.
Bid - bid plus/minus an optional offset amount. Enter a negative value to effect a minus offset.
Ask - ask plus/minus an optional offset amount. Enter a negative value to effect a minus offset.
Last - the last traded price plus/minus an optional offset amount. Enter a negative value to effect
a minus offset.
VWAP - the VWAP plus/minus an optional offset amount. Enter a negative value to effect a
minus offset.
Mov VWAP - the moving VWAP (of the current instrument ) over the past [specified time period]
plus/minus an optional offset amount. Enter a negative value to effect a minus offset.
Mov Avg - the moving average (of the current instrument ) over the past [specified time period]
plus/minus an optional offset amount. Enter a negative value to effect a minus offset.
Exp Mov Avg - the exponential moving average (of the current instrument ) over the past [specified time period] plus/minus an optional offset amount. Enter a negative value to effect a minus
offset.
My Last Trade - the price of the last trade in the algo, shown as the Last Trade Price in the order
Summary block. Note that this value cannot be used for the limit price alone since it would have
no price for the first trade.
Relative to size traded - calculates the price cap as: user-defined base price minus user-defined
offset value per number of shares relative to the total size traded in the algo, which is reflected in
the Shares bought field of the algo Summary block. For example, if the values are: $5.50 - .02
per 100 shares, the cap price for the first 100-share order where Size Traded = 0 would be
$5.50. Assuming the trade continues to execute in 100-share increments, the price cap would
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changes as follows: Size Traded = 100 cap = $5.48; Size Traded = 200 cap = $5.46; Size
Traded = 300 cap = $5.44.
Relative to position - calculates the price cap the same as Relative to size traded except that the
calculation is relative to the position as specified in the Account window and the Position column,
while the size traded is relative to what happens only in the Accumulate/Distribute algo.
9. Enter the value that corresponds to the selection above.
10. For Relative and Limit orders, click and to add more price conditions to the “but not higher than/not
lower than” price capping calculation. When you add multiple price-bounding conditions, a new
“Greatest of/Least of” selection appears for you to ensure the order price will not be higher(lower)
than the greatest of/least of Condition A and Condition B and Condition C etc.
11. Start time - by default, the start time is set to the current time, or to the next open if the markets are
currently closed. Click in the field to set a new start time, but note that the algo will not start until you
hit the Start button.
12. End time - by default, the end time is set to closing time of the current day, or to the next close is the
algo is started outside of regular trading hours. Click in the field to set a new end time.
13. Modify the time zone if desired.
14. Wait for current order to fill before submitting next order - if checked, the next component will be held
until the current quantity fills. The countdown until the Time of next order stops while the algo waits
for the current order to fill. Once it fills, the next order is submitted if the specified time interval has
elapsed.
15. Catch up in time - if checked and the algo falls behind, the next order will be placed immediately after
the current order fills, disregarding the time interval. This process will repeat until the algorithm has
caught up. Missed orders are tracked in the algo Summary block.
After one order fills, there is always a delay of two seconds before the next order is submitted.
16. Randomize time period by +/- 20% - if checked, the time interval you specified will be increased
or decreased randomly by up to 20% in either direction, to help keep the order from being noticed in
the market. For example, if your defined time interval is 40 seconds, randomizing allows the algo to
submit orders at intervals of 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47 or 48
seconds.
17. Randomize size by +/- 55% - if checked, the increment size you specified will increase or decrease
randomly by up to 55% (rounded to the nearest 100) in either direction, to help keep the order from
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being noticed in the market. For example, if your defined increment is 500 shares, randomizing
allows the algo to submit orders in random increments of 200, 300, 400, 500, 600, 700 or 800
shares.
18. Allow this order to be filled outside of regular trading hours - if checked order may fill outside
regular trading hours.
19. If the bid/ask is ____ or higher - for a buy order, if the current offer size is greater than or equal to
the size entered here AND the price is the same or better than the entered price, the algo will take
the entire size, or as much as will not exceed the total order quantity. This order is submitted as IOC
(Immediate-or-cancel).

Basic Algorithm Example
The populated fields in the image below translate to the following:
Buy 500,000 shares in size increments of 200 every 25 seconds. Set the price to the current best bid, but
don’t pay any more than the ask price. Let the algo run until it fills or is canceled.Wait for the current size
component to fill before submitting the next increment, and if the algo falls behind schedule catch up in time
by submitting increments immediately after a fill instead of honoring the time interval. Mix up the time
intervals by adding and subtracting 20%, and make the order size less uniform by adding/removing 55% on
each order, rounding to ensure no odd lots. If a large size order hits the market with a size of 200,000 or
more and a price of 421.00 or better, take the entire offer without exceeding the original total order quantity
or 500,000.
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Using Templates
You can save the basic algorithm settings in a named template to help you save time defining multiple
Accumulate/Distribute algo orders. Please note that the template only saves the basic algo settings, not the
conditions, since conditions are instrument -specific and would not translate across different algo orders.

Save Settings as a Template

After you have defined the basic algo settings described in the Define the Algorithm section, you may elect
to save these parameters for use with another Accumulate/Distribute algo order.
To save a template
1. From the Template command in the title bar, Save Template As.
2. Enter a descriptive name for the template (for example Buy 20000 or Sell 1,000,000) and click OK.
To use an Accumulate/Distribute template
From the Template command in the title bar, select Load Template.
If you make changes to an existing template after you load it, you have the choice to either Save
Template which saves your changes to the existing template, or Save Template As to create a new
template.

Define Algo Conditions
Note that the more conditions to be met, the more difficult it may be for your order to completely fill or to fill
according to schedule.
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Define Algo Conditions

All of the conditions are optional, but if you elect to set a condition, any unfilled fields in the definition
become mandatory and are shaded pink.
To clear the values from a condition, click the “x” at the end of the line. The “x” only appears when you have
entered data in a field.
Numbered descriptions below correspond to the numbered fields in the image above.
1. Specify whether you want untrue conditions (when set) to permanently stop the algo, or to stop it
temporarily and resume if/when conditions become true.
2. Define a range within which the instrument price must stay for the order to continue working.
3. Ensure that the price movement will not be affected by news stories by entering a value in minutes.
Until there has been no news for your defined time period as the algo will not work. News is monitored by the news suppliers you have set up in TWS, including Google News, Yahoo! Headlines and
the Reuters subscription service.
4. Specify that your position, as reflected in the Account window and Position column, must be greater
than or less than a specified value. This acts as a floor or ceiling for the position. Not only will
TWSnot place the order if the Position condition is violated, but it will not fill any order that would
leave it violated.
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5. Moving averages for this contract - Define moving average criteria for the current instrument .
Specify that the current instrument ’s: moving VWAP, moving average, exponential moving
average or last over the past [specified time period] is at least a [specified percent] greater than or
less than another moving average (for the current instrument ) over [specified time period]. To clear
the values, click the ‘x’ at the end of the line.
6. Moving averages for - Compare two moving averages, which could be for the same instrument or
for different contracts, for the same time period or for different time periods. Specify the underlying,
and then set values as in #4 above. To clear the values, click the ‘x’ at the end of the line.
7. These three fields work together to compare the change in price of two stocks over a specified time
period, based on the difference between the stock’s price and its moving average. The algo completes the calculation based on your inputs. To clear the values, click the ‘x’ at the end of the line.
Enter a percent value difference that must be met between the two stock calculations.

Create Multiple Algo Orders
The Accumulate/Distribute algo was designed to allow a single trader to do the work of multiple traders,
and it's easy to create and monitor multiple orders from the same page.

To add another Algo
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1. Click the "+" sign from the Accumulate/Distribute algo page to add a new tab.
2. On the new page, enter a symbol in the Contract field on the Quote panel and select an instrument .
3. Define the algo.
To monitor all algo orders from a single page, open the Accum/Dist Summary tab.

Transmit and Modify the Algo
Use the buttons along the bottom of the Conditions area to control the algo.

You cannot activate the algo until all required fields are filled. Missing fields are shaded pink.
Once all fields are complete you can activate the algo. Buttons works as described below:
Preview - Click to update the order line, and to display the Order Preview box.
Transmit - Transmit the order. Additionally, if you modify the order, click to apply changes to the algo. For
example, if you change the share increment from 500 to 300, the change will not be recognized until you
click the Transmit button.
Save - Saves the order for transmission at a later date.
Restore- click to restore unapplied changes to the original value. For example, you can undo your change
by clicking Restore. Once you Apply the change the Restore button is no longer available.
Cancel Order - Cancels the order.
Start - activates the algo. If you stop the algo manually, click Start to resume from where it left off.
Stop - stops the algo. This button will become active once the algo is started.
Reset - if the algo is stopped, either because it has finished or because you have manually stopped it, the
Reset button will start the algo from the beginning. If you prefer to resume the algo from where it left off,
use the Start button.
Status text: this note tells you what is happening on the current algo screen.
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Monitor the Order Progress
The order Summary provides real-time data to let you monitor the progress of the Accumulate/Distribute
order. This data applies only to the algo on this page. Use the aggregate Summary tab to see order
management lines for all of your Accumulate/Distribute algos.

Data in the Summary block monitors the order in real time and shows the following:
Share submitted - Shows the number of shares that have currently been submitted.
Shares bought - The total number of shares bought (or sold) to date in the algo. The sliding shading
illustrates the percent of the order complete.
Shares remaining - The outstanding quantity.
Last Trade Price - The price at which the last trade in the algo filled.
Average price - The average price to date for the completed portion of the order.
Time of last size increase - The time the last component size filled.
Time until next size increase - The counter counts down the time until the next component size will be
submitted.

Fox River Algos
To use Fox River algos, select FOXRIVER from the Algorithms section of the Destination field.
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Dark Sweep

458

Fox Alpha

459

Fox Blaster™

462

Fox Dark Attack™

463

Fox River Pyramid™

465

Fox Smart Order Router

469

Fox Spotlight™

471

Percent of Volume (POV)

473
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Fox TWAP

474

TWAP (Fox River)

477

Fox VWAP

479

VWAP (Fox River)

481

Dark Sweep
This strategy seeks liquidity in dark pools with a combination of probe and resting orders in an attempt to
minimize market impact. Works child orders at better of limit price or current market price. Prioritizes venue
by probability of fill.

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and market
close, and prior to Expire Time (if
set).
Defaults to immediately.

Expire Time
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Between market open and market
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Field Name

Field Name

Description

expire.

Valid Values/ Default Value

close, and after Effective Time (if
set).
Defaults to market close if not set.

Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
Dollar Certain

Optional. The commission cost on a

>0

Commission

cents-per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution

quantity by dollar value. Must be checked

least must be defined.

checkbox

for other "Dollar Certain" fields to be valid.

Fox Alpha
Participation-rate algorithm that uses Fox River alpha signals with the goal of achieving best execution.
Allows the user to determine the aggression of the order. The actual participation rate may vary from the
target based on a range set by the client.
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Field Name

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and
market close, and prior to Expire
Time (if set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to

Between market open and

expire.

market close, and after Effective
Time (if set).
Defaults to market close if not
set.

Participation Rate

Optional. The participation of volume rate

Digit that will be used as a

Limit

limit, as a percentage.

percentage
0 < rate <= 1.
Example: 0.05 equals 5%

End Time Behavior
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Field Name

Field Name

Description

expires.

Valid Values/ Default Value

balance
Hard - Complete the order with
give up
Soft - If possible, complete the
order with no give up

Participation Rate

Optional. The percentage of traded

Target

volume that is the target participation rate.

Elasticity

Optional. Elasticity describes the pacing
of the Fox trading signal. This value tells
how much leeway the model has to be off
the expected fill rate.

Aggressiveness

Optional. How aggressive to fill.

0 > rate >= 1, e.g. 0.05 is 5%

Low, Medium, High.
Set the High by default to provide
the most flexibility and best
performance.
0 - Low
1 - Medium
2 - High

Dark Attack

Optional. Whether or not to favor dark
pools.

0 - Do not favor dark pools
1 - Least aggressive
10 - Most aggressive
Will default to 0.

I Would Dark

Optional. Check to allow the order to

If unchecked, pacing will not be

checkbox

complete in a dark venue at any time.

affected by fills from dark venues.

Very aggressive if set.
Sweep Price

Optional. Set a price at which you would

>0

be willing to sweep all available equity.
Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
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Field Name

Field Name

Description

Valid Values/ Default Value

Dollar Certain

Optional. The commission cost on a

>0

Commission

cents-per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution checkbox

quantity by dollar value. Must be checked

least must be defined.

for other "Dollar Certain" fields to be valid.

Fox Blaster™
An aggressive arrival price strategy for traders who "pick their spots" based on their own market signals.
Trades with short-term alpha potential, more aggressive than Fox Alpha.

Field Name

Effective Time

Description

Valid Values/ Default Value

Optional. Set the time to begin the order.

Between market open and market
close, and prior to Expire Time (if
set).
Defaults to immediately.

Expire Time
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Field Name

Field Name

Description

Valid Values/ Default Value

set).
Defaults to market close if not set.

Aggressiveness

Optional. How aggressive to fill.

0 - Low
1 - Medium
2 - High

Dollar Certain Limit

Optional. The maximum acceptable

>0

dollar amount of the trade, including
Dollar Certain Commission. Used to
trade by dollar amount.
Dollar Certain

Optional. The commission cost on a

>0

Commission

cents-per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit (at

Execution checkbox

quantity by dollar value. Must be checked

least must be defined.

for other "Dollar Certain" fields to be
valid.

Fox Dark Attack™
Liquidity seeking dark strategy with the ability to dynamically slide between targeted levels with a single
numeric input in an effort to minimize market impact. Ability to access major dark pools and hidden liquidity
at lit venues. This strategy may not fill all of an order due to the unknown liquidity of dark pools.
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Field Name

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and market
close, and prior to Expire Time (if
set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to

Between market open and market

expire.

close, and after Effective Time (if
set).
Defaults to market close if not set.

Dark Minimum Fill

Optional. The minimum fill quantity in a

If set, must be greater than or

Quantity

dark pool.

equal to the lot size.

Dark Attack

Optional. Whether or not to favor dark

0 - Do not favor dark pools

pools.

1 - Least aggressive
10 - Most aggressive
Will default to 0.

Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
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Field Name

Field Name

Description

Valid Values/ Default Value

Certain Commission. Used to trade by
dollar amount.
Dollar Certain

Optional. The commission cost on a cents-

>0

Commission

per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution

quantity by dollar value. Must be checked

least must be defined.

checkbox

for other "Dollar Certain" fields to be valid.

Fox River Pyramid™
A dynamic single-order ticket strategy that changes behavior and aggressiveness based on user-defined
pricing tiers. Ability to set individual POV rate, "I Would" dark setting and sweep price.
This algo strategy can be applied to POV, VWAP, TWAP, Fox Dark Attack and Fox Alpha algos, using the
PyramidStrategy drop-down field.
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Field Name

Field Name

Effective Time

Description

Valid Values/ Default Value

Optional. Set the time to begin the order.

Between market open and market
close, and prior to Expire Time (if
set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to

Between market open and market

expire.

close, and after Effective Time (if
set).
Defaults to market close if not set.

Participation Rate

Optional. The participation of volume rate

Digit that will be used as a

Limit

limit, as a percentage.

percentage
0 < rate <= 1.
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Field Name

Field Name

Description

Valid Values/ Default Value

Example: 0.05 equals 5%
End Time Behavior

Optional. Tells how to treat an order that

Cancel - cancels any remaining

expires.

balance
Hard - Complete the order with
give up
Soft - If possible, complete the
order with no give up

Participation Rate

Optional. The percentage of traded

Target

volume that is the target participation

0 > rate >= 1, e.g. 0.05 is 5%

rate.

Aggressiveness

Optional. How aggressive to fill.

0 - Low
1 - Medium
2 - High

Dark Minimum Fill

Optional. The minimum fill quantity in a

If set, must be greater than or

Quantity

dark pool.

equal to the lot size.

Dark Attack

Optional. Whether or not to favor dark

0 - Do not favor dark pools

pools.

1 - Least aggressive
10 - Most aggressive
Will default to 0.

I Would Dark

Optional. Check to allow the order to

If unchecked, pacing will not be

checkbox

complete in a dark venue at any time.

affected by fills from dark venues.

Very aggressive if set.
Price Level 1

Optional. Define a price level at which
POV Rate 1 would be triggered.

>0
If a value is entered POV Rate 1
and I Would Dark 1 (if set) are in
effect.

POV Rate 1
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Field Name

Field Name

I Would Dark 1

Description

Valid Values/ Default Value

This is the participation rate of volume at

This POV Rate is used when

which to execute when Price Level 1 is

Price Level 1 (if set) has been

active.

triggered.

Optional. Check to allow the order to
complete in a dark venue at any time.
Very aggressive if set.

Price Level 2

Optional. Define a price level at which
POV Rate 2 would be triggered.

>0
If a value is entered POV Rate 2
and I Would Dark 2 (if set) are in
effect.

POV Rate 2

Required if Price Level 2 is populated.
This is the participation rate of volume at
which to execute when Price Level 1 is
active.

I Would Dark 2

0 > rate >= 1, e.g. 0.05 is 5%
This POV Rate is used when
Price Level 2 (if set) has been
triggered.

Optional. Check to allow the order to
complete in a dark venue at any time.
Very aggressive if set.

Price Level 3

Optional. Define a price level at
which POV Rate 3 and I Would Dark
3 would be triggered.

>0
If a value is entered POV Rate 3
and I Would Dark 3 (if set) are in
effect.

POV Rate 3

Required if Price Level 3 is populated.
This is the participation rate of volume at
which to execute when Price Level 1 is
active.

I Would Dark 3

0 > rate >= 1, e.g. 0.05 is 5%
This POV Rate is used when
Price Level 3 (if set) has been
triggered.

Optional. Check to allow the order to
complete in a dark venue at any time.
Very aggressive if set.

Pyramid Strategy
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Field Name

Field Name

Description

price levels of the pyramid will be applied.

Valid Values/ Default Value

VWAP
TWAP
Dark Attack
Alpha

Dollar Certain Limit

Optional. The maximum acceptable

>0

dollar amount of the trade, including
Dollar Certain Commission. Used to
trade by dollar amount.
Dollar Certain

Optional. The commission cost on a

>0

Commission

cents-per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution checkbox

quantity by dollar value. Must be checked

least must be defined.

for other "Dollar Certain" fields to be
valid.

Fox Smart Order Router
A strategy designed to provide intelligent liquidity-taking logic that adapts to a variety of real-time factors
such as order attributes, market conditions, and venue analysis. Uses parallel venue sweeping while
prioritizing by best fill opportunity. Routing reaches all major lit and dark venues.

TWS Guide

469

Chapter 1

Field Name

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and market
close, and prior to Expire Time (if
set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to

Between market open and market

expire.

close, and after Effective Time (if
set).
Defaults to market close if not set.

Sweep Type

Optional.

Sweep - Default setting that
sweeps lit markets price-point by
price-point up to the limit price. If
there is not enough size at a price
point it seeks out hidden and dark
liquidity.
Sweep-post - Same as sweep, but
posts remaining portion of the
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Field Name

Field Name

Description

Valid Values/ Default Value

order at the limit price in the lit
markets where it should have the
best chance to fill. Not valid for
IOC orders.
Flashlight - Sweeps the dark
markets at each price point first,
and then goes to lit markets when
dark liquidity is exhausted.
Flashlight-post - Same as
flashlight, but once all liquidity is
exhausted posts remainder to lit
market.
Flashpoint Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
Dollar Certain

Optional. The commission cost on a cents-

>0

Commission

per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution

quantity by dollar value. Must be checked

least must be defined.

checkbox

for other "Dollar Certain" fields to be valid.

Fox Spotlight™
An ETF-only strategy designed to minimize market impact. This algorithm is designed to assess market
impact and if orders are a large percentage of ADV (average daily volume), the strategy will attempt to
minimize impact while completing the order. Aims to execute large orders relative to displayed volume.
Dynamic and intelligent limit calculations to minimize impact.
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Field Name

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and market
close, and prior to Expire Time (if
set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to

Between market open and market

expire.

close, and after Effective Time (if
set).
Defaults to market close if not set.

Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
Dollar Certain

Optional. The commission cost on a cents-

Commission

per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution

quantity by dollar value. Must be checked

least must be defined.

checkbox

for other "Dollar Certain" fields to be valid.
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Percent of Volume (POV)

Percent of Volume (POV)
Percent of volume (POV) strategy designed to control execution pace by targeting a percentage of market
volume. Emphasis on staying as close to the stated POV rate as possible.

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and
market close, and prior to Expire
Time (if set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to expire.

Between market open and
market close, and after Effective
Time (if set).
Defaults to market close if not set.

End Time Behavior
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Field Name

Field Name

Description

Valid Values/ Default Value

Hard - Complete the order with
give up
Soft - If possible, complete the
order with no give up
POV Rate

Required. The percentage of traded

0 > rate >= 1, e.g. 0.05 is 5%

volume that is the target participation rate.
Dark Attack

Optional. Whether or not to favor dark
pools.

0 - Do not favor dark pools
1 - Least aggressive
10 - Most aggressive
Will default to 0.

I Would Dark

Optional. Check to allow the order to

If unchecked, pacing will not be

checkbox

complete in a dark venue at any time. Very

affected by fills from dark venues.

aggressive if set.
Sweep Price

Optional. Set a price at which you would be

>0

willing to sweep all available equity.
Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
Dollar Certain

Optional. The commission cost on a cents-

>0

Commission

per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution checkbox

quantity by dollar value. Must be checked

least must be defined.

for other "Dollar Certain" fields to be valid.

Fox TWAP
A time-weighted algorithm that aims to evenly distribute an order over the user-specified duration using
Fox River alpha signals. Allows the user flexibility to control how much leeway the model has to be off the
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Field Name

expected fill rate. Seeks to outperform TWAP using Fox Alpha and short-term alpha signals.

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and
market close, and prior to Expire
Time (if set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to expire.

Between market open and
market close, and after Effective
Time (if set).
Defaults to market close if not set.

Participation Rate

Optional. The participation of volume rate

Digit that will be used as a

Limit

limit, as a percentage.

percentage
0 < rate <= 1.
Example: 0.05 equals 5%

End Time Behavior
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Field Name

Field Name

Description

Valid Values/ Default Value

Hard - Complete the order with
give up
Soft - If possible, complete the
order with no give up
Elasticity

Optional. Elasticity describes the pacing of
the Fox trading signal. This value tells how
much leeway the model has to be off the
expected fill rate.

Dark Attack

Optional. Whether or not to favor dark
pools.

Low, Medium, High.
Set the High by default to provide
the most flexibility and best
performance.
0 - Do not favor dark pools
1 - Least aggressive
10 - Most aggressive
Will default to 0.

I Would Dark

Optional. Check to allow the order to

If unchecked, pacing will not be

checkbox

complete in a dark venue at any time. Very

affected by fills from dark venues.

aggressive if set.
Sweep Price

Optional. Set a price at which you would be

>0

willing to sweep all available equity.
Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
Dollar Certain

Optional. The commission cost on a cents-

>0

Commission

per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution checkbox

quantity by dollar value. Must be checked

least must be defined.

for other "Dollar Certain" fields to be valid.
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TWAP (Fox River)

TWAP (Fox River)
A passive time-weighted algorithm that aims to evenly distribute an order over the user-defined time
period. Participation rate is used as a limit.

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and
market close, and prior to Expire
Time (if set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to expire.

Between market open and
market close, and after Effective
Time (if set).
Defaults to market close if not set.

Participation Rate

Optional. The participation of volume rate

Digit that will be used as a

Limit

limit, as a percentage.

percentage
0 < rate <= 1.
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Field Name

Field Name

Description

Valid Values/ Default Value

Example: 0.05 equals 5%
End Time Behavior

Optional. Tells how to treat an order that

Cancel - cancels any remaining

expires.

balance
Hard - Complete the order with
give up
Soft - If possible, complete the
order with no give up

Dark Attack

Optional. Whether or not to favor dark
pools.

0 - Do not favor dark pools
1 - Least aggressive
10 - Most aggressive
Will default to 0.

I Would Dark

Optional. Check to allow the order to

If unchecked, pacing will not be

checkbox

complete in a dark venue at any time. Very

affected by fills from dark venues.

aggressive if set.
Sweep Price

Optional. Set a price at which you would be

>0

willing to sweep all available equity.
Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
Dollar Certain

Optional. The commission cost on a cents-

>0

Commission

per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution checkbox

quantity by dollar value. Must be checked

least must be defined.

for other "Dollar Certain" fields to be valid.
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Fox VWAP

Fox VWAP
A volume specific strategy designed to execute an order targeting best execution over a specified time
frame. Allows the user flexibility to control how much the strategy has to be ahead or behind the expected
volume. Using Fox short term alpha signals, this strategy is optimized for the trader looking to achieve best
overall performance to the VWAP benchmark.

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and
market close, and prior to Expire
Time (if set).
Defaults to immediately.

Expire Time

Optional. Time/date for the order to expire.

Between market open and
market close, and after Effective
Time (if set).
Defaults to market close if not set.

Participation Rate
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Field Name

Field Name

Limit

Description

limit, as a percentage.

Valid Values/ Default Value

percentage
0 < rate <= 1.
Example: 0.05 equals 5%

End Time Behavior

Optional. Tells how to treat an order that

Cancel - cancels any remaining

expires.

balance
Hard - Complete the order with
give up
Soft - If possible, complete the
order with no give up

Elasticity

Optional. Elasticity describes the pacing of
the Fox trading signal. This value tells how
much leeway the model has to be off the
expected fill rate.

Dark Attack

Optional. Whether or not to favor dark
pools.

Low, Medium, High.
Set the High by default to provide
the most flexibility and best
performance.
0 - Do not favor dark pools
1 - Least aggressive
10 - Most aggressive
Will default to 0.

I Would Dark

Optional. Check to allow the order to

If unchecked, pacing will not be

checkbox

complete in a dark venue at any time. Very

affected by fills from dark venues.

aggressive if set.
Sweep Price

Optional. Set a price at which you would be

>0

willing to sweep all available equity.
Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
Dollar Certain
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Field Name

Field Name

Description

Valid Values/ Default Value

Commission

per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution checkbox

quantity by dollar value. Must be checked

least must be defined.

for other "Dollar Certain" fields to be valid.
Corporate Buy

Optional. Check for 10b-18 corporate

Back checkbox

repurchase.

Yes or no.

VWAP (Fox River)
Passive volume specific strategy designed to execute an order targeting best execution over a specified
time frame. Tags specifying a time frame can optionally be set. Participation rate is used as a limit.

Field Name

Effective Time

Description

Optional. Set the time to begin the order.

Valid Values/ Default Value

Between market open and
market close, and prior to Expire
Time (if set).
Defaults to immediately.

TWS Guide

481

Chapter 1

Field Name

Field Name

Expire Time

Description

Optional. Time/date for the order to expire.

Valid Values/ Default Value

Between market open and
market close, and after Effective
Time (if set).
Defaults to market close if not set.

Participation Rate

Optional. The participation of volume rate

Digit that will be used as a

Limit

limit, as a percentage.

percentage
0 < rate <= 1.
Example: 0.05 equals 5%

End Time Behavior

Optional. Tells how to treat an order that

Cancel - cancels any remaining

expires.

balance
Hard - Complete the order with
give up
Soft - If possible, complete the
order with no give up

Dark Attack

Optional. Whether or not to favor dark
pools.

0 - Do not favor dark pools
1 - Least aggressive
10 - Most aggressive
Will default to 0.

I Would Dark

Optional. Check to allow the order to

If unchecked, pacing will not be

checkbox

complete in a dark venue at any time. Very

affected by fills from dark venues.

aggressive if set.
Sweep Price

Optional. Set a price at which you would be

>0

willing to sweep all available equity.
Dollar Certain Limit

Optional. The maximum acceptable dollar

>0

amount of the trade, including Dollar
Certain Commission. Used to trade by
dollar amount.
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Field Name

Field Name

Description

Valid Values/ Default Value

Dollar Certain

Optional. The commission cost on a cents-

>0

Commission

per-share basis, e.g. 0.1 = 1 cent

Dollar Certain

Optional. Check to determine the order

If checked, Dollar Certain Limit at

Execution checkbox

quantity by dollar value. Must be checked

least must be defined.

for other "Dollar Certain" fields to be valid.
Corporate Buy

Optional. Check for 10b-18 corporate

Back checkbox

repurchase.

Yes or no.

CSFB Algos
To use CSFB algos, select CSFBALGO as the routing destination.
CSFB Auction

484

CSFB Blast

485

CSFB Close

486

CSFB Crossfinder+

487

CSFB Float

489

CSFB Float Guerrilla

492

CSFB Guerrilla

494

CSFB Price Inline

497

CSFB I Would

499

CSFB Lightpool

502

CSFB Pathfinder

503

CSFB Pre/Post

504

CSFB Reserve

505

CSFB Sniper

508
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CSFB Auction

CSFB Tex

510

CSFB TWAP

512

CSFB Volume Inline

515

CSFB VWAP

517

CSFB Auction
Call an auction and control the order.

Field

Description

Algo Selector

Select the CSFB algo.

Execution Style

Select the degree of urgency.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.
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CSFB Blast

CSFB Blast
An aggressive algo that simultaneously routes your order to all available exchanges and ECNs with an
intermarket sweep designed to getting as close to simultaneous arrival as possible.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Iceberg

Enter the display size for the
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CSFB Close
Field

Description

order. Cannot be less than
100 shares, or greater than
the order size.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

CSFB Close
Minimizes market impact by intelligently working orders into the close.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
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CSFB Crossfinder+
Field

Description

the market's close.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

CSFB Crossfinder+
This strategy locates liquidity among a broad list of independent and broker-owned dark pools, with
continuous crossing capabilities. Using dynamic smart routing logic, CrossFinder+ will spread your order
over multiple destinations. This algo will fill at the midpoint or better, and may not execute.
For large sized orders, use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
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CSFB Crossfinder+
Field

Description

if desired. If no start time is
set, the algo becomes active
when you submit.
End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Max % Participation

Define the max percent of
volume if desired.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
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CSFB Float
Field

Description

5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

To use CSFB algos, select CSFBALGO as the destination and then select an algo.

CSFB Float
This tactic displays only the size you want shown and floats on the bid, midpoint, or offer until completion.
Enter a display size in the Iceberg field and choose a patient, normal, or aggressive execution.
For large sized orders, use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.
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CSFB Float

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Max % Participation

Define the max percent of
volume if desired.

Iceberg

Enter the display size for the
order. Cannot be less than
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CSFB Float
Field

Description

100 shares, or greater than
the order size.
Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

To use CSFB algos, select CSFBALGO as the destination on the Basic tab.
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CSFB Float Guerrilla

CSFB Float Guerrilla
Uses the Guerrilla algo but floats a small, visible portion near touch to facilitate trading when that side of the
book becomes active.
For large sized orders, use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.
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CSFB Float Guerrilla
Field

End Time

Description

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Min % Participation

Define the max percent of
volume if desired.

Max % Participation

Define the max percent of
volume if desired.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
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CSFB Guerrilla
Field

Description

defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

I Would Price

Set a price at which you are
willing to fill the entire order.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

CSFB Guerrilla
The GUERRILLA algo works differently depending on the Execution Style you select.
Normal and Passive modes: This tactic works orders without displaying bids or offers. When liquidity
materializes, it seeks to aggressively participate in the flow. If liquidity is poor, the order may not complete.
Aggressive mode: This will hit bids/take offers in an intelligent way based on a fair price model. It minimizes market impact and never posts bids or offers.
For large sized orders, use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.

TWS Guide

494

Chapter 1

CSFB Guerrilla

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Min % Participation

Define the max percent of
volume if desired.

Max % Participation
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CSFB Guerrilla
Field

Description

volume if desired.
Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

I Would Price

Set a price at which you are
willing to fill the entire order.
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CSFB Price Inline

To use CSFB algos, select CSFBALGO as the destination and then select an algo.

CSFB Price Inline
Minimizes implementation shortfall against the arrival price. Participation increases when the price is
favorable.
For large sized orders, use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
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CSFB Price Inline
Field

Description

set, the algo becomes active
when you submit.
End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Min % Participation

Define the max percent of
volume if desired.

Max % Participation

Define the max percent of
volume if desired.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

Auction

Specify whether or not to
include the order in all auctions, no auctions, just opening, just closing or just
imbalance auctions.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
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CSFB I Would
Field

Description

block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

I Would Price

Set a price at which you are
willing to fill the entire order.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

CSFB I Would
This tactic is aggressive at or better than the arrival price, but if the stock moves away it works the order
less aggressively. However, if the stock moves in your favor, it will act like Sniper and quickly get the order
done.
For large sized orders, use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.
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CSFB I Would

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Min % Participation

Define the max percent of
volume if desired.

Max % Participation
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CSFB I Would
Field

Description

volume if desired.
Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

To use CSFB algos, select CSFB as the destination and then select the algo.
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CSFB Lightpool

CSFB Lightpool
Routes orders to the Credit Suisse ECN.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Iceberg

Enter the display size for the
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CSFB Pathfinder
Field

Description

order. Cannot be less than
100 shares, or greater than
the order size.

To use CSFB algos, select CSFB as the destination and then select the algo.

CSFB Pathfinder
PathFinder will intelligently and dynamically post across multiple destinations, sweeping all available
liquidity. The remainder will be posted at your limit price.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
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CSFB Pre/Post
Field

Description

is set, the default end time is
the market's close.
Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

To use CSFB algos, select CSFBALGO as the destination and then select an algo.

CSFB Pre/Post
Smart routed algo to be used during pre- and post-market hours. Only supports limit orders.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.
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CSFB Reserve
Field

End Time

Description

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

To use CSFB algos, select CSFB as the destination and then select the algo.

CSFB Reserve
Use the Iceberg field to display the size you want shown at your price instruction. If you do not set a display
size, the algo will optimize a display size. Upon getting filled, it sends out the next piece until completion.
For large sized orders use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.
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CSFB Reserve

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Max % Participation

Define the max percent of
volume if desired.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
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CSFB Reserve
Field

Description

the order size.
Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

To use CSFB algos, select CSFBALGO as the destination and then select an algo.
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CSFB Sniper

CSFB Sniper
This is a very aggressive tactic that will hit bids/take offers that are better than your limit price, but will never
post bids or offers. It achieves high participation rates. Note it is not a pure sweep and can sniff out hidden
liquidity. As a result, it is often a better choice than placing a limit order directly into the market.
For large sized orders use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time
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CSFB Sniper
Field

Description

algo if desired. If no end time
is set, the default end time is
the market's close.
Execution Style

Select the degree of urgency.

Max % Participation

Define the max percent of
volume if desired.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size
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CSFB Tex
Field

Description

enabled.
Define the maximum size of the
block if desired.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

CSFB Tex
Designed to minimize implementation shortfall. The tactic takes into account movements in the total market
and in correlated stocks when making pace and price decisions. Timing is based on price and liquidity.
For large sized orders use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.
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CSFB Tex
Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Min % Participation

Define the max percent of
volume if desired.

Max % Participation

Define the max percent of
volume if desired.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

Auction

Specify whether or not to
include the order in all auctions, no auctions, just opening, just closing or just
imbalance auctions.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.
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CSFB TWAP
Field

Blockprice

Description

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

I Would Price

Set a price at which you are
willing to fill the entire order.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

CSFB TWAP
The system trades based on the clock, i.e., on a 2-hour order the system is 25% done after 30 minutes,
50% done after an hour, etc. Unlike VWAP, TWAP (time weighted average price) does not speed up/slow
down based on projected volume or price moves. However, it does use smart limit order placement
strategies throughout the order.
For large sized orders use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.
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CSFB TWAP

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Max % Participation

Define the max percent of
volume if desired.

Auction
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CSFB TWAP
Field

Description

include the order in all auctions, no auctions, just opening, just closing or just
imbalance auctions.
Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

I Would Price

Set a price at which you are
willing to fill the entire order.
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CSFB Volume Inline

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

CSFB Volume Inline
Works the order in line with the volume.
For large sized orders use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.

Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time
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CSFB Volume Inline
Field

Description

algo if desired. If no end time
is set, the default end time is
the market's close.
Execution Style

Select the degree of urgency.

Min % Participation

Define the max percent of
volume if desired.

Max % Participation

Required for this algo.
Define the max percent of
volume.

Iceberg

Enter the display size for the
order. Cannot be less than
100 shares, or greater than
the order size.

Auction

Specify whether or not to
include the order in all auctions, no auctions, just opening, just closing or just
imbalance auctions.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size
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CSFB VWAP
Field

Description

enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
block if desired.

I Would Price

Set a price at which you are
willing to fill the entire order.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

CSFB VWAP
The system attempts to match the VWAP (volume weighted average price) from the start time to the end
time. A unique and powerful feature is the ability to accept a maximum percent volume limit (“don’t be more
than 20% of the volume.”) The system trades over your time period, subject to your price and volume
constraints.
For large sized orders use Blockfinder to define a price/size at which you're willing to potentially move a
large block while still working the algo.
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Field

Description

Algo Selector

Select the CSFB algo.

Start Time

Enter a start time for the algo
if desired. If no start time is
set, the algo becomes active
when you submit.

End Time

Enter the end time for the
algo if desired. If no end time
is set, the default end time is
the market's close.

Execution Style

Select the degree of urgency.

Max % Participation

Define the max percent of
volume if desired.

Iceberg
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CSFB VWAP
Field

Description

order. Cannot be less than
100 shares, or greater than
the order size.
Auction

Specify whether or not to
include the order in all auctions, no auctions, just opening, just closing or just
imbalance auctions.

Blockfinder

Check to enable Blockfinder,
which submits blocks (with a
10,000 share minimum) for
execution which remaining
size continues to fill through
the algo.

Blockprice

Only valid if Blockfinder is
enabled.
Define the price at which the
block is eligible to execute.

Min Block Size

Only valid if Blockfinder is
enabled.
Define the minimum block size if
desired. Must be at least 5000
and increments are in sizes of
5000. If no minimum size is
defined the default size of
10,000 is used.

Max Block Size

Only valid if Blockfinder is
enabled.
Define the maximum size of the
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Field

Description

block if desired.

I Would Price

Set a price at which you are
willing to fill the entire order.

To use CSFB algos, select CSFBALGO as the destination and then select the algo.

Jefferies Algos
To use Jefferies algos, select JEFFALGO as the routing destination.
Jefferies Blitz

521

Jefferies DarkSeek

522

Jefferies Finale

525

Jefferies Multi Scale

527

Jefferies Opener

530

Jefferies Pairs - Net Returns

533

Jefferies Pairs - Ratio

534

Jefferies Pairs - Risk Arb

536

Jefferies Patience

538

Jefferies Portfolio

541

Jefferies Post

544

Jefferies Seek

546

Jefferies Strike

550

Jefferies Trader

553

Jefferies TWAP

554
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Jefferies Blitz

Jefferies Volume Participation

558

Jefferies VWAP

561

Jefferies Blitz
Liquidity seeking algo that sweeps all displayed markets, and sends Immediate-or-Cancel orders to all
non-displayed markets.

Number

Description

1

Choose algo

2

(optional) Set a start time

3

(optional) Set an end time

4

Relative Limit - (optional) Positive and Negative
values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
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Jefferies DarkSeek

Number

Description

specified number of basis points. The strategy
will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

5

Iceberg (optional) – Enter display size.

6

Trading Style (optional)– Indicate increasing
degrees of aggressiveness
Price Improvement
Opportunistic
Get it done
No Post

7

Buy Back -(optional) Indicates that the algo
should engage SEC Rule 10b-18 restrictions for Buy Back in US instruments. Also
applies local market Buy Back rules (for
non-US instruments). This field cannot be
modified. Value Y or N.

8

Trading Session (optional) - Day, PreOpen, After hours.

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies DarkSeek
Liquidity seeking algo that searches only dark pools.
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Jefferies DarkSeek

Number

Description

1

Select DS for the DarkSeek algo.

2

(optional) Set a start time

3

(optional) Set an end time

4

Relative Limit - (optional) Positive and Negative
values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
specified number of basis points. The strategy
will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

5

Urgency (optional) Passive, Active or
Aggressive.

6
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Jefferies DarkSeek

Number

Description

minimum number of shares per execution
when accessing displayed liquidity. Rounded down to closest lot size.
7

Min Fill Size - (optional) Specifies minimum number of shares per execution. This
applies only to eligible dark pool fills.

8

Buy Back (optional) - Indicates that the
algo should engage SEC Rule 10b-18
restrictions for Buy Back in US instruments.
Also applies local market Buy Back rules
(for non-US instruments). This field cannot
be modified. Value Y or N.

9

WoW (Would or Work) Price (optional)
Users must be able to modify this field on a
Cxl/Replace or cancel the original entry. If
this field has a value, user may specify
BPS Arrival or Price. Price is the default
behavior if WoW Reference is not submitted.

10

WoW (Would or Work) Reference (optional)This
field is used in con-junction with the WoW Price
fields. If a user enters a value in the WoW Price
field; they may specify BPS Arrival or Price. If
WoW Price is not submitted, a “reference” can
be submitted for processing. Users must be able
to modify this field on a Cxl/Replace or cancel the
original entry.
Market
Inside NBBO Price
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Jefferies Finale

Number

Description

Arrival Price
PNC (Previous Night's Close)
Open
BPS Arrival
Price
OPP
Midpoint

11

WoW (Would or Work) Order Percentage (optional) specified max percent of order
WoW can act on. 5-100.

12

WoW (Would or Work) Mode
BLITZ
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
Volume 10%
Volume 20%
Volume 30%
VWAP Day
Custom 1
Patience

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Finale
Benchmark algo that lets you trade into the close.
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Jefferies Finale

Number

Description

1

Choose TOC to use the Finale algo.

2

Start Time – (optional) Define the algo start time.

3

Urgency (optional) – Set the degree of
urgency for execution. a. Passive b. Active
c. Aggressive

4

Close Unit (optional) Used to determine type of
Close Quantity value.
Shares
% of Order
% of ADV
% of Expected Open

5

Close Qty - (optional) - This field combines
with Close Unit field to determine the quant-
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Jefferies Multi Scale

Number

Description

ity that will be placed into the closing auction. Positive numbers only. For an Close
Unit = Shares, Close Qty must be equal to
or greater than 1 round lot. For any %
option, value should be less than or equal
to 100.
To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Multi Scale
Three-tiered "holder" strategy - use algorithms within this work flow.
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Jefferies Multi Scale

Number

Description

1

Select MS to use the Multi Scale algo.

2

(optional) Set a start time

3

(optional) Set an end time

4

Base Algo (required)– percent of volume for
parent (base) algo. Must be different from Algo2
and Algo3 values:
Volume 5%
Volume 10%
Volume 15%
Volume 20%
Volume 25%
Volume 30%
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
BLITZ
VWAP Day
Custom 1
Qty Scale
Patience

5

Base Algo Max Quantity(optional) – Max
quantity for parent (base) algo. Rounded
down to the closest lot size.

6

Algo2 Price – Required if Algo2 is defined.
Used to trigger Algo2 and must be different
from limit price and Algo3 price. 00.00

7

Underlying Algo2 – Different from Base Algo and
Algo3:
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Jefferies Multi Scale

Number

Description

Volume 5%
Volume 10%
Volume 15%
Volume 20%
Volume 25%
Volume 30%
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
BLITZ
VWAP Day
Custom 1
Qty Scale
Patience

8

Algo2 Max Quantity (optional) – Max quantity for algo2. Rounded down to closest lot
size.

9

Algo3 Price - Required if Algo3 is defined.
Used to trigger Algo3 and must be different
from Base Algo price and Algo2 price.
00.00

10

Underlying Algo3 – Different from Base Algo and
Algo2:
Volume 5%
Volume 10%
Volume 15%
Volume 20%
Volume 25%
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Number

Description

Volume 30%
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
BLITZ
VWAP Day
Custom 1
Qty Scale
Patience
To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Opener
Benchmark algo that lets you trade into the open.
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Jefferies Opener

Number

Description

1

Choose algo

2

Relative Limit - (optional) Positive and Negative
values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
specified number of basis points. The strategy
will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

3

Open Unit (optional) - Used to determine type of
Open Quantity value.
Shares
% of Order
% of ADV
% of Expected Open

4

Qty on Open - (optional) - Used in conjunction with the Open Unit field to specify
the quantity that will be placed into the
opening auction. Positive numbers only. If
Open Unit is Shares, the Open Qty must be
equal to or greater than 1 round lot. For any
% option, the value must be less than or
equal to 100.

5

Post Open (optional) - Select the strategy to use
for the opening auction:
Volume 5%
Volume 10%
Volume 15%
Volume 20%
Volume 25%
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Jefferies Opener

Number

Description

Volume 30%
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
BLITZ
VWAP Day
Custom 1
Qty Scale
Patience

6

Post Open Limit - (optional) - Absolute limit
price for the post-open strategy. This limit
will be ignored if it exceeds the overall limit
or relative limit price.

7

Post Open Benchmark - (optional) –
Inside NBBO Price
Arrival Price
PNC
Open

8

Benchmark Offset - (optional) – Positive or
Negative value in basis points set as the
Relative Limit from the Post Open benchmark. These fields work together to set the
Relative Limit for the Post Open strategy. If
the Post Open Limit is specified then the
order will use the value that is more passive.

To use Jefferies algos, select JEFFALGO as the routing destination.
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Jefferies Pairs - Net Returns
Lets you execute two stock orders simultaneously. Use Net Returns to unwind a deal.

Number

Description

1

Select TR to choose the Net Return pairs algo.

2

(optional) Set a start time

3

(optional) Set an end time

4

Volume Limit - (optional) Max rate of volume

5

Pair ID (required) - Unique ID for the day.
Must be unique per pair, per date. Specify
on both legs of the pair. Limited to 28 characters.

6
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Jefferies Pairs - Ratio

Number

Description

Share Balanced
Cash Balanced
Ratio Balanced

7

Execution Style (optional) Active
TWAP
Aggressive
Custom

8

Leg Threshold - Expressed as a percentage by for values up to 99. Values of
100 or greater will be interpreted as a
share amount.

9

Pair Benchmark (required) PNC
Open
Arrival Price

10

Pair Spread ($) (optional) - Positive or negative values accepted.

11

Pair Spread Operator (required) - greater
than or equal to; less than or equal to.

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Pairs - Ratio
Execute two stock orders simultaneously - use the Ratio algo to set up the pairs order.
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Jefferies Pairs - Ratio

Number

Description

1

Choose the Ratio algo.

2

(optional) Set a start time

3

(optional) Set an end time

4

Volume Limit - (optional) Max rate of volume

5

Pair ID (required) - Unique ID for the day.
Must be unique per pair, per date. Specify
on both legs of the pair. Limited to 28 characters.

6

Balance (optional) Share Balanced
Cash Balanced
Ratio Balanced
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Jefferies Pairs - Risk Arb

Number

7

Description

Execution Style (optional) Active
TWAP
Aggressive
Custom

8

Leg Threshold - Expressed as a percentage by for values up to 99. Values of
100 or greater will be interpreted as a
share amount.

9

Pair Ratio (required) - Ratio per pair order.

10

Pair Spread ($) (optional) - Positive or negative values accepted.

11

Pair Spread Operator (required) - greater
than or equal to; less than or equal to.

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Pairs - Risk Arb
Let's you execute two stock orders simultaneously. Allows you to setup, unwind or reverse a deal.

TWS Guide

536

Chapter 1

Jefferies Pairs - Risk Arb

Number

Description

1

Select ARB to choose the Risk Arb pairs algo.

2

(optional) Set a start time

3

(optional) Set an end time

4

Volume Limit - (optional) Max rate of volume

5

Execution Style (optional) Active
TWAP
Aggressive
Custom

6

Leg Threshold - Expressed as a percentage by for values up to 99. Values of
100 or greater will be interpreted as a
share amount.
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Number

7

Description

Pair ID (required) - Unique ID for the day.
Must be unique per pair, per date. Specify
on both legs of the pair. Limited to 28 characters.

8

Pair Objective (optional) Setup
Unwind
Reverse

9

Pair Ratio (required) - Ratio per pair order.

10

CASH (optional) - same ratio value is
applied to both legs.

11

Pair Spread ($) (required) - Positive or negative values accepted.

12

Pair Spread Operator (required) - greater
than or equal to; less than or equal to.

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Patience
Liquidity seeking algo targeted at illiquid securities.
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Jefferies Patience

Number

Description

1

Choose the algo.

2

(optional) Set a start time

3

(optional) Set an end time

4

Volume Limit - (optional) Max rate of volume

5

Blocks Only - Check to specify.

6

WoW Price (optional) Users must be able
to modify this field on a Cxl/Replace or cancel the original entry. If this field has a
value, user may specify BPS Arrival or
Price. Price is the default behavior if WoW
Reference is not submitted.
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Jefferies Patience

Number

7

Description

WoW Reference (optional)This field is used in
con-junction with the WoW Price fields. If a user
enters a value in the WoW Price field; they may
specify BPS Arrival or Price. If WoW Price is not
submitted, a “reference” can be submitted for
processing. Users must be able to modify this
field on a Cxl/Replace or cancel the original
entry.
Market
Inside NBBO Price
Arrival Price
PNC
Open
BPS Arrival
Price
OPP
Midpoint

8

Min Take Size - Specifies the minimum
size to take. Will be rounded down to
nearest lot size.

9

Min Fill Size - (optional) Specifies minimum
number of shares per execution. This applies
only to eligible dark pool fills.

10

WoW Order Percentage - (optional) specified max percent of order WoW can act
on. 5-100.

11

WoW Mode
BLITZ
DARKSeek
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Jefferies Portfolio

Number

Description

Seek Passive
Seek Active
Seek Aggressive
Volume 10%
Volume 20%
Volume 30%
VWAP Day
Custom 1
Patience
To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Portfolio
Execute a group of stock orders according to user-defined input plus trading style.

TWS Guide

541

Chapter 1

Jefferies Portfolio

Number

Description

1

Choose the algo.

2

(optional) Set a start time.

3

(optional) Set an end time.

4

Volume Limit - (optional) Max rate of volume.

5

Portfolio ID (optional) - Set a user ID.

6

Portfolio Limit (optional) – Positive or negative value indicating the number of basis
points from the arrival price. Values from 10,000 to 10,000.

7
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Jefferies Portfolio

Number

Description

Exclude Both
Include Open
Include Close
Include Both

8

Urgency (optional) Passive, Active or
Aggressive.

9

Blocks Only (optional) –
Cash Balance
Beta Neutral
IS
Dark Only
Exec Balance

10

Complete by EOD (optional) – Define
urgency to complete by the end of the trading day.

11

Price Limit Type (optional) – Fixed or Floating

12

Benchmark - (optional)
Inside NBBO Price
Arrival Price
PNC
Open

13

Benchmark Offset(optional) – Positive or
negative value in basis points.

14

Tracking Index (optional) – User-specified
text

15
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Jefferies Post

Number

Description

ative value in basis points.
16

Min Outperform (optional) - Positive or negative value in basis points.

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Post
Allows trading on the passive side of a spread.

Number

Description

1

Select the algo.

2

(optional) Set a start time

3

(optional) Set an end time

4

Relative Limit - (optional) Positive and Negative
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Jefferies Post

Number

Description

values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
specified number of basis points. The strategy
will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

5

Volume Limit (optional) - The max rate of
volume.

6

WoW Price (optional) Users must be able
to modify this field on a Cxl/Replace or cancel the original entry. If this field has a
value, user may specify BPS Arrival or
Price. Price is the default behavior if WoW
Reference is not submitted.

7

WoW Reference (optional)This field is used in
con-junction with the WoW Price fields. If a user
enters a value in the WoW Price field; they may
specify BPS Arrival or Price. If WoW Price is not
submitted, a “reference” can be submitted for
processing. Users must be able to modify this
field on a Cxl/Replace or cancel the original
entry.
Market
Inside NBBO Price
Arrival Price
PNC
Open
BPS Arrival
Price
OPP
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Jefferies Seek

Number

Description

Midpoint

8

Min Take Size (optional) - Specifies the
minimum number of shares per execution
when accessing displayed liquidity. Rounded down to closest lot size.

9

Min Fill Size - (optional) Specifies minimum number of shares per execution. This
applies only to eligible dark pool fills.

10

WoW Order Percentage - (optional) specified max percent of order WoW can act
on. 5-100.

11

WoW Mode (optional)
BLITZ
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
Volume 10%
Volume 20%
Volume 30%
VWAP Day
Custom 1
Patience

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies Seek
This strategy pursues best execution for illiquid securities by seeking out hidden liquidity from multiple
sources, including hidden and displayed market centers.
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Jefferies Seek

Number

Description

1

Choose algo

2

(optional) Set a start time

3

(optional) Set an end time

4

Relative Limit - (optional) Positive and Negative
values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
specified number of basis points. The strategy
will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

5
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Jefferies Seek

Number

Description

Exclude Both
Include Open
Include Close
Include Both

6

Urgency (optional) Passive, Active or
Aggressive.

7

Volume Limit - (optional) Max rate of
volume

8

WoW (Would or Work) Price (optional)
Users must be able to modify this field on a
Cxl/Replace or cancel the original entry. If
this field has a value, user may specify
BPS Arrival or Price. Price is the default
behavior if WoW Reference is not submitted.

9

WoW (Would or Work) Reference (optional)This
field is used in con-junction with the WoW Price
fields. If a user enters a value in the WoW Price
field; they may specify BPS Arrival or Price. If
WoW Price is not submitted, a “reference” can
be submitted for processing. Users must be able
to modify this field on a Cxl/Replace or cancel the
original entry.
Market
Inside NBBO Price
Arrival Price
PNC (Previous Night's Close)
Open
BPS Arrival
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Jefferies Seek

Number

Description

Price
OPP
Midpoint

10

Min Fill Size - (optional) Specifies minimum number of shares per execution. This
applies only to eligible dark pool fills.

11

WoW (Would or Work) Order Percentage (optional) specified max percent of order
WoW can act on. 5-100.

12

WoW (Would or Work) Mode
BLITZ
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
Volume 10%
Volume 20%
Volume 30%
VWAP Day
Custom 1
Patience

To use Jefferies algos, select JEFFALGO as the routing destination.

TWS Guide

549

Chapter 1

Jefferies Strike

Jefferies Strike
This strategy seeks best execution in the user-designated time period, while minimizing market impact and
volatility cost and tracking the arrival price.

Number

Description

1

Choose algo

2

(optional) Set a start time

3

(optional) Set an end time

4

Relative Limit - (optional) Positive and Negative
values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
specified number of basis points. The strategy
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Jefferies Strike

Number

Description

will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

5

Volume Limit - (optional) Max rate of
volume

6

Urgency (optional) Passive, Active or
Aggressive.

7

Auction Participation - (optional)
Exclude Both
Include Open
Include Close
Include Both

8

WoW Price (optional) Users must be able
to modify this field on a Cxl/Replace or cancel the original entry. If this field has a
value, user may specify BPS Arrival or
Price. Price is the default behavior if WoW
Reference is not submitted.

9

WoW Reference (optional)This field is used in
con-junction with the WoW Price fields. If a user
enters a value in the WoW Price field; they may
specify BPS Arrival or Price. If WoW Price is not
submitted, a “reference” can be submitted for
processing. Users must be able to modify this
field on a Cxl/Replace or cancel the original
entry.
Market
Inside NBBO Price
Arrival Price
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Jefferies Strike

Number

Description

PNC
Open
BPS Arrival
Price
OPP
Midpoint

10

Min Fill Size - (optional) Specifies minimum number of shares per execution. This
applies only to eligible dark pool fills.

11

WoW Order Percentage - (optional) specified max percent of order WoW can act
on. 5-100.

12

WoW Mode
BLITZ
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
Volume 10%
Volume 20%
Volume 30%
VWAP Day
Custom 1
Patience

To use Jefferies algos, select JEFFALGO as the routing destination.
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Jefferies Trader

Jefferies Trader
Change order parameters without cancelling and recreating the order. Workflow algo that lets you
interactive with a working order and toggle between strategies with a single click.

Number

Description

1

Choose the TRADER algo.

2

Strategy Intent (required):
Volume 5%
Volume 10%
Volume 15%
Volume 20%
Volume 25%
Volume 30%
Volume 33%
Volume 50%
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Jefferies TWAP

Number

Description

DARKSeek
Seek Passive
Seek Active
Seek Aggressive
BLITZ
VWAP Day
VWAP 1 Hour
VWAP ½ Hr
VWAP 10 Minutes
Custom 1
Custom 2

3

Action Type (optional):
Halt
Resume
Check Dark
Take / Hit

4

Action Qty (optional) - Enter the number of
shares. Not available if Action Type is "Halt" or
"Resume."

5

Action Price - Enter the price.
Not available if Action Type is "Halt" or
"Resume."

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies TWAP
This strategy spreads transactions evenly over the designated time period by slicing the total order quantity
into smaller orders.
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Jefferies TWAP

Number

Description

1

Choose algo

2

(optional) Set a start time

3

(optional) Set an end time

4

Relative Limit - (optional) Positive and Negative
values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
specified number of basis points. The strategy
will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

5

Volume Limit - (optional) Max rate of
volume

6
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Number

Description

Exclude Both
Include Open
Include Close
Include Both

7

Trading Session (optional)– DAY, Pre
Open or after hours.

8

WoW Price (optional) Users must be able
to modify this field on a Cxl/Replace or cancel the original entry. If this field has a
value, user may specify BPS Arrival or
Price. Price is the default behavior if WoW
Reference is not submitted.

9

WoW Reference (optional)This field is used in
con-junction with the WoW Price fields. If a user
enters a value in the WoW Price field; they may
specify BPS Arrival or Price. If WoW Price is not
submitted, a “reference” can be submitted for
processing. Users must be able to modify this
field on a Cxl/Replace or cancel the original
entry.
Market
Inside NBBO Price
Arrival Price
PNC
Open
BPS Arrival
Price
OPP
Midpoint
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Number

10

Description

Min Fill Size - (optional) Specifies minimum number of shares per execution. This
applies only to eligible dark pool fills.

11

WoW Order Percentage - (optional) specified max percent of order WoW can act
on. 5-100.

12

WoW Mode
BLITZ
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
Volume 10%
Volume 20%
Volume 30%
VWAP Day
Custom 1
Patience

13

Buy Back -(optional) Indicates that the algo
should engage SEC Rule 10b-18 restrictions for Buy Back in US instruments. Also
applies local market Buy Back rules (for
non-US instruments). This field cannot be
modified. Value Y or N.

To use Jefferies algos, select JEFFALGO as the routing destination.
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Jefferies Volume Participation
This strategy allows the user to designate the percentage of stock to be executed during a specified period
of time to keep in line with the printed volume. The impact of the trade is directly linked to the volume target
you specify.

Number

Description

1

Choose algo

2

(optional) Set a start time

3

(optional) Set an end time

4

Relative Limit - (optional) Positive and Negative
values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
specified number of basis points. The strategy
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Number

Description

will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

5

Volume Limit - (optional) Max rate of
volume.

6

Dark Volume Limit – Max rate of volume for
dark pool liquidity.

7

Auction Participation - (optional)
Exclude Both
Include Open
Include Close
Include Both

8

Trading Session –DAY, Pre Open, After
hours.

9

WoW Price (optional) Users must be able
to modify this field on a Cxl/Replace or cancel the original entry. If this field has a
value, user may specify BPS Arrival or
Price. Price is the default behavior if WoW
Reference is not submitted.

10

WoW Reference (optional)This field is used in
con-junction with the WoW Price fields. If a user
enters a value in the WoW Price field; they may
specify BPS Arrival or Price. If WoW Price is not
submitted, a “reference” can be submitted for
processing. Users must be able to modify this
field on a Cxl/Replace or cancel the original
entry.
Market
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Number

Description

Inside NBBO Price
Arrival Price
PNC
Open
BPS Arrival
Price
OPP
Midpoint

11

Min Fill Size - (optional) Specifies minimum number of shares per execution. This
applies only to eligible dark pool fills.

12

WoW Order Percentage - (optional) specified max percent of order WoW can act
on. 5-100.

13

WoW Mode
BLITZ
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
Volume 10%
Volume 20%
Volume 30%
VWAP Day
Custom 1
Patience

14
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Jefferies VWAP

Number

Description

should engage SEC Rule 10b-18 restrictions for Buy Back in US instruments. Also
applies local market Buy Back rules (for
non-US instruments). This field cannot be
modified. Value Y or N.

To use Jefferies algos, select JEFFALGO as the routing destination.

Jefferies VWAP
This strategy automatically manages transactions to approximate the all-day or intra-day VWAP through a
proprietary algorithm.
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Number

Description

1

Choose algo

2

(optional) Set a start time

3

(optional) Set an end time

4

Relative Limit - (optional) Positive and Negative
values are allowed. Creates a "soft" limit on the
order as a price move from arrival price by the
specified number of basis points. The strategy
will use the Arrival Price after Market Open, the
day’s Opening price if the order is received
before Market Open.

5

Volume Limit - (optional) Max rate of
volume

6

Auction Participation - (optional)
Exclude Both
Include Open
Include Close
Include Both

7

Trigger Price (optional) Takes any positive
value to trigger the algo. No maximum

8

WoW Price (optional) Users must be able
to modify this field on a Cxl/Replace or cancel the original entry. If this field has a
value, user may specify BPS Arrival or
Price. Price is the default behavior if WoW
Reference is not submitted.

9

WoW Reference (optional)This field is used in
con-junction with the WoW Price fields. If a user
enters a value in the WoW Price field; they may
specify BPS Arrival or Price. If WoW Price is not
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Number

Description

submitted, a “reference” can be submitted for
processing. Users must be able to modify this
field on a Cxl/Replace or cancel the original
entry.
Market
Inside NBBO Price
Arrival Price
PNC
Open
BPS Arrival
Price
OPP
Midpoint

10

Min Fill Size - (optional) Specifies minimum number of shares per execution. This
applies only to eligible dark pool fills.

11

WoW Order Percentage - (optional) specified max percent of order WoW can act
on. 5-100.

12

WoW Mode
BLITZ
DARKSeek
Seek Passive
Seek Active
Seek Aggressive
Volume 10%
Volume 20%
Volume 30%
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Number

Description

VWAP Day
Custom 1
Patience

13

Buy Back -(optional) Indicates that the algo
should engage SEC Rule 10b-18 restrictions for Buy Back in US instruments. Also
applies local market Buy Back rules (for
non-US instruments). This field cannot be
modified. Value Y or N.

To use Jefferies algos, select JEFFALGO as the routing destination.

QB Algos
Quantitative Brokers (QB) offers algos designed to augment existing trading workflows and improve
performance and productivity, without the need to change trading platforms or executing brokers.
QB Bolt

564

QB Strobe

567

QB Closer

569

QB Octane

571

QB Bolt
Achieve best execution across wide-ranging market conditions with swift execution that strikes the perfect
balance between passive and aggressive fills.
To access QBALGOS from Mosaic Order Entry
Click "advanced" to display more order parameters.
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QB Bolt

From the Destination field select QBALGO.
From the Algo parameters list, select the QB Algo to use, in this case select Bolt.
Click the "star" icon to add QBALGOs to the favorites list. Going forward, it will appear as a selection in the
order type field and you can select it without going into the advanced window.
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Use the QB Bolt algo with a Limit or Market order (Market generally recommended).
Parameters
Field Name

Description

Valid Values/ Default Value

Start Time

Optional: Set a start time if desired.

End Time

Set an end time.

Required if Duration is not set.

Duration

Set the maximum time to work the

Required is End Time is not

(Minutes)

order, in minutes.

set.

Mode

Define the aggressiveness of the

Passive: Sophisticated multi-level

order.

pegging without crossing the
spread.
Normal (used as the default if not
defined): Perfect balance of
passive and aggressive.
Aggressive: Urgently seeks
liquidity.

Volume %

A threshold for market participation.

From 0.0 to 1.0

Enter percentage of volume. Note that
if the order is sufficiently large, this
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Field Name

Description

Valid Values/ Default Value

may prevent the order from completing.
Event Pause

For significant economic events,
instruct the algo whether is should

Pause Trading
Trade Through

complete the order ahead of the
event, or pause the order during the
event.
No cleanup

Set to "pause" by default if not
defined.

Order will attempt to complete by the

Check to disable cleanup and

end time if left unchecked.

allow order to sweep for available liquidity.

QB Strobe
Trade on schedule and attempt to capture the spread. This algo positions itself for opportunities to capture
the spread while keeping to a user-defined time schedule.
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QB Strobe

To access QBALGOS from Mosaic Order Entry
Click "advanced" to display more order parameters.
From the Destination field select QBALGO.
From the Algo parameters list, select the QB Algo to use, in this case select Strobe.
Click the "star" icon to add QBALGOs to the favorites list. Going forward, it will appear as a selection in the
order type field and you can select it without going into the advanced window.
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Parameters
Field Name

Description

Start Time

Optional: Set a start time.

End Time

Set an end time.

Valid Values/ Default Value

Required if Duration is not
set.

Duration

Set the maximum time to work the

Required if End Time is not

(Minutes)

order, in minutes.

set.

Benchmark

Choose from Volume-Weighted Average Price (VWAP) or Time-Weighted
Average Price (TWAP) benchmarks.

Volume %

Enter percentage of volume.

From 0.0 to 1.0

QB Closer
Trade optimally over an appropriate, automatically-selected time frame, while targeting the settlement
price as your benchmark. Trade optimally into the close.
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QB Closer

To access QBALGOS from Mosaic Order Entry
Click "advanced" to display more order parameters.
From the Destination field select QBALGO.
From the Algo parameters list, select the QB Algo to use, in this case select Closer.
Click the "star" icon to add QBALGOs to the favorites list. Going forward, it will appear as a selection in the
order type field and you can select it without going into the advanced window.
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QB Octane

This order may complete before, at, or after the benchmark time (if the market is open). Additionally it may
not complete is there is insufficient liquidity.
Not available for Calendar spreads.

QB Octane
A liquidity-seeking strategy designed to optimally execute when urgent completion is the primary objective.
This algo is recommended for orders expected to have a strong short-term alpha. It aggressively hunts for
liquidity as intelligently as possible, while attempting to minimize market impact and still allow opportunities
for spread capture.
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QB Octane

To access QBALGOS from Mosaic Order Entry
Click "advanced" to display more order parameters.
From the Destination field select QBALGO.
From the Algo parameters list, select the QB Algo to use, in this case Octane.
Click the "star" icon to add QBALGOs to the favorites list. Going forward, it will appear as a selection in the
order type field and you can select it without going into the advanced window.
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Parameters
Field Name

Description

Valid Values/ Default Value

Start Time

Optional: Set a start time.

End Time

Set an end time.

Required if Duration is not set.

Duration

Set the maximum time to work the

Required is End Time is not

(Minutes)

order, in minutes.

set.

Urgency

Define the level of urgency to fill the

High (default), Ultra High.

order.

Option Portfolio
Use the Option Portfolio to select, analyze and trade combinations of options on any US stock or index to
achieve the user-specified values of the Greeks, including delta, gamma, vega and theta, or to compare
cost/P&L for a contract or combo you would like to acquire with a simulated portfolio.
Save the Option Portfolio query to Risk Navigator to have orders generated when risk-based alarms are
triggered.
Get Started

574

Define and Submit the Query

577
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Get Started

Constrain the Query Results

582

Evaluate the Solution

583

View What-if Risk in the IB Risk NavigatorSM

584

Get Started
The Option Portfolio window runs off a sophisticated back-end algorithm that mathematically optimizes an
options portfolio using the defining criteria and constraints that you enter via TWSalong with relevant
economic criteria.
To open the Option Portfolio window
1. Select an underlying US stock or index on a trading page.
2. From the Trading Tools menu select Option Portfolio.
If you don’t see Option Portfolio in the tools list, expand the hidden items using the arrow at the bottom of
the menu.
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The Option Portfolio window opens and you’re ready to define the query. To add a tab with another
underlying to the Option Portfolio window, click the New Tab "+" icon.
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The Option Portfolio algorithm works within the user-defined query constraints, and evaluates the
comprehensive options market data (including bid and ask price and size) to minimize the sum of the
following, and find the lowest cost solution:
Cost to execute, as represented by the bid/ask spread for each option in the Query Results list, specifically:
(ask - bid) x (contract multiplier) x quantity
summed over all orders in the Query Results list;
Commission charged to fully execute all orders in the Query Results list;
Cost to hold the Query Results list for a given period of time. This term is only relevant when
the Hold until date is set to a value other then the current date. In this event, the holding cost is calculated as:

[(option value on “hold until” date) - (solution order
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Define and Submit the Query

price for the option)] x (contract multiplier) x (signed
quantity)
summed over all orders in the Query Results list.
The algorithm continues to work and reevaluates the solution in the Query Results list every 30 seconds
until the user submits the order group for execution, freezes the updates to evaluate the solution in more
detail, or changes the query criteria.
Next: Define and Submit the Query

Define and Submit the Query
Define the query by entering the quantity of the risk dimension you wish to acquire, and setting optional
specifications such as time slicing and randomization, last trading day and strike range, and an underlying
reference price range and Hold until date. You can also elect to create a Reference Portfolio and have the
Option Portfolio query an optional portfolio with the same or better P&L.

To define a query
1. Select the desired objective, i.e. Acquire 2000 Delta...
2. For the greeks, enter the position quantity you’d like to acquire.
The position quantity is equal to:
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greek value x position x multiplier
For example, 20 long call options with a delta of .4989 would show a position Delta of approximately
1000. The position Delta calculation is:
.4989 x 20 x 100 = 997.8
3. Define any optional query parameters.
Parameter

Description

Time-sliced

Select this option to acquire the total objective in smaller

orders

increments, with orders being submitted at user-defined time
intervals of seconds, hours or minutes.

Randomize

When you check the Randomize time checkbox, the Option

time period

Portfolio randomly changes the user-defined time interval by

by +/- 20%

any value up to as much as 20% in either direction.
For example, an order with a time interval of 30 seconds might
randomly be submitted at varying intervals of 24, 25, 26, 27,
28, 29, 30, 31, 32, 33, 34 35, 36 seconds.
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Randomize

When you check the Randomize size checkbox, the Option

size by +/-

Portfolio randomly changes the user-defined size increment

55%

by any value up to as much as 55% in either direction.
For example, an order using increments of 500 might
randomly return orders with an objective anywhere from 275
up to 775.

Range of

Select the last trading day(s) you are willing to trade.

Last
Trading
Days
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Define and Submit the Query

Select the range of strikes you are willing to trade.

Range

Reference
Price
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By default, the midpoint of the bid/ask of the underlying price is
used to calculate the objective.
Enter a reference price if you prefer to use a value other than
the midpoint of the underlying price. Note that an alternate
reference price cannot be used if the Price between constraint
is used.

Hold until

Enter a date if you want to hold the solution in the Query
Results list until a specific date.

Long/Short

Checked by default. Constrains the solution to only include

options

long or short option trades, as appropriate. For example, when

only

buying or selling Delta, long options would be more
appropriate to avoid the risk of being short options. The text
will change based on the objective and signed quantity. When
requesting short gamma, short vega or long theta, the text will
read “short options only.”
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Allow

Check to allow a stock leg in the proposed solution list.

underlying
leg
4. Add other constraints if needed (see Constrain the Query Results).
5. Submit the query by clicking the Submit Query button.

Next: Constrain the Query Results

Constrain the Query Results
Option Portfolio allows you to constrain the query results in the risk dimensions other than the objective
dimension. So, if your goal is to achieve a specific Gamma position, you will be able to constrain the
resulting Delta, Vega and Theta. The algorithm imposes the following default constraints:
C o n s t r a i n t s
O
b

Delta
Delta

Gamma

Vega

>0

>0

Theta

j
e
c
t
i
v
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e
Gamma

=0

Vega

=0

Theta

=0

For example, the default Delta constraint ensures that the Gamma and Vega of the Query Results solution
are positive.
To override the system defaults, enter a value in one or multiple input fields and click Submit Query.
Next: Evaluate the Solution

Evaluate the Solution

Freeze updates to the query to evaluate the solution, and use the IB Risk NavigatorSM to see how
implementing the option portfolio will affect your current risk profile.
To stop the algorithm from updating results
1. Click Freeze Updates to keep the algorithm from reevaluating and displaying new solutions.
Note that the data will continue to tick but the Query List will remain unchanged.
Next Step: View What-if Risk in the IB Risk NavigatorSM
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View What-if Risk in the IB Risk NavigatorSM
You can view the risk summary for the proposed Option Portfolio solution list in the IB Risk Navigator, and
add your existing portfolio to the What-if to see how acquired Greek risk dimension will affect your existing
risk profile.

The above image is querying for a basket of trades to acquire 6,000 delta. We have elected to Freeze
updates to the solution list and open the proposed list in the IB Risk Navigator. We click the Risk Navigator
button, and within seconds the solution list opens in its own What-if Portfolio window, shown below:
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To view the solution list in Risk Navigator
1. Click the Risk Navigator button to open a What-if scenario that contains the Query Results list.
The What-if is indicated by a red border around the portfolio, and is named “Option Portfolio.”
2. Select any Report or Measure to see the isolated risk profile for the list.
You can also view the proposed solution list integrated with your current portfolio risk profile. Simply add
your portfolio to the What-if scenario from the Option Portfolio.
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To add your portfolio to the What-if scenario
1. From the Edit menu of the IB Risk Navigator, select Add From.
2. Your actual portfolio, named My Portfolio, is the default selection. Click OK.If you have created other
portfolios, you may select another from the list.
3. The positions in your portfolio are added to the What-if scenario from the Option Portfolio solution
list.
Below you can see the What-if portfolio outlined in red, and below, your actual portfolio. The highlighted
positions are common to both, but distinct at this point.
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After you elect to Add your portfolio, the two sets of positions are summed in the new, integrated What-if
Portfolio, shown below.
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ScaleTrader
To use the ScaleTrader algo to manage blotter orders, right-click a blotter ticket and select Trading Tools
and then select ScaleTrader.
The ScaleTrader can help prevent increasingly deteriorating prices on large sized orders. Use to create a
simple scale order, a pair trade, or a multi-leg combo.
About ScaleTrader

589

Basic Scale Orders

591

Example 1: Basic Scale Order

594

Basic Scale with Profit Orders

595
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About ScaleTrader

Example 2: Scale order with Profit-Taking Orders

598

Scale Profit Orders with Initial Component

600

Example 3: Scale with Profit and Initial Component size

603

Scale Profit with Restore Size

605

Example 4: Scale order with Restore Size

608

Example 5: Restart ScaleTrader

610

Example 6: Restart ScaleTrader with Filled Initial Component Size

611

ScaleTrader for Pairs

612

Use the ScaleChart

614

View Scale Progress

616

Scale Order Examples

617

Combo Orders

618

ScaleTrader Summary

619

About ScaleTrader
ScaleTrader is a flexible trading tool that implements a sophisticated trading algorithm, allowing you to
scale into a large position without being subject to increasingly deteriorating prices, or to trade continually
over a specified price range to capture a user-defined profit offset amount. ScaleTrader supports all
products traded at IB except Mutual Funds.
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ScaleTrader Summary and Status

Below the Scale chart, the Summary and Status sections give you more information on the current scale
order.

TWS Guide

590

Chapter 1

Basic Scale Orders

The Summary shows the number of price levels in your scale, the average price of the total order, the
amount, and the range of the scale between the top and bottom prices.
The Status displays the displays the size of your filled position, and shows the latest Buy price and Sell
price working for the active scale order.
Use the Start and Stop buttons to start and stop the algo. Use Dismiss to close the ScaleTrader.

Basic Scale Orders
ScaleTrader provides many “add ons” that allow you to customize your order based on your trading
strategy. A basic scale order might involve simply scaling into or out of a position, with or without a profit
trade.
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To create a basic scale order
Select the action, Buy or Sell.
Maximum Position - Enter the total order size. Note that this value refers only to the position for this algo
order. It does not take into account or affect any current position in the underlying that you may hold.
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Initial Component Size - The initial component size refers to the number of units that will be submitted at
the starting price, and is used in determining the number of components and price levels needed to achieve
the Maximum Position. The component size must be entered in round lots.
If you do not enter a value in the Subsequent Comp. Size field, this value will be used for both initial and
subsequent components
Subsequent Comp. Size - The number of units that will be submitted at subsequent price levels. Must be
entered in round lots.
Starting Price - The price at which the initial component will be submitted. The starting price defaults to
the ask, but can be changed directly in the field or by dragging the blue line in the scale chart.
Price Increment - Used to define the price levels for each scale component. The increment will be
subtracted from the last price level for a buy order, and added to the last price level for a sell order.
The number of components along with the Starting Price and Price Increment are used to calculate the
Bottom Price, which is the lowest price at which any of the order components will be submitted. If you
change the Bottom Price, the Price Increment is recalculated.
For an example of how a basic scale order like this one will behave, see Example 1: Basic Scale Order.
To view the progress of your scale order, use the View Scale Progress feature.
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Example 1: Basic Scale Order

Data Assumptions:
Label

TWS Guide
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Basic Scale with Profit Orders

NBBO

$26.31 - $26.32

Action

Buy

Total Order Size

10,000

Initial/Subsequent

400

Component Size
Starting Price

$26.28

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of
the order ticket)

This is an order to buy 10000 shares scaled into 25 components of 400 shares each.
The first 400 share component is submitted as a buy limit order at the Starting Price of $26.28.
When the complete order fills, the next component of 400 shares is submitted at $26.26 (starting price price increment).
If price movement results in this order becoming unmarketable, the remainder of the order is held.
Once the price level fills, the next component for 400 shares is submitted at $26.26 (last filled price level price increment).
This pattern continues until all components have filled, or you cancel the order.
Basic Scale Orders topic.

Basic Scale with Profit Orders
ScaleTrader provides many “add ons” that allow you to customize your order based on your trading
strategy. A basic scale order might involve simply scaling into or out of a position, with or without a profit
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trade. The Profit taking orders are submitted against a filled order component at a specific price level,
where the price is calculated using the component price level +/- the defined profit offset.

To create a basic scale with profit orders
Select the action, Buy or Sell.
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Maximum Position - Enter the total order size. Note that this value refers only to the position for this algo
order. It does not take into account or affect any current position in the underlying that you may hold.
Initial Component Size - The initial component size refers to the number of units that will be submitted at
the starting price, and is used in determining the number of components and price levels needed to achieve
the Maximum Position. The component size must be entered in round lots.
If you do not enter a value in the Subsequent Comp. Size field, this value will be used for both initial and
subsequent components
Subsequent Comp. Size - The number of units that will be submitted at subsequent price levels. Must be
entered in round lots.
Randomize Size - Check to help ensure the components are not easily detected in the market. Resulting
component sizes will be plus or minus 55 percent rounded up or down to the nearest round lot. For a 400
component size, submitted sizes could be 200, 300, 400, 500 or 600.
The Randomize feature cannot be used with profit taker orders.
Starting Price - The price at which the initial component will be submitted. The starting price defaults to
the ask, but can be changed directly in the field or by dragging the blue line in the scale chart.
Price Increment - Used to define the price levels for each scale component. The increment will be
subtracted from the last price level for a buy order, and added to the last price level for a sell order.
The number of components along with the Starting Price and Price Increment are used to calculate the
Bottom Price, which is the lowest price at which any of the order components will be submitted. If you
change the Bottom Price, the Price Increment is recalculated.
Check Create profit taking order and enter a profit offset amount.
For an example of how a basic scale order like this one will behave, see Example 2: Scale order with ProfitTaking Orders.

TWS Guide

597

Chapter 1

Example 2: Scale order with Profit-Taking Orders

Example 2: Scale order with Profit-Taking Orders

Data Assumptions:
Label
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Example 2: Scale order with Profit-Taking Orders

NBBO

$26.31 - $26.32

Action

Buy

Total Order Size

10,000

Initial/Subsequent

400

Component Size
Starting Price

$26.28

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of
the order ticket)

Create profit taking

Check to enable

order
Profit Offset

0.20

Like example 1, this is an order to buy 10000 shares scaled into 25 components of 400 shares each. In
addition, we have instructed TWS to submit profit-taking sell orders against each order component, with a
.20 profit offset. This means the profit orders will be submitted at the last filled price level plus the .20 cent
offset.
The first 400 share component is submitted as a buy limit order at the Starting Price of $26.28. When the
component order fills two things happen. The next component of 400 shares is submitted at $26.26
(component price - price increment), and a sell order is submitted for 400 shares at $26.48 (component
price + profit offset).
When the $26.26 price level fills, a sell order for 400 shares at $26.46 (component price + profit offset) is
submitted. This pattern continues until all components have filled, or you cancel the order.
The order will be held if any parent component becomes unmarketable, but the profit orders can continue
to work without holding up the order.
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Basic Scale with Profit Orders topic.

Scale Profit Orders with Initial Component
ScaleTrader provides many “add ons” that allow you to customize your order based on your trading
strategy. A basic scale order might involve simply scaling into or out of a position, with or without a profit
trade. The Profit taking orders are submitted against a filled order component at a specific price level,
where the price is calculated using the component price level +/- the defined profit offset. If you use a
higher Initial Component size, the profit orders are submitted against a component size AS IF the
components were submitted at the Starting Price + Price Increment.
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To create a scale profit order with Initial Component
Select the action, Buy or Sell.
Maximum Position - Enter the total order size. Note that this value refers only to the position for this algo
order. It does not take into account or affect any current position in the underlying that you may hold.
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Initial Component Size - The initial component size refers to the number of units that will be submitted at
the starting price, and is used in determining the number of components and price levels needed to achieve
the Maximum Position. The component size must be entered in round lots.
If you do not enter a value in the Subsequent Comp. Size field, this value will be used for both initial and
subsequent components
Subsequent Comp. Size - The number of units that will be submitted at subsequent price levels. Must be
entered in round lots.
Randomize Size - Check to help ensure the components are not easily detected in the market. Resulting
component sizes will be plus or minus 55 percent rounded up or down to the nearest round lot. For a 400
component size, submitted sizes could be 200, 300, 400, 500 or 600.
Starting Price - The price at which the initial component will be submitted. The starting price defaults to
the ask, but can be changed directly in the field or by dragging the blue line in the scale chart.
Price Increment - Used to define the price levels for each scale component. The increment will be
subtracted from the last price level for a buy order, and added to the last price level for a sell order.
The number of components along with the Starting Price and Price Increment are used to calculate the
Bottom Price, which is the lowest price at which any of the order components will be submitted. If you
change the Bottom Price, the Price Increment is recalculated.
Check Create profit taking order, and enter the profit offset.
Once the price increment has been entered, the Top Price is calculated, and will be higher than the starting
price by the price increment times the number of component sizes higher the initial price is compared to the
subsequent component size. in the above example, the initial size is one component size larger than the
subsequent size, so the calculation is 1 x .02 = .02. The top price will be .02 (or one price increment) higher
than the starting price.
For an example of how a scale profit order with a larger initial component will behave, see Example 3:
Scale with Profit and Initial Component size.
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size

Example 3: Scale with Profit and Initial Component size

Data Assumptions:
Label
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Example 3: Scale with Profit and Initial Component
size

NBBO

$26.31 - $26.32

Action

Buy

Total Order Size

10,000

Initial Component Size

800

Subsequent Com-

400

ponent Size
Starting Price

$26.28

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of
the order ticket)

Create profit taking

Check to enable

order
Profit Offset

0.20

The difference between this order and the order in Example 2 is that the Initial Component Size is larger
than the subsequent component size by one full size. This feature works in conjunction with the profit taking
orders, which we have enabled at an offset of $.20.
To understand the larger initial component, let’s first look at the mechanics of using the same component
size of 400 with the $.02 profit offset. In this case, a BUY order would be submitted at the starting price of
$26.28 and after it fills, the profit SELL order would be submitted at the component price + profit offset, or
$26.48. When this fills, you have bought at $26.28 and sold at $26.48 for a profit of $.20 per share.
Now let’s look at the example above with the Initial Component of 800. TWS submits the first component
as a BUY order for 800 at the Starting Price, or $26.28. But when this fills, the profit sell orders are
submitted in Subsequent Component-sized lots AS IF the 800 shares were sent in as two BUY orders at
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$26.28 and $26.26, right up to the non-editable Top Price. So two sell orders for 400 shares each are
submitted for $26.48 and $26.46. Once these fill, the subsequent 400-share components kick in for the
remainder of the 10000-share order.
Scale Profit Orders with Initial Component topic.

Scale Profit with Restore Size
ScaleTrader provides many “add ons” that allow you to customize your order based on your trading
strategy. If you elect to Restore size after taking profit, the algo will restore the size component at the last
filled price level once the associated profit order has filled.
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To create a scale profit order with Restore Size
Select the action, Buy or Sell.
Maximum Position - Enter the total order size. Note that this value refers only to the position for this algo
order. It does not take into account or affect any current position in the underlying that you may hold.
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Initial Component Size - The initial component size refers to the number of units that will be submitted at
the starting price, and is used in determining the number of components and price levels needed to achieve
the Maximum Position. The component size must be entered in round lots.
If you do not enter a value in the Subsequent Comp. Size field, this value will be used for both initial and
subsequent components
Subsequent Comp. Size - The number of units that will be submitted at subsequent price levels. Must be
entered in round lots.
Randomize Size - Check to help ensure the components are not easily detected in the market. Resulting
component sizes will be plus or minus 55 percent rounded up or down to the nearest round lot. For a 400
component size, submitted sizes could be 200, 300, 400, 500 or 600.
Starting Price - The price at which the initial component will be submitted. The starting price defaults to
the ask, but can be changed directly in the field or by dragging the blue line in the scale chart.
Price Increment - Used to define the price levels for each scale component. The increment will be
subtracted from the last price level for a buy order, and added to the last price level for a sell order.
The number of components along with the Starting Price and Price Increment are used to calculate the
Bottom Price, which is the lowest price at which any of the order components will be submitted. If you
change the Bottom Price, the Price Increment is recalculated.
Check Create profit taking order and enter a profit offset amount.
Check Restore size after taking profit.
For an example of how the Restore size scale feature will behave, see Example 4: Scale order with
Restore Size.
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Example 4: Scale order with Restore Size

Data Assumptions:
Label
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Example 4: Scale order with Restore Size

NBBO

$26.31 - $26.32

Action

Buy

Total Order Size

10,000

Initial/Subsequent

400

Component Size
Starting Price

$26.28

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of
the order ticket)

Create profit taking

Check to enable

order
Profit Offset

0.20

Restore size after tak-

Check to enable

ing profit

The Restore Size feature restores the component size at a specific price level after the opposite side order
for the price level fills.
In this example, the order is scaled into 25 components of 400 shares each.
The first 400-share component is submitted at $26.28. After this level fills, the next limit order for 400 is
submitted at $26.26, and at the same time an opposite-side profit order is submitted for 400 at $26.48
(component price + profit offset).
Once the sell order fills at $26.48 taking the profit, the filled quantity of 400 is put back in to the original order
at its same price level of $26.28, and the $26.26 price level component is canceled.
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When using the Restore size feature, you may want to consider making the profit offset closer to the price
increment to help ensure the orders fill.
Scale Profit with Restore Size topic.

Example 5: Restart ScaleTrader
Data Assumptions:
Label

Value

NBBO

$10.12 - $10.15

Action

Buy

Total Order Size

1000

Initial Component

100

Size
Subsequent

100

Component Size
Starting Price

$10.10

Price Increment

.02

Order Type

Limit

Time in Force

GTC (this is set on the Basic tab of
the order ticket)

Create profit taking

Enabled

order
Profit Offset

.03

Restore size after

Enabled

taking profit
Restart ScaleTrader
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Example 6: Restart ScaleTrader with Filled Initial
Component Size

Initial Position

200

The Restart feature helps you resume a busted ScaleTrader order from the point of the bust. A bust results
in a lost connection between the scale and profit order processes, leaving two independent scaled orders.
You can cancel these orders and create a new ScaleTrader Restart order.
The Existing Position value of 200 tells ScaleTrader that two of the components have filled, at $10.10 and
$10.08, respectively. It "restarts" the scale order beginning with the 3rd component. The first buy order is
for 100, and is submitted at $10.06. The profit-taker orders are set up for all three components, 100 at
$10.13, 100 at $10.11, and 100 at $10.09, which are submitted. When the sell order for 10.13 fills, the size
is restored at the 10.10 price level.
The Existing Position feature is only available if the profit-taking order and Restore Size instructions are
used.

Example 6: Restart ScaleTrader with Filled Initial Component
Size
A busted scale order results in a lost connection between the scale and profit order processes, leaving only
two independent scaled orders. The Restart instruction is designed to help you resume a cancelled or
busted ScaleTrader order, starting from the point at which the scaled sequence left off. First, cancel the
two separated scale orders. Next, create a new ScaleTrader Restart order by identifying your current
position and telling ScaleTrader how much of the initial component size filled in the busted order.
ScaleTrader will restart the order at the appropriate component and price level.
Note: Note: The Filled Initial Component Size field only becomes active if the Existing
Position value is less than the Initial Component Size.
Profit Offset: $0.02
Restore Size after taking profit: box checked on Order Ticket Scale tab
Restart ScaleTrader: box checked on Order Ticket Scale tab
Existing Position value: 500
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Filled Initial Component Size: 1200 (this value must be greater than or equal to the Existing
Position value, up to a maximum of the Initial Component Size).
The Filled Initial Component Size of 1200 tells ScaleTrader that there is an unfilled quantity of 800 (of the
2000 Initial Component Size). The first buy order for 800 is submitted at $10.15, and profit-taker orders of
1000 and 200 are set at $10.17 and $10.18, respectively.
Activate the Restart ScaleTrader instruction using the checkbox on the Scale tab of the Order Ticket. This
feature is only available if the profit-taking order and Restore Size instruction is used, and if the value in the
Existing Position field is less than the Initial component size.

ScaleTrader for Pairs
A pair trade involves trading two stocks simultaneously, buying one and selling the other at predefined
price differences. Usually, the two stocks selected have displayed a close price relationship in the past, or
the relationship is dictated by fundamentals. When this relationship approaches a certain, extreme level, a
position is established in which the relatively overvalued stock is sold short and the other one is bought for
approximately equal dollar values. It is expected that eventually the relationship will return to a normal level,
at which time the position is unwound at a profit.

TWS Guide

612

Chapter 1

ScaleTrader for Pairs

Stock-stock pair combinations can only be traded as non-guaranteed. To help increase the chances that
both legs will fill, stock-stock scale pairs can only be sent as:
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LMT + MKT, where one or both legs are submitted as marketable limit orders when the combo
becomes marketable. If only one leg fills, the second leg is resubmitted as a market order.
REL + MKT, where one or both of the legs are submitted as simulated relative orders (at the bid for a
buy and at the ask for a sell). If only one leg fills, the second leg is resubmitted as a market order.
To create a scale stock pair trade based on price difference
Open the ScaleTrader.
From within Mosaic, use the New Window dropdown and select More Advanced Tools and
then ScaleTrader.
From within the Advanced Order Management quote monitor, use the Trading Tools
menu.
Select the Pair tab and click the Edit Pair button.
Create tickers for each of the stock-stock pair:
Enter the higher priced of the pair in the Buy line.
Enter the lower priced (but relatively overvalued) of the pair in the Sell line.
Choose price difference and click Create.
At this point you will be required to acknowledge that the combo is non-guaranteed.
The scale chart shows the price difference between the two contracts over time. The starting price
illustrates the beginning level of price difference between the two contracts at which you want to submit an
order.

Use the ScaleChart
The ScaleChart provides a visual method of modify the scale prices. Use the lines and handles in the chart
to set the Starting Price and bottom price and have TWS calculate the price increment.
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To move the prices, grab a line in the chart.
When you move the blue Starting Price line, the other lines move in the same increment.
When you move the Bottom Price line, the Price Increment is recalculated since the distance between
the starting and bottom prices have changed. If the Initial Component is higher than the Subsequent
Component size, the Top Price is also recalculated.
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If you move the top price, the Initial Component Size, Price Increment and Bottom Size are all recalculated.

View Scale Progress
You can monitor the progress of your scale orders using the Scale Progress box.

To View Scale Progress
Right-click the scale order line and select View Scale Progress.
The Scale Progress Box
The Scale Progress box displays the complete scale price ladder, the Open/Filled component list for the
parent scale order, and the Open/Filled component list for the child profit orders.
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Scale Order Examples
The data assumptions in the table below are repeated for all examples, with other variables described as
needed. These examples do not encompass all of the potential algorithmic results that would occur on
partially filled component levels.
Example 1: Basic Scale Order
Example 2: Scale order with Profit-Taking Orders
Example 3: Scale with Profit and Initial Component size
Example 4: Scale order with Restore Size
Example 5: Restart ScaleTrader
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Example 6: Restart ScaleTrader with Filled Initial Component Size

Combo Orders
When using ScaleTrader for creating generic combination orders, note the following:
When you create a STK STK generic combo, the ratios are automatically simplified when you save the
combo. This means that the combo you define in the Combo Selection box to Buy 300 XYZ and sell
700 ABC ends up on the ticker line as Buy 3 XYZ and Sell 7 ABC.
Scale parameters such as Total Order Size and Initial and Subsequent Component sizes are
expressed in terms of the total combo. For example, if you buy a generic STK STK combo defined as
Buy 10 DELL, Sell 1 IBM, and set the Initial Component Size to 5, the first component order would be:
Buy (5 x 10) DELL, Sell (5 x 1) IBM.

Guaranteed combination pairs including US stock-option and option-option pairs, and which can be traded
from the Combo tab, can use the following order types:
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LMT + LMT, where one or both legs are submitted as marketable limit orders when the combo
becomes marketable. If one fills, the other is resubmitted as a limit order.
REL + LMT, where one or both of the legs are submitted as a simulated relative order (at the bid for a
buy and at the ask for a sell). If only one leg fills, the second leg is resubmitted as a limit order.
LMT + MKT, where one or both legs are submitted as marketable limit orders when the combo
becomes marketable. If only one leg fills, the second leg is resubmitted as a market order.
REL + MKT,where one or both of the legs are submitted as a simulated relative order (at the bid for a
buy and at the ask for a sell). If only one leg fills, the second leg is resubmitted as a market order.
Use ScaleTrader for combination orders
1. Click the Combo tab in ScaleTrader.
2. If you opened ScaleTrader with an underlying selected, click the Edit Combo button; otherwise,
enter an underlying and select from the combo type, including EFP, Futures Spread or Option
Combo.
3. Use the ComboTrader box to define a strategy, and click Create.
You can monitor the progress of your scale orders by right-clicking on the order line and selecting View
Scale Progress.

ScaleTrader Summary
Use the Scale Summary page to view real-time status of your scale orders, including filled and total
quantity, filled, remaining, and total value, and the percent filled for each scale. The Scale Summary is a
system-generated page with its own layout.
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To create a Scale Summary
1. Use the right-click menu fromAdd Tab indicator and select ScaleTrader.
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Order Types
Discover more than 60 different order types including basic and advanced orders, algos, attributes and
times in force.
Basic Order Types

625

Limit

626

Limit if Touched

627

Limit-On-Close

628

Market

629

Market if Touched

630

Market-On-Close

630

Market-to-Limit

631

MidPrice Orders

632

Stop

634

Stop Limit

635

Advanced Order Types

636

Auto Trailing Stop

637

Bracket

639

Box Top

640

Conditional

641

Funari Orders

643

IBDARK Orders

644

Iceberg/Reserve

645
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Limit + Market

646

Market with Protection

647

Minimum Quantity

647

NYSE Closing Auction D-Quote

648

Passive Relative

649

Pegged-to-Market

650

Pegged to Midpoint

651

Pegged to Stock

652

Pegged to Benchmark

654

Price Improvement Auction

655

Relative/Pegged-to-Primary

656

Relative + Market

658

Retail Price Improvement Orders (RPI)

659

Snap to Market

660

Snap to Midpoint

661

Snap to Primary

662

Stop Order with Protection

663

T + 1 Stock Settlement

664

Trailing Stop

665

Trailing Stop Limit

667

Trailing Market if Touched

668

Trailing Limit if Touched

669
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Trailing Limit + Market

671

Trailing Relative + Market

672

Attached Orders

673

Attach a Beta Hedge Order

673

Attach a Delta Hedge Order

674

Attach an FX Order

676

Attach a Pair Trade

677

Auto Combo Limit Order

678

Auto Combo Market Order

679

Order Attributes

680

All or None (AON)

681

Block

682

Discretionary

682

Hidden

684

One Cancels Other

685

One-Cancels-Other (OCO)

687

Sweep-to-Fill

688

Volatility Orders

689

Pegged-to-Primary Volatility Order

689

Pegged to Market Volatility Order

691

Pegged to Midpoint Volatility Order

692

Pegged to Surface Volatility Order

693
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Times in Force

Basic Order Types

695
698

Times in Force for Orders

699

Regular Trading Hours

701

Good After Time

702

Fill or Kill

703

Auction

704

Market-on-Open

705

Limit-On-Open

706

Basic Order Types
Limit

626

Limit if Touched

627

Limit-On-Close

628

Market

629

Market if Touched

630

Market-On-Close

630

Market-to-Limit

631

MidPrice Orders

632

Stop

634

Stop Limit

635
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Limit
A limit order is an order to buy or sell a contract ONLY at the specified price or better.
To create a Limit order
Populate the Order Entry panel by selecting an instrument in a linked window or typing the symbol in the
entry box.
Click Buy or Sell.
Select LMT from the list of order types, and enter a limit price.
Click Submit to send the order.

From within the Classic Interface:
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1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select LMT as the order type.
3. In the Lmt Price field, enter the price at which you want the order to execute.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of limit orders and the products and exchanges on which they're supported,
visit the Order Types information page.

Short Video

Limit if Touched
A limit if touched order is designed to buy (or sell) a contract below (or above) the market, at the limit price
or better. The Aux. Price value is the trigger to submit the limit order at the specified limit price.
To create a Limit if Touched order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select LIT as the order type.
3. In the Lmt Price field, enter the price at which you want the order to execute.
4. In the Aux. Price field, enter the "touched" price to trigger the order.
5. To transmit the order, click the "T" in the Status field.

TWS Guide

627

Chapter 1

Limit-On-Close

For a more detailed description of Limit if Touched orders and the products and exchanges on which
they're supported, visit the Order Types information page.

Limit-On-Close
An LOC (limit-on-close) order will fill at the closing price if that price is at or better than the submitted limit
price. Otherwise, the order will be canceled.
To create an LOC order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field, select LOC as the order type.
3. To transmit the order, click the "T" in the Status field.
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For a more detailed description of LOC orders, visit the Order Types information page.

Market
A market order is an order to buy or sell an asset at the bid or offer price currently available in the
marketplace. When you submit a market order, you have no guarantee that the order will execute at any
specific price.
To create a Market order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MKT as the order type.
3. To transmit the order, click the "T" in the Status field.

For a more detailed description of market orders, visit the Order Types information page.
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Market if Touched
A market if touched order is designed to buy (or sell) a contract when the market goes below (or above) the
current price. The Aux. Price value is the trigger to submit the market order.
To create a Market if Touched order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MIT as the order type.
3. In the Aux. Price field, enter the "touched" price to trigger the order.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of Market if Touched orders visit the Order Types information page.

Market-On-Close
An MOC (market-on-close) order will execute as a market order as close to the closing price as possible.
To create an MOC order
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1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field, select MOC as the order type.
3. To transmit the order, click the "T" in the Status field.

For a more detailed description of MOC orders, visit the Order Types information page.

Market-to-Limit
A market-to-limit order is sent in as a market order to execute at the current best price. If the entire order
does not immediately execute at the market price, the remainder of the order is re-submitted as a limit
order with the limit price set to the price at which the market order portion of the order executed.
To create a market-to-limit order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MTL as the order type.
3. To transmit the order, click the "T" in the Status field.
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For a more detailed description of market-to-limit orders, visit the Order Types information page.

MidPrice Orders
The MidPrice order attempts to fill at the current midpoint of the NBBO or better. Set an optional price cap
to define the highest price (for a buy order) or the lowest price (for a sell order) you are willing to accept.

TWS Guide

632

Chapter 1

MidPrice Orders

To create a MidPrice Order
Populate the Order Entry panel by selecting an instrument in a linked window, or by typing the symbol in
the entry box.
Click Buy or Sell.
Select MIDPRICE from the list of order types.
Optionally, set a price cap and modify any other order parameters as needed.
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Click Submit to send the order.

To create a MidPrice Order in Classic Layout
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MIDPRICE as the order type.
3. Optionally use the Price Cap field to set a cap, and modify any other order parameters as needed.
4. To transmit the order, click the "T" in the Transmit field.
For a more detailed description of MidPrice orders and the products and exchanges on which they're
supported, visit the Order Types information page.

Stop
A Stop order becomes a market order to buy or sell securities or commodities once the specified stop price
is attained or penetrated. A Stop order is not guaranteed a specific execution price.
To create a Stop order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select STP as the order type.
3. Enter the Stop Election price in the Aux. Price field.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of stop orders, visit the Order Types information page.
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Stop Limit
A Stop Limit order is similar to a stop order in that a stop price will activate the order. However, unlike the
stop order, which is submitted as a market order when elected, the stop limit order is submitted as a limit
order. Use the Lmt Price and Aux. Price fields on the trading screen to enter orders requiring multiple
prices or values.
To enter a Stop Limit order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL order.
2. Click in the Type field and select STP LMT as the order type.
3. Enter the Limit price in the Lmt Price field.
4. Enter the Stop Election price in the Aux. Price field.

Note: You can enable the system to automatically adjust the limit price if you change the stop
price. To activate this feature, on the Edit menu select Global Configuration and then select Order
in the left pane. Check Auto-adjust limit price for STP LMT and LIT orders. The limit price will move
based on the offset implied when you set the original limit and stop election prices.
For a more detailed description of stop limit orders, visit the Order Typesinformation page.
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Advanced Order Types
Includes pegged, relative, trailing orders and more.
Auto Trailing Stop

637

Bracket

639

Box Top

640

Conditional

641

Funari Orders

643

IBDARK Orders

644

Iceberg/Reserve

645

Limit + Market

646

Market with Protection

647

Minimum Quantity

647

NYSE Closing Auction D-Quote

648

Passive Relative

649

Pegged-to-Market

650

Pegged to Midpoint

651

Pegged to Stock

652

Pegged to Benchmark

654

Price Improvement Auction

655
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Relative/Pegged-to-Primary

656

Relative + Market

658

Retail Price Improvement Orders (RPI)

659

Snap to Market

660

Snap to Midpoint

661

Snap to Primary

662

Stop Order with Protection

663

T + 1 Stock Settlement

664

Trailing Stop

665

Trailing Stop Limit

667

Trailing Market if Touched

668

Trailing Limit if Touched

669

Trailing Limit + Market

671

Trailing Relative + Market

672

Auto Trailing Stop
You can attach a trailing stop order to a limit order. The attached trailing stop order is automatically
activated when the limit order is filled.
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To attach an auto trailing stop
1. Right-click on a limit order and select Attach, then select Auto Trailing Stop.
To modify the trailing amount, change the value in the Aux. Price field.

To change the default trailing amount used to calculate the stop election price, use the Order > Order
Defaults page of Global Configuration.
2. When the limit order executes, the trailing stop order is submitted. The stop election price will be calculated using the (parent order limit price + trailing amount) for Buy orders, and the (parent order
limit price - trailing amount) for Sell orders.
The relationship between the parent and attached order can be seen in the Trailing Key field. Related
orders are assigned the same trailing key.
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Bracket
Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two
opposite-side orders. A BUY order is bracketed by a high-side sell limit order and a low-side sell stop (or
stop-limit) order. A SELL order is bracketed by a high-side buy stop (or stop-limit) order and a low side buy
limit order.
The order quantity for the bracketing orders is the same as that of the original order. By default, the amount
off the current price to which a bracket order is set is 1.0. This offset amount can be manually changed on
the order management line for a specific order, or you can modify the default offset amount using the Order
Preset in Global Configuration.
In addition, if you display the OCA Group field on your order line, you will see that the two child bracket
orders are automatically put into an OCA group. This means that when one of the orders executes, the
other will automatically be cancelled.
When including bracket orders in a basket, display the Key field in the BasketTrader to see the parent/child
relationship between orders.

Note: If you attach a bracket to a working order, you will need to transmit the child orders
manually. However, the system does recognize that the parent and child orders are designed to
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work as a bundled group, which you can see by the matching values in the Trailing Key field if you
display this field on your order line. If you attach a bracket to a working order and modify the parent,
when you re-transmit the parent order the children are then transmitted automatically.
To create a Bracket order
1. Click the "Ask" or "Bid" price of an asset to create an Order Management line.
Click the Ask Price to create a Buy order.
Click the Bid Price to create a Sell order.

2. On the right-click menu, select Attach and then select Bracket Orders.
3. Verify that the order parameters are correct.
4. Transmit the order.
For more information on Bracket orders, visit the Order Types information page.

Box Top
A BOX TOP order is sent in as a market order to execute at the current best price. If the entire order does
not immediately execute at the market price, the remainder of the order is re-submitted as a limit order with
the limit price set to the price at which the market order portion of the order executed.
To create a BOX TOP order
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1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select BOX TOP as the order type.
3. To transmit the order, click the "T" in the Status field.

Available for options routed to BOX.
For details on Box Top orders, visit the Order Types information page.

Conditional
A conditional order is an order that will automatically be submitted or cancelled ONLY IF specified criteria
for one or more defined contracts are met. You can use stocks, options, futures or security indexes to
trigger a conditional order.
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To create a conditional order
1. Select an order line.
2. From the right-click menu, select Modify and then select Condition.
3. From the Conditional tab on the order ticket click Add Condition.
4. Enter contract information for the contingent asset in the Conditional Order box.
5. Enter the trigger information for the contingent asset:
Select the trigger method.
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Select whether the price of the contingent asset should be less than or equal to (<=) or
greater than or equal to (>=) the trigger price.
Enter the trigger price.
If you select the double bid/ask trigger method, the greater than or equal to operator (>=) will
use the BID price and the less than or equal to operator (<=) will use the ASK price.
6. Click OK. The condition appears in the Current Conditions list.
To set multiple conditions, use the Add Condition button and click AND or OR in the Current
Conditions area.
Field/Button

Description

Add Condition

Invokes the Conditional Order entry box.

Delete

Deletes the selected condition.

Modify

Opens the Conditional Order entry box for the selected
condition to allow you to make changes.

Allow condition

Lets the selected condition activate the order if it is satisfied

to be satisfied...

outside of regular trading hours.

Action to take...

If selected conditional order is satisfied, you can elect to have
the primary order submitted OR cancelled.

Funari Orders
A Funari order is submitted as limit order, with any remaining unfilled quantity resubmitted as a Market-OnClose order at the end of trading.
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To create a Funari order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL order.
2. In the Dest. field ensure that the destination is TSEJ.
3. Click in the Type field and select FUNARI as the order type.
4. Specify the limit price.
This order type is only available for stock orders direct-routed to the Tokyo Stock Exchange.

IBDARK Orders
Non-marketable U.S. stock orders routed to IBDARK are tagged "post only” and are held in IB's order
book where incoming SmartRouted orders from other IB customers are eligible to trade against them.
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To route an order to IBDARK
From the market data line of a US Stock, click the Bid to create a SELL order or the Ask to create a BUY
order.
In the Destination field, select IBDARK.
Transmit the order.
For more information on how the IBDARK order works, see the IBDARK Order Type page.

Iceberg/Reserve
An Iceberg/Reserve order allows you to submit an order (generally a large volume order) while publicly
disclosing only a portion of the submitted order at a time.
To create an Iceberg/Reserve order
1. Show the Display Size field on an order management line:
Hold your mouse over any order row field until the "+" sign appears to the left of the field
title.
Click the "+" sign to invoke the order fields dropdown list.
In the Order Attributes list select Display Size.
2. On the trading screen, create an order (click the Ask Price to create a BUY order, or the Bid Price
to create a Sell order).
3. In the Display Size field, enter the quantity that you want publicly disclosed.

For a more detailed description of iceberg/reserve orders visit the Order Types information page.
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Limit + Market
The LMT + MKT order type is available for certain multi-leg combinations, and when used with a nonguaranteed combination order it could help to increase the chances of all legs in the order being filled.
Initially one or more legs are submitted as limit orders, but if the first leg fills or partially fills, the remaining
legs are resubmitted as market orders.

To create a combination Limit + Market order
1. Create a Combination Order line on the Quote Monitor.
2. Click the Bid or Ask to create a Sell or Buy order line.
3. From the Type dropdown, select LMT + MKT.
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When you select LMT + MKT, the limit price field becomes inactive and the Trigger Price field requires the
combo price input.

Market with Protection
A Market with Protection order is sent in as a market order to execute at the current best price. If the entire
order does not immediately execute at the market price, the remainder of the order is re-submitted as a
limit order, with the limit price set by the exchange to a price slightly higher/lower than the current best
price.
To create a market with protection order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select MKT PRT as the order type.
3. To transmit the order, click the red "T" in the Transmit field.

For a more detailed description of market with protection orders, visit the Order Types information page.

Minimum Quantity
Use the Minimum Quantity order attribute to ensure that the minimum specified number of units is filled for
your order.
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To create a Minimum Quantity order
1. Show the Min Quantity field: Hold your mouse over any field title until the "+" and "x" Insert and
Remove icons appear. Click the "+ " to display the list of available fields. Note that if you hover your
mouse over an order field, all available order fields are displayed. If you hover over a market data
field, all available market date fields are displayed.
2. On the trading screen, create an order (click the Ask Price to create a BUY order, or the Bid Price
to create a Sell order).
3. In the Min. Quantity field enter the minimum number of contracts that must be available for any part
of the order to execute.

Available for bonds and Smart-routed options orders.

NYSE Closing Auction D-Quote
The D-Quote order provides greater flexibility, execution speed and enhanced representation during the
NYSE closing auction.
To create a D-Quote order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Destination field, select NYSEFLOOR.
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3. In the Type field, select LMT or MKT as the order type.
Market orders will receive the closing print price.
Limit orders will receive the closing print price if the order is priced at or better than the closing auction
price.
4. To transmit the order, click the "T" in the Status field.

For a more detailed description of D-Quote orders, visit the Order Types information page.

Passive Relative
The Passive Relative order submits a limit order at a less aggressive price than the National Best Bid and
Offer (NBBO). Your price is automatically adjusted when the market moves. For a buy order, your bid is
pegged to the NBB by a less aggressive offset amount*, and if the NBB moves up, your bid will also move
up. For sales, your offer is pegged to the NBO by a less aggressive offset, and if the NBO moves down,
your offer will also move down. In addition to the offset, you can define an absolute cap, which works like a
limit price, and will prevent your order from being executed above or below a specified level.
For passive relative orders with a "0" offset, the order is submitted as a limit order at the best bid/ask, and
will move up and down with the market to continue to match the inside quote.
Note: If you have tooltips enabled, you can hold your mouse over the Limit price of the relative
order and see the current exchange price for that order.
*The offset is the amount that will be subtraced from the best bid (for a buy order) and added to the best
ask (for a sell order) to create the limit price at which the order will be submitted.
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To enter a Passive Relative order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL order.
2. Click in the Type field and select PASSV REL as the order type.
3. Enter the offset amount in the Offset Price field, or set a percent using the Pct. Offset field. If both
fields have values the higher of the two will be used as the offset. To display the Pct. Offset field, hold
your mouse over the Offset Price field until the “+” and “x” icons appear, and click the “+” icon. From
the Prices category select Pct Offset.

For a more detailed description of Passive Relative orders, visit the Order Types information page.

Pegged-to-Market
Submit an aggressive order that is pegged to buy on the best offer and sell on the best bid.
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To create a Pegged-to-Market order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Dest. field ensure that the destination is Island.
3. In the Type drop-down select PEG MKT.
4. If desired, modify the offset amount in the Aux. Price field.
5. To transmit, click the "T" in the Status field.

Available for stock orders direct routed to Island.
For a more detailed description of pegged-to-market orders, visit the Order Types information page.

Pegged to Midpoint
Pegged to Midpoint orders seek to execute at the midpoint of the National Best Bid and Offer (NBBO). The
order price adjusts automatically to peg the midpoint if the market moves. If the market moves in the
opposite direction, the order will execute.
The limit price acts as a price cap to prevent your order from being executed above or below a specified
level.
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To create a pegged to midpoint order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL order.
2. In the Dest. field ensure that the destination is Island.
3. Click in the Type field and select PEG MID as the order type.
This order type is only available for US Equity orders direct-routed to Island.
For a more detailed description of pegged to midpoint orders, visit the Order Types information page.

Pegged to Stock
Sometimes referred to as Relative to Stock, a pegged to stock order specifies that the option price will
adjust automatically relative to the stock price, using a calculated value based on data you enter.
Note: A Pegged to Stock order direct-routed to BOX puts you in BOX's Price Improvement
auction.
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To create a Pegged to Stock order
1. Click the Ask price to create a BUY options order, or the Bid price to create a SELL options order.
2. Select PEG STK in the Type field. Ensure that the supporting Pegged order fields are visible.If you
don't see PEG STK in the Type list, check to be sure that your option is routed to SMART (or an
exchange that supports this order type). This order type is only valid for US Equity options.
3. In the Delta field, enter an absolute value which will be used as a percent, eg. "5" equals 5%.
This percent value is signed positive for calls and negative for puts. This value is multiplied by the
change in the underlying stock price, and the product is added to the starting price to determine the
option price.
4. The Stock Reference Price used is the midpoint of the NBBO at the time of the order. You can
change this value if desired.
5. Define an optional high/low stock range if desired. If the stock price moves outside of the range, your
order will be canceled. Use the Underlying Range (High) and Underlying Range (Low) fields.
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6. The Starting Price for the option order is the midpoint of the option NBBO at the time of the order.
You can change this value if desired.
When you create a pegged to stock order using the Order Ticket, use the Basic tab to select the order type
and set the Starting price. Use the Pegged tab to set the Stock Ref. price, the high and low underlying
range limits, and the Delta value.
For more details and an example of a pegged-to-stock order, visit the Order Types information page.

Pegged to Benchmark
Similar to a Pegged to Stock order, a Pegged to Benchmark order specifies that the order price will adjust
automatically relative to changes in the price of a user-specified reference asset. To determine whether the
reference asset price has changed, the system monitors changes to the Last price for indexes, and
changes to the Bid (for buy orders) and to the Ask (for sell orders).

To create a Pegged to Benchmark order
From the Quote Monitor, click the Bid for SELL order, click the Ask for a BUY order.
From the Type field in an order line select PEG BENCH.
Within the inline algo parameters you can define the following fields:
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With a starting price of: Enter the price for the current order. By default the starting price for a Buy
order = bid (at the time the order is created), for a Sell order = ask (at the time the order is created).
Decrease price by/Increase price by: Specify an offset by which the price will increase/decrease in
response to the same-direction movement in the price of the reference contract.
For every price decrease (or increase) of: Enter the reference contract price-change increment
that will drive the increase/decrease of the order price.
in reference contract: Enter the underlying symbol for the reference contract.
Starting reference price is: You must enter a starting price for the reference contract. The reference
price is the current bid (for a buy order) and the current ask (for a sell order).
Order will be active only while reference price is between: If desired, set a defining "valid" price
range for the reference contract. If the price moves outside the defined range, the order will be canceled.
Click Transmit to send the order.
For an example of using an All or None order, visit the Order Types information page.

Price Improvement Auction
For options routed through BOX, you may elect to participate in the Price Improvement Auction to better
your price.
To submit a Price Improvement Auction order
1. Create an options order routed to BOX.
2. In the Type field, select either LMT, REL, or PEG STK.
For Limit orders, enter the limit price in the Lmt. Price field in penny increments.
For Relative orders, set a relative offset amount (in penny increments) in the Aux. Price field.
For PEG STK orders, you enter the starting price in the Aux. Price field, the delta in the
Delta field, the optional stock reference price in the Stock Ref. Price field, the low side of the
optional stock range in the Underlying Range (Low) field, the high side of the optional stock
range in the Underlying Range (High) field. Use the Order Ticket, or display these fields from the
Order Columns tab in page layout.
3. Transmit the order by clicking the "T" in the Status field.
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For a more detailed description of box auction orders, visit the Order Types information page.

Relative/Pegged-to-Primary
The relative order provides a means for traders to seek a more aggressive price than the National Best Bid
and Offer (NBBO). By becoming liquidity providers, and placing bids or offers into the book that are more
aggressive than what is currently quoted, traders increase their odds of execution. Quotes are
automatically adjusted when other market participants become more aggressive. For a buy order, your bid
is pegged to the NBB by a more aggressive offset amount*, and if the NBB moves up, your bid will also
move up. For sales, your offer is pegged to the NBO by a more aggressive offset, and if the NBO moves
down, your offer will also move down. In addition to the offset, you can define an absolute cap, which works
like a limit price, and will prevent your order from being executed above or below a specified level.
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For relative orders with a "0" offset, the order is submitted as a limit order at the best bid/ask, and will move
up and down with the market to continue to match the inside quote.
Note: If you have tooltips enabled, you can hold your mouse over the Limit price of the relative
order and see the current exchange price for that order.

To enter a Relative order
1. Click in the Ask Price field to initiate a BUY order, or the Bid Price field to initiate a SELL order.
2. Click in the Type field and select REL as the order type.
3. Enter the offset amount in the Aux. Price field, or set a percent using the Pct. Offset field. If both
fields have values the higher of the two will be used as the offset. To display the Pct. Offset field:
Hold your cursor over a field in the order row fields until the green “+” sign appears. Click
the “+” sign to show the list of order fields.
In the Price category, select Pct Offset. The field is added to the left of the selected field.
Note: If you submit a relative order with a percentage offset, you are instructing us to calculate an
order price that is consistent with the offset, but that also complies with applicable tick increments.
Therefore we will calculate the order price rounded to the appropriate tick increment (e.g., pennies
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for a U.S. stock trading at a price over $1.00). Buy orders will be rounded down to the nearest
acceptable tick increment and sell orders will be rounded up.

You can modify the offset amount for several relative orders on the same trading page at one time. To do
this, select multiple relative orders by holding the Ctrl key and clicking on each order. After you have
selected all relative orders, right-click on one of the selected orders and select Modify. In the Relative
Order Modification box, define an offset or percent offset amount and click OK. All selected orders will be
changed.
Please note that you can change the name of the Relative order to Pegged-to-Primary using the Settings
page of the Display group in Global Configuration.
For a more detailed description of relative orders visit the Order Types information page.
*The offset is the amount that will be added to the best bid (for a buy order) and subtracted from the best
ask (for a sell order) to create the limit price at which the relative order will be submitted.

Relative + Market
The REL + MKT order type is available for certain multi-leg combinations, and when used with a nonguaranteed combination order it could help to increase the chances of all legs in the order being filled.
Although the order type uses the term "Relative," this refers to the behaviour of the limit order initially
submitted, which is pegged to the bid for a buy and to the ask for a sell similiar to a Relative order, in an
attempt to add rather than remove liquidity. Initially one or more legs are submitted as limit orders, but if the
first leg fills or partially fills, the remaining legs are resubmitted as market orders.
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To create a combination Relative + Market order
1. Create a Combination Order line on the Quote Monitor.
2. Click the Bid or Ask to create a Sell or Buy order line.
3. From the Type dropdown, select REL + MKT.
When you select REL + MKT, the limit price field becomes inactive and the Trigger Price field requires the
combo price input.

Retail Price Improvement Orders (RPI)
This order is similar to a Relative order, but requires an offset greater than zero (which may be submitted in
sub-pennies). RPI orders are routed to a separate book at the NYSE to trade against qualified orders.
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To submit an RPI order
Click the Ask price to create a Buy order or the Bid price to create a Sell order.
From the Type field, select RPI.
If you don't see RPI in the order type list, ensure that your Destination is set to SMART and that the stock is
listed on either the NYSE or NASDAQ.
Specify an offset greater than zero.
Transmit the order.
For more information, see the Order Types page on the website.

Snap to Market
The Snap to Market (SNAP MKT) order is similar to a pegged order, as the original order price is
determined by the current bid/ask plus or minus an offset. But unlike the pegged order price, the "snap to"
order price doesn't continue to peg as the price moves.
A Snap to Market BUY order snaps to the ask minus the offset, to set the order price. For a SELL order, it
snaps to the bid plus the offset.
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To create a Snap to Market order
Create a buy or sell order.
From the Type field select SNAP MKT.
Specify an offset amount that will be subtracted from the bid (for a buy order) to determine the limit price.
Transmit.
For a more detailed description of relative orders visit the Order Types information page.

Snap to Midpoint
The Snap to Midpoint (SNAP MID) order is similar to a pegged order, as the original order price is
determined by the current bid/ask plus or minus an offset. But unlike the pegged order price, the "snap to"
order price doesn't continue to peg as the price moves.
A Snap to Midpoint BUY order snaps to the midpoint of the bid/ask minus the offset to set the order price.
For a SELL order, it snaps to the midpoint of the bid/ask plus the offset.
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To create a Snap to Midpoint Order
Create a buy or sell order.
From the Type field select SNAP MID.
Specify an offset amount that will be subtracted from the midpoint of the bid/ask to determine the limit price.
Transmit.
For a more detailed description of relative orders visit the Order Types information page.

Snap to Primary
The Snap to Primary (SNAP PRIM) order is similar to a pegged order, as the original order price is
determined by the current bid/ask plus or minus an offset. But unlike the pegged order price, the "snap to"
order price doesn't continue to peg as the price moves.
A Snap to Primary BUY order snaps to the bid plus the offset to set the order price. A SELL order snaps to
the ask minus the offset.
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To create a Snap to Primary Order
Create a buy or sell order.
From the Type field select SNAP PRIM.
Specify an offset amount that will be added to the bid (for a buy order) to determine the limit price.
Transmit.
For a more detailed description of relative orders visit the Order Types information page.

Stop Order with Protection
A Stop with Protection order is similar to a stop limit order. The order is submitted with a Stop Price. When
the contract trades at the stop price the order triggers, and is submitted as a limit order at the exchangedefined "protection" limit price.
To create a stop with protection order
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1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select STP PRT as the order type.
3. Define the Stop Price.
4. Transmit by clicking the "Transmit" button.
For a more detailed description of stop orders with protection, visit the Order Types information page.

T + 1 Stock Settlement
Clients who write covered calls can elect to purchase shares that settle in T+1 to satisfy their delivery
obligations, instead of using existing shares and potentially incurring a higher tax liability.
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To specify T+1 for a US stock order, from the Destination field select TPLUS1 as the routing destination.

Trailing Stop
A trailing stop sell order sets the initial stop price at a fixed amount below the market price as defined by the
Trailing Amount. As the market price rises, the sell stop price rises one-to-one with the market but always
at the interval set initially by the trailing amount. If the stock price falls, the stop price remains the same.
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When the stop price is hit, a market order is submitted. Reverse this for a buy trailing stop order. This
strategy may allow an investor to limit the maximum possible loss without limiting possible gain.

To create a trailing stop order
1. Click in the Ask Price to initiate a BUY order, or the Bid Price to initiate a SELL order.
2. Click in the Type field and select TRAIL from the dropdown list of order types.
3. Enter a value in the Trailing Amt field. This amount is used to calculate the initial Stop Price, and
the amount by which you want the limit price to continue to trail the stop price. To change the absolute value to a percent of the best bid/ask, click in the field to initiate a dropdown arrow, and then
choose Amt or %.
Stop Price - This field is optional. By default, the initial Stop Price is calculated as: market price - trailing amount. You can modify the stop price, but if it is lower than the calculated
value, it will be discarded when the order is submitted. Note that the value you enter may display in the Stop Price field even if it is not used.
Limit Price - this value defaults to the current best bid/ask. The limit price will move with the
trailing stop price based on the delta between the two prices (initial stop price - initial limit
price = limit delta). If the limit price and stop price are equivalent, they will move together
with a zero delta.
4. To transmit the order, click the "T" in the Status field.
For a more detailed description of Trailing Stop orders visit the Order Types information page.
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Trailing Stop Limit
A trailing stop limit order lets you create a trailing stop order that works in conjunction with a dynamicallyupdating limit order. When the stop order triggers, a limit order is submitted at the last calculated price
(instead of a market order which would be submitted with a regular trailing stop order).
The Trailing Stop Limit order uses four components: Stop price, Trail amount, Limit price, and Limit Offset.

To enter a trailing stop limit SELL order
1. Click in the Bid Price to initiate a SELL order.
2. Click in the Type field and select TRAIL LIMIT.
3. Display the Stop Price and Lmt Offset fields (Hold your mouse over any field title until the "+" and
"x" Insert and Remove icons appear. Click the "+ " to display the list of available fields. Note that if
you hover your mouse over an order field, all available order fields are displayed. If you hover over a
market data field, all available market date fields are displayed. ).
4. Enter values in the following fields:
a. Trailing Amount (Aux Price) (Trailing Amt) - This amount is used to calculate the initial
Stop Price, and the amount by which you want the limit price to continue to trail the stop
price. Use the dropdown to choose Amt or %. The trailing percent is calculated off the current best bid/ask. Note that you can define a default Trailing Amount in the Order
Defaults Default Order Offset Amounts area.
b. Stop Price - You must enter an initial stop price. Unlike a trailing stop order, the initial
stop price is not automatically calculated by TWS when you transmit the order, since the
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stop price is needed to calculate the limit price or limit offset. The stop price is continually
recalculated when the market price rises. If the initial stop price is higher than the (market
price - trail amount) it will not be modified.
c. Limit Price OR Limit Offset - The limit order piece of the trailing stop limit is submitted
once the stop price is penetrated. While the market price and stop price continue to fall,
the limit price is also recalculated using the limit offset, and moves with the stop price.
If you enter a limit offset, the limit price is calculated using (stop price - limit offset).
If you enter a limit price, the limit offset is calculated using (stop price - limit price)
when the order is submitted.
If the limit price and stop price are equivalent, they will move together with no offset.
5. To transmit the order, click "T" Status field.
For a more detailed description and example of Trailing Stop Limit orders, visit the Order Types information
page.

Trailing Market if Touched
A trailing market if touched is similar to a trailing stop order, except that the sell order sets the initial stop
price at a fixed amount above the market price instead of below. As the market price falls, the stop trigger
price falls by the user-defined trailing amount, but if the price rises, the stop price remains the same. When
the stop trigger is touched, a market order is submitted. Reverse this for a buy trailing market if touched
order.
To create a Trailing Market if Touched order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field select TRAIL MIT as the order type.
3. In the Aux. Price field, enter the trailing amount.
4. In the Stop Price field, enter the trigger price.
5. To transmit the order, click the "T" in the Status field.
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For a more detailed description of relative orders visit the Order Types information page.

Trailing Limit if Touched
A trailing limit if touched is similar to a trailing stop limit order, except that the sell order sets the initial stop
price at a fixed amount above the market price instead of below. As the market price falls, the stop trigger
price falls by the user-defined trailing amount, but if the price rises, the stop price remains the same. When
the stop trigger is touched, a limit order is submitted. Reverse this for a buy trailing limit if touched order.
To create a Trailing Limit if Touched order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. If not already visible, display the Stop Price and Lmt Offset fields (right-click in the column headers
and select Customize Layout, then use the Order Columns tab to add fields).
3. Enter values in the following fields:
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a. Aux Price (Trailing Amt) - This value is added to the bid price to continually recalculate
the stop price, if the market price drops. Use the dropdown to choose Amt or %. The trailing percent is calculated off the current best bid/ask. Note that you can define a default
Trailing Amount in the Order Defaults Default Order Offset Amounts area.
b. Stop Price - You must enter an initial stop price. Unlike a trailing market if touched
order, the initial stop price is not automatically calculated by TWS when you transmit the
order, since the stop price is needed to calculate the limit price or limit offset. The stop
price is continually recalculated when the market price falls. If the initial stop price is
higher than the (market price - trail amount) it will not be modified.
c. Limit Price OR Limit Offset - The limit order piece of the trailing stop limit is submitted
once the stop price is penetrated. While the market price and stop price continue to fall,
the limit price is also recalculated using the limit offset, and moves with the stop price.
If you enter a limit offset, the limit price is calculated using (stop price - limit offset).
If you enter a limit price, the limit offset is calculated using (stop price - limit price)
when the order is submitted.
If the limit price and stop price are equivalent, they will move together with no offset.
4. To transmit the order, click "T" Status field.

For a more detailed description of relative orders visit the Order Types information page.
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Trailing Limit + Market
The TRAIL LMT + MKT order type is available for certain multi-leg combinations. You define the trailing
amount, and when the order triggers it behaves the same as the Limit + Market order.

To create a combination Trailing Limit + Market order
1. Create a Combination Order line on the Quote Monitor.
2. Click the Bid or Ask to create a Sell or Buy order line.
3. From the Type dropdown, select TRAIL LMT + MKT.
4. Set or confirm the Trailing Amount and Trigger Price.
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When you select TRAIL LMT + MKT, the limit price field becomes inactive and the Trigger Price field
requires the combo price input.

Trailing Relative + Market
The TRAIL REL + MKT order type is available for certain multi-leg combinations. You define the trailing
amount, and when the order triggers it behaves the same as the Relative + Market order.

To create a combination Trailing Relative + Market order
1. Create a Combination Order line on the Quote Monitor.
2. Click the Bid or Ask to create a Sell or Buy order line.
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3. From the Type dropdown, select TRAIL REL + MKT.
4. Set or confirm the Trailing Amount and Trigger Price.
When you select TRAIL REL + MKT, the limit price field becomes inactive and the Trigger Price field
requires the combo price input.

Attached Orders
Use attached orders to hedge a parent order. The attached hedge orders are considered child orders of
the parent order, and are submitted one time when the parent order is submitted. These orders are not
continuously updated.
Attach a Beta Hedge Order

673

Attach a Delta Hedge Order

674

Attach an FX Order

676

Attach a Pair Trade

677

Auto Combo Limit Order

678

Auto Combo Market Order

679

Attach a Beta Hedge Order
Attach a Beta Hedge order to hedge a stock order with an ETF.
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To attach a beta hedge order
1. Create a buy or sell stock order.
2. Right-click in the order line, and select Attach, then select Beta Hedge.
3. Click the Attributes box in the Status field to show the hedge attributes on the inline editor.

4. Enter a hedging contract, generally an ETF. The system beta of the stock relative to the selected
ETF is calculated and displayed next to the hedging contract.
5. Hold your mouse over the Beta icon to see the calculated estimated quantity of the hedging contract.
6. If desired, adjust the beta by entering a new value in the User Beta field. The quantity of the child
hedge order is recalculated.
7. Click T to transmit the original order. The attached beta hedge is automatically transmitted.

Attach a Delta Hedge Order
Attach a delta hedge order to an options order, and as an alternative to setting a hedge order attribute in
the original Volatility order line.

TWS Guide

674

Chapter 1

Attach a Delta Hedge Order

To attach a Delta Hedge order
1. From the right-click menu, select Attach and then select Delta Hedge.
A new linked delta hedge order line displays. The link between the parent and child orders is
illustrated in the Key field.
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2. Select an order type for the hedging order (Limit, Market or Relative).
Please note that when you attach a delta hedge order to a Volatility order with Continuous Update or to a
Relative/Pegged-to-Stock order, the system will use the delta associated with the parent order instead of
using the current delta of the option based on market data at the time of trade. For Volatility orders, this
delta is calculated from the user-defined Implied Volatility specified at the time of the most recent order
modification or price update. For Relative/Pegged-to-Stock orders, this is the delta specified by the user.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the time the parent order fills,
and the best available price is used as the limit price (best ask for a buy and best bid for a sell).

Attach an FX Order
You can elect to attach an FX Order in cases where you are buying a contract in a currency other than your
base, and want to convert base currency to the currency of the contract to cover the cost of the trade.
To attach an FX Order
1. Create a buy order on a contract.
2. Right-click in the order line, and select Attach, then select FX Order.

3. Click the Attributes box in the Status field to show the hedge attributes on the inline editor. The appropriate currency pair is displayed.
Hold your mouse over the FX icon to see the calculated estimated quantity of the hedging contract.
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4. Transmit the parent order. The attached fx order will sell your base currency and buy a quantity of
the needed currency to cover the parent trade.

Attach a Pair Trade
The attached Pair Trade can be used to hedge one contract against another, generally in the same
industry. Offset a price discrepancy between the two contracts with a ratio.

To attach a Pair Trade
1. Create a buy or sell stock order.
2. Right-click in the order line, and select Attach, then select Pair Trade.
3. Click the Attributes box in the Status field to show the hedge attributes on the inline editor.
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4. Enter a contract to hedge the parent contract.

5. In the Hedging Ratio field, enter a value as a whole number or a decimal. This value is the first term
in the ratio.
Hold your mouse over the Pair icon to see the calculated estimated quantity of the hedging contract based
on the entered ratio. For example, if the parent order quantity is 500 and you enter a Hedge Ratio of 2, the
estimated quantity of the hedge order will 1000, i.e. a 2:1 ratio.

Auto Combo Limit Order
Attach an opposite-side limit order to a complex multi-leg combination order. The limit price is determined
using the Combo Order Preset values for the "Target Order." The attached order is a child order and will be
linked to the parent order automatically with the OCA (one-cancels-other) tag. This order will be autosubmitted when the parent order fills.
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To create an Auto Combo Limit order
From within the Classic TWS Interface, create a combination order and click the Ask to create a Buy order
or the Bid to create a Sell order.
Use the right-click menu from the order line to select Attach and then Auto Combo Limit.
The child order is created below the original parent order, and the "Key" field is displayed to show the OCA
relationship between the two orders.
If specified, the Limit price for the child order uses the "Target Order" limit price in the Combo Order Preset.
Otherwise, it will use the Bid for a sell order or the Ask for a buy order. The limit price can be modified on a
per-order basis.
Submit the parent order. When it fills, the auto combo limit order is automatically submitted.

Auto Combo Market Order
Attach an opposite-side market order to a complex multi-leg combination order. The attached order is a
child order and will be linked to the parent order automatically with the OCA (one-cancels-other) tag. This
order will be auto-submitted when the parent order fills.
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To create an Auto Combo Market order
From within the Classic TWS Interface, create a combination order and click the Ask to create a Buy order
or the Bid to create a Sell order.
Use the right-click menu from the order line to select Attach and then Auto Combo Market.
The child order is created below the original parent order, and the "Key" field is displayed to show the OCA
relationship between the two orders.
Submit the original order. When it fills, the auto combo market order is automatically submitted.

Order Attributes
All or None (AON)

681

Block

682

Discretionary

682

Hidden

684

One Cancels Other

685

One-Cancels-Other (OCO)

687
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All or None (AON)
Mark an order as "all or none" to specify that the order not execute unless the entire order quantity is
available and it can be filled in its entirety. This attribute can be applied to all order types.
To mark an order as All or None
1. Display the All or None field on your trading window:
a. Hold your cursor over a field in the order row fields until the green “+” sign appears. Click the
“+” sign to show the list of order fields.
b. In the Order Attributes category, select All or None. The field is added to the left of the selected field.
c. Highlight All or None and click the Add button.
2. Create an order (click the Ask Price to create a BUY order, or the Bid Price to create a Sell order).
3. Check the All or None checkbox to tag the order.

Note: You can also apply order attributes from the Miscellaneous tab on the Order Ticket.
For an example of using an All or None order, visit the Order Types information page.
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Block
A block order is a high volume order that consists of a minimum of 50 contracts at a specific limit price.
To submit a block order
1. Click the bid or ask price field on the option for which you want to submit a block order.
2. Check the Block Order attribute. To display the attribute:
Hold you mouse over the Type field label until the green “+” sign appears.
Click the “+” sign to display the field pick list, and from the Order Attributes section select Block
Order.
3. In the Exchange field, select ISE.
4. In the Price field enter a limit price.
5. Click Transmit to send the order.
For more information, visit the Order Types information page.

Discretionary
A Discretionary Order attribute can be applied to any smart-routed order that uses a limit price. The defined
discretionary amount is added to (for a buy) or subtracted from (for a sell) the limit price, and increases the
price range over which the order is eligible to execute. Only the original limit price is displayed to the
market.
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To create a Discretionary order
From Mosaic:

Create the Buy or Sell order in the Order Entry panel.
Expand the "Advanced +" panel to display the Discretionary Amt button.
Click to make the field editable and enter the discretionary amount. To use 2 cents, enter .02.
Submit the order.
From Classic TWS:

1. Display the Discretionary field on an order management line:
Hold your cursor over a field in the order row fields until the green “+” sign appears. Click
the “+” sign to show the list of order fields.
In the Prices category, select Discretionary Amt. The field is added to the left of the selected field.
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2. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
3. Enter a discretionary amount in the Discretionary Amt field of the order line.
4. To transmit the order, click the "T" in the Status field.
For US options, you can elect to have the discretionary amount automatically set by TWS (when you
specify a limit price somewhere between two price levels) by checking Submit orders for nickel/dime priced
options with price between price levels as Discretionary. For details on how the discretionary amount is
determined in these cases, see the Discretionary Order Handling page.
For more information on discretionary orders, visit theOrder Typesinformation page.

Hidden
A Hidden order (generally a large volume order) shows no evidence of its existence in either the market
data or the deep book.
To create a Hidden order
1. Display the Hidden field on an order management line:
Hold your cursor over a field in the order row fields until the green “+” sign appears. Click
the “+” sign to show the list of order fields.
In the Order Attributes category, select Hidden. The field is added to the left of the selected
field.
2. On the trading screen, create an order (click in the Ask Price to create a BUY order, or the
Bid Price to create a Sell order).
3. Check the Hidden field.
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4. To transmit the order, click the "T" in the Status field.
For a more detailed description of hidden orders, visit the Order Types information page.

One Cancels Other
Attach dependent orders to a parent order and specify the order action when one group members fills.
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Click "One Cancels Other" to expand the panel.
Change the order side if necessary. By default, the order side is the same as that of the original order.
Click "Contract" and enter the underlying.
Specify the order type, quantity, price and time in force.
To add more orders to the group, click +Add Order and follow steps 2 - 4 above.
If an order completely fills, other orders in the group are canceled. The On Fill: box instructs TWS what to
do if an order in the group is partially filled. Use the drop down selector to choose the action:
a. Reduce other orders: Reduces the quantity of other orders in the group by the partially
filled quantity of the order. Please note that using this option without overfill protection
will likely result in multiple orders being routed to an exchange, which may in turn result in
an overfill, or in a rejection (e.g. in the case of multiple sell orders where one is tagged as
"short sale").
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b. Reduce other orders, overfill protection: Designed to reduce quantity of other
orders in the group by the partially-filled quantity of the order, and specifies that only one
order at a time will be submitted to an exchange to avoid multiple orders filling (overfill).
c. Cancel other orders: All orders in the group will be canceled. When selected, "overfill
protection" is automatically enabled to prevent an overfill.

One-Cancels-Other (OCO)
For Mosaic orders, see One Cancels Other.
A One-Cancels-Other (OCO) order is a combination of separate orders that are worked in conjunction with
one another in the marketplace. A customer enters orders as part of an OCO group, and when an order is
executed, the remaining orders in the group are canceled. If an order is partially executed, the remaining
orders in the group are reduced proportionately to the amount that was executed. If an order is canceled
before execution, the remaining orders in the group are canceled.
To create an OCO order
1. Display the OCO Group order field: Hold your mouse over any field title until the "+" and "x" Insert
and Remove icons appear. Click the "+ " to display the list of available fields. Note that if you hover
your mouse over an order field, all available order fields are displayed. If you hover over a market
data field, all available market date fields are displayed.
2. On the trading screen, create an order (click in the Ask Price to create a BUY order, or the
Bid Price to create a Sell order).
3. Identify the order as part of an OCO group by entering a group name in the OCO Group field (you
can use any descriptive name that you want).
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4. Continue to create orders, and identify each as part of the group by entering the same name in the
OCA Group field for each order you create.
5. After you have created all orders for a group, transmit the OCA order by clicking Transmit All Orders
on Page on the Trade> Transmit menu.
Note: Because the OCA procedure is an automated process, there is no guarantee that requested
cancellations and modifications will reach the specific exchange before an order has been
executed. To specify more OCO order parameters, open the Miscellaneous tab of the Order
Ticket.
For a more detailed description of OCA orders visit the Order Types information page.

Sweep-to-Fill
A sweep-to-fill order identifies the best price and the exact quantity offered/available at the price, and
transmits the corresponding portion of your order for immediate execution. It simultaneously identifies the
next best price and quantity offered/available and submits the matching quantity of your order for
immediate execution.
To create a sweep-to-fill order
1. Display the Sweeps to Fill field for an order management line: Hold your mouse over any field title
until the "+" and "x" Insert and Remove icons appear. Click the "+ " to display the list of available
fields. Note that if you hover your mouse over an order field, all available order fields are displayed. If
you hover over a market data field, all available market date fields are displayed.
2. On the trading screen, click the Ask Price to create a BUY order, or the Bid Price to create a Sell
order.
3. Check the Sweep to Fill field.
4. To transmit the order, click the "T" in the Status field.
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For a more detailed description of sweep-to-fill orders, visit the Order Types information page.

Volatility Orders
Create orders that trade using volatility.
Pegged-to-Primary Volatility Order

689

Pegged to Market Volatility Order

691

Pegged to Midpoint Volatility Order

692

Pegged to Surface Volatility Order

693

Volatility Trading

695

Pegged-to-Primary Volatility Order
The Pegged to Primary volatility order for options pegs or matches the starting price of the order to the
same side volatility, for example a buy order (for both puts and calls) will peg to the volatility bid and a sell
order (for both puts and calls) will peg to the volatility ask.
This order allows a positive offset or no offset to the volatility.
To see bid/ask volatility instead of prices, open the VolatilityTrader from the Trading Tools menu.
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To create a Pegged-to-Primary Volatility Order
From the ticker line for an option, click the bid volatility to create a sell order, or the ask volatility for a buy
order.
From the Type field select PEGPRIMVOL.
Define the offset amount. Positive or no offset only. The offset makes the order more aggressive. For a buy
order the offset is added to the bid. For a sell order the offset is subtracted from the ask.
Specify other order parameters as needed, including Continuous Update, Reference Price etc.
Click Transmit to submit the order.
For a more detailed description of Pegged to Primary Volatility orders, visit the Order Types information
page.
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Pegged to Market Volatility Order
The Pegged to Market volatility order for options pegs or matches the starting price of the order to the
opposite side volatility. For example a buy order (for both puts and calls) will peg to the volatility ask and a
sell order (for both puts and calls) will peg to the volatility bid.
This order requires a positive offset to the volatility.
To see bid/ask volatility instead of prices, open the VolatilityTrader from the Trading Tools menu.

To create a Pegged to Market Volatility Order
From the ticker line for an option, click the bid volatility to create a sell order, or the ask volatility for a buy
order.
From the Type field select PEGMKTVOL.
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Define a positive offset amount. The offset makes the order less aggressive. For a buy order the offset is
subtracted from the bid. For a sell order the offset is added to the bid.
Specify other order parameters as needed, including Continuous Update, Reference Price etc.
Click Transmit to submit the order.
For a more detailed description of Pegged to Market Volatility orders, visit the Order Types information
page.

Pegged to Midpoint Volatility Order
The Pegged to Midpoint volatility order for options pegs or matches the starting price of the order to the
midpoint of the bid/ask volatility, specifically the bid volatility + ask volatility/2.
This order allows a positive offset, negative offset or no offset to the volatility.
To see bid/ask volatility instead of prices, open the VolatilityTrader from the Trading Tools menu.
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To create a Pegged to Midpoint Volatility Order
From the ticker line for an option, click the bid volatility to create a sell order, or the ask volatility for a buy
order.
From the Type field select PEGMIDVOL.
Define the offset amount. Positive, negative or no offset all allowed. A positive offset makes the order less
aggressive. For a buy order the offset is subtracted from the midpoint. For a sell order the offset is added to
the midpoint. A negative offset makes the order more aggressive. For a buy order the offset is added to the
midpoint. For a sell order the offset is subtracted from the midpoint.
Specify other order parameters as needed, including Continuous Update, Reference Price etc.
Click Transmit to submit the order.
For a more detailed description of Pegged to Midpoint Volatility orders, visit the Order Types information
page.

Pegged to Surface Volatility Order
The Pegged to Surface volatility order for options pegs or matches the starting price of the order to the
implied volatility calculated by the Model Navigator, shown in the Model field below. Buy orders (for both
puts and calls) will peg to the volatility bid and sell orders (for both puts and calls) to the volatility ask.
This order allows a positive, negative or no offset to the volatility.
To see bid/ask volatility instead of prices, open the VolatilityTrader from the Trading Tools menu.
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To create a Pegged to Surface Volatility Order
From the ticker line for an option, click the bid volatility to create a sell order, or the ask volatility for a buy
order.
From the Type field select PEGSURFVOL.
Define the positive or negative offset amount if desired. A positive offset makes the order less aggressive.
For a buy order a positive offset is subtracted from the bid, and for a sell a positive offset is added to the
ask. A negative offset makes the order more aggressive. For a buy order the negative offset is added to the
bid and for a sell the negative offset is subtracted from the ask.
Specify other order parameters as needed, including Continuous Update, Reference Price etc.
Click Transmit to submit the order.
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For a more detailed description of Pegged to Surface Volatility orders, visit the Order Types information
page.

Volatility Trading
The VOL order type allows you to trade volatility, and provides ways to dynamically manage your options
orders.

To trade Volatility
1. From the Trading Tools menu, select Volatility Trader. The fields used to define and dynamically
manage volatility orders are on the new page.
2. Create market data lines. Note that Bid and Ask price fields display in volatility rather than as a dollar
amount. Market data for stock tickers will still display the bid and ask price.
3. Select Annual or Daily volatility using the Volatility Type dropdown list.
4. Create an order by clicking the Ask volatility for a Buy order, or the Bid volatility for a Sell order. The
order type defaults to VOL.
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Note: You can use the VOL order type for equity options, index options and combination
orders. Hold your cursor over the option's volatility to see the option price, based on that
volatility.
Please note the following requirements for transmitting a VOL combination order:
Combo VOL orders must be Smart-routed.
All legs must be on the same underlying, and each leg must independently be eligible to use the
VOL order type. For example, a BuyWrite order could not be sent as a VOL order since its stock
leg would not allow this order type.
All VOL orders must be DAY orders.
You can elect to price a Smart-routed Index Option order using reverse futures premium
calculations by selecting a futures contract from the Reference Contract field.
If you have changed the reference contract in the Model Navigator, VolatilityTrader will used the
new contract as the default reference contract.
5. To have the workstation calculate a limit price for the option or combination order based on your
volatility input, enter a value in the Order Volatility field. The value shown in the Imp Vol field is calculated via the Model Navigator.
6. To transmit the order, click the "T" in the Transmit field, or the Transmit icon on the trading toolbar.

Field

Description

Volatility

If desired, enter a volatility to use in calculating a limit price for the option. If blank,
the calculation will use the volatility derived via Option Analytics.

Volatility

Select from Daily or Annual volatility.

Type
Hedge

Select an order type. The application will send an order against the executed

Order Type

option trade to maintain a delta neutral position. Use the Hedge Aux. Price field to
set a price for orders that require one. Note that for index options, you will need to
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select a futures contract for use in a hedge delta trade.
Alternately, you can use the right-click menu to attach a Delta Hedge order and set
the hedging attributes from the new order line.
Please note that if you select Continuous Update, the system will use the delta
associated with the parent order, which is calculated from the user-defined Implied
Volatility specified at the time of the most recent order modification or price update,
instead of using the current delta of the option based on market data at the time of
trade.
For a Limit delta hedge order, a snapshot of the stock bid/ask price is taken at the
time the parent order fills, and the best available price is used as the limit price
(best ask for a buy and best bid for a sell).
Hedge Aux.

Used in conjunction with the Hedge Order Type field. If you have selected an order

Price

type that requires you to define a price, for example a relative order, use this field to
set the price.

Continuous

Check this selection to continuously update the price of the order if the price of the

Update

underlying instrument changes significantly. Note that you can only check
Continuous Update for three active orders at a time.

Reference

Elect to use the NBB (bid) when buying a call or selling a put; the NBO (ask) when

Price Type

selling a call or buying a put; or the average of the best Bid and Ask. This price is
also used to compute the limit price sent to an exchange (whether or not
Continuous Update is selected), and for stock range price monitoring.

Stock Price

Undrl. Range (Low) - enter a low end acceptable stock price relative to the

Monitoring

selected option order. If the price of the underlying instrument falls BELOW the
lower stock range price, the option order will be cancelled. Merely touching the
price does not cancel the order.
Undrl. Range (High) - enter a high end acceptable stock price relative to the
selected option order. If the price of the underlying instrument rises ABOVE the
upper stock range price, the option order will be cancelled. Merely touching the
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watermark does not cancel the order.

Reference

Used for smart-routed Index Option volatility orders. This field allows you to select

Contract

the futures contract to use for calculating the implied volatility. To activate this
feature, use the Volatility and Analytics page in Global Configuration and
selectPrice index options relative to futures contract.

For a more detailed description of Trailing Stop orders visit the Order Types information page.

Times in Force
Specify a time in force to determine how long your order will continue to work in the market.
Times in Force for Orders

699

Regular Trading Hours

701

Good After Time

702

Fill or Kill

703

Auction

704

Market-on-Open

705

Limit-On-Open

706
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Times in Force for Orders
The time in force for an order defines the length of time over which an order will continue working before it
is canceled. We support many times in force which are described below.
Note: The selections available for any order are valid based on the combined order type,
exchange and product. Not all Times in Force are available for all orders.

DAY - Using "Day" as the time in force for a Regular Trading Hours ("RTH") Only order specifies that
the order will work throughout the trading day during regular trading hours until it is filled, is canceled by
the user, or expires at the end of the trading day. (By default, the time in force for orders is set to "Day."
Orders for some products are entered with a default restriction of Regular Trading Hours (RTH) Only
to prevent orders from being executed during the pre- and post-market sessions).

A day order that is submitted after regular trading hours* with the order attribute of RTH will be held in
the system and begin to work at the start of the next trading day. The order will be active during the next
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trading day until it is filled, is canceled by the user, or expires at the end of the trading day.
IMPORTANT NOTE: You can add order attributes to any order or change default settings to
specify that orders be activated, triggered, or filled outside of regular trading hours.
You can add order attributes to any order or change default settings to specify that orders be activated,
triggered, or filled outside of regular trading hours.
* For TWS: Day orders submitted with “RTH ONLY” will be canceled between 4:00-4:05 pm. Day orders
submitted after 4:05 pm with “RTH ONLY” will be queued for the next day.
For FIX connections: Day orders submitted with “RTH ONLY” will be canceled between 4:00 – 5:00 pm.
Day orders submitted after 5 pm with “RTH ONLY” will be queued for the next day. Contracts with short
close-to-open time, such as Forex and CME futures, have a shorter window.

GTC - A Good-Til-Canceled order will continue to work within the system and in the marketplace until
it executes or is canceled. GTC orders will be automatically be canceled under the following conditions:
If a corporate action on a security results in a stock split (forward or reverse), exchange for shares,
or distribution of shares.
If you do not log into your IB account for 90 days.
At the end of the calendar quarter following the current quarter. For example, an order placed during the third quarter of 2011 will be canceled at the end of the first quarter of 2012. If the last day is a
non-trading day, the cancellation will occur at the close of the final trading day of that quarter. For
example, if the last day of the quarter is Sunday, the orders will be canceled on the preceding Friday.
Orders that are modified will be assigned a new “Auto Expire” date consistent with the end of the
calendar quarter following the current quarter.
Orders submitted to IB that remain in force for more than one day will not be reduced for dividends.
To allow adjustment to your order price on ex-dividend date, consider using a Good-Til-Date/Time
(GTD) or Good-after-Time/Date (GAT) order type, or a combination of the two.
Note: For market centers that do not accept "native" GTC orders, the order type is simulated by
resubmitting the relevant order each business day upon opening of the market center.

OPG - Use OPG to send a market-on-open (MOO) or limit-on-open (LOO) order.
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IOC - Any portion of an Immediate-or-Cancel order that is not filled as soon as it becomes
available in the market is canceled.
GTD - A Good-Til-Date order will remain working within the system and in the marketplace until it
executes or until the close of the market on the date specified. When you select GTD as the time in
force, both an Exp. Date and Exp. Time field is displayed on the order management line. Enter the
date up until which you want the order to continue to work in the format YYYYMMDD. To set a
time, enter the time in the format HH:MM(:SS). If desired, enter a time zone using an accepted
three-letter acronym. Note that if you do not enter a specific time zone, the time zone to which your
computer is set will be used.
FOK - If the entire Fill-or-Kill order does not execute as soon as it becomes available, the entire
order is canceled.
DTC - A Day 'Til Canceled order is similar to a day order, but instead of being canceled and
removed from the trading screen at the end of the day, the order is deactivated. This means that
the order is canceled AT THE EXCHANGE but remains on your trading screen to be retransmitted whenever you click the Transmit button.
Fill/trigger outside RTH - When displayed, checking this option allows orders the flexibility to fill (and/or
trigger in the case of stop and other trigger orders) both during regular hours and outside of regular trading
hours.
Note: This option may not be available for particular products that are not listed on an exchange.
IB customers are solely responsible for ensuring that this parameter is available for the product
involved.

Regular Trading Hours
You can trade many exchange-listed products outside of regular trading hours. To allow trading outside
regular hours for all eligible products, ensure that the setting is enabled in all order presets.
To enable outside trading hours in Order Presets
1. Display the Presets column if it is not displayed: Hold your mouse over any field title until the "+" and
"x" Insert and Remove icons appear. Click the "+ " to display the list of available fields. Note that if
you hover your mouse over an order field, all available order fields are displayed. If you hover over a
market data field, all available market date fields are displayed.
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2. Click in the Presets field on a ticker line and select Configure at the bottom of the dropdown list. The
Preset for the current contract is displayed.
3. In the Settings area at the top of the Presets page, check Allow order to be activated, triggered or
filled outside of regular trading hours.
When the Preset is active for the contract, the order will be eligible to trade outside of regular trading hours
IF it is exchange-traded and eligible on the exchange.

Good After Time
A "good after time" order is held in the system and sent to the exchange on the date and time you enter.

To create a "good after time" order
1. Display the Start Time field on an order management line:
Hold your cursor over a field in the order row fields until the green “+” sign appears. Click
the “+” sign to show the list of order fields.
In the Time in Force category, select Start Time. The field is added to the left of the selected
field.
2. On the trading screen, create an order (click in the Ask Price to create a BUY order, or the
Bid Price to create a Sell order).
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3. In the Good After Time field, click the Calendar icon to open the date/time setter.
4. Choose a month, year and day from the Date area, and a time and time zone from the Time area.
Click OK.
Note that the time uses a 24-hour clock instead of "AM" and "PM."
5. Transmit the order. The order is held in the IB system until the time and date you set.
For a more detailed description of GAT orders and the products and exchanges supported, visit the Order
Types information page.

Fill or Kill
A time in force for options orders, specifying that the order must execute immediately and in its entirety, or
be canceled.
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To apply the FOK time in force to order
1. Create an options order (click the Ask Price to create a BUY order, or the Bid Price to create a Sell
order).
2. In the TIF field, select FOK.
If FOK is not displayed in the dropdown list, it is not applicable to the order your are creating.
3. Transmit the order by clicking the "T" in the status field.
For more information about Fill or Kill orders, visit the Order Types information page.

Auction
An auction order is submitted at the Calculated Opening Price (COP). If the order doesn't execute, it is
resubmitted as a limit order at the COP or best bid/ask.
To create an auction order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order. This action will
open the Order Ticket window.
2. Select an order type in the Type field.
3. In the Time in Force field, select AUC (auction).
4. Transmit the order by clicking "T" in the Status field.
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Available for limited products and exchanges, including futures on HKFE and stock on LSE, IBIS, and
VSE.
For a more detailed description of auction and other order types, visit the Order Types information page.

Market-on-Open
MOO (market-on-open) is a market order executed at the market's open at the market price.
To create a MOO order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field, select MKT as the order type.
3. In the TIF field, select OPG as the time in force.
4. To transmit the order, click the "T" in the Status field.

TWS Guide

705

Chapter 1

Limit-On-Open

For a more detailed description of MOO orders visit the Order Types information page.

Limit-On-Open
A LOO (limit-on-open) order is a limit order executed at the market's open if the opening price is equal to or
better than the limit price.
To create a LOO order
1. Click the Ask price to create a BUY order, or the Bid price to create a SELL order.
2. In the Type field, select LMT as the order type.
3. In the TIF field, select OPG as the time in force.
4. To transmit the order, click the "T" in the Status field.

TWS Guide

706

Chapter 1

Limit-On-Open

For a more detailed description of LOO orders, visit the Order Types information page.
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Add a Quote Monitor
There is no limit to the number of Quote Monitors you can create in TWS. You can enter as many lines of
market data as you want, but at any one time you will only be able to see 100 active market data lines at a
time. For details, see Notes about Market Data use. Use the Quote Monitors to sort your assets by
instrument type, exchange, or your own trading system categories. You can navigate through the tabbed
pages without the mouse by using the Ctrl key along with the Page Up and Page Down keys.
To detach a page, simply click the tab and drag the page away from the tabset.
To create a new page, click the “+” sign and select Quote Monitor
To delete a page, click the X.
To rename a page, right-click the page title and select Rename Page.
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You can also use a page-level feature called Quick Stock Entry, which will automatically complete a market
data line for a stock using the set of order destinations you set up.
To add a Portfolio Page
You can create a system-maintained Quote Monitor that includes a data line for each position in your
portfolio. Use the right-click menu from the “+” sign and select Portfolio Window. The portfolio page can
only be created once.
This creates a page with the same positions that are displayed in the Portfolio section of the Account
window. Each time you take a position, the Portfolio page is automatically updated to include market data
for the new position. When you zero out a position, the market data line remains on your Portfolio page.
You can remove zero position tickers from this and other pages using the right-click menu on a page and
selecting Clear Zero Position Rows.
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Edit a Quote Monitor
Modify the page name and other settings, add or remove market data and order fields, and insert a market
data line or a blank line in your Quote Monitor using the right-click menu or the Request Ticker dialog box.
See how to:
Edit a page name and other settings
Copy tickers to a new page
Edit a page layout
Insert a Market Data line between two existing lines
Move, drag, and drop a Market Data line up or down on a page
Delete a row
Delete multiple rows
Select contiguous rows
Select non-contiguous rows
Clear data from a row and leave an empty line
Add a blank row (above the selected row)
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To edit a page name and other settings
1. Right-click the page tab and select Rename Page.
2. Modify the page name or assigned layout and click OK.
Note: The Pending page is a system page that displays all of your working orders. You cannot
delete or rename the Pending page, but you can edit order parameters.
To copy tickers to a new page
1. On a populated Quote Monitor, click the first ticker row you want to copy.
2. Press and hold the shift key and click the last row you want to copy. This will select all rows including
the first and last highlighted ticker rows.
3. Use the right-click menu to select Copy.
4. In the tabset of pages, click the “+” tab to create a new page.
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5. Enter a page name and click OK.
6. Right-click in the top blank row of the new page and select Paste.
To edit a page layout
1. Right-click the page tab and select Layout.
2. Modify the desired characteristics and click OK.
Note: Before you modify the page layout be aware that you are not simply changing the look of the
active page, you are modifying an applied layout which may also be associated with other pages.
To insert a Market Data line between two existing lines
Note: When you add a line, it is inserted ABOVE the selected line.
1. Click in a market data line. The new line will be inserted ABOVE this line.
2. Right click and select Insert Row.
To move, drag, and drop a Market Data line up or down on a page
1. Select the market data line you want to move by clicking in the line.
2. Click and hold the mouse in the selected line.
3. Drag the selected line up or down on the page.
4. Release the mouse to drop the line in its new position.
To Delete Lines on a Quote Monitor
You can delete lines from your Quote Monitor using the right-click menu.
Note: The delete command does not distinguish between deleting blank lines and deleting market
data lines, and does not give you a warning before it deletes your data. Be certain you have only
selected the lines you want to delete. Selected lines appear highlighted in dark grey across the
Trading screen.
To delete a row
Right click in the line you want to delete and select Delete Row.
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To delete multiple rows
1. Select the line(s) you want to delete by clicking the lines.
2. Right click and select Delete Rows.
To select contiguous rows
Click in the first line you want to delete, hold down the Shift key, and click in the last line to select a
group of contiguous rows.
To select non-contiguous rows
Hold the Ctrl key and click each row.
To clear data from a row and leave an empty line
Right click in the line you want to delete and select Clear Row.
To add a blank row (above the selected row)
Right click in a line and select Insert Row.

Close All Positions
Use this feature to easily create orders to close all or a portion of one or multiple selected positions.
Electing to close all or some of a single position creates an order ready for transmission. Electing to close
multiple positions opens the Close Position dialog box where you set filters, define the order type and
more.
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Close some or all of a single position
Select a position from your Portfolio.
Use the right-click menu to select Trade and then a percentage of the position(s) to close. This creates an
order in the Order Entry panel (Mosaic) or in the Orders row (Classic).
Confirm order parameters and submit the order.
You can also select multiple orders and use the Close Position box to specify percentage of and types of
positions and other filters. Elect to close multiple positions using a Limit, Market or Relative order type, or
using an algorithmic order. NOTE: Algo orders are only supported for Limit and Market orders.
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Close some or all of multiple positions
Select multiple positions from your Portfolio.
Use the right-click menu to select Trade and then select a percentage to close. This opens the Close
Position dialog box.

TWS Guide

716

Chapter 1

Close All Positions

Use Close Position fields to define the order parameters:
Amount: Specify the percentage of each position you want to close.
Positions Filter: Select the asset type and whether to close long, short, or both long & short positions.
Order Type: Choose from Limit, Market or Relative order type. Based on the selected order type complete related parameters.
Destination: If desired, select an algorithm destination to close your positions with an algo order. This
feature is only valid for Limit and Market orders.
Complete parameters for selected algo order.
Click OK to create closing orders in the Orders panel (Mosaic) or Order line (Classic) for the selected
instruments.
Check order parameters then transmit individual orders.
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Consolidated Quote Button
The Consolidated Quote button is displayed when a US equity product is selected, and when clicked it
shows a consolidated market data view for the selected instrument.

In Mosaic, the button displays in the Order Entry panel when an eligible product is selected. When clicked,
attention is brought to the Quote Details tile if that is included in the layout; otherwise, a small consolidated
quote box appears and shows the last price, the change, the last size and exchange and more.
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In Classic view, selecting an eligible product displays the Consolidated button in the Ticker Action field.
When clicked, the consolidated quote box appears and shows the last price, the change, the last size and
exchange, and more.
Clients who choose to receive delayed data will see this button labeled "Snapshot." When the Snapshot
button is clicked, the current real-time price is displayed and the client is charged the per-snapshot rate.
Find out more about US Reg NMS Snapshot Market Data.

Add and Remove Fields
You can quickly add and remove fields from most windows by holding your mouse over the field name to
invoke the insert/remove column commands.

To add or remove columns from a window

TWS Guide

719

Chapter 1

Restore and Save Page Settings

1. Hold your mouse over a field to invoke the quick insert/remove commands.
2. Click the “+” icon to insert a column to the left of the selected column. Pick from the drop-down picklist that appears when you click "Insert Column."
3. Click the “x” icon to remove the selected column from the window. You can re-add it at any time.
You can choose not to see these icons by deselecting the feature "Quickly insert/remove columns from
column headers" from the Display>Settings page in Global Configuration.

Restore and Save Page Settings
To restore trading pages and tickers you had set up on a previous day, you can elect to restore the entire
settings file, which includes all trading pages and their tickers.
Note: Restoring a page file completely replaces all of your current trading pages with those from a
previous day.
To restore settings
1. On the File menu, select Open Settings File.
2. In the Open dialog box, click on the day's file you want to use to replace the current set of pages and
tickers.
To view the actual dates the files were saved, click the Details icon on the top right of the box.
1. Click Open. Your current trading pages and tickers are replaced with those in the file you selected.
Save Settings to the IB Server
When you are logging in you can check Store settings on server. This setting serves two purposes: it GETS
the saved settings from the IBserver when you log in, and it SAVES any session changes to the IBserver
when you log out.
If this feature is not checked, you will not have global access to your account settings from any internet
machine.
To save your settings on the IB server
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1. After you've logged in, from the Edit menu select Global Configuration.
2. On the Lock and Exit page, check Use/store settings on server.
To use global settings that have been saved on the IB server
In the Login box, check the Store settings on server box. This instructs TWS to go to the global server and
use any settings you saved previously.

Organize Data on a Page
You can sort a page of market data lines alphabetically by underlying ticker symbol. Once you have sorted
the lines, you cannot return to your original market data line order. Use drag-and-drop to rearrange the
order of your trading pages within the tabset.
To alphabetically sort page tabs
1. Open the page you want to sort by ticker.
2. Right-click in the heading area of the page tab and select Sort Tickers.
To move a Quote Monitor within the pages tabset
1. Click on a page tab to select the page.
2. Click and hold the mouse, and drag the page left or right within the tabset.
3. Release the mouse to drop the page in its new location.
Note: You cannot move the Pending page tab.

Create a Group Header
Use Group Header rows to separate instruments on the same page into custom-designed categories. Use
in a Watchlist or on a Quote Monitor in the Classic interface.
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To create a group header
Right-click in an empty row and select Create Group Header. If you need to create a row between lines of
data, use the Insert key on your keyboard, or right-click and select Insert Row.
Name your header row, for example US Stocks, and click OK.
The Group Header is more than just a title; it actually keeps the group together (including all assets that
come under it until the next Group Header, regardless of blank rows) if you auto-sort on the page by
column header. Additionally, if you drag the header to another trading page, all tickers under the header
will be dragged with it. And in the Classic Quote Monitor, several of the P&L columns, including the Market
Value, P&L, Realized P&L and Unrealized P&L columns will provide a total for all positions within the
group and display those values on the Group Header row.

Field Sorting
You can sort all fields by ascending and descending value (-15, -12, 10, 22) by clicking the field one or
multiple. Additionally you can also sort many of the TWS fields by ascending or descending absolute value
(10, -12, -15, 22 etc). You can change the sort type by clicking the field title multiple times to cycle through
sort types in order (no sort, descending order, ascending order, descending by absolute value, ascending
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by absolute value) or by using the right-click menu. Each sort type is identified by an icon; ascending and
descending use upward and downward pointing arrows respectively, and ascending and descending
absolute value use upward and downward pointing arrows with border lines, respectively.
Fields that currently support the new sort types include the following: (new fields may be added)
%Change (used in Top % Gainers scan)
%Change Since Open (used in Top % Gainers Since Open scan)
%Gap (used in Top Close-To-Open % Gainers scan)
ImpVol %Change (used in Top Option Imp Vol % Gainers scan)
ImpVol vs Hist (used in High Option Imp Vol Over Historical scan)
Growth (used in High Growth Rate scan)
ROE (used in High Return On Equity scan)

Create the Portfolio Window
The Portfolio window is an automated trading page you can elect to create. It is based on the current
content of your portfolio.
To create a Portfolio window
From Classic TWS - Right-click the "+" icon along the end of the tabset and select Portfolio Window.
From Mosaic - In the Monitor section, click the "+" icon and select Portfolio.
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Click the Filter icon to filter by symbol or security type. The content will be filtered out as you type.
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Group By

Positions in the Portfolio page can be grouped by Security Type or Expiry using the right-click menu in the
Contract field. You can also click the Contract field multiple times to change the grouping mode. The cycle
allows you to group by:

Alphabetically (by contract name), ascending.
by Security Type, ascending
by Expiry, ascending
by Expiry, descending
by Expiry and Option Right, ascending
by Expiry and Option Right, descending
Additionally, when the portfolio is sorted and you hold your mouse over the Position or Market Value fields,
the summary data totals for the sorted section displays the total position, total market value, and total cost
basis.
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The right-click menu offers additional features. Use the right-click from the P&L column to color-code these
columns, customize the calculation, round values and more.

`
For information on configuring this page, see the Portfolio Window configuration topic.

View Margin Requirements for a Position
You can view the margin requirements on a specific position from the right-click Contract Info menu.
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To view the margin impact on a position
From position, use the right-click menu to select Contract Info and then Show Margin Impact.

Use the Feature Search
The comprehensive Search returns a categorized list of application-related results with links that will open
a window, add a column or display a feature. Use the Search to add contracts to your trading page based
on search criteria.
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To use the Search field
1. In the top right corner of a main Quote Monitor, enter a word or phrase in the Search field and hit
Enter.
2. On the Search Results page, check Application to view all TWS-related occurrences of the search
topic, and check Contracts to see all contracts with the search topic in the title.
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Using the Search results
For application-related results, clicking a link will perform the search related action based on the results
category. For example, if you clicked OptionTrader from the Open Window category, TWSwould
open the OptionTrader window, or bring you to that window if it's already open.
For Add Contract results, clicking a link will open a ticker line on the last active trading page with the
search item as the contract in focus. From this point you can either add the contract, or click the Find
button to broaden your search by company name.

Use Quick Data
You can use market data shorthand to quickly request data for stock, options, futures and forex contracts.
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Use Quick Data for Stocks
In the Contract field use the format symbol pipe exchange, as in:
IBM|SMART or DELL|ISLAND.
Note: For NASDAQ listed contracts, use ISLAND as the destination.
Use Quick Data for Options and Futures
Enter shorthand in the Contract field using the format exchange symbol pound sign exchange as in:
MSQJC#SMART (option) or
MSFT1CU8#ONE (future)
Use Quick Data for Forex
Enter an fx pair using the syntax xxx.yyy, for example EUR.USD.

Import Tickers from a File
You can populate a trading page with market data that you import from a comma-delimited .csv file or .txt
file. Create the list using any word processing program and save the file with a .txt file extension, or in MS
Excel and save as a .csv file.
To create file of ticker symbols to import
1. Create a file with the extension .txt, for example twsTickers.txt, or create a .csv file in Excel.
2. In the text file, create one comma-delimited line for each line of market data you want using the syntax described below. In Excel, create one row, using one cell for each field. Note that the first field
designation is the line type: DES, SYM, and CON.
DES, UNDERLYING, SECTYPE, EXCHANGE, LASTTRADINGDAY, STRIKE, PUT/CALL,
MULTIPLIER
SYM, SYMBOL, EXCHANGE
CON, CONID, EXCHANGE
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The DES line type requires information or placeholders for information, with the strike, Put/Call and
multiplier fields being optional. Format for the Last Trading Day is YYYYMM, or YYYYMMDD. All entries
must be in caps. An example for an options contract XYZ would be:
DES, XYZ, OPT, ISE, 201509, 75, CALL,
A stock instrument for symbol XYZ in this line type would look like this:
DES, XYZ, STK, SMART,,,,
where the commas are placeholders for fields you don't define for stocks.
Using the SYM line type for a stock would look like this:
SYM, XYZ, SMART
Use the CON type to quickly enter contracts with a conid, for example
CON, 12348765, SMART
To import a file into Classic TWS
1. From the File menu, select Import/Export and then select Import Contracts.

2. Use the Browse button to find the file to import.
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3. Specify where you want imported tickers to go, either onto an existing page or onto a new page.
4. Click OK.
To import a file into a Mosaic Watchlist
Right click in the Watchlist, and select Import/Export then Import Contracts.

Use the Browse button to find the file to import.
Click OK.
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Imported contracts entered onto an existing page appear at the bottom of the active trading page or
Watchlist.

Transfer Login Authentication
Traders using TWS can pass off their login authentication to their mobileTWS device to allow them to trade
on mobileTWS without going through the login process.
mobileTWS for iPhone, iPad and Android supports Read-Only Access, which allows mobileTWS users to
view their IB account without logging in. Before trading access is granted the user will be required to
complete the full account login on their mobile device.
If you are working at your desktop TWS and need to leave the office, you can transfer your account
authentication over to mobileTWS, which saves you the effort of opening and logging into mobileTWS.
To transfer login authentication from TWS to mobileTWS
While logged into TWS, tap the mobileTWS icon on your mobile device.
In mobileTWS, at the message stating that another session exists, tap "OK."
In TWS, click Transfer Authentication to Mobile Device in the Mobile Login Handoff dialog.
To keep your TWS desktop session logged in, click Disconnect Mobile Device.
You can now trade via mobileTWS.

Enable Quick Stock Entry
Quick Stock Entry is a page-level feature which automatically completes a market data line for a stock
based on the underlying symbol you enter. When enabled, you simply enter the stock symbol, and TWS
completes the ticker line.
If you enable multiple exchanges, you will get a ticker line for all exchanges on which the symbol trades. For
example, I activate NYSE, SMART/NYSE, ISLAND, and TSE. When I enter the ticker "MMM" I get four
ticker lines, where MMM represents 3M on all but TSE, where it represents Minco Gold Corp.
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Before you can use the Quick Stock Entry feature, you must:
Enable a trading page for Quick Stock Entry
Create a list of quick stock order destinations

To enable Quick Stock Entry
When you enable Quick Stock Entry for a page, the system assumes that you want to enter ONLY stock
tickers on this page, and automatically completes a market data line with the appropriate order destination.
1. Open the page you want to enable for Quick Stock Entry.
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We recommend that you identify the page as being enabled for Quick Stock Entry by naming it
appropriately.
2. Right- click in the area of the page tab and select Settings.
3. In the Page Settings dialog box, select Quick Stock/Bond Entry.
4. Click the Quick Stock Entry Exchanges button to add recognized exchanges for quick stock entry
support.
To add Quick Stock Entry Exchanges
1. On the Edit menu, select Global Configuration.
2. In the left pane, select Quick Stock/Bond Entry Exchanges.
3. Click Add.
4. Enter a destination, for example ISLAND, and click OK.
5. Add as many order destinations as you would like to have available. You can add more destinations
at any time.
Note: To add SMART, you must also define the primary exchange, for example NYSE, or
ISLAND (for NASDAQ stocks).
You can also use the syntax symbol|exchange to enter a stock ticker.

Edit Dividend Schedule
Use the Dividend Editor to manually create your own dividend schedule. IB provides an automatic "best
guess" dividend payment schedule based on historical data for that asset.
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To open the dividend editor
1. Right-click the ticker whose dividend schedule you want to edit.
2. Select Dividend Schedule.

To manually create a dividend schedule
1. Use the Upcoming tab.
2. Check the Manual Edit checkbox. The existing information remains as a starting point, but you can
modify any fields, and add or remove dividends.
3. To insert or delete a line, click the Insert Dividend or Delete Dividend command.
4. Modify data on any line by clicking in a field and changing the value.
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The Dividend Amount is a cash value.
5. Click Save to apply your modified dividend schedule to the selected asset.
To paste dividends from a Word or Excel table
1. Create a five-column table in MS Word or MS Excel.
2. Enter data in the format of the existing table, with the Ex-Dividend Date in the first column and
Dividend Amount in the second column of your table.
3. Select and copy the table.
4. From the Upcoming tab of the dividend editor, check Manual Edit.
5. Click the Paste button. The data from your external dividends table will replace the current dividends
data.
6. Click Save to save your changes.
7. Click OK to save your data and exit the Dividends Editor.

Price and Size Wheels
You can quickly modify the price or size in an order row using the scroll-wheel on your mouse.
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To modify price or size using the scroll wheel
1. Click in the Quantity or Price field in an order row.
Scroll the wheel upward to increase the value.
Scroll the wheel downward to decrease the value.

The Price and Size Wands
The Price Wand and Size Wand help you to modify the order price and order quantity using just your
mouse. Wands become active when you click and hold the mouse in the Lmt Price or Quantity field on an
order line.
To use the price wand
1. Create a Limit order. The Lmt Price field populates with the best bid or ask price.
2. Click and hold your mouse in the Lmt Price field to invoke the price wand.
3. Select a new limit price and release the mouse.
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Note: The top of the wand ladder includes MARKET; the bottom is VWAP. These selections
change your order type to a MARKET or VWAP order to use the market or vwap price.

The prices in the wand ladder are created using the market price plus/minus the price increment.
To modify increments in a wand

TWS Guide

739

Chapter 1

Switch Exchange

1. On the Edit menu, select Global Configuration.
2. Expand the Order category in the left pane, and select General.
3. In the right panel, check Big scale prices or Big scale sizes to increase the price/size increment used
in the wand.
To allow penny increments for US Options in Price wand

1. On the Edit menu, select Global Configuration.
2. In the Configuration category in the left pane, select Display.
3. Check the option to Use penny increments in price wand for US options.

Switch Exchange
When you add a market data line to a Quote Monitor, you have the choice of directed exchange or SMART
for the ticker's market data. For positions that display on the system-drive Portfolio page, this choice is
made by TWS, and it may be the case that TWSuses an exchange to which you have no subscription. In
this case there may be no data showing for certain positions on the Portfolio page.
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The Switch Exchange button allows you to choose a subscribed exchange, enabling ticking data for the
position from the Portfolio window.

Check Risk Pre-Order
Before you transmit an order, use the Check Risk feature to get a quick idea of how transmitting the order
might affect your portfolio-relative P&L.

To check risk on an order
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From an order line, right-click and select Check Risk.
The Risk NavigatorSM Portfolio Relative P&L chart displays both the current and potential P&L for your
portfolio. You can also create and check risk on multiple orders.
To check risk on multiple orders
1. Hold down the Ctrl key and click on each non-submitted order you want to include in the Check Risk
P&L.
2. From the Trade menu, select Check Risk.
The Risk Navigator’s Portfolio Relative P&L displays two lines: the red solid line shows your current
portfolio relative P&L for all positions, and the blue dashed line shows the ‘what-if’ Portfolio Relative P&L
including the order(s) you are considering.
You can also elect to use the Date Scenario, which shows the current portfolio P&L and the ‘what-if’
portfolio P&L at the selected Last Trading Day.
If you check the risk on a potential order for a contract in which you hold no current position, the number of
‘what-if’ positions will increase. If you check the risk on an order for a contract in which you currently hold a
position, the ‘what-if’ position will not change, but the risk will increase or decrease the current position and
still be reflected in the blue dashed line.
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To view a complete What-If scenario in Risk Navigator comprised of all current positions plus whatever
trades you are considering, ensure that "With Portfolio" is selected, and then click the View Details button
in the top left corner.

Receive Delayed Market Data
Customers have the option to receive delayed market data for contracts to which they do not currently hold
market data subscriptions. You can elect to receive delayed data by clicking the Free Delayed Data button
from a non-subscribed ticker row.
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You can choose to trade with no data and not see the subscription and delay data buttons by turning off the
prompts in Global Configuration.
To hide market data buttons
1. From the Edit menu, select Global Configuration.
2. In the left pane of Global Config, select Display and then select Ticker Row.
3. Check Do not prompt for market data subscriptions. Note that you must restart TWS for this change
to take effect.
To re-enable market data buttons
1. From the Edit menu, select Global Configuration.
2. In the left pane of Global Config, select Display and then select Ticker Row.
3. Uncheck the “Do not prompt” box.
If you have subscribed to delayed data, but wish to remove it, click the Reset Subscription button.

Add Market Data using Class or Symbol
Add market data by entering the contract symbol or class as defined by the exchange on which it trades.
To add an options security definition directly to the trading screen
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1. Click in an empty row in the Contract column.
2. Enter the security definition by contract class or contract symbol, and press ENTER. Use the
formats in the table below.
Symbol Entry Formats

contract class

@

exchange acronym

contract symbol

#

exchange acronym

To add a security definition using Request Ticker form
1. In symbol mode, click the Add Ticker icon on the Trading toolbar.
2. In the Instrument Type field select Option.
3. Select the Symbol Type.
If you

Do this

select
Class

Enter the contract class symbol, exchange, expiration date and strike price,
and select the right.

Contract

Enter the exchange local symbol and the exchange.

Note: If you add a market data line for a derivative instrument, TWS will ask if you want the
underlying symbol added to the page. If you answer yes, it will be included at the bottom of the
page (unless the underlying is already on the page).

Trade Bonds
Trade Smart-routed US Corporate bonds, US Treasury bonds, notes and bills, and US Municipal bonds.
Trade US Corporate Bonds

746

Trade Treasuries

747
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Trade US Municipal Bonds

748

Trade US Corporate Bonds
Use the US Corporate Bonds scanner to find contracts to add to your trading page.

Add corporate bonds market data to your trading page
1. Enter an underlying symbol and hit enter, then select the Bond instrument from the selection list.
2. In the Contract Selection box, use the Maturity date, Issue Date and Coupon filter lists to narrow
your display choices.
3. Select the contract(s) from the right pane and click OK.
If you want to add multiple contracts with different maturities, click Add instead of OK. This will add the
selected contracts to your trading screen and then allow you to select a different maturity date and add
more contracts. Click OK to close the box.
Market data for the bond is displayed on the trading page. The following information is noted in the
Description field of the market data line:
Instrument type - For treasuries. Labeled as bond, note, or bill.
Coupon - the interest rate used to calculate the amount you will receive as interest payments over the
course of a year.
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Maturity date - the date on which the issuer must repay the face value of the bond.
CUSIP number - a nine-character ID for a specific security.
Bond rating - Identifies the credit rating of the issuer. A higher credit rating generally indicates a less
risky investment. The bond ratings are from Moody's and S&P, respectively.
To see contract details, double-click on a market data line.
Trade corporate bonds
1. Click the Ask to create a BUY order; click the Bid to create a SELL order.
2. Click “T” to transmit the order.
Note: Place a non-marketable limit order that meets or exceeds the best quote and your order will
be included in the market data shown to other IB customers.

Trade Treasuries
Once you have subscribed to bond market data via Account Management, you can enter data and trade tbonds, t-bills and t-notes.
To trade treasuries
1. Add market data for treasuries
1. Click the Treasuries icon on the Trading toolbar, or use the Edit menu and select Treasury Bond
Selector.

2. In the Contract Selection box, use the Type list in the left pane to choose Bills, Bonds or Notes.

3. Filter your contracts using the Maturity date, Issue Date and Coupon filter lists.

4. Select the contract(s) from the right pane and click OK.

If you want to add multiple types of treasuries to your screen, click Add instead of OK. This will add
the selected contracts to your trading screen and then allow you to select a different type and add
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more contracts. Click OK to close the box. to your trading page.
2. Click the Ask to create a BUY order, click the Bid to create a SELL order.

Trade US Municipal Bonds
US residents can trade municipal bonds in TWS
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Add muni bond market data to your trading page
1. In the Underlying field, enter the municipality name, for example Boston.
2. From the list of results, uncheck all asset types except munis.
3. Select the muni bond(s) from the remaining results and click OK.
4. The muni data is added to your trading window.
Note: Add the Company Name field to your page layout to see the municipality name. The
Underlying field only displays the CUSIP.
Trade muni bonds
1. Click the Ask to create a BUY order; click the Bid to create a SELL order.
2. Click “T” to transmit the order.
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3. In the Comparable Bonds screen, submit an RFQ, compare your bond to others that are comparable, and transmit your order.
Notes on Comparable Bonds

MSRB Rule G-18 requires each broker, dealer and municipal securities dealer, when executing a
transaction in municipal securities for or on behalf of a customer, to make a reasonable effort to obtain a
price for the customer that is fair and reasonable in relation to prevailing market conditions. Since IB
customers enter orders to buy and sell municipal bonds into an automated system, the system is designed
to provide the relevant information regarding each security that a customer is considering trading.

IB's Best Execution policy is designed to attempt to get two or more quotes for each customer transaction.
Because the municipal securities market may be extremely illiquid, two quotes may not be available for a
specific security and the currently available quotes may not reflect the best possible price. Therefore, in
addition to providing the customer with quotes and comparable prices for the specific bond chosen by the
customer, IB provides quotes and prices for comparable bonds as a comparison and also provides a facility
to place a request for a quote (RFQ) on a specific bond that the customer selects. After reviewing and
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evaluating the prices for comparable securities, in addition to the specific security that they have requested,
customers can transmit an order for the municipal bond of their choice.
To qualify as “comparable” to your target bond for price comparison, a bond must meet all of the following
criteria:
It must have the same organization type, bond type, debt class and rating as the target bond.
It must have identical watch list status as the target bond (either “none”, or “marked for upgrade” or
“marked for downgrade”).
The difference between the target bond's coupon rate and the associated bond's rate must be 50 basis
points or less.
The difference in maturity date between the target bond and the associated bond must be one year or
less.

Trade Mutual Funds
Choose a fund and trade from the trading window or the Order Ticket.
Before you can trade funds, you must upgrade your trading permissions in Account Management.

To trade a fund
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1. Add a fund to your trading window:
a. In Classic mode, from the Edit menu select Mutual Fund Selector.
b. Select a fund family in the left pane, and then choose the fund(s) you want to trade in the right
pane. Click OK.

Data for funds only appears in the Last or Close price fields. Mutual funds are accumulated throughout the
day and transmitted to the funds at 15:59 for pricing.
2. From the trading window, click the Bid field for a sell order and the Ask field for a buy order.
For a Sell order, enter the quantity in the Quantity field.
For a Buy order, enter a dollar value in the price field. The number of shares purchased is
calculated after the funds are priced.
3. Click “T” to transmit your order.
Buy orders are entered in dollars. Sell orders can only be entered in shares. Mutual funds can only be
submitted as Market orders as they are priced once per day after the market closes.
For more details on mutual funds and to access electronic prospectuses, see the Funds product page.

Trade FX from the Trading Window
If you have a multi-currency margin account, you can trade domestic and foreign securities and currencies
from the same account.
To use FXTrader for trading FX, see the FXTrader topic.
To trade FX from the trading window
1. Add a market data line using the traded currency pair.
To add a primary pair, simply enter the symbol using the syntax xxx.yyy, for example EUR.USD.
2. Select the instrument type Forex, and choose the trading currency.
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Example 1
If you want to buy/sell a specific amount of GBP, set up the market data line by entering the symbol GBP
(as the transaction currency) and selecting Forex as the instrument type. In the Contract Selection box,
choose USD as the Currency (settlement currency) from the list in the right pane. Or simply enter
GBP.USD. You will then receive the quote GBP.USD, with the Bid: 1.5598 Ask: 1.5600. This means that
GBP 1 = USD 1.56XX
To buy GBP 10,000, click on the ask and enter 10,000 as the quantity of GBP that you wish to buy. You will
pay $1.5600 for each GBP.
To sell GBP 10,000, click on the bid and enter 10,000 as the quantity of GBP that you wish to sell. You will
receive $1.5598 for each GBP.
Example 2
If you want to buy/sell a specific amount of USD, set up the market data line by entering the symbol USD
(as the transaction currency) and selecting Forex as the instrument type. In the Contract Selection box,
choose GBP as the Currency (settlement currency) from the list in the right pane. You will then receive the
quote USD.GBP, with the Bid: 0.5950 Ask: 0.6230. This means that USD 1 = GBP 0.62XX
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To buy USD 10,000, click on the ask and enter 10,000 as the quantity of USD that you wish to buy. You will
pay GBP 0.6230 for each USD. Thus, you will pay GBP 6,230.
To sell USD 10,000, click on the bid and enter 10,000 as the quantity of USD that you wish to sell. You will
receive GBP 0.5950 for each USD. Thus, you will receive GBP 5,950.
For more details, see the Forex Products pages on the IB website.
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Columns and Data Points
Add market data and order management columns to your trading windows and tools.
Market Data Fields

757

AltaVista Research ETF Data Points

758

Recognia® Technical Indicator Data Points

763

Market Data Fields

766

Contract Description

767

News

769

Position and P & L

770

Prices

771

High/Low/Volume/History

775

ETF Columns

780

Futures Columns

783

Options
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Bond Columns

785

Greeks Columns

787

Auction

788

Dividend Columns

789

Fundamentals Popular

790

Fundamentals - Analyst Ratings

793

Fundamentals - Independent Ratings

795
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Fundamentals Other
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Graphic Prices
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Short Selling Fields
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Status Columns
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Scale Order Columns
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Technical Indicator Columns
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817
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AltaVista Research ETF Data Points
Easily find ETFs using the ETF Market Scanner. Filter and scan over 1400 US Equity and Fixed Income
ETFs with more than 30 data points provided by AltaVista Research, and view these data points in column
form on any tool or window.
Altavista data points include:
Altar ScoreTM - Stands for AltaVista Long-Term Annual Return Forecast Score. is AltaVista's proprietary measure of an ETF's overall investment merit. ALTAR compares funds based on their fundamentals and identifying value (or the lack thereof) and then assigns the following investment ratings
based on this score: Avoid (< 3%), Underweight (3% to 6%), Neutral (6% to 8%), Overweight (8% to
11%) and Speculative (> 11%).
Asset Class - The asset class of the ETF holding, such as Equity or Fixed Income.
Asset Turnover Ratio - Asset turnover.
Assets Under Management - The assets under management for the ETF.
Average Altar ScoreTM - The average ALTAR score assigned by AltaVista for all funds in this category.
Average Bid/Ask Spread % - The average spread between the bid and ask prices of the ETF,
expressed as a percentage.
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Beta vs. S&P 500 - The ETFs beta versus that of the S&P 500 index.
Book Value per Share (current year) - The forecasted book value/share for the current fiscal year.
Book Value per Share (next year) - The forecasted book value/share for the upcoming fiscal year.
Book Value per Share (previous year) - The forecasted book value/share for the prior fiscal year.
Developed Market Exposure - The percentage of your portfolio allocated to Developed Markets as
defined by Morgan Stanley Capital International (MSCI).
Distribution Frequency - How often the ETF distributes gains and dividends.
Dividend Yield (current year) - Forecasted dividend yield for the current fiscal year.
Dividend Yield (next year) - Forecasted dividend yield for the upcoming fiscal year.
Dividend Yield (previous year) - Forecasted dividend yield for the prior fiscal year.
Dividends per share (current year) - Forecasted dividends per share for the current fiscal year.
Dividends per share (next year) - Forecasted dividends per share for the upcoming fiscal year.
Dividends per share (previous year) - Forecasted dividends per share for the prior fiscal year.
EPS Growth (current year) - Forecasted earnings-per-share growth for the current fiscal year.
EPS Growth (next year) - Forecasted earnings-per-share growth for the upcoming fiscal year.
EPS Growth (previous year) - Forecasted earnings-per-share growth for the prior fiscal year.
Earnings per share (current year) - Forecasted earnings per share for the current fiscal year.
Earnings per share (next year) - Forecasted earnings per share for the upcoming fiscal year.
Earnings per share (previous year) - Forecasted earnings per share for the prior fiscal year.
Emerging Markets Exposure - The percentage of your portfolio allocated to Emerging Markets as
defined by Morgan Stanley Capital International (MSCI).
Expense - Annual expense ratio in basis points (bps).
Five Year EPS Growth - Five year earnings-per-share growth as a compound annual growth rate.
Five Year Performance - The total return of the ETF for the past five years.
Forward Dividend Yield - Twelve months forward dividend yield.
Forward P/E - Twelve months forward price-to-earnings ratio.
Forward Price/Cash Flow - Twelve months forward price-to-cash flow ratio.
Leverage - Debt divided by common equity.
Long Term Growth - Consensus forecast for long-term EPS growth.
Median Comp Moody Rating - Displays the median Moody's credit rating of the ETF's debt holdings.
Median Comp S&P Rating - Displays the median S&P credit rating of the ETF's debt holding.
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NAV Ask - The ask price of the ETF's Net Asset Value (NAV).
NAV Bid - The bid price of the ETF's Net Asset Value (NAV).
NAV Change - The difference between the ETF Net Asset Value's Last and Closing prices on the previous trading day. The calculation is based on the ETF's underlying securities.
NAV Change% - The difference between the ETF Net Asset Value's Last and Closing prices on the
previous trading day expressed as a percentage. The calculation is based on the ETF's underlying
securities.
NAV Close - Today's closing price of the ETF's Net Asset Value. The calculation is based on the ETF's
underlying securities.
NAV Last - The Last price of the the ETF's Net Asset Value. The calculation is based on the ETF's
underlying securities.
NAV Prior Close - Yesterday's closing price of the ETF's Net Asset Value. The calculation is based on
the ETF's underlying securities.
Net Margin (current year) - The forecasted net margin for the current fiscal year.
Net Margin (next year) - The forecasted net margin for the upcoming fiscal year.
Net Margin (previous year) - The forecasted net margin for the prior fiscal year.
Number of Components - Shows the number of the components held by the ETF.
Number of Issuers - Shows the number of distinct issuers of debt held by the ETF.
One Month EPS Change - The change in EPS estimates over the past month.
One Year Performance - The total return of the ETF for the past year.
P/E (current year) - Forecasted price-to-earnings ratio for the current fiscal year.
P/E (next year) - Forecasted price-to-earnings ratio for the upcoming fiscal year.
P/E (previous year) - Forecasted price-to-earnings ratio for the prior fiscal year.
P/E to Growth (current year) - Forecasted P/E to Growth ratio for the current fiscal year.
P/E to Growth (next year) - Forecasted P/E to Growth ratio for the upcoming fiscal year.
P/E to Growth (previous year) - Forecasted P/E to Growth ratio for the prior fiscal year.
Payout - Dividends divided by EPS.
Pct with Fixed Interest Rate - Shows the percentage of the ETF's holdings that are fixed interest rate
debt (as opposed to variable).
Pct with Standard Maturity - Shows the percentage of the ETF's holdings with standard maturity (as
opposed to callable/convertible etc).
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Performance since Inception - Total return of the ETF since the fund's inception.
Price-to-Sales (current year) - The forecasted price-to-sales ratio for the current fiscal year.
Price-to-Sales (next year) - The forecasted price-to-sales ratio for the upcoming fiscal year.
Price-to-Sales (previous year) - The forecasted price-to-sales ratio for the prior fiscal year.
Price/Book Value (current year) - The forecasted price/book value for the current fiscal year.
Price/Book Value (next year) - The forecasted price/book value for the upcoming fiscal year.
Price/Book Value (previous year) - The forecasted price/book value for the prior fiscal year.
Price/Cash Flow (current year) - The forecasted price/cash flow for the current fiscal year.
Price/Cash Flow (next year) - The forecasted price/cash flow for the upcoming fiscal year.
Price/Cash Flow (previous year) - The forecasted price/cash flow for the prior fiscal year.
RSI 30 Day - The Relative Strength Indicator calculated over the past 30 days.
Return on Equity (current year) - Forecasted return on equity for the current fiscal year.
Return on Equity (next year) - Forecasted return on equity for the upcoming fiscal year.
Return on Equity (previous year) - Forecasted return on equity for the prior fiscal year.
SPS Growth (current year) - Forecasted sales per share growth% for the current fiscal year.
SPS Growth (next year) - Forecasted sales per share growth% for the upcoming fiscal year.
SPS Growth (previous year) - Forecasted sales per share growth% for the prior fiscal year.
Sales per share (current year) - Forecasted sales per share for the current fiscal year.
Sales per share (next year) - Forecasted sales per share for the upcoming fiscal year.
Sales per share (previous year) - Forecasted sales per share for the prior fiscal year.
Short Interest Ratio - Shows the ratio of shares shorted to the overall float.
Ten Year Performance - Shows the total return of the ETF for the past 10 years.
Three Month EPS Change - Change in EPS estimates over the past three months.
Tracking Difference - The difference in one year's return between the ETF and its benchmark value.
Weighted Average Convexity - Shows the weighted average of the convexity for each of the ETF's
debt holdings.
Weighted Average Coupon - Shows the weighted average of the coupons for each of the ETF's debt
holdings.
Weighted Average Current Yield - Shows the weighted average of the current yield for each of the
ETF's debt holdings.
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Weighted Average Macaulay Duration - Shows the weighted average Macauley duration (in years) of
the ETF's debt holdings.
Weighted Average Maturity - Shows the weighted average maturity (in years) of each of the ETF's
debt holdings.
Weighted Average Modified Duration - Shows the weighted average modified duration (as a percent)
of the ETF's debt holdings.
Weighted Average Yield to Maturity - shows the weighted average of the yield to maturity for each of
the ETF's debt holdings.
Year to Date Performance -Total return of the ETF for the current year-to-date.
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Recognia® Technical Indicator Data Points
Use technical market scanners and columns powered by Recognia Research. Recognia’s pattern
recognition technology identifies technical events that have formed over days, weeks, and even months
which may indicate the trends over the short-, medium- and long-term horizons. Apply technical pattern
scanning with other fundamental and technical data points to find the stocks that match your specified
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criteria. Recognia can recognize over 60 technical events such as Head and Shoulders, Breakouts,
Shooting Stars, Hammers, Gravestones, Triangles, Flags, Pennants and more.
To add Technical Indicators by Recognia columns to a Watchlist or other windows, hold your mouse
over an existing column heading and click the green "+" sign to insert column. From the displayed list select
Technical Indicators by Recogniaand select the data point columns to add.
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Intermediate Term Event Score - Recognia's proprietary score of the event on a scale of 0 to 5.
Events are assigned a score upon their confirmation - the value is assigned differently depending on
the type of event. For example, for classic patterns, the value depends on how symmetrical the pattern
is and how closely it matches the textbook definition. For indicator and oscillator events, the value is
based on the amount of penetration.
Intermediate Term Event Trade Type - Potential trading opportunity type based on the event. Possible values include: Long, Short, and Undefined. This data is provided for information purposes only
and is not intended as a recommendation to buy or sell securities.
Intermediate Term Technical Event Class - The class for the event. Technical events are placed
into one of four classes:
Classic Patterns, such as Double Top, Flag, Head and Shoulders Top, etc.
Short-term Patterns, such as Shooting Star, Engulfing Line, Hammer, etc.
Indicator, such as double and triple moving average crossovers
Oscillator, such MACD, RSI, Fast Stochastic, etc.
Intermediate Term Technical Event Date - The date the event formed. All dates are of the form:
YYYY-MM-DD.
Intermediate Term Technical Event Name - The name of the Technical Event® pattern or indicator
identified by Recognia.
Long Term Event Score - Recognia's proprietary score of the event on a scale of 0 to 5. Events are
assigned a score upon their confirmation - the value is assigned differently depending on the type of
event. For example, for classic patterns, the value depends on how symmetrical the pattern is and how
closely it matches the textbook definition. For indicator and oscillator events, the value is based on the
amount of penetration.
Long Term Event Trade Type - Potential trading opportunity type based on the event. Possible values are: Long, Short, and Undefined. This data is provided for information purposes only and is not
intended as a recommendation to buy or sell securities.
Long Term Technical Event Class - The class for the event. Technical events are placed into one of
four classes:
Classic Patterns, such as Double Top, Flag, Head and Shoulders Top, etc.
Short-term Patterns, such as Shooting Star, Engulfing Line, Hammer, etc.
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Indicator, such as double and triple moving average crossovers.
Oscillator, such MACD, RSI, Fast Stochastic, etc.
Long Term Technical Event Date - The date the event formed. All dates are of the form: YYYY-MMDD.
Long Term Technical Event Name - Name of the Technical Event® pattern or indicator identified by
Recognia.
Short Term Event Score - Recognia's proprietary score of the event on a scale of 0 to 5. Events are
assigned a score upon their confirmation - the value is assigned differently depending on the type of
event. For example, for classic patterns, the value depends on how symmetrical the pattern is and how
closely it matches the textbook definition. For indicator and oscillator events, the value is based on the
amount of penetration.
Short Term Event Trade Type - Potential trading opportunity type based on the event. Possible values include: Long, Short, and Undefined. This data is provided for information purposes only and is not
intended as a recommendation to buy or sell securities.
Short Term Technical Event Class - The class for the event. Technical events are placed into one of
four classes:
Classic Patterns such as Double top, Flag, Head and Shoulders Top, etc.
Short-term Patterns, such as Shooting Star, Engulfing Line, Hammer, etc.
Indicator, such as double and triple moving average crossovers.
Oscillator, such as MACD, RSI, Fast Stochastic, etc.
Short Term Technical Event Date - The date the event formed. All dates are of the form: YYYYMM-DD.
Short Term Technical Event Name - Name of the Technical Event® pattern or indicator identified by
Recognia.

Market Data Fields
Introduction
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To add or remove fields from your Quote Monitor or any tool, hold your mouse over a field until the "Insert"
and "Remove" commands appear. If you hover over a Market Data field, the list will display the market data
categories; if you hover over and order field, the list of order fields is displayed.

To add a field
Hold your mouse over a field to display the Insert and Remove selections.
Click the "+" sign to add a column.
Choose from the displayed list or categories and field columns to add a field to the right of the current field.

Contract Description
Column

Description

Name
Category

A category within an industry in which the underlying can be categorized.

Company

Shows the company name for the underlying.

Name
Contract

Provides the contract description including the underlying, primary
exchange, and if not Smart, the directed exchange.
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Contract Description

Identifies the source of the top market data.

Source

Days to

The number of calendar days remaining until the last trading day

Last Trad-

for the contract.

ing Day
Description

Identifies the instrument type and other descriptive contract information.

Exchange

The market data exchange. If no other exchange is specified for order
routing, this exchange is also where the contract will be routed. Select
SMART order routing to route directly to the best available market.

Industry

The type of industry under which the underlying is categorized.

Issuer

The country issuing the stock.

Country
Maturity

For bonds, the date when the bond matures.

Notes

An editable, unlimited text field where you can enter notes about the
underlying, etc. When you mouse over the Notes text, it displays in a pop up
box so you can read the entire note.
Note:

The Notes field is not editable on system-generated pages, since

these pages (including the Pending page and Portfolio page) function
differently from user-maintained pages. They are dynamically created and
populated at the start of a TWS session and do not have the capability to
save user-entered text.
Sector

The most detailed description of the industry under which the underlying
company can be categorized.

Shortable

Uses colors to identify whether or not there is stock available for the
customer to short it. Colors relay the following information:
Red - No shares are available
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Dark Green - The system is trying to locate shares.
Light Green - At least 1000 shares are available.

Symbol

Shows the exchange symbol for the contract.

Trading

The trading currency of the asset.

Currency
Underlying

The underlying symbol for the contract. To toggle between underlying and
symbol mode, on the View menu select the desired mode.

Upcoming

The date the contract will begin to trade.

IPO Date

News
Column

Description

Name

Net

Shows the net number of Social Sentiment (by aheadsup.com)

Social

headlines per contract (# of positive - # of negative).

Sentiment
News Time

Displays the time and date of the latest contract-related news story. Rows
use a color gradient to help differentiate latest from oldest stories at a
glance. To view this field, you must activate the RSS News feed feature via
the Feature Selector>Fundamental Analysis category.

News Title

Displays the title of the news story. To view this field, you must activate the
RSS News feed feature via the Feature Selector>Fundamental Analysis
category. For a deeper look at a story, double-click the title.

Social

Shows the total number of Social Sentiment (by aheadsup.com)

Sentiment

headlines per contract.

Activity
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Position and P & L
Column

Description

Name

% of Mar-

Shows the market value of the contract as a percentage of the

ket Value

total market value of the account.

Avg Price

The average cost of the current position.

Cost Basis

The cost basis is calculated using the formula:
average price x position x multiplier

Deliverable
Value

For stocks, this is the value of the stock.
For options and futures, this is the value of the underlying asset.

Long Mar-

The current total market value of all long positions in your port-

ket Value

folio.

Market

Equal to (position * market price).

Value
P&L

Displays gains or losses. To modify the P&L calculation used, right-click
the field and select or deselect Include today's opening position in P&L
calculation.
NOTE: When the closing price is not available, the average price is used
for the P&L calculation. This occurrence is noted by an exclamation point
(!) in the P&L field.

Position

Your current position in the selected contract.

Realized

Calculates the realized profit and loss per position.

P&L
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Short Mar-

The current total market value of all short positions in your port-

ket Value

folio.

Target %

The target percent of the contract as defined in the Rebalance
window.

Unrealized

Calculates unrealized P&L for stocks, stock options and futures options.

P&L

Unrealized P&L is calculated using the formula:
(current market price - average cost/share) x total number of shares
The average cost per share is updated in realtime. This field is
automatically added to the Trading window when the customer takes a
position. Once removed it is not automatically added again.

Unrealized

A graphic real-time representation of unrealized profit and loss, where the

P&L Spinner

arrow color indicates whether your current unrealized P&L is positive
(blue) or negative (red), the direction indicates whether the last price
change was negative (pointing left) or positive (pointing right), and the
length of the arrow represents the distance between the purchase/sale
price and the last bid/ask.

Prices
Column

Description

Name

After Hour

Price change after regular trading hours.

Change
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After Hour

Price change after regular trading hours, displayed as a per-

Change %

centage.

Ask

The best ask price for a contract. This is the best price at which you could
currently BUY.

Ask Size

The approximate depth of the current offer.

Bid

The best bid price for a contract. This is the best price at which you could
currently SELL.

Bid Size

The approximate depth of the current bid.

Change

How much the current price has risen or declined from the previous day's
closing price. If the price has declined, the background is red. If the price
has risen, the background is blue. To toggle between dollar change and
percent change, click the column title.

Change

The percentage that the current price has risen or declined from the

(%)

previous day's closing price. If the price has declined, the background is
red. If the price has risen, the background is blue. To toggle between
percent change and dollar change, click the column title.

Change

The change in price (by dollar value or percent) since the day's opening

Since Open

price. If the price has declined, the background is red. If the price has risen,
the background is blue. To toggle between percent change and dollar
change, click the column title.

Close

Displays the last available closing price for the asset. For US equities, we
use corporate action processing to get the closing price. This means the
close price is adjusted to reflect forward and reverse splits, and cash and
stock dividends.

EXT

Requires a subscription to eSignal market data. The exchange where the
contract has traded.

Gap

Displays the difference between the previous night's closing price and the
day's opening price. You can toggle this display between showing the gap
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Toggle Display.

Halted

If trading for a contract has been halted, the field displays an
exclamation point. Otherwise, the field remains blank.

Historical

Shows the 30-day real-time historical volatility as a percentage.

Volatility
%
Historical

The difference between the historical volatility as of yesterday's

Volatility

close, an the current historical volatility, shown as an absolute

Change

value and as a percentage.

Historical

Hows the historical volatility based on the previous day's closing

Volatility

price, as a percentage.

Close %
Last

The last price at which the contract traded. A "C" in front of the last price
indicates that this is the previous day's closing price.
For forex and commodities and , the "midpoint" value is displayed instead of
the last.

Last ($)

The last price at which the contract traded, converted to US dollars. A "C" in front of the last price indicates that this is the previous
day's closing price.

Last

The time at which the contract was last quoted.

Quote
Time
Last RTH

Shows the last price at which the contract traded during regular

Trade

trading hours.
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Last Size

Prices

The number of units traded at the last size. If the last size is larger than the
previous last size, the font is green. If it's smaller, the font is red.

Mark Price

The mark price is equal to the LAST price unless:
Ask < Last - the mark price is equal to the ASK price.
Bid > Last - the mark price is equal to the BID price.

Mid

The midpoint between the current bid and ask.

Month to

The difference between the current last price, and the closing price

Date

of the last day of the previous month.

Change
Month to

The difference between the current last price, and the closing price

Date

of the last day of the previous month, shown as a percentage.

Change %
Open

The opening price for the day.

Prior

The previous trading day's closing price.

Close
Prior

The closing price of the last trading day of the previous month.

Month

This value is adjusted for corporate actions.

Close
Prior Year

The closing price of the last trading day of the prior year. This

Close

value is adjusted for corporate actions.

RSI

Requires a subscription to eSignal market data. The Relative Strength

Colorful

Index compares the magnitude of recent losses to recent gains and relays
that comparison in the form of a number that ranges from 0 to 100 where 0
indicates weaker performance. For quick reference, the background color
is red if the RSI is less than 20, and green if the RSI is higher than 80.

RSI

Requires a subscription to eSignal market data. The Relative Strength

Numeric

Index compares the magnitude of recent losses to recent gains and relays
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that comparison in the form of a number that ranges from 0 to 100 where 0
indicates weaker performance.

Short Sale

If a short sale restriction is in effect for the contract, a special icon

Restriction

is displayed. Otherwise, the field is blank.

Spread

The difference between the current ask and bid.

Trade Time

Time of the last trade. The background color indicates the relative activity of
a security compared with all other active contracts on your trading pages.
The lighter background indicates more activity for the contract. Darker
indicates that other securities are trading more actively.

Underlying

Displays the price of the underlying.

Price
VWAP

The volume-weighted average price.

Y Close

Requires a subscription to eSignal market data. The previous trading day’s
last trade price.

Year to

The difference between the current Last price, and the last closing

Date

price of the previous year.

Change
Year to

The difference between the current Last price, and the last closing

Date

price of the previous year, shown as a percentage.

Change %

High/Low/Volume/History
To add High/Low/Volume/History columns to the Quote Monitor or other window, hold your mouse over an
existing Market Data column heading and click the green "+" sign to insert column. From the displayed list
select High/Low/Volume/History and click the field to add. To add multiple fields, use the right-click menu
from the column header and select Customize Layout.
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Column Name

Description

13 week high

The highest price for the past 13 weeks.

13 week low

The lowest price for the past 13 weeks.

26 week high

The highest price for the past 26 weeks.

26 week low

The lowest price for the past 26 weeks.

52 week fraction

Shows the (Last Price – 52 week low)/(52 week
high – 52 week low). The closer the percentage is to
100%, the closer the current price is to the 52 week
high.

52 week high

The highest price for the past 52 weeks.

52 week low

The lowest price for the past 52 weeks.

Average Closing

The average closing trade volume for the past 90

Volume

days.

Average Opening

The average opening trade volume for the past 90

Volume

days.

Average Option

The average option volume for the past 90 days.

Volume
Average Volume

The average daily trading volume over 90 days (multiply
this value times 100).

Average Volume (%)

The average daily trading volume over 90 days (multiply this value times 100) shown as a percentage.

Close 182 Days Ago

Shows the closing price as of the last trading date
182 calendar days ago. Mouse over the value to
see actual date of the data. Value is adjusted for corporate actions.
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Close 273 Days Ago

High/Low/Volume/History

Shows the closing price as of the last trading date
273 calendar days ago. Mouse over the value to
see actual date of the data. Value is adjusted for corporate actions.

Close 30 Days Ago

Shows the closing price as of the last trading date
30 calendar days ago. Mouse over the value to see
actual date of the data. Value is adjusted for corporate actions.

Close 60 Days Ago

Shows the closing price as of the last trading date
60 calendar days ago. Mouse over the value to see
actual date of the data. Value is adjusted for corporate actions.

Close 91 Days Ago

Shows the closing price as of the last trading date
91 calendar days ago. Mouse over the value to see
actual date of the data. Value is adjusted for corporate actions.

High

High price for the day for the selected contract.

Low

Low price for the day for the selected contract.

Price - 1 week price per- One week change in price expressed as a percent.
cent change
Price - 4 week price per- One week change in price expressed as a percent.
cent change
Price - 13 week price

One week change in price expressed as a percent.

percent change
Price - 52 week price

One week change in price expressed as a percent.

percent change
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High/Low/Volume/History

The price range change: (Max(High, Close) - Min
(Low, Close))

Price Range/Avg

Ratio of the price range (see above) divided by the
historical volatility of the contract.

Relative Volume

Requires a subscription to eSignal market data. Compares
today’s volume with volume from the previous trading day.
Indicator grows toward the right as today’s volume
increases.

Relative Volume 3D

Requires a subscription to eSignal market data. Compares
today’s volume with volume from the previous trading day.
Indicator grows toward the right as today’s volume
increases.

Short-Term Volume 10

The true volume over the past 10 minutes. Inter-

Min

polation may be applied if necessary.

Short-Term Volume 3

The true volume over the past 3 minutes. Inter-

Min

polation may be applied if necessary.

Short-Term Volume 5

The true volume over the past 5 minutes. Inter-

Min

polation may be applied if necessary.

Trades

Trade count for the day.

Trades/Min

Trade count per minute.

Volume

Trading volume for the day for the selected contract.

Volume ($)

Trading volume for the day in USD.

Volume Spinner

A graphic representation of volume activity, where a blue
bar representing 10,000 shares moves across the field
from left to right. The faster the bar moves the higher the
trading volume. A temporary color change indicates that
the last sale was greater than 10,000 shares.
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Volume/Min

Trading volume per minute.

Y High

Requires a subscription to eSignal market data. The
highest price from the previous trading day.

Y Low

Requires a subscription to eSignal market data. The lowest
price from the previous trading day.

Y Volume

Requires a subscription to eSignal market data. The
trading volume from the previous trading day.

ETF Columns
To add ETF columns to the Quote Monitor or other window, hold your mouse over an existing Market Data
column heading and click the green "+" sign to insert column. From the displayed list select ETFs.
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Column Name

Description

NAV Ask

The ask price of the ETFs
Net Asset Value, calculated
based on the prices of the
ETFs underlying securities.

NAV Bid

The bid price of the ETFs
Net Asset Value, calculated
based on the prices of the
ETFs underlying securities.

NAV Change
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last price and the previous
day's closing price f the
ETFs Net Asset Value, calculated based on the prices
of the ETFs underlying
securities.
NAV Change%

The difference between the
last price and the previous
day's closing price f the
ETFs Net Asset Value
shown as a percentage, calculated based on the prices
of the ETFs underlying
securities.

NAV Close

Today's closing price of the
ETFs Net Asset Value, calculated based on the prices
of the ETFs underlying
securities.

NAV Last

The last price of the ETFs
Net Asset Value, calculated
based on the prices of the
ETFs underlying securities.

NAV Prior Close

Yesterday's closing price of
the ETFs Net Asset Value,
calculated based on the
prices of the ETFs underlying securities.
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Futures Columns
To add Futures columns to the Quote Monitor or other window, hold your mouse over an existing Market
Data column heading and click the green "+" sign to insert column. From the displayed list select Futures.
Column Name

Description

Futures Open

The total number of currently

Interest

outstanding futures contracts.

Options
To add Options columns to the Quote Monitor or other window, hold your mouse over an existing Market
Data column heading and click the green "+" sign to insert column. From the displayed list select Options.
Column Name

Description

Ask Exch

Identifies the options exchange(s) posting the best ask price on the
options contract.

Bid-Exch

Identifies the options exchange(s) posting the best bid price on the
options contract.

Call/Put

Call option open interest/put option open interest.

Interest
Call/Put

Call option volume/put option volume for the trading day.

Volume
Closing

The implied volatility of the option on yesterday’s closing price.

Implied Vol.

Historical

Shows the historical volatility based on the previous day's clos-

Volatility

ing price, as a percentage.

Close %
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Options

The implied volatility is based on the average of the best bid and offer for
an option. This calculation is non-linear, and may not converge for low
vega options. In such cases, no implied volatility estimate will be
displayed.

Implied

The ratio of the implied volatility over the historical volatility,

Vol/Historical

expressed as a percentage.

Vol %
Model

The option model price is calculated using the underlying price, interest
rate, dividends and other data that you enter using the Option Model
Editor.

Model IV %

The option model implied volatility expressed as a percentage.

Opt. Imp. Vol.

The absolute change in implied volatility between the current value and

Change

the value calculated using yesterday’s closing price.

Opt. Implied

A prediction of how volatile an underlying will be in the future. The IB 30-

Vol

day volatility is the at-market volatility estimated for a maturity thirty
calendar days forward of the current trading day, and is based on option
prices from two consecutive expiration months.

Opt. Volume

The total number of contracts traded over a specified time period.

Opt Volume

Change in volume from the previous day's close as a percentage.

Change %
Option Open

Charts the total number of options that were not closed.

Interest
Put/Call

Put option open interest/call option open interest, for the trading day.

Interest
Put/Call

Put option volume/call option volume for the trading day.

Volume
Time Value %
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percentage.
Time Value = Option Bid - Intrinsic Value
IV for Calls = max(stock price - strike, 0)
IV for Puts = max(strike - stock price, 0)

Underlying

The price of the underlying contract for derivatives. Hold your

Price

mouse over the current price to also see the current bid/ask/last.

Bond Columns
The bond-related fields below can be added to your trading windows in TWS.
Column

Description

Name
10 yr Hedge

The equivalent number of 10-year US Treasury bonds that would hedge
one of the given bonds. It is the DVO1 of the given bond divided by the
DV01 of the 10-year US Treasury bond.

Amount

The amount of the bond outstanding as of the corporation’s latest available

Outstanding

balance sheet.

Ask Yield

The yield-to-worst. This is the lower of yield to maturity and yields to all
calls. The yield is only shown if it is offered on the exchange.

Bid Yield

The yield-to-worst. This is the lower of yield to maturity and yields to all
calls. The yield is only shown if it is offered on the exchange.

Bond Short

Shows the actual text name of the bond for easier identification.

Name
CUSIP

The cusip identifier.

Convexity

Duration is a reasonably good estimate of bond price movements upon
small interest rate moves. However, it assumes that bond price moves
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linearly with interest rates, which is not true especially for larger rate
moves. Convexity corrects duration for this non-linearity as follows:
= ½ x Convexity x (Rate Move in decimals ^ 2) * 100
In Example 1, if the convexity is 8, the correction to duration would be:
= ½ x 8 x (0.0050 ^ 2) * 100 = 0.01%
Hence, the bond price would be expected to increase by:
= 2.5% + 0.01% = 2.51%
or:
= 2.51% x 105 = 2.6355
Coupon

The interest rate used to calculate the amount you will receive annually,
payable based on the Payment Frequency.

Current Ask

The yield of the bond if it is purchased at the current offer.

Yield
Current Bid

The yield of the bond if it is purchased at the current bid.

Yield
Duration

Duration is a measure of bond price sensitivity to interest rate movements.

(%)

It is defined as the percentage decrease (or increase) in the bond price in
response to a 100 basis point upward (or downward) move in interest
rates.
Example 1: When the interest rates in the market fall by 50 basis points, a
bond trading at 105 with a duration of 5 would be expected to appreciate by
roughly: 5 x 50 / 100 = 2.5%. Note that for ordinary bonds, the price moves
opposite to the interest rate. If the rates had increased by 50 basis points,
the bond price would have declined by 2.5%.

Exchange

Indicates whether or not the bond is listed.

Listed
Last Yield

TWS Guide

The yield-to-worst. This is the lower of yield to maturity and yields to all

786

Chapter 1

Greeks Columns

calls. The yield is only shown if it is offered on the exchange.

Mark Yield

Implied yield of the bond if it is purchased at the current market
price.

Payment

The bond payment frequency.

Frequency
Ratings

The rating issued for the bond.

Value of

The dollar value decrease in the price of a bond due to a 1 basis point,

BPS

upward parallel shift in the yield curve. Commonly referred to as DV01. It is
the duration times the bond price divided by 100.

Greeks Columns
To add Greeks columns to the Quote Monitor or other window, hold your mouse over an existing Market
Data column heading and click the green "+" sign to insert column. From the displayed list select Greeks.
Column

Description

Name
Delta

The ratio of the change in the price of the option to the corresponding change
in the price of the underlying.

Gamma

The rate of change of Delta with respect to the underlying asset's
price.

Portfolio
Delta

Calculated as delta * position.
A position delta that captures both the direction and the magnitude of the
portfolio's sensitivity to an underlying by representing the degree and direction
of change in the option price, based on a change in the price of the underlying.

Portfolio
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Auction

Helps you to assess directional risk by defining the speed at which the option's
directional changes will occur, i.e. the rate of change of delta.

Portfolio
Theta

Calculated as theta * position.
Theta represents the portfolio's sensitivity to the passage of time by indicating
that rate at which the market value of our portfolio will change with time. This
metric calculation is based on the assumption that all other variables remain
unchanged, including the underlying price, implied volatility and interest rate.

Portfolio
Vega

Calculated as vega * position.
Represents the portfolio's sensitivity to changes in implied volatility of the
underlying, and shows the changed in the price of an option relative to a
change in the implied volatility of the underlying. Generally long option
positions benefit from rising (and suffer from declining) implied volatilities,
while short options positions experience the opposite.

Theta

A measure of the rate of decline of the value of an option due to the
passage of time.

Vega

The amount that the price of an option changes with a 1% change in
volatility.

Auction
For Arca options orders.
Column

Description

Name
Auc. Price

The price at which the auction would occur if no new orders were received
and the auction were held now. The indicative price for the auction.

Auc.

The number of shares that would trade if no new orders were received and

Volume

the auction were held now.

Imbalance

The number of unmatched shares for the next auction; shows how many
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more shares are on one side of the auction than the other.
Green indicates an imbalance on the buy side (more buy orders), red
indicates an imbalance on the sell side (more sell orders).

Imbalance

The number of unmatched shares for the next auction divided by the

%

average daily volume, and expressed as a percentage.
Green indicates an imbalance on the buy side (more buy orders), red
indicates an imbalance on the sell side (more sell orders).

Reg.

Imbalance used to determine which at-the-open or at-the-close orders can

Imbalance

be entered following the publishing of the regulatory imbalance.
Green indicates a buy-side regulatory imbalance, red indicates a sell-side
regulatory imbalance.

Reg Imbal- The regulatory imbalance divided by the average daily volume and
ance %

expressed as a percentage.
Green indicates a buy-side regulatory imbalance, red indicates a sell-side
regulatory imbalance.

Dividend Columns
To add Dividends columns to the Quote Monitor or other window, hold your mouse over an existing Market
Data column heading and click the green "+" sign to insert column. From the displayed list select Dividends.
Column Name

Description

Dividend Amount

Shows the amount of the
upcoming dividend

Dividend Date

Displays the dividend exdate.

Dividend Yield %

The total expected dividend
payments per share over the
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next twelve months divided
by the current price, and
expressed as a percentage.
For derivatives, shows the
expected total dividend payments up until the last trading day.
Dividend Yield TTM%

The total dividend payments
per share over the past
twelve months divided by
the current price, and
expressed as a percentage.

Dividends

The total expected dividend
payments per share, over
the next twelve months.
Hold your mouse over this
value to see the expected
payment schedule.

Dividends TTM

The total dividend payments
per share, over the past
twelve months.

Fundamentals Popular
To add Popular Fundamentals columns to the Quote Monitor or other window, hold your mouse over the
Market Data column next to where you want to include the column, and click the green "+" sign to display
the list of available columns.
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To add multiple columns, right-click the column header and select Customize Layout.
Column Name

Description

Analyst Fore-

Provides the analyst forecast estimate of EPS for the next twelve

cast of EPS -

months.

N12
Book Value

Defined as the Common Shareholder's Equity divided by the

(Common

Shares Outstanding at the end of the most recent interim period.

Equity) per

Book Value is the Total Shareholder's Equity minus Preferred

share

Stock and Redeemable Preferred Stock.

EPS Growth

This growth rate is the compound annual growth rate of Earnings Per
Share over the last 5 years, excluding Extraordinary Items and
Discontinued Operations.
NOTE: If the value for either the most recent year or the year furthest out
is zero or negative, the growth rate cannot be calculated and 'NA' (Not
Available) will display.

EPS exclud-
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ing

for the trailing twelve months divided by the trailing twelve month

extraordinary

Diluted Weighted Average Shares Outstanding.

items
Insider Per-

The percentage of the security's shares owned by company

cent Owned

insiders.

Insider

The number of the security's shares owned by company insiders.

Shares
Owned
Inst. Percent

The percentage of the security's shares owned by an institution.

Held

Inst. Shares

The number of the security's shares owned by an institution.

Held

Market Cap

Calculated by multiplying the current price by the current number
of outstanding shares.

P/E

This ratio is calculated by dividing the current Price by the sum of the
Diluted Earnings Per Share from continuing operations BEFORE
Extraordinary Items and Accounting Changes, over the last four interim
periods.

Price/Book

This is the Current Price divided by the latest interim period Book Value
Per Share.

Price/Tang.

The current price divided by the latest interim period Tangible

Book Ratio

Book Value per Share. Tangible Book Value per Share is the
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book value minus Goodwill and intangible Assets, divided by the
Shares Outstanding at the end of the interim period.
Quick Ratio

Also known as the Acid Test Ratio, this value is defined as Cash plus
Short Term Investments plus Accounts Receivable for the most recent
interim period divided by the Total Current Liabilities for the same period.
NOTE: This item is Not Available (NA) for banks, insurance companies
and other companies that do not distinguish between current and long
term assets and liabilities.

Return on

This value is the Income Available to Common Stockholders for the

Equity %

trailing twelve months divided by the Average Common Equity, and is
expressed as a percentage. Average Common Equity is calculated by
adding the Common Equity for the five most recent quarters and dividing
by five.

Fundamentals - Analyst Ratings
To add Fundamentals - Analyst Ratings columns to the Quote Monitor or other windows, hold your mouse
over an existing Market Data column heading and click the green "+" sign to insert column. From the
displayed list select Fundamentals - Analyst Ratings.
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Column Name

Description

Analyst Target/Price

A measure of the dif-

Disparity %

ference between the last
price of a stock and the
average analyst target
price of the stock. Data
provided by Thomson Reuters.

Average Price Target

The current average of ratings analysts covering the
stock. Data provided by
Thomson Reuters.
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Fundamentals - Independent Ratings

An opinion given by an
analyst to clients on
whether or not the stock is
worth buying. Data
provided by Thomson Reuters.

Num of Analyst Rat-

Number of analysts cur-

ings

rently covering the stock.
Data provided by Thomson
Reuters.

Num of Targets

Number of analysts publishing the"target" stock
price. Data provided by
Thomson Reuters.

Fundamentals - Independent Ratings
View individual ratings issued by various subscription-based research providers. Rankings are also
available in Portfolio Builder in the Investment Strategy section.
To add Independent Ratings columns to the Quote Monitor or other windows, hold your mouse over an
existing Market Data column heading and click the green "+" sign to insert column. From the displayed list
select Fundamentals - Independent Ratings.
Only those research providers to which you subscribe will be displayed. If you have no research
subscriptions, the Fundamentals - Independent Ratings section will not be displayed.
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Fundamentals Other
To add Other Fundamentals columns to the Quote Monitor or other window, hold your mouse over the
Market Data column next to where you want to include the column, and click the green "+" sign to display
the list of available columns.
Column Name

Description

Beta

The measure of a company's common stock price volatility
relative to the market. Not calculated if less than 40 months of
pricing is available.
Reuters Beta is the slope for the 60 month regression line of the
percentage price change of the stock relative to the percentage
price change of the local index.
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Book Value (tan-

This is the interim Tangible Book Value divided by the Shares

gible) per share

Outstanding at the end of the most recent interim period. Tangible
Book Value is the Book Value minus Goodwill and Intangible
Assets for the same period.

Cash Flow per

This value is the trailing twelve month Cash Flow divided by the

share

trailing twelve month Average Shares Outstanding. Cash Flow is
defined as the sum of Income After Taxes minus Preferred
Dividends and General Partner Distributions plus Depreciation,
Depletion and Amortization.

Cash per share

This is the Total Cash plus Short Term Investments divided by the
Shares Outstanding at the end of the most recent interim period.
NOTE: This does NOT include cash equivalents that may be
reported under long term assets.

Current Enterprise

The sum of Market Capitalization and Net Debt for the

Value

most recent fiscal period. Reported only for Industrial, Utility and Banking companies.

Current ratio

This is the ratio of Total Current Assets for the most recent interim
period divided by Total Current Liabilities for the same period.
NOTE: This item is Not Available (NA) for Banks, Insurance
companies and other companies that do not distinguish between
current and long term assets and liabilities.

Dividend Yield - 5

The average of the dividend yield for the past 60 months.

year average
Dividend per share

The average of the Annual Dividends per share for the

- 5 year average

past 60 months.

EBITD

Earnings Before Interest, Taxes, Depreciation and Amortization (EBITDA) is EBIT for the trailing twelve months plus the same
period's Depreciation and Amortization expenses (from the
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Statement of Cash Flows). NOTE: This item is only available for
Industrial and Utility companies.

EPS Change TTM

This is the percent change in the trailing twelve month EPS as

%

compared to the same trailing twelve month period one year ago.
It is calculated as the trailing twelve month EPS minus the trailing
twelve month EPS one year ago divided by the trailing twelve
month EPS one year ago, multiplied by 100. NOTE: If either value
has a negative value, the resulting value will be Not Meaningful
(NM).

EPS Change Y/Y

This value is calculated as the most recent interim period EPS

%

minus the EPS for the same interim period one year ago divided
by the EPS for the same interim period one year ago, multiplied
by 100. NOTE: EPS must be positive for both periods. If either
EPS value is negative, the result in Not Meaningful (NM).

EPS Normalized

This is the Normalized Income Available to Common
Stockholders for the most recent annual period divided by
the same period's Diluted Weighted Average Shares Outstanding.

Earnings before

Also known as Pretax Income and Earnings Before

taxes

Taxes, this is Total Revenue for the most recent TTM
period minus Total Expenses plus Non-operating Income
(Expenses) for the same period.

Earnings before

This is the Income Before Tax number excluding the

taxes Normalized

impact of all unusual/one-time/special charges items for
the most recent annual period.

Free Cash Flow -

The TTM Cash from operations minus Capital Expendit-

TTM

ures and Dividends paid from the same period. Calculated using the Quarterly Statement of Cash Flows.
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Free Cash Flow per

The trailing 12 month Free Cash Flow divided by the trail-

share - TTM

ing twelve month Average Shares Outstanding, found on
the income statement.

Gross margin %

This value measures the percent of revenue left after paying all direct production expenses. It is calculated as the
trailing 12 months Total Revenue minus the trailing 12
months Cost of Goods Sold divided by the trailing 12
months Total Revenue and multiplied by 100. NOTE: This
item is only available for Industrial and Utility companies.

High Price

The highest price at which the stock traded over the past
12 months. It may be an intraday high.

Inventory turnover -

Measures how quickly the inventory is sold. Calcuated as: Cost of

TTM

Goods Sold for the trailing twelve months divided by the Average
Inventory. (Average Inventory is inventory for the five most recent
quarters/5).
Not a meaningful value (NM) for banks and insurance companies.

LT debt/equity

This ratio is the Total Long Term Debt for the most recent
interim period divided by Total Shareholder Equity for the
same period.

Low Price

The lowest price at which the stock traded over the past
12 months. May be an intra-day low.

Net Debt, LFI

The sum of all short term debt, notes payable, long term
debt, minority interest and preferred equity minus total
cash and equivalent and short term investments for the
most recent interim period. Only reported for industrial, utility and banking companies.
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Net Income Avail-

This is the annual dollar amount accruing to common

able to Common,

shareholders for dividends and retained earnings exclud-

Normalized

ing the impact of all unusual/one-time/special charges
items.

Net income available

This is the trailing twelve month dollar amount accruing to

to common

common shareholders for dividends and retained earnings. Income Available to Common Shareholders is calculated as trailing twelve month Income After Taxes plus
Minority Interest and Equity in Affiliates plus Preferred
Dividends, General Partner Distributions and US GAAP
Adjustments. NOTE: Any adjustment that is negative (i.e..
Preferred Stock Dividends) would be subtracted from
Income After Taxes.

Net Income/Em-

The Income after Taxes for the past 12 months divided by

ployee - TTM

the number of employees of the last reported fiscal year.

Net Interest Cover-

Also "Times Interest Earned" this is the ratio of Earnings before

age - TTM

interest and taxes for the trailing 12 months divided by the trailing
12 months' Interest Expense, Net.
NOTE: Not meaningful (NM) for banks and insurance, and if TTM
Interest Expense, Net is less than or equal to 0.

Net Profit Margin %

Also known as Return on Sales, this value is the Income
After Taxes for the trailing twelve months divided by Total
Revenue for the same period and is expressed as a percentage. NOTE: Most Banks and Finance companies do
not report revenues when they announce their preliminary
quarterly financial results in the press. When this happens, the trailing twelve month value will not be available
(NA).

TWS Guide

800

Chapter 1

Operating margin %

Fundamentals Other

This value measures the percent of revenues remaining
after paying all operating expenses. It is calculated as the
trailing 12 months Operating Income divided by the trailing 12 months Total Revenue, multiplied by 100. Operating Income is defined as Total Revenue minus Total
Operating Expenses.

P/E Normalized

This is the Current Price divided by the latest annual
Normalized Earnings Per Share value.

Payout ratio

This ratio is the percentage of the Primary/Basic Earnings
Per Share Excluding Extraordinary Items paid to common
stockholders in the form of cash dividends during the trailing twelve months.

Pretax margin %

This value represents Income Before Taxes for the most
recent fiscal year expressed as a percent of Total Revenue for the most recent fiscal year.

Pretax margin -

The trailing twelve months' Income Before Taxes,

TTM

expressed as a percentage of total revenue for the same
period.

Price to Cash Flow

This is the current Price divided by Cash Flow Per Share

per share

for the trailing twelve months. Cash Flow is defined as
Income After Taxes minus Preferred Dividends and General Partner Distributions plus Depreciation, Depletion
and Amortization.

Price to Free Cash

This is the current Price divided by trailing twelve months' Free

Flow per share -

Cash Flow Per Share.

TTM

Free Cash Flow is calculated from the Statement of Cash Flows
as a Cash from Operations minus Capital Expenditures and
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Dividends paid.

Price to sales

This is the current Price divided by the Sales Per Share
for the trailing twelve months. If there is a preliminary earnings announcement for an interim period that has recently
ended, the revenue (sales) values from this announcement will be used in calculating the trailing twelve month
revenue per share. NOTE: Most Banks and Finance companies do not report revenues when they announce their
preliminary interim financial results in the press. When
this happens, the trailing twelve month values will not be
available (NA) until the complete interim filing is released.

Receivables

Ratio of total revenue for the trailing 12 months divided by

turnover - TTM

Average Accounts Receivables.
Not meaningful (NM) for banks.

Relative (S&P 500)

The percent change in price since the close of the last

price percent

trading day of the previous year, as compared to the

change - YTD

change in the price of the S&P 500 during that same
period.

Return on average

This value is the Income After Taxes for the trailing twelve

assets

months divided by the Average Total Assets, expressed
as a percentage. Average Total Assets is calculated by
adding the Total Assets for the five most recent quarters
and dividing by five.

Return on invest-

This value is the trailing twelve month Income After Taxes

ment %

divided by the average Total Long Term Debt, Other Long
Term Liabilities and Shareholders Equity, expressed as a
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percentage.

Revenue

This is the sum of all revenue (sales) reported for all operating divisions for the most recent TTM period. NOTE:
Most banks and Insurance companies do not report revenues when they announce their preliminary quarterly financial results in the press. When this happens, the
quarterly value will not be available (NA).

Revenue Change

This is the percent change in the trailing twelve month

TTM %

Sales as compared to the same trailing twelve month
period one year ago. It is calculated as the trailing twelve
month Sales minus the trailing twelve month Sales one
year ago divided by the trailing twelve month Sales one
year ago, multiplied by 100.

Revenue Change

This value is calculated as the most recent interim period

Y/Y %

Sales minus the Sales for the same interim period 1 year
ago divided by the Sales for the same interim period one
year ago, multiplied by 100.

Revenue growth

The Five Year Revenue Growth Rate is the annual com-

rate %

pounded growth rate of Revenues over the last five years.

Revenue/Employee

The trailing twelve months' total sales divided by the num-

- TTM

ber of employees at the end of the last reported fiscal
year.

Revenue/share

This value is the trailing twelve month Total Revenue
divided by the Average Diluted Shares Outstanding for
the trailing twelve months. NOTE: Most Banks and Insur-
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ance companies do not report revenues when they
announce their preliminary quarterly financial results in
the press. When this happens, the trailing twelve month
values will not be available (NA).
Total debt/total

This ratio is Total Debt for the most recent interim period

equity

divided by Total Shareholder Equity for the same period.
NOTE: This is not meaningful (NM) for banks.

Volume

This is the daily average of the cumulative trading volume
for the last ten days.

Graphic Prices
Column

Description

Name
Ask

A red bar whose placement in the field represents the cents in the current

Spinner

best Ask price, relative to a dollar. A bar in the center of the field indicates
that the cents value in the Ask price is close to $.50. A bar toward the left
indicates that the cents value is closer to zero, and to the right indicates that
it's approaching one dollar.

Bid Spinner

A green bar whose placement in the field represents the cents in the
current best Bid price, relative to a dollar. A bar in the center of the field
indicates that the cents value in the Bid price is close to $.50. A bar toward
the left indicates that the cents value is closer to zero, and to the right
indicates it's approaching one dollar.

Candlestick

A graphic representation of the direction and magnitude of price change.
The wide end of the arrow represents the opening price, and the narrow
end represents the last price. An arrow pointing to the right indicates that
the price is higher than the previous close, and an arrow pointing to the left
indicates that the price has dropped from the previous close. A brighter
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shade indicates a greater magnitude of price change.

Graphic

A graphic representation of the difference between the last price and the

Change

previous day's closing price. The arrow is centered in the field, and colored
green if the last price is higher than the close, and colored red if it's lower.
The longer the arrow the wider the difference between the two prices. The
field accommodates graphing changes up to $2.00 below and $2.00 above
the close.

Last

A magenta bar whose placement in the field represents the cents in the

Spinner

current Last price relative to a dollar. A bar in the center of the field
indicates that the cents value in the Last price is close to $.50. A bar toward
the left indicates that the cents value is closer to zero, and to the right
indicates that it's approaching one dollar.

RSI

Requires a subscription to eSignal market data. The Relative Strength
Index compares the magnitude of recent losses to recent gains and relays
that comparison in the form of a number that ranges from 0 to 100 where 0
indicates weaker performance. For quick reference, the indicator shows a
red bar if the RSI is less than 50, and a green bar otherwise. Bar size and
color hue change based on the RSI value.

RSI Scaled

Requires a subscription to eSignal market data. The Relative Strength
Index compares the magnitude of recent losses to recent gains and relays
that comparison in the form of a number that ranges from 0 to 100 where 0
indicates weaker performance. The scaled version uses values from 20 to
80. For quick reference, the indicator shows a red bar if the RSI is less than
50, and a green bar otherwise. Bar size and color hue change based on the
RSI value.

Range

A graphic comparison of the last price to the day's high and low. The
indicator starts in the center of the field and moves toward the left (in red)
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as the last price approaches the day's low, and to the right (in green) as the
last price approaches the day's high. If the last price equals the low or high,
the bar changes color. You can elect to view the Range in three visual
different modes, basic Range, Range 3D, and Range 3D Alert. Only the
last shows a color change when the price equals the high or low.
Smart

A graphic representation of the cents in the current price relative to a dollar.

Spinner

If you hold a short position, the bar is red and represents the cents in the
Ask price. If you hold a long position, the bar is green and represents the
cents in the Bid price. For contracts in which you hold no position, the bar is
gray, and represents the cents in the Last price. A bar in the center of the
field indicates that the cents value in the price is close to $.50. A bar toward
the left indicates that the cents value is closer to zero, and to the right
indicates that it's approaching one dollar.

Wall Street Horizon Corporate Event Calendar
To add WSH columns to the Quote Monitor or other window, hold your mouse over an existing Market
Data column heading and click the green "+" sign to insert column. From the displayed list select WSH
Corporate Event Calendar.
Column Name

Description

Dividend Amount

Shows the amount of the

(WSH)

upcoming dividend

Dividend Date

Displays the dividend ex-

(WSH)

date.

Recent Analyst

Date and time of the most

Meeting

recent analyst meeting.

Recent Earnings

Date and time of the most
recent earnings/earnings call
event.
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Short Selling Fields

Date and time of the most
recent shareholder meeting,
presentation or other event.

Upcoming Analyst

Date and time of the next

Meeting

scheduled analyst meeting.

Upcoming Earnings

Date and time of the next
scheduled earnings/earnings
call event.

Upcoming Event

Shows the next major upcoming company event.

Upcoming Event

Shows the date of the next

Date

major upcoming company
event.

Upcoming Misc

Date and time of the next

Event

shareholder's meeting,
presentation or other event.

Short Selling Fields
To add Short Selling columns to the Quote Monitor or other window, hold your mouse over an existing
Market Data column heading and click the green "+" sign to insert column. From the displayed list select
Short Selling.
Column Name

Description

Days to cover

Calculated as the aggregate
short interest for the month
divided by the average daily
share volume traded between
short interest settlement dates.
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Also known as "short interest
ratio."

Fee rate

Interest rate charged on borrowed shares.

Rebate rate

Fed funds or other currency-relevant Benchmark
rate minus the interest rate
charged on borrowed
shares minus Tier III Short
Sale Proceeds Interest
spread.

Shares short

The total number of shares of a
security that have been sold
short by customers and
securities firms that have not
been repurchased to settle
outstanding short positions in
the market; the net short
positions outstanding in the
stock as of the settlement date.

Short % of Float

Percentage of short interest
shares to float shares outstanding. Percentage of
Float % = short interest/float
shares x 100.

Short Interest Change

The percentage that the
short interest shares have
changed compared to the
previous period.
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Short Outstanding

Percent of short interest to

Ratio

total shares outstanding.

Shortable Shares

The number of shares available
for shorting.

Utilization

Shows the ratio of shares lent
to shares available, as a
percentage. Illustrates the
general level of demand for an
asset; the larger the
percentage, the greater the
demand.

Technical Indicator Columns
To add Technical Indicator columns to the Quote Monitor or other window, hold your mouse over an
existing Market Data column heading and click the green "+" sign to insert column. From the displayed list
select Technical Indicator.
Column Name

Description

EMA (100)

100-period Exponential Moving
Average.

EMA (100) Cros-

100-period Exponential Moving

sover

Average crossover, shown as a
percentage.

EMA (20)

20-period Exponential Moving
Average.

EMA (20) Cros-

20-period Exponential Moving

sover

Average crossover, shown as a
percentage.
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EMA (20)/EMA

20-period Exponential Moving

(200)

Average over 200-period Exponential Moving Average, shown
as a percentage.

EMA (200)

200-period Exponential Moving
Average.

EMA (200) Cros-

200-period Exponential Moving

sover

Average crossover, shown as a
percentage.

EMA (50)

50-period Exponential Moving
Average.

EMA (50) Cros-

50-period Exponential Moving

sover

Average crossover, shown as a
percentage.

MACD

Moving Average Convergence/Divergence.

MACD Histogram

Moving Average Convergence/Divergence histogram.

MACD Signal

Moving Average Con-

Line

vergence/Divergence signal.

PPO

Percent of Price Oscillator,
shown as a percentage.

PPO Histogram

Percent of Price Oscillator histogram, shown as a percentage.

PPO Signal Line

Percent of Price Oscillator signal
line, shown as a percentage.
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Recognia® Technical Indicator Data Points

1:1 ratio of price to 100-period
Exponential Moving Average.

Price/EMA (20)

1:1 ratio of price to 20-period
Exponential Moving Average.

Price/EMA (200)

1:1 ratio of price to 200-period
Exponential Moving Average.

Price/EMA (50)

1:1 ratio of price to 50-period
Exponential Moving Average.

Recognia® Technical Indicator Data Points
Use technical market scanners and columns powered by Recognia Research. Recognia’s pattern
recognition technology identifies technical events that have formed over days, weeks, and even months
which may indicate the trends over the short-, medium- and long-term horizons. Apply technical pattern
scanning with other fundamental and technical data points to find the stocks that match your specified
criteria. Recognia can recognize over 60 technical events such as Head and Shoulders, Breakouts,
Shooting Stars, Hammers, Gravestones, Triangles, Flags, Pennants and more.
To add Technical Indicators by Recognia columns to a Watchlist or other windows, hold your mouse
over an existing column heading and click the green "+" sign to insert column. From the displayed list select
Technical Indicators by Recogniaand select the data point columns to add.
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Intermediate Term Event Score - Recognia's proprietary score of the event on a scale of 0 to 5.
Events are assigned a score upon their confirmation - the value is assigned differently depending on
the type of event. For example, for classic patterns, the value depends on how symmetrical the pattern
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is and how closely it matches the textbook definition. For indicator and oscillator events, the value is
based on the amount of penetration.
Intermediate Term Event Trade Type - Potential trading opportunity type based on the event. Possible values include: Long, Short, and Undefined. This data is provided for information purposes only
and is not intended as a recommendation to buy or sell securities.
Intermediate Term Technical Event Class - The class for the event. Technical events are placed
into one of four classes:
Classic Patterns, such as Double Top, Flag, Head and Shoulders Top, etc.
Short-term Patterns, such as Shooting Star, Engulfing Line, Hammer, etc.
Indicator, such as double and triple moving average crossovers
Oscillator, such MACD, RSI, Fast Stochastic, etc.
Intermediate Term Technical Event Date - The date the event formed. All dates are of the form:
YYYY-MM-DD.
Intermediate Term Technical Event Name - The name of the Technical Event® pattern or indicator
identified by Recognia.
Long Term Event Score - Recognia's proprietary score of the event on a scale of 0 to 5. Events are
assigned a score upon their confirmation - the value is assigned differently depending on the type of
event. For example, for classic patterns, the value depends on how symmetrical the pattern is and how
closely it matches the textbook definition. For indicator and oscillator events, the value is based on the
amount of penetration.
Long Term Event Trade Type - Potential trading opportunity type based on the event. Possible values are: Long, Short, and Undefined. This data is provided for information purposes only and is not
intended as a recommendation to buy or sell securities.
Long Term Technical Event Class - The class for the event. Technical events are placed into one of
four classes:
Classic Patterns, such as Double Top, Flag, Head and Shoulders Top, etc.
Short-term Patterns, such as Shooting Star, Engulfing Line, Hammer, etc.
Indicator, such as double and triple moving average crossovers.
Oscillator, such MACD, RSI, Fast Stochastic, etc.
Long Term Technical Event Date - The date the event formed. All dates are of the form: YYYY-MMDD.
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Long Term Technical Event Name - Name of the Technical Event® pattern or indicator identified by
Recognia.
Short Term Event Score - Recognia's proprietary score of the event on a scale of 0 to 5. Events are
assigned a score upon their confirmation - the value is assigned differently depending on the type of
event. For example, for classic patterns, the value depends on how symmetrical the pattern is and how
closely it matches the textbook definition. For indicator and oscillator events, the value is based on the
amount of penetration.
Short Term Event Trade Type - Potential trading opportunity type based on the event. Possible values include: Long, Short, and Undefined. This data is provided for information purposes only and is not
intended as a recommendation to buy or sell securities.
Short Term Technical Event Class - The class for the event. Technical events are placed into one of
four classes:
Classic Patterns such as Double top, Flag, Head and Shoulders Top, etc.
Short-term Patterns, such as Shooting Star, Engulfing Line, Hammer, etc.
Indicator, such as double and triple moving average crossovers.
Oscillator, such as MACD, RSI, Fast Stochastic, etc.
Short Term Technical Event Date - The date the event formed. All dates are of the form: YYYYMM-DD.
Short Term Technical Event Name - Name of the Technical Event® pattern or indicator identified by
Recognia.

ESG Combined Scores
Use Environmental, Social and Government (ESG) scores as another tool when making investment
decisions.
To add ESG - Combined Scores columns to a Watchlist or other windows, hold your mouse over an
existing column heading and click the green "+" sign to insert column. From the displayed list select ESG Combined Scores and select the columns to add.
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Column Name

Description

ESG Combined

Thomson Reuters ESG Com-

Score

bined Score is an overall
company score based on the
reported information in the
environmental, social and
corporate governance pillars
(ESG Score) with an ESG
Controversies overlay. (com-
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prises ESG Controversies
Score, Resource Use Score,
Emissions Score, Environmental Innovation Score,
Workforce Score, Human
Rights Score, Community
Score, Product Responsibility Score, Management
Score, Shareholders Score
and CSR Strategy Score).
ESG Score

Thomson Reuters ESG
Score is an overall company
score based on the selfreported information in the
environmental, social and
corporate governance pillars. (comprises Resource
Use Score, Emissions Score
Environmental Innovation
Score, Workforce Score,
Human Rights Score, Community Score, Product
Responsibility Score, Management Score, Shareholders Score, and CSR
Strategy Score).
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ESG Category Scores
Use Environmental, Social and Government (ESG) scores as another tool when making investment
decisions.
To add ESG - Category Scores columns to a Watchlist or other windows, hold your mouse over an existing
column heading and click the green "+" sign to insert column. From the displayed list select ESG - Category
Scores and select the columns to add.
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Column Name

Description

CSR Strategy Score

CSR strategy category
score reflects a company's
practices to communicate
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that it integrates the economic (financial), social
and environmental dimensions into its day-to-day
decision-making processes.
Community Score

Community category score
measures the company's
commitment towards being
a good citizen, protecting
public health and respecting business ethics.

ESG Controversies

ESG controversies cat-

Score

egory score measures a
company's exposure to
environmental, social and
governance controversies
and negative events reflected in global media.

Emissions Score

Emission category score
measures a company's
commitment and effectiveness towards reducing
environmental emission in
the production and operational processes.

Environmental Innov-

Environmental innovation

ation Score

category score reflects a
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company's capacity to
reduce the environmental
costs and burdens for its
customers, and thereby creating new market opportunities through new
environmental technologies and processes or
eco-designed products.
Human Rights Score

Human rights category
score measures a company's effectiveness
towards respecting the fundamental human rights conventions.

Management Score

Management category
score measures a company's commitment and
effectiveness towards following best practice corporate governance
principles.

Product Responsibility

Product responsibility cat-

Score

egory score reflects a company's capacity to produce
quality goods and services
integrating the customer's
health and safety, integrity
and data privacy.
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Resource Use Score

ESG Pillar Scores

Resource use category
score reflects a company's
performance and capacity
to reduce the use of materials, energy or water, and to
find more eco-efficient solutions by improving supply
chain management.

Shareholders Score

Shareholders category
score measures a company's effectiveness
towards equal treatment of
shareholders and the use
of anti-takeover devices.

Workforce Score

Workforce category score
measures a company's
effectiveness towards job
satisfaction, healthy and
safe workplace, maintaining diversity and equal
opportunities, and development opportunities for its
workforce.

ESG Pillar Scores
Use Environmental, Social and Government (ESG) scores as another tool when making investment
decisions.
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To add ESG - Pillar Scores columns to a Watchlist or other windows, hold your mouse over an existing
column heading and click the green "+" sign to insert column. From the displayed list select ESG - Pillar
Scores and select the columns to add.

Column Name

Description

Corporate Governance

The Corporate Governance

Score

pillar score is the weighted
sum of the Management,
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Shareholders and CSR
Strategy category scores.
Environmental Score

The Environmental pillar
score is the weighted sum
of the Resource Use, Emissions and Enviroinmental
Innovation category scores.

Social Score

The Social pillar score is
the weighted sum of the
Workforce, Human Rights,
Community and Product
Responsibility category
scores.
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Pegged to Stock Columns
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Order Management Fields
Customized Layout

To add or remove fields from your Quote Monitor, right-click on any field label and select Customize
Layout. In the list of Order Management columns, move the desired field from the Available to the Shown
list to display, or from the Shown list to the Available list to hide. You can modify the layout of fields per
page, or globally using a page layout that is applied to multiple Quote Monitors.
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Changes to a page layout are automatically applied to any pages that already use the layout.
Mandatory Columns
Contract Descriptions
Time in Force Columns
Quantity Columns
Price-based Columns
Actions Columns
Adjustable Stop Columns

TWS Guide

825

Chapter 1

Mandatory Columns

Volatility Columns
EFP Columns
Pegged to Stock Columns
Order Attributes Columns
Status Columns
Scale Order Columns

Mandatory Columns
The columns below are always displayed on an order line in the trading window.
Column

Description

Name
Shown Columns (mandatory columns that cannot be removed)

Action

The order action. BUY or SELL.

Type

The order type.

Quantity

The number of units in your order.

Lmt.

The limit price for order types to which this price applies, including Limit, Stop

Price

Limit, and Relative orders.

Aux.

This field reflects the Election price for Stop and Stop Limit orders, and the

Price

Offset Amount for Relative and Trailing Stop orders. You can set these
auxiliary amounts in the Default Order Settings box.

Basis

Used with futures EFPs. The basis point value is equal to the implied interest

Points

rate x 100.

Status

The order status. See Guide to System Colors for details.

Contract Descriptions
Column
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Name
Contract Description

Description

Identifies the instrument type and other descriptive contract information.

Exchange

The market data exchange. If no other exchange is specified in the
Destination field, this is also the destination to which the contract will be
routed. Select SMART order routing to route directly to the best available
market.

Symbol

The exchange symbol for the contract.

Underlying

Shows the underlying symbol. Note that if you want a single Underlying field
on the trading window with no order field below it, check the Underlying field
for both market data and order management.

Time in Force Columns
Column

Description

Name
Time in Force

Exp.

For GTD orders. Keeps the order active until the close of market on the date

Date

you enter. Date format is YYYY/MM/DD.

Exp.

For GTD orders. Keeps the order active until the time on the date you enter in

Time

the Exp. Date field.

Good

Activates the order after the specified time has elapsed.

After
Time
Time in

The time span over which your order remains active. By default, the time in

Force

force is day, which means any part of your order that has not executed by the
time the market closes will be cancelled by the system.
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Quantity Columns
Column

Description

Name
Quantity

Display

Enter a display size to create an iceberg order.

Size
Min

Enter the minimum acceptable quantity that must be available for the order

Quantity

to execute.

Quantity

Used in conjunction with Quantity Value field to automatically calculate order

Type

quantity based on your instructions.

Quantity

Used in conjunction with Quantity Type field to automatically calculate order

Value

quantity based on your instructions.

Total Qty

The total quantity of the original order.

Price-based Columns
Column

Description

Name
Prices

Current

The current working price of an order at the exchange.

Price
Discretionary

Enter a discretionary amount with a limit order to create a discretionary

Amt

order.

Lmt Offset.

Used for trailing stop limit orders to determine the limit price for the
contract.

Pct. Offset

TWS Guide
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a decimal value between 0 - 1.
Stop Price

The Election price for Stop and Stop Limit orders, and the initial stop price
for trailing stop and trailing stop limit orders.

Actions Columns
Column Name

Description

Actions
Cancel

Click to cancel the order.

Transmit

Click to send the order to the order destination.

Adjustable Stop Columns
Column

Description

Name
Adjustable Stop

Adj Order

The order price submitted when the trigger price is hit on a stop, stop limit,

Type

trailing stop or trailing stop limit order.

Adj Stop

The initial limit price for the adjusted stop limit or trailing stop limit order.

Lmt Price
Adj Stop

The new stop price for the adjusted order.

Price
Adj Trailing

The new trailing amount for a trailing stop or trailing stop limit order.

Amnt
Trigger

The price that triggers the one-time adjustment of a stop, stop limit, trailing

Price

stop or trailing stop limit order.
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Volatility Columns
Column

Description

Name

Continuous

If checked, the option limit price is automatically updated based on

Update

significant movement in the price of the underlying. Also used for EFPs.

Hedge Aux

If needed, enter the auxiliary price for a delta neutral order type that

Price

requires another price field.

Hedge

Define an order type for a delta neutral trade. This will be submitted in

Order Type

conjunction with dynamic management of your volatility orders.

Reference

For dynamic volatility orders. Choose the average of the NBBO, or the bid

Price Type

or ask price to be used as the reference price.

Undrl.

The optional low-end value of a stock range for Volatility orders. If the price

Range

of the underlying falls below this value, the order is cancelled.

(High)
Undrl.

The optional high-end value of a stock range for Volatility orders. If the

Range

price of the underlying rises above this value, the order is cancelled.

(Low)
Volatility

Displays volatility for the option at a specific strike price.

Volatility

Select either Annual or Daily implied volatility calculation for VOL orders.

Type

EFP Columns
Column

Description

Name
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EFP

Continuous

For EFPs. If checked, the limit price is automatically recalculated based

Update

on movement in the basis points.

Int. Rate

For EFPs.

Pegged to Stock Columns
Column

Description

Name
Pegged-to-Stock

Delta

Used for pegged to stock orders. This value is used as a percent, and is
multiplied by the change in the underlying price. this value is added to the
starting price to determine the price for a call option.

Stock

An optional value used for Pegged to Stock option orders. If left blank, the

Ref

NBBO midpoint is used. This value is subtracted from the current NBBO

Price

midpoint to determine a change in the stock price.

Undrl

The optional high-end value of a stock range for Pegged to Stock orders. If the

Range

price of the underlying rises above this value, the order is cancelled.

(High)
Undrl

The optional low-end value of a stock range for Pegged to Stock orders. If the

Range

price of the underlying falls below this value, the order is cancelled.

(Low)

Order Attributes Columns
Column

Description

Name
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Order Attributes

All or None

Marks the order as AON, to ensure the order will not execute unless/until
the entire quantity is available.

Block

Mark your high-volume limit order as a block order.
You may want to consider using ScaleTrader for large volume orders.

Consider

If checked, Smart router will consider trade costs, including commissions,

Cost

when deciding where to route your order.

Hidden

Check to create a hidden order.

Hide

For US Options orders in pennies, hides the pennies from the market.

Pennies
ISE Order

For Midpoint Match orders on the ISE Stock Exchange, select from two

Type

order types. A Standard order is entered as a market or limit order but is
not displayed to the trading community. Standard orders support the
Immediate or Cancel (IOC) order attribute.
An SOI (Solicitation of Interest) order broadcasts the symbol to ISE MPM
users. These orders have a minimum order quantity of 2000.

Non-

Check to indicate that you will take all the risk for partially executed smart-

Guaranteed

routed spread orders.

OCA Group

Allows you to create a one-cancels-all advanced order group without
opening the Order Ticket window.

Open/Close

Specifies whether the order is to open (or increase) a position, or close (or
decrease) a position.

Add Liquid- If checked, this feature attempts to improve the price on the combo
ity

by providing liquidity on at least one leg of a two-legged combo
by submitting one leg of a marketable combo one tick below the
market for that leg. Leaving this feature enabled may result in the
combo order not executing.
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Origin

The customer type from which the order originated. Mainly used for
institutional accounts.

Preserve

Check to keep your order in the queue regardless of incurred exchange

Time

fees.

Priority

Shareholder

A tag used by large shareholders who trade Canadian products.

Sweep to

Check to create a sweep-to-fill order.

Fill
Soft Dollars

Use the dropdown list to select the soft dollar tier for the order. This field is
only visible for accounts that have soft dollar functionality enabled.

Trigger

Displays a dropdown field with a list of all available Trigger Methods. This

Method

allows you to select a new method on a per-order basis.

Status Columns
Column

Description

Name
Status

Destination

The routing destination.

Key

System-created key to identify bundled limit, bracket and trailing stop
orders.

Trade Price

The price at which the order or portion of the order executed.

Scale Order Columns
Column

Description

Name
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Scale Orders

Scale

This amount is used to calculate the per-unit price of each component in the

Incr.

scale ladder. Note that the price increment cannot be negative.

Scale

Set the initial component size for the scaled order.

Init
Scale

A value in this field instructs TWS to submit profit-taking orders, and defines

Profit

the minimum amount of profitability you will accept to exit a position.

Offset

ScaleTrader will submit an opposite-side profit order against the original
order, using the limit price of the parent component plus/minus the profit
offset. For example, if you submit a 10,000 share BUY limit order at $65.00
with a component size of 1000, and enter $15.00 as the Scale Profit Offset,
as soon as the first component executes, TWSwill submit a 1000 share SELL
limit order at $80.00.

Scale

Set the subsequent component size for the scaled order. If you leave this field

Sub

blank, ScaleTrader uses the initial component size.
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Alerts and Notifications
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The Account Window
The Account window lets you monitor every aspect of your account activity. We present "key" account
values as the default when you first open the Account window (this default view is shown in the illustration
below). The account window conveys in real-time the funds you have available for additional trades and
current margin projections.
To open the Account window
From the Mosaic Monitor panel, select the Portfolio tab and click the Account button in the right-hand
corner.

The Account screen is divided into the following sections. Please note the scroll bar to the right of the
window.
Balances, which shows your account balances for securities, commodities and in total. These balances
don't include margin requirements.
Margin Requirements, which shows your current initial and maintenance margin requirements based
on your current positions. Customers under the Reg T margin model can compare their current margin
to current projected requirements under the Portfolio Margin model by clicking the Try PM icon.
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Available for Trading, which tells you what you have for additional trades and cushion before liquidation, based on your balance information and margin requirements.
Market Value - Real FX Position, which shows the total value of all positions, sorted by currency.
FX Portfolio - Virtual FX Position, which shows activity for currency pair trades only. The value in the
Position field only reflects trades executed in the FX market. Please note that these may not reflect
real-time FX positions, since non-base currency conversions may also be included.
Portfolio, which lists all current positions sorted by underlying, and displays the total current market
value for each position.
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Advisors and other multi-client account holders will see a drop-down selection on the Account and
Summary tabs to select either an individual account or an account group.
On the Account page, elect to display account information for All accounts, any individual account including
the Master, or a user-defined Account Group, which includes a subset of accounts (in the image below,
Advisor Tour is a user-defined account group).

On the Summary page, choose to view the account summary for Models, Groups or ALL.
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Advisors can also print the summary page by selecting Print Summary from the File menu.

Balances
The Balances section shows your account balances for securities, commodities and in total. These
balances don't include margin requirements.
To view all Balances values, expand the section using the green plus (+) sign. To customize this view to
show only the values you want to see, put a check next to these parameters and click the green minus (-)
sign to contract the section.
If you have strategies or models, view them by expanding a line, or use the drop-down selector to view
values only for a selected model/strategy.
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Values in the Balances section include:
Parameter

Securities

Commodities

Net Liquidation

Total cash value + stock value + securities

Total cash value (which

Value

options value + bond value + fund value.

includes futures P&L) +
commodities options value.

Net Liquidation

Displays the uncertainty of the Net

Uncertainty (957

Liquidating Value associated with

and higher)

after-hours price changes.

Equity with Loan

Cash Account: Settled Cash.

Value

Margin Account: Total cash value + stock
value + bond value + fund value +
European & Asian options value.

Cash Account: Total cash
value + commodities option
value - futures maintenance
margin requirement + minimum
(0, futures P&L).
Margin Account: Total cash
value + commodities option
value - futures maintenance
margin requirement.

Previous Day

Marginable Equity with Loan Value as of

Equity with Loan

16:00 ET the previous day.
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Value
Reg T Equity with
Loan Value

Cash Account: Settled Cash.
Margin Account: Total cash value + stock
value + bond value + fund value + non-U.S.
& Canadian securities options value +
accrued interest + accrued dividend.

Cash Account: Total cash
value + commodities option
value - futures maintenance
margin requirement + minimum
(0, futures P&L).
Margin Account: Total cash
value - futures maintenance
margin requirement.

Special

A special account associated with a Reg T

Memorandum

Margin account that is maintained for the

Account

purpose of applying Federal Regulation T

Not applicable.

initial margin requirements at the end of the
trading day.
If this values falls
below zero at the
end of the trading
day, positions will
be liquidated.

Max ((EWL - US initial margin
requirements)*, (Prior Day SMA +/- change
in day's cash +/- US initial margin
requirements** for trades made during the
day.))
*calculated end of day under US Stock
rules, regardless of country of trading.
**at the time of the trade

Securities Gross

Equals the sum of the absolute value of all

Position Value

positions except cash, index futures and US

(GPV)

treasuries.
Value of a position is price * size * multiplier

Cash

TWS Guide
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Margin Requirements

Cash recognized at the time of settlement purchases at the time of trade commissions - taxes - fees.

Same as for Securities.
Futures Settlement: Trade date
+ 1 day

Stock Settlement: Trade date + 2 days
Options Settlement: Trade date + 1 day
Accrued Interest

Interest that has accumulated but has not

Same as for Securities.

been paid or charged.
Dividend

Dividends in Lieu that must be paid by the

Payables

holder of a short position.

Margin Requirements
Use real-time margin monitoring to see your current margin requirements at a glance, and to understand
the margin implications of any transaction before you transmit an order.
To view real-time margin requirements
1. From the Account menu, select Account Window.
2. The Account Information window shows your account details, including the current market value and
portfolio.
3. Use the Margin Requirements section to monitor your margin.
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To check projected margin requirements under the Portfolio Margin model, click the Try PM icon. Portfolio
Margin uses a risk-based model that may result in lower margin for balanced portfolios with hedging
positions. Existing customers can upgrade to a Portfolio Margin account via Account Management.
See how to check your margin requirements before you submit an order using the Check Margin feature.
Margin Warning

To help you stay on top of your margin requirements, we provide pop-up messages and color-coded
account information to notify you that you are approaching a serious margin deficiency. TWS will highlight
the row whose value is in the distress state. The colors on your account screen tell you the following:
Yellow - You have only a 5% cushion above the margin requirement.
If your account equity moves rapidly from a greater than 5% cushion to a margin violation, your positions
may be liquidated without you receiving a yellow warning.
Orange - Your margin cushion is depleted and you have a short time to enter into margin-reducing trades
before your positions are liquidated. At this point you will not be able to enter into any trades that might
increase your margin.
Red - Your positions will shortly start to be liquidated as necessary to bring your account back within the
margin limits.
The following table defines the fields available in the Margin Requirements section.

Parameter

Securities Account

Commodities Account

Reg T

Initial margin requirements

Initial margin requirements

Margin

calculated under US Regulation T

calculated under US Regulation T

rules.

rules.

Current

Initial margin requirement in the base

Initial margin requirement in the base

Initial Margin

currency of the account. The initial

currency of the account. The initial

margin requirement is what is required

margin requirement is what is required

to open a new position.

to open a new position.
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Post-Expiry

Provides a projected "at expiration"

Provides a projected "at expiration"

Margin @

margin value based on the soon-to-

margin value based on the soon-to-

Open (pre-

expire contracts in your portfolio.

expire contracts in your portfolio.

dicted)

Value displays at expiration and are

Value displays at expiration and are

highlighted in red. All other times

highlighted in red. All other times

the value is "0". The projected

the value is "0". The projected

value in this field includes the anti-

value in this field includes the anti-

cipated account value including the

cipated account value including the

expiring contract. To see just the

expiring contract. To see just the

projected margin and excess liquid-

projected margin and excess liquid-

ity value for the expiring contract,

ity value for the expiring contract,

double click the entry.

double click the entry.

Current

Maintenance margin requirement in the

Maintenance margin requirement in the

Maintenance

base currency of the account. This is the

base currency of the account. This is the

Margin

value required to maintain your current

value required to maintain your current

positions.

positions.

Projected

Projected initial margin requirement as

Projected initial margin requirement as

Look Ahead

of next period's margin change in the

of next period's margin change in the

Initial Margin

base currency of the account.

base currency of the account based on
current margin requirements, which are
subject to change. This value depends
on when you are viewing your margin
requirements. If it is 3:00 pm ET, the
next calculation you're looking ahead to
is after the close, or the Overnight Initial
Margin. If it's 3:00 am ET, the next
calculation will be at the market's open.

Projected

Projected maintenance margin

Maintenance margin requirement as of

Look Ahead

requirement as of next period's margin

next period's margin change in the base
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Maintenance

change, in the base currency of the

currency of the account based on

Margin

account.

current margin requirements, which are
subject to change. This value depends
on when you are viewing your margin
requirements. If it is 3:00 pm ET, the
next calculation you're looking ahead to
is after the close, or the Overnight Initial
Margin. If it's 3:00 am ET, the next
calculation will be at the market's open.

Projected

Projected overnight initial margin

Overnight initial margin requirement in

Overnight

requirement in the base currency of the

the base currency of the account based

Initial Margin

account.

on current margin requirements, which
are subject to change.

Projected

Projected overnight maintenance

Overnight maintenance margin

Overnight

margin requirement in the base currency

requirement in the base currency of the

Maintenance

of the account.

account based on current margin

Margin

requirements, which are subject to
change.

Please see the Margin Overview page on the IB website for details on margin calculations and soft-edge
margining.

Available for Trading
The Available for Trading values show you the state of your account at a glance. Your Available Funds tells
you if you can put on a trade. Your Excess Liquidity tells you whether you have sufficient cushion to
maintain your current positions, your Buying Power tells you how much you have at your disposal including
your equity and IB's margin.
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To view all Available for Trading values, expand the section using the green plus (+) sign. To customize this
view to show only the values you want to see, put a check next to these parameters and click the green
minus (-) sign to contract the section.
If you have strategies or models, view them by expanding a line, or use the drop-down selector to view
values only for a selected model/strategy.

The following table defines the fields available in the Available for Trading section.
Parameter

Securities Account

Commodities Account

Current

Equity with Loan Value - Initial margin.

Net Liquidation Value - Initial Margin

Available
Funds

This value tells what you have available
for trading.

Current Excess

This value shows your margin cushion,

Net Liquidation value - Maintenance

Liquidity

before liquidation.

margin.

Equity with Loan Value - Maintenance
margin.

Post-Expiry

Provides a projected "at expir-

Provides a projected "at expir-

Excess (pre-

ation" excess liquidity value based

ation" excess liquidity value based

dicted)

on the soon-to-expire contracts in

on the soon-to-expire contracts in

your portfolio. Value displays at

your portfolio. Value displays at

expiration and are highlighted in

expiration and are highlighted in

red. All other times the value is

red. All other times the value is
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"0". The projected value in this

"0". The projected value in this

field includes the anticipated

field includes the anticipated

account value including the expir-

account value including the expir-

ing contract. To see just the pro-

ing contract. To see just the pro-

jected margin and excess liquidity

jected margin and excess liquidity

value for the expiring contract,

value for the expiring contract,

double click the entry.

double click the entry.

Special

Line of credit created when the market

N/A

Memorandum

value of securities in a Reg. T account

Account

increase in value.
See the Knowledge Base for details.

Look Ahead

This value reflects your available funds

Net Liquidation value - Look ahead

Available

at the next margin change. The next

Initial margin.

Funds

change is displayed in the Look Ahead
Next Change field.
Equity with loan value - look ahead
initial margin.

Look Ahead

Equity with loan value - look ahead

Net Liquidation value - look ahead

Excess

maintenance margin.

maintenance margin.

Same as during regular trading hours.

Net Liquidation value - Overnight

Liquidity
Overnight
Available

Maintenance margin

Funds
Overnight

Same as during regular trading hours.

Excess

Net Liquidation value - Overnight
Maintenance margin.

Liquidity
Buying Power

Cash Account: Minimum (Equity with

Not applicable for futures.

Loan Value, Previous Day Equity with
Loan Value)-Initial Margin
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Standard Margin Account: Minimum
(Equity with Loan Value, Previous Day
Equity with Loan Value) - Initial Margin
*4
Leverage

Gross Position Value/Net Liquidation.

Same.

Look Ahead

Shows you when the next margin

Same.

Next Change

period will begin.

Day Trades

Number of day trades still available for

Left

4-day pattern day trader period.

Not applicable for futures.

Market Value - Real FX Position
The Market Value section shows you total value for all assets sorted by currency. Accounts with the ability
to transfer between brokers will also have an In Transit tab to monitor DVPs and other position transfers.
If you have strategies or models, view them by expanding a line, or use the drop-down selector to view
values only for a selected model/strategy.

The following table defines the fields in the Market Value section. Note that not all available fields are
displayed in the above image.
Parameter
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Currency

Open positions are grouped by currency.

Total Cash

Cash recognized at the time of trade + futures P&L.
This value reflects real-time current FX positions, including:
• Trades executed directly through the FX market
• Trades executed as a result of automatic IB conversions, which occur when
you trade a product in a non-base currency,
• Trades deliberately executed to close non-base currency positions using the
FXCONV destination.

Settled Cash

Total cash that has settled + futures P&L.

Accrued

Reflects the current month's accrued debit and credit interest to date, updated

Interest

daily.

Stock

Real-time mark-to-market value of stock.

Options

Real-time mark-to-market value of securities options.

Futures

Real-time change in futures value since last settlement.

FOPs

Real-time mark-to-market value of futures options.

Funds

Current funds balance.

Exchange

The currency exchange rate to the base currency.

Rate
Net

Total cash value + stock value + options value + bond value.

Liquidation
Value
Unrealized

The difference between the current market value of your open positions and the

P&L

average cost, or Value - Average Cost.

Realized

Shows your profit on closed positions, which is the difference between your entry

P&L

execution cost and exit execution cost, or
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(execution price + commissions to open the position) - (execution price
+ commissions to close the position).

FX Portfolio - Virtual FX Position
This section is designed to show activity for currency pair trades for FX traders so that they can track
average cost and running P&L on their currency trades. However the "Position" value may reflect the sum
of trades executed in the FX market along with currency conversions to change non-base funds into your
base currency.
Consequently these “virtual” positions do not necessarily reflect an actual cash balance in any
currency.
For actual, real-time currency balance, check the Total Cash field of the Market Value section.
To avoid having currency conversions reflected in this panel, use the FXCONV destination on the
order line.
When the FX Portfolio panel is displayed, currency positions will also be displayed in the trading window. To remove currency positions from display, condense the FX Portfolio panel by clicking the arrow
to the left of the panel title.
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Watch a short video that explains our dual FX display.

Parameter

Description

Contract

Symbol and description.

description
Exchange

An exchange on which the pair trades. This may not be the executing exchange for the
trade.

Position

The sum of trades executed in the FX market for the selected currency pair.

Unsettled

Unsettled currency trades.

Position
Currency

Currency used to buy/sell the FX pair.

Market

(Position) x (market price).

Value
Market

Real-time price of the position.

Price
Average

Average price per contract.

Price
Unrealized

The difference between the trade price and the market price times position, including

P&L

commission.
Example: BUY 20,000 EUR.USD @ 1.54390
Trade Price = 1.54390

TWS Guide

853

Chapter 1

FX Portfolio - Virtual FX Position

Market Price (current price) = 1.54385
1.54390 – 1.54385 = .00005
.00005 X 20,000 = 1
+ 2.5 commission = -3.50 Unrealized P&L
Realized

Realized profit & loss for the pair.

P&L
Liquidate

Last liquidation "Yes" or "No" tag. If set to "Yes" this position will be put at the end of the

Last

queue to liquidate last in the case of margin requirements. To set, use the right-click
menu on the desired position.
Note: While customers have the opportunity to pre-request the order of liquidation in
the event of a margin deficiency in their account, such requests are not binding on IB. In
the event of a margin deficiency in customer’s account, IB retains the right, in its sole
discretion, to determine the assets to be liquidated, the amount of assets liquidated, as
well as the order and manner of liquidation. Customers are encouraged to consult the
IB Customer Agreement and the IB Disclosure of Risks of Margin Trading for further
information.

TWS FX Dual Presentation
In TWS, IB presents currency/FX position data in two different areas of the account window. We separate
out your actual currency values, which may result from FX trades, conversions, or trading products in
another currency, from your direct FX pair trading activity.
Market Value - Real FX Balances
Your account’s actual currency balances are shown in the Market Value – Real FX Balances section of the
account window.
FX Portfolio - Virtual FX Position
The FX Portfolio section displays your FX trading activity in currency pairs that is helpful for FX Traders as
it allows tracking of a running P&L and average cost. But, it may also reflect “indirect” FX currency
conversions designed to close out a non-base currency balance. This view MAY NOT reflect your actual
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cash balance in any currency. To manage actual currency positions, refer to the Market Value - Real FX
Balances section of the account window.
Automated FX Transaction Decision
When you submit an FX order, TWS will attempt to identify whether you want an FX pair trade or a
currency conversion, based on your positions and balances, and will ask you how you want the currency
trade to be considered. If you elect “Currency Conversion,” TWS will create the order to reflect this
objective. You submit the order manually, and when the order fills your virtual position in the FX Portfolio
section will not be affected. Previously, conversions would affect the virtual position and your only option
was to manually adjust the position and cost to negate the completed conversion.
If you prefer to let TWS make this determination without displaying the confirmation box, check Let TWS
make this determination automatically in the future at the bottom of the confirmation box. When you
activate this feature, FX trades will display FXCONV as the Destination. You can change the destination
on a per-order basis by selecting IDEALPRO. To enable the message again, activate it from the Messages
section of Global Configuration. Note that the order will not be transmitted automatically.

Portfolio
The Portfolio section shows the current value of each position and allows you to mark any position to be
liquidated last in the event of a margin call. Accounts with the ability to make transfers between brokers will
also have an In Transit tab to monitor DVPs and other position transfers.
Please note that TWS displays all FA customer positions in the Account window on a net/aggregate basis.
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Fields in the Portfolio section include:

Parameter

Description

Filter - Enter a symbol to filter out all other positions from the Portfolio display.
Security Type - Elect to see all or only one security type.
Currency - Enter a currency to filter out all other currencies from the Portfolio display.
Trades on - Enter an exchange or market center to filter out all others from the
Portfolio display.
Show Zero Position Rows - displays a line for all traded contracts even if the position
was closed out.
Contract

Symbol and description.

description
Position

Quantity of long/short shares or contracts.

Currency

Currency of the contract.

Market

(Position) x (market price).

Value
Market

Real-time price of the position.

Price
Average

Average cost of stock and securities options opening positions, including

Price

commissions.
Note: Right click and select Show all values in base currency to have TWS
convert all non-base currency position values for display in your base
currency. Converted values are displayed in italics for easy identification.

Unrealized

(Market value of positions) - (average cost).

P&L
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Realized

(Market value of positions since close of period*) - (average cost for these

P&L

positions).
*Cut-off times for determining realized P&L for transactions are as follows:
• 20:30 ET for securities
• Two periods for futures: 17:30 ET and 7:10 ET

Liquidate

Last liquidation "Yes" or "No" tag. If set to "Yes" this position will be put at the

Last

end of the queue to liquidate last in the case of margin requirements. To set,
use the right-click menu on the desired position.
Note: While IB provides customers the opportunity to pre-request the order
of liquidation in the event of a margin deficiency in their account, such
requests are not binding on IB. In the event of a margin deficiency in
customer’s IB account, IB retains the right, in its sole discretion, to determine
the assets to be liquidated, the amount of assets liquidated, as well as the
order and manner of liquidation. Customers are encouraged to consult the IB
Customer Agreement and the IB Disclosure of Risks of Margin Trading for
further information.

The Right-click Portfolio Menu
If you select an asset in the Portfolio section and click your right mouse button, you will have access to the
following menu items.
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Parameter

Description

Sort by

Sort positions alphabetically by security type.

Security
Type
Sort by

Sort positions based on their location on a trading page.

Current
Page
Order
Trade

• Buy - Creates a buy order on the trading page for the selected
contract.
• Sell - Creates a sell order on the trading page for the selected
contract.
• Close Position - Transmits an appropriately sized opposite-side
order to close our the position.
• Close All Positions - Transmits multiple opposite-side orders to
close out all positions in your portfolio.
• Close Portion of Positions - In the text entry box that pops up, enter
the percentage which will be used to calculate the size of each
position's opposite-side order transmitted.

Transfer

For transfer-capable accounts - initiates a DVP/RVP, CMTA or other
transfer.

Create

Creates a market data line for the contract on the main trading screen.

Ticker
Adjust

Only active for Forex positions. Use this feature to enter a hypothetical

Position or

"new" position and "new" average cost. This feature does not modify

Average

your forex positions but lets you create a "what-if" to see total P&L
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Price

including positions you may hold elsewhere.

Adjust

Displayed for all products except cash. Select a position and choose

Average

Adjust Average Price. Use the dialog box to enter a new position or

Price

change the average price to include transfers and corporate actions.

Set

Last liquidation "Yes" or "No" tag. If set to "Yes" this position will be put

Liquidate

at the end of the queue to liquidate last in the case of margin

Last

requirements. To set, use the right-click menu on the desired position.
Note: While IB provides customers the opportunity to pre-request
the order of liquidation in the event of a margin deficiency in their
account, such requests are not binding on IB. In the event of a margin
deficiency in customer’s IB account, IB retains the right, in its sole
discretion, to determine the assets to be liquidated, the amount of
assets liquidated, as well as the order and manner of liquidation.
Customers are encouraged to consult the IB Customer Agreement
and the IB Disclosure of Risks of Margin Trading for further
information.

Unset

Removes the “Liquidate Last” designation for a position.

Liquidate
Last
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Create

Creates a trading page called Portfolio that includes market data lines

Portfolio

for all tickers in your Portfolio.

Page

The Trade Log
The Trade Log

860

Trades Summary

866

The Trade Log
Introduction

The Trade Log displays reports for daily executions including those completed during after-hours trading.

To see trades
Click the Trade Log icon on the trading toolbar, or from the Account menu select Trade Log.
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Trades Tab

The Trades window has two tabs: Trades and Summary. Advisors and other multi-client account holders
have the option to see trade activity for All accounts, an individual account (including the Master) or any
user-defined Account Group. The account group “Global Fund” is selected in the image above.
To add or remove columns from the Trades tab
1. Right-click in any column heading and select Layout.
2. Check the columns you want to include; uncheck columns you want to hide.
Column Name

Description

Action

The action, either Bought (Bot) or Sold (SLD)

Quantity

The number of units in the trade.

Underlying

The underlying symbol.

Comb

If checked, identifies the trade as a combo trade. Use the “+”
sign to expand the combo and view individual legs.

Description

The contract description.

Price

The current market price per unit.
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Currency

The currency in which the position is held.

Exchange

The exchange that executed the order.

Date

The execution date.

Time

The execution time.

Order ID

The order ID.

Order Ref

The order reference number as defined by the user on the
Order Ticket. For basket orders, this field contains the name of
the basket to which the order belongs.

Commissions

Commission charged on the trade.

VWAP Time

For VWAP orders, the time at which the order executed.

Comment

Displays comments relative to the order.

Account

Identifies the beneficial account number.

Confirm

Valid only for Linkage customers.

Submitter

Identifies the order submitter.

Yield

The yield-to-worst. This is the lower of yield to maturity and
yields to all calls. The yield is only shown if it is offered on the
exchange.

The text along the bottom of the window describes the sort order of fields on the
Trades tab.
Email Trade Reports
You can select a group of trades and email them from your default email client. Customize the mail settings
to include specific fields and use different delimiters (these separate the data in the list and may need to be
changed based on how the recipient intends to use the list).
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To email trades
1. From the Trades tab, select the trades you would like to email.
To select a group of contiguous trades, click on the first trade, hold down the Shift key and click
on the last trade in the group.
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To select a group of non-contiguous trades, press and hold the Ctrl key while you click on the
desired trade lines.
2. Right-click the trades or group of trades and select Email trades.
3. In the configuration box, choose the column layout and other settings for the email.
Default Columns shows the columns that are on your trades window.
Extended Form includes all available columns.
Custom Columns allows you to select the columns to include in the email.
4. Enter the email address(es) of the recipient(s) and send your trade reports.
Export Trade Reports
You can export today's and previous days' execution reports to a file which you can then view using MS
Excel or another outside application.
To export trade reports
From within Classic TWS:
1. Click the Trade Log icon on the Trading toolbar to open the Trades window.
2. On the File menu, select Export Today's (or Previous Day's) Reports.
3. If applicable, select the day's report and click OK.
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Default columns will include basic trade report columns in the exported version.
Check Extended Form to include the type, expiry, strike, right and premium currency fields on the
exported report.
Check ID to include the ID field on the report
Check Add Volatility Link to include the volatility calculation (for Volatility orders).
4. In the Symbol dropdown choose Underlying, Local Symbol or both.
5. If desired, changed the field delimiter (which separates each entry) from a comma to something else.
Most users will not need to touch this field.
6. In the Filename field, enter the location and filename you want to assign to the report. Note that the
report will be saved as a text (.txt) file.
7. Click OK to save the report to an outside directory.
You can open your exported report in a spreadsheet by performing a few simple steps.
To open your trade report in Excel
1. Open MS Excel and click File > Open.
2. In the Files of type dropdown, select All Files (*.*).
3. Find the location of the .txt executions file you want to open.
4. In the Text Import Wizard, use Delimited as the file type and click Next.
5. Select Semicolon as the delimiter and click Next.
6. Leave the column data format as General and click Finish.
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Trades Summary
The Summary tab displays execution information by contract. To view executions, click the Trades icon on
the trading toolbar.
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To add/remove columns
1. Right-click on any column heading and select Customize Layout.
2. In the Available Columns list, select a column and click Add to move it into the Shown
Columns list.

Single-Line Complex Positions
View spread and other complex multi-leg positions as a single line entry in your portfolio and in the Account
Information window. The position will be identified by the named strategy (Calendar, Box etc) when
applicable. View individual legs using the drill-down "+" sign next to the complex position title.

You can see the net market value, average price, and realized/unrealized P&L for the position along
with the value for each individual leg.
Complex positions that share a leg on different sides will not display as the two opposite legs will cancel
each other out.
If you trade an option that effectively closes out one leg of a complex position, the complex position is
dissolved and the remaining legs display as single option positions.
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You can close out the entire complex multi-leg position using the right-click Trade>Close Selected Position command.
Several tools may not reflect this Complex Position display, including Rebalance, Option Rollover and
Option Exercise.
This display is not supported in the API.
The trade Summary tab on the Activity panel will reflect a trade that closes the position for one leg.
Hold your mouse over the trade for a description of the canceled trade in which the complex position is
transferred to a single option trade (or group of trades if the position comprised more than two original
legs).
To turn off the complex order display (and show only individual legs), from Global Configuration select
Display>Ticker Row and then select Hide complex positions. To re-enable this display, select Group
legs into complex positions.

Profit and Loss
You can see P&L on the trading screens and in the Account window.
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Position - Shows your position in the instrument.
Market Value - Equal to the position * market price.
Avg Price - The average price is calculated by dividing your cost (execution price + commission) by
the quantity of your position. This value is then used to determine your unrealized P&L. Right-click the
field name and select Configure Precision to specify additional decimal places that will display as superscript.
P&L - Shows your profit and loss for the current day. You can elect to show New Position P&L displayed as P&L (N) which shows P&L only for transactions executed today, or Daily P&L which
includes all open positions.
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Unrealized P&L - The difference between the current market value and the average price of your position.
Select "Display Both" from the right-click menu to show the unrealized P&L as both a value and a
percentage of the initial investment.
Realized P&L - Shows your actual profit or loss on closed positions, which is the difference between
your entry execution cost (execution price + commissions to open the position) and exit execution cost
(execution price + commissions to close the position).
Cost Basis - (the current position x average price).
To display New Position P&L
Right click the P&L field.
Uncheck Include today's opening position in P&L calculation. The field heading will display P&L (N) to
indicate it's for new positions only.
To display Daily P&L
Right click the P&L field.
Check Include today's opening position in P&L calculation. The field label will read P&L.

P&L Calculations
By default, Daily P&L is calculated on all positions in your portfolio in the time zone of each instrument. To
modify the default P&L settings go to Global Configuration and from the General page find the P&L Time
Zone section.
Daily P&L calculation:
PositionNow * PriceNow - positionAtResetTime * priceAtResetTime + NetAmountTraded
For instruments that open and close the same day, ResetTime is five minutes before midnight in
the time zone of the instrument.
For instruments that open today and close tomorrow (trade through midnight) Reset Time is five
minutes before it opens for trading, in the time zone of the instrument.
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Check Margin Pre-Order
See the potential margin impact for an order using the Check Margin feature.

To preview margin impact
You can get to the Preview Margin page several ways:
From within the Order Entry panel or any trading tool, click the Advanced icon and then select Margin
(in the case of option orders, the button is labeled Performance/Margin.)
From an order line in Classic TWS, use the right-click menu and select Check Margin.
View the order details before you transmit, including commissions, margin impact and the order
description.
Click Transmit to send the order from the Preview window, or Close to modify before sending. to send the
order from the Preview window, or Close to modify before sending.
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Performance Profile
The Performance Profile helps demonstrate the key performance characteristics of an option or complex
option strategy.
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It comprises:
An enhanced Quote Details window that shows the Return-to-Risk ratio, Profit Probability and the
potential Max Return and Max Loss;
A Performance Graph that shows the P&L (or any of the Greeks) as a function of the underlying price;
The Scenarios window, which displays the effects of a change in underlying price on the P&L, the
Greeks (either the Instrument Greeks or the Position Greeks) and the volatility of a position.
To open the Performance Profile
You can open the option Performance Profile tool several ways:
Right-click a strategy from the Portfolio or other tool and select Analytical Tools > Performance Profile.
From within the Order Entry panel for a strategy, set order parameters and click the Advanced icon.
Click the Margin/Performance button and ensure that Performance Profile is checked.
Within the Strategy Builder, click the "Profile" button below the strategy.

Understanding System Colors
The application uses colored text and backgrounds to convey information about market movement, order
destination, and order status. Colors are used on all screens that send and receive data, including the
Trading screen, the Market Depth window and the Arbitrage Meter. The meaning of the text colors is
consistent throughout the screens. Information on system colors is sorted into the following sections:
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874

Background colors on a Market Data Line

875

Background colors on an Order Management Line

876

Order Status Colors

876

Text Colors
Colored text on the screen's black background is used to represent up and down movement of price and
quantity, and order destination information.
Color

Description
YELLOW indicates no change in size or price.

GREEN indicates an upward movement in size or price.

ORANGE (or red) indicates a downward movement in
size or price.

For options, the price displayed in PURPLE indicates
that the best price is not executing automatically at one or
more of the exchanges displayed.
MAGENTA - For inter-market spread orders, indicates
the implied price of the order.

LIGHT BLUE indicates that this was the last price at
which the contract traded.

TWS Guide

874

Chapter 1

Background colors on a Market Data Line

MEDIUM BLUE indicates that the quote is not currently
tradable.

The page tab text changes color from black to RED to indicate that the page displays an asset for which an
order has been transmitted.

Background colors on a Market Data Line
Color

Description
DARK GRAY across the entire Market Data line indicates
that the line is selected.

The Change field line uses a background color to represent up and down market movement.
Color

Description
The Change column identifies the degree and direction of
change in the asset's current price from the prior day's
closing price.
A RED background in the Change field indicates that the
change for the day is negative.
A GREEN background in the Change field indicates that
the change for the day is positive.
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This PALE RED indicates that trading has been halted on
the underlying.

Note: Change for the day figures are based on 4 P.M. Eastern Time (ET) prior day closing prices.

Background colors on an Order Management Line
Color

Description
A BLUE background in the Action field indicates a BUY
action.

A RED background in the Action field indicates a SELL
action.

LIGHT BROWN across the entire Order Management
line indicates that you have modified a working order but
have not yet re-transmitted the order.

Order Status Colors
The color in the Status field of an order management line indicates the status of your order.
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Color

Description
LIGHT GRAY indicates that you are in the process of
creating an order and you have not yet transmitted it.

LIGHT BLUE indicates that you have transmitted your
order, but have not yet received confirmation that it has
been accepted by the order destination.

PALE PURPLE indicates that an order has been
accepted by the system (simulated orders) or an
exchange (native orders) but that currently the order is
not working, due to system, exchange or other issues.
When the order becomes active, the order status color
will change appropriately.
PURPLE indicates that the order has been suspended
and is awaiting customer action. Component size is
larger than the account can support. Please modify the
component size or add funds to your account.
DARK BLUE indicates that an order has been accepted
by the system (simulated orders) or an exchange (native
orders) and that this order has yet to be elected. The
order status remains DARK BLUE until the election
criteria are met. At that time the order is triggered, and
the order status color will change appropriately.
Prior to TWS 919, dark blue was also displayed for
native stops that were at the exchange but hadn't been
triggered. Beginning with TWS919, native stops at the
exchange, both triggered and untriggered, display
green.
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Color

Description
GREEN indicates that your order has been accepted
and is working at the destination.
When you display the Shortable market data column,
this color indicates that at least 1000 shares are
available to sell short.
DARK GREEN is used in the Shortable column and
indicates that this contract can be sold short but that at
the moment there are no shares available for short sale,
and that the system is searching for shares.
LIGHT GREEN is used by the Blotter to indicate that a
ticket has been accepted by the trader.

PINK indicates that you have sent a request to cancel
the order but have not yet received cancel confirmation
from the order destination. At this point, your order is not
confirmed canceled. You may still receive an execution
while your cancellation request is pending.
ORANGE indicates that a cancellation request has been
accepted by the system but that currently the request is
not being recognized, due to system, exchange or other
issues. At this point, your order is not confirmed
canceled. You may still receive an execution while your
cancellation request is pending.
RED indicates that the balance of your order has been
confirmed canceled by the system. This could occur
unexpectedly when the destination has rejected your
order.
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Color

Description

In the Shortable column, RED indicates that no shares are available for
short sale.
Once the order is confirmed canceled, the Order Management line will
disappear from your trading screen after 30 seconds. Please see the
Customer Agreement for further information on order confirmation and
order cancellation.
MAROON indicates that an attached simulated order
type has been accepted by the system and has yet to be
elected. The order is held in the IBsystem (and the
status remains MAROON) until the election criteria are
met. At that time the order is transmitted to the order
destination specified and the order status color will
change appropriately.

Alerts and Notifications
The application uses colored text and backgrounds to convey information about market movement, order
destination, and order status. Colors are used on all screens that send and receive data, including the
Trading screen, the Market Depth window and the Arbitrage Meter. The meaning of the text colors is
consistent throughout the screens. Information on system colors is sorted into the following sections:
For You Notifications

880

Set Price Alerts

881

Set Time Alerts

882

Set Margin Cushion Alerts

883

Set P&L Alerts

886

Set Trade Alerts

888

Set Percentage Change Alerts

889
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Set Volume Alerts

891

Set up a Rebate Rate in Percent Alert

893

Create a Shortable Shares Alert

895

Assign Actions to Alerts

897

Set Price Movement Alarms

897

Set Volume Change-activated Alarm
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For You Notifications
Always stay up to date on important events in your account with For You Notifications.

For You notifications display automatically when you log in, if any impactful events have occurred in your
account since your last log-in. Click the For You blue banner to see all new and unread notices. Use
shortcuts "Next Steps" to take action on important events.
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Set Price Alerts
The Alerts window is composed of two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.

By default, the Alerts window opens to a Price alert.
To set a Price alert
1. Right-click an instrument from your Portfolio, Quote Monitor, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
3. In the Configure Price Condition box, select a trigger method from the Method dropdown.
4. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
5. In the Price field, enter the value that will be acted on by the operator defined above, and click the
Finish button.
6. To allow the alert to trigger outside of Regular Trading Hours, check the Alert outside of RTH checkbox.
7. For more options such as alert Duration and Actions, click Advanced Settings. Otherwise, click Activate.
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Set Time Alerts
Set up an alert that triggers at a specific time/date.
The Alerts window is composed of two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.

To set a Time alert
1. Right-click an instrument from your Portfolio, Quote Monitor, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
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3. In the Configure Price Condition box, click Advanced Settings in the bottom right corner.
4. Begin to set the alert conditions by selecting Time in the Choose Condition section of the Create
Condition box, then click Next.
5. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
6. In the Time field, enter the value that will be acted on by the operator defined above, and click the
Finish button.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line following the above steps 3 - 7.
Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message and
audio alerts, and elect to have an order triggered.
Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active
through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition
to be satisfied..." box.

Set Margin Cushion Alerts
The Alerts window is composed of two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.
Margin Alerts
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Margin Cushion alerts are based on the status of an IB-calculated "margin cushion" derived using current
values from your account. You can find these values on the Account screen. The margin cushion is
calculated as follows:
(Equity with Loan Value - Maintenance Margin)/Net Liquidation Value

To set a Margin Cushion alert

From Mosaic
1. Right-click an instrument from your Portfolio, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
3. In the Configure Price Condition box, click Advanced Settings in the bottom right corner.
4. Begin to set the alert conditions by selecting Margin Cushion in the Choose Condition section of the
Create Condition box, then click Next.
5. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
6. In the Cushion (%) field, enter the value that will be acted on by the operator defined above, and
click the Finish button.

TWS Guide

884

Chapter 1

Set Margin Cushion Alerts

7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line following the above steps 3 - 7.

From Classic TWS
1. On the Analytical Tools menu select Alerts.
2. Click the New button, and enter a descriptive title in the Name box. The <unnamed> tab takes the
name you enter.
3. Define an asset in the Conditions area by dragging and dropping one from your trading screen, or
click the Add button.
4. Begin to set the alert conditions by selecting Margin Cushion in the Choose Condition section of the
Create Condition box, then click Next.
5. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
6. In the Cushion (%) field, enter the volume value that will be acted on by the operator defined
above, and click the Finish button.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line following the above steps 3 - 7.
Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message and
audio alerts, and elect to have an order triggered.
Alerts Duration
Allow the alert to remain active even after it has triggered by selecting the "Repeatable" box.
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active
through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition
to be satisfied..." box.
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Set P&L Alerts
The Alerts window comprises two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.

To set a Daily P&L alert

From Mosaic
1. Right-click an instrument from your Portfolio, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
3. In the Configure Price Condition box, click Advanced Settings in the bottom right corner.
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4. Begin to set the alert conditions by selecting Daily P&L in the Choose Condition section of the
Create Condition box, then click Next.
5. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
6. In the Daily P&L field, enter the value that will be acted on by the operator defined above, and click
the Finish button.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line following the above steps 3 - 7.

From Classic TWS
1. On the Analytical Tools menu select Alerts.
2. Click the New button, and enter a descriptive title in the Name box. The <unnamed> tab takes the
name you enter.
3. Define an asset in the Conditions area by dragging and dropping one from your trading screen, or
click the Add button.
4. Begin to set the alert conditions by selecting Daily P&L in the Choose Condition section of the
Create Condition box, then click Next.
5. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
6. In the Daily P&L field, enter the volume value that will be acted on by the operator defined
above, and click the Finish button.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line following the above steps 3 - 7.
Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message and
audio alerts, and elect to have an order triggered.
Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active
through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition
to be satisfied..." box.
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Set Trade Alerts
Set up an alert that triggers when the specified instrument is traded.
The Alerts window is composed of two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.

To set a Trade alert
1. Right-click an instrument from your Portfolio, Quote Monitor, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
3. In the Configure Price Condition box, click Advanced Settings in the bottom right corner.
4. Begin to set the alert conditions by selecting Trade in the Choose Condition section of the Create
Condition box, then click Next.
5. Modify the Underlying, Exchange and Type values if needed and click the Finish button.
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6. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line.
Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message and
audio alerts, and elect to have an order triggered.
Alerts Duration
Allow the alert to remain active even after it has triggered by selecting the "Repeatable" box.
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active
through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition
to be satisfied..." box.

Set Percentage Change Alerts
Set up an alert that triggers if the price of an instrument changes by plus/minus the specified percentage.
The Alerts window is composed of two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.
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To set up a Percentage Change alert
1. Right-click an instrument from your Portfolio, Quote Monitor, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
3. In the Configure Price Condition box, click Advanced Settings in the bottom right corner.
4. Begin to set the alert conditions by selecting Percentage Change in the Choose Condition section of
the Create Condition box, then click Next.
5. Modify the instrument if needed, then in the Operator field, choose from "greater than or equal to" or
"less than or equal to."
6. In the Percentage Change field, enter the value that will be acted on by the operator defined
above, and click the Finish button.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line.
Your alert conditions are described in the Preview box at the bottom right of the window.
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Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message and
audio alerts, and elect to have an order triggered.
Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active
through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition
to be satisfied..." box.

Set Volume Alerts
The Alerts window is composed of two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.
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To set a volume alert

From Mosaic
1. Right-click an instrument from your Portfolio, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
3. In the Configure Price Condition box, click Advanced Settings in the bottom right corner.
4. Begin to set the alert conditions by selecting Volume in the Choose Condition section of the Create
Condition box, then click Next.
5. On the Configure Volume Condition page, enter an underlying if you have a blank field and select the
rest of the instrument description parameters including instrument type and exchange.
6. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
7. In the Volume field, enter the volume value that will be acted on by the operator defined above, and
click the Finish button.
8. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line following the above steps 3 - 7.

From Classic TWS
1. On the Analytical Tools menu select Alerts.
If you're already in the Alerts box, click the Alerts tab to gain access to the New button. Continue
with Step 2 below.
2. Click the New button, and enter a descriptive title in the Name box. The <unnamed> tab takes the
name you enter.
3. Define an asset in the Conditions area by dragging and dropping one from your trading screen, or
click the Add button.
4. Begin to set the alert conditions by selecting Volume in the Choose Condition section of the Create
Condition box, then click Next.
5. On the Configure Volume Condition page, enter an underlying if you have a blank field and select the
rest of the instrument description parameters including instrument type and exchange.
6. In the Operator field, choose from "greater than or equal to" or "less than or equal to."
7. In the Volume field, enter the volume value that will be acted on by the operator defined above, and
click the Finish button.
8. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line following the above steps 3 - 7.
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Your alert conditions are described in the Preview box at the bottom right of the window.
Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message and
audio alerts, and elect to have an order triggered.
Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active
through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition
to be satisfied..." box.

Set up a Rebate Rate in Percent Alert
Set up an alert that triggers if the rebate rate on a specified instrument greater than, less than or equal to
the user-defined rate percent.
The Alerts window is composed of two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.
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To set up a Rebate Rate % alert
1. Right-click an instrument from your Portfolio, Quote Monitor, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
3. In the Configure Price Condition box, click Advanced Settings in the bottom right corner.
4. Begin to set the alert conditions by selecting Rebate Rate in the Choose Condition section of the
Create Condition box, then click Next.
5. Modify the instrument if needed, then in the Operator field, choose from "greater than or equal to" or
"less than or equal to."
6. In the Rebate Rate in % field, enter the value that will be acted on by the operator defined
above, and click the Finish button.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line.
Your alert conditions are described in the Preview box at the bottom right of the window.
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Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message and
audio alerts, and elect to have an order triggered.
Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active
through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition
to be satisfied..." box.

Create a Shortable Shares Alert
Set up an alert that triggers if a specified number of shares of a certain instrument become available to
short.
The Alerts window is composed of two sections. The first is the Conditions area, where you define the
conditions which must be met to activate the alert. The second is the Actions area, where you define the
action that will occur when the conditions are met. Create alerts based on price movement, time and date,
trading volume or the state of your margin cushion. Alert actions include sending a notification such as a
pop-up message on your trading screen, an email or a text message, or initiating an order, specifically a
buy or sell order.
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To set up a Shortable Shares alert
1. Right-click an instrument from your Portfolio, Quote Monitor, Watchlist or other window.
2. At the end of the quick-trade button bar, click the "Alert" bell icon.
3. In the Configure Price Condition box, click Advanced Settings in the bottom right corner.
4. Begin to set the alert conditions by selecting Shortable Shares in the Choose Condition section of
the Create Condition box, then click Next.
5. Modify the instrument if needed, then in the Operator field, choose from "greater than or equal to" or
"less than or equal to."
6. In the Shortable Shares field, enter the value that will be acted on by the operator defined
above, and click the Finish button.
7. To define multiple conditions, select And or Or from the Logic drop-down list, and add another contract on the next line.
Your alert conditions are described in the Preview box at the bottom right of the window.
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Now specify the action(s) that the alert will trigger. You can select from email, SMS, pop-up message and
audio alerts, and elect to have an order triggered.
Alerts Duration
By default, the alert will remain active until you cancel it. You can elect to have the alert remain active
through a specific date and time by selecting Alert active until... and setting a date in the format
YYYYMMDD hh:mm:ss.
If you want the condition(s) to be able to trigger outside regular trading hours, check the "Allow condition
to be satisfied..." box.

Assign Actions to Alerts
Assign Message Action to Alerts
Assign Order Action to Alerts
Assign Audio Action to Alerts
Assign Sounds to Events

Set Price Movement Alarms
For any asset, you can set a price-triggered alarm that goes off when the selected price hits the trigger
value. You can use values in the Bid, Ask and/or Last price fields as the triggers. The price field and page
title turn red and start to blink when your price has been reached. You can also set an audio alarm that
notifies you by beeping.
Note: Each line of market data with an attached price-activated alarm will always take up one live
market data line whether the page is open (active) or closed. You can only receive market data for
a limited number of live market data lines (usually 40).
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When you log off, any alarms you have set will be shut off unless you choose to preserve them between
sessions. To do this, select Preserve the alarm between sessions when you set the alarm.
To set a price movement alarm
1. Select the asset for which you want to set an alarm.
2. Right click and select Analytical Tools, then select Set Alarm.
3. In the Alarm Settings window, enter a "less than" and/or "greater than" price in any or all of the bid,
ask and last price entry fields.
4. To set a volume activated alarm, enter a trigger amount in the Alarm if volume is greater than
field.
5. To add a beeping sound to the visual alarm, select Play warning sound.
Example: If you enter a price of $40.15 in the second field on the top row, Alarm if bid is greater than,
your alarm will trigger when the bid price for the selected asset is greater than or equal to $40.15. Put a
price of $40.00 in the first field (Alarm is bid is less than) and the alarm will trigger is the bid is equal to or
falls below that price.
The default background color for all fields that have an alarm set is murky green. You can modify the
background color by using the Layout editor.
To shut off an activated price movement alarm
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Click in the market data line of the asset that has the alarm.

Set Volume Change-activated Alarm
For any asset, you can set a volume change-triggered alarm that goes off when the volume for the selected
asset rises by the amount you define. The Volume field and page title turn red and start to blink when the
volume has increased by your set amount. You can also set an audio alarm that notifies you by beeping.
Note: Each line of market data with an attached alarm will always take up one live market data line
whether the page is open (active) or closed. You can only receive market data for a limited number
of live market data lines (usually 40).
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When you log off,. any alarms you have set will be shut off unless you choose to preserve them between
sessions. To do this, select Preserve the alarm between sessions when you set the alarm.
To set a volume change alarm
1. Select the asset for which you want to set an alarm.
2. Right-click and select Analytical Tools, then select Set Alarm.
3. In the Alarm Settings window, enter a trigger amount in the Alarm if volume is greater than
field.
4. To add a beeping sound to the visual alarm, check Play warning sound.
If you have the Volume field displayed on your trading screen, you will see the default background color on
market data lines that have alarms set is murky green. You can modify the background color by using the
Layout editor.
To shut off an activated volume increase alarm
Click in the market data line of the asset that has the alarm.
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Note: To hear sounds other than a beep on your computer, you must have a sound card installed.

Other Realtime Activity Tools
Pending Orders Page
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Best Price for Options using SmartRoutingSM
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Pending Orders Page
You can view working orders on the Pending page, as well as on any trading page that displays the
instrument. Once an order has been executed, it is removed from the Pending page and the execution
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report is displayed in the Trade log. If you have orders pending when you log in, the Pending page is
automatically displayed for your review.
You can view positions on the Pending page by displaying the Positions column using the Page Layout.

To view pending orders
On the Trading screen, click the Pending tab. When orders are working, the Pending tab title, along
with the title of the page on which the asset is displayed, is red.
You can also elect to display GTC orders on a separate Pending page from other orders.
To separate Pending order pages for GTCs
1. On the Edit menu select Global Configuration.
2. In the left pane, select Order, then select General.
3. In the right panel, check Display pending day and GTC orders on separate pages.
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Note: You can manage working orders from the Pending page, but you cannot create an order or
add a new market data line. You can also modify conditions for a conditional order from the
Pending page.
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Trader Dashboard
The real-time Trader Dashboard is an optional tool that can be displayed at the top of the pages tabset.
This customizable panel allows you to monitor data fields from your Account Information window, keep
abreast of the most recent activity for specific contracts, and view current real-time news headlines for
products in your portfolio and for any tickers you are watching.

To configure the Trader Dashboard
1. On the Edit menu, select Global Configuration.
2. In the left pane, click Trader Dashboard.
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3. Use checkboxes in the right pane to set the following:
Check Show news to display news headlines for any products in your portfolio and to alert you to
recent news on any tickers you elect to display.
To see only portfolio-relevant news, check Display News for products in portfolio only.
To only see indicators of recent news next to individual tickers that you are watching, check Display recent news indicator only.
Check Show price change in percentage to view the last price and price change values as percentages in ticker lines.
Check Show price change in value to view the last price change as an absolute value.
4. Click the Add Account Data button, and scroll down the list. Double-click each Account field that
you want to add to the dashboard. Each field you double-click is added to the Display Item list on the
configuration pane. Click OK to close the Add box.
The descriptions for Account Information fields are in the Account Information topic.
5. To add a last price/price change field for an instrument, enter the underlying in the Symbol field and
click Add Ticker, then define the parameters just as you do when you add market data to the trading
page. The last price/price change displays in red to indicate downward movement and blue to indicate upward movement.
6. Click OK. The Trader Dashboard is displayed at the top of your trading window, just above the
pages tabset.
You can change the display name for selected dashboard fields using the Change Label feature.

Bulletins and System Status
Notices concerning exchange issues, system problems and other trading information are announced
through bulletins and system status reports. Bulletins are announced by a flashing red "Bulletin" notification
along the top of the Menu bar.
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To read the current bulletin
Click the flashing red "Bulletin" notification.
To review bulletins
Click the Bulletin icon on the toolbar, or
From the View menu, select Bulletins.
Note: You can move and resize the Bulletins window (which opens when you perform any of the
above actions) so that it doesn't block out the critical information on your trading screen. The
system saves your settings and will always open the window to the size and location you specify.
To see the system status from the website
From the View menu, select IB Systems.

Audit Trails
This feature creates a file of daily trading activity that you can view from your browser. An audit file is
created each day, and is named using the day of the week. Each week, the existing daily files are
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overwritten by the new files using the same name. You can rename these daily files if you want to save
them.

To view an Audit Trail
1. From the Account menu, selectAudit Trail.
2. Select a day up to 5 days back.
3. Choose Condensed or Expanded form, and click OK.
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Best Price for Options using SmartRoutingSM
Option traders who use SmartRouting can see which exchange(s) are offering the best bid and ask price.
This information is displayed in the Bid Exch and Ask Exch fields on the Market Data line. Each exchange is
represented by a single alpha character as defined in the table below. If multiple exchanges show an
identical "Best" price offering, then multiple alpha characters are displayed. For example, if "ACP" is
displayed in the Bid Exch column of a market data line, it means that AMEX, CBOE, and PSE are all
offering the identical highest bid price (shown in the Bid Price column) for the option. Valid exchange
abbreviations are:
Acronym

Exchange

A

AMEX

B

BOX

C

CBOE

I

ISE

P

PSE

X

PHLX

BT

BATS

W

CBOE2

Exchange abbreviations are always displayed in yellow. The Bid Price and Ask Price, Bid Size and Ask
Size colors convey the following information:
Color

Description
YELLOW indicates no change in price or size.
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GREEN indicates an upward movement in price or size.

ORANGE (or red) indicates a downward movement in price or
size.

PURPLE indicates that the best price is not executing
automatically at any of the exchanges displayed.

SmartRouting does not guarantee that your order will execute at the best displayed price. We display
prices in purple to illustrate that some exchanges are not automatically executing at the best price, and that
your order might execute at a different price. However, the availability of automatic execution updates with
every tick.
Note: ISE always executes automatically, but may not always be offering the best price and may
slow down their execution times in a fast market.
For more details on order routing and Smart Order routing, see the Customer Agreement on the IB
website.
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Understanding the Risk Navigator Interface
Sections of the Risk Navigator interface are described below.

The title bar shows the portfolio name and type, and displays the
menus.
The Risk Dashboard provides a snapshot view of key account metrics. It is always displayed at the top of the interface above the
Report Viewer regardless of the selected tab.
The tabset list provides easy navigation between asset types and
information sets.
The Report Viewer displays data that is driven by selections in the
Report Selector. It can be customized by adding and removing fields,

TWS Guide

912

Chapter 1

Open the Risk Navigator

resizing columns and resorting. The Report Viewer for each tab operates independently of all others; changes made to the Report Viewer
for one tab are not reflected in viewers for other tabs. This means
you will need to add desired fields to each Report Viewer.
The Portfolio Relative P&L Graph illustrates how the value of your
portfolio (or of the selected sub portfolio) will change based on percent changes in the price of the underlying.
The Report Selector controls the output displayed in the Report
Viewer and in the P&L Graph. Available selections in the drop down
lists vary based on the selected tab. For example, reports displayed
for the Equity tab may not be relevant in the Bond tab.

Open the Risk Navigator
The Risk NavigatorSM shows your portfolio risk for multiple asset classes, and allows you to:
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View and assess specific risk slices of your portfolio, such as risk by position, risk by underlying, and
risk by industry.
View the greek contract and position risk dimensions for each report.
Assess Value at Risk and check Margin Sensitivity.
Measure your portfolio P&L (from close-to-close) by Price Change/Volatility Change, and measure
exposure and the greek position dimensions by Underlying/Maturity.
Hypothetically modify your portfolio to test different risk scenarios before making actual changes.
Much more!
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To open Risk Navigator
From Mosaic - From the New Window drop down select Risk Navigator and then elect to open:

My Portfolio: This uses your actual live portfolio.
New What-If: Opens a new hypothetical test portfolio. You can elect to fill the what-if with a copy of
your current portfolio, or start with a blank frame and add positions manually.
Saved What-If: Invokes the Open file dialog box to the default directory of saved what-if portfolios
you may have created in the past.
From Classic TWS - From the Analytical Tools menu select Risk Navigator.
NOTE: If you don't see Risk Navigator in the list (in the Portfolio category), use the expand arrow at the
bottom of the list to display this choice.
IB Risk Navigator report data refreshes automatically every 10 seconds, and immediately whenever an
order executes, for all reports except the Measure by Price Change and Volatility Change. This report uses
prices from the close of the previous business day and calculates market outcome risk by advancing the
time parameter to the close of the next business day.

Change Font Size
By default, the Risk Navigator inherits its font and size from TWS, but you can change the font size in Risk
Navigator from the Volatility and Analytics page in Global Configuration.
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To change the font in Risk Navigator
Click the Configuration "wrench" icon in the Risk Navigator title bar and select Configure Font.
From the Risk Navigator Font section of the Volatility and Analytics configuration page, check Custom
Font Size and enter a size.
Click OK.

Risk Navigator Trader Personalities
To help make the default report fields more relevant for traders, Risk Navigator provides a "personality"
selector to drive the selection of fields on each report. You can add or remove fields from reports at any
time. To modify a single report, work directly in that report. To configure multiple reports, use the Report
Designer.
To choose a personality, from the Report menu select Personality.
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You can select a personality and have all reports changed by clicking Change and Reset Reports. To keep
your reports set up as is, select a personality and click Change. You can then modify the field layout on a
report-by-report basis using the Reset Report command on the Report menu.
To see the fields that are included by default in each personality, see the Fields per Report for Trader
Personalities topic.

Portfolio Relative P&L Graph
The Portfolio Relative P&L graph illustrates how the total value of your portfolio for a specific asset class
(or a subset of your portfolio) will change, based on a percent change in the price(s) of the underlying(s).
Available settings may change based on the asset class displayed.
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The image above shows the portfolio relative P&L for an equity portfolio, based on the value All
Underlyings selected from the Underlying list in the Report Selector.

For a single underlying, you can toggle between showing the absolute price or showing the underlying
price change as a percent. Click the price label below the horizontal price axis to select a display type.
Note that for leveraged ETFs, the Risk Navigator moves them by their target performance ratio in the
aggregated P&L graph. For example, for an index and its triple inverse ETF, to the +10% P&L it adds the

TWS Guide

919

Chapter 1

Portfolio Relative P&L Graph

index P&L at 10% to the ETF P&L at -30%. When either one is plotted individually, it shows their own P&L,
but it shows the index on a +/-30% range and the ETF on a +/-90% range.
Beta analysis in IB Risk Navigator allows the investor to view the P&L plot differently. In its default format
"Equal Percentage," the P&L plot assumes a same percentage move for all underlying portfolio pieces.
When Beta Weighted Aggregation is selected, the underlying price scenario includes beta weighted price
changes. Beta explains the performance of a stock over and above that associated only with the
performance of the market itself.
The Confidence Interval, shown within the yellow vertical lines, illustrates the worst-case loss over a oneday period with a default 99.5% confidence level. Use the Confidence sub-command on the
Settings menu to toggle between 95%, 99% and 99.5% confidence levels. Turn the Confidence Level
brackets on or off using the Confidence Interval command on the right-click menu.
For portfolios containing options or volatility products (like VIX or its derivatives), vol-coordinated price
changes show the effect of a change in market price level and a corresponding simultaneous change in
volatility level. In scenarios where stock prices are down X%, vols are assumed to simultaneously increase
by up to (10*X)% for short-dated options, decaying gradually to (2*X)% for options with longer expiries.
Conversely, in scenarios with stock prices up X%, vols are assumed to be down X% for short-dated
options, decaying to (X/5)% for longer expiries.
Curves generated using these coordinated volatility changes will be marked "Vol.Coord.", and will be
displayed together with a tool tip detailing the scenarios used.
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Use the Vol-up by 15%*, Vol-down by 15%* and reduced time to expiry by 1 day checkboxes in the rightclick menu to view the plot under different scenarios to help you visualize the volatility and time risk in your
option positions. While you can elect to display the base P&L using both the previous day’s closing price
and the most recent dynamic price, the volatility and time variables are always based on the previous close.
*The Vol Up and Vol Down commands increase/decrease projected volatility in relative percent change.
Relative percent change is calculated by multiplying the current implied volatility by 15%, and
adding/subtracting this value to/from the current implied volatility. For example, if the current implied
volatility of an option is 10%, a 15% relative increase would result in an implied volatility of 11.5%,
calculated as follows: 10 + (10 * 0.15) = 11.5% . If the current implied volatility of an option is 42.45%, a
15% relative decrease would result in an implied volatility of 36.082%, calculated as follows: 42.45 - (42.45
* 0.15) = 36.082%.

When the Vertical Crosshair is activated on the P&L graph using the right-click menu, you will get mouseover help at any price-change percentage point.
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For Bonds, the P&L plot is based on the interest rate change.
In cases where the index price is invalid for futures/futures options, the graph provides a drop-down
selector with available expirations to use for the reference price. Ensure that the "Underlying" field in the
report selector has only one contract selected.

Risk Dashboard
The Risk Dashboard is pinned along the top of the product tabsets, and is available for what-if as well as
active portfolios. The values are calculated on demand for what-if portfolios. The dashboard provides at-aglance account information including:
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Dashboard Field

Description

Net Liquidation

The total Net Liquidation value for the account.
This value is taken from the Total Net
Liquidation Value field in the Account
Information window.

P&L

The total daily P&L for the entire portfolio.
This value is taken from the "All Contracts" level
of the Risk Navigator P&L tab in the P&L for the
Day field.

Maintenance Margin

Total current maintenance margin. Use this to
see margin for a hypothetical what-if portfolio as
well as for your current portfolio.
This value is taken from the Margin
Requirements section in the Account
Information window.

Initial Margin

Total initial margin requirements. Use this to
see margin for a hypothetical what-if portfolio as
well as for your current portfolio.
This value is taken from the Margin
Requirements section in the Account
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Information window.

VAR

Shows the Value at Risk for the entire portfolio. VAR is a measure of the largest anticipated loss over a specified time period
and confidence level, where the confidence level provides the probability that
the VAR measure will not be exceeded.

Expected Shortfall

Expected Shortfall (average value at risk)

(ES)

is the expected return of the portfolio in the
worst case; the average of all losses
which are greater or equal than VaR.

Average Beta

The sum of the raw beta (the beta on the
underlying) beta across the entire portfolio
divided by the number of positions.

Portfolio Beta

The sum of the weighted beta for all positions. This sum is also reflected in the top
total row of the Weighted Beta column.

To hide or display the dashboard
From the View menu, select Risk Dashboard.

Stock Yield On Demand
The Stock Yield Enhancement Program allows you to earn extra income on the fully-paid shares of stock
held in your account. You can find out what your potential extra earned income would be at any time using
the Stock Yield report.
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Create a Basket Hedge Order
Display the Hedge metric on the Risk by Underlying and Risk by Industry reports to create a basket of delta
hedge orders.

To create a basket hedge
1. Display the Hedge column from the Metrics menu.
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If the feature is grayed out on the Metrics menu, it's not supported for that report. The Hedge checkbox
functions at the aggregated level, and is only available in reports with a collapsible contract dimension, i.e.
Risk by Underlying, Risk by Industry, Risk by Country, Plot Data by Underlying etc.

2. Enable the checkbox in the Hedge column of an underlying for all subportfolios whose deltas you
want to hedge.
To select all subportfolios, use the checkbox in the All Underlyings top row.
3. When all contracts are selected, click the Hedge button in top right corner of the report.
4. Define the hedge order attributes and click OK:
Pick the order type (Limit, Market or Relative).
If you selected the Relative order type, define the relative offset amount
5. The BasketTrader opens, and the legs of the order reflect the subportfolios you selected in the Risk
Navigator.
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The Total Quantity for each leg is identical to the delta for the subportfolio, with the Action set to the
opposite side; if the delta is positive, the leg becomes a SELL order. If the delta is negative, the leg
becomes a BUY order.

You can save the basket for later use by clicking the Save button at the top right of the basket.
For more information on using basket orders, see the BasketTrader topic.
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Upload a Portfolio
You can import your portfolio into IB Risk Navigator using a .csv Excel spreadsheet. Positions are imported
into a hypothetical What-if. Once imported, you can create orders from the What-If to add the imported
positions to your actual portfolio.
You can also create a what-if and quickly populate it with your existing portfolio all from within the Risk
Navigator.
To create a .cvs file to import
Create an Excel spreadsheet.
Create a header row that contains the field headings. Field headings can be in any order. Valid header row
field titles include (but are not limited to) the below:
Action - Buy, Sell
Quantity - 1, 100, etc.
Symbol - Underlying symbol
SecType - stk, opt, fut etc.
Exchange - SMART, NYSE etc
Currency
LastTradingDayOrContractMonth - 201506
Strike - 129, 56 etc
Right - Call, Put
DivPrt (dividend protected - for futures)
CUSIP
ISIN
If a field header is invalid or misspelled, you will receive an import error. Please double-check
that there are no typos in header names.
For each position you want to import, create a single row of parameters. IF the position does not require a
value, leave that cell blank.
Ensure that field values match the field label in the header row. For example, don't put the symbol "IBKR"
under the SecType field or the import will be rejected.
Save the spreadsheet with a .csv extension, making note of where you save it.
To import a .csv portfolio file into Risk Navigator
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Open the IB Risk Navigator.
a. From Mosaic, use the New Window dropdown.
b. From Classic TWS, use the Analytical Tools menu.
From the Portfolio menu select Import.
Navigate to the .csv file or enter the file name in the File Name field and click Open.
The imported orders are opened in a new What-If portfolio. Note that both Maintenance and Initial margin
values are displayed for the portfolio in the Risk Dashboard. If you have multiple asset types, use the tabset
to display risk for each type.

Increase Memory Size for TWS
Advanced users who manage large portfolios (over 500 stock or 100 options positions) or who
simultaneously use more than 15 chart windows may need to manually increase the amount of memory
allotted to TWS to accommodate the higher demands needed by both TWS and the Risk Navigator to
handle this kind of heavy load.
You can modify the memory size in Global Configuration. From the Mosaic File menu, select Global
Configuration. Choose General in the left pane, and enter an updated value in the Memory Allocation field.
You will need to shut down and restart TWS for this change to take effect.
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Alternatively, modifying the memory size requires that you open, edit and save the tws.vmoptions file.
Find the tws.vmoptions File

Standard Download: If you downloaded standard TWS software (Latest, Beta or stable) you will find this
file in the Jts folder which is typically in the C:\ directory on Windows/Linux machines, and in ~/ on the
Mac.
If you didn't specifically find and download the Offline TWS, you are using the standard TWS software.
For example, you will likely find the file in C:\Jts\tws.vmoptions (Windows and Linux) and in
~/Jts/tws.vmoptions (Mac). If you are having trouble finding this file among all of the "tws" files in
Windows file explorer, look in the "Type" column for VMOPTIONS File in all uppercase letters.
Offline Download: If you downloaded the Offline TWS software, you will find this file in a sub directory of
the Jts folder, named for the build version you downloaded.
For example, if you installed Offline TWS Latest when the latest version was 955.4, you will likely find the
file in C:\Jts\955\tws.vmoptions (Windows and Linux) and in ~/Jts/tws-955.vmoptions
(Mac).
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Edit the tws.vmoptions File

Open the file, and find the line that looks like: -Xmx768m. This defines the memory size currently being
used by TWS. In this example, it is 768 MB.
If you're running Window 10, consider opening and editing the file directly in Notepad. To open Notepad,
right-click the Start button and select Run. Type "notepad." Use the File>Open menu in Notepad and in the
Files of Type field change the filter to All Files. Navigate to C:/jts and find the tws.vmoptions file. Make
edits as shown then Save the file.
Modify the size (in MB). We recommend not to go above 2 GB (or 2000 MB) as this will likely degrade your
machine's overall performance.
Move this memory size line BELOW the line that says: ### keep on update. Otherwise, the setting
will revert to the default value when the version is updated.
The body of the file will look something like the below when you're done (note the highlighted lines at the
bottom of the file):

Save the file.
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Check that the memory has been upgraded the next time you log into TWS. From the Help menu select
About and check the max heap size in the Java Version section.

Risk Navigator Products and Tabs
Positions within each "product tab" are grouped by asset class, and the Report Viewer displays only those
reports available for a specific tab. Product categories are presented on different tabs

Equity Tab
All non-bond positions that cannot be clearly categorized into the other tabs are put into the equity tab. The
following reports are available for products on the Equity tab:
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Portfolio Report

Use the Portfolio report to view risk and exposure for all positions in your portfolio.
You can view totals for specific risk measures (where applicable) in the Risk by Underlying report.
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To open the Portfolio report
From the Report menu, choose Select Report and then select Portfolio.
Alternatively, use the Report Selector below the reports and in the Report drop down select
Portfolio.
Use the Plot, Underlying, Category, Currency, and Last Trading Day fields in the Report Selector to further
customize the report display.
Risk by Position Report

The Risk by Position report displays risk measures calculated for each position, by underlying.
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To view the Risk by Position report
1. On the Analytical Tools menu, selectRisk Navigator.
2. In the Report Viewer, select Risk by Position in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
If you elect to view metrics for only a single underlying, the report will not display the Underlying column as
shown above.
Use the Metrics menu to display available risk metrics.
Risk by Underlying Report

The Risk by Underlying report is designed to open by default when you open the IB Risk NavigatorSM.
This report displays portfolio metrics across all asset classes and provides drill-down depth control for each
underlying.
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To view the Risk by Underlying report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Underlying in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
Use the Metrics menu to display available risk metrics.
Risk by Industry Report

The Risk by Industry report sorts your portfolio by industry. This report displays values on all levels of
detail, from individual positions to totals per industry sector.
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To view the Risk by Industry report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Industry in the Report dropdown.
You can drill down several levels within an Industry category, and then drill down in the Underlying field for
that category to see all underlyings in the industry, and then all derivatives of the underlying. To drill down
to a deeper level of detail, click the plus "+" sign. A minus "-" sign indicates that you have drilled down to the
deepest level of detail. Click the "-" sign to go up a level.
Use the Metrics menu to display available risk metrics.
Risk by Country Report

The Risk by Country report sorts positions by country-related attributes that you specify from the Risk
Navigator Settings menu.
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To run the Risk by Country report
From the Risk Navigator main window, select the Bond tab.
In the Report field, select Risk by Country.
From the Settings menu, specify the Country sort criteria:
Registration - This is the country where the bond was issued.
Issuer Domicile - The domicile of the bond issuer.
Parent Domicile - The domicile of the parent company of the bond issuer.
Ultimate Parent Domicile - The domicile of the ultimate parent company of the bond issuer.
Plot Data by Underlying

Select this report to view values for the symmetric data slicers in the P&L Plot. By default the slicers are
spaced at +/- 3%, 6%, 9%, 12% and 15%.
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If you have the cross-hair activated in the P&L plot using the right-click menu, when you hold your mouse
over a line in the plot its value is displayed. Keep in mind that the domain of the P&L plot is determined by
the intersection of the valid domains for each instrument in the portfolio. This may restrict the domain of
accessible values, especially for beta-weighted plots.
To open the Plot Data by Underlying report
Open the Risk Navigator
a. From Mosaic - Use the New Window drop down and select Risk Navigator from the
Advanced Trading Tools category.
b. From Classic TWS - Use the Analytical Tools menu and select Risk Navigator from the
Portfolio category.
From the Report drop down list, select Plot Data by Underlying.
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To change the interval between plot slicers
From within the plot, drag any of the blue slicer lines in an out to change the interval. Note that the
corresponding negative/positive line will also adjust.
Using the menu, from the Metrics menu select Plot data columns and then select Settings.
Measure by Underlying and Maturity

The Measure by Underlying and Maturity matrix displays risk by measure for all underlyings, sorted by
Last Trading Day. The measure, which you selected in the Measure dropdown of the Report Selector, is
displayed along the top of the matrix. The Last Trading Day fields display the sum of all positions
(measures) for the given underlying/LTD.
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To view the Measure by Underlying and Maturity report
On the Analytical Tools menu, select Risk Navigator.
In the Report Viewer, select Measure by Underlying and Maturity in the Report dropdown.
Use the Metrics menu to display available risk metrics.
Measure by Price Change and Volatility Change

This report uses the Risk FactorySM system to calculate the theoretical price and a set of risk measures for
each position in your portfolio in each of the market outcome scenarios noted in the bulleted list below, and
measures the market outcome for the relative portfolio Delta, Gamma, Vega, and Theta.
You must "Download global risk" from the Settings menu to populate this report.
All other reports in the Risk Navigator use real-time data in their calculations, but values in this report are
calculated using the underlying and derivative prices on the close of the previous business day, at multiple
positive, negative, and zero percent change scenarios in the underlying price, volatility and interest rate.
Scenarios for each value are:
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Underlying price scenarios: -30%, -20%, -10%, unchanged, +10%, +20%, +30%
Volatility scenarios: -30%, -15%, unchanged, +15%, +30%
Interest rate scenarios: -100 bp, -50 bp, unchanged, +50 bp, +100 bp
The scenarios advance the time parameter to the close of the next business day, and the values in the table
reflect the scenarios applied to the measure you picked in the Report Selector. Although 175 market
outcome scenarios (7x5x5) are calculated for each contract, you can only view a flat slice of these values at
one time, due to the limitations imposed by our 2-dimensional display capabilities.

To view the Measure by Price Change and Volatility Change report
1. From the Risk Navigator Report Viewer, select Measure by Price Change and Volatility Change in
the Report dropdown.
2. From the Settings menu, select Download global risk.
3. Use the Dimensions>Scenario Risk Matrix menu to change the row and column values to view different scenarios.
You can apply market scenarios to other IB Risk Navigator reports using the drill through feature.
Portfolio Statistics Report

The Portfolio Statistics report shows two summary tables: one for all Stock and Futures positions, and
one for all Options positions.
The Stock and Future summaries shows all long positions, all short positions, the net and gross units, and
their corresponding total value.
The Option/Warrant summary shows all long calls, long puts, the sum of both calls and puts, and the total
value; all short calls, short puts, the sum of both calls and puts, and the total value; the net units for calls,
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puts, the sum of both and the total net value; and gross units for calls, puts the sum of both, and the
corresponding net value.
The Cash balance summary shows you total in base, and all cash totals for currencies in your portfolio.
The Opaque Positions list displays positions for which risk cannot be calculated. While these positions are
not included in any risk reports, the market value is included in the Portfolio Value version of the P&L graph.

To view the Portfolio Statistics report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Portfolio Statistics in the Report dropdown.
Value at Risk Report

The Value at Risk report shows the greatest loss that a portfolio will sustain over a one-day period, with
either 95%, 99.5% or 99.5% confidence. VAR is calculated using three different methods, each with
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different assumptions about correlations of the underlying assets in the portfolio. This report is only
available in the Equity tab and is calculated in real-time using the P&L plot data. To see VAR for you entire
portfolio, use the VAR tab.

Worst Case -Calculates the worst case price movement between the selected confidence interval for
each underlying independently. Note that the VAR column in the Risk by Underlying report contains
the same values.
Perfect Correlation - Assumes each underlying in your portfolio moves perfectly correlated with the
S&P 500, and calculates the worst case price movement between the confidence interval of SPX.
Index Correlated Price Estimate - Assigns a correlation (Beta) to each underlying in your portfolio to
the S&P 500 (used as a reference index), and then looks for the worst loss within its adjusted confidence level.
To view the VAR report
Open the Risk Navigator.
a. From Mosaic - Use the New Window drop down and select Risk Navigator from the
Advanced Trading Tools category.
b. From Classic TWS - Use the Analytical Tools menu and select Risk Navigator from the
Portfolio category.
From the Report field, select Value at Risk.

TWS Guide

944

Chapter 1

P&L Pie Chart

P&L Pie Chart

The P&L Pie Chart shows the position Delta and P&L for all positions in your portfolio relative to the total
portfolio. Use default color coding to see losing positions in red, profiting positions in green and neutral
positions in blue, or change the coloring to display each position using a different color.
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To view the P&L Pie Chart
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1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Selector, select P&L Pie Chart from the Report dropdown.

Bond Tab
All bill, bond and note positions can be found on the Bond tab. The following reports are available for
bonds:

Risk by Position Report

The Risk by Position report displays risk measures calculated for each position, by underlying.
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To view the Risk by Position report
1. On the Analytical Tools menu, selectRisk Navigator.
2. In the Report Viewer, select Risk by Position in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
If you elect to view metrics for only a single underlying, the report will not display the Underlying column as
shown above.
Use the Metrics menu to display available risk metrics.
Risk by Issuer

Sorts bonds by issuer.
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To view the Risk by Issuer Report
From within Risk Navigator, select the Bond tab.
In the Report drop down, select Risk by Issuer.
Risk by Industry Report

The Risk by Industry report sorts your portfolio by industry. This report displays values on all levels of
detail, from individual positions to totals per industry sector.
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To view the Risk by Industry report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Industry in the Report dropdown.
You can drill down several levels within an Industry category, and then drill down in the Underlying field for
that category to see all underlyings in the industry, and then all derivatives of the underlying. To drill down
to a deeper level of detail, click the plus "+" sign. A minus "-" sign indicates that you have drilled down to the
deepest level of detail. Click the "-" sign to go up a level.
Use the Metrics menu to display available risk metrics.
Risk by State Report

The Risk by State report sorts muni bonds by state.
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To run the Risk by State report
From the Risk Navigator main window, select the Bond tab.
In the Report field, select Risk by State.
Risk by Country Report

The Risk by Country report sorts positions by country-related attributes that you specify from the Risk
Navigator Settings menu.
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To run the Risk by Country report
From the Risk Navigator main window, select the Bond tab.
In the Report field, select Risk by Country.
From the Settings menu, specify the Country sort criteria:
Registration - This is the country where the bond was issued.
Issuer Domicile - The domicile of the bond issuer.
Parent Domicile - The domicile of the parent company of the bond issuer.
Ultimate Parent Domicile - The domicile of the ultimate parent company of the bond issuer.

Forex Tab
This page displays ultimate underlyings of the cash contract class, indexes categorized as "Foreign
Exchange Index" and any linked ETFs (each underlying is mapped to an FX contract). Presented positions
are grouped by the primary Forex underlying contract.
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Note: All FX underlyings (EUR/USD, EUR/JPY etc) are decompressed into one or two primary FX
contracts with the reference currency as denominator, for example CHF/GBP is decompressed to
(CHF/USD) / (GBP/USD), if the reference currency is USD. The primary FX contract prices are assumed
to move in tandem, either with the same percentage or in the same direction but with different volatilities.
All of the subportfolio ultimate underlying moves are composed from these primary FX moves.
Real FX positions are not supported in the Risk Navigator, but the cash balance of a currency is translated
into a Forex position. The denominator of the forex contract is the current portfolio reference currency. E.g
a cash balance of 1120.23 EUR is translated into 1120.23 EUR/USD forex position assuming USD is the
portfolio reference currency.
The following portfolio reports are available for forex products:

Portfolio Report

Use the Portfolio report to view risk and exposure for all positions in your portfolio.
You can view totals for specific risk measures (where applicable) in the Risk by Underlying report.
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To open the Portfolio report
From the Report menu, choose Select Report and then select Portfolio.
Alternatively, use the Report Selector below the reports and in the Report drop down select
Portfolio.
Use the Plot, Underlying, Category, Currency, and Last Trading Day fields in the Report Selector to further
customize the report display.
Risk by Position Report

The Risk by Position report displays risk measures calculated for each position, by underlying.
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To view the Risk by Position report
1. On the Analytical Tools menu, selectRisk Navigator.
2. In the Report Viewer, select Risk by Position in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
If you elect to view metrics for only a single underlying, the report will not display the Underlying column as
shown above.
Use the Metrics menu to display available risk metrics.
Risk by Underlying Report

The Risk by Underlying report is designed to open by default when you open the IB Risk NavigatorSM.
This report displays portfolio metrics across all asset classes and provides drill-down depth control for each
underlying.
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To view the Risk by Underlying report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Underlying in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
Use the Metrics menu to display available risk metrics.
Plot Data by Underlying

Select this report to view values for the symmetric data slicers in the P&L Plot. By default the slicers are
spaced at +/- 3%, 6%, 9%, 12% and 15%.
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If you have the cross-hair activated in the P&L plot using the right-click menu, when you hold your mouse
over a line in the plot its value is displayed. Keep in mind that the domain of the P&L plot is determined by
the intersection of the valid domains for each instrument in the portfolio. This may restrict the domain of
accessible values, especially for beta-weighted plots.
To open the Plot Data by Underlying report
Open the Risk Navigator
a. From Mosaic - Use the New Window drop down and select Risk Navigator from the
Advanced Trading Tools category.
b. From Classic TWS - Use the Analytical Tools menu and select Risk Navigator from the
Portfolio category.
From the Report drop down list, select Plot Data by Underlying.
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To change the interval between plot slicers
From within the plot, drag any of the blue slicer lines in an out to change the interval. Note that the
corresponding negative/positive line will also adjust.
Using the menu, from the Metrics menu select Plot data columns and then select Settings.
Portfolio Statistics Report

The Portfolio Statistics report shows two summary tables: one for all Stock and Futures positions, and
one for all Options positions.
The Stock and Future summaries shows all long positions, all short positions, the net and gross units, and
their corresponding total value.
The Option/Warrant summary shows all long calls, long puts, the sum of both calls and puts, and the total
value; all short calls, short puts, the sum of both calls and puts, and the total value; the net units for calls,
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puts, the sum of both and the total net value; and gross units for calls, puts the sum of both, and the
corresponding net value.
The Cash balance summary shows you total in base, and all cash totals for currencies in your portfolio.
The Opaque Positions list displays positions for which risk cannot be calculated. While these positions are
not included in any risk reports, the market value is included in the Portfolio Value version of the P&L graph.

To view the Portfolio Statistics report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Portfolio Statistics in the Report dropdown.
P&L Pie Chart

The P&L Pie Chart shows the position Delta and P&L for all positions in your portfolio relative to the total
portfolio. Use default color coding to see losing positions in red, profiting positions in green and neutral
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positions in blue, or change the coloring to display each position using a different color.

To view the P&L Pie Chart
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1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Selector, select P&L Pie Chart from the Report dropdown.

Commodity Tab
The Commodity Tab displays contracts with an ultimate underlying categorized as "Commodity" or
"Commodity Index." Commodity positions are grouped by product category.
The following reports are available for your portfolio's commodity products:

Portfolio Report

Use the Portfolio report to view risk and exposure for all positions in your portfolio.
You can view totals for specific risk measures (where applicable) in the Risk by Underlying report.

To open the Portfolio report
From the Report menu, choose Select Report and then select Portfolio.
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Alternatively, use the Report Selector below the reports and in the Report drop down select
Portfolio.
Use the Plot, Underlying, Category, Currency, and Last Trading Day fields in the Report Selector to further
customize the report display.
Risk by Position Report

The Risk by Position report displays risk measures calculated for each position, by underlying.

To view the Risk by Position report
1. On the Analytical Tools menu, selectRisk Navigator.
2. In the Report Viewer, select Risk by Position in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
If you elect to view metrics for only a single underlying, the report will not display the Underlying column as
shown above.
Use the Metrics menu to display available risk metrics.
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Risk by Underlying Report

The Risk by Underlying report is designed to open by default when you open the IB Risk NavigatorSM.
This report displays portfolio metrics across all asset classes and provides drill-down depth control for each
underlying.

To view the Risk by Underlying report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Underlying in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
Use the Metrics menu to display available risk metrics.
Plot Data by Underlying

Select this report to view values for the symmetric data slicers in the P&L Plot. By default the slicers are
spaced at +/- 3%, 6%, 9%, 12% and 15%.
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If you have the cross-hair activated in the P&L plot using the right-click menu, when you hold your mouse
over a line in the plot its value is displayed. Keep in mind that the domain of the P&L plot is determined by
the intersection of the valid domains for each instrument in the portfolio. This may restrict the domain of
accessible values, especially for beta-weighted plots.
To open the Plot Data by Underlying report
Open the Risk Navigator
a. From Mosaic - Use the New Window drop down and select Risk Navigator from the
Advanced Trading Tools category.
b. From Classic TWS - Use the Analytical Tools menu and select Risk Navigator from the
Portfolio category.
From the Report drop down list, select Plot Data by Underlying.
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To change the interval between plot slicers
From within the plot, drag any of the blue slicer lines in an out to change the interval. Note that the
corresponding negative/positive line will also adjust.
Using the menu, from the Metrics menu select Plot data columns and then select Settings.
Portfolio Statistics Report

The Portfolio Statistics report shows two summary tables: one for all Stock and Futures positions, and
one for all Options positions.
The Stock and Future summaries shows all long positions, all short positions, the net and gross units, and
their corresponding total value.
The Option/Warrant summary shows all long calls, long puts, the sum of both calls and puts, and the total
value; all short calls, short puts, the sum of both calls and puts, and the total value; the net units for calls,

TWS Guide

965

Chapter 1

P&L Pie Chart

puts, the sum of both and the total net value; and gross units for calls, puts the sum of both, and the
corresponding net value.
The Cash balance summary shows you total in base, and all cash totals for currencies in your portfolio.
The Opaque Positions list displays positions for which risk cannot be calculated. While these positions are
not included in any risk reports, the market value is included in the Portfolio Value version of the P&L graph.

To view the Portfolio Statistics report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Portfolio Statistics in the Report dropdown.
P&L Pie Chart

The P&L Pie Chart shows the position Delta and P&L for all positions in your portfolio relative to the total
portfolio. Use default color coding to see losing positions in red, profiting positions in green and neutral
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positions in blue, or change the coloring to display each position using a different color.

To view the P&L Pie Chart
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1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Selector, select P&L Pie Chart from the Report dropdown.

Money Market Tab
The Money Market tab display ultimate underlyings categorized as Financial Index” or “Financial Notional”.
The product categories of FUT and FOP are either “Fixed Income” or “Money Market.” Money Market
positions are grouped by currency.
The following reports are available for Money Market products in your portfolio:

Portfolio Report

Use the Portfolio report to view risk and exposure for all positions in your portfolio.
You can view totals for specific risk measures (where applicable) in the Risk by Underlying report.

To open the Portfolio report
From the Report menu, choose Select Report and then select Portfolio.
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Alternatively, use the Report Selector below the reports and in the Report drop down select
Portfolio.
Use the Plot, Underlying, Category, Currency, and Last Trading Day fields in the Report Selector to further
customize the report display.
Risk by Position Report

The Risk by Position report displays risk measures calculated for each position, by underlying.

To view the Risk by Position report
1. On the Analytical Tools menu, selectRisk Navigator.
2. In the Report Viewer, select Risk by Position in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
If you elect to view metrics for only a single underlying, the report will not display the Underlying column as
shown above.
Use the Metrics menu to display available risk metrics.
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Risk by Underlying Report

The Risk by Underlying report is designed to open by default when you open the IB Risk NavigatorSM.
This report displays portfolio metrics across all asset classes and provides drill-down depth control for each
underlying.

To view the Risk by Underlying report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Underlying in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
Use the Metrics menu to display available risk metrics.
Plot Data by Underlying

Select this report to view values for the symmetric data slicers in the P&L Plot. By default the slicers are
spaced at +/- 3%, 6%, 9%, 12% and 15%.
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If you have the cross-hair activated in the P&L plot using the right-click menu, when you hold your mouse
over a line in the plot its value is displayed. Keep in mind that the domain of the P&L plot is determined by
the intersection of the valid domains for each instrument in the portfolio. This may restrict the domain of
accessible values, especially for beta-weighted plots.
To open the Plot Data by Underlying report
Open the Risk Navigator
a. From Mosaic - Use the New Window drop down and select Risk Navigator from the
Advanced Trading Tools category.
b. From Classic TWS - Use the Analytical Tools menu and select Risk Navigator from the
Portfolio category.
From the Report drop down list, select Plot Data by Underlying.
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To change the interval between plot slicers
From within the plot, drag any of the blue slicer lines in an out to change the interval. Note that the
corresponding negative/positive line will also adjust.
Using the menu, from the Metrics menu select Plot data columns and then select Settings.
Portfolio Statistics Report

The Portfolio Statistics report shows two summary tables: one for all Stock and Futures positions, and
one for all Options positions.
The Stock and Future summaries shows all long positions, all short positions, the net and gross units, and
their corresponding total value.
The Option/Warrant summary shows all long calls, long puts, the sum of both calls and puts, and the total
value; all short calls, short puts, the sum of both calls and puts, and the total value; the net units for calls,
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puts, the sum of both and the total net value; and gross units for calls, puts the sum of both, and the
corresponding net value.
The Cash balance summary shows you total in base, and all cash totals for currencies in your portfolio.
The Opaque Positions list displays positions for which risk cannot be calculated. While these positions are
not included in any risk reports, the market value is included in the Portfolio Value version of the P&L graph.

To view the Portfolio Statistics report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Portfolio Statistics in the Report dropdown.
P&L Pie Chart

The P&L Pie Chart shows the position Delta and P&L for all positions in your portfolio relative to the total
portfolio. Use default color coding to see losing positions in red, profiting positions in green and neutral
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positions in blue, or change the coloring to display each position using a different color.

To view the P&L Pie Chart
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1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Selector, select P&L Pie Chart from the Report dropdown.

Structured Products Tab
Structured products are partially supported in Risk Navigator, and are presented with only the position
size, price and P&L without any additional calculated risk measures.
The following reports are available for structured products in your portfolio:

Portfolio Report

Use the Portfolio report to view risk and exposure for all positions in your portfolio.
You can view totals for specific risk measures (where applicable) in the Risk by Underlying report.

To open the Portfolio report
From the Report menu, choose Select Report and then select Portfolio.

TWS Guide

975

Chapter 1

Risk by Position Report

Alternatively, use the Report Selector below the reports and in the Report drop down select
Portfolio.
Use the Plot, Underlying, Category, Currency, and Last Trading Day fields in the Report Selector to further
customize the report display.
Risk by Position Report

The Risk by Position report displays risk measures calculated for each position, by underlying.

To view the Risk by Position report
1. On the Analytical Tools menu, selectRisk Navigator.
2. In the Report Viewer, select Risk by Position in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
If you elect to view metrics for only a single underlying, the report will not display the Underlying column as
shown above.
Use the Metrics menu to display available risk metrics.
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Risk by Underlying Report

The Risk by Underlying report is designed to open by default when you open the IB Risk NavigatorSM.
This report displays portfolio metrics across all asset classes and provides drill-down depth control for each
underlying.

To view the Risk by Underlying report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Underlying in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
Use the Metrics menu to display available risk metrics.
Risk by Industry Report

The Risk by Industry report sorts your portfolio by industry. This report displays values on all levels of
detail, from individual positions to totals per industry sector.
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To view the Risk by Industry report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Industry in the Report dropdown.
You can drill down several levels within an Industry category, and then drill down in the Underlying field for
that category to see all underlyings in the industry, and then all derivatives of the underlying. To drill down
to a deeper level of detail, click the plus "+" sign. A minus "-" sign indicates that you have drilled down to the
deepest level of detail. Click the "-" sign to go up a level.
Use the Metrics menu to display available risk metrics.
Portfolio Statistics Report

The Portfolio Statistics report shows two summary tables: one for all Stock and Futures positions, and
one for all Options positions.
The Stock and Future summaries shows all long positions, all short positions, the net and gross units, and
their corresponding total value.
The Option/Warrant summary shows all long calls, long puts, the sum of both calls and puts, and the total
value; all short calls, short puts, the sum of both calls and puts, and the total value; the net units for calls,
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puts, the sum of both and the total net value; and gross units for calls, puts the sum of both, and the
corresponding net value.
The Cash balance summary shows you total in base, and all cash totals for currencies in your portfolio.
The Opaque Positions list displays positions for which risk cannot be calculated. While these positions are
not included in any risk reports, the market value is included in the Portfolio Value version of the P&L graph.

To view the Portfolio Statistics report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Portfolio Statistics in the Report dropdown.

Volatility Products
The same risk measure can have a qualitatively different financial meaning, depending on whether or not it
is applied to a volatility product.
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The Volatility Products tab collects these products separately from their underlyings. The Delta measured
on this tab represents a risk commensurate to Vega on the Equity tab.
The risk measures (Greeks) shown for volatility products are the same as those for equity products.
However, it is important to understand that their financial meaning can be quite different.

Volatility Products Tab

Volatility indices, published daily by exchanges, allow implied volatility levels to be traded directly. Volatility
products, including derivatives on these indexes and funds such as ETFs, may help traders easily gain
exposure to volatility levels. Some notable volatility indices (with the underlying whose volatility is
measured, in parentheses) are:
VIX (SPX)
V2TX (STOXX)
NKVI (N225)
GVZ (GLD)
VXXLE (XLE)
VXAPL (AAPL)
Documentation for the computation methodology of these measures can be found on the various
exchange websites. Indexes are generally quoted in annual percentage terms, except for a small number
of interest-rate related indexes which are quoted in basis point terms. For example, VIX is the annualized
percentage volatility of SPX; a VIX of 1 means an SPX volatility of 0.01 or 1%. Consider a VIX call with
VIX-delta equal to 0.8. It would appreciate by 0.8 x 1 = 0.8 if VIX were to increase by 1. This is equivalent to
saying that the value of the VIX call will rise by 0.8 when the SPX volatility goes up by 1%, so the VIX call
has an SPX-vega of 0.8. (This uses the Risk Navigator convention: we present volatility in percentage
terms, and define vega as the derivative value change due to a 1% change in the underlying volatility.)
Generally, a portfolio that has VIX-delta risk can be viewed as having SPX-vega risk. The following formula
provides the translation between the delta risk of the volatility index and the vega risk of the underlying it
measures. The volatility index-specific scaling factor below captures the quotation convention of each
index:
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Vega (underlying) = Delta (derivative of volatility index) x (volatility
index-specific scaling factor) x 0.01
Many ETFs have been created to allow traders to more easily gain exposure to volatility index levels.
These funds hold portfolios of volatility index derivative positions with various expiries in different
proportions. The index holdings can be long or short, creating directional or inverse exposure to the
volatility indexes. For example, IPATH S&P 500 VIX S/T FU ETN (ticker: VXX) holds long VIX futures with
unit leverage and a mean time to expiry of 30 days. Its medium-term equivalent (ticker: VXZ) also holds
long VIX futures, but with a mean of 5 months to expiry. An inverse ETF (ticker: XIV) holds a short VIX
futures position, while leveraged ETFs (e.g., ticker TVIX) hold futures positions with notional exposure of
twice the ETF’s assets.
The relationship between the prices of these funds and the volatility indexes are not completely predictable
for several reasons: composition of these funds could be opaque, tracking errors exist, and fund portfolios
are dynamically constructed with periodic rebalancing and rollovers near expiration dates of derivatives.
The images below show some regression results, comparing the returns on some select ETFs to returns
on the VIX index, using daily closing prices since 2006. These results suggest that the daily returns of ETFs
are strongly correlated with those of the volatility indexes. The slope coefficient expresses the historical
sensitivity of the fund's daily return to the volatility index's daily return. These factors should be considered
when choosing a product or sizing a trade.

TWS Guide

981

Chapter 1

TWS Guide

Volatility Products Tab

982

Chapter 1

Volatility Products Tab

Owning a volatility-targeting fund is equivalent to owning a portfolio whose value is sensitive to the volatility
of a targeted underlying index. The fund's sensitivity to the volatility index can be translated to the Vega of
the underlying as follows.
Vega (Underlying) = (Sensitivity of the fund's return to Volatility Index return) x (Current Fund price /
Current Volatility Index) x (Volatility Index-specific scaling factor) x 0.01 = (Sensitivity of the fund's price
movement to Volatility Index price movement) x (Volatility Index-specific scaling factor) x 0.01
While the “Sensitivity of the fund's price movement to Volatility Index price movement” was estimated from
historical prices, some users may express a different view than historical data would suggest. We provide
the flexibility for them to specify their own override on the “Sensitivity Editor”.
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Relationship between the Equity/Commodity tabs and the Volatility Products tab in
Risk Navigator:
Three portfolio value curves are displayed on the Equity/Commodity tab:
A) At the current volatility
B) If the volatility is increased by 15%
C) If the volatility is decreased by 15%
The portfolio value difference between A and B on the Equity/Commodity tab is equal to the portfolio value
difference on the Volatility Products tab between the current level and the 15%-up level of the volatility
index. A similar description applies to the portfolio value curve C.
The Volatility-Coordinated P&L graph, visible on the Equity tab, is a view of the portfolio’s value change in a
set of scenarios where equity and volatility both change (as detailed in the “i” tooltip on that graph). Though
the portfolio value might depend on both equity and volatility changes, here the x-axis is simply the equity
price change, allowing the graph to be projected onto the two-dimensional screen.
The Volatility-Coordinated P&L graph can also be viewed on the Volatility Products tab; here the graph is
projected so that the x-axis is the volatility change. Since the coordinated methodology assumes that
volatility increases with decreasing stock price, the “market down” scenario is now at the right (positive x)
side of the graph. The information content of the graph is unchanged; it is simply being viewed from a
different angle.
The volatility change displayed on the x-axis will range from -30% to +300%. These nominal volatility
changes are scaled down by a factor dependent on the time to expiry or futures settlement, which
parametrizes the relative stability of longer-dated options and futures.

Aggregation of Volatility Products on the Volatility Products tab
Volatility products are aggregated by the volatility indexes that they are sensitive to. For example, VXX,
XIV, and VIX options are sensitive to VIX. There is a drop-down list showing all the volatility indexes that
volatility products within the portfolio are sensitive to. When the user selects a particular volatility index,
Risk Navigator will aggregate the price scans of only those volatility products that are sensitive to this
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volatility index, and ignore the rest. When the entire portfolio is sensitive to only one volatility index, that
index is selected by default.
Portfolio Report

Use the Portfolio report to view risk and exposure for all positions in your portfolio.
You can view totals for specific risk measures (where applicable) in the Risk by Underlying report.

To open the Portfolio report
From the Report menu, choose Select Report and then select Portfolio.
Alternatively, use the Report Selector below the reports and in the Report drop down select
Portfolio.
Use the Plot, Underlying, Category, Currency, and Last Trading Day fields in the Report Selector to further
customize the report display.
Risk by Position Report

The Risk by Position report displays risk measures calculated for each position, by underlying.
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To view the Risk by Position report
1. On the Analytical Tools menu, selectRisk Navigator.
2. In the Report Viewer, select Risk by Position in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
If you elect to view metrics for only a single underlying, the report will not display the Underlying column as
shown above.
Use the Metrics menu to display available risk metrics.
Risk by Underlying Report

The Risk by Underlying report is designed to open by default when you open the IB Risk NavigatorSM.
This report displays portfolio metrics across all asset classes and provides drill-down depth control for each
underlying.
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To view the Risk by Underlying report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Underlying in the Report dropdown.
3. Use the Underlying and Measure lists to define your report criteria.
Use the Metrics menu to display available risk metrics.
Risk by Industry Report

The Risk by Industry report sorts your portfolio by industry. This report displays values on all levels of
detail, from individual positions to totals per industry sector.
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To view the Risk by Industry report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Risk by Industry in the Report dropdown.
You can drill down several levels within an Industry category, and then drill down in the Underlying field for
that category to see all underlyings in the industry, and then all derivatives of the underlying. To drill down
to a deeper level of detail, click the plus "+" sign. A minus "-" sign indicates that you have drilled down to the
deepest level of detail. Click the "-" sign to go up a level.
Use the Metrics menu to display available risk metrics.
Plot Data by Underlying

Select this report to view values for the symmetric data slicers in the P&L Plot. By default the slicers are
spaced at +/- 3%, 6%, 9%, 12% and 15%.
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If you have the cross-hair activated in the P&L plot using the right-click menu, when you hold your mouse
over a line in the plot its value is displayed. Keep in mind that the domain of the P&L plot is determined by
the intersection of the valid domains for each instrument in the portfolio. This may restrict the domain of
accessible values, especially for beta-weighted plots.
To open the Plot Data by Underlying report
Open the Risk Navigator
a. From Mosaic - Use the New Window drop down and select Risk Navigator from the
Advanced Trading Tools category.
b. From Classic TWS - Use the Analytical Tools menu and select Risk Navigator from the
Portfolio category.
From the Report drop down list, select Plot Data by Underlying.
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To change the interval between plot slicers
From within the plot, drag any of the blue slicer lines in an out to change the interval. Note that the
corresponding negative/positive line will also adjust.
Using the menu, from the Metrics menu select Plot data columns and then select Settings.
Portfolio Statistics Report

The Portfolio Statistics report shows two summary tables: one for all Stock and Futures positions, and
one for all Options positions.
The Stock and Future summaries shows all long positions, all short positions, the net and gross units, and
their corresponding total value.
The Option/Warrant summary shows all long calls, long puts, the sum of both calls and puts, and the total
value; all short calls, short puts, the sum of both calls and puts, and the total value; the net units for calls,

TWS Guide

990

Chapter 1

P&L Summary

puts, the sum of both and the total net value; and gross units for calls, puts the sum of both, and the
corresponding net value.
The Cash balance summary shows you total in base, and all cash totals for currencies in your portfolio.
The Opaque Positions list displays positions for which risk cannot be calculated. While these positions are
not included in any risk reports, the market value is included in the Portfolio Value version of the P&L graph.

To view the Portfolio Statistics report
1. On the Analytical Tools menu, select Risk Navigator.
2. In the Report Viewer, select Portfolio Statistics in the Report dropdown.

P&L Summary
The P&L Summary report displays profit and loss values for all contracts in your portfolio. The display is
sorted by asset type, and includes the total P&L for your portfolio, totals by asset class, and the current P&L
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for each asset.
To view the P&L, click the P&L tab.

On Demand VaR
The Value at Risk represents the expected loss under normal market conditions, over a specific time
horizon and based on the percent probability as defined by the confidence level. This is a theoretical value
and does not represent the potential worst-case loss scenario.The On Demand VaR report calculates VaR
for the entire portfolio. The report calculates VaR at the subportfolio level and aggregates it at the currency
and portfolio levels. On Demand VaR is also available for What-If portfolios. Hold your mouse over the
column names inside the report for more information.
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To use the On Demand VaR report
From the Risk Navigator main window, select the VaR tab.
Select the VaR Scenario:
Historical - Uses past data to estimate price.
Monte Carlo - Implements a model for price estimation.
Specify the confidence level.
100% is only available in the Historical scenario.
Specify the time horizon in days.
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Margin Sensitivity
The Margin Sensitivity report, accessed from the report tabset next to the VAR report, shows you the
margin impact to your portfolio of a specific increase and decrease in your positions or a group of positions.

Once the position change is specified, the report shows the initial and maintenance margin sensitivity for
both position increase and position decrease. Along the top of the report is the Control Panel which is used
to specify how to modify the positions in your portfolio. The method is set to "Order defaults" by default.
Overall - Uses the value you set in the entry field. If this radio button is selected, enter the change
amount for all positions in your portfolio in the enterable field.
Order defaults - uses the Order Quantity default specified in the order presets, based on asset type. If
the stock default quantity is 500 and the option default order quantity is 5, all stock positions will display
margin impact on + and - 500, and all option positions will show impact for + and - 5 contracts.
By asset type - Use the Edit box to enter the change value for each asset type.
Position Size - Changes the current position by the current position size. A stock position of 7200 will
show margin impact for a position of 14,400, and 0 (+7200 and -7200).
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In the bottom right corner you can change the display from "All Underlyings" to a specific underlying, and
you can change the way the report is displayed by selecting "Margin Sensitivity by Underlying."

Risk Navigator Reports
Risk Navigator Reports
Report

Portfolio Report

Find on These Product Tabs

Equities, FX, Commodities, MoneyMarket, Structured Products, Volatility
Products

Risk by State Report

Bonds

Risk by Issuer

Bonds

Risk by Country Report

Equities, Bonds

Risk by Position Report

Equities, Bonds, FX, Commodities,
MoneyMarket, Structured Products, Volatility Products

Risk by Underlying Report

Equities, FX, Commodities, MoneyMarket, Structured Products, Volatility
Products

Plot Data by Underlying

Equities, FX, Commodities, MoneyMarket, Volatility Products

Risk by Industry Report

Equities,Bonds, Structured Products,
Volatility Products

Measure by Underlying and

Equities

Maturity
Measure by Price Change

Equities

and Volatility Change
Portfolio Statistics Report
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Report

Find on These Product Tabs

ket, Structured Products, Volatility
Products
Value at Risk Report

Equities

P&L Pie Chart

Equities, FX, Commodities, MoneyMarket

Report Designer
Use the Risk Navigator Report Designer to quickly and easily configure all reports from a single window.
Because the Risk Navigator reports are separate and unique, adding a field to one report does not add the
field to all. The designer allows you to add fields to your reports without opening and modifying each report
individually.

To open the Report Designer
From the Risk Navigator Report menu, select Designer.
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Market Scenario Drill Through
You can apply a market outcome scenario (calculated in the Measure by Price Change and Volatility
Change report) to any of the other risk reports using the drill through command on the right-click menu.

To apply market outcome scenarios to other reports
1. Select a market outcome scenario by clicking in a cell at the intersection of the x-axis and y-axis scenarios.
2. Use the right-click menu to select Drill Through, and then select a report.
3. The chosen report is displayed with the applied market outcome scenario you selected described at
the top of the report.
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When you are viewing the market outcome scenarios via the drill-through feature, all of the values on the
report reflect this hypothetical scenario, and therefore do not reflect actual, real-time risk. To reset the
report to real-time, click the Reset Scenario button on the top right.

Use the Industry Editor
You can modify the default industry groups shown in the Risk by Industry report using the Industry Editor.
The editor allows you to assign an underlying to a different group, assign the underlying to multiple industry
groups, and create new industry sectors, groups and sub-groups.

To use the Industry Editor
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From the Risk Navigator Edit menu select Edit industry groups. The Sector, Group and Subgroup
fields become editable when you click in them.
An asterisk appears next to any underlying whose sector, group or subgroup have been edited.
To assign an underlying to a different sector, group or subgroup
Click the appropriate field in the underlying row and select a different entry.
To add the underlying to multiple groups

1. Use the Industry Editor Edit menu to select New Entry for Underlying. A second line is created for
the underlying.
2. Click the appropriate field to display the dropdown list and select a different entry. You now have two
lines for the underlying with two different industry selections.
To add a new industry
1. Select an underlying, and use the Industry Editor Edit menu to select New Entry for Underlying.
2. Enter the name of the new industry in the blank field. You now have two different lines for the underlying with two different industry selections.
3. To remove the original, right-click the row and select Remove Row.
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You must also enter anew Group and Subgroup for the new industry. This new entry will now be
available in the selection list for all underlyings.

Risk Navigator Menus
Risk Navigator Portfolio Menu
Open your portfolio or create a new hypothetical What-if portfolio.

Field

Description

New

Create a new what-if portfolio.

Open

Open an existing what-if portfolio.

Save

Save the active portfolio.

Save As

Save the active portfolio in a new directory or with a different
name.

Import

Import a .csv file as a new portfolio.

Open

Only available from within a What if. This command opens

'My Port-

your actual portfolio in the Risk Navigator.

folio'
Close

Closes the portfolio.

Risk Navigator Edit Menu
Edit a what-if portfolio, and tools for any portfolio from the Edit menu.
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Field

Clear

Description

Available from What-If Only: Complete clears all data
including underlyings and positions from the what-if
portfolio.

Reload

Available from What-If Only: Replaces current what-if

from file

data with position data from a selected file.

Add

Available from What-If Only: Adds all positions from a

From...

selected file. Note that if you currently have a position
in the what-if and also in the file from which you are
adding, the position quantity will be the sum of both
positions.

Subtract

Available from What-If Only: Subtracts the positions from the

From...

selected file from your what-if. For example, if the what if
does not include aapl, but the portfolio you're using to
"Subtract From" includes a long 500 position in aapl, the
what-if position quantity will be:
0 - 500 = -500 (it subtracts the position quantity).
If your what-if includes a long 1000 position in aapl and you
subtract the long 500 position, the position quantity will be:
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Field

Description

1000 - 500 = 500.

Edit

Opens the Industry Editor.

Industry
groups
Edit Beta

Manually edit beta values with the Manual Beta

Values

Editor.

Edit Beta

Opens the Beta Calculation Editor.

Calculation
Method

Risk Navigator Report Menu
Select, configure and export Risk Navigator reports.

Field

Description

Select report

Open a report. This is the same list that is available
from the selector in the bottom right panel of the
Risk Navigator.

Personality

Select a "trading personality" that is used to determine the fields that appear in certain reports. rader
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Field

Description

Personalities include Derivatives, Equity Hedged,
and Equity Long/Short. Existing customers can
choose to
Designer
Reset report

Returns the open report layout to the default original. This action will remove any added fields,
column sizing, manual entries etc.

Restore fact-

This command restores all reports to the default ori-

ory con-

ginal layout.

figuration
Apply con-

Select this command to apply your changes to all

figuration for

reports. For example, if you add the Beta Weight-

all portfolios

ing field to the open report, use this command to

(pfs)

add the same field to all reports that support it.

Export

Let's you export your portfolio to and.xls or .csv file
format to open in Excel.

Stock Yield

Displays the Stock Yield Enhancement report

Enhancement

within Account Management. This provides an
estimate on the potential yield available to you if
you loan out shares of stock that you fully own.

Exposure fee

Displays the Daily Exposure Fee imposed for having a
very high worst-case loss risk exposure.
Displays the Daily Exposure Fee imposed for having a
very high worst-case loss risk exposure.

Risk Navigator Dimensions Menu
Define parameters and filters for reports.
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Field

Description

Country

Add the Country field to the report.

Industry

Add the Industry field to the report.

Contract

Modify the Contract field details by adding or removing
details such as expiry, right, issuer etc. Only fields valid
for the active report are displayed.

Filters

Filter the display by specifying the expiration style,
asset type or right to show.

Scenario

When the Measure by Price Change and Volatility

Risk Mat- Change report is displayed, specify the matrix values for
rix

columns, rows and the slicer.

Report Metrics
The Risk Navigator Metrics menu is context-sensitive, and allows you to select applicable metrics for each
report.
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Not all menu commands are available for all reports. For example, the Portfolio Analysis columns are only
available in the P&L Summary.

Metrics

Description

Size columns...
Position size

Select Position size to display your (signed) position in the contract. A
short position is depicted by a "-" minus sign.
Choose "None" to remove the Position field from your report.
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Value columns...

Long/Short

These columns provide aggregated values for all long and all
short positions.

All

Selects all available value columns to include in the report.

None

De-selects all columns.

Unrealized P&L

(Market value of positions) - (average cost)

(%)

(Market value of positions) - (average cost) shown as a percentage.

Realized P&L

(Market value of positions since close of period*) - (average cost for
these positions).
*Cut-off times for determining realized P&L for transactions are as
follows:
• 20:30 ET for securities
• Two periods for futures: 17:30 ET and 7:10 ET

Total P&L

The "unrealized" Average Cost P&L is shown in total, per underlying,
and for each position.

P&L for Day

(current price - prior day's closing price) x (total number of outstanding
shares) + (New Position calculation for all new positions)

Price

The current market price of one unit of the contract.

Price Change

The difference between the last price, and the closing price on
the previous trading day.

Price Change

The percentage difference between the last price, and the clos-

%

ing price on the previous trading day.

Value

Current market value of the position.
Position x Multiplier x Price
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The ratio of the current value to the total net liquidity of the portfolio.
For futures: The ratio of the Daily P&L to the total net liquidity of the
portfolio.

Gross Value

The current gross market value of the position.

Gross Value

The current gross market value of the position as a percentage

% NLV/GMV

of the total New Liquidation Value (or Gross Market Value) of the
portfolio.

Underlying

The price of the underlying (in cases where position is a deriv-

Price

ative).

Average Cost

The average price you paid (cost) per unit.

Time Value

The (price) x (position).

Conversion

Displays the rate used to convert non-base positions into the base

Rate

currency.

Currency

The currency of the position.

VAR

Value at Risk (VAR) represents the minimum expected loss under
normal market conditions over a specific time horizon, and based on the
percent probability as defined by the confidence level. This is a
theoretical value and does not represent the potential worst-case loss
scenario.
Note: In cases where the VAR cannot be calculated, the notation "N/A"
is displayed on a violet background.

Portfolio Analysis columns...
Mark-to-Mar-

Shows the profit or loss recognized in the current month for both

ket P&L

open and closed positions.

Month-to-Date
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Mark-to-Mar-

The percent that the position's mark-to-market P&L for the cur-

ket P&L

rent month-to-date accounts for, relative to the portfolio's total.

Month-to-Date
(%)
Mark-to-Mar-

Shows the profit or loss recognized in the current year for both

ket P&L Year-

open and closed positions.

to-Date
Mark-to-Mar-

The percent that the position's mark-to-market P&L for the cur-

ket P&L Year-

rent year-to-date accounts for, relative to the portfolio's total.

to-Date (%)
Realized P&L

Realized month-to-date P&L from the previous business day +

Month-to-Date

realized P&L from the current day.

Realized P&L

The percentage of the position's realized P&L month-to-date to

Month-to-Date

the portfolio's total month-to-date P&L.

(%)
Realized P&L

Realized year-to-date P&L from the previous business day +

Year-to-Date

realized P&L from the current day.

Realized P&L

The percentage of the position's realized P&L year-to-date to the

Year-to-Date

portfolio's total year-to-date P&L.

(%)
Unrealized

The change in unrealized P&L in the current month.

P&L Month-toDate
Unrealized

The percentage of the change of the position's unrealized

P&L Month-to-

month-to-date P&L to the portfolio's total change in unrealized

Date (%)

month-to-date P&L.

Unrealized

The change in unrealized P&L in the current year.
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P&L Year-toDate
Unrealized

The percentage of the change of the position's unrealized year-

P&L Year-to-

to-date P&L to the portfolio's total change in unrealized year-to-

Date (%)

date P&L.

Position Risk columns...

Long/Short

These columns provide aggregated values for all long and all
short positions.

All

Selects all available value columns to include in the report.

None

De-selects all columns.

Delta

This position delta captures both the direction and the magnitude of the
portfolio's sensitivity to an underlying by representing the degree and
direction of change in the option price, based on a change in the price of
the underlying.
We use a capital "D" to differentiate the IB Risk Navigator position Delta
from the contract delta. Position Delta is calculated as (delta * position).

Delta Dollars

Delta Dollars is calculated using the formula:
delta x underlying price.

Delta Dollars

The ratio of the current exposure to the total Net Liquidity Value

% NLV/GMV

(or Gross Position Value) of the portfolio.

Futures Delta

This column is derived from raw position delta. For each futures position
or futures option position with this future as direct underlying, futures
delta = (delta / exp(r*T)) / futureMultiplier, where futureMultiplier is the
contract multiplier of future, exp(r*T) is the scaling factor that we
currently apply to raw delta; dividing by it yields the original raw delta.
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Gamma helps you assess directional risk by defining the speed at which
the option's directional changes will occur, i.e. the rate of change of delta.
We use a capital "G" to differentiate the IB Risk Navigator "position
Gamma" calculated as (gamma * position) from the contract gamma
calculation.

Gamma Dol-

Gamma Dollars is calculated using the formula:

lars

0.5 x Gamma x (Underlying Price x 1%)2

Vega

Vega represents the portfolio's sensitivity to changes in implied volatility
of the underlyings, and shows the change in the price of an option
relative to a change in the implied volatility of the underlying. Generally
long option positions benefit from rising (and suffer from declining)
implied volatilities, while short option positions experience the opposite they benefit from declining (and suffer from rising) implied volatilities.
We use a capital "V" to differentiate the IB Risk Navigator "position Vega"
calculated as (vega * position) from the contract vega calculation.

Theta

Theta represents the portfolio's sensitivity to the passage of time by
indicating the rate at which the market value of your portfolio will change
with time. This metric calculation is based on the assumption that all
other variables remain unchanged, including the underlying price,
implied volatility and interest rate.
We use a capital "T" to differentiate the IB Risk Navigator "position
Theta" calculated as (theta * position) from the contract theta calculation.

Beta Risk columns
Contract Risk columns...
All

The "unrealized" Average Cost P&L is shown in total, per underlying,
and for each position.

None
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Delta captures both the direction and the magnitude of the portfolio's sensitivity to an underlying by representing the degree
and direction of change in the option price, based on a change
in the price of the underlying.

Gamma

Gamma helps you assess directional risk by defining the speed
at which the option's directional changes will occur, i.e. the rate
of change of delta.

Vega

Vega represents the portfolio's sensitivity to changes in implied
volatility of the underlyings, and shows the change in the price
of an option relative to a change in the implied volatility of the
underlying. Generally long option positions benefit from rising
(and suffer from declining) implied volatilities, while short option
positions experience the opposite - they benefit from declining
(and suffer from rising) implied volatilities.

Theta

Theta represents the portfolio's sensitivity to the passage of time
by indicating the rate at which the market value of your portfolio
will change with time. This metric calculation is based on the
assumption that all other variables remain unchanged, including
the underlying price, implied volatility and interest rate.

Implied Volat-

The implied volatility on an option.

ility
Implied Volat-

The absolute change in implied volatility between the current

ility Change

value and the value calculated using yesterday's closing price.

Implied Volat-

The change in implied volatility between the current value and

ility Change

the value calculated using yesterday's closing price, as a per-

(%)

centage.

Historical

The last available historical volatility.
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Volatility
Historical

The difference between the historical volatility as of yesterday's

Volatility

close and the current historical volatility.

Change
Historical

The difference between the historical volatility as of yesterday's

Volatility

close and the current historical volatility, as a percentage.

Change (%)
Tracking

Provides the related tracking factor if the contract has a related

Factor

primary contract.

Plot data columns..
All

Adds all data slicers below to the P&L Plot.

None

Removes all data slicers from the P&L Plot.

3%

Add or remove just this pair of data lines (+3%/-3%)

6%

Add or remove just this pair of data lines (+6%/-6%)

9%

Add or remove just this pair of data lines (+9%/-9%)

12%

Add or remove just this pair of data lines (+12%/-12%)

15%

Add or remove just this pair of data lines (+15%/-15%)

Settings

Click to adjust slicer line values. You can also grab and drag
slicer lines within the P&L plot.

Descriptive columns...
All

Display all descriptive columns.

None

Hide all descriptive columns.

Description

Company name or short description of the contract.

Currency

Currency of the position.
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Hedge
Hedge

Check to create a hedging order for the selected position. Click

Column

the "Hedge" button at the top of the portfolio to create the
hedging orders in TWS. You need to manually transmit the order
(s).

Trade Column

For What-If only: If you want to add a what-if position to your real
portfolio, check the "Trade" checkbox to tag the position for order
creation. When you click the "Trade" button at the top of the What-if, an
order will be created in TWS. The order quantity will reflect the difference
between your current position and the what-if quantity so that the result
will mimic the what-if position as closely as possible. You need to
manually transmit the order(s).

Include Pos-

For What-If only: indicates that you want the position included

itions

in the risk calculations and in the P&L graph computation.

Risk Navigator View Menu
Show or hide tools and views.
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Field

Description

Refresh Table

Manually refreshes data in the report.

Alarms

Displays details for active Risk Navigator
alarms.

Risk Dashboard

Display the Risk Dashboard.

Beta Weighted Port-

Displays beta weighting fields.

folio
Dual Plots

Opens side-by-side P&L plots to allow
you to compare Equal Percentage Move
and Beta Weighted plots.

Custom Scenario

Opens the custom scenario.

Positions not included

Shows the list of unresolved positions
(below the report selector in the bottom
right corner of the interface).

Highlight measures
Span cells
Pie chart

When the P&L Pie Chart is displayed, this
menu command is enabled and allows
you to change pie chart settings.

Vertical crosshair

Enables the vertical crosshair in the P&L
Plot. You can also enable/disable this feature using the right-click menu from within
the plot.

Risk Navigator Settings Menu
Use the Settings menu to specify global directives for the Risk Navigator.

TWS Guide

1014

Chapter 1

Risk Navigator Settings Menu

Field

Confidence

Description

Set the confidence level which is used in both the
P&L plot and in the VaR calculations. Possible values are
95%, 99% and 99.5%.

Reference

Defines the base currency for the portfolio. This is used in

Currency

the portfolio-level aggregations and in forex
decomposition on the forex tab.

Beta Refer-

The index used as the benchmark for beta cal-

ence Index

culations.

Margin Mode

For What-If only: Click to select a new margin
mode to apply, if available.

Country
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Field

Description

Registration - This is the country where the bond was
issued.
Issuer Domicile - The domicile of the bond issuer.
Parent Domicile - The domicile of the parent company of
the bond issuer.
Ultimate Parent Domicile - The domicile of the ultimate
parent company of the bond issuer.
Scaling

Define scaling settings for the presented measures.

Percentages

Percentage settings for the Measure by Price Change
and Volatility Change report.

Percentage

Toggle the calculation for calculated fields to use

Column Cal-

Total Net Liquidation Value or Total Gross Market

culations

Value.

Drilling

Specifies the drilling depth, i.e. the number of levels that
should be expanded when you drill down.

Greek

Select cross-underlying aggregation methods for the

Aggregations

Greek columns.

Date Scenario

Specific to the P&L plot. Specify whether changing the
Date Scenario for Custom Scenarios is restricted to the
selected underlying.

Pin First Row

When selected, the first row of aggregated report
data will remain visible below the header row
when you scroll through a table. This setting is
enabled by default.

Exclude
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Field

Description

undefined val- exclude any undefined position. Positions may be
ues in

undefined for many reason including missing mar-

aggregations

ket data, invalid prices, missing conversion rates
etc.

Download

This feature is mandatory when presenting the risk

Global Risk

matrix via the Measure by Price Change and Volatility Change report. This features requires greater
CPU and memory usage and should be disabled
until needed.

Portfolio Beta Weighting
Beta Weighting in Risk Navigator
The sensitivity of an individual stock to the movement in the broader market is known as its beta. Stocks
sensitive to market movements typically have high betas over time. Stocks that show low correlation with
the market have low betas, while some may move broadly in line with the market as a whole. Stocks that
move inversely to the market would have negative betas.
Risk Navigator measures beta-weighted performance, allowing traders to consider risk by measuring
individual component correlation with a market index in order to estimate likely gains or losses in the event
of a given move in the market.
For the same portfolio of stocks, we can generate contrasting risk profiles by looking at risk units in deltaterms versus beta-terms, which shows the aggregate sensitivity of a portfolio to a market index.
You can find beta risk elements across the Risk Navigator:
View beta risk fields in Equity reports.
Change the aggregation method in the Portfolio Relative P&L Graph.
See beta risk snapshot in the Risk Dashboard.
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Define the reference contract.
Manually change the beta value for an equity contract.
To enable Beta Weighting
From the Risk Navigator View menu, select Beta Weighted Portfolio.

Beta-weighting allows traders to contrast the likely performance of a delta neutral portfolio (should the
component pieces behave in the future as they have in the past) with respect to a specific benchmark index
or reference contract. One might expect a long high-beta portfolio to perform better when considering betaweighting in the event of a market rise in comparison to its performance when assuming it is equally deltaweighted. Conversely, its beta-weighted performance should be expected to be worse for a market fall in
comparison to an across the board equal-weighted decline for all component pieces.

Reference Index for Beta Weighting
The first time you turn on Beta Weighting from the View menu, the Beta Reference Index box is displayed.
This allows you to select a benchmark index other than the default S&P 500, or manually enter a ticker
symbol and define a specific stock as the reference contract.
Reference contracts are associated with a specific portfolio, which means that you can use different
reference contracts in your different portfolios.

TWS Guide

1018

Chapter 1

Edit Beta Values

You can elect to modify the reference contract at any time by clicking the current Beta Reference symbol in
the information bar along the bottom of the Risk Navigator.

Edit Beta Values
You can modify the calculated beta values for any contract using the Manual Beta Editor, or by clicking
directly into the beta field for any stock position.
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There can only be one beta value per contract/reference index across all portfolios. This means that if you
modify the beta value for contract XYZ in a portfolio that uses the default S&P 500 index as the reference
index, the beta value for XYZ in any other portfolio that uses this reference index will also change.
Edit Beta Using the Manual Beta Editor
From the Edit menu select Edit Beta Values.
In the Manual Beta Editor, add an underlying in the current Reference Contract section by clicking NEW.
The calculated beta value is displayed.
Click in the Manual Beta field and enter the desired beta value. Hit Enter.
If desired, click the "+" sign to add a new section for other reference contracts (you might do this if you had
multiple portfolios that each used a different reference contract).
Click Apply to apply the value to the report and leave the Editor open. Click OK to apply and close.

Change Beta Directly in Report
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Click in the beta field to enter your own beta value. Right-click in the edited beta field (identified with red
text) and select Remove Manual Beta to reset the value to the calculated beta.

Beta Calculation Method Editor
Beta is calculated based on equal weighted daily returns over the last two years. The Beta Calculation
Method Editor allows you to change the default two-year period relatively from the current date, or using a
specified date range that contains a minimum 30-day period.
To open the Beta Calculation Method Editor
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From the Risk Navigator Edit menu select Edit Beta Calculation Method.

To change the time period relative to today, select Custom Horizon and then choose the number or
units and the unit (years, months or days).
To change the time period to use a specific date range, select Date Interval and then define the Start
and End dates.

Beta Risk Fields
Add or remove beta risk-related fields using the Beta Risk section of the Metrics menu.
You can add one or multiple beta risk fields to your equity reports, but to enable beta weighting throughout
the portfolio including the Risk Dashboard and P&L Graph, select Beta Weighted Portfolio from the View
menu.
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Long/Short

Beta Risk Fields

Description

Notes

Shows the specific value for all long
positions and for all short positions to
allow you to see the aggregate for
both. Note that the other field for these
values provides the net.

All

Add all Beta Risk fields.

None

Remove all Beta Risk fields.

Beta

The ultimate underlying’s raw beta at
the ultimate underlying level (for
reports with drill-down capability) and
at the position level for stock positions.
This means that for underlyings with
both stock and option positions, the
stock beta is displayed. Beta can be
used to estimate the expected return
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Field

Description

Notes

on an asset given the return on a statistically related asset.
Correlation

Provides the correlation between the
contracted and the user-selected reference index.

Weight

The position weight used for the portfolio beta calculation (shown in the
Risk Dashboard).

Weighted

The contribution of a given product to

The total

Beta

the total beta of your portfolio.

weighted
beta value
is also displayed in
the "Portfolio Beta"
field in the
Risk Dashboard.

SPX (Beta

The index-equivalent delta position for the

The ref-

Weighted)

stock.

erence con-

Delta

Calculation: Delta x dollar-adjusted beta

tract is

(adjusted by ratio of close prices).

displayed in
the title of
this field;
this
example
uses SPX
as the reference
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Field

Description

Notes

index.
SPX (Beta

This is a measure of the change in the

Weighted)

position’s exposure in currency terms

Delta Dol-

resulting from the change in the mar-

lars

ket (the reference contract). The Beta
Weighted Delta Dollar reading multiplies the Delta * the position size to
show the relative significance of any
position translated in dollar terms and
is the expected change in the value of
the stock should the benchmark
increase or decrease in value by
$1.00

SPX (Beta

The ratio of the current beta weighted

Weighted)

delta dollars to the portfolio's total net

Delta Dol-

liquidity.

lars % NLV
Beta Delta

Exposure weighted by the unadjusted

Dollars

beta of the given position. For stocks,
this is sometimes called the BetaAdjusted Market Value.

Beta Delta

Delta dollars weighted by the unad-

Dollars %

justed beta of the given position as a

NLV

percentage of the Total Net Liquidation/GMV of the entire portfolio. This
is also referred to as the Beta-Adjusted Exposure or Beta-Adjusted Market
Value in Percentage.

Beta Delta
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Beta Weighting in the Portfolio Relative P&L Graph
Description

Notes

the delta position weighted by the
unadjusted beta of the given position.

You can also change the calculation used for all calculated fields from NLV to GMV. From the Settings
menu select Percentage Column Calculations.

Beta Weighting in the Portfolio Relative P&L Graph
The Portfolio Relative P&L graph illustrates how the total value of your portfolio for a specific asset class
(or a subset of your portfolio) will change, based on a percent change in the price(s) of the underlying(s).
Available settings may change based on the asset class displayed.

The image above shows the portfolio relative P&L for an equity portfolio, based on the value All
Underlyings selected from the Underlying list in the Report Selector.
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Beta Weighting in the Portfolio Relative P&L Graph

For a single underlying, you can toggle between showing the absolute price or showing the underlying
price change as a percent. Click the price label below the horizontal price axis to select a display type.
Note that for leveraged ETFs, the Risk Navigator moves them by their target performance ratio in the
aggregated P&L graph. For example, for an index and its triple inverse ETF, to the +10% P&L it adds the
index P&L at 10% to the ETF P&L at -30%. When either one is plotted individually, it shows their own P&L,
but it shows the index on a +/-30% range and the ETF on a +/-90% range.
Beta analysis in IB Risk Navigator allows the investor to view the P&L plot differently. In its default format
"Equal Percentage," the P&L plot assumes a same percentage move for all underlying portfolio pieces.
When Beta Weighted Aggregation is selected, the underlying price scenario includes beta weighted price
changes. Beta explains the performance of a stock over and above that associated only with the
performance of the market itself.
The Confidence Interval, shown within the yellow vertical lines, illustrates the worst-case loss over a oneday period with a default 99.5% confidence level. Use the Confidence sub-command on the
Settings menu to toggle between 95%, 99% and 99.5% confidence levels. Turn the Confidence Level
brackets on or off using the Confidence Interval command on the right-click menu.
For portfolios containing options or volatility products (like VIX or its derivatives), vol-coordinated price
changes show the effect of a change in market price level and a corresponding simultaneous change in
volatility level. In scenarios where stock prices are down X%, vols are assumed to simultaneously increase
by up to (10*X)% for short-dated options, decaying gradually to (2*X)% for options with longer expiries.
Conversely, in scenarios with stock prices up X%, vols are assumed to be down X% for short-dated
options, decaying to (X/5)% for longer expiries.
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Beta Weighting in the Portfolio Relative P&L Graph

Curves generated using these coordinated volatility changes will be marked "Vol.Coord.", and will be
displayed together with a tool tip detailing the scenarios used.

Use the Vol-up by 15%*, Vol-down by 15%* and reduced time to expiry by 1 day checkboxes in the rightclick menu to view the plot under different scenarios to help you visualize the volatility and time risk in your
option positions. While you can elect to display the base P&L using both the previous day’s closing price
and the most recent dynamic price, the volatility and time variables are always based on the previous close.
*The Vol Up and Vol Down commands increase/decrease projected volatility in relative percent change.
Relative percent change is calculated by multiplying the current implied volatility by 15%, and
adding/subtracting this value to/from the current implied volatility. For example, if the current implied
volatility of an option is 10%, a 15% relative increase would result in an implied volatility of 11.5%,
calculated as follows: 10 + (10 * 0.15) = 11.5% . If the current implied volatility of an option is 42.45%, a
15% relative decrease would result in an implied volatility of 36.082%, calculated as follows: 42.45 - (42.45
* 0.15) = 36.082%.
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When the Vertical Crosshair is activated on the P&L graph using the right-click menu, you will get mouseover help at any price-change percentage point.
For Bonds, the P&L plot is based on the interest rate change.

What-If Portfolios
Create a What-If Portfolio
The What-if portfolio feature lets you create an editable, hypothetical portfolio based on your actual
portfolio. This allows you to "make changes" to your portfolio, including adding, closing, reducing or
increasing positions, to see how your risk profile would change. Additionally, you can check your margin
requirements on the portfolio.
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Create a What-If Portfolio

You can also build a new hypothetical portfolio, position-by-position, to see how the risk profile changes as
positions are added and modified.
You can also create an order from within a What-if portfolio that will fill on an exchange. For details, Create
Orders from a What If Portfolio
What-if portfolios are outlined in red for easy identification, and display the What-if title at the top of the
window.

To create a "what-if" scenario based on your current portfolio
1. Open the IB Risk Navigator window and on the Portfolio menu, select New.
2. Specify whether or not you want to base the hypothetical portfolio on your existing portfolio.
a. If yes, all of your current positions will download to the new What-if.
b. If no, you will see a blank window and can addition positions by clicking the green "New" field or dragging and dropping contracts from your main window.
To save a "what-if" portfolio
1. On the Portfolio menu select Save As.
2. Enter a file name and click Save.
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To add or modify "what if" cash positions
Select the P&L tab.
From the Report table, expand the Cash section.
Click the position cell for a given currency, enter the new amount, and press "Enter."
To add a new currency, use the right-click menu and select Add new Cash Position.
Choose the currency and click "OK.
You should see that the new currency is now available in the Cash section of the P&L tab, and you can edit
the Position size.
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To reload the last saved version
Use this command to reset all values in the active portfolio to the last saved version. This command only
works on an unsaved file. An unsaved portfolio will display an asterisk "*" at the end of the title.
1. On the Edit menu select Reload from file.
2. Confirm that you want to reload the file and lose all of your unsaved changes by clicking Yes.
To add/subtract positions from other portfolio files
1. From the active portfolio, on the Edit menu select Add From or Subtract From.
2. Select a portfolio to add/subtract. The add/subtract selection list only displays names of portfolios
that are currently open.
3. Click OK to add or subtract positions from the active portfolio.
The add/subtract feature nets out positions common to both portfolios, and creates a
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contract line for each new contract (even if the position is "0").
You can add/subtract the same portfolio multiple times. Current positions are netted out
each time.
To add one new contract
1. Click NEW and enter the underlying symbol.
2. Define the asset.
3. Specify the position.
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Create Orders from a What If Portfolio
The What-If portfolio allows you to create and fine-tune hypothetical "positions" in a risk-free environment.
You can then create a similar position in your actual portfolio using the Trade feature in the what-if.
When you initiate an order from a what-if position, Risk Navigator will create an order in TWS such that its
execution will result in a position that mimics the what-if position. This means that if you create an order on
an underlying in which you already hold a position, the quantity for the order will be calculated to
accommodate the current position. For example, if you currently hold a long position of 100 in IBKR and
you create a trade from the IBKR what-if position of 700, the order quantity in TWSwill be for 600 shares.

To create an order from a what-if position
1. Ensure that the position on which you want to base the order is checked using the Include/Exclude
box.
2. Ensure that the Trade column is displayed. Use the Metrics menu to display the column.
3. Check the Trade box for the position you want to create.
4. Click the Trade button in the top right corner to create the order(s).
The order is created in TWS. You will need to review and transmit the order to complete the trade.
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Handling Expired Positions
When you open a saved "what-if" portfolio that includes expired positions, you can elect to have Risk
Navigator transform these positions into deliverables according to the settlement procedure. For example,
an expired at-the-money IBM option position would be replaced by the proper amount of IBM stock and
cash.
To transform expired positions to deliverables, say "Yes" to the transform message.

To always have the system transform expired what-if positions, check "Remember my decision."
If you have an expired position in your actual portfolio, you can elect to have Risk Navigator create a new
what-if portfolio populated with your existing positions, and it will transform expired positions as noted in the
new what-if.

Scenario Analysis
Risk Navigator offers several types of scenario analysis, with the results generally presented in graph form.
All our scenarios are simplified hypothetical outcomes, using only one or two parameters to describe a
change to all market prices. The variety of possible real-world outcomes is vastly greater than anything our
scenarios can model. It should be expected that actual market outcomes during periods of stress will be
significantly different from any scenario that can be specified a priori.
The purpose of scenarios is not to predict market outcomes, but simply to provide a range over which the
portfolio's behavior can be explored.

TWS Guide

1036

Chapter 1

Volatility-Coordinated Scenarios

Volatility-Coordinated Scenarios
Volatility-coordinated scenarios explore simultaneous shocks to market price and volatility. Because the
change to volatility is a deterministic function of the price change, the coordinated scenarios still only
explore a one-dimensional subspace of the very large space of possible market outcomes.

Volatility Term Structure Response
One common feature of the coordinated scenarios is that the volatility shock is not applied directly to
implied volatility or to volatility products. Instead, it is first multiplied by a term-structure response function,
which we will denote as VR(t) where t is the time to option expiry (for stock options) or to futures delivery
(for volatility index derivatives). To reflect the observed propensity of volatility levels to fluctuate less as this
time increases, VR(t) is a decreasing function with VR(0) = 1.
ETFs and ETNs which invest in volatility index derivatives do not use any single future, but must roll their
portfolios through time. Thus we cannot use VR(t) directly for them; instead we use the measured historical
beta of the ETF/ETN with respect to the underlying volatility index (e.g., the beta of VXX with respect to
VIX). These historical betas are updated daily.
We refer to the volatility change before application of VR(t) or beta as the "nominal" change.

Equity Markets
For equity products and equity-derived volatility products, we use the formula
Y = -X when X>0, -10*x when X<0
to derive the nominal volatility shock "Y" from the price shock "X". For example, a 30% increase in market
prices is accompanied by a 30% nominal decrease in volatility; a 20% decrease in market prices is
accompanied by a 200% nominal increase in volatility. As always, this functional relationship is not
predictive of real-world changes.
In the resulting scenarios, the value computation for a market instrument depends on its type. The table
below gives a few representative examples:
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Note that the volatilities of volatility products are not changed in these scenarios.
Floor on VIX

There is also a caveat to the above: we impose a lower limit on the value of Y, in order to create a lower
limit on the values of the spot VIX index which will be explored by the scenarios. Thus the scenarios
presented in Risk Navigator embed this assumption about VIX behavior. In a large real-world market
move, this assumption could turn out to be incorrect.
See some samples.

Volatility-Coordinated Scenarios - Sample Portfolios
As illustrated in the below image, our sample portfolio contains both stock and volatility instruments. The
latter are grouped under "SPX" in the examples, since their value is ultimately derived from SPX volatility.

P/L by Market Price Change
Risk Navigator supports scenarios with coordinated volatility, and also with no volatility change. The results
can be quite different:
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Since the price-based part of the portfolio is a short covered call and an outright long position, it loses value
as market prices drop. This is reflected in the "What-if" line on the graph, which shows the price-based
instruments losing value and the vol-based instruments unchanged.
The vol-based part of the portfolio contains long positions in VXX stock, a VXX call, and a VIX future, all of
which will profit from a volatility increase. If a market price drop is accompanied by a volatility increase, then
the vol-based instruments will gain value in these market-down scenarios. The "Vol.Coord." line on the
graph shows a smaller P&L change, due to this offsetting effect.
It is important to note that such simple scenarios cannot be expected to quantitatively predict the details of a
large market move. Both curves are computed from vastly simplified toy models of what might happen in a
severe market downturn. Their only goal is to compactly summarize one aspect of a portfolio's potential
behavior.

P/L by Equity Market Volatility Change
The graph on the Volatility Products tab shows the results of the same volatility-coordinated scenario
analysis as that used on the Equity tab.
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However, the graph's x-axis is now the volatility change rather than the corresponding price change.
Because the volatility-coordinated scenarios associate increasing price and decreasing volatility, the
direction of P&L change appears to have reversed. And because the relationship between market price
change and volatility change is non-linear, the graph's shape appears to have changed.
The values in the two graphs nonetheless correspond precisely. For instance, a single scenario in which
prices increase 10% and nominal volatilities decrease 10% contributes one point on each graph:
The point where "Market Price Change (percent)" is 10, on the Equity tab
The point where "Equity Market Volatility Change (percent)" is -10, on the Volatility Products tab
Another scenario, in which prices decrease 20% and nominal volatilities increase 200%, contributes a
different point:
The point where "Market Price Change (percent)" is -20, on the Equity tab
The point where "Equity Market Volatility Change (percent)" is 200, on the Volatility Products tab
In scenarios like the latter, the volatility products will experience a positive P&L; but because the volatility
increase is assumed to be accompanied by a decline in market prices, the price-based products will
experience a negative P&L in the same scenario. The graph shows the sum of these two effects.
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Portfolio Relative P&L Graph
The Portfolio Relative P&L graph illustrates how the total value of your portfolio for a specific asset class
(or a subset of your portfolio) will change, based on a percent change in the price(s) of the underlying(s).
Available settings may change based on the asset class displayed.

The image above shows the portfolio relative P&L for an equity portfolio, based on the value All
Underlyings selected from the Underlying list in the Report Selector.
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For a single underlying, you can toggle between showing the absolute price or showing the underlying
price change as a percent. Click the price label below the horizontal price axis to select a display type.
Note that for leveraged ETFs, the Risk Navigator moves them by their target performance ratio in the
aggregated P&L graph. For example, for an index and its triple inverse ETF, to the +10% P&L it adds the
index P&L at 10% to the ETF P&L at -30%. When either one is plotted individually, it shows their own P&L,
but it shows the index on a +/-30% range and the ETF on a +/-90% range.
Beta analysis in IB Risk Navigator allows the investor to view the P&L plot differently. In its default format
"Equal Percentage," the P&L plot assumes a same percentage move for all underlying portfolio pieces.
When Beta Weighted Aggregation is selected, the underlying price scenario includes beta weighted price
changes. Beta explains the performance of a stock over and above that associated only with the
performance of the market itself.
The Confidence Interval, shown within the yellow vertical lines, illustrates the worst-case loss over a oneday period with a default 99.5% confidence level. Use the Confidence sub-command on the
Settings menu to toggle between 95%, 99% and 99.5% confidence levels. Turn the Confidence Level
brackets on or off using the Confidence Interval command on the right-click menu.
For portfolios containing options or volatility products (like VIX or its derivatives), vol-coordinated price
changes show the effect of a change in market price level and a corresponding simultaneous change in
volatility level. In scenarios where stock prices are down X%, vols are assumed to simultaneously increase
by up to (10*X)% for short-dated options, decaying gradually to (2*X)% for options with longer expiries.
Conversely, in scenarios with stock prices up X%, vols are assumed to be down X% for short-dated
options, decaying to (X/5)% for longer expiries.
Curves generated using these coordinated volatility changes will be marked "Vol.Coord.", and will be
displayed together with a tool tip detailing the scenarios used.
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Use the Vol-up by 15%*, Vol-down by 15%* and reduced time to expiry by 1 day checkboxes in the rightclick menu to view the plot under different scenarios to help you visualize the volatility and time risk in your
option positions. While you can elect to display the base P&L using both the previous day’s closing price
and the most recent dynamic price, the volatility and time variables are always based on the previous close.
*The Vol Up and Vol Down commands increase/decrease projected volatility in relative percent change.
Relative percent change is calculated by multiplying the current implied volatility by 15%, and
adding/subtracting this value to/from the current implied volatility. For example, if the current implied
volatility of an option is 10%, a 15% relative increase would result in an implied volatility of 11.5%,
calculated as follows: 10 + (10 * 0.15) = 11.5% . If the current implied volatility of an option is 42.45%, a
15% relative decrease would result in an implied volatility of 36.082%, calculated as follows: 42.45 - (42.45
* 0.15) = 36.082%.
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When the Vertical Crosshair is activated on the P&L graph using the right-click menu, you will get mouseover help at any price-change percentage point.
For Bonds, the P&L plot is based on the interest rate change.
In cases where the index price is invalid for futures/futures options, the graph provides a drop-down
selector with available expirations to use for the reference price. Ensure that the "Underlying" field in the
report selector has only one contract selected.
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Custom Scenarios
You can elect to modify the variables that affect your risk profile using the Custom scenario command on
the View menu.
The Custom Scenario section is populated with the same data as the realtime market scenario until you
modify the variables.
VAR in the market scenario is calculated based on the previous day's closing price. VAR in the Custom
Scenario is calculated based on the current Last price when the scenario is created. Total VAR can be
found in the "Value at Risk" report.
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To create a Custom Scenario
1. From the View menu select Custom Scenario.
2. In the Scenario Editor, filter the underlyings you want to include in the custom view.
Select All Underlyings to affect the entire portfolio from a single editing line.
Select Any Underlyings to edit individual underlyings line by line.
Choose a single underlying to show the subportfolio (the underlying and its derivatives).
Additionally, use Ctrl + click to select multiple underlyings.
3. Modify the Date to view your risk profile at a future date. By default the date is set to today.
4. In the Underlying Price section, define the value of the price change and the type.
ExpV - the Custom Scenario price will be changed to exactly reflect the explicit value in the
Price field, either positive or negative depending on the sign. For example, if the price for
ABC is currently $60.25 and you enter 55.00 ExpV, the Custom Scenario price for ABC will
be $55.00.
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Chg - Adds or subtracts the value in the Price field, depending on the sign. For example, if
the price for ABC is currently $60.25 and you enter -4.25 Chg, the Custom Scenario price
for ABC will be $56.00.
Chg% - Adds or subtracts the percent of the value in the price field, depending on the sign.
For example, if the price for ABC is currently $60.25 and you enter 10 %Chg, the Custom
Scenario price for ABC will be $54.23.
The values in the Custom Scenario are always compared to values in the realtime Market
Scenario. For example, if you modify the Price parameter to show a 10% change in the
underlying price and get a Custom Scenario price of $54.23, then you modify this price
again to see a -10% change, the new calculation will be based on -10% of the market price
of $60.25, not the existing custom scenario price of $54.23.
5. Use the Volatility section to modify volatility using the same types (ExpV, Chg and %Chg as
described above in the Price section.
6. Hit Apply at the top left of the Scenario Editor to see the impact of your changes in the Custom
Scenario section.

Custom Scenario Examples
You can create complex custom scenarios by editing the price, date and volatility variables. The examples
below are only a few of the possible custom views available, and are meant to help you become familiar
with the tool.
Custom Scenario Example 1: You want to view the impact on your portfolio of a 10% change in the
underlying price of IBM.
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1. Filter the underlying. In this case,
select IBM.
2. Optionally check the "Filter positions..."
checkbox to hide all values for other
underlyings to make the difference
between market and custom scenarios
easier to see.
3. Enter the Price value. Be sure to
delete the existing value first.
4. Select the price change type.
5. Click Apply to see your changes
reflected in the Custom Scenario
table.
Note: Modified data in the
editor appears in red,
indicating that you have not yet
applied the changes. When
you click Apply, the red color is removed.

Note: To remove data changes, click the Reset button at the top of the editor.

The effects of this change can be seen in the Custom Scenario, and can be compared with the realtime
market data that appears in the adjoining Market Scenario. The underlying price change shows in the
underlying stock line, and the trickle-down affect of this change can be seen in the Price, Value, Delta and
Theta fields.
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Risk Navigator Alarms
Risk Navigator Alarms
You can set Alarms in Risk Navigator that alert you with sound, send a pop-up message and create an
order when a specified measure achieves a user-defined value. Available measures against which you can
set alarms include Delta, Futures Delta, Gamma, Delta Dollars, Gamma Dollars, Vega and Theta. Note
that these are "position" values (indicated by capitalization of the first letter). You can set alarms at the
position level or at the "All Underlying" level. Additionally if you access the Bond tab you can set alarms
based on the bond measures including Dv01, Duration and Convexity.
Set a basic alarm
Set an alarm to create an Option Portfolio order
Set an alarm to create a single order
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To set a basic alarm in Risk Navigator
1. Right-click the contract and select Set Alarm.
2. Define the measure, select the operator, specify the value.
3. Indicate the alert method(s) and other Settings and select Set.
To remove an alarm, right-click the contract and select Remove Alarm.
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Click Add Single Order to open the Order Ticket and define the order you want to be created when the
alarm is triggered. Once the alarms triggers, the Order Ticket opens again with your defined order criteria.
You can edit and/or transmit the order. Please note that market conditions may have changed by the time
your alarm triggers; you may want to consider using a Relative order, and we recommend that you review
the order parameters when the alarm triggers before you submit the order.
Set an alarm to create a single order
Right-click the contract and select Set Alarm.
Define the measure, select the operator, and specify the value.
Click Add Single Order to open the Order Ticket.
Specify the order criteria including the order type and any necessary offset values.
We recommend that you use a Relative order as the market conditions may have changed by the time the
alarm triggers.
Click Create Order. The order will be created when the alarm triggers and you must manually transmit the
order.
Click Set to set the alarm. Click Edit or Remove to modify or delete the order.
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Option Portfolio Alarms in Risk Navigator
You can set Alarms in Risk Navigator that trigger the creation of a pre-defined Option Portfolio order. You
must submit the order manually.
Available measures against which you can set alarms include Delta, Futures Delta, Gamma, Delta Dollars,
Gamma Dollars, Vega and Theta. Note that these are "position" values (indicated by capitalization of the
first letter). You can set alarms at the position level or at the "All Underlying" level.
To set up an alarm, right-click the contract and select Set Alarm.

To trigger an Option Portfolio order from a Risk Navigator alarm
Right-click a contract and select Set Alarm.
Define the measure, select the operator, specify the value.
Click Add Option Portfolio Order to open the Option Portfolio tool.
Specify the criteria and run the Option Portfolio query.
Click Save Query to Alarm in Risk Navigator to have the order created when the alarm triggers.
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Click Set to set the alarm.
When the alarm triggers, the Option Portfolio order will be displayed and you can transmit the order.

Option Analytics Window
The Option Analytics window displays values that reflect the rate of change of an option's price with
respect to a unit change in each of a number of risk dimensions.
The contract price plots display the static set of contract prices determined during the price scan. Each
point associates an underlying price on the horizontal axis with the corresponding contract price on the
vertical axis. Note that the contract price is expressed as the price per underlying unit (just as it is
represented on an order line or in the execution window). The top plot displays calls, the bottom plot
displays puts, for whichever option(s) your have highlighted in the list.
Move your mouse over the curves to highlight the current value. Also, note that the current underlying price
is highlighted on the bottom axis, and the close price is marked by a light gray vertical line.
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Use the Plus sign to specify the close value. Use the Vol+15%, Vol-15% and Time-1d raise the implied
volatility by 15% in relative change*, reduce the implied volatility by 15% in relative change*, and reduce the
time to expiry by one calendar day. Use the Date Scenario section to create dynamic curve scenarios.
To view the Option Analytics window
From Mosaic - Use the New Window drop down and select Option Analysis > Interactive Analytics >
Option Analytics.
From Classic TWS - Use the Analytical Tools menu and select Option Analysis > Interactive Analytics >Option Analytics from the Technical section.

*For an example of a relative percent change, if the current implied volatility of an option is 10%, a 15%
relative change would result in an implied volatility of 11.5%, calculated as follows:
10% * (1 + 0.15) = 11.5%.
Additionally you can open just the option Greeks or just the Put & Call P&L by selecting:
Option Analysis > Interactive Analytics > Greeks
Option Analysis > Interactive Analytics >Put+Call P&L
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View Futures Prices Term Structure
View the real-time and historical term structure of futures prices with the Futures Term Structure window.
This window displays a split chart that shows the real-time and historical settlement prices of the existing
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futures contracts for the given underlying (top chart) and the differences between the older settlement price
curves and the most recent selected curve (bottom chart).
To view Futures Term Structure
Select a futures contract.
Use the right-click menu to select Charts and then select Term Structure. Note that if you don't see this
command, use the down arrow to expand the list and view all available commands.
Alternatively, use the New Window Search field in Mosaic and start typing Term to see the full tool name.
Data and Data Selection

Use checkboxes at the top to view Today and/or Yesterday's previous close data. Click "+" to add more
historical data points from the past two years
Select up to five predefined historical dates and define three other custom dates.
Use the sliders along left and bottom frames or select any area on the plot by dragging your mouse to
zoom. To restore, use the right-click menu and select Rescale.
Use the right-click menu to chose the data source. By default we display "Last Price" for Today and
"Close Price" for historical dates. You can also select "Mark" price for Today. See related legend on the
right top corner of the plot
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Underlying Prices

The first node of a term structure series is the current or historical underlying index or stock price when it is
available. The spot price is rendered by an unfilled symbol. Add horizontal markers at the current spot from
the right-click menu by selecting Underlying. The current last price and price change is displayed in the
right side of the window header (when available).
Difference series definitions

Between the Price and the Difference plots you can see labels for the currently selected difference
definitions. Their border colors are the same as their difference series color. TWS updates the default
series for the difference plot based on your configuration, as you add or remove dates to/from the price
plot or change your configuration.
You can change the difference series definition by clicking on the label. It will show a small popup
where you can select the days (all the series that are selected for the Price Plot). Once you select the
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days pair it will change the currently selected definition to the new one (unless you selected a pair
which is already selected, in this case it will just remove the edited definition)
Remove a definition and its series by clicking the "X" inside the color border.
Add a new definition by clicking on "+" and using the popup.
When you remove a date from the top check boxes it will remove all definitions that contained this date.
When you select a new date the window will generate the appropriate new definition depending on the
configuration
The definitions you specify here will be kept for a newly opened Future term structure window or when
you select a new future. It will save a definitions for the current Future Term Structure window just like
the configurations once you close the TWS and on restart it will use these definitions.
Highlights/Tooltips

As you move your mouse over the plots, the data points of the closest 'Last Trading Day' (LTD) or
'Days to LTD' are highlighted with a bigger symbol. The highlighted values are also displayed in moving
colored labels on the related axis.
Use the right-click menu and select "Highlight LTD" from the Tools section to display more information
of the closest series. If this feature is disabled it may mean that you have Tool Tips enabled.
Use the right-click menu and select "Tooltips" to get more details of any given data points when you
hover your mouse over it. Notice that 'Highlight LTD' is disabled when the tooltips are enabled
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Configuration

Use the Configure icon in the top right corner to manage:
Color scheme

Rainbow mode assigns a unique color to each series.
Gradient mode uses gradations of the main color you choose.
Domain Axis Mode

You can change the display mode of the horizontal axis. It can display the absolute 'Last Trading Days'
(uniform or proportional spacing) or the relative 'Days to Last Trading Day' in days.
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Price Difference

You can change the display mode of the vertical axis of the difference plot. It can display the real price
difference of the selected two series or the percentage price change (as known as return).
Default difference with respect to...

Based on the configuration of this section, the default difference series will be generated with respect to the
latest (Today, if selected) series or it will generate incremental differences between the selected dates.

Index Arbitrage Meter
Introduction

The Index Arbitrage Meter illustrates the extent of the premium (or discount) of the lead month futures price
above (or below) its fair future value with respect to the index price. A green bar indicates that the lead
month futures price is at a premium to (i.e. greater than) its fair future value. A red bar indicates that the
lead month futures price is at a discount to its fair future value. This tool is available for Index instrument
types.

To show or hide the Arbitrage Meter on Login
When you log in, the Arbitrage Meter is displayed by default for all index instruments. To hide the arbitrage
meter on login:
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1. On the Edit menu, select Global Configure, then select Display in the left pane.
2. Check or uncheck Show Arbitrage Meter.
To display the Arbitrage Meter for an index
1. Click on the desired market data line to select the index.
2. Right click and select Tools and then select Arbitrage Meter.

Implied Volatility Viewer

Open the Implied Volatility Viewer
For all stock, index and futures that have option contracts, open the Implied Volatility Viewer to see option
volatility plotted against a range of user-specified strike prices for a user-defined expiry list.
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Use the Implied Volatility Viewer
Use the Implied Volatility Viewer to see option volatility plotted against a range of user-specified strike
prices for different Last Trading Days. Available for all stock, index and futures contracts that have options.
Adjust display and other frequently used settings using the right-click menu within the chart.
Study the model volatility surface of contracts in 3D. Display the model surface together with individual
option IV points, or compare the current surface with any historical value by plotting them together.
Click and drag the plot to rotate the view, and scroll within the plot to zoom. Expand the "Extra plot
controls" to show contour and value lines and manipulate scaling using sliders.
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Use the right-click menu to open such tools as the Crosshair and tooltip display and to import and
export curves.
Use the wrench configuration icon to define other settings.
To zoom in, use scroll bars or draw a rectangle on the chart to zoom to that area.
The Implied Volatility Viewer has two modes: Remote Server and Local PC.
Remote Server mode - In this mode, the model Implied Volatility is calculated on the server side, based on
the entire volatility surface for the selected underlying. This computation includes all options in the related
option chains that have a valid quote. In Remote Server mode, you cannot access the Edit menu nor can
you make any changes to assumptions used in the model.
Local PC mode - In this mode, the model Implied Volatility is calculated on the based only on options
loaded in TWS. In this mode, you have access to the Edit menu and can modify the interest and dividends
and the loaded basket contract.
Remote Server Mode

TWS Guide

1065

Chapter 1

3D Volatility Surface Webtool

3D Volatility Surface Webtool

Click the "3D" button on the Implied Volatility Viewer to view. Grab and move the 3D image with your
mouse.
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Local PC Mode

Use the Configuration menu for more settings:
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Strike axis shared - When checked all curves use the same Strike axis along the bottom of the graph. If
unchecked, curves are charted separately each with their own Strike axis.
Strikes relative to forward price - If checked, the strike axis shows the value relative to the forward price
of each vol curve. If unchecked, the axis displays the actual strike prices.
Show Legend - If Midpoint and/or the bid/ask are displayed, the legend in the top right corner identifies
the icons used for them.
Highlight strike points near cursor - When checked, the strike points are shown as easy to see colored
balls along the curves as you move your cursor along them.
Highlight curves on mouse hovering - When checked, curves are highlighted in white when the cursor
is over them.
Include prices in export - When exporting the chart, if checked the prices are also included along with
the volatilities.
Connect forward price with related curve - Uses vertical lines from the Strike axis to connect forward
prices with the related curve. Only available if "Strikes relative to forward price" is not checked.
Connect at-the-money IV with related curve - Uses horizontal lines from the Volatility axis to connect
at-the-money implied volatilities with the related curve. Only available if "Strikes relative to forward
price" is not checked.
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Default Domain Range
Full Model
IV Strikes
set range
Tooltip Mode
Compact - Shows the very basic for mouse-over tips.
Verbose - Shows an expanded version of information for mouse-over tips.
Volatility Units
Annual - Uses annual volatility
Daily (business days) - Uses daily volatility
Color Scheme
Automatic Rainbow
Gradient

Options Implied Volatility Term Structure
The Option IV Term Structure shows the Days to Last Trading Day along the bottom horizontal axis and
the at-the-money IV for that date along the vertical left axis. You can use this tool alone, or open it in
conjunction with the Implied Volatility Viewer.
Use checkboxes at the top to view Today and/or Yesterday's previous close data.
Change the color scheme and the display and configuration of the horizontal axis using the "Configure"
wrench icon in the top right corner.
Elect to show "uniform spacing" for last trading day, or to show Days to Last Trading Day.
Use the slider along the bottom frame to zoom, and use the right-click menu to show data tooltips.
The Implied Volatility Term Structure has two modes: Remote Server and Local PC.
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Remote Server mode - In this mode, the model Implied Volatility is calculated on the server side, based on
the entire volatility surface for the selected underlying. This computation includes all options in the related
option chains that have a valid quote.
Local PC mode - In this mode, the model Implied Volatility is calculated on the based only on options
loaded in TWS. In this mode, you have access to the Edit menu and can modify the interest and dividends
and the loaded basket contract.

To open Options Implied Volatility Term Structure
From the New Window drop down select Option Analysis then Interactive Analytics and then
select Option IV Term Structure.

Model Navigator
Use the Model Navigator to modify option pricing assumptions, including the volatility, interest rates and
dividends, and have the Model Navigator use these values in its option model price calculations..
Using the Model Navigator
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Using the Model Navigator
Price/Risk Analytics uses current market data along with interest and dividend values to calculate implied
volatilities and option model prices. Use the Model Navigator to modify pricing assumptions and
recalculate the model price.
Option model computation requires market data for both the option and its underlying. In the case of index
options, the market data for the futures reference contract is also required.

To open the Model Navigator
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1. From the Analytical Tools menu, select Model Navigator.

If you open the Model Navigator from the OptionTrader, it is automatically populated with all loaded
option chains.
If you open the Model Navigator from a Quote Monitor, it will show options on all pages that have the
Model or Imp Vol fields displayed, which require the model price calculation.
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To display Model or Imp Vol fields on a Quote Monitor
1. Hold your mouse over a Market Data column to display the “+” icon, and click on it to show the
column picklist.
2. Expand the Options category and select the Imp. Vol and/or Model fields.
The Imp Vol and Model fields display on the page, and all options contracts on the page now require a
model calculation and will appear in the Model Navigator Contract Description pane. The implied volatility
calculation is non-linear and may not converge for low vega options. In such cases, the Model Navigator
will not provide an implied volatility estimate.
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The Model Navigator window comprises three main sections: the Contract Description Pane which shows
all available options in an expandable tree, the Volatility Model Pane which displays the volatility curve
plots, and the Volatility Curve Table table which lists associated strike prices and implied volatilities.

Contract Description Pane
The left pane shows all available options grouped by ultimate underlying, which can be sorted
alphabetically or based on option count order using the Sorting command on the Settings menu. Select
the checkbox next to an Last Trading Day to create a volatility model. All volatility models on an underlying
appear in the same sub-pane. Each underlying has a unique pane of volatility model(s).

Use the Settings menu to elect not to merge the FUT subtree with the option, and see the whole FOP
structure.
To include contracts in the Model Navigator, you must either:
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Use the OptionTrader and download a set of option chains
Open the IB Risk NavigatorSM, or
Add the contracts to your trading page with the Imp Vol. and/or Model fields displayed.

Volatility Model Pane
Volatility Models are displayed for all checked contracts in the center pane of the Model Navigator. The
Volatility Model pane includes:
Price Offset - optional. Offset the price of the underlying for selected options, by an absolute value or a
percent of the current price.
Volatility Curve Plot - Shows the volatility profile as a function of the strike price. You can manually edit
a plot by right-clicking and choosing Edit.
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The horizontal axis is the strike price, the vertical axis is the volatility.
Risk Navigator calculates the implied volatility for each option in a class.
The blue and red dots show implied volatility derived from the market data for calls and puts, respectively. Dark blue/dark red indicates a half quote call/put (either just the bid or just the ask).
Volatility knots calculated from the option bid/ask include a representational “error bar” to indicate the
error range of the calculation. This range is specified numerically in the mouse-over help, for example
“+/- 0.008.” If the volatility is not calculated using bid/ask (for example, a half quote call/put) the error
range is not displayed.
If there is no bid/no ask, the volatility is calculated from the previous closing price indicated by an open
circle.
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The average or close implied volatilities are fitted to a parabola, vs. the strike price. The fit is weighted
by the vega of each option, which means that the curve is constrained to be closest to the implied volatilities for the options that have the most vega, i.e. whose option price changes the most per unit change
in the option's volatility.
To see details for a given implied volatility point, hold your mouse cursor over the point. The system will
display the option right, strike price implied volatility and error range.

Volatility Curve Table
The volatility curve table reflects the data in the plot. To add IV (Manual) entries, use the Edit menu to
select the profile to edit, or right-click in a plot and select Edit. Both the volatility plot and table become
editable. In the Manual column, double-click the implied volatility at a strike price and enter a new value.

By default, the Model Navigator’s sophisticated option model calculation engine uses the values in the plot
along with the calculated interest rate, dividends, underlying price and other parameters, to calculate the
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Model price. If you prefer to calculate the model price using the pricing assumptions reflected in
an edited plot, you must apply the changes to your plot and leave it in Edit mode. Any expiry that
has a volatility curve plot in Edit mode will use this profile in the calculation of the Model price and Implied
Volatility.
You can also modify the Interest Rates and Dividend Schedule, and specify that these modified pricing
assumptions be used in the Model Price calculations.

Edit Interest Rates
You can modify the interest rate by entering values in the Manual column of the Interest Rate Navigator.
To open the Interest Rate Navigator
1. From the top-level Edit menu, select Interest Rate.
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There are two interest rate columns, Forward Rate (Auto) and Forward Rate (Manual). The Auto column
displays the U.S. default rate. The Manual column initially displays the U.S. rate (rather than an empty
field), but the value is editable.
To edit interest rates
1. Select the Manual radio button to make the column of manual rates editable.
2. Double-click a rate in the Manual column and enter a new rate.
3. Click Apply to save your changes.
To have the model calculations use your manual value, ensure that the Manual radio button is selected.
To change the number of dates/rates displayed, right-click in the table and select Add new to create a
blank editable row at the top of the table, or Remove Selected to delete the selected row.
To globally apply an offset value or percent to all manual entries, enter an offset amount in the Interest
Rate Offset field, and select the Percent or Absolute value radio button.
The option model is calculated using the interest rate you define by selecting the Auto or Manual radio
buttons.
The annual percentage rate is a simple time deposit rate using the bank year calendar (360 days/year).
The system converts the interest rate table to a set of exponential interest rates that apply on a spot-todate basis for each expiry in a class. This is displayed as the IR value in the Contract Description Pane
when you expand an expiry.
The interest rate table applies across all option classes. When you change the interest rate in one
option class, the change is applied to all option classes.

Edit Dividends
In addition to letting you manually set the dividend schedule, the Dividend Schedule Navigator also
provides an automatic "best guess" dividend payment schedule based on historical data for that asset.
To open the Dividend Schedule Navigator
1. From the top-level Edit menu, select Dividend Schedule.
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There are two dividend, Dividend (Auto) and Dividend (Manual). The Auto column displays the "best
guess" dividend payment schedule based on historical data. The Manual column shows the same values
(rather than an empty column), but the value is editable.
To edit dividends
1. Select the Manual radio button to make the manual column editable.
2. Double-click a dividend in the Manual column and enter a new value.
3. Click Apply to save your changes.
To change the number of dividends displayed, right-click in the table and select Add new to create a
blank editable row at the top of the table, or Remove Selected to delete the selected row.
To globally apply an offset value or percent to all manual entries, enter an offset amount in the Dividend
Offset field, and select the Percent or Absolute value radio button.
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The option model is calculated using the dividend schedule you specify by selecting the Auto or
Manual radio buttons.

Edit the Lending Yield
Adjust the underlying yield so that the stock lending rate is reflected in the model calculation using the
Lending Yield table. You will be able to edit the yield for any underlyings for which you have an option
displayed on the Quote Monitor. You must also have the Model and/or Imp Vol field displayed on the Quote
Monitor to see entries in the Model Navigator.
To open the Dividend Schedule Navigator
1. From the Analytical Tools menu, select Model Navigator.
2. Within the navigator, select the Dividend tab.
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The white fields are editable, and changes to the yield are reflected in the left page Yield field.
To edit the Lending Yield
1. Set the time in days when the rate will begin to decrease linearly with time.
2. Set the rate in basis points.
3. Set the time in days when the rate will decrease to zero.
4. Click Apply to incorporate the edited lending yield in the model calculation.

Edit the Volatility Profile
Edit mode allows you to create a new volatility curve plot for an expiry using a new set of volatility knots.
You can use this edited plot to calculate model prices and implied volatilities in TWS, and save your model
to use in comparison to Model Navigator-calculated plots.
By default, the Model Navigator’s sophisticated option model calculation engine uses the values in the plot
along with the calculated interest rate, dividends, underlying price and other parameters, to calculate the
Model price. If you prefer to calculate the model price using the pricing assumptions reflected in
an edited plot, you must apply the changes to your plot and leave it in Edit mode. Any expiry that
has a volatility curve plot in Edit mode will use this profile in the calculation of the Model price and Implied
Volatility.
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To edit a volatility curve plot
1. Right-click a volatility curve plot and select Edit.
Edit mode displays a series of brown volatility knots along the bottom of the plot. Grab and move these
knots up and down to create a volatility profile that you think more accurately represents the implied
volatility data. Applied changes to the plot are reflected in the Manual column of the expiry’s Volatility Curve
table.
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To see the values for the manual volatility curve reflected in the Volatility Curve table, be sure that you
have selected the expiry whose plot you are editing from the expiry dropdown list at the top of the table.
The table and plot work in both directions. You can modify the implied volatility of a knot in the plot by
changing the corresponding value in the table.
You can add and delete brown volatility knots in edit mode. To add a knot, point to where you would like
to add it and double-click. To delete a knot, select it and double-click.
Click Refit from the right-click menu to refit the manual volatility knots to the calculated volatility curve.
Compare volatility changes by saving and viewing historical profiles from using the Model History
command.
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To save a model
1. From the right-click menu, select Save Model.
2. Click Exit Edit to close editing mode.
The model is saved using the current date and time.

To display a model
1. From the right-click menu within a plot, select Model History.
2. Choose the historical model based on the date/time name.
3. Select Show.
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The saved model displays as a grey curve inside the real-time colored plot. You can also display saved
models under the Expiry in the left Contract Description pane.

Model Price Color Key
Model prices are displayed in color on the trading screen to help you see at a glance where they fall in
relation to the bid and ask prices. The color bar below shows the range within which model prices may fall.
Model price colors update with the underlying last price.
You must have the Model field displayed on your trading page to see the model price.

To show a field in TWS
Hold your mouse over any field until the "+" and "x" icons appear. Click the "+ " to display the list of available
fields. Note that if you hover your mouse over an order field, all available order fields are displayed. If you
hover over a market data field, all available market date fields are displayed.
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Note: Implied volatilities (in the Imp. Vol column) are always displayed in either pink or white. If
either the Model or Imp Vol(%) values are displayed in white, it means the model hasn't calculated
any prices or implied volatilities.
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Event Calendars
View Corporate Earnings, Corporate Events, Economic Events, Dividends, Splits and IPO/Secondary
Offerings from the unified Events Calendar.

To open the Event Calendar
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From the Mosaic Anchor Window, click the Event Calendar button.
The left side of the display provides filters to streamline the displayed data shown on the right. By default
the view opens to today's date, but you can click any date on the calendar widget to view events for that
day. Other filters include:
Filter by Company: Enter a symbol to filter out all data but for the specified company.
Only Show My Companies
If on, companies displayed in the individual sections are in your portfolio, a Watchlist, were recently
held by you, or are competitor companies of these. Filter further by unchecking any of the four "my
companies" selections.
If off, you will see full data including all companies returned by Thomson Reuters Street Events.
Corporate Actions
If on, all four sections of the Corporate Actions umbrella are displayed. Filter further by unchecking
one or more of the Corporate Action sub-categories.
Corporate Events - Toggle on or off to display or hide Corporate Events.
Economic Events - Toggle on or off to display or hide Economic Events.
Option Last Trade Dates - Toggle on or off to display or hide the Option Last Trade Dates section.
Region - Use the drop down selector box to view data for US, America Non-US, Europe, Asia, or all
regions.
The results of your filters are displayed in the large frame on the right side of the Calendars window.
Click an event to see more details.
Use the DAY/WEEK/MONTH buttons on the top right to view results for the selected day, week, or month.
Events shown in weekly or monthly view are identified by colored dots. Use the calendar widget in the Filter
section to select a different day, week or month.

Analyst Ratings (Summary)
Our sell-side Analyst Rating Summary tear sheet provides summary rating and price target statistics, along
with upgrade/downgrade history and TipRanks fundamental analysis. The Summary tab graphs mean
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ratings history, price target history and rating distribution over time. The Coverage tab displays TipRanks
Analyst Consensus and its breakdown, the Analyst Price Target, and a list of analysts.

To view Analyst Ratings (Summary)
From within Mosaic, use the New Window drop down to select Fundamentals then Analyst Ratings
(Summary).
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Ownership Tear Sheet
Detailed insider and institutional ownership statistics and graphs to incorporate into your investment
strategies. The Insider and Institutional Ownership tear sheet provides detailed institutional and insider
ownership rosters with a graph of ownership percentage over time, and an insider trade log.
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To view Ownership Tear Sheet
From within Mosaic, use the New Window drop down to select Fundamentals then Ownership).
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Wall Street Horizon Data
Subscribe to Wall Street Horizon to see ticker-specific events calendars and industry-related events for
thousands of companies worldwide. The Events Calendars display dates for earnings announcements,
shareholder meetings, investor conferences and other events, and provides links to Seeking Alpha
transcripts whenever available.
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To access the WSH Corporate Events Calendar
From Mosaic - From the New Window drop down select WSH Corporate Events Calendar.
From Classic TWS - From the Analytical Tools menu select WSH Corporate Events
Calendar.Then select My Portfolio to see events for companies in your portfolio, or Selected company
to see events for the company selected in the Quote Monitor. See below for detailed instructions on
company-specific display.
If you don't see this command listed in the Fundamentals section of the Analytical Tools men, use the
Expand arrow at the bottom of the list to display hidden menu items.
Select a future event in either table and click Set Alert to create a message or order action alert.
Click the blue hypertext to access a transcript.
You can also view the Events Calendar for one or multiple tickers.
To view Events for specific tickers
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1. Start in the Classic TWS interface.
2. From a Quote Monitor, select a ticker or select multiple tickers by holding down the Ctrl key and clicking the market data lines.
3. From the WSH Corporate Events Calendar menu command choose Selected company.
You can also view recent events for your portfolio, which comprises all of your current positions.
To view a Portfolio Events Calendar
1. From the Analytical Tools menu, select Event Calendar and then My Portfolio.
Note: If you have a large portfolio, it may take several minutes for all of the data to load. You may
want to consider viewing events for a subset of tickers using the procedure above.

Recent events are listed in the Events table, sorted by date.
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Click the Underlying field heading to re-sort the table by underlying. Click any other field to re-sort by
that field.
Hold your mouse over the Earnings Call Information icon to see dates for upcoming Earnings calls.
Select a line and click the Company Fundamentals button to open that tool for a single underlying.
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Reposition Charts

1146

Chart Multiple Assets

1147

Charts - Estimated Price Range

1150

Add New Chart to Existing Chart Window

1152

Save a Chart Layout as a Template

1154

Charting Expired Contracts

1155

Charts Toolbar

1157

Editing Charts

1163

Chart Display

1166

Move the Right Margin

1166

Add Alerts in Charts

1167

Chart Types & Tools

1169

Chart Indicators

1179

Apply ADX/DMI Indicator

1184

Accelerator/Decelerator Indicator

1186

Apply an Accumulation/Distribution Line

1188

Apply an Accumulation Swing Index Study

1189

Adaptive Moving Average

1190

Arnaud Legoux Moving Average

1191

Apply an Aroon Oscillator Indicator

1192

Apply an Aroon Up/Down Indicator

1193

Apply an Average True Range Indicator

1195
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Awesome Oscillator

1196

Balance of Power Indicator

1198

Bill Williams Alligator

1199

Bill Williams Alligator Oscillator

1200

Apply Bollinger Band Indicator

1201

Bollinger Band Width Indicator

1203

Apply Chaikin Money Flow Oscillator

1204

Apply a Chaikin Oscillator

1205

Camarilla Pivot Points

1206

DeMark Pivot Points

1209

Fibonacci Pivot Points

1211

Floor Pivot Points

1213

Woodie Pivot Points

1215

Chaikin Volatility Indicator

1217

Chande Kroll Stop

1218

Chande Momentum Oscillator

1219

Choppiness Index

1220

Chop Zone

1221

Connors RSI

1222

Coppock Curve

1223

Chande Volatility Index Dynamic Average (VIDYA)

1224

Apply a Commodity Channel Indicator (CCI)

1225
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Detrended Price Oscillator

1226

Departure Chart

1227

Directional Movement Index

1228

Apply a Donchian Channels Indicator

1229

Apply a Donchian Channel Width Indicator

1231

Apply a Double Exponential Moving Average (DEMA)

1232

Ease of Movement Indicator

1233

Apply an Elder-Ray Indicator

1234

Apply Envelope Indicator

1236

SMI Ergodic Oscillator

1237

Apply Exponential Moving Average Indicator

1238

Fast Stochastic Oscillator

1239

Fisher Transform Indicator

1241

Force Index

1242

Apply High Low Bands

1243

Historical Volatility Ratio

1244

Hull Moving Average

1245

Ichimoku Cloud

1246

Intraday Intensity Index Indicator

1247

Intraday Intensity Percent

1248

Intraday Volume Weighted Average Price

1250

Keltner Channel Indicator

1251
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Klinger Volume Oscillator

1252

Apply a Know Sure Thing (KST) Indicator

1253

Lane's Stochastic Oscillator

1256

Least Squares Moving Average

1257

Linear Regression Curve

1258

Linear Regression Indicator

1259

Linear Regression Intercept

1261

Linear Regression R-Squared

1261

Linear Regression Slope

1262

Apply MACD Indicator

1263

Apply a Mass Index Indicator

1265

McGinley Dynamic

1266

Apply a Momentum Indicator

1267

Moving Average Crossover

1268

Apply a Moving Standard Deviation Indicator

1270

Apply a Negative Volume Index Indicator

1271

Net Volume Indicator

1273

Apply an On Balance Volume Indicator

1274

Apply Parabolic SAR Indicator

1275

Percentage Price Oscillator

1277

Percentage Volume Oscillator

1278

Percent B Indicator

1279
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Performance Indicator

1280

Pivot Points

1282

Pivot Points High/Low

1283

Apply a Positive Volume Index (PVI) Indicator

1285

Price Oscillator

1287

Price Volume Trend Indicator

1288

Raff Channel Indicator

1288

Apply Rate of Change Indicator

1290

Relative Momentum Index

1291

Apply a Relative Strength Indicator

1292

Relative Vigor Index

1293

Relative Volatility Index

1294

Stochastic RSI Indicator

1295

Apply Simple Moving Average Indicator

1297

Slow Stochastic Oscillator

1298

Standard Deviation Channel

1299

Apply a Stochastic Oscillator Indicator

1300

Swing Index

1301

Apply a Triangular Moving Average (TMA) Indicator

1302

Apply a Triple Exponential Moving Average (TEMA) Indicator

1304

TRIX Indicator

1305

True Strength Index

1306
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Typical Price Indicator

1308

Apply an Ultimate Oscillator Indicator

1309

Variable Moving Average

1310

Vertical Horizontal Filter

1312

Volatility Stop

1313

Volume Exponential Moving Average

1314

Apply a Volume * Price Momentum Oscillator (PMO) Indicator

1315

Volume Oscillator

1317

Volume Rate of Change Indicator

1318

Volume Weighted Moving Average

1319

Vortex Indicator

1320

Wilder's Moving Average

1321

Apply a Williams Oscillator Indicator

1322

Weighted Close

1324

Apply Weighted Moving Average Indicator

1325

Zig Zag Indicator

1326

Bond Indicators

1327

Bond Search Query

1327

Bond Search Scatter Plot

1331

Bond Details Table

1332

Export Bond Details to Risk Navigator

1333
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Continuous Futures
When adding futures market data to TWS, you can now select a "continuous" futures contract, which is a
series of monthly/quarterly contracts spliced together.
When a futures contract expires (and if you have the feature enabled in Global Configuration), the system
will automatically add the new lead month futures contract and removed the expired contract. When you
use a Continuous Futures contract, it is no longer necessary to roll contracts, or to manually re-enter the
new lead month if Automatic Rollover is disabled.”Additionally, it allows you to chart the future across
multiple expiries, and apply moving averages and other technical studies that aren't relevant with the
limited life of a single monthly or quarterly contract.
Find out about...
Adding a continuous futures contract
Charting continuous futures
Generating normalized historical data series for Continuous Futures
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To enter a continuous futures contract using Mosaic Watchlist
Click in an empty row and enter the underlying symbol.
Hit enter, and select the futures contract from the list.
From the selector, choose the contract with the infinity sign (∞)which denotes a continuous futures
contract.
The market data line for the future will also show the infinity sign.
To see the Ratio Adjustment (RA) Points on a chart
Open the Charts>Settings page in Global Configuration and enable Show futures rollover points.
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Continuous Futures

Note that these continuous contracts are for market data only; orders on futures are not updated. If you
select a non-continuous contract, the Automatic Futures Rollover feature (if enabled) will notify you that the
contract is expiring.

To generate normalized historical data series for Continuous Futures
A "continuous futures" contract represents a sequence of successively expiring lead futures contracts
along with an associated interval during which each future is the lead. This allows us to construct a
normalized historical data series for the contract. For example, we can construct a continuous futures
contract for CL@NYMEX using the following contracts:
CL MAY'15
CL APR'15 20150317
CL MAR'15 20150217
CL FEB'15 20150115
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CL JAN'15 20141216
CL DEC'14 20141117
CL NOV'14 20141016
CL OCT'14 20140917
CL SEP'14 20140817
CL AUG'14 20140717
CL JUL'14 20140617
CL JUN'14 20140515
CL MAY'14 20140417
The above list of sequential contracts shows the lead end dates when the particular contract stops being
the lead contract and the next one takes over.
To generate a normalized historical data series for the above sequence, call CL MAY'15 as Contract A and
CL APR'15 as Contract B. Then follow the steps below:
Take the closing price of Contract B and Contract A on 20150317.
Calculate the ratio of closingPrice(Contract A)/closingPrice(Contract B).
Multiply all Contract B data for 20150317 and all prior dates by this ratio. This results in the adjusted time
series of Contract B having the SAME closing price on 20150317 as Contract A.
Repeat for prior months.

Mutual Fund/ETF Replicator
The Mutual Fund/ETF Replicator finds a single or compound ETF whose performance parallels that of a
user-specified Mutual Fund or ETF, but whose fees are generally lower. Once you enter the contract or
symbol and the investment amount, the replicator scans the market and returns the top single and
compound ETFs in the recommended quantity (based on the investment amount) whose performance
most closely follows that of your submitted asset. The Performance Analysis and Return Comparison
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panels display performance correlation characteristics including the correlation, tracking error and a
comparison of management fees.

Use the Mutual Fund/ETF Replicator
Open the Mutual Fund/ETF Replicator.
From Mosaic - From the New Window drop down select Mutual Fund/ETF Replicator.
From Classic TWS - From the Analytical Tools menu select Mutual Fund/ETF Replicator.
Enter the fund or ETF symbol, or click Browse Mutual Funds to search by fund family.
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Modify the investment amount, if desired.
View comparison between returned ETF(s) and the original entered contract.
This comparison is intended for information purposes only, and does not constitute a recommendation or
solicitation to buy or sell securities. There is no guarantee that any correlation displayed within this tool will
continue into the future, or that the displayed ETFs will have a similar investment return into the future as
the entered fund or ETF. Customers are solely responsible for their own trading decisions.

Time and Sales Data
You can elect to view the Time & Sales for any underlying.

To use Time & Sales
1. Open the Time & Sales window.
From Mosaic - From the New Window drop down select Time & Sales.
From Classic TWS - From the Analytical Tools menu select Time & Sales.
2. To change the underlying, select a new ticker in a grouped window, or enter the ticker symbol in the
entry field.
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Select from chart
From the Time & Sales Search menu, choose Select from chart. The chart for the active underlying opens
with the cursor in "Time and Sales" mode.
Click on the time/date you want reflected in the Time & Sales window.
To search for a date and time from a chart, use the "Select from chart" from the Search button.
See Trade Conditions
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In addition to using the mouse over feature, you can elect to add the Exchange and Conditions field to
the Time & Sales window to show trade conditions when available.
To configure the Time & Sales window or add/remove fields, access the Settings configuration page by
clicking the wrench icon.
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Performance Profile
The Performance Profile helps demonstrate the key performance characteristics of an option or complex
option strategy.
It comprises:
An enhanced Quote Details window that shows the Return-to-Risk ratio, Profit Probability and the
potential Max Return and Max Loss;
A Performance Graph that shows the P&L (or any of the Greeks) as a function of the underlying price;
The Scenarios window, which displays the effects of a change in underlying price on the P&L, the
Greeks (either the Instrument Greeks or the Position Greeks) and the volatility of a position.
To open the Performance Profile
You can open the option Performance Profile tool several ways:
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Right-click a strategy from the Portfolio or other tool and select Analytical Tools > Performance Profile.
From within the Order Entry panel for a strategy, set order parameters and click the Advanced icon.
Click the Margin/Performance button and ensure that Performance Profile is checked.
Within the Strategy Builder, click the "Profile" button below the strategy.

Virtual Securities
The Virtual Security feature provides the ability to view current pricing and chart historical pricing for a
synthetic security that you create by entering one or multiple underlyings in an equation using our flexible
Virtual Security Equation Builder. Once you have defined a Virtual Security and designated a ticker symbol
for it, it can be used throughout TWS in the quote and analytical tools. It cannot be used in any of the
trading tools.
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To create a virtual security
In the Quote Monitor, right-click in a blank line select Virtual Security.
Using the equation builder, define the custom security. Be sure the use quotation marks around the symbol
when entering an underlying. See example.
Enter a name for the virtual security and click OK.
The security is listed as a new contract in the Quote Monitor and displays the Last, Bid and Ask prices. You
can view the calculated market data and chart historical pricing for the synthetic ticker, but you can't use it in
any of the trading tools.

Price History
The Price History shows the Open, High, Low, Close and Volume by date, with the first line ticking realtime market data and corresponding to today's date.

Use the scroll bars on the right side to scroll up and down by date, and use the "Options" button at the
bottom of the scroll bar to go to a specific date/time, export the current table to Excel, and show
splits/dividends by opening the Adjustments field.
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To open the Price History window
From the New Window dropdown (or from the Mosaic Toolbox) click Price History.
If you open the Price History from the Mosaic Toolbox, the window will open linked to the same windows
group as the toolbox, and populated with that group's current underlying.

Market Scanners
Advanced Market Scanner

1115

Market Scanner Types

1117

US Corporate and Municipal Bond Scanners

1126

Non-Subscribed Scanner Locations

1130

After Hours Scanner Snapshot

1131

TICK & TRIN Market Indicators

1132

Advanced Market Scanner
The Advanced Market Scanners quickly scan of relevant markets and return the top contracts based on the
instrument, parameter and filtering criteria you define. In addition, you can transmit orders directly from a
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scanner, and save a scan as a template for later use.

To create an Advanced Market Scanner
From Mosaic - From the New Window drop down select Advanced Market Scanner.
From Classic TWS - From the Analytical Tools menu select Advanced Market Scanner. Use the
icons to the far right of the command to open the scanner as a new window (recommended) or as a
new tab.
Define Scan Criteria
1. Select an instrument type from the Instrument list. Note that the scan title changes with each selection to reflect the criterion you select.
2. Instruments are defined by region. “Global” scanners can scan an instrument across global markets.
3. Choose the location/exchange whose data will be included in the market scan. The valid locations
change in response to the instrument you selected in Step 1.
4. Use the Filter fields to narrow the contracts that will be returned in your query by characteristic. For
example, you may only want to see the Top% US Stock Gainers within a certain P/E range, or with a
capitalization above 2,000,000.
5. Choose a Scanner parameter, such as Top% Gainers, Hot Contracts by Price or Top Option Implied
Volatility in the Parameter field.
6. Click Search to return the top contracts that meet your search criteria. Data is updated every 60
seconds.
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Most scans return the top 50 contracts by default. You can specify the maximum number of returns using
the Max results field.
To save a scanner template
1. After you have defined the scan criteria, click the "Save" disk icon to the right of the Max Results
field.
2. Select Save Template.
3. Enter a descriptive file name and click Save.
To use a saved scanner template
1. From within a Market Scanner page, click the "Save" disk icon to the right of the Max Results field.
2. Select Load Template.
3. Select the scanner file you want to use and click Open.

Market Scanner Types
Available market scans change based on the Instrument/Location criteria you select.
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Market Scanner Parameters
Parameter

Description

Top%

Contracts whose last trade price shows the highest percent increase from the

Gainers

previous night's closing price.

Top%

Contracts whose last trade price shows the lowest percent increase from the

Losers

previous night's closing price.

Most

Contracts with the highest trading volume today, in terms of shares.

Active
Not Open

Contracts that have not traded today.

Most

Contracts with the highest trading volume in terms of dollar amount.

Active($)
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Most

Contracts with the highest average trading volume in terms of dollar amount. The

Active

volume is averaged over the past 90 days.

(Avg$)
Halted

Contracts for which trading has been halted.

Hot

Contracts where:

Contracts
by Price

(lastTradePrice-prevClose)/avgDailyChange is highest in absolute value (positive
or negative).
The avgDailyChange is defined as an exponential moving average of the
contract's (dailyClose-dailyOpen)
Exponential Moving Average calculation is: (price - close) / close /
historicalVolatility30

Hot
Contracts

Contracts where:
today'sVolume/avgDailyVolume is highest.

by Volume
avgDailyVolume is a 30-day exponential moving average of the contract's daily
volume.
Top Trade

The top trade count during the day.

Count
High

Returns the top 750 US stocks with the highest dividend per share yield.

Dividend
Yield
Top Trade

Contracts with the highest number of trades in the past 60 seconds (regardless of

Rate

the sizes of those trades). Displays the trades/minute field.

Top Price

The largest difference between today's high and low, or yesterday's close if

Range

outside of today's range.

Hot by

The largest price range (from Top Price Range calculation) over the volatility.

Price
Range
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The top volume rate per minute.

Volume
Rate
Top %

Shows contracts with the highest percent price INCREASE between the last

Gainers

trade and opening prices.

Since
Open
Top %

Shows contracts with the highest percent price DECREASE between the last

Losers

trade and opening prices.

Since
Open
Top Close-

Shows contracts with the highest percent price INCREASE between the previous

to-Open %

close and today's opening prices.

Gainers
Top Close-

Shows contracts with the highest percent price DECREASE between the

to-Open %

previous close and today's opening prices.

Losers
Highest

Shows the top underlying contracts (stocks or indices) with the highest vega-

Option Imp

weighted implied volatility of near-the-money options with an expiration date in the

Vol*

next two months.

Lowest

Shows the top underlying contracts (stocks or indices) with the lowest vega-

Option Imp

weighted implied volatility of near-the-money options with an expiration date in the

Vol*

next two months.

Top Option

Shows the top underlying contracts (stocks or indices) with the largest percent

Imp Vol %

gain between current implied volatility and yesterday's closing value of the 15

Gainers*

minute average of implied volatility.

Top Option

Shows the top underlying contracts (stocks or indices) with the largest percent

Imp Vol %

loss between current implied volatility and yesterday's closing value of the 15

Losers*

minute average of implied volatility.
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High

Shows the top underlying contracts (stocks or indices) with the largest divergence

Option Imp

between implied and historical volatilities.

Vol Over
Historical*
Low Option

Shows the top underlying contracts (stocks or indices) with the smallest

Imp Vol

divergence between implied and historical volatilities.

Over
Historical*
Most

Displays the most active contracts sorted descending by options volume.

Active by
Opt
Volume
Most

Returns the top 50 underlying contracts with the (highest number of outstanding

Active by

call contracts) + (highest number of outstanding put contracts)

Opt Open
Interest
High Opt

Put option volumes are divided by call option volumes and the top underlying

Volume

symbols with the highest ratios are displayed.

P/C Ratio
Low Opt

Put option volumes are divided by call option volumes and the top underlying

Volume

symbols with the lowest ratios are displayed.

P/C Ratio
High

Returns the top 50 contracts with the highest put/call ratio of outstanding option

Option

contracts.

Open
Interest
P/C Ratio
Low Option

Returns the top 50 contracts with the lowest put/call ratio of outstanding option

Open

contracts.
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Interest
P/C Ratio
Hot by

Shows the top underlying contracts for highest options volume over a 10-day

Option

average.

Volume
13-Week

The highest price for the past 13 weeks.

High
13-Week

The lowest price for the past 13 weeks.

Low
26-Week

The highest price for the past 26 weeks.

High
26-Week

The lowest price for the past 26 weeks.

Low
52-Week

The highest price for the past 52 weeks.

High
52-Week

The lowest price for the past 52 weeks.

Low
High

Returns the top 50 contracts with the highest Earnings Per Share growth rate.

Growth

Note that a new field, Growth Rate, is inserted after the Description field to

Rate

display the EPS per contract.

(Reuters)
Low

Returns the top 50 contracts with the lowest Earnings Per Share growth rate.

Growth

Note that a new field, Growth Rate, is inserted after the Description field to

Rate

display the EPS per contract.

(Reuters)
High P/E

Returns the top 50 contracts with the highest Price to Earnings ratio. Note that a

Ratio

new field, P/E Ratio, is inserted after the Description field to display the P/E ratio

(Reuters)

per contract.

TWS Guide

1122

Chapter 1

Market Scanner Types

Low P/E

Returns the top 50 contracts with the lowest Price to Earnings ratio. Note that a

Ratio

new field, P/E Ratio, is inserted after the Description field to display the P/E ratio

(Reuters)

per contract.

High Quick

Returns the top 50 contracts with the highest "Quick" ratio. Note that a new field,

Ratio

Quick Ratio, is inserted after the Description field to display the Quick Ratio per

(Reuters)

contract.

Low Quick

Returns the top 50 contracts with the lowest "Quick" ratio. Note that a new field,

Ratio

Quick Ratio, is inserted after the Description field to display the Quick Ratio per

(Reuters)

contract.

High

Returns the top 50 contracts with the highest dividend per share yield. Note that a

Dividend

new field, Div Per Share, is inserted after the Description field to display the per

Yield

share dividend yield per contract.

(Reuters)

Low

Returns the top 50 contracts with the lowest dividend per share yield. Note that a

Dividend

new field, Div Per Share, is inserted after the Description field to display the per

Yield

share dividend yield per contract.

(Reuters)

High

Returns the top 50 contracts with the highest return on equity. Note that a new

Return on

field, Return on Equity, is inserted after the Description field to display the return

Equity

on equity per contract.

TWS Guide

1123

Chapter 1

Market Scanner Types

(Reuters)

Low

Returns the top 50 contracts with the lowest return on equity. Note that a new

Return on

field, Return on Equity, is inserted after the Description field to display the return

Equity

on equity per contract.

(Reuters)

High

Returns the top 50 contracts with the highest price to book value per share ratio.

Price/Book

Note that a new field, Price/Book Ratio, is inserted after the Description field to

Ratio

display the return on equity per contract.

(Reuters)

Low

Returns the top 50 contracts with the lowest price to book value per share ratio.

Price/Book

Note that a new field, Price/Book Ratio, is inserted after the Description field to

Ratio

display the return on equity per contract.

(Reuters)

Market
Statistics

Let's you see exchange-specific statistics for:
• Advancing, declining and unchanged issues
• Up, down, unchanged and total volumes
• TRIN and TICK indicators
To use, select Market Statistics from the Instruments list, then select an
exchange from the Location dropdown.

High Synth

Highlights the highest synthetic EFP interest rates available. These rates are

Bid Rev

computed by taking the price differential between the SSF and the underlying

Yield

stock and netting dividends to calculate an annualized synthetic implied interest
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rate over the period of the SSF. The High rates may present an investment
opportunity.

Low Synth

Highlights the lowest synthetic EFP interest rates available. These rates are

Bid Rev

computed by taking the price differential between the SSF and the underlying

Yield

stock and netting dividends to calculate an annualized synthetic implied interest
rate over the period of the SSF. The Low rates may present a borrowing
opportunity.

Relevant

This tool scans the US market and returns all Exchange for Physicals relevant to

EFPs

your portfolio, based on the stock and SSF positions you currently hold. For more
information on using EFPs to reduce your trading cost, see the Relevant EFPs
user guide topic.

The following scanners are available, based on the selected instrument:

*30-day (V30) Implied Volatilities:
Implied volatility is calculated using a 100-step binary tree for American style options, and a Black-Scholes
model for European style options. Interest rates are calculated using the settlement prices from the day’s
Eurodollar futures contracts, and dividends are based on historical payouts.
The 30-day volatility is the at-market volatility estimated for a maturity thirty calendar days forward of the
current trading day. It is based on option prices from two consecutive expiration months. The first expiration
month is that which has at least eight calendar days to run. The implied volatility is estimated for the eight
options on the four closest to market strikes in each expiry. The implied volatilities are fit to a parabola as a
function of the strike price for each expiry. The at-the-market implied volatility for an expiry is then taken to
be the value of the fit parabola at the expected future price for the expiry. A linear interpolation (or
extrapolation, as required) of the 30-day variance based on the squares of the at-market volatilities is
performed. V30 is then the square root of the estimated variance. If there is no first expiration month with
less than sixty calendar days to run, we do not calculate a V30.
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US Corporate and Municipal Bond Scanners
The US Corporate- and US Municipal Bond Scanners include filters and parameters specific to the needs
of bonds traders.

To scan for US Corporate Bonds
1. From the Analytical Tools menu, select Market Scanner.
2. Select US Corporate Bonds or US Municipal Bonds as the instrument type.
3. Define optional filters to control the search results:

TWS Guide

1126

Chapter 1

TWS Guide

US Corporate and Municipal Bond Scanners

1127

Chapter 1

TWS Guide

US Corporate and Municipal Bond Scanners

1128

Chapter 1

TWS Guide

US Corporate and Municipal Bond Scanners

1129

Chapter 1

Non-Subscribed Scanner Locations

4. Set the sort criteria for results display, and click Search.

Non-Subscribed Scanner Locations
Market scanners support limited returns when you select a non-subscribed location, which displays in
italics with a lock icon indicating a restricted search. If you choose to include a non-subscribed location, the
results may include contracts from the location but no market data.
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In the above scan, Hong Kong (HKFE) is a non-subscribed location. When it is checked to include in the
scan, the scan parameters also display in italics to indicate that the results include non-subscribed data.
When you click Search to run the scan, you will receive a notification that you have included assets from
non-subscribed exchanges, and you have the option to add a market data subscription directly from this
box.

From the scan results, you can also elect to subscribe to the location, or to receive free delayed (nonsubscribed) market data. If you elect to receive delayed data, the data line will be highlighted in yellow as
an indication. In the above scan, the markets are closed and you are viewing an After Hours Scanner
Snapshot, indicated by the grey background.

After Hours Scanner Snapshot
When all trading has stopped including extended hours trading, you can still use most TWS Market
Scanners (with the exception of penny option and EFP scanners).
After-hour scanners use data from the previous close to provide a static snapshot as of the market's close.
A scan displaying snapshot data is identified by a gray background color in the Scanner display.
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TICK & TRIN Market Indicators
Use market indicators to help spot trends. The Tick Index indicator shows the number of stocks trading on
an uptick minus the number of stocks trading on a downtick. The TRIN (Trader's Index) indicator is a
technical analysis indicator calculated by dividing the advances-to-declines spread by the volume of
advances to declines.

To see tick and trin indicators
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1. use the Search feature to enter “tick” or “trin” and select the index you want to view.
The date lines appear on your trading window, and the Index Arb meter opens with the Index Price. Note
that you can not trade these indexes.
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Chart Types & Tools

1169

Create a Real-time Chart
You can define parameters to display a real-time line or bar chart for all supported contracts.
Charts are not supported for mutual funds.

Some of the features of a real-time chart are captured in the above image.
1. Chart Dashboard/Menu allows you to quickly change the underlying, time period and chart display
type and Save Templates (File menu) access Chart Parameters, Studies, and Global Configuration
(Edit menu) and easily control hide/display attributes of the chart's components (View menu)
2. Chart Toolbar - Provides quick-click access to add commentary, edit the chart, zoom in and out,
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change the cursor to a crosshair, increase or decrease the bar width for a bar chart, and open Global
Configuration.
3. The customizable Quote Zone makes relevant data immediately visible on the chart. To
add/remove fields from the Quote Zone, right-click and select Configure Quote Zone.
4. Action Buttons - Click a button to arm the cursor with the selected function. Click in the chart at the
desired price level to create a price alert, sell order or buy order at the selected price. The order
displays on the chart and in the ChartTrader panel if you have that opened (via Chart Parameters).
5. Hot Buttons - Check the "Armed" checkbox to activate Instantaneous Transmission. Click a button
to arm the cursor with the selected function. Click in the chart at the desired price level to immediately transmit a price alert, sell order or buy order at the selected price. Enable via the Hot Buttons checkbox in the Additional Data and Features section of the Chart Parameters window.
6. Vertical Scrollbar allows you to quickly increase or decrease the visible price range. Once you use
the scrollbar, the price update is locked and you must unlock using the price icon for real-time
updates. The blue arrow icon allows you to add a degree of vertical buffer to the chart with each
click.
7. The Bar Details Zone provides detailed information for a specific bar in the chart. We have
displayed it for information only, since the image depicts a line chart.
8. If enabled, the ChartTrader displays once you have created an order using the Buy or Sell hot
buttons. Enable via the ChartTrader checkbox in the Additional Data and Features section of the
Chart Parameters window.
To create a chart
From Mosaic - From the New Window drop down select Chart.
From Classic TWS - From the Analytical Tools menu select Chart. Enter Chart Parameters.

Chart Parameters
You can set chart parameters when you open a chart, and modify parameters from within a chart using the
Edit menu.
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Field

Description

Time Period

Choose a time period and interval along with the
denomination of bar or line for the chart.
If you select an Automatic chart, you are selection only
the interval and denomination. You will be able to modify
the time period using the drag bar within the chart.
Click the Customize Menu link to define custom time
periods/intervals.

What to show:

Choose the primary display: Trades, Midpoint, Bid/Ask,
Option Volume, Historical Volatility, Option Implied
Volatility, Option Open Interest.

Bar Type

Choose the type of bar if applicable, either High Low Bar,
Candlestick, Hollow Candles or Heikin-Ashi.
The Hollow Candles display green unfilled candlesticks
when that period's close is higher than its open.
The Heikin-Ashi candles use the open-close data fro the
prior period with the open/high/low/close data from the
current period to create a combo candlestick.
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Note that selections will be grayed out when unavailable,
based on other time period selections.
Volume Plot Height

This applies to the plot height of additional plots such as
Volume.
When checked, prices are adjusted for dividends on the

Adjust for Dividends

chart. The day before the dividend date the dividend
amount is subtracted from the close price.
This action is completed automatically if you add a
second ticker for comparison to the chart.
Show # bars

Enter the number of bars to display on the chart, and
check to enforce this attribute. When checked, the
number of bars remains consistent regardless of
changes to the Time period or other variables.

Manual Vertical Scale

Define a price range to scale the vertical axis for the
chart. If checked, click the yellow lock icon that will
appear in the chart to re-enable auto-scaling.

Additional Data and Features

Additional data shown in your chart parameters box is dependent on the selections you set as the primary
parameters. The table below lists all potential options. Because they are context-sensitive, you won’t see
all of them at the same time.

Field & Description
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Bid/Ask or Midpoint or Trades

Volume Histogram

Shows a secondary plot along with your

Shows the daily trading volumes at each

primary plot. Display will change based on

price point in a separate area of the chart.

your primary plot, i.e. if you show Trades as
the primary, your options will include Bid/Ask
and Midpoint.
Daily P&L

Total call and put

Option volume

Displays daily profit

value

Charts call and put volume in the Option

and loss for the

For option settings

Volume sub-chart.

contract.

such as open interest
and volume, check to
display the total value
for calls and puts.

Historical volatility

Option implied

Option open interest

Displays actual

volatility

Chart put and call open interest on the Open

historical volatility.

Charts implied

Interest sub-chart.

volatility in a Volatility
sub-chart.
Put-call ratio

Crosshair

Legend

Shows the put-call

Displays the cursor

Hide or display the chart legend.

ratio in a sub-chart.

as a crosshair on the

Note that you must

chart.

display Option
Volume or Option
Open Interest to
enable the put-call
ratio.
Prior close

Quote zone

Quote panel

Displays the prior

Display market data

Display the traditional Quote Panel above the

day’s closing price for

for the contract

chart.
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the contract.

directly in the chart.

Hot buttons

Buttons panel

ChartTrader

Display the Buy, Sell

Display the

Displays the Orders, Log, Trades and

and Alert hot buttons

configurable Buttons

Portfolio tabs along the top of the chart.

in the chart.

panel along the

These panels will also open automatically

bottom of the chart.

when you create an order.

The button arms the
cursor to complete
the selected action.
Completed trades
Displays the Show
Trades checkboxes
along the top of the
chart.

Volume

Logarithmic Scale

Plots trade volume in

Change the increments on the price axis to

a sub-chart. Set the

represent price change by "percentage

Volume Plot Height

change"- rather than "dollar-value" change.

above if desired.

Using Log Scale, a $5.00 change from 10 to
15 represents a 50% price change, while a
$5.00 change from 20 to 25 is a 25% change.

Highlight on Chart

Define the extras you want to have highlighted on your chart.

Field

Description

Splits and

Shows splits and dividends on the underlying.

dividends
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Order description

Includes order information directly in the chart.

My trades

Highlights the trades you made on the
underlying.

Highlight on Y axis

Specify that any of the following items be highlighted along the Y-axis in the chart.

Field

Description

Bid/ask

Highlights the bid and ask prices.

Last

Highlights the last traded price.

High/Low

Highlights the current high and low of the underlying.

Cursor price

Highlights the current price level of your mouse
cursor.

Vertical Buffer

A vertical buffer makes the price range on a chart larger than necessary to give extra space at the top and
bottom of the actual chart. When you add a vertical buffer, the chart automatically scales to accommodate
a wider price range. You can elect to:
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Field

Description

Scale to Fit

Y-axis (price) scaling will accommodate any studies to

Studies

ensure that they are visible in the new scaled layout.

Ignore

Y-axis (price) scaling ignores any studies and applies

Studies

scaling only based on price.

Display

Checked by default. Uncheck to removed the vertical

Vertical

scrollbar from the scaled chart.

Scrollbar
Chart Time Options

Set time options for this chart.

Field

Description

Keep chart up-

Check to have chart update in real-time.

to-date
Show data

If checked, displays charts for exchanges that trade extended

outside of

hours, like Globex.

regular trading
hours
Show data in
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user time zone

uses the time zone from the contract’s listed market.

Set ignored

Define a time interval that will be ignored when charting the

daily time

underlying.

interval
Bypass this

If checked, these settings are applied to the next chart you open

dialog when

without displaying this dialog box. You can modify settings by

opening a new

selecting Chart Parameters from the Chart menu.

chart

Thumbnail Charts
Thumbnails are small floating charts that provide at-a-glance tracking.

To create a thumbnail chart
1. Select an underlying on a Quote Monitor.
2. Use the right-click menu to select Analytical Tools>Technical>Thumbnail Chart.
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The small chart can be moved to any area of your desktop, and can be reduced or enlarged by grabbing
and dragging one of sides.

Time Period Charts
You can quickly change or create new Time Period charts from the chart dashboard.

To change a time period
1. From the dropdown list in the dashboard, you can:
Click a new time period/denomination pair (the current set shows a checkmark).
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Use the denomination dropdown on any time period and choose a new one. For example,
change the 2 days/5 min bars to 2 days/15 min bars.
Use the Other dropdown to create a new time period/denomination pair.

Automatic Charts
Quickly create an automatic chart that lets you quickly pick the bar denomination (5 minute bars, daily bars
etc) independent of the time period, using the chart dashboard.

To create an automatic char
1. From the dropdown list in the dashboard, select an automatic chart.
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You cannot create custom displays for automatic charts, but must choose from the pre-defined displayed
or Other charts.

Chart Combos
TWS will chart a combination comprised of multiple legs, but you must first specify that you want to have
the combo charted. Due to the capacity for pacing market data requests, charting a combo may result in
very slow load times for your charts.

To chart a combo
1. Select the market data line for the combination from the Quote Monitor.
2. Use the right-click menu to select Charts then New Chart.
3. Define the parameters for the chart and click OK.
4. Decide how you want to handle charting of combo orders:
a. Chart this combo now provides a one-time charting action for the current combo.
b. Always chart this combo will bypass this selection box the next time you choose to chart the
specific combo.
c. Always chart all combos will bypass this selection box for all combo charts.

TWS Guide

1145

Chapter 1

Reposition Charts

The combination is charted.

Reposition Charts
Grab and move the chart within its frame to view different time and price areas of the chart. Repositioning
the chart results in a snapshot view of the chart with locked data. The chart must be unlocked to reestablish
realtime price updates.
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To reposition a chart
1. Within a chart, use the View menu to select Reposition. The cursor changes to a pointing hand.
2. Move this cursor to an area in the chart you want to move, and click the mouse. The cursor changes
to the “move” icon.
3. Keeping the mouse key depressed, slide the chart around to reposition. The vertical sliders and price
axis adjust according.
4. Release the mouse key to disable Reposition mode.

To resume price updates
Click the yellow lock on the price axis that signifies snapshot mode.

Chart Multiple Assets
You can chart two or more assets on the same chart for comparison.
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To chart multiple assets
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1. From the Edit menu, select Secondary Series.
2. In the Contract section, enter the underlying symbol and select the contract.

3. Select the source for the plot:
Trades shows the prices at which orders executed.
Midpoint plots the midpoint of the current best bid/ask price.
Bid/Ask shows the best bid and best ask.
4. Choose the Axis Selection and Scale Type:
Primary with Auto Scale automatically scales and plots the secondary contract relative to
the price for the primary contract.
Primary with None does not scale the secondary contract and modifies the price axis to
include the price range for both contracts.
Secondary with Auto Scale automatically scales and plots the secondary contract and
shows the scaled, secondary price axis along the right side of the plot.
Secondary with None shows the secondary price axis along the right side of the chart and
plots the secondary series with no scaling along that secondary price axis.
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5. If you select Auto Scale:
In the Lines meet at: field you can enter a date different from the starting date of the time period at which
the two points in the chart will meet. By default, lines meet at the starting date of the time period and are
auto-scaled accordingly.
6. Click OK. All contracts are charted in different colors, defined by a key along the bottom of the chart.

Charts - Estimated Price Range
The Estimated Price Range presents a graphical representation of the estimated price range of an asset to
one, two or three standard deviations. The estimated range is calculated based on the current price, the
implied volatility of the symbol's option, and the distance in time from "now." The graphical representation
uses a blue shaded area to chart the estimated range over time.
This feature is only available for contracts that have options.
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To display the Estimated Price Range
Ensure that the feature is activated in the Chart Parameters box.
Grab the right margin arrow to the left to expose the blue Estimated Price Range graphic.
Slide the margin line to the left or right to see the estimated price range for specific days.
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To enable Estimated Price Range
Open the Chart Parameters box (from Mosaic use the File menu; from TWS use the Edit menu).
Check Estimated Price Range and specify the number of standard deviations.
Click OK.

Add New Chart to Existing Chart Window
You can elect to include multiple charts within a single window, use auto display features to arrange the
charts, and share trendlines among charts with the same underlying.
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To add a new chart to an existing chart window
1. From the File menu, select Add Chart to Window.
2. If you want the chart to use the same security that the existing chart uses, check Sub-chart uses current security. Checking this feature pre-populates the contract description in the Chart Parameters
box. If you're adding a chart for a different security, uncheck this selection.
If you have charted multiple contracts in the same chart, the Current Security refers to the symbol used to
create the original chart.
3. Define the new chart in the Chart Parameters box and click OK. Both charts appear in the charts
frame.
To arrange multiple charts within a window
On the chart's View menu, select Chart Tiling. Choose from Gird, Horizontal, Vertical, or Custom. All
charts in the window conform to the selected tiling design.
To share trendlines for the same contract among charts
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If you have charts for the same underlying, you can choose to apply a trendline action to all of the charts by
activating the Share Trendlines feature.
1. Click the Configure wrench from the chart window.
2. In the Settings page, check Share trendline among charts.

Save a Chart Layout as a Template
You can reuse the layout of a favorite chart by saving the chart as a template and then reapplying the
template to other contracts.

To create a chart template
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1. Create a real-time chart or group of charts with all parameters defined.
2. On the chart's File menu, select Save Chart Template.
3. Give the template a descriptive name by replacing "untitled" in the Template File field with a chart
name.
Note: In cases where you are saving a template with more than one chart, click the Advanced
button to specify which chart is Replaceable when you open the template. You must have at least
one chart labeled “Replaceable.”
4. Click OK to save the template.
To use a template to create a new chart
1. On the chart's File menu, select Open Chart Template.
2. Select the chart template you want to open from the Template File list, or use the Browse button to
find the template you want to use.
3. Enter new contracts by entering the underlying symbol in the Underlying field
4. Click OK to see the new chart based on your saved template.

Charting Expired Contracts
You can chart data for expired futures contracts on the real-time charts. In addition, if you want to chart an
expired contract that is not currently on your trading screen, you can add the contract.
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To add an expired futures contract to the trading window
1. Enter the underlying symbol and hit enter, then choose Futures from the instrument type list.
2. At the bottom of the expiry list, select Expired, and then choose the expired contract you want to
chart by selecting the expiry month and year.
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3. If you would like market data for the underlying as well, click Yes at the message asking if you want
to add the underlying.
To chart an expired contract
1. Select the expired contract and from the right-click menu select Charts, then select New Chart.
2. Set your chart criteria for the contract.

Charts Toolbar
Use the icons on the toolbar to initiate an action. For instructions on how to add or remove buttons from the
toolbar, use the charts Configuration topic.
Icon

Action

Description

Chart

Opens the Chart Parameters dialog box where you set or modify

Parameters

criteria for the chart display.

Show/Hide

Opens (or hides) the ChartTrader tool, which lets you submit

ChartTrader

trades directly from a chart.

Show/Hide

Allows you to change the time period and interval for the active

Time

chart.

Parameters
panel

TWS Guide
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Print

Prints the selected chart.

Shift Time

Set a new date and time for the chart data.

Period...

Shift Time
Period to
Present

Add Contract

Resets the time period to the current data/time.
The icon that reflects the type of time period in use will be greyed
out.
Define chart parameters for a new asset which is added to the
current chart.

Add Study

Click the dropdown arrow next to the icon to select a chart study.

Add New

This button allows you to quickly add another chart to the open

Chart

chart window. To start with the same contract information, check
Sub-chart uses current security in the pop-up box.

TWS Guide
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Commentary

displayed on the chart in a commentary box.
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Remove All

Deletes all commentary boxes from the chart.

Commentaries

Compare to

Charts the selected index on the active chart.

Index
Tile Charts

Automatically resizes and arranges multiple charts into the
pattern you specify using the dropdown arrow. Choose from grid,
horizontal, vertical, or custom.

Modify or

Click the dropdown arrow next to the icon to modify or remove the

Remove

selected asset or study from a chart. This feature works for single
charts with multiple assets or studies. It will not include multiple
charts within a single chart frame.

Show bars

For a candlestick chart, click to change to bars.

Show

For a bar chart, click to change to candlestick display.

candlesticks

Show/Hide

The icon that reflects the current chart type is greyed out.

Displays or hides the Volume panel on the bottom of the chart.

Volume

Time & Sales

Click to change the cursor to the Time & Sales line. Click on a
time, and the Time & Sales data page opens for that time. To
change the cursor back, click the Switch to Crosshair icon.
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Toggle

Changes the cursor to a crosshair. Note that if you don't have the

Crosshair

Show horizontal crosshair line enabled in Global Configuration,
you will only see a vertical line when you are in this mode.

Edit Chart

A selected trendline will now display a white square at either end.
When you click and pull an end, you can rotate the trendline 360
degrees and shorten or lengthen the line. Clicking in the line area
still allows you to move the trendline while maintaining the same
length and angle to the chart. Right-clicking the trendline allows
you to change the color of the line, the thickness of the line, or
remove the line.

Undo

Click to undo the last action.

Redo

Click to reapply the last undone action.

Add Horizontal

Turns the cursor to a horizontal trendline. Click in the chart to set

Trendline

the trendline. To change the cursor back, click the Switch to
Crosshair icon.

Add Vertical

Turns the cursor to a vertical trendline. Click in the chart to set the

Trendline

trendline. To change the cursor back, click the Switch to
Crosshair icon.

Add Fibonacci

Inserts a Fibonacci trendline to the chart.

Line
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Remove

Removes the selected trendline. To change the cursor back, click

Selected

the Switch to Crosshair icon.

Trendline

Remove all

Removes all trendlines from the active chart.

Trendlines

Zoom in

Zooms in to an area on the chart. You can scroll to a new area in
the zoom in box.

Zoom out

Zooms out to give you a bigger view of the chart area.

Switch to

This icon becomes active after you have zoomed in. Click to

smaller bars

display smaller bars.

Enter visible

Opens the Visible Range dialog where you enter the price range

range

that will be visible in the chart.

Clear range

Clears the previously set Visible (price) Range.

entered
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Add Horizontal

Creates a "zoom out" effect by condensing the current view and

Space to

adding more time intervals to the right side of the chart.

Chart

Remove

Removes time intervals to create a "zoom in" effect.

Horizontal
Space from
Chart
Add Vertical

Creates a vertical "zoom out" effect by condensing the current

Space to

view and adding more price intervals to the top of the price axis.

Chart

Remove

Removes price intervals from the top of the chart to create a

Vertical Space

"zoom in" effect.

from Chart

TWS Guide

Increase Bar

Increase the width of bars in the bar chart by 1 pixel per click of

Width

the icon.

Decrease Bar

Decreases the width of bars in the bar chart by 1 pixel per click of

Width

the icon.

1162

Chapter 1

Editing Charts

Configure

Opens the Global Configuration window with Chart Colors

Chart Colors

selected. Change the colors displayed on different chart
parameters.

Refresh

Refreshes chart data.

Configure

Opens the Global Configuration window for Chart configuration.

Editing Charts
The right-click Edit menu for trendlines, indicators, bars and other chart display items lets you hide,
remove, and change the data, color, and thickness of items to customize your chart and make it easier to
read.
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To use the charts editing feature
1. Select a display feature for editing by holding your mouse over the chart item. An item is "selected"
when it changes color.
2. Right-click and apply the desired edit to your display.
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The right-click menu is context-sensitive to display only applicable editing choices based on the item you
selected. For example, if you select a bar in a bar chart, the right-click menu choices include Remove Bar,
Replace Bar Data and Change Bar Color. If you select a plotted line from an indicator, the right-click menu
choices include Hide Indicator, Change Indicator Thickness and Change Indicator Color.
To undo an edit
Use the Undo or Redo icons on the chart toolbar to remove or reapply the last editing function you performed.

To hide and show indicator lines
1. Select an indicator line by holding your mouse over the line. It changes color to indicate that it has
been selected.
2. Right-click and check "Hide Indicator name." The line disappears, and the color key block turns grey.
3. To show a hidden line, slowly move your mouse up the chart until the hidden line displays in grey.
4. Right-click and check "Show Indicator name." The line reappears, and the color key block returns to
its original color to match the line.

TWS Guide

1165

Chapter 1

Chart Display

Chart Display
TWS displays upcoming splits and dividends directly on your chart. When this feature is enabled, events
will be visible on the chart when you open it, with splits in magenta and dividends in yellow. When you hold
your mouse over the event, a pop-up box displays details.

To view splits and dividends on charts
1. In the Global Configuration panel, select Charts and then Settings in the left pane.
2. In the Highlight on chart area of the Settings page, check Splits and dividends.

Move the Right Margin
A movable right margin allows you to move the chart data to the left while still allowing studies and
trendlines to continue into the future.
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To move the right margin
1. Hover your mouse along the right margin until the cursor changes to a double-sided blue arrow and
the margin line turns purple.
2. Click and drag the margin to the left.
3. Release to reposition the margin at a new point.
To reset the margin
Right-click on the margin line and select Reset Margin.

Add Alerts in Charts
You can set price alerts quickly within a chart using the Alerts hot button.
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To create an alert from within a chart
1. Ensure that you have Hot Buttons activated from the View menu.
2. Click the Alert hot button. The curser becomes a dotted line.
3. Click at the price level you want to use for the alert.
4. In the Configure Chart Alert dialog box, verify or change the trigger Method, Operator and Price trigger.
For more details on setting Alerts, see the Alerts and Notifications topic.
A labeled Alert line is positioned on the chart.
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Chart Types & Tools
Chart Arithmetic

ChartTrader
Create a Bar Chart
Create a Line Chart
Time and Sales Data
View MarketWatch Historical Charts
Apply Fibonacci Trend Lines

Chart Arithmetic
You can add or subtract the bid/ask average prices for two or more contracts, and chart the sum as a single
value.
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To chart combined contracts
1. Select an underlying and use the right-click menu to select Charts then New Chart.
2. Select the Combined Contracts radio button at the top of the New Chart window.
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If the Combined Contracts selection at the top of the parameters window is not available, you will
need to disable the last checkbox on the page, Bypass this dialog when opening a new chart which is
enabled by default. Disable this feature and click OK, then create your new chart. The Combined
Contracts feature will now be available.
3. In the contracts table, define multiple contracts.
4. To subtract a value, use the Ratio field to enter a minus sign in front of the ratio, or check Show difference at the top of the window.
5. If desired, enter an offset amount.
6. Choose the Time Period.
7. Click OK.
A combined chart looks like this:

Autofit Combined Charts
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The chart arithmetic feature includes the ability to mathematically calculate the ratios for one or more
contracts to approximate as closely as possible the chart for a single contract or index. You can elect to
show both the primary and the autofitted charts, or just see the difference by checking Show Difference.
The ratios and offsets for the autofits are calculated using the algorithm for fitting least squares regression
problems under non-negativity constraints. Details are described by Lawson & Hanson in "Solving Least
Squares Problems."
To use the Autofit Chart feature
1. Check the Autofit checkbox at the top of the window.Use the Show difference checkbox to see a
single autofitted chart equal to the difference between the primary chart and the autofit.
2. In the contracts table, define multiple contracts. The first instrument you list will be the primary, and
those that follow will be autofitted to the primary.
You must either check the Autofit box before you list the instruments you want to chart, or select all
underlyings you want to include in the autofit before you check the box.
A chart using just Autofit looks like this:
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A chart using both Autofit and Show difference looks like this:

IChartTrader
Transmit orders instantaneously from a chart using the armed Hot Buttons, or create an order from the
buttons panel and modify it on the Orders tab.
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To create an order in ChartTrader
1. Click the blue Buy button to create a buy order, or the Red sell button to create a sell order. The
cursor becomes a dotted line.
2. Move your cursor into the chart and position the dotted line at the order price you want. Note that
your exact price position is highlighted along the price axis.
3. Click to create an order. The order is displayed in the Quote panel, and can be modified. If the order
was not transmitted instantaneously, you must transmit the order.
Orders are transmitted instantaneously when an asterisk(*) appears next to the button title, or when you
activate the cursor using the armed Hot Buttons.
Orders that you create using ChartTrader also display on the Trading page that displays the contract data.
Trading pages that hold an order display the page title in red.
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Create a Bar Chart
To create a bar chart
1. Select the contract for which you want to create a chart, and from the right-click menu select Charts
and then New Chart.
2. In the Time Period selector, choose a "bars" interval.

3. Define remaining chart parameters and click OK to display your chart.

To create a candlestick chart, choose Candlestick as the Bar type.
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Create a Line Chart
To create a line chart
1. Select the contract for which you want to create a chart, and from the right-click menu select Charts
and then New Chart.
2. In the Time Period selector, choose a "line" interval.
3. Click OK to view the chart. For details on all of the setting you can use, see the Create a Real-time
Chart overview topic.
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Apply Fibonacci Trend Lines
The Fibonacci trendlines may be used to help determine price support/resistance at or near certain levels.
The Fibonacci lines occur at 0.0%, 23.6%, 38.2%, 50.0%, 61.8%, 76.4% and 100.0%. Retracements
occurring at these points within a trend could be used to help determine entry and exit points for a contract.

To add Fibonacci lines to a chart
1. From within a chart, use the Annotate menu to select Fibonacci Retracement/Extension.
2. Click your mouse at a peak or low point in the chart and pull to down/up and to the right across the
chart.
3. A series of seven colored trendlines are drawn at 0.0%, 23.6%, 38.2%, 50.0%, 61.8%, 76.4% and
100.0%.
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To delete a Fibonacci series of trendlines
Click the Remove All Trendlines icon, located three icons to the right from the Add Fibonacci Line icon.

View MarketWatch Historical Charts
Define a historical chart using a time period from 1 day to one decade. You can also create interactive
charts that update in real-time.
To view historical charts
1. On a quote monitor, highlight a contract and use the right-click menu to select Charts, then select
MarketWatch Chart.
2. Define chart parameters such as time frame, events, index comparison and moving average, then
click Draw Chart.
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Any time you modify chart parameters, you must click Draw Chart to update.

Chart Indicators
Apply ADX/DMI Indicator

1184

Accelerator/Decelerator Indicator

1186

Apply an Accumulation/Distribution Line

1188

Apply an Accumulation Swing Index Study

1189

Adaptive Moving Average

1190

Arnaud Legoux Moving Average

1191

Apply an Aroon Oscillator Indicator

1192

Apply an Aroon Up/Down Indicator

1193
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Apply an Average True Range Indicator

1195

Awesome Oscillator

1196

Balance of Power Indicator

1198

Bill Williams Alligator

1199

Bill Williams Alligator Oscillator

1200

Apply Bollinger Band Indicator

1201

Bollinger Band Width Indicator

1203

Apply Chaikin Money Flow Oscillator

1204

Apply a Chaikin Oscillator

1205

Camarilla Pivot Points

1206

DeMark Pivot Points

1209

Fibonacci Pivot Points

1211

Floor Pivot Points

1213

Woodie Pivot Points

1215

Chaikin Volatility Indicator

1217

Chande Kroll Stop

1218

Chande Momentum Oscillator

1219

Choppiness Index

1220

Chop Zone

1221

Connors RSI

1222

Coppock Curve

1223

Chande Volatility Index Dynamic Average (VIDYA)

1224
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Apply a Commodity Channel Indicator (CCI)

1225

Detrended Price Oscillator

1226

Departure Chart

1227

Directional Movement Index

1228

Apply a Donchian Channels Indicator

1229

Apply a Donchian Channel Width Indicator

1231

Apply a Double Exponential Moving Average (DEMA)

1232

Ease of Movement Indicator

1233

Apply an Elder-Ray Indicator

1234

Apply Envelope Indicator

1236

SMI Ergodic Oscillator

1237

Apply Exponential Moving Average Indicator

1238

Fast Stochastic Oscillator

1239

Fisher Transform Indicator

1241

Force Index

1242

Apply High Low Bands

1243

Historical Volatility Ratio

1244

Hull Moving Average

1245

Ichimoku Cloud

1246

Intraday Intensity Index Indicator

1247

Intraday Intensity Percent

1248

Intraday Volume Weighted Average Price

1250
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Keltner Channel Indicator

1251

Klinger Volume Oscillator

1252

Apply a Know Sure Thing (KST) Indicator

1253

Lane's Stochastic Oscillator

1256

Least Squares Moving Average

1257

Linear Regression Curve

1258

Linear Regression Indicator

1259

Linear Regression Intercept

1261

Linear Regression R-Squared

1261

Linear Regression Slope

1262

Apply MACD Indicator

1263

Apply a Mass Index Indicator

1265

McGinley Dynamic

1266

Apply a Momentum Indicator

1267

Moving Average Crossover

1268

Apply a Moving Standard Deviation Indicator

1270

Apply a Negative Volume Index Indicator

1271

Net Volume Indicator

1273

Apply an On Balance Volume Indicator

1274

Apply Parabolic SAR Indicator

1275

Percentage Price Oscillator

1277

Percentage Volume Oscillator

1278
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Percent B Indicator

1279

Performance Indicator

1280

Pivot Points

1282

Pivot Points High/Low

1283

Apply a Positive Volume Index (PVI) Indicator

1285

Price Oscillator

1287

Price Volume Trend Indicator

1288

Raff Channel Indicator

1288

Apply Rate of Change Indicator

1290

Relative Momentum Index

1291

Apply a Relative Strength Indicator

1292

Relative Vigor Index

1293

Relative Volatility Index

1294

Stochastic RSI Indicator

1295

Apply Simple Moving Average Indicator

1297

Slow Stochastic Oscillator

1298

Standard Deviation Channel

1299

Apply a Stochastic Oscillator Indicator

1300

Swing Index

1301

Apply a Triangular Moving Average (TMA) Indicator

1302

Apply a Triple Exponential Moving Average (TEMA) Indicator

1304

TRIX Indicator

1305
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True Strength Index

1306

Typical Price Indicator

1308

Apply an Ultimate Oscillator Indicator

1309

Variable Moving Average

1310

Vertical Horizontal Filter

1312

Volatility Stop

1313

Volume Exponential Moving Average

1314

Apply a Volume * Price Momentum Oscillator (PMO) Indicator

1315

Volume Oscillator

1317

Volume Rate of Change Indicator

1318

Volume Weighted Moving Average

1319

Vortex Indicator

1320

Wilder's Moving Average

1321

Apply a Williams Oscillator Indicator

1322

Weighted Close

1324

Apply Weighted Moving Average Indicator

1325

Zig Zag Indicator

1326

Apply ADX/DMI Indicator
To apply an ADX/DMI Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose ADX/DMI and Add the study.
3. Complete parameters as necessary.
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The ADX/DMI is represented by three lines +DM, -DM and ADX.
The Directional movement
If today's High is higher than yesterday's High then:
+DM = today's High - yesterday's High
If today's Low is lower than yesterday's Low then:
-DM = yesterday's Low - today's Low
If +DM is greater than -DM then: -DM = 0
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If +DM is less than -DM then: +DM = 0
The true range
True range is the largest of:
|today's High - today's Low|
|today's High - yesterday's Close|
|yesterday's Close - today's Low|
Moving average of +DM, -DM and True Range
+DMMA = exponential moving average of +DM
-DMMA = exponential moving average of -DM
TRMA = exponential moving average of True Range
The Directional Indicators
+DI = +DMMA / TRMA
-DI = -DMMA / TRMA
Directional Index
DX = |(+DI - (-DI))| / (+DI + (-DI))
The Average Directional Movement Index
ADX = the exponential moving average of DX
ADX = SUM[(+DI-(-DI))/(+DI+(-DI)), N]/N
Where:
N — the number of periods used in the calculation.

Accelerator/Decelerator Indicator
The Accelerator/Decelerator Technical Indicator (AC) measures acceleration and deceleration of the
current driving force. This indicator will change direction before any changes in the driving force, which, in
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its turn, will change its direction before the price. The Acceleration/Deceleration is an early warning signal.

To apply an Accelerator/Decelerator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Accelerator/Decelerator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply an Accumulation/Distribution Line
This indicator attempts to quantify the flow of money into and out of a given stock. In theory, knowing this
money/volume flow may help you to recognize an upcoming move in the stock price.

To apply an Accumulation/Distribution line
1. From within a chart, from the Edit menu select Studies.
2. Choose Accumulation/Distribution and Add the study.
3. Complete parameters as necessary.
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Apply an Accumulation Swing Index Study
The Accumulation Swing Index is a cumulative total of the Swing Index and attempts to show the phantom
line which represents the “real market,” which theoretically occurs among the open, high, low and close
prices. Since the Accumulation Swing Index attempts to show the "real market," it closely resembles the
prices themselves. This allows you to use classic support/resistance analysis on the Index itself.
Typical analysis involves looking for breakouts, new highs and lows, and divergences.

To apply an Accumulation Swing Index Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Accumulation Swing Index and click Add to add the study.
3. Complete parameters as necessary.
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Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Adaptive Moving Average
An Adaptive Moving Average (AMA) is one more moving average overlay, just like EMA. It changes its
sensitivity to price fluctuations. The Adaptive Moving Average becomes more sensitive during periods
when price is moving in a certain direction and becomes less sensitive to price movement when price is
volatile.

To apply an Adaptive Moving Average Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Adaptive Moving Average and click Add to add the study.
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3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Arnaud Legoux Moving Average
Arnaud Legoux Moving Average (ALMA) removes small price fluctuations and enhances the trend by
applying a moving average twice, once from left to right, and once from right to left. At the end of this
process the phase shift (price lag) commonly associated with moving averages is significantly reduced.
Zero-phase digital filtering reduces noise in the signal. Conventional filtering reduces noise in the signal,
but adds a delay.

To apply an Arnaud Legoux Moving Average
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1. From within a chart, from the Edit menu select Studies.
2. Choose Arnaud Legoux Moving Average and click Add to add the study to the Applied Studies
group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply an Aroon Oscillator Indicator
A trend-following indicator that uses aspects of the Aroon indicator (see "Aroon Up/Down") to gauge the
strength of a current trend and the likelihood that it will continue. The Aroon oscillator is calculated by
subtracting Aroon down from Aroon up. Readings above zero indicate that an uptrend is present, while
readings below zero indicate that a downtrend is present.
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To apply an Aroon Oscillator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Aroon Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply an Aroon Up/Down Indicator
Aroon up” and “Aroon down” are the two components that comprise the Aroon indicator. Assuming that an
asset is trending up when a stock is trading near the high of its range, Aroon up is used to measure the
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strength of the uptrend, while Aroon down is used to measure the strength of the downtrend. A cross
above the zero line may suggest the beginning of a new uptrend. Conversely, a cross below zero could
indicate the start of a downtrend. Readings near zero suggest that a security may be trending sideways
and that this period of consolidation may continue.

To apply an Aroon Up/Down Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Aroon Up/Dn and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply an Average True Range Indicator
The Average True Range indicator is used to determine the volatility of the market. The idea is to replace
the high-low interval for the given period, as the high-low does not take into consideration gaps and limit
moves. You set the period when you create the study.
The True Range is the largest of:
difference between the current maximum and minimum (high - low)
difference between the previous closing price and the current maximum
difference between the previous closing price and the current minimum
The Average True Range is a simple moving average of the true range values.
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To apply an Average True Range
1. From within a chart, from the Edit menu select Studies.
2. Choose Average True Range and Add the study.
3. Complete parameters as necessary.

Awesome Oscillator
The Awesome Oscillator is an indicator used to measure market momentum. AO calculates the difference
of a 34 Period and 5 Period Simple Moving Averages. The Simple Moving Averages that are used are not
calculated using closing price but rather each bar's midpoints. AO is generally used to affirm trends or to
anticipate possible reversals.
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To apply an Awesome Oscillator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Awesome Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Balance of Power Indicator
The Balance of Power indicator measures the market strength of buyers against sellers by assessing the
ability of each side to drive prices to an extreme level. The calculation is: Balance of Power = (Close price –
Open price) / (High price – Low price) The resulting value can be smoothed by a moving average.
Traders may use this indicator to help:
Identify the direction of a trend.
Find divergences between the price and the BoP in order to identify a potential trend reversal or trend
continuation setup.
Take advantage of overbought and oversold conditions.

To apply a Balance of Power Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Balance of Power and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Bill Williams Alligator
The Alligator indicator comprises three moving average lines. The blue line represents the jaw, the red line
represents the teeth, and the green line the lips. All of the moving average lines are editable and use the
exponential moving average as the default. The interaction between the three lines helps identify trends.
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To apply a Bill Williams Alligator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Bill Williams Alligator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Bill Williams Alligator Oscillator
This indicator is displayed as a line chart in a plot separate from the Alligator. The Alligator Oscillator
includes the same configurable fields as the Alligator plus a field to adjust the plot height of the indicator.
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To apply a Bill Williams Alligator Oscillator
1. From within a chart, from the Edit menu select Studies.
2. Choose Bill Williams Alligator Oscillator and click Add to add the study to the Applied Studies
group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply Bollinger Band Indicator
Bollinger Bands measure volatility by plotting a series of three bands. The middle band represents the
moving average (SMA or WMA or EMA). The upper band is a set number of standard deviations higher
than the middle band (generally 2), and the lower band is a set number of standard deviations (generally 2)
lower than the middle band. You set the distance of standard deviation when you create the study.

TWS Guide

1201

Chapter 1

Apply Bollinger Band Indicator

To apply Bollinger Bands
1. From within a chart, from the Edit menu select Studies.
2. Choose Bollinger Bands and Add the study.
1. Complete parameters as necessary.
Bollinger Bands are calculated like this:
ML = Avg. (N)
TL = ML + (D*StdDev)
BL = ML — (D*StdDev)
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Where:
ML - middle line
Avg(N) - SMA or WMA or EMA
TL - top line
BL - bottom line
N — is the number of periods used in calculation;
StdDev — the Standard Deviation.
StdDev = SQRT(SUM[(CLOSE — SMA(CLOSE, N))^2, N]/N)

Bollinger Band Width Indicator
Bollinger Band Width is derived from Bollinger Bands and measures the percent difference between the
upper and lower bands. It decreases as Bollinger Bands narrow and increases as Bollinger Bands widen.
Because Bollinger Bands are based on the standard deviation, falling Band Width reflects decreasing
volatility and rising Band Width reflects increasing volatility.
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To apply a Bollinger Band Width Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Bollinger Band Widthand click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply Chaikin Money Flow Oscillator
The Chaikin Money Flow Oscillator is calculated using the Accumulation/Distribution Line. It takes the
cumulative total of the Accumulation/Distribution values for 21 periods (or X number of periods if you elect
to change this value) divided by the cumulative total of volume for 21 (or X) periods.
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To apply a Chaikin Money Flow Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Chaikin Money Flow and Add the study.
3. Complete parameters as necessary.

Apply a Chaikin Oscillator
The Chaikin Oscillator monitors the flow of money in and out of the market. It calculates and plots the
difference between the 10-period exponential moving average and the three-period exponential moving
average of the accumulation distribution. The accumulation distribution uses the relationship between the
open and the close of the bar and the range of the bar to weigh and characterize the volume as
accumulation (buying) or distribution (selling).
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In short, the Chaikin Oscillator compares the money flow to the price action of an issue, which allows the
user to recognize tops and bottoms in short cycles.

To apply a Chaiken Oscillator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Chaiken Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Camarilla Pivot Points
Pivot point studies highlight prices considered to be a likely turning point when looking at values from a
previous period, whether it be daily, weekly, quarterly or annual. Each pivot point study has its own
characteristics on how these points are calculated. The formula applied for the Camarilla Pivot Points is:
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Define: Range = High - Low
Pivot Point (P) = (High + Low + Close) / 3
Support 1 (S1) = Close - Range * (1.1 / 12)
Support 2 (S2) = Close - Range * (1.1 / 6)
Support 3 (S3) = Close - Range * (1.1 / 4)
Support 4 (S4) = Close - Range * (1.1 / 2)
Support 5 (S5) = Close - (R5 - Close)
Resistance 1 (R1) = Close + Range * (1.1 / 12)
Resistance 2 (R2) = Close + Range * (1.1 / 6)
Resistance 3 (R3) = Close + Range * (1.1 / 4)
Resistance 4 (R4) = Close + Range * (1.1 / 2)
Resistance 5 (R5) = (High/Low) * Close
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To add a Camarilla Pivot Point indicator
1. From within a chart, from the Edit menu select Studies.
2. In the Pivot Studies section select Camarilla Pivot Points and Add the study.
3. Complete parameters as necessary.
It is possible that in some cases, for example when the closing price is near the high or low and there
is a wide range, the S1 or R1 value will be above the PP.
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DeMark Pivot Points
Pivot point studies highlight prices considered to be a likely turning point when looking at values from a
previous period, whether it be daily, weekly, quarterly or annual. Each pivot point study has its own
characteristics on how these points are calculated. The formula applied for the DeMark Pivot Points is:
If Close < Open, then X = High + (2 * Low) + Close
If Close > Open, then X = (2 * High) + Low + Close
If Close = Open, then X = High + Low + (2 * Close)
Pivot Point (P) = X/4
Support 1 (S1) = X/2 - High
Resistance 1 (R1) = X/2 - Low
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To add a DeMark Pivot Point indicator
1. From within a chart, from the Edit menu select Studies.
2. In the Pivot Studies section select DeMark Pivot Points and Add the study.
3. Complete parameters as necessary.
It is possible that in some cases, for example when the closing price is near the high or low and there
is a wide range, the S1 or R1 value will be above the PP.
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Fibonacci Pivot Points
Pivot point studies highlight prices considered to be a likely turning point when looking at values from a
previous period, whether it be daily, weekly, quarterly or annual. Each pivot point study has its own
characteristics on how these points are calculated. The formula applied for the Fibonacci Pivot Points is:
Pivot Point (P) = (High + Low + Close)/3
Support 1 (S1) = P - {.382 * (High - Low)}
Support 2 (S2) = P - {.618 * (High - Low)}
Support 3 (S3) = P - {1 * (High - Low)}
Resistance 1 (R1) = P + {.382 * (High - Low)}
Resistance 2 (R2) = P + {.618 * (High - Low)}
Resistance 3 (R3) = P + {1 * (High - Low)}
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To add a Fibonacci Pivot Point indicator
1. From within a chart, from the Edit menu select Studies.
2. In the Pivot Studies section select Fibonacci Pivot Points and Add the study.
3. Complete parameters as necessary.
It is possible that in some cases, for example when the closing price is near the high or low and there
is a wide range, the S1 or R1 value will be above the PP.
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Floor Pivot Points
Pivot point studies highlight prices considered to be a likely turning point when looking at values from a
previous period, whether it be daily, weekly, quarterly or annual. Each pivot point study has its own
characteristics on how these points are calculated. The formula applied for the Floor Pivot Points is:
Pivot Point (P) = (High + Low + Close)/3
Support 1 (S1) = 2 * P - High
Support 2 (S2) = P - (High - Low)
Support 3 (S3) = S1 - (High - Low)
Resistance 1 (R1) = 2 * P - Low
Resistance 2 (R2) = P + (High - Low)
Resistance 3 (R3) = R1 + (High - Low)
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To add a Floor Pivot Point indicator
1. From within a chart, from the Edit menu select Studies.
2. In the Pivot Studies section select Floor Pivot Points and Add the study.
3. Complete parameters as necessary.
It is possible that in some cases, for example when the closing price is near the high or low and there is a
wide range, the S1 or R1 value will be above the PP.
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Woodie Pivot Points
Pivot point studies highlight prices considered to be a likely turning point when looking at values from a
previous period, whether it be daily, weekly, quarterly or annual. Each pivot point study has its own
characteristics on how these points are calculated. The formula applied for the Woodie Pivot Points is:
Define: Range = High - Low
Pivot Point (P) = (High + Low + (Period's Open * 2)) / 4
Support 1 (S1) = (2 * P) - High
Support 2 (S2) = P - Range
Support 3 (S3) = Low - 2 * (High - P)
Support 4 (S4) = S3 - Range
Resistance 1 (R1) = (2 * P) - Low
Resistance 2 (R2) = P + Range
Resistance 3 (R3) = High + 2 * (P - Low)
Resistance 4 (R4) = R3 + Range
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To add a Woodie Pivot Point indicator
From within a chart, from the Edit menu select Studies.
In the Pivot Studies section select Woodie Pivot Points and Add the study.
Complete parameters as necessary.
It is possible that in some cases, for example when the closing price is near the high or low and there is a
wide range, the S1 or R1 value will be above the PP.
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Chaikin Volatility Indicator
Shows the difference between two moving averages of a volume-weighted accumulation-distribution line.
Comparing the spread between a security's high and low price quantifies volatility as a widening of the
range between the high and the low price. An increase in the Volatility Indicator over a relatively short time
period may indicate that a bottom is near. A decrease in volatility over a longer time period may indicate an
approaching top. It is recommended to use the Chaikin Volatility in conjunction with a moving average
system or price envelope.

To apply a Chaikin Volatility Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Chaikin Volatility and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Chande Kroll Stop
This is a trend-following indicator that identifies the stop loss for a long or short position by using a variation
on directional movement. It is calculated on the average true range of an instrument’s volatility. The stops
are placed under (and on) the high (low) of the last “n” bars. The difference is proportional to the average
True Range on “N” bars.
You can use the Chande Kroll to trade in a number of ways:
Sell when the price crosses below both lines.
Buy when the price crosses above both lines.
Trade when the two lines cross each other.
As the price moves sideways you will note that the lines begin to flatten out and the price will trade broadly
between the two lines. Make sure that when you trade it is always in the direction of the trend.
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To apply a Chande Kroll Stop Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Chande Kroll Stop and Add the study.
3. Complete parameters as necessary.

Chande Momentum Oscillator
A technical momentum indicator that is created by calculating the difference between the sum of all recent
gains and the sum of all recent losses and then dividing the result by the sum of all price movement over the
period. This oscillator is similar to other momentum indicators such as the Relative Strength Index and the
Stochastic Oscillator because it is range bounded (+100 and -100).

To apply a Chande Momentum Oscillator Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Chande Momentum Oscillatorand click Add to add the study to the Applied Studies
group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Choppiness Index
The Choppiness Index is designed to determine whether the market is choppy or trading sideways, or not
choppy and trading within a trend in either direction. Using a scale from 1 - 100, the market is considered to
be choppy as values near 100 (over 61.80) and trending when values are lower than 38.20).

To apply a Choppiness Index Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Choppiness Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Chop Zone
This is a visual indicator designed to identify trends and choppiness. Plotted within -100/+100 levels, the
Chop Zone illustrates the difference between close price and its EMA by converting its values to colors.

To apply a Chop Zone Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Chop Zone and click Add to add the study to the Applied Studies group.
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3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Connors RSI
A three period RSI, the Connors RSI is a composite indicator consisting of three components. Two use the
Relative Strength Index (RSI) calculations, and the third ranks the most recent price change on a scale of 0
to 100. Working together, these three factors form a momentum oscillator, an indicator that fluctuates
between 0 and 100 to indicate the level to which a security is overbought (high values) or oversold (low
values).

To apply a Connors RSI
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1. From within a chart, from the Edit menu select Studies.
2. Choose Connors RSI and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Coppock Curve
The Coppock curve is a long-term price momentum indicator used primarily to recognize major bottoms in
the stock market. It is considered to be an excellent tool for discriminating between bear market rallies and
true bottoms in the stock market. The indicator was designed for use on a monthly time scale and is
calculated as a 10-month weighted moving average of the sum of the 14-month rate of change and the 11month rate of change for the index. A buy signal is generated when the indicator falls below zero and turns
upward from a trough. Because the Coppock curve is a trend-following indicator, it does not pick an exact
market bottom, but may identify rallies and reveal when a new bull market has begun.
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To apply a Coppock Curve Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Coppock Curve and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Chande Volatility Index Dynamic Average (VIDYA)
A moving average that automatically adjusts its speed based on market volatility. The absolute value of a 9period Chande Momentum Oscillator is used for the volatility index.
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To apply a Chande Volatility Index Dynamic Average (VIDYA) Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Chande Volatility Index Dynamic Averageand click Add to add the study to the Applied
Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Commodity Channel Indicator (CCI)
The CCI price momentum indicator is designed to identify cyclical turns in commodities pricing, and
represents the position of the current price relative to the average of the price over a specified period.
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To apply a CCI
1. From within a chart, from the Edit menu select Studies.
2. Choose Commodity Channel and Add the study.
3. Complete parameters as necessary.

Detrended Price Oscillator
This oscillator strips out price trends in an effort to estimate the length of price cycles from peak to peak, or
trough to trough. Unlike other oscillators, such as the Stochastic or MACD, detrended price is not a
momentum indicator. It highlights peaks and troughs in price, which are used to estimate entry and exit
points in line with the historical cycle.
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To apply a Detrended Price Oscillator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Detrended Price Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Departure Chart
One of the oldest technical studies, the Departure Chart measures the difference between two moving
averages of price; one short and one long. Its primary use is as a trend identification tool, but it may also be
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used to identify overbought and oversold conditions as well. Default periods are 10 and 20.

Directional Movement Index
Designed to help you see whether or not an instrument is currently trending.
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To apply a Directional Movement Index Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Directional Movement Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Donchian Channels Indicator
A simple trend-following breakout system, this moving average indicator that plots the highest high and
lowest low over the last period time intervals. The signals derived from this system are based on the
following basic rules:
When the price closes below the Donchian Channel, sell short and liquidate long positions.
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When the price closes above the Donchian Channel, buy long and cover short positions.

To apply a Donchian Channels Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Donchian Channels and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply a Donchian Channel Width Indicator
The width of Donchian Channels is a useful indicator for seeing the volatility of a market price. If a price is
stable the Donchian channel will be relatively narrow. If the price fluctuates a lot the Donchian channel will
be wider.
This indicator is designed to detect trends: low values of the indicator signify that the price is moving
sideways, while increasing values signify the start of a new trend.

To apply a Donchian Channel Width Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Donchian Channel Width and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Double Exponential Moving Average (DEMA)
Based on both a single exponential moving average (EMA) and a double EMA, the DEMA is a fast-acting
moving average that is more responsive to market changes than a traditional moving average. It was
developed in an attempt to create a calculation that eliminated some of the lag associated with traditional
moving averages.
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To apply a Double Exponential Moving Average Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Double Exponential Moving Average and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Ease of Movement Indicator
A technical momentum indicator that can help illustrate the relationship between the rate of an asset's price
change and its volume. This indicator attempts to identify the amount of volume required to move prices.
Generally a value greater than zero is an indication that the stock is being accumulated (bought) and
negative values are used to signal increased selling pressure. A high positive value appears when prices
move upward on low volume. Strong negative numbers indicate that price is moving downward on low
volume.
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To apply an Ease of Movement Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Ease of Movement and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply an Elder-Ray Indicator
Measures the amount of buying and selling pressure in the market. This indicator consists of two separate
indicators known as "bull power" and "bear power". These can help a trader to determine the position of the
price relative to a certain exponential moving average (EMA).
Bull Power = Daily High - n-period EMA Bear Power = Daily Low - n-period EMA
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Use the values of the bull and bear power along with divergence to help make transaction decisions.
Consider taking a long position when the bear power has a value below zero but is increasing, and the bull
power's latest peak is higher than it was previously. Consider a short position when the bull-power value is
positive but falling, and the bear power's recent low is lower than any other previous bottom. The slope of
the EMA can also be used in both cases to help confirm the direction of the trend.

To apply an Elder-Ray Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Elder-Ray and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
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Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply Envelope Indicator
SMA/WMA/EMA Envelopes plot a band composed of two moving averages, one which is shifting
upwards, the other shifting downwards, to help define a stock's upper and lower boundaries. The bands of
an envelope are calculated as follows:
Upper Band = MA(CLOSE, N)*[1+K/100]
Lower Band = MA(CLOSE, N)*[1-K/100]
Where:
MA — Simple (or Weighted or Exponential) Moving Average;
N — averaging period;
K/100 — the value of shifting from the average (measured in basis points).
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To apply an Envelope indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Envelope and Add the study.
3. Complete parameters as necessary.

SMI Ergodic Oscillator
The Ergodic Oscillator (EO) is a double- smoothed True Strength Index (TSI) with a signal line. It acts like a
stochastic indicator without the compression often seen with stochastics at extremes. As a result, the
Ergodic helps to register long trends in prices.
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To apply an Ergodic Oscillator
1. From within a chart, from the Edit menu select Studies.
2. Choose Ergodic Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply Exponential Moving Average Indicator
The exponential moving average gives more weight to the latest prices and includes all of the price data
in the life of the instrument. It is defined by taking:
(previous period's exponential moving average)/(N+1) and adding (current price)*2/(N+1).
For the first period we take the simple average as above.
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To apply a Exponential Moving Average
1. From within a chart, from the Edit menu select Studies.
2. Choose Exponential Moving Avg and Add the study.
3. Complete parameters as necessary.

Fast Stochastic Oscillator
The stochastic oscillator provides information about the location of a current close in relation to the period's
high and low. It ranges between 0% and 100%. A reading of 0% indicates that the close was the lowest
price at which the security traded during the preceding x number of time periods. A reading of 100%
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indicates that the close was the highest price at which the security traded during the preceding x number of
time periods.
This version of the Stochastic Oscillator does not include the Period of slow average. The fast stochastic
may be more sensitive to changes in the price of the underlying than the slow version.

To apply a Fast Stochastic Oscillator
1. From within a chart, from the Edit menu select Studies.
2. Choose Fast Stochastic Oscillatorand click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Fisher Transform Indicator
Used to predict price reversals. The Fisher Transform helps to more clearly identify extreme price
movements by transforming the probability density function of any waveform to a bell-curve.

To apply a Fisher Transform Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Fisher Transform and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Force Index
The Force Index is an indicator that uses price and volume to assess the power behind a move or identify
possible turning points. The Force Index combines all three "essential elements" of a stock's price
movement (direction, extent and volume) as an oscillator that fluctuates in positive and negative territory as
the balance of power shifts. The Force Index can be used to reinforce the overall trend, identify playable
corrections or foreshadow reversals with divergences.

To apply a Force Index Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Force Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply High Low Bands
These two bands are generated from the triangular moving averages (calculated from the underlying price)
and sandwich the underlying price. The triangular moving average is, in turn, shifted up and down by a
fixed percentage. The bands are wave-lines formed by shifting the triangular moving average by some
specific percentage on both the sides. Triangular moving averages are smooth in nature, which is why
High Low bands tend to be more responsive to price fluctuations. They are most effective when it comes to
trending markets, and may generate signals in trending markets. These bands, similar to all other
indicators, fail in sideways or choppy markets.
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To apply High/Low Bands
1. From within a chart, from the Edit menu select Studies.
2. Choose High/Low Bands and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Historical Volatility Ratio
The Historical Volatility Ratio is the percentage of short to long average historical volatility. When a
market's short volatility declines below a certain percentage of its long volatility, it may be an indication that
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an explosive move is imminent

To apply a Historical Volatility Ratio Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Historical Volatility Ratio and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Hull Moving Average
The Hull moving average indicator improves on smoothing price fluctuations, and also accounts for price
lag. It does this by using the square root of a given period instead of the actual period itself.
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To apply a Hull Moving Average Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Hull Moving Average and click Add to add the study.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Ichimoku Cloud
The Ichimoku Cloud indicator shows support and resistance, and momentum and trend directions. The
"cloud" comprises five lines, and is formed between the spans of the conversion and baseline moving
averages and the midpoint of the 52-week high and low.
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To apply an Ichimoku Cloud Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Ichimoku Cloud and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Intraday Intensity Index Indicator
A technical indicator that approximates the volume of trading for a specified security in a given day. It is
designed to help track the activity of institutional block traders and is calculated by subtracting the day's
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high and low from double the closing price, divided by the volume and multiplied by the difference between
the high and the low.

To apply an Intraday Intensity Index Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Intraday Intensityand click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Intraday Intensity Percent
Also known at the Money Flow %, calculated as:
Intraday Intensity% = Intraday Intensity/Sum(Volume, x) * 100%
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Where Intraday Intensity = (2 * close - H - L) / (H - L) * volume
and x = period of sum, by default = 21

To apply an Intraday Intensity Percent Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Intraday Intensity Percent and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Intraday Volume Weighted Average Price
Tracks VWAP throughout the day, and displays as a colored line linking VWAP values at varying times
throughout the one-day period. By default, the line that tracks Intraday VWAP is bracketed within a
high/low standard deviation range. The standard deviation is calculated for the same period as the VWAP,
and the range can be adjusted by modifying the number of Standard Deviations within the settings of the
Intraday VWAP.
Intraday VWAP is calculated as: VWAP=[sum (Volume_bar_i * Typical_price_i)]/sum(volume_bar_i)
where i is the intraday bar number. If we use a 1 min daily bar chart, the calculation is made from the first
minute with i=[1;N] where N is the last bar number of the chart, Typical_price_i = VWAP_on_bar_price_i
=> This is the VWAP we currently store and volume_bar_i is the volume for the bar i. If no volume is
available for the product (i.e. for IND, CASH and CMDY), use 1 as volume for each bar.
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To apply an Intraday VWAP Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Intraday Volume Weighted Average Price and click Add to add the study to the Applied
Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Keltner Channel Indicator
Apply a Keltner Channel Indicator
The Keltner Channel indicator is sensitive to volatility, and plots an "envelope" of two bands above and
below the middle line, which represents a 20-period Exponential Moving Average (EMA). The upper and
lower bands define the area inside of which the price should generally fall. The price crossing or floating
towards these lines could indicate a trading opportunity.
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The Keltner Channel bands are calculated as follows:
Middle Line = EMA(TP)
Top Line = EMA(TP + Dev x TR)
Bottom Line = EMA(TP - Dev x TR)
Where:
EMA - exponential moving average
TP = typical price
TR - trade range equals high - low
Dev — the deviation factor.
To overlay a Keltner Channel Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Keltner Channel and Add the study.
3. Complete parameters as necessary.
Note that you can increase the thickness and color of the indicator lines by right-clicking a line and using the
edit menu to select Change Indicator Thickness or Change Indicator Color. A thickness of "1" is the
thinnest; 4 is the thickest.

Klinger Volume Oscillator
This oscillator is used to determine long-term trends of money flow, while remaining sensitive enough to
short-term fluctuations to predict short-term reversals. It compares the volume flowing in and out of a
security to price movement, and it is then turned into an oscillator. A signal line (13-period moving average)
is used to trigger transaction decisions. This technique is very similar to signals that are created with other
indicators such as the MACD (moving average convergence divergence). The Klinger Oscillator also uses
divergence to identify when price and volume are not confirming the direction of the move. It is considered
to be a bullish sign when the value of the indicator is heading upward while the price of the security

TWS Guide

1252

Chapter 1

Apply a Know Sure Thing (KST) Indicator

continues to fall. It is recommended to use other tools such as trendlines, moving averages and other
indicators to confirm the reversal.

To apply a Klinger Volume Oscillator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Klinger Volume Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Know Sure Thing (KST) Indicator
A two-line indicator used to determine momentum in stock trends. As an oscillator, it fluctuates above and
below zero, providing trade signals and analytical insight based on divergence with price and KST and
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signal Line crossovers.
The indicator formula uses four different time frames to show overall momentum (rather than momentum
over only one specific timeframe):
ROCMA1 = 10-Period SMA of 10-Period Rate-of-Change
ROCMA2 = 10-Period SMA of 15-Period Rate-of-Change
ROCMA3 = 10-Period SMA of 20-Period Rate-of-Change
ROCMA4 = 15-Period SMA of 30-Period Rate-of-Change
KST Line = (RoCMA1 x 1) + (RoCMA2 x 2) + (RoCMA3 x 3) + (RoCMA4 x 4)
Signal Line = 9-period SMA of KST, where SMA stands for Simple Moving Average and ROC stands
for Rate-of-Change.
While the formulas are different, the applications of KST are similar to those of the MACD.
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To apply a Know Sure Thing Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Know Sure Thing and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Lane's Stochastic Oscillator
The stochastic oscillator provides information about the location of a current close in relation to the period's
high and low. It ranges between 0% and 100%. A reading of 0% indicates that the close was the lowest
price at which the security traded during the preceding x number of time periods. A reading of 100%
indicates that the close was the highest price at which the security traded during the preceding x number of
time periods.
Note: Like the full Stochastic Oscillator, you can edit the source, input price and observation
period, but the periods of fast and slow average cannot be edited and the method used is always
SMA. use the full Stochastic Oscillator for more flexibility.
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To apply a Lane's Stochastic Oscillator
1. From within a chart, from the Edit menu select Studies.
2. Choose Lane's Stochastic Oscillatorand click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Least Squares Moving Average
Sometimes called an End Point Moving Average, this indicator is based on a linear regression, but goes
one step further by estimating what would happen if the regression line continued. Least Squares Moving
Average is used mainly as a crossover signal with another moving average or with itself.
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To apply a Least Squares Moving Average Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Least Squares Moving Average and click Add to add the study to the Applied Studies
group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Linear Regression Curve
This indicator plots a line that best fits the prices specified over a user-defined time period. The Linear
Regression Curve is used mainly to identify trend direction and is sometimes used to generate buy and sell
signals.
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To apply a Linear Regression Curve Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Linear Regression Curve and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Linear Regression Indicator
The Linear Regression Indicator is used for trend identification and trend following, similar to a moving
average. The indicator should not be confused with Linear Regression Lines, which are straight lines fitted
to a series of data points. The Linear Regression Indicator plots the end points of a whole series of linear
regression lines drawn on consecutive days. The advantage of the Linear Regression Indicator over a
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normal moving average is that it has less lag than the moving average and responds more quickly to
changes in direction. The downside is that it is more prone to whipsaws, where a price heads in one
direction and then quickly moves in the opposite direction.

To apply a Linear Regression Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Linear Regression (Least Square)and click Add to add the study to the Applied Studies
group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Linear Regression Intercept
A statistical tool used to help predict future values from past values. It is commonly used as a quantitative
way to determine the underlying trend and when prices are overextended.

To apply a Linear Regression Intercept Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Linear Regression Intercept and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Linear Regression R-Squared
An indicator used to determine the strength of the dominant market trend. It is typically used with other
indicators such as Linear Regression Slope. The Slope indicates the overall market trend (positive or
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negative) and the R-Squared indicates the strength.

To apply a Linear Regression R-Squared Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Linear Regression R-Squared and click Add to add the study to the Applied Studies
group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Linear Regression Slope
A common statistical technique used to identify the strength and direction of a dominant market trend. The
Linear Regression Slope is a centered oscillator type of indicator similar to momentum indicators. As
indicated by its name, it "oscillates" or fluctuates above and below a central line drawn at 0. In general, the
momentum is positive when the slope is above 0 and negative when it is below 0. It can be used to
measure the strength or weakness and direction of the momentum.
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To apply a Linear Regression Slope Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Linear Regression Slope and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply MACD Indicator
This is a trend-following dynamic indicator that shows the correlation between two moving averages,
generally a 26-period and 12-period SMA or WMA or EMA. You can modify the period length when you
create the study. To help illustrate opportunity, a 9-period EMA "signal line" is plotted on top of the MACD.
The MACD and signal line are plotted using the following calculations:
MACD = MA(CLOSE, 12)-MA(CLOSE, 26)
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SIGNAL = EMA(MACD, 9)
MACD Histogram/OSMA = MACD - SIGNAL
Where:
MA — Simple or Weighted or Exponential Moving Average;
SIGNAL — the signal line of the indicator.

To apply a Moving Average Convergence/Divergence Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Moving Avg Conv Div and Add the study.
3. Complete parameters as necessary.
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Apply a Mass Index Indicator
This indicator examines the range between high and low stock prices over a specific period of time. It
suggests that a reversal of the current trend will likely take place when the range widens beyond a certain
point and then contracts.

To apply a Mass Index Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Mass Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

McGinley Dynamic
The McGinley Dynamic is a smoothing mechanism for prices that often tracks far better than any moving
average. It minimizes price separation and price whipsaws and hugs prices much more closely. Because of
the calculation, the Dynamic Line speeds up in down markets as it follows prices yet moves more slowly in
up markets.
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To apply a McGinley Dynamic Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose McGinley Dynamic and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Momentum Indicator
The Momentum is the difference between the current point (price or something else) and the point N
periods ago. Momentum is calculated as a ratio of today’s price to the price several (N) periods ago.
Momentum = CLOSE(i)/CLOSE(i-N)
Where:
CLOSE(i) — is the closing price of the current bar.
CLOSE(i-N) — is the closing bar price N periods ago
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To apply a Momentum Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Momentum and Add the study.
3. Complete parameters as necessary.

Moving Average Crossover
A crossover occurs when a faster Moving Average (a shorter period moving average) crosses either above
or below a slower (i.e. longer period) moving average. A crossover that moves above a slower MA is
considered a bullish crossover; one that moves below is considered a bearish crossover.
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To apply an MA Crossover
1. From within a chart, from the Edit menu select Studies.
2. Choose MA Crossover and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply a Moving Standard Deviation Indicator
Standard deviation is a statistical term that provides a good indication of volatility. It measures how widely
values (for example, closing prices) are dispersed from the average. Dispersion is the difference between
the actual value (closing price) and the average value (mean closing price). The larger the difference
between the closing prices and the average price, the higher the standard deviation will be and the higher
the volatility. The nearer the closing prices are to the average price, the lower the standard deviation and
the lower the volatility.
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To apply a Moving Standard Deviation Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Moving Standard Deviation and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Negative Volume Index Indicator
This indicator relies on changes in a security’s volume to identify when so-called “smart money” (i.e.
institutions, funds and professional traders) is driving the current trend. The Negative Volume Index
suggests that unsophisticated investors buy and sell primarily on high-volume days, while shrewd investors
are more likely to trade on low-volume days. Often when volume drops, price drops. If a stock’s price
increases despite a decrease in volume, technical analysts consider this a positive sign. They use the
negative volume index to help identify bull and bear markets.
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To apply a Negative Volume Index Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Negative Volume Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Net Volume Indicator
A security's uptick volume minus its downtick volume over a specified time period. The net volume of a
stock aggregates the total positive and negative movements of the security over this period. When the total
upward movement is greater than the total downward movement over this period, the stock has a positive
net volume.

To apply a Net Volume Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Net Volume and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply an On Balance Volume Indicator
The concept behind the OBV indicator is: volume precedes price. OBV is a simple indicator that adds a
period's volume when the close is up and subtracts the period's volume when the close is down. A
cumulative total of the volume additions and subtractions forms the OBV line.
If today’s close is greater than yesterday’s close then:
OBV(i) = OBV(i-1)+VOLUME(i)
If today’s close is less than yesterday’s close then:
OBV(i) = OBV(i-1)-VOLUME(i)
If today’s close is equal to yesterday’s close then:
OBV(i) = OBV(i-1)
Where:
OBV(i) — is the indicator value of the current period.
OBV(i-1) — is the indicator value of the previous period.
VOLUME(i) — is the volume of the current bar.
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To apply an On Balance Volume (OBV) indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose On Balance Volume and Add the study.
3. Complete parameters as necessary.

Apply Parabolic SAR Indicator
For use in trending markets, parabolic SAR uses a trailing stop and reverse method to help determine
good exit and entry points. The Parabolic SAR calculation is:
SARt+1 = SARt+ AF x (EPtradex SARt)

Where:
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SARt+1 — next period's SAR
SARt - current SAR
AF - acceleration factor, begins at .02 and increases by .02 to a maximum of 0.20.
Note: You can reset the initial, increments and maximum acceleration factor when you create the
study.
EPtrade — the extreme price (HIGH for long positions and LOW for short positions).

To apply a Parabolic SAR indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Parabolic SAR and Add the study.
3. Complete parameters as necessary.
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Percentage Price Oscillator
A momentum oscillator for price. Shows the difference between two moving averages as a percentage of
the larger moving average.

To apply a Percentage Price Oscillator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Percentage Price Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
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Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Percentage Volume Oscillator
A momentum oscillator for volume. It measures the difference between two volume-based moving
averages as a percentage of the larger moving average.

To apply a Percentage Volume Oscillator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Percentage Volume Oscillator and click Add to add the study to the Applied Studies
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group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Percent B Indicator
%B quantifies a security's price relative to the upper and lower Bollinger Band. There are six basic
relationship levels:
%B equals one when the price is at the upper band.
%B equals zero when the price is at the lower band.
%B is greater than one when the price is above the upper band.
%B is less than zero when the price is below the lower band.
%B is greater than .50 when the price is above the middle band (20-day SMA).
%B is less than .50 when the price is below the middle band (20-day SMA).
The default setting for %B is based on the default setting for Bollinger Bands (20,2). The bands are set two
standard deviations above and below the 20-day simple moving average, which is also the middle band.
The security price used is the closing price or the last trade.
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To apply a Percent B Channel Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Percent Band click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Performance Indicator
The Performance indicator displays a security's price performance as a percentage. This is sometimes
called a "normalized" chart. The Performance indicator displays the percentage that the security has
increased since the first period displayed. For example, if the Performance indicator is 10, it means that the
security's price has increased 10% since the first period displayed on the left side of the chart. Similarly, a
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value of -10% means that the security's price has fallen by 10% since the first period displayed.
Performance charts are helpful for comparing the price movements of different securities.

To apply a Performance Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Performance and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Pivot Points
The Pivot Point indicator calculates the numerical average of a stock's high, low and closing prices, and is
used to help identify resistance and support levels. We calculate pivot points using the five-point system,
which uses the previous day's high, low and close to get the pivot point, and then calculates two resistance
levels and two support levels, as follows:
R2=P + (H-L) = P + (R1-S1)
R1 = (P x 2) - L
P = (H + L + C) /3
S1 = (P x 2) - H
S2 = P - (H - L) = P - (R1 - S1)
where "S" is the support levels, "R" is the resistance levels, "P" is the pivot point, H, L, C are high, low and
close, respectively.
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To add a Pivot Point indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Pivot Points and Add the study.
3. Complete parameters as necessary.
It is possible that in some cases, for example when the closing price is near the high or low and there
is a wide range, the S1 or R1 value will be above the PP.

Pivot Points High/Low
Pivot points are used to project potential support and resistance levels. Main time periods are daily, weekly
and monthly.
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To apply a Pivot Points High/Low Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Pivot Points High/Low and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
It is possible that in some cases, for example when the closing price is near the high or low and there is a
wide range, the S1 or R1 value will be above the PP.
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Apply a Positive Volume Index (PVI) Indicator
An indicator used in technical analysis that is based on days where trading volume has significantly
increased from the previous day. The Positive Volume Index (PVI) assumes that uninformed investors
dominate the action on days with substantial trading volume, while the "smart money" - consisting of
institutions, funds and professional traders - is more active on relatively quiet days with below-average
trading volume.
As the PVI only takes into consideration days when trading volume is higher compared with the previous
period, if the PVI is up, it implies that price is appreciating on rising volume, while a lower PVI implies that
price is declining on rising volume.
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To apply a Positive Volume Index Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Positive Volume Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Price Oscillator
Shows the difference between two moving averages, in points. Unlike MACD which always uses the 12and 26-day moving averages, Price Oscillator can use any two user-specified values.

To apply a Price Oscillator Trend Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Price Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Price Volume Trend Indicator
Price Volume Trend is a variation of On Balance Volume. It's a horizontal histogram that overlays the chart
and helps determines the strength of trends and warn of reversals.

To apply a Price Volume Trend Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Price Volume Trend and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Raff Channel Indicator
The Raff Channel is a linear regression with evenly spaced trend lines above and below. The width of the
channel is based on the high or low that is the furthest from the linear regression. If prices continue to rise
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within the channel, the trend is up. An uptrend reverses when the price breaks below the channel
extension. When prices decline within the channel, the trend is down. Similarly, a downtrend reverses
when price the breaks above the channel extension.

To apply a Raff Channel Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Raff Channeland click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply Rate of Change Indicator
ROC is a refined version of Momentum. The readings fluctuate as percentages around the zero line. You
set the number of periods when you create the study.
Rate of change =100(V/Vx)
where:
V - the latest closing price.
Vx - the closing price of x bars ago.

To apply a Rate of Change indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Rate of Change and Add the study.
3. Complete parameters as necessary.

Relative Momentum Index
The Relative Momentum Index (RMI) is a variation of the Relative Strength Index (RSI). While the RMI
counts up and down days from today’s close relative to the close ”n-days” ago (n is not limited to 1), the RSI
counts days up and down from close to close.

To apply a Typical Price Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Relative Momentum Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
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Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Relative Strength Indicator
The RSI indicator is for overbought/oversold conditions. It goes up when the market is strong, and down
when the market is weak, and oscillates between 0 -100. The RSI calculation is:
RSI = 100-(100/1+RS)
Where:
RS - Average of X bars Up Closes/Average X bars Down Closes (X=number of bars set by user)

To apply a Relative Strength Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Relative Strength Ind and Add the study.
3. Complete parameters as necessary.

Relative Vigor Index
The Relative Vigor Index measures the conviction of a recent price action and the likelihood that it will
continue by comparing the positioning of a security's closing price relative to its price range. The result is
smoothed by calculating an exponential moving average of the values. It's similar to the stochastic
oscillator, but the vigor index compares the close relative to the open rather than relative to the low. The
value will likely grow as the bullish trend gains momentum, since a security's closing price tends to be at the
top of the range while the open is near the low of the day.

TWS Guide

1293

Chapter 1

Relative Volatility Index

To apply a Relative Vigor Index
1. From within a chart, from the Edit menu select Studies.
2. Choose Relative Vigor Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Relative Volatility Index
The Relative Volatility Index (RVI) is similar to the Relative Strength Index (RSI) index. Both measure the
direction of volatility, but RVI uses the standard deviation of price changes in its calculations, while RSI
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uses the absolute price changes. The RVI is best used as a confirmation indicator to other momentum
and/or trend-following indicators.

To apply a Relative Volatility Index Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Relative Volatility Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Stochastic RSI Indicator
The stochastic oscillator provides information about the location of a current close in relation to the period's
high and low. It ranges between 0% and 100%. A reading of 0% indicates that the close was the lowest
price at which the security traded during the preceding x number of time periods. A reading of 100%
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indicates that the close was the highest price at which the security traded during the preceding x number of
time periods. The RSI version of this indicator in essence applies the stochastic calculation to the Relative
Strength Indicator (RSI).

To apply a Stochastic RSI
1. From within a chart, from the Edit menu select Studies.
2. Choose Stochastic RSIand click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply Simple Moving Average Indicator
The simple moving average sums the prices (you can choose from the closing price, the VWAP timeweighted price or the high/low/close average price) for a specific number of data points and divides by that
number. The calculation for a 3-bar simple moving average is:
(price_1) + (price_2) + (price_3) divided by 3

To apply a Simple Moving Average
1. From within a chart, from the Edit menu select Studies.
2. Choose Simple Moving Avg. and Add the study.
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3. Complete parameters as necessary.

Slow Stochastic Oscillator
The stochastic oscillator provides information about the location of a current close in relation to the period's
high and low. It ranges between 0% and 100%. A reading of 0% indicates that the close was the lowest
price at which the security traded during the preceding x number of time periods. A reading of 100%
indicates that the close was the highest price at which the security traded during the preceding x number of
time periods.
This version of the Stochastic Oscillator does not include the Period of fast average and tends to be less
sensitive to changes in the price of the underlying than the fast version.
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To apply a Slow Stochastic Oscillator
1. From within a chart, from the Edit menu select Studies.
2. Choose Slow Stochastic Oscillatorand click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Standard Deviation Channel
Standard deviation channels are plotted at a set number of standard deviations around a linear regression
line. They can be used in swing trading and in detecting changes in momentum.

To apply a Standard Deviation Channel Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Standard Deviation Channeland click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Stochastic Oscillator Indicator
The stochastic oscillator provides information about the location of a current close in relation to the period's
high and low. It ranges between 0% and 100%. A reading of 0% indicates that the close was the lowest
price at which the security traded during the preceding x number of time periods. A reading of 100%
indicates that the close was the highest price at which the security traded during the preceding x number of
time periods.
Note: You can specify the source and input price, and the observation period, method (SMA,
WMA, EMA or TMA), period of slow average and period of fast average when you create the
study.
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Note:

To apply a Stochastic Oscillator
1. From within a chart, from the Edit menu select Studies.
2. Choose Stochastic Osc. and Add the study.
3. Complete parameters as necessary.

Swing Index
The Swing Index tries to determine the real strength and direction of the market by comparing the
relationships between the high, low and close prices of a stock.
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To apply a Swing Index Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Swing Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Triangular Moving Average (TMA) Indicator
The Triangular Moving Average is basically a double-smoothed Simple Moving Average that gives more
weight to the middle section of the data interval. The TMA has a significant lag to current prices and is not
well-suited to fast moving markets.
TMA = SUM (SMA values)/ N Where N = the number of periods.
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To apply a Triangular Moving Average Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Triangular Moving Average and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply a Triple Exponential Moving Average (TEMA) Indicator
A technical indicator used for smoothing price and other data. It is a composite of a single exponential
moving average, a double exponential moving average and a triple exponential moving average.
The TEMA smooths price fluctuations and filters out volatility, thereby making it easier to identify trends
with little lag. It is a useful tool in identifying strong, long lasting trends, but may be of limited use in rangebound markets with short term fluctuations.
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To apply a Triple Exponential Moving Average Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Triple Exponential Moving Average and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

TRIX Indicator
TRIX is a momentum oscillator that displays the percent rate of change of a triple exponentially smoothed
moving average. TRIX is designed to filter out insignificant price movements with its triple smoothing. TRIX
generates signals similar to MACD, and a signal line can be applied to look for signal line crossovers. A
directional bias can be determined with the absolute level. Bullish and bearish divergences can be used to
anticipate reversals.
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To apply a TRIX Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose TRIX and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

True Strength Index
The True Strength Index is designed to show trend direction and overbought/oversold conditions, and uses
moving averages of the underlying momentum of a financial instrument. Momentum is considered a
leading indicator of price movement, and a moving average characteristically lags behind price. The TSI
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combines these two characteristics to create an indication of price and direction more in sync with market
turns than either just momentum or just the moving average.

To apply a True Strength Index
1. From within a chart, from the Edit menu select Studies.
2. Choose True Strength Index and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Typical Price Indicator
Typical price, calculated as (High Low Close) / 3, is a useful filter for moving average systems.

To apply a Typical Price Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Typical Price and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply an Ultimate Oscillator Indicator
The Ultimate Oscillator combines the price action for three different time frames. You set the observations
periods 1, 2, and 3 when you create the study.
Time Frames:
true low = min(low or prev close)
buying pressure = close - true low
true range = max(high - low, high - prev close, prev close - low)
Buying pressure sum 1, buying pressure sum 2 and buying pressure sum 3 are calculated by adding up
buying pressures for 3 different time frames.
The same applies to the true range sum 1, 2 and 3.
raw ultimate oscillator = 4 * (buying pressure sum 1 / true range sum 1)
+ 2 * (buying_pressure_sum_2 / true_range_sum_2) + (buying_pressure_sum_3 / true_range_sum_3)
ultimate oscillator = raw ultimate oscillator / (4 + 2 + 1) ) * 100
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To apply a Ultimate Oscillator indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Ultimate Osc. and Add the study.
3. Complete parameters as necessary.

Variable Moving Average
This is an exponential moving average that adjusts its smoothing constant on the basis of market volatility.
Its sensitivity grows as long as the volatility of the data increases. The performance of this exponential
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moving average is improved by using a Volatility Index (VI) to adjust the smoothing period as market
conditions change.

To apply a Variable Moving Average Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Variable Moving Average and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Vertical Horizontal Filter
The Vertical Horizontal Filter determines whether prices are in a trending phase or a trading range or
congestion phase. Trend-following indicators such as the MACD and moving averages are excellent in
trending markets, but may generate multiple conflicting trades during trading range or congestion periods,
while oscillators such as the RSI and stochastics work well when prices fluctuate within a trading range, but
they almost always recommend closing positions prematurely during trending markets. The Vertical
Horizontal Filter indicator attempts to determine the "trendiness" of prices to help a trader decide which of
these indicator types to use.

To apply a Vertical Horizontal Filter Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Vertical Horizontal Filter and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Volatility Stop
The Volatility Stop Indicator helps define the current trend. This indicator plots a red line above the price
bars when a downward trend is detected, and a blue line below the bars when an upward trend is
detected. These lines are commonly used as trailing stops, and this indicator is commonly used as an exit
tool rather than an entry technique. When price crosses the VSTOP value, the trend reverses and VSTOP
moves to the other side of the price.
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To apply a Volatility Stop Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Volatility Stop and Add the study.
3. Complete parameters as necessary.

Volume Exponential Moving Average
Identical to our existing Exponential Moving Average indicator except that it uses volume data instead of
price data.

To apply a Volume Exponential Moving Average
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(PMO) Indicator

1. From within a chart, from the Edit menu select Studies.
2. Choose Volume Exponential Moving Average and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Volume * Price Momentum Oscillator (PMO) Indicator
A price and volume momentum oscillator. Traders might consider buying when the VPMO rises above zero
and selling when it falls below.
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(PMO) Indicator

To apply a Volume * PMO Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Volume * PMO and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Volume Oscillator
Measures volume by measuring the relationship between two moving averages.

To apply a Volume Oscillator Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Volume Oscillator and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
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Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Volume Rate of Change Indicator
The volume rate of change indicator is used to gauge the volatility in a security’s volume. The volume rate
of change is a powerful indicator when estimating a security’s ability to push through key resistance. It is
calculated the exact same way as the rate of change indicator except instead of tracking the closing price it
tracks volume. The calculation is: Volume ROC = ((Volume – Volume n-periods ago )/ Volume n-periods
ago) *100.

To apply a Volume Rate of Change Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Volume Rate of Change and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Volume Weighted Moving Average
Identical to our existing Weighted Moving Average indicator except that it uses volume data instead of price
data.

To apply a Volume Weighted Moving Average Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Volume Weighted Moving Average and click Add to add the study to the Applied Studies
group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Vortex Indicator
A two-line oscillator comprising an uptrend line (VI+) and a downtrend line (VI-). Used to spot trend
reversals and confirm current trends. An uptrend or buy signal occurs when VI+ crosses above VI-. A
downtrend or sell signal occurs when VI- crosses above VI+.
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To apply a Vortex Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Vortex and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Wilder's Moving Average
Also called Wilder's Smoothed Moving Average, this indicator is similar to the Exponential Moving
Average. Compared to other moving averages, Wilders MA responds more slowly to price changes, where
an n-period Wilder MA gives similar values to a 2n- period EMA. For example, a 14-period EMA has almost
the same values as a 7-period Wilder MA.

To apply a Wilder Moving Average Indicator
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1. From within a chart, from the Edit menu select Studies.
2. Choose Wilder Moving Average and click Add to add the study.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Apply a Williams Oscillator Indicator
The Williams Percent Range (%R) indicator identifies the overbought/oversold levels. The scale extends
from 0 to -100.
%R = (HIGH(i-n)-CLOSE)/(HIGH(i-n)-LOW(i-n))-100
Where:
CLOSE — is today’s closing price.
HIGH(i-n) — is the highest high over a number (n) of previous periods.
LOW(i-n) — is the lowest low over a number (n) of previous periods.

TWS Guide

1322

Chapter 1

Apply a Williams Oscillator Indicator

To apply a Williams Oscillator indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Williams Osc. and Add the study.
3. Complete parameters as necessary.
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Weighted Close
Presents an average of each day's price with extra weight given to the closing price.

To apply a Weighted Close Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Weighted Close and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.
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Apply Weighted Moving Average Indicator
The weighted moving average gives each data point a weight proportionate to its number in the
sequence and divides by the sum of its weights. The calculation for a 3-bar weighted moving average is:
(1 x price_1) + (2 x price_2) + (3 x price_3) divided by 6, where 6 is the sum of the weights (1 + 2 + 3).

To apply a Weighted Moving Average
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1. From within a chart, from the Edit menu select Studies.
2. Choose Weighted Moving Avg. and Add the study.
3. Complete parameters as necessary.

Zig Zag Indicator
The Zig Zag is a series of trendlines that connect the tops and bottoms of significant prices. Connection
criteria is defined using the indicator's Minimum Change or Percent Change parameter.

To apply a Zig Zag Indicator
1. From within a chart, from the Edit menu select Studies.
2. Choose Zig Zag and click Add to add the study to the Applied Studies group.
3. Complete parameters as necessary.
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Once the study is defined, you can elect to uncheck/check to remove and add the study to your chart.

Bond Indicators
Bond Search Query

1327

Bond Search Scatter Plot

1331

Bond Details Table

1332

Export Bond Details to Risk Navigator

1333

Bond Search Query
You can query for bonds issued by agencies, government or corporate bonds. Use these fields to define
bond search criteria (similar to scanners). The less criteria you specify the larger the number of bonds that
will be returned. You must define at least one criterion for the search to begin.

TWS Guide

1327

Chapter 1

Using the Query Criteria

Using the Query Criteria

As you define the search criteria for bonds, the Search button on the bottom right of the tool will return the
number of bonds that meet your criteria.
Criteria is optional, but at least one criterion must be specified to make the search valid. Filter fields
includes:

Filter
Issuer Name

Description
Specify a ticker or group of tickers,
separated by commas.

Moody's Rat-

Select one or multiple choices.

ing/Collateral
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Type
Option Flag

Select one or multiple flags (definitions
from Investopedia):
Bullet: A debt instrument whose entire
face value is paid at once on the maturity
date. Bullet bonds are non-callable.
Bullet bonds cannot be redeemed early
by an issuer, so they pay a relatively low
rate of interest because of the issuer's
exposure to interest-rate risk. Both
corporations and governments issue
bullet bonds, and bullet bonds come in a
variety of maturities, from short- to longterm.
Callable: The main cause of a call is a
decline in interest rates. If interest rates
have declined since a company first
issued the bonds, it will likely want to
refinance this debt at a lower rate of
interest. In this case, company will call its
current bonds and reissue them at a
lower rate of interest.
Puttable: A bondholder can redeem
puttable bonds on certain dates and at
certain prices. The advantage of these
bonds to an investor is that if market
yields rise and the value of the bond falls
below the put price, the investor can
exercise the put option and stem his
losses to the put price. Of course, the
special advantages of put bonds mean
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that some yield must be sacrificed.
Sinkable: A sinkable bond issuer is
required to buy a certain amount of the
bond back from the purchaser at various
points throughout the life of the bond, at
a set sinking price. Issuers set aside
money in their sinking fund to repay the
money owed based on the bond's par
value. If interest rates fall below the
nominal rate of the bond, sinking fund
provisions can allow the company to
repay all or part of the amount owed, and
refinance the remaining balance to the
lower rate.

Issuer Type

Select agency, corporate, government or All.

Coupon Fre-

The per-year frequency of coupon

quency

payments.

Open Amount

Specify a range to search.

Coupon Rate
Maturity
Issue Date

Query Type

Option-Adjusted Spread - A
measurement tool for evaluating price
differences between similar products
with different embedded options. A
larger OAS implies a greater return with
greater risk. For an OAS scatter plot,
toggle the x-axis to display to Duration.
Yield to the Worst - Yield to worst is
calculated on all possible call dates. It is
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Bond Search Scatter Plot

assumed that prepayment occurs if the
bond has call or put provisions and the
issuer can offer a lower coupon rate
based on current market rates. The yield
to worst will be the lowest of yield to
maturity or yield to call (if the bond has
prepayment provisions); yield to worst
may be the same as yield to maturity but
never higher.

Industry

Select multiple industries; use the
"+" sign to drill down into the list to
more detailed sectors.

Bond Search Scatter Plot
The results of a bond search are presented in a scatter plot, where each green dot represents a bond that
meets the specified criteria.
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To display a scatter plot
After filters are defined, click the Search button.
To zoom in, click in the plot and drag. The area to be enlarged is appears highlighted in yellow. To unzoom,
click Reset Scale.
By default, the X-axis displays maturity in years. For an Option Adjusted Spread, the scatter plot can be
toggled between Time to Maturity (in years) and Duration (price sensitivity to interest rate movements).
The Y-axis represents the query type: Option-Adjusted Spread (to evaluate bond price) or Yield to the
Worst (lowest potential yield on a bond). The higher the YTW – the more risk.

Bond Details Table
See the risk measures and bond attributes. Add or remove columns in the table and reset units/decimals
for scaling using the buttons in the table.
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Export Bond Details to Risk Navigator
Once you have finished populating the Bond Details table, you can import all bonds from the table in the
Risk Navigator in the form of a What-If portfolio.

To export bond details to Risk Navigator
From the Bond Details table, click Export What-If.
Choose to Save the file and click OK.
Choose the directory (or note the default directory) where the file will be saved. For example, Firefox saves
files to C:\Downloads by default.
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Open the Bond Details using a what-if portfolio in Risk Navigator. You can modify the position and initiate
trades from within the What-If.

To open Bond What-If in Risk Navigator
Open the Risk Navigator from the Analytical Tools menu.
From the Portfolio menu, select Open and find the saved file. Click Open.
Select the Bond tab to see the new What-If bond portfolio.
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Using Global Configuration
The global Configuration window is your starting point for defining system-wide default configuration
settings.

To use Global Configuration
From within Mosaic: Use the File menu and select Global Configuration.
From with Classic TWS: Use the Edit menu select Global Configuration.
Or
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From within any window or tool click the configuration wrench icon.
Use the left pane to navigate high-level sections and pages. Use the right pane to define configuration
settings for the selected page.
You can also use the text filter box at the top of the window to find the page you want to configure. The list is
filtered to show only those pages which include the text you've entered in their title.

General Configuration
Use the General configuration page to set miscellaneous defaults such as automatic future rollover
notification, audit trails and language settings.
To define general configuration settings
From the Mosaic File menu select Global Configuration.
From the Classic layout use the Edit menu to select Global Configuration.
Click General in the left pane.
Use the right pane to set these parameters:
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General
Keep application on top - Check to keep the trading screen on top of all other active windows.
Auto Roll Data for Expiring Futures Contracts - When checked, all futures data lines that are
about to expire will be rolled to the lead month's futures contract. In addition, if you have orders on expiring contracts you will receive a message asking if you would like TWS to cancel those pending orders.
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Create audit trail - When checked, you can elect to view a condensed or extended version of your
audit trail, which includes all trade activity for your account. Find the Audit Trail command under the
TWS Account menu.
Desktop notifications - Instruct TWS to notify you when an order fills or a new FYI is available using
a subtle, transparent notification pop up in the bottom right corner of your screen. This notice opens on
top of your open desktop applications and is visible for ten seconds, but it doesn’t take focus away from
your current task. If you want more details on the event, simply click the pop-up to be taken into the FYI
or orders section of the tool.
Once per completed order and FYI event - Displays when an order fills or when new IB FYI is
available.
Each trade and FYI event separately - Includes partial fills or specific legs filled on combination
orders.
Never - Will not notify for any order activity and will not display FYI events.
Display account number - For users who have multiple instances connected to different accounts,
for example a production trading account and a paper account, check Display account number to show
the number of the originating account.

P&L Time Zone
Changes to P&L settings will not take effect until your next log in.
Use instrument-specific reset time - Resets the daily P&L on a per-instrument basis in accordance
with the time zone in which the instrument trades. For instruments that open and close on the same
day, the P&L is reset five minutes before midnight of the instrument's time zone. For instruments that
trade across two days (through midnight), the P&L is reset five minutes before it opens for trading in
the instrument's time zone.
Use time zone of the device - Will use the time zone of the device to define the "start of day" for calculating daily P&L. Available only when Use instrument-specific reset time is disabled.
Use specific time zone - Allows you to select a time zone that will be used to define the "start of day"
for calculating daily P&L. Available only when Use instrument-specific reset time is disabled.
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Browser
Enter complete path to browser - Actions that require a browser will use your default browser
unless you specify a different path here. Please note that any path or executable you enter here will not
be checked, and if the application is compromised your system may be exposed to attack.

Language and Region
Current Language - Displays the current TWS language. Click Select to choose another language.
Click OK, then log out of TWSand log back in to activate the language change.
Current region - Displays the current region. Use the dropdown list to change the region. Click OK,
then log out of TWSand log back in to activate the language change.

Table editing
Enable keyboard entry on order lines - when checked, you can tab through an order line and
modify field values without using your mouse. Each field becomes editable when you land in it, and the
Enter key works like the left mouse click.

Configure Auto Export
Use the Auto Export configuration page to define settings for automatically exporting trade reports.
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To define auto export configuration settings
1. On the Edit menu select Global Configuration.
2. Click Auto Export in the left pane.
3. Use the right panel to set these parameters:
Field

Description

Activate

Check to enable automatic exportation of trade reports.

auto
export
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Start time

Enter the time to start the export in the format HH:MM.

Stop time

Enter the time to stop the export in the format HH:MM.

Interval

Set the interval (in minutes) to be used for checking for
and exporting reports.

Export

Define the directory to which you want to export the file,

directory

for example c:\desktop

Export

Enter the name for the exported file. To use the system-

filename

assigned default name, leave this field blank.

ID

Check this box to include the ID field on exported
execution reports.

Default

Select one column format. Extended mode includes the

Column/

type, last trading day, strike, right and premium

Extended

currency fields as well as the default columns, and

Form/

custom allows you to define all fields that will be

Custom

included in the report.

Columns
Write

If checked, shows the local time for executed trades

trade

regardless of the time zone in which the order filled.

times...
Symbol

Select the display type for the symbol, either the
underlying, the local, or both.

Field

Allows you to specify a field delimiter other than

delimiter

comma.

HotKeys
Assigning actions to specific keys and key combinations helps you rapidly create and transmit orders to the
marketplace. You can assign any keystroke, or a combination of the "Ctrl" and "Shift" keys with one of the
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26 keyboard letters, to map specific order creation and order transmission commands, such as buy, sell,
transmit and cancel.

To record hot keys
1. From the Mosaic File menu select Global Configuration, then select Hotkeys from the left pane.
2. In the Possible Actions area, choose an action to which you want to assign a hot key and click
Create Shortcut.
3. In the Keyboard area, click Record. If you already have a hot key recorded for the selected action, it
is displayed in the Current Key Shortcut field.
4. Press the actual keystroke or keystroke combination you will use to complete this action. The system
records your keystroke and displays it in the Current Key Shortcut field.
Note: If the Customize tab is visible, you can customize your hot key to be more specific. For
example, after you record a Buy hot key, customize it to create a bracket or trailing stop limit order.
After you record the desired hot keys and click Close, the mapped keys are displayed on the status line at
the bottom of the screen. To re-record a hot key assignment, follow steps 1-4 above. To remove a hot key
assignment from an action, click Clear.
How to define specific Hot Keys
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The procedures below pertain to specific hotkey functionality, including:
To create a Buy/Sell hot key for a specific order type (i.e. Buy Limit Order, Sell Stop Order)
To create a Buy/Sell hot key for a specific instrument (i.e. Buy Limit Order for XYZ)
To use instantaneous transmission
To attach bracket orders
To create Increase (or Decrease) order size hot key
To create Increase (or Decrease) Limit (Aux.) Price hot key
To use All Available for Buy/Sell order quantity
To change order type/time in force
To open the Alerts box to view/set alerts
To set an Auto Stop hotkey
To set an Auto Trailing Stop hotkey
To create a Buy/Sell hot key for a specific order type (i.e. Buy Limit Order, Sell Stop Order)
1. On the Edit menu select Global Configuration.
2. In the left pane select click Hot Keys
3. Select Buy or Sell as the Action and click Create Shortcut.
4. Click the Customize tab.
5. In the Order Type drop-down select the order type for which you want to create a hot key.
6. Populate any necessary order type-related fields.
7. Click the Shortcuts tab.
8. Click Record and press the keystroke combination that will represent the order type hot key.
9. Verify that the hot key has been properly recorded in the Shortcuts section.
To create a Buy/Sell hot key for a specific instrument (i.e. Buy Limit Order for XYZ)
1. On the Edit menu select Global Configuration.
2. In the left pane select Hot Keys
3. Select Buy or Sell Specific Product as the Action and click Create Shortcut.
4. Click the Customize tab.
5. In the Underlying field, enter an underlying symbol.
6. Populate the Order related fields.
7. Click the Shortcuts tab.
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8. Click Record and press the keystroke combination that will represent the order type hot key.
9. Verify that the hot key has been properly recorded in the Shortcuts section.
To use instantaneous transmission
When you create a buy or sell hot key for any order type, you can elect to "Transmit the order
instantaneously" by checking this feature at the bottom of the Customize page. When you activate
instantaneous transmission, using the hot key combination creates and transmits the order without giving
you time to review and modify order parameters.
Leave this feature unchecked to have the hot key combination create an order and leave it on the trading
screen for you to manually transmit.
To attach bracket orders
1. On the Edit menu select Global Configuration.
2. In the left pane select Hotkeys.
3. Select Buy or Sell as the Action and click Create Shortcut.
4. Click the Customize tab.
5. In the Attached Orders area, check Add Simple Bracket.
6. In the Bracket Orders area:
7. In the Lmt Price (+/- offset) field select Bid, Ask, Last or None as the basis for the Limit Price portion of the bracket order, and enter an offset amount if desired.
8. Select a Stop Type.
9. Set the Stop price and offset for the stop trigger price.
10. For Stop Limit orders, set the Stop Limit price and offset.
11. On the Shortcuts page record the hot key combination, and click OK.
To create Increase (or Decrease) order size hot key
1. On the Edit menu select Global Configuration.
2. In the left pane select Hotkeys.
3. Select Increase (Decrease) price or size and click Create Shortcut.
4. On the Customize tab select Size in the Field drop-down.
5. Set the Num Ticks value to represent the increment by which to increase (decrease) the default
order size.
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6. On the Shortcuts page, click Record and press the hot key combination to represent Increase
(Decrease) order size.
7. Close the dialog box.
To create Increase (or Decrease) Limit (Aux.) Price hot key
1. On the Edit menu select Global Configuration.
2. In the left pane select Hotkeys.
3. Select Increase (Decrease) price or size and click Create Shortcut.
4. On the Customize tab select Limit Price (Aux. Price) in the Field drop-down.
5. Enter the Num Ticks increment by which you want the hot key to increase (decrease) the price
value.
6. On the Shortcuts page, click Record and press the hot key combination to represent Increase
(Decrease) Limit (Aux.) Price.
7. Close the dialog box.
To use All Available for Buy/Sell order quantity
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. Select Buy or Sell as the Action and click Create Shortcut.
4. Click the Customize tab.
5. In the Size field, select Available, then click OK.Now when you use the Buy or Sell hotkey, the order
quantity will be determined by the number of available contracts as shown in the Ask Size or Bid Size
field.
To change order type/time in force
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. In the Modify/Transmit Order section, select Modify Order Type or Modify Time in Force and click
Create Shortcut.
4. On the Shortcuts page, click Record and press the hot key combination.
5. Close the dialog box.
To open the Alerts box to view/set alerts
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1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. In the Real-time Activity Monitoring section, select View Alerts and click the Create Shortcut
button.
4. On the Shortcuts page, click Record and press the hot key combination, for example Ctrl + A.
5. Close the dialog box.
6. Click OK.
When you use Ctrl + A from the TWS, the Alerts box opens displaying your current alerts. To create an
alert, click the New button.
To set an Auto Stop hotkey
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. In the Real-time Activity Monitoring section, select Add Auto Stop Order.
4. Click Record and press the hot key combination, for example Ctrl + A.
5. Close the dialog box.
6. Click OK.
Now when you use Ctrl + A from the TWS, you will attach a Stop order to the selected order.
To set an Auto Trailing Stop hotkey
1. On the Edit menu select Global Configuration.
2. In the left pane, select Hotkeys.
3. In the Real-time Activity Monitoring section, select Add Auto Trailing Stop Order.
4. Click Record and press the hot key combination, for example Ctrl + T.
5. Close the dialog box.
6. Click OK.
Now when you use Ctrl + T from the TWS, you will attach a Trailing Stop order to the selected order. The
trailing amount used is the value defined in the order defaults.
If you try to use a reserved key - for example the Alt key - when creating a hotkey shortcut, you will receive
an error message. If this happens please re-record the hotkey with another keystroke combination.
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Note: The standard hot keys do not function within the Rapid Order Entry panel. When you record
a hot key for one of the rapid order entry actions, you must use "Ctrl" plus a character key, or the
Escape key.

Configure Lock and Exit Parameters
Use the Lock and Exit configuration page to define auto lock and exit options such as whether or not you
want a confirmation message before the application closes.

To define exit configuration settings
1. From the Mosaic File menu select Global Configuration.
2. Click Lock and Exit in the left pane.
3. Use the right panel to set these parameters:
Lock Trader Workstation
Lock Trader Workstation after ___ minutes of inactivity - locks your workstation if no activity has
occurred for a defined number of minutes. Once locked, you must unlock the application using your

TWS Guide

1347

Chapter 1

Exit Options

TWS password.
Never lock Trader Workstation - check to remove auto-locking mechanism. Note that you can manually lock the workstation at any time by selecting Lock Application from the File menu.

Exit Options
Warn on exit with position - Check to display a warning message when you exit that lets you know
you are holding positions, and verifies that you still want to exit.
Prompt when exiting - Check to have TWS display a confirmation message "Are you sure you want
to exit?" before shutting down the application.
Auto save settings - check to have any changes to your settings, including the addition of new tickers
or Quote pages, automatically saved.
Use/Store settings on server - check to save the latest settings to the IB server, and to download the
latest settings from the IBserver on login. Checking this feature ensures that TWS will always have the
same content when you log in regardless of the machine you are using.
Save watchlists to cloud - check to save your TWS watchlists to the cloud. These watchlists can
then be imported into TWS for Mobile using the "Import" feature in mobile configuration.
Save market scanners to cloud – Check to save your TWS Market Scanners to the cloud for use in
TWS for Mobile.

Auto Logoff/Restart Timer
Set Auto Log Off Time - Specify a time of day for TWS to automatically log off. You must specify a
time.
Set Auto Restart Time - Specify a time of day for the application to automatically restart (without
authentication requirements). Please review auto-restart considerations before using this feature.

Information about Auto Restart
You have elected to have your trading platform restart automatically on a daily basis. This procedure will
require authentication only once a week, on Sunday.
There are several factors outside the control of IBKR that may impede auto-restart:
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If your machine is in sleep or hibernation mode, or happens to have no power when the restart is scheduled to occur.
If your machine is installing operating system updates that trigger an automatic system restart when
complete.
In rare cases, for example for security reasons, IBKR may need to revoke the authentication token,
causing your platform to require manual authentication once the restart competed.
Users should take into account that auto-restart works best with OFFLINE versions. In other TWS
versions, a failure of the automatic update, such as a network issue or failing to write on the disk, may result
in an interruption of the automatic restart.
Having your trading platform constantly up and running exposes it to the risk of being accessed by
unauthorized persons. We therefore strongly recommend that you consider the following security
measures:
Use a higher level of access control and protections for the operating system account profile, the physical machine running your trading platform, and the premises where it is located.
Keep the account protected with our two-factor authentication; either the Secure Login System (SLS)
devices or our smart phone application.
Should you consider a different type of protection than the SLS for your trading access, the recommended minimum is IP restrictions to be set for the user not protected by a security device or app.
Refer to the Security Considerations Following SLS Opt Out knowledge base article to find out more.

Display TWSMessages
Each time you receive an information or confirmation message in TWS, we include a checkbox in the
bottom left corner with the text "Don't display this message again." If you elect to hide a message, you can
enable it again at any time using the Messages section of the Global Configuration tool.
To enable a TWS message
1. On the Edit menu select Global Configuration.
2. Click Messages in the left pane.
3. Use the right panel to check any messages you want to enable.
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Note: This page can only be used to enable messages that you have turned off, not to disable
messages. We want to ensure you have read each message at least one time before you elect to
disable it.

Assign Sounds to Events
Use the Sound Manager to assign sounds to trading events.
To hear sounds other than a beep on your computer, you must have a sound card installed.
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To configure the Sound Manager
From the Mosaic File menu, select Global Configuration.
Click Sound Manager in the left pane.
From the Profile drop down at the top of the page, select a sound profile to apply to all enabled sounds.
Check an event to enable sound. Uncheck to disable sound.
For each enabled event, use the File Name "down" arrow to select an available sound type within the
selected profile.
If you have selected a voice profile, you will be able to apply non-voice sounds on an event-by-event basis.
Use the three-ellipses “Browse” button to add a new sound file not included in our list. Click and navigate to
your .wav sound file. Use the Play arrow to hear the sound you have chosen.
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In the Repeat field, enter the number of times you want the sound to repeat when it is invoked.
Click OK to save your sound configuration.

Configure Volatility and Analytics Settings
Use the Volatility and Analytics configuration page to define default settings for both volatility orders and
Price/Risk Analytics.

To define default Volatility configuration settings
1. On the Edit menu select Global Configuration.
2. Click Volatility and Analytics in the left pane.
3. Use the right pane to set these parameters:
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Volatility
Field

Description

Volatility

Choose either Annual or Daily.

units
Reference

Choose Bid or Ask to use the NBB (bid) when buying a

price type

call or selling a put and the NBO (ask) when selling a call or
buying a put. Choose Average to use the average of the
best Bid and Ask. This price is also used to compute the
limit price sent to an exchange (whether or not Continuous
Update is selected), and for stock range price monitoring.

Show

When checked, the volatility page displays prices rather

prices on

than volatility, with volatility in parentheses. If unchecked

volatility

(which is the default) values in the Price columns will be the

layout

volatility.

Continuous

When checked, the checkbox in the Continuous Update

Update

field is automatically checked and enabled. You can deselect Continuous Update on a per order basis.The
Continuous Update feature monitors the underlying price
and will update the price of the order if the price of the
underlying instrument changes significantly. Note that
you can only use Continuous Update for three active
orders at a time.

Price index

When checked, you can price smart-routed Volatility index

options

option orders off a selected futures price from the

relative to

Reference Contract field on the order line.

futures
contract
Show

Check to display the option price or volatility as a mouse tip
when you hover over the value in an order line.
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option
prices and
volatility in
tooltip

Analytics
Field

Description

Option

Shows a different scenario on the Option Analytics plot.

Value

Uses a blue line to show a raise in the implied volatility

Curve -

by 15% in relative change* using a blue line.

Volatility
up
Option

Shows a different scenario on the Option Analytics

Value

plot. Uses a red line to show a reduction in the implied

Curve -

volatility by 15% in relative change*

Volatility
down
Option

Decreases the time to expiration by one calendar day.

Value
Curve Time down
Cache

Choose to Always cache, Never cache, or make the

Check

choice based on your last selection (Auto).

Risk on
TWs
startup
*For an example of a relative percent change, if the current implied volatility of an option is 10%, a 15%
relative change would result in an implied volatility of 11.5%, calculated as follows:
10% * (1 + 0.15) = 11.5%.
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eSignal Market Data
Use the eSignal page to configure and use eSignal market data. Please note that to connect to eSignal
data, you must subscribe to eSignal, and download and install the eSignal application www.esignal.com.

To define eSignal settings
1. On the Edit menu select Global Configuration.
2. Click eSignal in the left pane.
3. Use the right panel to set these parameters:
Use eSignal for Market Data - check to use your eSignal subscription to receive market data in
TWS. If checked, enter eSignal username, password and host address.
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Connectivity
Enter username, password and Host Address for eSignal connection.
Note: You must restart your system for changes to take effect.
Change the update frequency if desired.

Market Data
For available security types, check appropriate boxes to receive top level and/or deep data.

Quick Stock/Bond Entry Exchange Configuration
Quick Stock/Bond Entry is a page-level feature which automatically completes a market data line for a
stock or bond based on the underlying symbol or CUSIP you enter. To use Quick Entry, you must:
Create a list of order destinations.
Enable a trading page for Quick Stock/Bond Entry.
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To configure Quick Stock Entry destinations
1. On the Edit menu select Global Configuration.
2. Click Quick Stock/Bond Entry in the left pane.
3. In the right pane, click Add, enter a destination and click OK.
4. Add as many order destinations as you would like to have available. You can add more destinations
at any time.
Add Smart to the list to be able to route Quick Stocks and Bonds via Smart order routing.
Clarify aggregate exchanges such as Smart by specifying the primary exchange also. For example,
Smart/NYSE.
You can enable Quick Stock Entry for an existing or new Quote Monitor. Ensure that the feature is enabled
by opening Global Configuration from the Edit menu. From the Features menu, expand the Market Data
Tools section and ensure that Quick Stock/Bond Entry is checked.
To enable Quick Stock/Bond Entry for a Quote Monitor
Right-click the tab and select Settings.
In the Order Origin area of the page settings, check Quick Stock/Bond Entry.

API Configuration
API Settings

1358

API Precautions

1360
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API Settings

To configure API settings
1. On the Edit menu select Global Configuration.
2. Click API in the left pane, and select Settings.
3. Use the right panel to set these parameters:
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General

Enable Active X and Socket Clients - Check to enable integration with TWS using ActiveX or
socket clients including Java and C++. Download sample programs from the Software page on the IB
website.
Enable DDE clients - Check to enable integration with TWS through DDE. Download sample files
from the TWS Software page on the website.
Download open orders on connection - uncheck if you do not want to download all open orders
when you connect to your API.
Include FX positions when sending portfolio - If you have the Include FX Positions feature activated, all FX positions will be included when portfolio updates are sent the to API client. Uncheck this
box if you don't want FX positions sent to the API client when the portfolio updates are sent.
Send status updates for EFP and Volatility orders with "Continuous Update" flag - If you
have Continuous Update activated for EFP or Volatility orders, all updates are sent to the API client by
default. Uncheck if you don't want these updates sent from TWS to the API client.
Use negative numbers to bind automatic orders - if checked, all orders that are automatically
bound to an API client via the reqOpenOrders or reqAutoOpenOrders calls or via system-generated
orders (i.e. volatility hedging orders) will be assigned negative API order IDs. Otherwise, these orders
will be assigned incremental API order IDs. Volatility hedging orders will have the order ID “parent API
order ID + 1” when possible.
Create API message log file - check to create a message log file. Use the Logging Level selector to
define the level of detail in the log.
Include market data in API message - shows market data in the API log file.
Socket port - Enter a socket port number which allows you to sync up multiple versions of TWS in
your ActiveX spreadsheet.
Logging Level - Set the level of log detail for the API text log. System gives the most general level of
logging; Detail gives the most detailed level.
Master API client ID - The API client with the specified client ID will receive all orders, even those
placed by other API clients. This differs from the Client ID of “0” which will receive all orders sent from
the TWS GUI.
Timeout to send bulk data to API - define the time in seconds that TWS will wait before disconnecting the API client if data cannot be sent quickly enough.
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Trusted IP Addresses

If you connect to the API through a trusted IP address, the connection is not questioned. Otherwise, you
will get a verification message asking if you are sure you want to make the connection.
Click Create to add a new trusted IP address to the list.
Click Edit to modify the selected address.
Click Delete to remove the selected address.

API Precautions
Specify whether or not to bypass precautionary warnings for API orders that trigger a red flag.
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Bypass Order Precautions for API Orders - check to allow orders that fall outside the size or value
limits to be submitted without a warning.
Bypass Bond warning for API Orders - check to allow bond orders that fall outside the specified
face value and other limits to be submitted without a warning.
Bypass negative yield to worst confirmation for API Orders - check to bypass any warning that
your API order will result in a negative yield to worst excluding commissions.
Suppress market cap - check to suppress the existing market cap for API stock and warrant orders.

Display Configuration
Display Settings

1361

Style Settings

1365

Ticker Row Settings

1366

Date Formats Configuration

1372

Toolbar

1373

Display Settings
To define display configuration settings
1. On the Edit menu select Global Configuration.
2. In the left pane, click Display and then Settings.
3. Use the right pane to set these parameters:
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Display Settings

Show arbitrage meter - check to automatically show the index arb meter if you have index instruments listed in your market data.
Show leg trades only - When checked, spreads and combination executions will be shown in individual legs. If unchecked, the entire combination will be displayed, and you can click to expand the line
and show the individual leg executions.
Use consolidated status column - When checked, the Status column will split and show both the
Transmit/Cancel buttons and the status color. You must manually remove the Transmit field to activate
this feature.
Rename Relative order type to Pegged-to-Primary - If checked, "relative" orders will display as
"Pegged-to-Primary" orders wherever the title occurs. This only changes the name. The relative functionality remains the same.
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Basic display mode - When checked, the display mode remains basic to potential improve system
performance. Check to turn off animation and other aesthetic actions.
Show combo strategy title first - When checked, the strategy title of a combo will display first in the
description, as in Calendar Spread + Feb 19 ‘10, - JAN 15 ‘10 14 Call. Uncheck to display the title last,
as in + Feb 19 ‘10, - JAN 15 ‘10 14 Call Calendar Spread.
Auto Show Price/Size Wand - When checked, the price and size wands will display automatically
when you put the cursor into an applicable field. If unchecked, the wand will display when you click and
hold the mouse in the field.
Quickly insert/remove columns from column headers - When checked, holding your mouse over
a column header will display the "Insert Column" and "Remove column name" commands. The "Insert"
displays a list of available columns that you can quickly add to your panel or window with a single click.
The "Remove" command lets you quickly remove the selected column.
Flash bulletins - Check to have trading notifications flash in red at the top of the screen.
Titlebar text - Text entered here will be used in place of your account number in the TWS titlebar.
Allow order sorting on Pending page - When checked, the pending page will go into compressed
view when you click an order field header to sort orders. Compressed view displays only orders, no
market data lines and no blank lines are shown.
Auto-resize columns - When checked, tables such as the trading window etc. will automatically resize table columns when a field has been added or removed.
Show symbol for derivatives - When checked, the local symbol will be shown as part of the contract
description.
Show daylight/summer time indication - When checked, the visible, displayed time zone reflect
change for daylight's savings (EST to EDT). When unchecked, this change occurs in the background.
Enabling a change to this setting requires you to restart TWS for it to take affect.
Rename Quantity column to "Leaves" - If checked, the Quantity column across all tools will be
renamed to "Leaves" but ONLY IF the Total Quantity column is also displayed.
Windows Handling

Bring all windows to front if one is selected - When checked, all windows in the application are
functionally linked, so that selecting one window will bring all windows to the front. This feature is automatically enabled if you enable Workspace windows snapping (above).
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Open new windows near action spot - When checked, new windows or tools will open next to the
spot where you initiated the action. This feature is especially helpful for smaller windows and tools that
might otherwise open behind or away from the current window, making it difficult to find.
Page Handling

Allow pages to be detached - When checked, you can detach trading pages from the main trading
window.
Insert pages in alpha order - When checked, newly added pages are automatically inserted alphabetically into your existing tab set of page names.
Display X icon in tab header - When checked, the X icon to delete a trading page will appear on the
active page, next to the trading page title.
Tooltips

Show for column headers - When checked, you will see descriptive text when you hold your cursor
over any of the main Trading screen column names.
Show timestamps - If checked, when you mouse over the last price you will also see the time of the
trade.
Show tooltip for order reversal - If checked, you will see a tooltip when you elect to reverse an order
from the trading window.
Show mouse hotkey - When checked, you will see a description of the hotkey when you mouse over
any fields for which you have created a mouse-click shortcut.
Show order status information - If checked, when you mouse over the Status field for an order the
status of the order, such as Submitted, Pending, Filled, is shown.
Show calculations for P&L columns - If checked, the full P&L calculation for any P&L columns will
be displayed in the mouse-over help. These calculations may be lengthy and require a large help box.
Blink "Trades" toolbar icon after trades

Blink always on new trade - If selected, the Trades icon on the trading toolbar will blink each time an
order executes.
Blink if Trade window is closed - If selected, the Trades icon on the trading toolbar will only blink on
new executions if you have the Executions window closed.
Never blink - If selected, the Trades icon on the trading toolbar will never blink.
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Options Colors

Color options based on in-the-money status - Check this box to use color-coding to identify an
option's in-the-money status at a glance.
Use the Change button to modify the default in-the-money or out-of-the-money background colors.

Style Settings
Use the Style configuration page to define style settings such hiding or showing gridlines, changing fonts
and modifying the color palette.

To define style configuration settings
1. On the Edit menu select Global Configuration.
2. In the left pane, click Display and then Style.
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3. Use the right panel to set these parameters:
Style Settings
Use system title bar - if checked, the TWS menus will be moved down a level and the original system
title bar will be displayed.
Large menu text - if checked, the menu titles on the titlebar will display larger.
Show grid lines in tables- check to display solid gridlines on your trading pages.
Color Text- check to display a text description of status colors on top of the colored field. For example,
the status field turns red when you transmit an order. With this feature checked, the colored area will
display the word "red" as well as displaying the color.
Auto Alignment - if checked, text will align left and numerical values will align right in all TWS fields.
Alternating row brightness - this setting provides a contrast level for better row by row readability on
trading pages. A setting of "4" provides the brightest contrast between alternating rows, "0" provide the
least contrast.
Font
Select Font Style - choose a new font.
Font Size - choose a new font size.
Mosaic Font Size - choose a font size that will be applied only to Mosaic windows.
If you "lock" the sizes, this will keep the ratio between Advanced Order Entry and Mosaic fonts intact. For
example, if current sizes are 11 and 13 and you change "11" to "12," the font size for Mosaic will
automatically change from "13" to "14" to keep the ratio intact.
Reset- click to reset font style and size to the default values.
Application Color Adjustment
Select a palette to apply a color scheme across the application. Please note that the new setting will not
be applied until the next time you log in. A sample view of your selection is shown using the TWS
image.

Ticker Row Settings
Use the Ticker Row configuration settings to specify the look of tickers on your trading pages.
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To define Ticker Row configuration settings
Open Global Configuration
From within Mosaic, use the File menu.
From within Classic TWS, use the Edit menu.
In the left pane, click Display and then Ticker Row
Use the right panel to set the custom ticker row parameters.
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Ticker Row Settings

Display stocks with options available in bold - when checked, stocks that have options will display
in bold font on the trading screen.
Show hedging icon in size column - check to have the delta hedge icon shown in the Quantity field
for volatility orders with an attached delta hedge.
Display tick-dots instead of colored prices - when checked, price display on the Quote Monitor will
be in white with a colored tick dot indicating upward or downward price movement.
Remove leading zero before decimal point - Check to remove the leading zero before decimals in
TWS to conserve space, for example see ".25" instead of "0.25."
Show position values in base currency - If checked, all position and P&L values are recalculated to
display in your base currency, and are shown in italics to identify them as having been converted from
the local currency to your base currency.
Highlight high or low for the day - when checked, the Last price will display in RED if it is also the
day's low, and will display in BLUE if it is also the day's high.
Display Buy/Sell mouse-pointer over Bid and Ask cells - When checked, you will see the word
"BUY" when you hover over the Ask price and "SELL" when you hover over the bid price as a reminder
of the action a click will invoke.
Show white outline for cells with hotkey actions - When checked, a thin white border will display
around cells when you mouse over them whenever clicking the cell will result in an action, for example
the bid or ask cell will initiate a sell or buy order when clicked.
Double click on contract will - Specify whether double-clicking an instrument will open the full Contract Details page, or make the field editable allowing you to change the instrument .
Home Exchange

Set a Home Exchange Group that identifies your most-used exchange groups. Each time the primary
listing exchange for an instrument matches a home exchange group, that exchange is hidden from the
description on the ticker line. This feature can help to clean up your trading page by removing the repetitive
listing of your most-used exchanges.
Fixed Income Minimum Size Increment

Customize the quantity display for fixed income products.
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Select $1 to size in face value.
Select $1 K to size in multiples of 1000.
Fixed Income Pricing

Shows the bond price including or excluding the away platform fees. Bond orders are frequently created on
the condition that they should only trade when the quantity meets or exceeds a minimum acceptable trade
size (set when the order is created) becomes available at their price. IB calculates and displays the net
price for each order or quote that it receives from away platforms assuming that the quoted price will trade
in full.
Given the platform fee and any possible minimum size requirements the displayed "total" bid or ask prices
may only be achieved by trading the full size.
Show Net Price - Displays full bond price including away platform fees.
Show Raw Price - Displays the bond price only, exclusive of away platform fees.
Forex Size Display Settings

Full display shows all digits - If selected, a sample size would show as 5,000,000.
Abbreviated display shows “K” for thousands and “M” for millions - If selected, the above size
of 5,000,000 would display as 5M.
Position and P&L Display Settings

Include Away positions to Portfolio and P&L - check to show away positions on a new tab in the
Positions section of the Account window, in the Positions field displayed on any TWS trading page,
and on the Portfolio page.
For display purposes, position values are aggregated to include both IB-held positions and “away”
positions on the same instrument/contract. However for trading purposes, if you elect to “close” a position,
only the portion held at IB will be traded.
Include today’s opening position in P&L calculation - Check to include existing positions in the
calculation for the P&L column only.
Round values to nearest whole number - When checked, the Cost Basis, Market Value and all
other P&L value column will be rounded to the nearest whole number.
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Color-code position and P&L columns - When checked, the Position and all P&L columns will use
color-coding to indicate positive and negative values at a glance. Set the colors using the selection
boxes below.
Increase average price precision by "n" points - Increase precision of Market Value and Average
Price fields by adding more decimals places. Elect to show the extra precision in superscript, i.e.
23.4521

Complex (Multi-Leg) Positions

Group legs into complex positions/Hide complex positions - Elect to "Group" legs to show the
position as a single combination strategy. Elect to "Hide" complex positions to display legs individually.
Display P&L on Complex Positions - When checked, both P&L and Realized P&L will be shown for
the complex position to which it is attributed. When unchecked, it will be shown on corresponding legs.
Simplify combinations ratios - Check to simplify the combination ratio display, ie. simplify 6:3 to 2:1.
Leave unchecked to leave ratios in their original form.
Use option leg price increments in price wand - When checked, price increments for complex
multi-leg positions will be the same as increments for an individual leg.
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Borrow/Loan Rate Format

The default Fee Rate format shows the borrow/lend rate from the perspective of a fee owed.
The Rebate Rate mode shows the borrow/lend rate from the perspective of a rebate received. When in
rebate mode, data is italicized.
Volume Column Display Settings

Prefer native volume - Does not update with every tick, but will include delayed transactions, busts,
late-reported trades and combos.
Prefer calculated volume - Updates with every tick, but may not include delayed transactions, busts,
late-reported trades and combos.
Abbreviated display shows "K" for thousands and "M" for millions - Check to show abbreviated instead of exact volume display using letters. This display saves space but may not show
enough detail for all cases.
Market Data

Click Reset Subscription to modify settings for delayed market data.
Show Forex data in 1/10 pips - When checked, forex quote precision will be increased to 1/10 of a
PIP (from usual 1/2 PIP). This is for quotes only.
Allow Forex trading in 1/10 pips - When checked, Forex orders will be submitted in 1/10 pip
increments.
Show last known quotes, excluding indexes - When checked, a static snapshot of the bid, ask, bid
size and ask size is displayed when the markets are closed, for all tickers that are subscribed to market
data excluding indexes.
Show last known quotes for indexes only - When checked, a static snapshot of the last price on
the index is displayed when the markets are closed, for all index tickers that are subscribed to market
data.
Do not prompt for Market Data subscriptions - When checked, you will not be prompted to see
delayed market data for those tickers that have no market data subscription. A change to this parameter requires that you restart your system before the change takes effect.
Format prices with commas - Check to see commas in price quotes where applicable.
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Date Formats Configuration
Customize how dates are formatted and displayed throughout TWS.

To use Date Formats
Open Global Configuration.
In the left pane select Display and then select Date Formats.
In the right pane, define the Global Date settings in the top section.
If desired, use the drop down selector on a section to define a unique date format just for that section.
Click OK to apply. You can modify these settings at any time.
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Toolbar
Use the Toolbar configuration page to define settings for the main Trading toolbar.

To define toolbar configuration settings
Open Global Configuration
From within Mosaic, use the File menu.
From within Classic TWS, use the Edit menu.
In the left pane, click Display and then click Toolbar.
Use the right pane to set the below parameters.
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Simplify menu and toolbar - when checked, the Classic TWS layout will use the simplified Mosaic menu
instead of the traditional TWS menu and toolbar.
Options
Show toolbar - check to display the main Trading toolbar.
Show icons - check to display icons on the main Trading toolbar.
Use large icons - check to increase the size of the icons on the main Trading toolbar.
Show text - check to display text descriptions of buttons on the toolbar. Use this feature in conjunction
with the Show icons selection to see both the icon and the text name of the toolbar buttons.
Show toolbar on detached pages - if you elect to detach some trading pages, the toolbar will remain
visible.
Font
Font name - choose a new font.
Font Size - choose a new font size.
Default - click to reset font style and size to the default values.
Toolbar Items
The items in the screen can be added to/removed from the trading toolbar. Change the order of the buttons
and separators using the Move Up and Move Down buttons on the right. Use the Remove button to
remove a feature from the toolbar. Use the Add Separator button to add a line separator above the
selected toolbar feature. Click Reset to put back all removed features and separator lines. Click Default to
configure the toolbar based on the default layout.
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Configure Trading Tools
Accumulate/Distribute

1375

BasketTrader

1377

BookTrader

1378

FXTrader

1382

OptionTrader

1385

Portfolio Window

1387

Configure the Quote Monitor

1388

Accumulate/Distribute
Configure the Quote Panel, the Orders tab and the Trades tab.
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To configure Accumulate/Distribute
1. Click the Configure wrench icon from Accumulate/Distribute, or from the Edit menu select Global
Configuration.
2. In the left pane under Trading Tools, click Accumulate/Distribute, and then choose Quote
Panel, Order Columns or Trade Columns.
3. Use the right pane to set the Accumulate/Distribute parameters.
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BasketTrader
Use the BasketTrader configuration section to modify the layout of existing pages, or apply a new layout to
a page.
To define BasketTrader configuration settings
1. On the Edit menu select Global Configuration, or click the configure wrench icon from the BasketTrader window.
2. Click BasketTrader Layout in the left pane.
3. Use the right pane to configure the following fields:

Settings
Show total row on basket pages - Check to display the Total row on the BasketTrader. The Total
row displays the total P&L values for all P&L fields you have displayed.
Instant removal of basket orders from pending page - Check to have executed trades instantly
removed from the pending page.
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BookTrader
Use the BookTrader configuration page to define basic settings, hotkeys, buttons and to control the
visibility of column fields.
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To define BookTrader configuration settings
1. Click the Configure wrench icon on any window.
2. Click BookTrader and then Settings in the left pane.
3. Use the right pane to set the following:
Components

Display menu - Check to see the BookTrader menu.
Display toolbar - Check to see the BookTrader toolbar.
Display user-configurable buttons - opens the Buttons panel on the BookTrader window.
Display Deep Book Buttons - check to show the Deep Book buttons panel in BookTrader. Depress
a button on the panel to include that data in the price ladder.
Show Deep Book buttons without permissions - check to display buttons for any subscribable
deep book data to which you don’t currently subscribe.
Price Ladder Status Column

Show single status column - check to display one Status column on the Bid side, and one Status
column on the Ask side. When this status is selected, use the Order control section to tell TWS how to
handle multiple orders on the same side.
Show separate status column for each order - check to have a new Status column created for
each order. When this status is selected, the Order control section is unnecessary and becomes inactive.
Do not show status column - check to hide the status from BookTrader. When this status is selected,use the Order control section to tell TWS how to handle multiple orders on the same side.
Price Ladder Order Control

Move existing order - select if you want an existing order to be moved when an empty price level on
the same side is clicked. This selection does not allow multiple orders on the same side.
Create new order - select if you want to allow multiple orders on the same side at different price
levels.
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Cancel order - select if you want to cancel an existing order at a specific price level when that same
price level is clicked. This selection does not allow multiple orders on the same side at the same price
level.
Create new order - select if you want to allow multiple orders on the same side at the same price
level.
Re-center

Center around last price - If selected, when you click the Re-center button the BookTrader ladder puts
the central focus back around the last traded price.
Center around midpoint of bid/ask - If selected, when you click the Re-center button the BookTrader
ladder puts the central focus back around the midpoint of the bid/ask price.
Number of rows to display - Enter a value that defines the number of rows, or prices, you will see.
Jump to order - If checked, your cursor will jump to the order in the Orders panel after you transmit.
Allow multiple untransmitted orders - If checked, you can create more than one order in the Underlying
panel. Otherwise, only one untransmitted order is allowed.
Show Cumulative Size in Bid/Ask - If checked, the cumulative size is shown at the top of the Bid
column and Ask column.
Display Size column in Price Ladder - check to display a Size column on the Bid side and Ask side.
Note that this checkbox is only active if Cancel order when Bid Size /Ask Size column is clicked at a
price level that already has an existing order is selected in the Order control section.
Display P&L column - Click to display the P&L column on both the bid and ask sides of the BookTrader
ladder. The P&L column.
Show High/Low - When checked, identifies the high and low prices by displaying different colored backgrounds.
The High price is highlighted by a Bright Blue background.
The Low price is highlight by a Red background.
Show bold prices every 5 lines - Use this feature to help make prices easier to follow by having every
5th row bolded.
Show price histogram - Checked by default. If checked, a colored field displays the volume of trading
each day at each price level on the BookTrader price ladder. The bar colors coincide with colors in the
Price field, for example the last trade is teal blue, the current best ask is green, etc. See the topic on
BookTrader colors for details.
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Use context cursors in armed mode - Check to include a text description below your cursor. For
example, if you hold your cursor in the yellow Bid Size column, the text Buy appears to let you know
that clicking at a price level in this field will initiate a buy order.
Retain filled order columns - Valid only in Advanced Mode. When checked, the new Order column will
remain visible after the order has filled.
Show tooltips for order columns - Valid only in Advanced Mode. When checked, displays an order-relevant tooltip when you hold your mouse cursor over a field in the Order column.
Display P&L in Order Columns - Valid only in Advanced Mode. When checked, the P&L will display in
the new Order column when an order executes
Order type select Buttons - Valid only if Show separate status column for each order is select in the
Status section. Displays a toolbar with order type buttons. Click a button to put the mouse cursor into
that specific order type mode.
Remember armed state between sessions - check to keep BookTrader armed so that it is in armed
mode the next time you log in to TWS.
Display auto-scroll countdown after scrolling - When the inside market (or last trade price) moves
outside the display area, the ladder will automatically re-center on the inside market (or last trade
price). When the user is scrolling the ladder using either the Up/Down arrow keys or the scrollbars, and
the inside market (or last trade price) falls outside of the display area, auto-recentering will occur five
seconds after the user has completed scrolling. Check this feature to see an animated progress countdown bar.
Hotkeys

Opens the Hotkeys and Mouse Shortcuts dialog box. You can modify the configuration of existing
shortcuts by selecting an action and clicking Configure. For more information see the BookTrader Hotkeys
topic.
Buttons

Create custom buttons to add to the toolbar, or edit existing buttons.
Quote Panel

Hide or display fields in the Quote Panel using the Columns page of the Page Layout. Modify text and
background colors using the Colors page.
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Order Columns

Hide or display fields in the Orders area using the Columns page of the Page Layout.
Trade columns

Hide or display fields in the Trade panel.
BookTrader Colors

Allows you to change text/ background colors for many of the BookTrader fields. To change a color, click
the Text or Background button in the appropriate row and select a new color from the palette.
BookTrader Sound Manager

Opens the Sound Manager for the BookTrader where you apply sound settings for placing a limit order
(click bid or ask price), cancelling an order, and placing a stop order (right-click bid or ask price). You can
also elect to disable an event sound by unchecking the checkbox in the appropriate row.

FXTrader
FXTrader is customizable on many levels, from the color and number of cells to the method used to
calculate order quantity.
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To define FXTrader configuration settings

TWS Guide

1383

Chapter 1

Settings Page

1. On the Edit menu select Global Configuration, or click the Configure wrench from the FXTrader
page.
2. Click FXTrader in the left pane.
3. Use the right panel to set these parameters:
Settings Page
Components

Display menu - Check to see the FXTrader menu.
Display toolbar - Check to see the FXTrader toolbar.
Display Quote panel -Check to show the Quote panel with market data at the top of the window.
Display user-configurable buttons - check to show customizable buttons.
General

Jump to order- Automatically positions the cursor on a newly created order in the Orders panel.
Allow multiple untransmitted orders - If checked, you can create more than one order in the
Underlying panel. Otherwise, only one untransmitted order is allowed.
Allow numerator sizes - adjusts the display to allow trading the numerator instead of the denominator.
Color Schema - Use these settings to change the look of your FXTrader interface by changing the color of
cells and text.
Position Information and Cell Layout

Show Position - When checked, the position is displayed at the bottom of the trading cell.
Show Average Cost - When checked, the average cost of the position is displayed at the bottom of the
trading cell.
Show Profit and Loss - When checked, the unrealized P&L is displayed at the bottom of the trading
cell.
Cell Layout Grid - Modify your FX Trader grid to be as small as one cell or as large as 4x4. The blue
cells will display in your FX Trader.
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OptionTrader
Use the OptionTrader configuration page to define basic settings, order presets, hotkeys, buttons and to
control the visibility of column fields.
To define OptionTrader configuration settings
1. Click the Configure wrench from any window.
2. Click OptionTrader in the left pane and then click Settings.
3. Use the right pane to set these parameters:
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Settings

Components
Display menu - Check to see the OptionTrader menu.
Display or hide toolbar - Check to see the Option Trader toolbar.
Display Quote panel - check to display the Quote Panel, which displays a single line of market data
for the asset. You can create an order from the Quote panel by click the bid or ask price.
Display user-configurable buttons - hide or display buttons you create using the Buttons panel.
Display or hide Statistics - a configurable, optional panel that shows option-related data and statistics.
Miscellaneous
Jump to order- automatically puts the cursor on the newly created order in the Orders panel.
Allow multiple untransmitted orders - if checked, you can create more than one order in the
Underlying panel. Otherwise, only one untransmitted order is allowed.
Show all orders - check to view all orders for the underlying.
Show option prices in volatility - check to view volatility instead of dollar prices.
Show last trading day headers - check to sort option chains using a single header for the Last Trading Day followed by a list of strike prices. This helps save room in the option chain Description column.
Link option chains to windows groups - If checked, the Mosaic Option Chains window (not full
OptionTrader) will be linked to the windows group allowing selected option chain contracts to act as the
source and change focus in all grouped windows.
Auto refresh chains after updating filters - If checked, option chains update immediately when any
filter criteria (strike, right etc) are changed. If unchecked, you must manually update chains using the
Load Chains button.
Order Ref - A user-defined reference name to help identify where the order originated.
Order Presets - OptionTrader-specific default order settings. The OptionTrader preset is linked to the
selected Order Ref. above. Create a preset for both Stock and Options with the same title and link to
the Order Ref by selecting it or by creating a new preset. These presets will control the default order
parameters for any stock and options orders created from the OptionTrader. If you do not create a
stock preset for the OptionTrader, the default stock preset will be used for stock orders created in the
OptionTrader.
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Auto-Loading
OptionTrader automatically loads option chains based on the criteria you set in this area.
Assume underlying is a SMART stock - Uses Smart instead of a specific exchange.
Quick stock entry - Check to auto load stock and bring up the exchange dialog immediately when you
enter an underlying.
Load the closest N strikes to the money - Choose a number to limit how many options load in the
chain.
Load the nearest N expiries - Only shows you those options with the N closest expiries.
Load specific months - Specify the exact months' options you want to see.
Auto-resize columns on load - When checked, data columns will resize appropriately to accommodate revised data.

Portfolio Window
The Portfolio window is an automated trading page you can elect to create based on the current content of
your portfolio. Configure the Portfolio window to hide or show panels, market data and order management
columns by default. You can modify any of these settings directly from the window at any time.
To configure the Portfolio window
1. On the Edit menu select Global Configuration.
2. Click Trading Tools and then Portfolio Window in the left pane.
3. Configure Settings, Trade Columns, Order Management columns or the Market Value panel.
4. Use the right panel to set these parameters:
Settings

Display market value panel - opens the Market Value panel populated with data from the Account
Information window.
Display orders panel - Opens the Orders panel in the Portfolio window. New orders will be displayed in
this separate panel rather than directly below the ticker.
Display trades panel - Opens the Trades panel to display executions.
Jump to order - if checked, automatically places the cursor on newly created orders in the
Orders panel.
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Trade Columns

Check the columns you want to show in the Trades panel.
Order Management

Customize the layout of the main window by adding or removing columns from the Market Data and Order
columns.
Market Value

Check the columns you want to show in the Market Value panel.

Configure the Quote Monitor
Create a Page Layout
The Layout feature lets you create custom layouts that you can then apply to your trading pages. Use the
Layout editor to identify which columns you want to display, where you want the columns to be in relation
to each other, and the text and background colors used to convey trading information for a specific layout.
If you want to change the way your pages display but want them all to look the same, you can simply
change the Default page layout. If you want to apply different layouts to specific pages or save the default
settings, create a new layout by copying the Default, renaming and editing it.
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To create a page layout
To create a new layout, you must copy an existing layout, rename it, and then edit it to your specifications.
1. On the Edit menu, click Global Configuration and then click Trading Window.
2. Select Other Layouts in the left pane, and then click the New button in the right pane.
3. Enter a name for the new page layout and click OK.
4. Click Edit to open the Page Layout editor.
5. Modify column visibility, column order, and text and background colors and click OK. The layout
remains unused until you apply it to a page.

Apply a Page Layout
You can apply a layout to existing trading pages one page at a time, or to a new page when you create it.
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To apply a layout to an existing page
1. On the Edit menu, select Global Configuration.
2. In the left pane, select Trading Window and then Pages.
3. Choose the page on which you want to apply a layout.
4. In the Layout dropdown list, select the layout you want to apply.
5. Choose an order default strategy.
6. Click OK.
All pages use the Default layout and Default strategy until you specify otherwise.
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Edit a Page Layout
The Layout feature lets you create custom layouts that you can then apply to your trading pages. Use the
Layout editor to identify which columns you want to display, where you want the columns to be in relation
to each other, and the text and background colors used to convey trading information for a specific layout.
If you want to change the way your pages display but want them all to look the same, you can simply
change the Default page layout. If you want to apply different layouts to specific pages or save the default
settings, create a new layout by copying the Default, renaming and editing it.
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To edit a page layout
1. On the Edit menu, click Global Configuration and then click Trading Window.
2. In the left pane, select the layout you want to edit.
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3. Use the Market Data Columns and Order Columns tabs to Add or Remove fields.

4. Fields in the Market Data Columns page display along the TOP row of field headings on a Trading
page. Fields in the Order Columns page display along the bottom row of fields headings. If you display the same field on both the Market Data and Order row pages, it appears as a single field like the
Underlying, Exchange and Description fields above.
5. If desired, change text and background color using the Colors tab and click OK.
The layout remains unused until you apply it to a page.

Display Market Data Columns
You can choose to display or hide many of the columns on the trading page using the Layout manager in
Global Configuration.
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To display/remove market data columns on a page
1. Right click and column heading on a trading page, and select Customize Layout.
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2. Click the Market Data Columns tab to view columns.The columns already displayed on your trading window appear in the Shown Columns list on the left side of the page. The remaining columns
are grouped by category in the Available Columns list to the right.
3. To display columns, select one from the Available Columns list and click the Add button to move the
column into the Shown list.
4. To remove a column, select a column in the Shown Columns list and click the Remove button.
Column titles in bold are always visible and cannot be removed. Use the Filter field to help find the column
you’re looking for, or click the Sort radio button to list all columns alphabetically.
For descriptions of data displayed in Market Data columns, see the Market Data Fields topic.

Configure Columns
You can configure the text and background on individual columns in the trading window.
For price and size columns, you can turn off the dynamic coloring, which indicates upward movement in
price or size in green and downward movement in red, by unchecking the Use Dynamic Colors box.

To configure columns
1. Right click the column name and select Configure xyz Column.
2. If dynamic coloring is available, you can uncheck the feature if desired.
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3. Modify the background and text color of the column using the Text and Background color-pickers.
Click User Defaults to return to original TWS colors.
4. Alignment moves the data within the column.
5. Width controls the column size.

Display Order Management Columns
You can choose to display or hide many of the columns on the trading page using the Layout manager in
Global Configuration.
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To display/hide order columns on a page
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1. Right click the field labels on a trading page, and select Customize Layout.
2. Click the Order Columns tab to view columns.The columns already displayed on your trading window appear in the Shown Columns list on the left side of the page. The remaining columns are
grouped by category in the Available Columns list to the right.
3. To display columns, select one from the Available Columns list and click the Add button to move the
column into the Shown list.
4. To remove a column, select a column in the Shown Columns list and click the Remove button.
Column titles in bold are always visible and cannot be removed. Use the Filter field to help find the column
you’re looking for, or click the Sort radio button to list all columns alphabetically.
For a description of data displayed in Order columns, see the Order Management Fields topic.

Rearrange Trading Page Columns
You can reposition columns on a trading page by dragging and dropping a column into a new location.
Since order management and market data columns are stacked, you will be asked if you want to move one
of the columns, or both together.

To reposition a column
1. Click your mouse on the column you want to move.
2. Holding the mouse key, drag the column left or right to its new position.
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3. Release the mouse button.
4. In the confirmation message, select a single column, or elect to move both columns together.

Change Background and Text Colors
You can modify the background and text color for specific columns and rows using the Layout Editor.

To change colors in a page layout
1. On the Edit menu, click Global Configuration, then click Trading Tools and then Trading Window in
the left pane.
2. Select a layout (use Default to change the basic layout, click Other Layouts to find a custom layout
you designed).
3. Click the Colors tab and elect to modify either the text or the background color.
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You can modify text and/or background colors for the following items:
Ticker Row (text & background) - row that contains the market data for the product.
Up-tick (text only) - a tick that is moving up.
Down-tick (text only) - a tick that is on the decline.
Implied-tick (text only) - the implied tick for a combo order that is \simulated by adding the values of the
legs, as opposed to market data which represents an actual order for the combo.
No auto-ex (text only) - for options, tells you that orders placed against this market will not execute electronically.
Alarm set (background) - tells you that this line has an alarm set against it.
Order Row (text & background) - the order row that is created when you click on a bid or ask price for a
product.
Modified (background) - the background for orders that have been modified.
Selected modified (background) - the background for modified orders you have highlighted (to transmit
or cancel, etc.)
Total Row (text & background) - the optional total rows displays in different color to help it standout.
Background Grid (background) - the background of the entire trading page grid.
Background Auction (background) - the background of an order row whose instrument is participating
in an auction, and cannot be cancelled.

Modify Rapid Order Entry Settings
The Rapid Order Entry panel is one component of a trading page, and consequently its settings are
managed through the Page Layout Manager. Any changes you make to the Rapid Order Entry settings are
applied via that page's assigned page layout. If you have not created or applied page layouts to specific
pages, all pages are controlled through the default page layout. The procedure below assumes some
familiarity with the page layout manager.
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To modify Rapid Order Entry settings
1. On the Edit menu, select Global Configuration.
2. Select Trading Tools then Trading Window in the left pane.
3. Click the Rapid Order Entry tab to view the current settings.
4. Use the checkboxes, editable fields and Display Settings described in the table below to enable/disable features, set default values and select a default order type.
5. Click OK.
Note: Note that you are making changes to a component of a page layout, not to a specific page.
These changes will also be applied to all other pages using this layout.
Rapid Order Entry Settings
You can record hot key assignments for rapid order entry actions. Note that your standard hot keys (Buy,
Sell etc) are not valid within the Rapid Order Entry panel.
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Display
Show - displays the Rapid Order Entry panel at the top of any pages using the layout.
Hide - hides the Rapid Order Entry panel at the top of any pages using the layout.
Contract type
Stocks - automatically configures the Rapid Order Entry panel to allow you to trade stocks. You will see
the Display Settings list to the right from which you can select the fields you want to use.
Stocks/Options - automatically configures the Rapid Order Entry panel to allow you to trade stocks or
options. You will see the Display Settings to the right from which you can select the fields you want to
use.
Combos - automatically configures the Rapid Order Entry panel to allow you to create and trade combination and spread orders. The Display Settings list is not relevant to this layout.
Miscellaneous
Primary Exchange - enter the default routing exchange. We recommend using Smart to get the best
execution.
Default size - set the default order size. You may edit the value in this field from the panel.
Default order type - sets the default order type. You may edit this value from the panel.
Request market data - controls whether you will see a line of market data above the order management line that is created when you transmit an order.
Save contract info - when checked, the information for the current instrument will remain after you
transmit an order. Unchecked, all fields are cleared after you transmit an order.
Display Settings
Check any fields that you want to appear on the Rapid Order Entry panel.
Move up/move down - puts the checked fields in order. The order in which they appear in this list
determines the order in which they will appear on the Rapid Order Entry panel, and the order in which
the cursor will be inserted as you tab through the fields if Include in tab order is checked.
Include in tab order - this box must be checked or unchecked for each of the selected fields in the list.
Checking instructs your cursor to land in that field as you tab through.
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Time & Sales

1411

Trader Dashboard

1411

Configure Alerts
Use the Alerts configuration page to define basic settings, hotkeys, buttons and to control the visibility of
column fields.
To define Alerts configuration settings
1. On the Edit menu select Global Configuration, or click Configure from the Alerts menu.
2. Click Alerts in the left pane. You can expand the options in the left pane or in the right panel.
3. Use the right panel to set these parameters:
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Settings
Components
Display menu - check to see the Alerts menu.
Display toolbar - check to see the Alerts toolbar.
Display message as pop up - if checked, the default for Alerts is a pop up message.
Flash rows - if checked, the rows of market data used for the Alerts will flash when the Alert has been
activated.
Play sound - if unchecked, None is selected by default on the Audio tab of the Alerts page.
Sound - select a default alert sound.
Delete Timeout - set the time after which the alert notifications will stop.
Repeatable - if checked, this feature will be checked by default in the Duration area of the Alerts page.
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Hotkeys

Opens the Hotkeys and Mouse Shortcuts dialog box. You can modify the configuration of existing
shortcuts by selecting an action and clicking Configure. For more information see the Assign Mouse
Shortcuts topic.
Buttons
Create custom buttons to add to the toolbar, or edit existing buttons. Click New to create a new button.
Order Columns
Hide or display fields in the Orders area using the Columns page of the Page Layout.

Configure Alerts
Use the Alerts configuration page to define basic settings, hotkeys, buttons and to control the visibility of
column fields.
To define Alerts configuration settings
1. On the Edit menu select Global Configuration, or click Configure from the Alerts menu.
2. Click Alerts in the left pane. You can expand the options in the left pane or in the right panel.
3. Use the right panel to set these parameters:
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Settings
Components
Display menu - check to see the Alerts menu.
Display toolbar - check to see the Alerts toolbar.
Display message as pop up - if checked, the default for Alerts is a pop up message.
Flash rows - if checked, the rows of market data used for the Alerts will flash when the Alert has been
activated.
Play sound - if unchecked, None is selected by default on the Audio tab of the Alerts page.
Sound - select a default alert sound.
Delete Timeout - set the time after which the alert notifications will stop.
Repeatable - if checked, this feature will be checked by default in the Duration area of the Alerts page.
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Hotkeys

Opens the Hotkeys and Mouse Shortcuts dialog box. You can modify the configuration of existing
shortcuts by selecting an action and clicking Configure. For more information see the Assign Mouse
Shortcuts topic.
Buttons
Create custom buttons to add to the toolbar, or edit existing buttons. Click New to create a new button.
Order Columns
Hide or display fields in the Orders area using the Columns page of the Page Layout.

Configure Market Depth
Use the Market Depth configuration page to define basic settings, hotkeys, buttons and to control the
visibility of column fields.
To define Market Depth configuration settings
1. On the Edit menu select Global Configuration, or click Configure from the Market Depth menu.
2. Click Market Depth in the left pane. You can expand the options in the left pane or in the right panel.
3. Use the right panel to set these parameters:
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Settings
Components

Display menu - check to see the Market Depth menu.
Display toolbar - check to see the Market Depth toolbar.
Display Quote panel - check to display the Quote Panel, which displays a single line of market data for
the asset. You can create an order from the Quote panel by click the bid or ask price.
Display user-configurable buttons - if checked, the buttons that allow configuration are displayed.
Display Deep Book Buttons - if checked, the Deep Book Buttons panel will display, with a button for
each market center for which you have deep book data permissions.
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Display Deep Book buttons without permissions - if checked and Deep Book Buttons panel is
also displayed, the buttons for deep data will display even if you do not have permissions. These buttons will be visible but inactive.
Show pending orders in the book - if checked, any orders you transmit from the DepthTrader window will show, highlighted in white, in the Deep Book data.
Jump to order - automatically puts the cursor on the newly created order in the Orders panel.
Allow multiple untransmitted orders - if checked, you can create more than one order in the Underlying
panel. Otherwise, only one untransmitted order is allowed.

Configure News Feeds
You can elect to add more pre-configured news feeds to your workstation browser. You can also subscribe
to Reuters News Service via the Market Data subscriptions page in Account Management.
To view Reuters News
1. On the Edit menu, select Global Configuration.
2. In the left pane, click the horizontal key to expand the News Configuration feature, then select
News Suppliers.
3. In the Pre-configured Providers section at the top of the right page, check Reuters News Service.
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If this selection is grayed-out, it means you have not subscribed to this service in Account Management.
To add existing news feeds
1. On the Edit menu, select Global Configuration.
2. In the left pane, click the horizontal key to expand the News Configuration feature, then select
News Suppliers.
3. The right pane displays the current list of news suppliers whose headlines you can access. Click the
Add button to configure a new supplier.
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4. Select a supplier name from the dropdown list. The RSS Link is automatically loaded. Click OK.
5. The new supplier appears in the list of available news feeds.
Note: You can elect Refresh Intervals of 1, 2, 3, 4, 5, 10 and 15 minutes. Note that refreshing the
news feeds requires some system resources, and more frequent refresh intervals may have a
minor impact on your system performance depending on your connection type.

Time & Sales
Define the layout of the Time & Sales page that you can display for a chart.
Settings - choose to show quote line and show last only.
Hotkeys - define Time & Sales hotkeys and shortcuts.
Quote Panel - Hide or display fields in the Quote Panel area.
Colors - modify colors.
Columns - uncheck to remove columns from the Time & Sales main data area.

Trader Dashboard
The real-time Trader Dashboard is an optional tool that can be displayed at the top of the pages tabset.
This customizable panel allows you to monitor data fields from your Account Information window, keep
abreast of the most recent activity for specific contracts, and view current real-time news headlines for
products in your portfolio and for any tickers you are watching.
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To configure the Trader Dashboard
1. On the Edit menu, select Global Configuration.
2. In the left pane, click Trader Dashboard.
3. Use checkboxes in the right pane to set the following:
Check Show news to display news headlines for any products in your portfolio and to alert you to
recent news on any tickers you elect to display.
To see only portfolio-relevant news, check Display News for products in portfolio only.
To only see indicators of recent news next to individual tickers that you are watching, check Display recent news indicator only.
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Check Show price change in percentage to view the last price and price change values as percentages in ticker lines.
Check Show price change in value to view the last price change as an absolute value.
4. Click the Add Account Data button, and scroll down the list. Double-click each Account field that
you want to add to the dashboard. Each field you double-click is added to the Display Item list on the
configuration pane. Click OK to close the Add box.
The descriptions for Account Information fields are in the Account Information topic.
5. To add a last price/price change field for a contract, enter the underlying in the Symbol field and click
Add Ticker, then define the contract parameters just as you do when you add market data to the
trading page. The last price/price change displays in red to indicate downward movement and blue
to indicate upward movement.
6. Click OK. The Trader Dashboard is displayed at the top of your trading window, just above the
pages tabset.
You can change the display name for selected dashboard fields using the Change Label feature.

Configure Charts
Charts Settings

1413

Charts Toolbar

1424

Charts Colors

1424

Charts Quote Zone

1426

ChartTrader

1427

Charts Settings
To define Charts configuration settings
1. On the Edit menu select Global Configuration, or click the configure wrench from within a chart.
2. Click Charts in the left pane. You can expand the options in the left pane or in the right panel. Sections of the Settings page include:
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Display
Layout
Highlight
What to show when switching contract
Trendlines
Tooltips
Graphical position indicator
Order Display
Miscellaneous
Display

Define global default display settings for charts.

Name - Description

Name - Description

Market clock - if checked,

Toolbar - check to display theChartstoolbar.

displays the time in the top title
bar.
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Display

Chart value label - if

Buttons Panel - check to display configurable

checked, the Price,

ChartTrader buttons.

Volume and other axis
labels are displayed.
Hot Buttons - check to dis- Chart key (legend)- if checked, displays a key
play the floating

to the color, type of chart and asset charted

Buy/Sell/Alert set of hot

along the bottom of the chart.

buttons that you use to create orders. Hot buttons can
be armed to transmit
instantaneously.
Quote panel- if checked,

Quote Zone - check to display the Quote Zone,

the Quote panel, which

which floats within the chart along the top.

shows market data for the
instrument , displays at the
bottom of the chart window.
Crosshair - puts the cursor

Horizontal Crosshair Line - when checked, both the

into crosshair mode and

vertical and horizontal crosshair lines are displayed on

displays the vertical crosshair

a chart when you are in Crosshair Mode. When

line.

unchecked, only the vertical crosshair line displays.

Margin area - check to

VWAP on bar - check to show the volume- weighted

display a small, left-facing

average price on the bar.

arrow at the bottom of the
chart. Drag the margin in to
increase the horizontal buffer.
Bypass parameter

Show candle outline - check to shows outlines for

window - check to open

candlesticks.

charts using specified data
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Create multiple charts as

without opening the Chart
Parameters window.
Prior close - check to show

Intersection between trading days - check to show

the prior close price on the

a dotted line as a separator

chart.

ChartTrader - Displays

Logarithmic Scale - Change the increments on

the Orders, Log, Trades

the price axis to represent price change by "per-

and Portfolio tabs along

centage change"- rather than "dollar-value"

the top of the chart. These

change. Using Log Scale, a $5.00 change from

panels will also open auto-

10 to 15 represents a 50% price change, while a

matically when you create

$5.00 change from 20 to 25 is a 25% change.

an order.
Display Vertical Scrollbar - Adds a vertical scrollbar.
Create multiple charts as

Specify the layout for multiple charts.

Tabs - each charts goes into its own tabbed page.
Internal windows - charts are tiled within the same frame.
Layout

Set up global default layout options for charts.
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Highlight on ...

Price axis on: Left, Right, or Both

Quote panel on: Top or Bottom

Time axis on: Top, Bottom or Both

ChartTrader on: Top or Bottom

Fibonacci label at: Left, Middle or Right

Alert label at: Left, Middle or Right side

side of the top red Alerts bar.

of the top red Alerts bar.

Horizontal trendline label at: Left, Middle,
Right or None
Highlight on ...

Define which items you want highlighted on the Y (price) axis and on the chart.

Check the prices to highlight along the price axis. “Cursor price” is the price over which your cursor is
currently hovering within the chart.
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What to show when switching contract

Check the events to highlight in the chart itself. Holding your cursor over any of the highlighted events will
display a text description of the event.
What to show when switching contract

When adding a new chart, choose to either use the default “What to show” selection (i.e. Trades for stocks,
Midpoint for Forex) or keep the selection from the current chart.

Trendlines

Set trendline characteristics for charts.

Field

Description

Auto-

If checked, you can instruct TWS to complete a freehand

complete

trendline. Begin your trendline by clicking and holding the

trendline

mouse. To use auto-complete, release the mouse key, then
click again. TWScompletes the trendline across the chart,
following your trajectory.

Share

TWS Guide
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Tooltips

trend line

be reflected on other active charts using the same

among

instrument .

charts

Share

Check to share trendlines only when the bar size on charts

when bar

is the same, e.g. 5 min bar, 4 hour bar, daily bar etc.

size is

This feature is only enabled when Share trend line among

the same

charts is checked.

Tooltips

Specify whether to show tooltips on the chart, and how to display.

Field

Description

Display

Check to see mouse-over tooltips of the buttons on

ChartTrader

the button panel.

button tooltip

Display bar

Check to show details for bars in a bar chart. Use the

details

radio buttons to specify where the information will be
displayed.
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Graphical position indicator

If you select "bar details zone" you can pick the data
fields that display.
"tooltip" shows details in the mouse-over information.
"separate window" opens a small pop-up window
in the chart each time you mouse over a bar.
"bar details zone" displays information in the bottom right corner. Details change as you mouse
over each bar.
Display any of the following fields in the Bar Details
Zone: Date/Time, High, Low, Close, Open, Volume,
VWAP and Studies.
Graphical position indicator

Use colors to show the current position in the chart.

Check to indicate your current position using lines or color in the chart
Line - draws a line at the price point of the position.
Field - shades the chart from the position up (long position) or down (short position).
Custom - define the height of the shaded field.
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Order Display

Order Display

Define display features for orders shown in your chart. Set for both ChartTrader orders (orders submitted
from within the chart) and for all other orders (including orders submitted from any tool or window other
than ChartTrader).

Field

Description

Show live orders

Display working orders on the chart.

Show filled orders

Display filled orders on the chart.

Show cancelled orders

Display cancelled orders on the chart.

Miscellaneous

Define other miscellaneous chart features.
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Miscellaneous

Field

Description

Allow more

Enables smaller bar size for the same time

than 500 bars

periods. Note that some bars may be too
small to read.

Arrow-Key

Moves the control for moving from bar to

Candle Selec-

bar from the mouse cursor to the keyboard

tion

arrow keys.

Show selected

When checked, the specific time displays

time

in highlighted yellow along the bottom axis
of the chart as you move the cursor.

Bar chart spike
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Miscellaneous

protection

percentage value. If any bar exceeds this

(max. % change

percentage relative to the previous bar, it is

from previous

automatically eliminated from the chart.

bar)

Line chart

If you want to apply spike protection, enter

spike pro-

a percentage value. If any point exceeds

tection (max.

this percentage relative to the previous

% change

point, it is automatically eliminated from

from previous

the chart.

point)
Line grab

The higher the sensitivity, the more precise

sensitivity

you will need to be to grab and move lines.
Higher sensitivity makes it easier to draw
trendlines close together.

Show sub-chart

When checked, a box asking if you want the sub-

security

chart to use the same security as the selected

selection box

chart is displayed when you elect to Add New
Chart.

Always chart

Check to chart combos. If you leave

all combos

unchecked, you will be asked on an individual basis. Charting combos uses more
system resources than charting individual
contracts.

Gap between

Define the number of missing bars (up to 9)

trading days

allowed between trading days.

Axis label font

Select a font size to be used along the price and

size

time axes.

Quote zone font

Select a font size to be used in the chart’s Quote

TWS Guide

1423

Chapter 1

size

Charts Toolbar

Zone.

Charts Toolbar
Configure the toolbar by adding, removing and re-ordering toolbar icons.

Charts Colors
You can customize the display and print colors for many aspects of your charts using the Chart colors
matrix. Note that your changes are global and will be applied to all charts.
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TWS Guide
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Charts Quote Zone

You can restore the original colors by clicking Restore Defaults at the bottom of the colors list.

Charts Quote Zone
Specify the fields you want displayed in the middle and right areas of the Quote Zone. Note that the left
area cannot be modified.
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ChartTrader

To add and remove Quote Zone fields
1. Select the Middle or Right tab to edit the appropriate Quote Zone area.
To display a field, use the Add button to move a field from the Available Columns list to the Shown
Columns list.
To remove a field, select the field in the Shown Columns list and use the Remove button to put the field
back into the Available Columns list.

ChartTrader
Create hotkeys and shortcuts and action buttons, and add/remove fields from the Quote panel, Orders
panel and Trades panel.
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Orders

Orders
Orders - Default Settings

1428

Configure SmartRouting

1431

Configure IB Algo Favorites

1435

Orders - Default Settings
Use the Orders page to define general, global default settings.

TWS Guide

1428

Chapter 1

Orders - Default Settings

To define General order configuration settings
1. On the Edit menu select Global Configuration.
2. Click Orders in the left pane and then select Settings.
3. Use the Settings page to set the following parameters:
Orders
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Orders - Default Settings

Auto-save default size- when checked, any change you make to the quantity of an order is saved as
the default size for that instrument type, after the order is transmitted.
Big Scale prices - when checked, the increment used in the price wand is increased. The price wand
presents a selection of prices above and below the order price, and is invoked when you click and hold
the cursor in the Price field on an order line.
Big scale sizes - when checked, the increment used in the size wand is increased. The size wand
presents a selection of quantities higher and lower than the order size, and is invoked when you click
and hold the cursor in the Quantity field on an order line.
Auto-sort submitted orders - this feature is checked by default. When unchecked, orders created
on the same underlying are no longer sorted by limit price.
Auto-adjust limit price for STP LMT and LIT orders - if checked, the limit price in stop limit and
limit if touched orders will automatically be adjusted when you modify the stop price. The limit price
adjusts based on the offset amount you define when you create the order.
Round shares to nearest 100 when entering amount in “Quantity Value” column - if checked,
the system will round the order quantity to the nearest 100 shares.
Display pending day and GTC orders on separate pages - if checked, pending orders will be separated by GTC and DAY times in force to display on different pages.
Continuously update limit price for EFP orders in percent yield - if checked, TWS will continuously update the limit price for EFP orders where the price is entered in "percent yield." To enter
price in percent yield, right-click on price column header and select Show Percent.
Reset Short Sell Locations button - for non-cleared customers or customers who can clear-away
only. By default, TWS remembers how many shares you located when doing a sell short order. Clicking this button clears out that memory.
Disable auto-expand editor for orders with Presets - if checked, orders that generally invoke the
inline order editor that displays when you create an order (for example, algo orders) will not display IF
an order preset is assigned. Only check this if you will not want to edit these orders on a per-order
basis.
Auto adjust algo times - If checked, algos that are submitted at the close or use an invalid start or
end time will be automatically adjusted to use the valid trading date. This setting could be useful for
VWAP orders entered when the markets are closed.
Use multi-level structure in Order Destination field - if checked, the display of order destinations
in the Destination field will use collapsible categories with sub-entries.
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Configure SmartRouting

Set order ref for attached hedging order same as the parent order - if checked, child orders will be
assigned the same order reference number as the parent order. If unchecked, the child order reference will show a message that includes the parent ID.
Completed Orders Settings
Auto-remove orders - this feature is checked by default. When unchecked, executed and cancelled
orders remain on the both the trading and the pending pages.
Reuse rejected order - if checked, rejected orders will remain on the trading page.
Leave filled orders on the screen for - lets you increase or decrease the number of seconds before
filled orders are deleted from the Trading window.
Leave cancelled orders on the screen for - lets you increase or decrease the number of seconds
before cancelled orders are deleted from the Trading window.
Use auto-logoff time instead of midnight when downloading completed orders - if checked,
TWS will download orders from the time of the last auto-logoff. Otherwise completed orders from midnight to the current time are downloaded.

Configure SmartRouting
You can define event-specific directives for contracts routed through SmartRouting, such as excluding
quotes, setting a price cap by defining the acceptable distance from the NBBO, and specifying a strategy
for non-marketable orders.
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Configure SmartRouting

To modify SmartRouting functionality
1. OpenGlobal Configuration.
From within Mosaic, use the File menu.
From within Classic TWS, use the Edit menu.
2. Click Smart Routing in the left pane.
3. Use the right panel to set these parameters:
Excluded Quotes
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Routing Configuration

Exclude exchanges with non-firm quotes
Exclude exchanges with non-electronic quotes
If this option is selected, best efforts are used to determine which exchanges’ quotes are immediately
automatically executable, and which exchanges’ quotes would require manual (human) handling, and
SMART will route only to those exchanges offering automatic execution. Please note that while best
efforts are used, it is not always possible to determine whether a quote is automatically executable.
Maximum allowable distance from NBBO
Define the NBBO price cap by entering the "maximum allowable distance from NBBO." Note that
NBBO price capping supersedes the exclusion of non-firm quotes, i.e. your order will be routed to a
non-firm quote within the price cap over a firm quote outside the price cap.
Note: IMPORTANT If you choose to: a) exclude quotes from certain exchanges; b) exclude nonfirm quotes; or c) exclude non-electronic quotes, your order may not be executed at the best
posted price nationally (the “NBBO”). This is because one of the exchanges that you chose to
exclude might have the best posted price but that exchange will be bypassed by the SmartRouting
system on your instruction.
In addition, if you exclude certain exchanges from the eligible SmartRouting destinations and your order is
routed to another exchange with an inferior posted price, your order may not be executed by the exchange
to which it is sent because that destination may not be willing to execute at an inferior price, or your order
may not be marketable at that exchange. You should carefully evaluate all of these factors before deciding
whether to exclude certain exchanges from the eligible SmartRouting destinations.
Routing Configuration
Seek Price Improvement

If checked, Smart routing will sweep certain exchanges for hidden liquidity at more favorable prices. This
may result in slower executions.
Pre-Open Re-route

This allows you to route orders to major exchanges three minutes before the open. For orders submitted
before the open, checking this box ensures your orders are routed prior to the open. This directive only
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SMART Stock Routing Algorithms

Ignore Opening Auction order attribute is set.
SMART Stock Routing Algorithms

Do not route to dark pools - For stock and warrant orders only. When checked, all dark pool
destinations will be bypassed by the Smartrouter.
Customers who have the unbundled "Cost Plus" commission structure for stocks have the ability to choose
from a list of Smart routing strategies for non-marketable stock orders to complement their trading strategy.
Use the checklist to select a single "Default" strategy which will automatically be applied to any nonmarketable, Smart routed stock order, and any number of "Display" strategies, each of which will be
available from the Destination field as a per-order selection.
Available strategies include:
SMART Multipurpose (SMART) - This is the basic smart-routing algorithm. Routes your non-marketable order to the default exchange for the instrument.
SMART Dark Only - Will probe the dark pools for liquidity and use the immediate-or-cancel time in
force.
SMART Option Routing Algorithms

Choose how to route a smart-routed, non-marketable options order.
SMART Multipurpose (SMART) - This is the basic smart-routing algorithm. Routes your non-marketable order to the default exchange for the instrument .
SMART Maximize Rebate (SMART MaxRebate) - Routes the order to the exchange offering the
highest rebate.
SMART Prefer Rebate (SMART PreferRebate) - Routes the order with the bias toward getting a
rebate vs. getting the order filled.
SMART Prefer Fill (SMART PreferFill) - Routes the order with the bias toward getting a fill vs. getting a
rebate.
SMART Maximize Fill (SMART MaxFill) - Routes the order with the sole objective of getting a fill.
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Configure IB Algo Favorites

Configure IB Algo Favorites
Configure IB Algos to be "Favorites" or clear Favorites settings. When an algo is marked as a favorite, it will
become available from the Order Type drop down box from an order, eliminating one full click. When NOT
a favorite, you need to select IBALGO from the Order Type drop down and then pick the algo.
Check to enable, uncheck to disable as a favorite.
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About Order Presets
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About Order Presets
Order presets present a hierarchical layout of order strategies whose characteristics and values are set
ahead of time, and can be set as the default order strategy or can be selected prior to the creation of an
order. The below sections explain the hierarchy of presets and the function of each section on a preset
page based on its position in the hierarchy.
The Hierarchy

Order presets are laid out as shown below, in a three-level hierarchy. Each sub-level inherits the settings
from its parent preset. In the image below, the named preset Scale inherits the default values from its
parent Stocks(2) preset, while the Stocks preset inherits applicable default values from the highest level
Presets(1) preset. This hierarchy is described in more detail below.
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The Hierarchy

The top level preset contains settings that apply to orders of all types on all asset classes. If you create
named presets at the top level, the preset can be applied to orders on all asset types. Settings at the top
level are inherited by and can be changed on the asset-level presets. Use this level to make a change that
you want to affect all presets; for example, you may want to allow all orders to activate outside regular
trading hours. Define this setting at the top level and elect to propagate some or all of the changes to other
applicable presets using the Propagate Settings box shown below:
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The Hierarchy

The Propagate Settings box is displayed any time you make a change in a higher level preset that could
be applied to sub presets.
Asset Level
The second level, or asset-level presets, contain both the top level settings and asset-specific settings. For
example, the Stock preset contains all the fields on the top level preset as well as Algorithm and Display
Settings areas that are valid only for stocks.
Under the asset-level presets, you can create named and ticker-specific presets.
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Create Order Presets

Named presets inherit all settings from the asset-level preset, and also include instrument -specific settings
you can define for your strategy. You can create multiple named presets for an asset type, for example one
that creates a trailing stop order, one for scale orders, one for bracket orders, and select the preset strategy
from the market data line before you create an order.
Ticker presets will be active by default for that ticker. As with all presets you can select a different strategy
on a market data line before you create an order.

Create Order Presets
Presets expand the usefulness of default order settings by allowing you to create multiple sets of order
defaults at the instrument level or ticker level, and apply them from the trading page prior to creating an
order using the drop down selection in the Presets field.
To configure presets
1. Open Global Configuration:
From within Mosaic, use the Edit menu.
From within Classic TWS, use the File menu.
2. Select the instrument for which you want to define a preset.
3. Use the right-click menu and select Preset.
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Create Order Presets

4. Enter a name and click OK.

The settings for the new preset are derived from the default settings defined at the main preset level
identified by the crown. This upper level page includes all possible settings. When you create a subpreset and modify the basic settings, you can elect to view only the differences between the sub and
main presets by depressing the Overridden fields only button.
Note: The asterisk next to a group label indicates that you made changes but haven’t yet
saved your settings.
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Create Order Presets

5. The new strategy is highlighted in the left pane with its associated order defaults page in the right.
Edit the order fields you want to associate with the order strategy and click OK. The numbered
descriptions in the table below correspond to the image above:
1

Strategies defined at the top Preset level, such as Trail-Stop in this example, can be
applied to any instrument type, but cannot be designated as “Active.”

2

The top-level instrument type is the default order preset for all contracts of that type,
until another is made Active. Instrument-level presets appear below the top-level
instrument type and will only be available from the Preset drop-down for tickers of
that instrument type.

3

One preset for each instrument can be active. The Active preset is identified by the
green ball, and becomes the default order strategy for all contracts of that type. In
the above example, all Stock contracts on all pages will use the Stk-Scl-Strat order
defaults when you create an order. Select a different preset for any instrument
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Define Order Preset Values

using the Preset drop-down list on the market data line.

4

Ticker-level presets become the default for that ticker and are not available for any
other tickers even on the same instrument.

5

The Preset icons function as follows:
Strategy - click to create a new preset strategy for the selected level, either top,
instrument-level, or ticker-level.
Ticker - becomes available when you select an instrument type. Click to create a
ticker-level preset.
Make Active - click to make the selected preset active for all symbols of the
instrument type, except those with a ticker-level preset defined.
Copy - copies the strategy settings from the selected preset.
Paste - overwrites the settings from the selected preset with the copied settings.
Delete - removes the selected preset strategy with no confirmation message.
Rename - change the name of the selected preset.

The default values that you can define for each Preset vary slightly based on the instrument/contract you
select. The defaults you can set are defined in the tables in the Define Order Preset Values topics.

Define Order Preset Values
The presets pages are broken into categories, including:
Timing and Size Settings
Primary Order Settings
Scale and Adjusted Stop Fields
Target Order (Profit-taker) Settings
Attached Stop Order Settings
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Primary Order Settings

Miscellaneous Defaults
Define Precautionary Settings
Algorithm Settings
Default Display Settings

Primary Order Settings
The primary order is also called the parent order. Values you set will be used when you select the
associated order type, for example, the Stop Price value will only be used if you select Stop as the order
type. Based on the settings below, the default order type is a LIMIT order.
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Primary Order Settings

Field Name

Description

Notes

Values

Relevant properties will be inverted for sell

NOTE: This feature can

entered are

orders.

only be turned off in the

for buy orders

user-defined named

and will be

presets.

flipped for sell
orders.
Order Type

The default order type that will be used any
time you create an order using this preset.

Limit price

The value used for the default limit price, if

Use the +/- offset field to

your order uses a limit price. Pick from Bid,

enter an offset amount,

Ask, Last or Bid/Ask Midpoint.

percentage or ticks that will
be added to/subtracted
from the price. Note that
you can enter a positive or
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Primary Order Settings

negative value.

Stop Price

The value used for the default stop price. Pick

Use the +/- offset field to

from Bid, Ask, Last or Bid/Ask Midpoint. This

enter an offset amount,

value is used if the default order type is a stop

percentage or ticks that will

order, and also if the default order type is not

be added to/subtracted

a stop order, but in the order line you elect to

from the price. Note that

change the order type to a Stop order.

you can enter a positive or
negative value.

Stop-limit

The value used to determine the limit price in

Use the +/- offset field to

price

a stop limit order. Pick from Bid, Ask, Last or

enter an offset amount,

Bid/Ask Midpoint.

percentage or ticks that will
be added to/subtracted
from the price. Note that
you can enter a positive or
negative value.

Offset Amount

The offset amount used for Relative and RPI
(Retail Price Improvement) orders. This
amount will be added to the best bid (for a
buy order) and subtracted from the best ask
(for a sell order) to create the limit price at
which the order will be submitted.

Relative limit

The value used to calculate the starting price

price

for a Relative order. Choose from Bid, Ask,
Last, Bid/Ask Midpoint or None.
If you choose None, the price defaults to the
Bid price for Sell, and the Ask price for a Buy.
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Scale and Adjusted Stop Fields

Trailing

The trailing value used for a trailing stop

amount

order.

Touched

Value used to calculate the Trigger Price for

trigger

Limit if Touched and Market if Touched
orders. Pick from Bid, Ask, Last or Bid/Ask
Midpoint.

Discretionary

The default value that will be applied

Amt.

when you use the discretionary order
attribute.

Scale and Adjusted Stop Fields
These fields show only for named presets and apply to the primary order.

Field Name
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Scale and Adjusted Stop Fields

Initial

Set a default size for the initial component of a

Component

scale order.

Size
Price

The incremental amount by which the price of

Increment

each successive component will change.

Subsequent

Set the component size for all remaining order

Leave blank to use the

Component

components of the scale order.

Initial Component

Size
Profit-taker

Size for all components.
Define the amount that will be added
to/subtracted from the last filled component
price for the opposite side profit order.

Restore

Check to have the size of the order restored at

size after

a specific price level after the profit order fills.

taking
profit

Field

Description

Notes

Name
Adjusted

When you select an adjusted order type, the stop order you're adjusting will

order

not trigger when the stop price is hit. Instead, it will be changed to this order

type

type, and use the other parameters below.
Select one of the stop order types. When your current stop price is
penetrated, it will change to this order type and use the instructions you set
in the following fields.

Adjusted

When the trigger price is hit, the adjusted stop price is implemented for the

stop

new order.
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Target Order (Profit-taker) Settings

price
Adjusted

Used for Stop Limit and Trailing Stop Limit orders. This value will be the limit

stop

price of the order if it is triggered and submitted.

limit
price
Adjusted

Used for Trailing Stop and Trailing Stop Limit orders. This value will replace

trailing

the original trailing amount if the adjusted order is triggered.

amount

Target Order (Profit-taker) Settings
The target order fields are linked to the parent or Primary order, and will not be available if you elect a scale
primary order with Restore size after taking profit enabled.
Note that you must enter these values as if the parent order were a Buy order. In the case that the parent
order is a sell, the values will automatically be flipped.

Field Name

Description

Notes

Order Type

The order type for the child profit-

If you select None no target

taking order.

order will be created.

The limit price for the profit taker.

Select Parent order to create a

Limit Price

target price equal to the price of
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Attached Stop Order Settings

the parent order +/- a defined
offset amount or percent.

Apply off-

If you elect to apply the offset to

set to par-

the parent order price, check to

ent

have the offset applied to the
actual fill price of the parent order.

Offset

If the Relative or RPI (Retail Price

Amount

Improvement) order type is selected,
defines the offset amount.

Initial

Set a default size for the initial

Component

component of a scale order.

Size
Price

The incremental amount by which the

Increment

price of each successive component
will change.

Subsequent

Set the component size for all

Leave blank to use the Initial

Component

remaining order components of the

Component Size for all

Size

scale order.

components.

Attached Stop Order Settings
The attached stop fields are related to the parent order.
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Field

Attached Stop Order Settings

Description

Notes

Order

The order type for the attached

If you select None no attached order

Type

child order.

will be created.

Stop

The stop trigger price for the

Select Parent order to create a stop

Price

attached stop order.

price equal to the price of the parent

Name

order +/- a defined offset amount or
percent.
Stop-

The limit price at which the

Only used if the order is a stop limit or

limit

attached order will be submitted

trailing stop limit order type.

Price

when triggered.

Trailing

If the order is a trailing order, this

Amount

value represents the amount by

The order trails in only one direction.

which the order will trail the market
price.
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Attached Stop Order
Adjusted Stop Fields
These fields are used if the Attached Stop Order type above is Adjustable Stop.
Field Name

Description

Adjusted

The trigger price that triggers adjustments to the existing

Trigger Price

stop order.

Adjusted Stop

The adjusted stop trigger price for the order.

Notes

Price
Adjusted Stop

The adjusted limit price at which the order will be submitted.

Limit Price
Adjusted

The new trailing amount which defines the amount by which

Trailing

the order will now trail the market price.

Amount

Miscellaneous Defaults for Presets
Define defaults to be used for all sub-presets (i.e. stocks, options, specific symbols etc) that you don't set.
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Field Name

Description

Notes

Trigger

The trigger method is used to trigger Stop, Stop Limit, Trailing

You can

Method

Stop and Trailing Stop Limit orders.

Modify the
Stop
Trigger
Method.

Trigger

Check to keep triggered orders active. If unchecked,

Once

triggered orders are deactivated at the end of the day,
and will only trigger again if defined trigger criteria are
met.

Open/Close
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cleared
customers.
Order Ref.

A user-controlled field to identify orders.

This
setting will
be
overridden
by the
page level
setting.

Clearing

Select the clearing account.

Acct

For noncleared
customers.

Order

Defines the origin of your order in relation to the market.

Origin
ISE Order

The Standard order is completely anonymous. The SOI order

Type

broadcasts the symbol to other ISE MPM members and may
get execution priority.

Post only

If checked, when there is non-displayed liquidity at the same

For smart-

price point, the order price is adjusted low (for a buy) or higher

routed US

(for a sell) by one penny to avoid taking that liquidity. If the

stocks and

order comes in at a price higher (for a buy) or lower (for a sell)

options.

than an order already sitting on the book, it becomes an IOC
(immediate-or-cancel) order at the better price.
Prefer

If checked, TWS will SMART route all orders if Smart-routing is

SMART

available, regardless of the routing selection defined for the
ticker.

No default

If checked, all orders using this preset will be created with a

destination

blank default routing destination.

Consider

If checked, Smart routing will consider the total cost of
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cost when

executing the order, including commissions and other fees,

routed

routing

when deciding where to route the order. If unchecked, only the

European

exchange price is considered.

stocks.

Hidden

Check to hide the entire order quantity from the market.

Auto-can-

For orders with a parent-child pair, check to have the

cel parent

parent order canceled when the child order is canceled.

OCA Group Defaults

Use the One-Cancels-All order attribute to work related orders in conjunction with one another.
If one order in group is partially filled, other orders should be...
a. Reduced in size: Reduces the quantity of other orders in the group by the partially filled
quantity of the order. Please note that using this option without overfill protection may
likely result in multiple orders being routed to an exchange. This may result in an overfill,
or in a rejection in the case of multiple sell orders where one is tagged as "short sale."
b. Reduced in size with Overfill Protection: Designed to reduce quantity of other orders
in the group by the partially-filled quantity of the order, and specifies that only one order
at a time will be submitted to an exchange to avoid multiple orders filling (overfill).
c. Cancelled: All orders in the group will be canceled. When selected, "overfill protection"
is automatically enabled to prevent an overfill.
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Define Precautionary Settings
Precautionary values are used by the system as safety checks. If you submit an order that violates any of
these custom settings, you will have to confirm your intent to transmit the order before TWS submits it.

Field Name

Description

Percentage

This option was created as a safety net to prevent you from

Notes

transmitting a limit order that has a mistyped limit price. If you
attempt to transmit a limit order with a price outside of this calculated
percent off the market price, you will receive a message asking you
to verify that you meant to enter that off-percentage price before it
will transmit the order. The market price used is the price displayed
in either the bid (sell) or ask (buy) field at the time you transmit the
order. This option can be left blank.
Total Value

If you transmit an order with a price that exceeds the total dollar

Limit

amount you specify, you will receive a message informing you that
the Total Value constraint has been violated, and you must confirm
that you want to submit the order regardless.
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Define Precautionary Settings

Limits the value in the Quantity field. If you enter a higher value, you
can override the default size limit by clicking Yes in the warning box.

Number of

Like the Percentage option above, number of ticks is also a safety

Ticks

net to prevent you from transmitting a limit order that has a mistyped
limit price. If you attempt to transmit a limit order with a price outside
of this calculated number of ticks off the market price, you will get a
message asking you to verify that you meant to enter the offpercentage price before it will transmit the order. The market price
used is the price displayed in either the bid (sell) or ask (buy) field at
the time you transmit the order. This option can be left blank.

Algorithm

If you transmit an algo order with a price that exceeds the total dollar

Enter “0”

Total Value

amount you specify, you will receive a message informing you that

to disable

Limit

the Total Value constraint has been violated, and you must confirm

the limit.

that you want to submit the order regardless.

If you do
not enter
a value,
the algo
value
limit
defaults
to the
Total
Value
Limit
(above) x
10.

Algorithm

Limits the value in the Quantity field for algo orders. If you enter a

Enter “0”

Size Limit

higher value, you can override the default size limit by clicking Yes in

to disable

the warning box.

the limit.
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If you do
not enter
a value,
the algo
size limit
defaults
to the
Size Limit
(above)x
10.

Algorithm Settings
Choose an algo destination to use the algo order as the default order type.

Default Display Settings
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Display settings change the way values are displayed on the trading window.
Field Name

Description

Multiplier

Multiplies the price by this value.

Offset

You can use this to offset a displayed price for

Notes

instance for a specific futures contract. Say ES
bid/ask is 1314.75/1315.00. First, select Futures in
the middle pane, then click the Add button at the
bottom of the column and enter ES. Enter an offset
of 1300. To see how this will display, in the Test box
enter 1314.75 and click the Test button. The
example displays as 14.75.
Rounding

Change the default of None to Round, Nearest
Valid Price or Truncate. Use the Test entry field to
enter a value, can click Test to see the result.

Decimals

Overrides the default 2 decimal-place price display.

Show

Displays price data italicized.

using
italics
Show

Re-calculates the quote to 1/quote. This setting

You can apply the

Reciprocal

allows Asian contracts to be viewed in the familiar

reciprocal display to specific

local format.

contracts using the Add
button beneath the leftpane list. Select an
instrument type, click Add,
and enter a symbol.
Highlight that symbol and
click Show Reciprocal.
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Using Presets from the Trading Window

Used to test the display changes you have made.
Enter a hypothetical price value, then click the
Test button. All of the Display Setting changes are
applied and the result shows as the Example.

Using Presets from the Trading Window
To use a Preset order default strategy, simply select it from the Preset field in the ticker line on your trading
window. Note the following:
Presets created at the top Presets level are available on any instrument.
Presets created at the instrument level are available only for that instrument.
Ticker level - only one preset can be created for a specific symbol, and it can only be used for that symbol. A
ticker-level preset is used as the default for the symbol.
Alternatively, you can associate a preset strategy with a Quote Monitor to guarantee that all orders created
on a specific page will use a specified preset.
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To associate a Preset with a Quote Monitor
This procedure assumes that you have already created the preset you want to associate. If you have not,
please Create Order Presets
1. Right-click the title of a page and select Settings.
2. In the Order Presets field, select the name of the preset to associate with the page.
3. Click OK.
To use the Preset field from the Trading Window
1. Right-click the row of field headings and select Customize Layout.
2. From the Order Presets category, select Preset and Add to the Shown Columns list.
3. Click the Preset drop-down from a market data line to see the preset strategies available for the
selected ticker.

Note: Existing customers: Each top level instrument strategy uses the original order defaults you
defined, unless you elect to copy and paste a new set of values.
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The displayed value is the default strategy for that instrument or ticker; select a new strategy from the dropdown list. The list includes all global presets and all instrument-level presets. The Default is the current
active strategy defined in Global Configuration. New orders will use the displayed preset strategy. If you
change the strategy, the change will not apply to existing orders.

If the page does not have the Preset column displayed, a Strategy icon appears next to any tickers that
have a custom strategy applied. If no strategy icon is displayed, the ticker uses the default instrument-type
set of order defaults.

Modify the Stop Trigger Method
You can modify the trigger method for Stop, Stop Limit, Trailing Stop and Trailing Stop Limit orders on a
per-order basis using the Order Ticket. You can also set the default trigger method for a strategy using the
Trigger Method dropdown in the Miscellaneous section of the order Preset.
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To change the default Trigger Method
1. On the Edit menu, select Global Configuration.
2. In the left pane, select Presets.
3. In the Trigger Method dropdown list, select the preferred trigger method that will be used for all
orders affected by the preset.
To modify the stop trigger method for the current order
1. Display the Trigger Method field on the trading window.
2. Highlight a stop, stop-limit, trailing stop or trailing stop limit order and select a method from the Trigger Method field.
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Modify the Stop Trigger Method

Description

Method
Default

Unless the customer modifies any of these features, the default trigger method for all
stocks is the Last method, described below.
For US options, the default trigger method is the double bid/ask method, where two
consecutive ask price (bid price) values must be less than (greater than) or equal to
the trigger price, and the second bid or ask must have greater size if it is at the same
price level as the first bid or ask.
For Forex contracts (for example EUR/USD currency pair), the default trigger method
is bid/ask, where the ask price (bid price) value must be less than (greater than) or
equal to the trigger price.
For all other contracts, the default trigger method is the Last method, described
below.

Last

For a buy (sell) order to be triggered:
One last price value must be greater than (less than) or equal to the trigger price;
and
The exchange or other market center where the order is to be executed must also
publish (and the system must also receive) a bid price and an ask price; and
Last must be within the bid/ask (i.e. >=bid and <= ask) or within leeway percentage outside the bid/ask (i.e. >=bid-0.5% of last and <=ask+0.5% of last). This
0.5% amount of leeway is subject to change at any time without notice.
With the exception of OTCBB- and Pink Sheets-listed stocks, stop and stop-limit
order in US stocks will also only be triggered if the primary exchange on which the
stock trades is open, is holding regular trading hours, and has a valid bid/ask quote
for the stock. Regular trading hours are usually between 9:20 am - 4:00 pm
Eastern Time, Monday through Friday for exchange-listed stocks. NOTE: This limitation does not apply to stop or stop-limit orders in futures contracts).

Double

For a buy (sell) order to be triggered:

Last
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Configure the Account Window

•

Two consecutive last price values must be greater than (less than) or equal to the

trigger price; or
•

The last price value must be greater than (less than) or equal to the trigger price

and the last size must be an increase.
Bid/Ask

For a buy (sell) order to be triggered:
•

A single bid (ask) price must be greater than (less than) or equal to the trigger

price.
Double
Bid/Ask

For a sell order to be triggered:
•

Two consecutive ask prices must be less than or equal to the trigger price; or

•

One ask price value must be less than or equal to the trigger price and the ask size

must be an increase.
For a buy order to be triggered:
•

Two consecutive bid prices must be greater than or equal to the trigger price; or

•

One bid price value must be greater than or equal to the trigger price and the bid

size must be an increase.
Last or
Bid/Ask

For a buy (sell) order to be triggered:
•

A single bid (ask) or a single last price must be greater than (less than) or equal to

the trigger price.
Midpoint

For a buy (sell) order to be triggered:
•

The midpoint of the bid/ask must be greater than (less than) or equal to the trigger

price.

Configure the Account Window
Specify the fields you want to include in the sections of the Account information window.
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Features
Introduction

Open the Feature Selector
Enable Features through Menus

Open the Feature Selector
The Feature Selector groups features in categories and subcategories. To help you find what you're
looking for, use the text Search box at the top of the window. The list is filtered to show only those features
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Open the Feature Selector

which include the text you've entered in their title. To clear the search and display all categories again, click
the Clear icon that appears to the right of the Search box.

To open the Feature Selector
On the Edit menu select Global Configuration and then choose Features in the left pane.
You can disable an entire category of features with a single click, or drill down to a specific feature within a
group using the expand/collapse icon.
To disable/enable a feature using the Feature Selector
1. Click to remove the checkmark next to a feature or a feature group.
2. Click the expand icon to drill down in a group.
You can also enable features from the menus.
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Enable Features through Menus
The Feature Selector, accessible through the Configuration menu or by clicking the Configure icon on
the toolbar, allows you to disable features you don't use. These disabled features are hidden from the
menus and screens. You can now enable these features at any time without having to search for them
within the Feature Selector by expanding the menu to show disabled features.
Enable a feature from its menu
Menus which contain disabled features show a double "expand" arrow following the final menu command.
1. Click the double arrows at the bottom of the selected menu.
2. Disabled features now appear in the menu, highlighted in dark grey. Select the feature you want to
use.
3. Click Yes to the question "Would you like to enable this feature now?"
The feature is enabled, and will become active if appropriate. For example, if you have an underlying
selected and elect to enable Market Depth, the Market Depth window will open for the selected underlying
after you click "Yes." If you don't have an underlying selected, the Market Depth feature will be enabled but
will not open since it has no data to display.
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Workspaces and Panels
Introduction

Managing Workspaces
Quote Panel
Orders Panel
Log Panel
Trades Panel
Portfolio Panel
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Menus
To accommodate multiple views, TWS provides multiple menu structures. The menu structure you see
depends on the tool and view you choose. While the menus are arranged differently, they all provide
access to most of the same tools and features.

Mosaic Menus
File Menu
Mosaic Account Menu
Mosaic Help Menu

Classic TWS Menus
File Menu
Edit Menu
Trade Menu
Account Menu
Trading Tools
Analytical Tools
View Menu
Help Menu
Right-click in a Blank Line
Right-click on a Market Data Line
Right-click on an Order Management Line

Simplified View for Classic TWS Menus
Simplified TWS: File Menu
Simplified TWS: Trade Menu
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Mosaic Menus

Simplified TWS: Account Menu
Simplified TWS: Help Menu

Mosaic Menus
File Menu
Mosaic Account Menu
Mosaic Help Menu
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Mosaic File Menu

Menu Command

Description

Unlock Layout

Unlocks the Mosaic frame to allow you to edit, includ-

(Edit Mode)

ing adding and removing tools and resizing windows.

New Window

Provides access to most TWStools.

New Window

Create a new workspace based on a blank frame,
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Menu Command

Group

Description

the Mosaic, or Classic TWS. Note that only one Classic TWStab is allowed.

Open Classic

Available only when there is no version of Classic

TWS

TWSrunning.

Global Con-

Opens Global Configuration which includes configuration

figuration

pages for all TWS elements. You can also access toolspecific configuration pages from the wrench icon displayed
in the title bar of most windows.

Layout/Settings

Opens the Settings Recovery box, where you can

Recovery

choose to restore your layout from a previous day.

Open Saved

Allows you to select and open a previously saved

Chart

interactive chart.

Save Settings

Locally saves any changes you made to your trading
screen layout, defaults, and menu selections.

Save Settings

Allows you to name your settings file and save it to

As...

any directory.

Lock Applic-

Locks the application and requires a password to

ation

unlock.

Close Window

Shuts down the application and saves settings.

Exit

Shuts down the application and saves settings.

Mosaic Account Menu
Many commands on the Account menu bring you conveniently into Account Management without requiring
further login or security credentials.
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Menu Command

Account Win-

Mosaic Account Menu

Description

Opens the TWS Account Information window.

dow
Account Man-

Logs you directly into your Account Management

agement Home

home page without requiring further credentials.

Close All Pos-

Submits closing orders for all or a specified per-

itions

centage of your open positions using the Close
Position dialog box. Note that selecting OK immediately sends closing orders for the positions.

Option Exercise

Opens the Option Exercise window (for US options
only) to exercise options prior to their expiration
date, or to exercise options on Expiration Friday that
would normally be allowed to lapse.

Activity >
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Menu Command

Description

Statements page in Account Management.
Export Activity - Takes you directly to the Activity Downloads page in Account Management. Export activity to
MS Excel, MS Money, Quicken, CapTools, TradeLog,
or Gainskeeper.
Trade Confirm Report - Takes you directly to the Trade
Confirmations page in Account Management.

Performance >

Takes you directly to the Portfolio Analyst tool in
Account Management.

Risk Reports >

Takes you directly to the risk reports in Account
Management including:
Margin Reports
Value at Risk Report
Stress Test

Tax >

Takes you directly into the Tax section of Account
Management.
Tax Forms
Tax Optimizer

Subscribe to

Takes you directly into the Research Subscription

Market Data/Re-

page in Account Management.

search
Set Trading Per-

Takes you directly to the Trading Permissions page

missions

in Account Management.

Declare Tax

Takes you directly into Account Management.

Basis Method
Create Paper

Takes you into the settings page in Account Man-

Trading

agement to set up a Paper Trading account.

Account
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Menu Command

Description

Change Pass-

Takes you directly into the Change Password page

word

in Account Management.

Transfer Fund-

Takes you directly into the Funding section of Account

s/Positions >

Management where you can:
Begin a Fund Transfer
Begin a Position Transfer
See your Transaction History
Specify the Position Transfer Basis

Mosaic Help Menu

Menu Com-

Description

mand

Guides and Documentation >
• Quick Start

Opens the TWS quickstart

Guide
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Menu Com-

Description

mand

• Online

Opens the complete online help set for TWS.

Users’ Guide
• Tutorials

Opens the suite of tours that focus on specific TWS tools and
features.

• Algo

Displays information on our automated algos including

Documentation

ScaleTrader and Accumulate/Distribute.

Center
• Release

Opens the TWS Release Notes page.

Notes
Show Help

Opens TWS Javahelp.

Customer Service >
• Customer

Displays the Customer Service information web page.

Service Info
• Customer

Connects you to the live chat accessed from within Account

Service Chat

Management.

• Open

Opens the customer service message center within Account

Message

Management.

Center
Features Poll

Use the Features Poll to suggest new features and to vote on
suggestions made by other IB customers.

Traders’ Chat

Brings up the login for Traders’ Chat. To create a chat account,
log into Account Management and select the User
Management menu, then Voting Subscription.

Status Monitors >
Data Con-

Displays the connection status of all Market Data Con-

nections

nections.
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Menu Com-

Description

mand

IB Systems

Opens IB's System Status page with current issues and
availability.

Bulletins

Shows the system bulletin board with recent messages.

Report Prob-

Allows you to send a problem message to our devel-

lem

opment team.

Show Tip of

Hide or show the Tip of the Day. When checked the tip

the Day

will also display at login.

About Trader

Display TWS version and other information.

Workstation

Classic TWS Menus
File Menu
Edit Menu
Trade Menu
Account Menu
Trading Tools
Analytical Tools
View Menu
Help Menu
Right-click in a Blank Line
Right-click on a Market Data Line
Right-click on an Order Management Line
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Classic TWS File Menu
Use commands on the File menu to export reports to your PC, save settings and create a basket file. The
File menu commands are described in the table below.

Menu Com-

Description

mand

Import/Export

Allows you to import or export contracts, or export the contents
of the quote monitor to Excel or to another quote monitor.

New Win-

Create a new workspace based on a blank frame, the

dow Group

Mosaic, or Classic TWS. Note that only one Classic
TWS tab is allowed.

Open Saved

Allows you to select and open a previously saved interactive

Chart

chart.

Save Set-

Locally saves any changes you made to your trading
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Menu Com-

Description

mand

tings

screen layout, defaults, and menu selections.

Save Set-

Allows you to name your settings file and save it to any

tings As...

directory.

Settings

Opens the Settings Recovery box, where you can choose to

Recovery

restore your layout from a previous day.

Print

Prints the active page.

Lock

Locks the application and requires a password to unlock.

Application

Close Win-

Shuts down the application and saves settings.

dow
Exit
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Classic TWS Edit Menu

Menu Com-

Description

mand

Cut

Cuts the selected ticker.

Copy

Copies the selected ticker.

Paste

Pastes the last copied or cut ticker as a new row.

Insert Row

Inserts a blank row above the selected row.

Delete Row

Deletes the row you have selected.

Create Group

Inserts a non-data row into the page. Enter a title or label to use

Header

this row as a separator or label for a group of tickers.

Mutual Fund

Opens the Contract Selection box showing available families of

Selector

no-load mutual funds.
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Menu Com-

Description

mand

Mutual Fund

The Mutual Fund Replicator finds an ETF(s) whose per-

Replicator

formance parallels that of a user-specified mutual fund.

Treasury

Opens the Contract Selection box showing available T-Bonds,

Bond

Bills and Notes.

Selector
Contract

Displays the Ticker Description box which contains information

Description

about the selected underlying.

Detail
Edit Dividend

Opens the Dividend Editor window.

Schedule
Global

Opens the TWS Global Configuration tool which includes the

Configuration

Feature Selector and configuration pages for all TWS
elements.
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Classic TWS Trade Menu

Menu Com-

Description

mand

Buy

Creates a buy order for the selected contract; opens the order
ticket when used from a blank line.

Sell

Creates a sell order for the selected contract; opens the order
ticket when used from a blank line.

Close

Submits a closing order for all selected positions. Choose to

Selected

close:

Positions

• 50% of each selected position
• 100% of each selected position
• A customer percentage of each selected position.
Note that orders are transmitted instantaneously.

Close All
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Menu Com-

Description

mand

Positions

open positions usng the Close Position dialog box. Note that
selecting OK immediately sends closing orders for the
positions.

RFQ

Use to request market data for instruments not showing data,
or to get a size quote.

Check Margin

Shows a preview of the created order and how it would affect

Impact

your margin requirements.

Transmit

Transmit the selected order(s), all of you orders, or all of the
orders on the current page.

Pause

Submits a cancel request on the selected orders, all of your

Execution

orders, or all of the orders on the current page. Leaves the
order line on the page for quick re-transmittal.

Cancel

Submits a cancel request on the selected orders, all of your
orders, or all of the orders on the current page.

Modify

Define parameters to automatically update the order type,

Multiple

time in force, limit price (with or without a limit offset) for one or

Orders

multiple orders. Additionally, specify a validation procedure to
be used when attributes are not applicable to all orders.

Save Orders

Saves the selected group of orders as a basket file that can be

as Basket

accessed via the BasketTrader.

Option

Opens the Option Exercise window where you can exercise

Exercise

an option prior to expiration.
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Classic TWS Account Menu

Menu Com-

Description

mand

Account

Displays your balances, margin, P&L, equity, market value

Window

and more.

Portfolio

Creates a Portfolio trading page that includes all current

Window

positions.

Trade Log

Displays trade reports and a trade summary of up to seven
days’ activity.

Statement

Displays your account activity statement within Account

Viewer

Management.

Audit Trail

View a log of your daily trade activity for the current week in
HTML. Choose from condensed or expanded version. Each
week’s audit trail overwrites those from the previous week.

Completed
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Menu Com-

Description

mand

Orders
Account

Puts you directly into Account Management.

Management
Home

Stock Yield

Opens the page to join the Stock Yield program, which

Enhancement

automatically lends out stock that you own to borrowers who want to short the stock.

Market Data

Puts you into the Market Data Subscription section of Account

Subscription

Management.

Manager
Mistrade

Enter a Trade Cancellation Request from the Customer

Request Form

Service tools section of Account Management.

Clearing

Add or modify settlement instructions from within Account

Instruction

Management.

Modification
Form

Tax Optimizer

Puts you into the "Launch" page for the Tax Optimizer
in Account Management.
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Classic TWS Trading Tools Menu

Menu Command

Quote Monitor

Description

A trading page that holds market data lines for all products,
and algo provides complete order management.

Watchlist

Opens a new floating watchlist window that allows you to view
multiple tickers in a single, small window.

Market Depth

Shows Level II quotes with no trading capabilities.

(Level II)
Market Depth

Displays aggregated Level II market data. The Market Depth

Trader (Level II)

Trader also displays shows the Quote Panel and allows for
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Menu Com-

Description

mand

complete order management.

BookTrader

Create, modify and transmit orders for a single contract from
within the book price ladder.

Integrated Stock

A dynamic, customizable tool that includes all of the data and

Window

order management tools to analyze the current market, track
activity, make trading decisions and place orders for a
selected security.

Merger

Use the Merger Arb window to take advantage of arbitrage

Arbitrage

opportunities associated with takeovers or mergers.

ScaleTrader

An automated trading algorithm designed to help you
effectively buy into a declining market at ever-lower prices,
scale into a toppy market, or scale out of a long position.

Accumulate/

An automated trading algorithm that helps you effectively

Distribute

trade large blocks of stock without being detected in the
market.

Option Chain

Displays the Option Chain section of the OptionTrader,
with data only (no order management).

Strategy

Strategy Builder allows you to quickly and easily build

Builder

option combination strategies directly from the Option
Chains.

Option

Option Strategy Lab helps you to create and submit

Strategy Lab

both simple and complex multi-leg option orders,
based on your own price and volatility forecasts.

Probability
Lab

SM

Volatility Lab

TWS Guide

The Probability Lab offers a practical way to think
about options without the complicated mathematics.
Volatility Lab comprises a comprehensive toolkit of

1487

Chapter 1

Classic TWS Trading Tools Menu

Menu Com-

Description
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volatility tools designed to help you uncover superior
trading opportunities.
OptionTrader

An integrated suite of options tools that allows provides
market data and statistics, lets you create and manage options
orders, view available option chains and easily create
combination strategies, all in a single screen.

Write Options

Opens the Write Options tool.

Rollover

Opens the Rollover Options tool.

Options
Option Portfolio

An automated trading algorithm that helps you adjust the risk
profile of your portfolio by any of the Greek risk dimensions.

Volatility Trader

Creates a trading page that lets you trade in terms of volatility
rather than price.

FXTrader

Custom-designed trading tool with optimized display for FX
traders that emphasizes the key price component.

FX Matrix

Light version of the FXTrader that shows FX pairs
quotes with no trading capabilities.

BasketTrader

Designed to trade previously-created basket files or baskets
based on a selected index.

Portfolio Builder

Create investment strategies based on fundamentals data
and top-tier research, back-test and adjust as needed and
then invest in the strategy and tracks its performance within
your existing portfolio.

Rebalance

Simplifies periodic portfolio balancing.

Portfolio
SpreadTrader

Create futures spreads, EFPs and option combos.

Stock

Creates a Stock Borrow/Loan page that provides access to

Borrow/Loan

the borrow/loan marketplace.
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Classic TWS Analytical Tools Menu

Menu Command

Information

Description

Opens the Mosaic tab workspace tab.

System

TWS Guide

1489

Chapter 1

Classic TWS Analytical Tools Menu

Menu Command

Chart

Description

Opens the new chart window with the Contract Description
populated based on the contract you selected in the trading
window.

Option Analysis

Displays a list of analytical option tools:
Probability Lab
Option Strategy Lab
Multi Expiry or Time Lapse Volatility Skews
Implied and Historical Volatility
Option Volume and Open Interest Activity
Interactive Analytics including Option Analytics window,
the Greeks and Put & Call P&L
The Strategy Performance Graph

Quote Details

Opens a floating window that shows quote, high/low and
volume data for a single underlying.

Mosaic Market

Scan the markets for the top-performing products

Scanner

based on user-selected criteria.

Advanced

Scan the markets for the top-performing products based on

Market Scanner

user-selected criteria.

Complex

Returns all complex strategies on a specific under-

Orders and

lying that has a native bid/ask quote or that has

Trades Scan-

traded today. To find the strategy that has traded the

ner

most today, sort the results by Volume (click on the
Volume column to sort).

Mutual Fund

The Mutual Fund Replicator finds an ETF(s) whose

Replicator

performance parallels that of a user-specified mutual
fund.

Bond Search

TWS Guide

Opens the Bond Search query in a browser window.
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Menu Command

Description

Time & Sales

Displays Time & Sales for the selected instrument .

Price History

Shows history for the Open, High, Low, Close and
Volume history on the selected underlying.

Alerts

Set time, price or margin-based alerts.

SLB Rates

Shows current Borrow/Loan Fee and Rebate rates
and historical rates on the selected underlying.

Set Alarm

Define an alarm for the selected underlying.

Model Navigator

Edit pricing assumptions to calculate model prices.

Arbitrage Meter

The Arbitrage Meter illustrates the extent of the premium (or
discount) of the lead month futures price above (or below) its
fair future value with respect to the index price.

Toolbox

Opens the Toolbox window which allows one-click
access to useful analytical tools including : Market
Depth, Time & Sales, Price History, SLB Rates,
Option Chain, Fundamentals, Alerts, News, Charts
and Analyst Research.

Analyst

Subscription-based research including: Briefing.com,

Research

Zacks, Morningstar and Waverly Advisors.

WSH Cor-

Available to subscribers to Wall Street Horizon. View

porate Event

events for the selected instrument .

Calendar
Daily Lineup

Designed to be viewed first thing in the morning, the
Daily Lineup provides a birds-eye view of upcoming
market events.

Economic

Lists major economic events for specific date/region.

Event Cal-

Requires research subscription to Thomson-Reuters.
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Menu Command

Description

endar
Corporate

Shows corporate earnings data and upcoming events

Earnings Cal-

for contracts in your portfolio, your Watchlists and/or

endar

your Quote Monitors. Requires research subscription
to Thomson-Reuters.

Company

Displays business and financial summary data, charts,

Fundamentals

scanners and more for the selected instrument .

Company

Displays industry-related news and commentary for the

Specific News

selected underlying.

Filtered News

Filter news by subject or newsfeed.

Market Signals

Our data servers continuously scan the markets for irregular
price and volume actions and transmit these notifications
directly to your trading interface in the form of Market Signal
alerts. Available market signals include price spikes,
irregular volume spikes, new 52 week highs/lows, put/call
ratio spikes, trading halts and more.

Social Sen-

Subscription-based news.

timent
Portfolio or

Show news for all companies in your portfolio and/or

Watchlist

all tickers in your Quote Monitors and Watchlists

News

and/or a custom list of tickers with news on competitors of custom tickers.

Broad Tape

Shows all subscribed news.

Today's Top

Tops news headlines by StreetInsider, or Dow Jones

Ten

(based on subscription).

News Topics

Opens the New Topic Chooser that allows you to include
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Menu Command

Description

industry-specific news in the ticker lines.
Risk Navigator

Opens the Risk Navigator real-time risk management tool.

Portfolio

Opens the Portfolio Analyst reporting tool in Account

Analyst

Management.

Classic TWS View Menu

Menu Com-

Description

mand

Trader

Monitor key data from your Account window and view current

Dashboard

real-time news headlines.

Rapid Order

Allows for quick entry of stocks, options futures and combos.

Entry
Order

Provides assistance in modifying order parameters.

Wizard
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Button

Provides access to quick-click trade buttons. Activate buttons for

Panel

instantaneous transmit.

Data

Shows the status and purpose of your market data connections.

Connections
IB Systems

Shows the current system status.

Bulletins

Shows the current customer bulletins.

OS Window

Inserts the title bar back on the top of the TWS windows.

Bar

Large

When checked, increases the font size of the menu titles.

Menu Text

Classic TWS Help Menu

TWS Guide

1494

Chapter 1

Classic TWS Help Menu

Menu Com-

Description

mand

Guides and Documentation >
• Quick Start

Opens the TWS quickstart

Guide
• Online

Opens the complete online help set for TWS.

Users’ Guide
• Tutorials

Opens the suite of tours that focus on specific TWS tools and
features.

• Algo

Displays information on our automated algos including

Documentation

ScaleTrader and Accumulate/Distribute.

Center
• Release

Opens the TWS Release Notes page.

Notes
Show Help

Opens TWS Javahelp.

Customer Service >
• Customer

Displays the Customer Service information web page.

Service Info
• Customer

Connects you to the live chat accessed from within Account

Service Chat

Management.

• Open

Opens the customer service message center within Account

Message

Management.

Center
Features Poll

Use the Features Poll to suggest new features and to vote on
suggestions made by other IB customers.

Traders’ Chat

Brings up the login for Traders’ Chat. To create a chat account,
log into Account Management and select the User
Management menu, then Voting Subscription.
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Menu Com-

Description

mand

Show Hotkey

Displays a key to the current hotkeys set up in TWS.

Popup

Report Prob-

Allows you to send a problem message to our devel-

lem

opment team.

Show Tip of

Hide or show the Tip of the Day. When checked the tip

the Day

will also display at login.

About Trader

Display TWS version and other information.

Workstation

Classic TWS Right-Click Menu from a Blank Line
To see a right-click menu, select a line and then click the right mouse button. Select an item from a rightclick menu using your mouse. The Right-click menu on in a blank line contains the following menu
commands.
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Menu Com-

Description

mand

Order

Opens the Order Ticket window which you use to create and
transmit orders.

Ticker

Opens the Request Ticker box where you enter instrument
information. This creates a new market data line.

Generic

Opens the Combo Composition box to the Underlying field.

Combo

Begin defining legs for a spread order.

Virtual Secur-

Opens the equation builder to create a Virtual Security.

ity
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Merger

Create a combination order for an anticipated merger.

Arbitrage
RFQ

Enter contract information to request a quote.

Treasury Bond

Opens the Contract Selections box, showing available T-

Selector

Bonds, Bills and Notes.

Filtered News

Opens the News Topic Chooser, which lets you filter news by
source, type and category.

Portfolio or

Show news for all companies in your portfolio and/or

Watchlist

all tickers in your Quote Monitors and Watchlists and/or

News

a custom list of tickers with news on competitors of custom tickers.

Broad Tape

Shows all subscribed news.

Market Sig-

Our data servers continuously scan the markets for irregular

nals

price and volume actions and transmit these notifications
directly to your trading interface in the form of Market Signal
alerts. Available market signals include price spikes, irregular
volume spikes, new 52 week highs/lows, put/call ratio spikes,
trading halts and more.

Social Sen-

Subscription-based news.

timent
News Topics

Opens the News Topics chooser.

Mutual Fund

Opens the Contract Selections box, showing available fund

Selector

families.

Mutual Fund

The Mutual Fund Replicator finds an ETF(s) whose

Replicator

performance parallels that of a user-specified mutual
fund.
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Description
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Insert Row

Inserts a blank line above the selected line.

Delete Row

Deletes the selected row or rows. This command deletes both
blank lines and market data lines without a warning.

Create Group

Insert a row with a label that can be used to help organize

Header

tickers within a page.

Create Cash

Select a currency to create a row that shows the total cash

Balance Row

balance for that currency.

Contract

Choose from the default “Underlying” mode and Symbol

Display Mode

mode, which shows the exchange symbol.

Import/Export

Allows you to import or export contracts, or export the
contents of the quote monitor to Excel or to another
quote monitor.

Classic TWS Right-Click Menu from a Market Data Line
To see a right-click menu, select a market data line and then click the right mouse button. The Quick menu
displays limited selections and adds commands that you use. Click the Expand arrow at the bottom of the
Quick list to see all commands.
The right-click menu on a Market Data line contains the following menu commands. Please note that the
menu is context sensitive and may not show all of the items in the list below for a selected data line.
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Description
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BUY

Creates a buy order for the selected instrument . Requires

hotbutton

that you manually transmit the order.

SELL

Creates a sell order for the selected instrument . Requires that

hotbutton

you manually transmit the order.

CLOSE hot-

Creates an order to close out the position in the selec-

button

ted instrument . Requires that you manually transmit
the order.
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Menu Com-

Description
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Action Toolbar

Quickly open the Quote Details, Chart, News, Company
Fundamentals, Time & Sales, OptionTrader or Alert window
for the selected ticker.

Trading Tools

Access available order entry tools. List of tools varies based
on the asset type selected.

Analytical

Access available analytical tools. List of tools varies based on

Tools

the asset type selected.

Trade

Close Position - creates a closing order on the instrument for
all or a portion of the position. Only available if you currently
hold a position in the selected instrument .
Pre-borrow Shares for Shorting - opens the Stock
Borrow/Loan window. where you can check borrow rates on
different stocks.
Order Ticket - opens the Order Ticket from which you define
order parameters.
Order Entry - Opens the Order Entry panel.

Show

Available on options lines. Displays the underlying asset in a

Underlying

data line above the selected option, and disappears when you
move your mouse off the option line. To keep, right-click the
underlying row and select Make Permanent.

Show Legs

(Option combos) Displays each separate leg of a combination
order, with market data.

Adjust Combo

(Option combos) Allows you to modify the ratio of legs in a

Ratio

combination ticker.

Next Expiry

Options and Futures: Adds a new line below the selected
contract for the next expiry.
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Previous

Options and Futures: Adds a new line below the selected

Expiry

contract for the previous expiry.

Next Strike

Options: Adds a new line below the selected contract for the
next strike.

Previous

Options: Adds a new line below the selected contract for the

Strike

previous strike.

Charts

Create a chart for the selected instrument .

What-If

Opens a what-if scenario in Risk Navigator.

Contract Info

Shows the contract description, details and the margin
requirements for contracts in which you currently hold a
position.

Dividend

Opens the Dividend Editor window.

Schedule
Configure

Opens the order preset configuration page for selected

Order Presets

product type.

Trade Log

Opens the Trades window which displays execution reports
for up to seven days.

Insert Row

Inserts blank row above the selected row.

Delete Row

Deletes the selected row and its data.

Clear Row

Deletes data from row and leaves a blank row.

Cut

Cut the selected market data line.

Copy

Copy the selected market data line.

Import/Export

Allows you to import or export contracts, or export the
contents of the quote monitor to Excel or to another
quote monitor.
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Classic TWS: Right-click on an Order Management Line
To see a right-click menu, select an order management line and then click the right mouse button. Select
an item from a right-click menu using your mouse. The right-click menu on an Order Management line
contains the following menu commands:

Menu
Command

Description

Transmit

Transmits the selected order.

Discard

Removes the order from the page.
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Classic TWS: Right-click on an Order Management
Line

Menu

Description

Command

Transmit

Transmits all orders on the current Quote Monitor page.

All
Check

Opens the Preview Order box which shows the order parameters,

Margin

commissions and margin impact of the order before you transmit.

Impact
Attach

• Bracket Orders - Attach a set of opposite-side orders that
"bracket" the current order in an attempt to limit loss.
• Target Limit - Attach an opposite side limit order.
• Target Relative/Pegged - Attach an opposite side relative
order.
• Stop - Attach a Stop order to the selected order.
• Stop Limit - Attach a Stop Limit order to the selected order.
• Trailing Stop - Attach a Trailing Stop order to the selected
order.
• Trailing Stop Limit - Attach a Trailing Stop Limit order to the
selected order.
• Adjustable Stop - Attach an adjustable stop order, which will be
modified to the adjusted order type when the stop trigger is hit.
• Auto Combo Limit - Flips the parent combination order and
submits an opposite side limit order. You must enter a limit price.
For example, if you have a BUY calendar spread, the parent order
looks like this:
Buy 1 XYZ OPT NOV06 80.0 CALL
Sell 1 XYZ OPT OCT06 80.0 CALL
When you attach an auto combo limit, TWS flips the combo and
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Menu

Description

Command

create a SELL calendar spread order like this:
Sell 1 XYZ OPT NOV06 80.0 CALL
Buy 1 XYZ OPT OCT06 80.0 CALL
You must enter a limit price. Since the attached order is dependent
on the parent order, it will not be transmitted until the parent order
executes.
• Auto Combo Market - Flips the parent combination order and
submits an opposite side market order. See above.
• Beta Hedge - Attach a Beta Hedge Order to the selected order.
• FX Order - Attach an FX Order to the selected order.
• Pair Trade - Attach a Pair Trade to the selected order.

Create

• Duplicate - Creates another order management line with the
same order parameters directly below the selected line.
• Scale Orders - Creates a series of orders at incrementally
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Menu

Description

Command

decreasing/increasing price intervals.

Modify

• Order Ticket - Opens the Order Ticket window where you can
modify parameters before you transmit the order.
• Condition - Opens the Conditional tab on the Order Ticket
where you can create or modify a conditional order, which is an
order that will automatically be submitted or cancelled ONLY IF
specified criteria for one or more defined contracts are met.

What if

Creates a new what-if scenario in Risk Navigator that includes the
proposed order(s).

Configure

Opens the Presets configuration page for the selected

Order

ticker/instrument type. Note that any changes you make to the

Presets

order presets do not apply to the current existing order.

Integrated

Opens the ISW.

Stock
Window
Remove

Removes filled orders from the page.

All Filled
Orders
Save

Saves the order.

Simplified View TWS Menus
Simplified TWS: File Menu
Simplified TWS: Trade Menu
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Simplified TWS: File Menu

Simplified TWS: Account Menu
Simplified TWS: Help Menu

Simplified TWS: File Menu

Menu Command

Description

Layout >
Unlock Layout

Unlocks the Mosaic frame to allow you to edit, includ-

(Edit Mode)

ing adding and removing tools and resizing windows.

New Window

Provides access to most TWStools.

New Window

Create a new workspace based on a blank frame,

Group

the Mosaic, or Classic TWS. Note that only one Classic TWStab is allowed.

Open Classic

Available only when there is no version of Classic

TWS

TWSrunning.
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Menu Command

Description

Application Settings >
Global Con-

Opens Global Configuration which includes configuration

figuration

pages for all TWS elements. You can also access toolspecific configuration pages from the wrench icon displayed
in the title bar of most windows.

Layout/Settings

Opens the Settings Recovery box, where you can

Recovery

choose to restore your layout from a previous day.

Open Saved

Allows you to select and open a previously saved

Chart

interactive chart.

Save Settings

Locally saves any changes you made to your trading
screen layout, defaults, and menu selections.

Save Settings

Allows you to name your settings file and save it to

As...

any directory.

Lock & Exit >
Lock Applic-

Locks the application and requires a password to

ation

unlock.

Close Window

Shuts down the application and saves settings.

Exit

Shuts down the application and saves settings.
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Simplified TWS: Trade Menu

Menu Com-

Description

mand

Buy

Creates a buy order for the selected contract; opens the order
ticket when used from a blank line.

Sell

Creates a sell order for the selected contract; opens the order
ticket when used from a blank line.

Close

Submits a closing order for all selected positions. Choose to

Selected

close:

Positions

• 50% of each selected position
• 100% of each selected position
• A customer percentage of each selected position.
Note that orders are transmitted instantaneously.
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Description

mand

Close All

Submits closing orders for all or a specified percentage of your

Positions

open positions usng the Close Position dialog box. Note that
selecting OK immediately sends closing orders for the
positions.

RFQ

Use to request market data for instruments not showing data,
or to get a size quote.

Check Margin

Shows a preview of the created order and how it would affect

Impact

your margin requirements.

Transmit

Transmit the selected order(s), all of you orders, or all of the
orders on the current page.

Pause

Submits a cancel request on the selected orders, all of your

Execution

orders, or all of the orders on the current page. Leaves the
order line on the page for quick re-transmittal.

Cancel

Submits a cancel request on the selected orders, all of your
orders, or all of the orders on the current page.

Modify

Define parameters to automatically update the order type,

Multiple

time in force, limit price (with or without a limit offset) for one or

Orders

multiple orders. Additionally, specify a validation procedure to
be used when attributes are not applicable to all orders.

Save Orders

Saves the selected group of orders as a basket file that can be

as Basket

accessed via the BasketTrader.

Option

Opens the Option Exercise window where you can exercise

Exercise

an option prior to expiration.
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Simplified TWS: Account Menu

Menu Command

Account Win-

Description

Opens the TWS Account Information window.

dow
Account Man-

Logs you directly into your Account Management

agement Home

home page without requiring further credentials.

Close All Pos-

Submits closing orders for all or a specified per-

itions

centage of your open positions using the Close
Position dialog box. Note that selecting OK immediately sends closing orders for the positions.

Option Exercise

Opens the Option Exercise window (for US options
only) to exercise options prior to their expiration
date, or to exercise options on Expiration Friday that
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Menu Command

Description

would normally be allowed to lapse.
Activity >

Activity Statement - Takes you directly to the Activity
Statements page in Account Management.
Export Activity - Takes you directly to the Activity Downloads page in Account Management. Export activity to
MS Excel, MS Money, Quicken, CapTools, TradeLog,
or Gainskeeper.
Trade Confirm Report - Takes you directly to the Trade
Confirmations page in Account Management.

Performance >

Takes you directly to the Portfolio Analyst tool in
Account Management.

Risk Reports >

Takes you directly to the risk reports in Account
Management including:
Margin Reports
Value at Risk Report
Stress Test

Tax >

Takes you directly into the Tax section of Account
Management.
Tax Forms
Tax Optimizer

Subscribe to

Takes you directly into the Research Subscription

Market Data/Re-

page in Account Management.

search
Set Trading Per-

Takes you directly to the Trading Permissions page

missions

in Account Management.

Declare Tax

Takes you directly into Account Management.

Basis Method
Create Paper

TWS Guide
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Menu Command

Trading

Description

agement to set up a Paper Trading account.

Account
Change Pass-

Takes you directly into the Change Password page

word

in Account Management.

Transfer Fund-

Takes you directly into the Funding section of Account

s/Positions >

Management where you can:
Begin a Fund Transfer
Begin a Position Transfer
See your Transaction History
Specify the Position Transfer Basis

Simplified TWS: Help Menu
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Menu Com-

Description

mand

Guides and Documentation >
• Quick Start

Opens the TWS quickstart

Guide
• Online

Opens the complete online help set for TWS.

Users’ Guide
• Tutorials

Opens the suite of tours that focus on specific TWS tools and
features.

• Algo

Displays information on our automated algos including

Documentation

ScaleTrader and Accumulate/Distribute.

Center
• Release

Opens the TWS Release Notes page.

Notes
Show Help

Opens TWS Javahelp.

Customer Service >
• Customer

Displays the Customer Service information web page.

Service Info
• Customer

Connects you to the live chat accessed from within Account

Service Chat

Management.

• Open

Opens the customer service message center within Account

Message

Management.

Center
Features Poll

Use the Features Poll to suggest new features and to vote on
suggestions made by other IB customers.

Traders’ Chat

Brings up the login for Traders’ Chat. To create a chat account,
log into Account Management and select the User
Management menu, then Voting Subscription.
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Menu Com-

Description

mand

Status Monitors >
Data Con-

Displays the connection status of all Market Data Con-

nections

nections.

IB Systems

Opens IB's System Status page with current issues and
availability.

Bulletins

Shows the system bulletin board with recent messages.

Show Hotkey

Displays a key to the current hotkeys set up in TWS.

Popup

Report Prob-

Allows you to send a problem message to our devel-

lem

opment team.

Show Tip of

Hide or show the Tip of the Day. When checked the tip

the Day

will also display at login.

About Trader

Display TWS version and other information.

Workstation
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Exercise and Rollover
Automatic Rollover of Expiring Futures Contracts

1516

Option Exercise with Notifications

1517

Exercise Options - Manual File

1520

Automatic Rollover of Expiring Futures Contracts
When specified in Global Configuration, the system automatically rolls soon-to-expire futures data lines to
the next lead month. Approximately three days prior to expiration, the new lead month contract will be
added to quote monitor. Approximately one day after the contract expires it will automatically be removed
from the display.
Additionally, you can instruct TWS to cancel open orders on expiring contracts. If you have the auto-roll
option selected, anytime there are open orders on expiring futures contracts you will receive a pop-up
message asking if you want TWSto cancel the listed open orders in anticipation of expiration. Once the
contracts expire the orders will be canceled automatically.
To activate auto expiring futures rollover
1. Click the Configure wrench icon on the trading window.
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2. In the left pane of Global Configuration, select General.
3. In the right pane, confirm that Auto Roll Data for Expiring Futures Contracts is checked.

Option Exercise with Notifications
Use the Option Exercise window (for US options only) to exercise options prior to their expiration date, or
to exercise options on Expiration Friday that would normally be allowed to lapse according to clearing
house rules. You can also import a file with instructions, using the Load From File command on the File
menu.
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To exercise an option
Open the Option Exercise window.
In Mosaic: From the Account menu select Option Exercise.
From Classic: From the Trade menu in select Option Exercise.
Select an option to see details, including your current position in the underlying, the current underlying
NBBO, and the deadline to submit the exercise instruction.
Select the option(s) you want to exercise or lapse, and use the Scheduled Action field to set up the exercise
instruction.
Choose Exercise to exercise the entire position.
Choose Partial (when applicable) to exercise or lapse a portion of the position.
Choose Lapse (only available on the last trade date).
The instruction is displayed like an order row. Click “T” to transmit the instruction. To discard without
submitting, use the right-click menu and select Discard Modifications.
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The Details window displays when you select a contract, and shows a deadline for submitting the
instruction today along with all options positions in the underlying and the accompanying market data.
Configure Final Option Exercise Requests

The Orders page of Global Configuration provides a selection box where you can specify that an option
exercise request be final, and therefore cannot be canceled, or editable until the cutoff time (default), which
varies by clearing house. Electing "final and cannot be canceled" allows for immediate delivery of the stock
in the account. Note that some contracts will not follow this rule and will remain revocable up until the
clearing house deadline.

To specify this parameter, from the Mosaic File menu or Classic Edit menu, select Global Configuration
and then Settings from the configuration tree on the left side

TWS Guide

1519

Chapter 1

Notification of Dividend-Related Early Exercise

Notification of Dividend-Related Early Exercise

Accounts that hold dividend-paying positions that may be affected by early exercise will receive notification
via email and in the Option Exercise window in the Optimal Action field approximately two days before the
underlying goes ex-dividend, and options in the Watchlist and in your portfolio will show a yellow lightening
icon next to them.
This information is generated via the IB FYI which cannot be disabled.
Only one notification is sent, but recommendations, if updated, are displayed in the Optimal Action
field, and potential benefits (in terms of value saved by closing the position versus value lost by holding
the position) are shown in the Total Benefits field. For example, if the recommendation changes or a
new position is established after the deadline on (exDiv – 2), no new emails will be sent but the user will
see the latest recommendation in the Optimal Action field and potential benefit in the Total Benefits
field.
The system does not make early exercise recommendations when the dividend amount is uncertain,
e.g. for ETFs, halted stocks and stocks with other uncertainties.
To better understand the mechanics of dividend-related early exercise, see the IB Knowledge Base article
Considerations for Exercising Call Options Prior to Expiration.
Display of Short Positions

The Option Exercise window displays actionable Long positions in the top half of the page, and nonactionable Short positions in the bottom half of the window. On ex-div – 1, for all short positions in OCC
stocks with dividends, we will project whether the option will be assigned or not.
Note that the system does not make these projections when the dividend amount is uncertain, e.g. for
ETFs, halted stocks and stocks with other uncertainties.

Exercise Options - Manual File
The Option Exercise window includes a Load from File button that lets you import a file with instructions
to exercise or lapse specific options. You can create the file using any word processing program, and the
file must include a comma-delimited list of values, one line for each option. You can use one of two different
formats. Table 1 illustrates using the underlying, Table 2 shows fields for symbol mode.
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For each option you want to include in the file, create one line of text and observe the following rules:
Include one value for each field described in the table(s) below.
Separate field values by commas.
List field values in the order in which they appear in the table(s) below.
Field Name

Possible

Field Name

Values

Possible
Values

Table 1 - Underlying Mode

Table 2- Symbol Mode

action

action

exercise,
lapse

account #

underlying

IB acct

exercise,
lapse

account #

IBacct

number, i.e.

number, i.e.

U44982

U44982

underlying

local symbol

IBMSE

exchange

i.e. AMEX

symbol, i.e.
IBM
strike

i.e. 50

(smart is not
accepted)
right

p, c

quantity

i.e. 3

LastTrading

i.e. 20150930

override*

yes, no

DayorContractMonth

or 201509

(yyyymmdd) or
(YYYYMM)**
multiplier

i.e. 100

exchange

i.e. AMEX
(smart is not
accepted)

TWS Guide

1521

Chapter 1

Exercise Options - Manual File

quantity

i.e. 3

override*

yes, no

* Specifies whether your settings will override the system's natural action. For example, if
you have the action set to exercise an option and that contract is not in-the-money, you
would receive a message saying that the contract was not in-the-money and would not
exercise option. However, if you have the override set to "yes," this instruction will
override the system and the option will exercise.
**If you use the format YYYYMMDD we understand that you are using the last trading
day. If you use the format YYYYMM we understand that you are identifying the contract
month.
Your lines in the file based on the examples in the tables above would look like this:
exercise, U44982, IBM, 50, C, 2001509, 100, AMEX, 3, no
exercise, U44982, IBMSE, AMEX, 3, no
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Multi-Client Accounts
Allocation Order Tool

1524

Soft Dollar Commission Tiers

1529

FTP File Instructions

1531

OATs Order Time Reporting for Manual Orders

1538

Give-up

1539

IBExecution Services

1540

IBExecution Services from an Order Line

1541

Configure a Default Give-Up

1542

Short Sale Confirmation

1544

Pre-Trade Allocations

1545

Create an Order with Share Allocations

1546

Allocation Order Tool

1547

Allocating Shares

1551

Rebalance for Advisors

1552

Edit Inline Profile on Rebalance

1554

Create an Account Group for Share Allocation

1555

Create a Share Allocation Profile

1558

Import and Export Groups and Profiles

1560

Edit a Share Allocation Profile

1564

Use Presets for Default Allocations

1566
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Default Clearing for Allocation Profiles

1569

Advisor Model Marketplace

1574

Model Portfolios

1580

Set up a Model Structure

1581

Initial Funding and Populating

1583

Establish Target Percent Allocations

1583

Fund a Model

1584

Purchase Model Investments

1587

Models and Positions

1589

Invest in a Model

1591

Invest in Multiple Models

1591

Divest Funds from a Model

1594

Withdraw Cash from a Model

1596

Rebalance a Model

1597

Reallocate Client Funds Among Models

1599

Monitor Model Activity

1601

Delete a Model

1602

Allocation Order Tool
Manage Allocations Profiles more efficiently with our one-stop Allocation Order Tool. This interface
combines TWS allocation elements into a single, efficient tool that makes it easy to create order allocations
to:
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Reduce or exit an existing position
Increase or open a new position
Rotate positions (close some and open others almost simultaneously)

Currently available for Advisors, Money Managers, Allocating IBrokers

To open the Allocation Order Tool
From a market data line or order line (for an un-transmitted order), use the right-click menu to select
Allocation Order Tool.
From any order tool: From the Allocation drop-down field in any tool, select Allocation Order Tool.
Other ways to access the tool:
Classic: Using the Allocation toolbar button from a selected market data or order row.
From the Activity panel, trade log or the Pending Orders quote monitor, select a trade or partially filled
order and use the right-click menu to select Create allocation profile from trade…
To use the Allocation Order Tool
In the Classic view, select an asset, for example AAPL stock, and use the right-click menu to select
Allocation Order Tool.
Select or change the order side (Buy/Sell) as needed.

Note: Neither Symbol nor Quantity values are editable in this area. The Quantity updates automatically
from allocation values in the Accounts table below.
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From the Allocation drop down list, select a group or profile to use a pre-defined sub-set of accounts.
Otherwise, leave All.
NOTE: Account Groups and Allocation Profiles will not apply the associated allocation method to the
group. It only uses the group to populate the Accounts table with the specific sub-set of accounts.

Filter Allocation Accounts
In the Filter section, use criteria to filter out the accounts displayed in the Accounts table, and that will be
available to select for order allocation:

a. Check “Only include accounts with XXX” to filter out accounts that don’t have a position
in the selected underlying.
b. Using greater than, less than and in the range of qualifiers, filter out accounts based on:
• Position size
• Market value
• % of NLV
• Unrealized P&L
• Cash Balance and
• Buying Power
When filters are complete, click Apply to filter the Accounts table. To clear all filters and start again, click
Reset
Define and Apply an Allocation Method
Use Allocation criteria to define how to populate the Allocation values Quantity and Cash Quantity in the
Accounts table. You can only set one of these Allocation methods.
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Increase (decrease) position by: Specify a percentage by which you want to increase (for a buy order)
or decrease (for a sell order) positions for the selected accounts.
Set allocation based on: Calculate per-account allocations based on the Cash Balance or Buying Power
multiplied by a user-specified number (between 0 and 100). The system calculates ratios for all selected
accounts based on the specified value and allocates based on these ratios.
Allocate total: Use this option to allocate the total Quantity or Cash Quantity of a user-specified value,
either:
Proportionally, based on position, cash balance or buying power, or
Equally
Allocate: Enter a percentage of recent trades (over the past seven days) that will be used to determine
allocation values, based on the absolute value of the cash value allocated to each account. Click Select to
open the Trades window and use checkboxes to select the trades to use.
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If you select multiple trades, the system will use the sum of the cash values. When you have checked all
desired trades, click Select to allocate.
NOTE: In cases where you check trades that allocated to accounts not selected in the Accounts table, you
can add them by clicking Add from the message "The selected trades include some accounts that are
missing from selected accounts. Would you like to add missing accounts?"
When the allocation calculation is complete, click Apply to populate the Quantity and Cash Quantity values
in the Accounts table.

Manage Accounts for Allocation
The Accounts table includes all of the accounts that you can include in the order allocation. Check each
account that you want to include.
The list of accounts shown in the table comes from the group or profile selected in the Allocation dropdown list, and may then be modified further by the applied Filters. To remove filter criteria and see all
accounts from the chosen Allocation, elect to Reset All in the filter section.
The first row shows calculated totals. You cannot edit these Total values.
We calculated values in the Quantity and Cash Quantity allocation fields using the applied Allocation
method, but you CAN manually edit these values per account row.
If you edit the values of these allocation fields in a way that changes the total, we will update the
Total value. We will not recalculate allocations for other accounts and redistribute shares.
Optionally elect to Save as, Export or Copy the list of accounts and allocations.
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Save As: Use this feature to save the list of accounts and allocations as a new Allocation Profile. Elect
to save as “Shares” which will use the value in the Quantity field, or as “Cash Quantity.”
Export: Lets you export the table in .csv format and save the file to your machine.
Copy: Copies the table to the clipboard.
Once you have checked all accounts and defined the allocation method, use the Set Allocations button at
the bottom of the table to create an order in TWS that will apply the order allocation.

You must submit the order manually.

Soft Dollar Commission Tiers
Advisors and hedge and mutual funds have the option to offset the costs of approved research products
and services using soft dollars. Once you have requested soft dollars via Account Management and
defined the commission tiers, you can select the commission tier on a per-trade basis from within TWS.
Soft Dollars are available on stock and option orders only, and can be applied on all pricing structures.
For instructions on requesting soft dollars via Account Management, see the Soft Dollars topic.
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Soft dollar commission tiers can be selected from the Misc tab of the order ticket, or from the Soft Dollars
order field directly from an order row using the drop-down list.
To display the Soft Dollars field
1. Hold your mouse over an order row field for two seconds, or until the green "+" sign appears.
2. Click the "+" sign to invoke the Order Row field list.
3. Select Order Attributes, then select Soft Dollars.
The Soft Dollars field is displayed to the left of the field you originally selected.
When you create a client stock or option order, you can specify the commission tier for the order by clicking
in the Soft Dollars field and selecting a tier. Tiers must be defined in Account Management. Soft dollar
commissions must be between 0 and 0.05 dollars per share.
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Please note that this tier selection is used to calculate the total gross commissions, and the soft dollar
disbursement amount is the remainder once all IB commissions have been deducted.
Let's look at a simple example on a stock order using the Fixed Rate commission structure. On the above
order for 1000 shares with Tier 5 selected, total client commissions would be 1000 (shares) x 0.05 (tier
rate) = $50.00. The IB Fixed Rate commission on this order ($.005/share) is 1000 x .005 = $5.00. The soft
dollar amount would be equal to $45.00 for this order.
To choose a commission tier for an order
1. Click the Bid or Ask price to create a Sell or Buy order.
2. In the Soft Dollars field, select a commission tier.
If you do not select a tier for an order, no soft dollar markup is applied. There is no default value.

FTP File Instructions
Prime clients who trade with an away executing broker must submit a file reporting those trades to IB. Files
are sent via an FTP login that is provided to you when Prime capabilities are setup. Instructions are as
follows:
Files must be submitted on trade date when you execute away. The file has to be submitted in CSV format
with a consistent and unique filename. For example: “[COMPANY]_[YYYYMMDD].csv”.
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US Options, Futures, and Future Option trades must be reported no later than 5:00 pm ET. All non-US
activity must be submitted no later than 6:00 pm ( in the local market time).
For each executing broker that IB approves you will be provided with a Broker Name and Broker Code to
use in the upload file. The correct symbol format is required to avoid rejects and breaks. Please see below
for the correct format by product and region.

Sample Trade File
To download a sample trade file (shown below) click here.

Stocks
Enter the symbol which can be found on TWS. CUSIP is optional. Example, MSFT = MSFT, IBM = IBM.

Options
IB uses the 21-character “Option Symbology Initiative” (OSI) format. The easiest way to find this is to load
the option in TWS and use the Symbol column:
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OSI Details

The OSI identifier comprises six data elements arranged in logical order, each with a minimum field size.
Option Root Symbols must have 6 characters (if the symbol has less than 6 characters, spaces must be
added to equal the six character minimum)

Futures, Future Options and Single Stock Futures (SSFs)
Futures, Future Options and SSFs do not follow a standard symbol convention like OSI for Options. Please
confirm the symbol in TWS before loading the file. Load the product on TWS and refer to the Symbol
column to see the correct format. Column N for the Exchange must be populated with the exchange. Note
that for SSFs, the exchange should be "IBONE."
See Sample Trade File above, and examples below:
Futures
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CL Nov 2011 Future: The TWS symbol has no spaces and would be entered on the trade file as CLX1.
ZN Dec 2011 Future: The TWS symbol has one space between ZN and DEC and between DEC and 11,
therefore it would be entered on the file as ZN DEC 11.
Future Options
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CL Nov 2011 87 Calls: The TWSsymbol has one space between LOX1 and C8700, therefore it would be
entered on the file as LOX1 C8700.
ZN Dec 2011 114 Calls: The TWS symbol has one space between C and OZN, between OZN and Dec,
between Dec and 11, & between 11 and 11400. Therefore it would be entered on the file as C OZN DEC
11 11400.
Futures and futures options filled at the ICE or NYBOT need to be reported with security type "FUT ICE" or
"FOP ICE". Additionally, any zeros in the strike price should be removed from the symbol, i.e. you would
use "KOF3 P1.4" rather than "KOF3 P1.40"

HK Stocksfile
Enter the numeric underlying, which can be confirmed in TWS, in the symbol column. Enter currency HKD,
exchange HKEX, and the appropriate Settlement amount and ISIN.
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NOTES:
Remember not to trade with your executing broker (with intent to clear at IB) until we notify you that all
agreements and booking instructions are in place.
FTP files are processed every 15 minutes from Monday - Friday. Executing away is not a means to
resolve real time deficits as away trades will not be taken into consideration for beneficial margin purposes until 9 pm ET on Trade Date or when the trades have been reported and matched with external
confirms, whichever is later. Trading away for expiring options, on expiration day, is also discouraged
due to the potential for late or inaccurate reporting which can lead to erroneous margin calculations or
incorrect exercise and assignment activity. Clients who wish to trade expiring options, on expiration
day away from IB, must load their FTP file no later than 2:50 pm ET, and do so at their own risk.
If an incorrect file is loaded, do not delete or overwrite it. Instead, contact the Prime Services group at
203-618-4060 or primeserve@interactivebrokers.com to be advised on the best way to
resolve. Depending on the situation, IB may be able to stop processing, correct certain details, or
require a new file be loaded. Certain details can be amended by IB, such as Trade Date, Commission,
Price, and Quantity. The rest will require a new file to be submitted. If a new file is required please
ensure the filename is unique and does not overwrite the previous file, i.e. add a suffix to the file like “2”
or “B”. For Hong Kong stocks, please call +852-2156-7999 between 0800 - 1700 HKT.
If you do not know how to use FTP or need an FTP program you can use WinSCP – a free FTP management program – to post files to our servers. To download go to http://winscp.net/eng/download.php and select the “Installation Package” (not sponsored).
The "Exchange" is required for Futures, Futures Options, SSF, and Hong Kong stock trades.
The "Settlement Amount" and "ISIN" are required for Hong Kong stock trades.
Canadian stocks are only supported for settlement in Canadian dollars.

WinSCP – Store Session
WinSCP allows you to “store a session” allowing future logins without the need to provide the
username/password. To do so enter the following at the WinsSCP login window and select Save instead
of Login. Create a session name, check “save password”, click OK. In the future you will have the option to
log into this session each time you launch WinSCP.
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FTP Host name: ftp3.interactivebrokers.com or ftp.interactivebrokers.com (as provided by Prime
Services)
FTP username/password: Provided by Prime Services
File Protocol: FTP
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OATs Order Time Reporting for Manual Orders
For accounts requiring OATs reporting to remain in compliance with FINRA Rule 7440, a record of the
order time (in hours, minutes and seconds) must be made for "manual" orders. An order is considered
manual if instructions to submit/revise/cancel the order are received from a client in any way, for example
over the phone, in writing or by another medium.
Orders entered at the discretion of a broker or advisor do not require the Manual Order Time.

To set the Manual Order Time from Classic
From the order ticket, select the Misc. tab
Confirm or set the Manual Order Time.
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Orders allocated using a group, a profile or "All" display a blank Manual Order Time field. Use the calendar icon to set the order time.
Non-allocated orders display a default Manual Order Time of now. Use the calendar icon to modify if
needed.

To set the Manual Order Time from Mosaic
Create an order.
Click Advanced to open the Advanced Order Entry panel.
Confirm or set the Manual Order Time.
Orders allocated using a group, a profile or "All" display a blank Manual Order Time field. Use the calendar icon to set the order time.
Non-allocated orders display a default Manual Order Time of now. Use the calendar icon to modify if
needed.

Give-up
IBExecution - Order Ticket
IBExecution - Order Line
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Configure a Default Give-Up
Create DVP/RVP Instructions
Short Sale Confirmation
Transfer a Position Using DVP/RVP

IBExecution Services
As an IBExecution Services customer, you can tell TWS where you want to clear your trades on a per
order basis. Note that before you can use IBExecution Services, you must first apply and then provide us
with your give-up instructions which you specify in Account Management. You can use IBExecution
Services from both the Order Ticket and on an order management line to define pre-trade or post-trade
give ups.
IBExecution Services on the Order Ticket

1. Right-click on a ticker and select Trade, then select Order Ticket.
2. Set up your order on the Basic tab, then click the Misc. tab to use IBExecution Services.
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3. Use the Allocation drop-down to select your give up. Choose from your list of clearing choices including:
Interactive Brokers (IB). This was the previous default clearing destination.
Pre-trade Give Up. At the time of the trade, choose a third-party clearing give-up location from
the instructions in the clearing field, which you defined through Account Management. If you
defined multiple DTCID or CMTA settlement instructions via Account Management, you will see
multiple pre-trade choices.
Post Trade Allocation (PTA). This selection is available upon request, and puts your trades
into the PTA pool after execution. Allocate post-trade using the Trading Access section of
Account Management, which is directly accessible by selecting Post Trade Allocations on the
View menu. The clearing choice you select will automatically be used as the default selection the
next time you submit an order.
The clearing choice you select will automatically be used as the default selection the next time you
submit an order.
4. Use the Open/Close indicator for US Options orders to specify whether your order is designed to
close/reduce a position or open/increase a position. You can set a default for this indicator in the
Order Defaults section of Global Configuration.
5. The Clearing Account field is required for US futures and futures options orders that use PTA or
Awayclearing. You must specify the account number or other identity of the true beneficiary of the
order. This information is reported to the exchange with the order. IB Execution clients with multiple
clearing destinations can configure a default give-up. For Option and Stock orders, the clearing
account number is in the settlement instruction and this field is optional.

IBExecution Services from an Order Line
As an IBExecution Services customer, you can instruct TWS where you want to clear your trades on a per
order basis. Note that before you can use IBExecution Services, you must first apply, and then enter your
give-up instructions through Account Management. You can use IBExecution Services from both the
Order Ticket and on an order management line to define pre-trade or post-trade give ups.
IBExecution Services from an Order Management Line
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1. Click the Ask or Bid price on a market data line to create a BUY or SELL order, respectively.
2. Use the Clearing dropdown to select to select your give up. Elect from one of three (3) types of clearing choice:

Interactive Brokers (IB). This was the previous default clearing destination.
Pre-trade Give Up. At the time of the trade, choose a third-party clearing give-up location from
the instructions you defined through Account Management. If you defined multiple DTCID or
CMTA settlement instructions via Account Management, you will see multiple pre-trade choices.
Post Trade Allocation (PTA). This selection puts your trades into the PTA pool after execution. Allocate post-trade using the Trading Access section of Account Management, which is
directly accessible by selecting Post Trade Allocations on the View menu. The clearing choice
you select will automatically be used as the default selection the next time you submit an order.
3. Use the Open/Close indicator for US Options orders to specify whether your order is designed to
close/reduce a position or open/increase a position. You can set a default for this indicator in the
Order Defaults section of Global Configuration.
4. The Clearing Account field is required for US futures and futures options orders that use PTA or
Away clearing. You must specify the account number or other identity of the true beneficiary of the
order. This information is reported to the exchange with the order. For Option and Stock orders, the
clearing account number is in the settlement instruction and this field is optional.

Configure a Default Give-Up
If you have multiple clearing destinations, you can define a default give-up for each asset type. The default
will be shown each time you create an order, but can easily be changed by selecting another clearing
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destination.

To create a default give-up
From the TWS Edit menu, select Global Configuration.
In the left pane select Give-ups.
Click "Add" from the top right of the window and fill in the Give-up box.
Enter the exchange acronym or use "*" as the wildcard to include all exchanges.
Enter the security type.Valid acronyms include:
OPT
STK
FUT
FOP
Click OK to save the give-up
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To include default give-ups for different security types, click "Add" and specify a separate give-up for each
security type.
Click OK at the bottom of the pane to close Global Configuration and save the list of all default give-ups.

Short Sale Confirmation
Use the Short Sale Confirmation box to confirm that the shares you want to short are available at the
clearing firm. This confirmation box pops up the first time you elect to short an underlying. If you enter the
number of shares available, it will only require input once per underlying/per TWS session (a session lasts
until you log out of TWS) as long as you stay within the available shares limit.

To confirm availability of shares for short sale
1. Select Short sell as the action on a buy/sell order line.
2. Enter confirmation information in the Short Sale Confirmation box.
Enter the Total Number of Shares available to avoid having to confirm availability each time you
short this underlying.
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3. TWS will track the number of shares available based on the short sell orders you submit on the
underlying. If the number of available shares does not cover the order quantity, you will be required
to confirm availability again.

Pre-Trade Allocations
Create an Order for Multiple Clients

Allocating Shares
Rebalance for Advisors
Create an Account Group for Share Allocation
Create a Share Allocation Profile
Default Clearing for Allocation Profiles

TWS Guide

1545

Chapter 1

Create an Order with Share Allocations

Edit a Share Allocation Profile
Set Default Allocations

Create an Order with Share Allocations
Use pre-defined Account Groups or Allocation Profiles to allocate order shares.

To create an order with share allocations
1. Click the "Ask" or "Bid" price on a market data line to create an order.
Click the Ask Price to create a Buy order.
Click the Bid Price to create a Sell order.
2. Use the Allocation field drop down list to select an Account Group, Account Profile, a single
account or All* accounts.
3. For the Account Group, modify the allocation method if necessary. If you choose the PctChange
method, enter a positive or negative value in the Percentage field. All other automatic allocation
methods are calculated using the order size.
4. If you use an Allocation Profile, select a group name.
5. To allocate all shares to one account, select a single account.
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6. Click OK to complete the order.
7. Click Transmit to send the order.
* The option to select "All" accounts is hidden if the number of accounts in an IBroker family is greater than
50 (unless the IBroker is enabled for allocations).

Allocation Order Tool
Manage Allocations Profiles more efficiently with our one-stop Allocation Order Tool. This interface
combines TWS allocation elements into a single, efficient tool that makes it easy to create order allocations
to:
Reduce or exit an existing position
Increase or open a new position
Rotate positions (close some and open others almost simultaneously)

Currently available for Advisors, Money Managers, Allocating IBrokers

To open the Allocation Order Tool
From a market data line or order line (for an un-transmitted order), use the right-click menu to select
Allocation Order Tool.
From any order tool: From the Allocation drop-down field in any tool, select Allocation Order Tool.
Other ways to access the tool:
Classic: Using the Allocation toolbar button from a selected market data or order row.
From the Activity panel, trade log or the Pending Orders quote monitor, select a trade or partially filled
order and use the right-click menu to select Create allocation profile from trade…
To use the Allocation Order Tool
In the Classic view, select an asset, for example AAPL stock, and use the right-click menu to select
Allocation Order Tool.
Select or change the order side (Buy/Sell) as needed.
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Note: Neither Symbol nor Quantity values are editable in this area. The Quantity updates automatically
from allocation values in the Accounts table below.
From the Allocation drop down list, select a group or profile to use a pre-defined sub-set of accounts.
Otherwise, leave All.
NOTE: Account Groups and Allocation Profiles will not apply the associated allocation method to the
group. It only uses the group to populate the Accounts table with the specific sub-set of accounts.

Filter Allocation Accounts
In the Filter section, use criteria to filter out the accounts displayed in the Accounts table, and that will be
available to select for order allocation:

a. Check “Only include accounts with XXX” to filter out accounts that don’t have a position
in the selected underlying.
b. Using greater than, less than and in the range of qualifiers, filter out accounts based on:
• Position size
• Market value
• % of NLV
• Unrealized P&L
• Cash Balance and
• Buying Power
When filters are complete, click Apply to filter the Accounts table. To clear all filters and start again, click
Reset
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Define and Apply an Allocation Method
Use Allocation criteria to define how to populate the Allocation values Quantity and Cash Quantity in the
Accounts table. You can only set one of these Allocation methods.

Increase (decrease) position by: Specify a percentage by which you want to increase (for a buy order)
or decrease (for a sell order) positions for the selected accounts.
Set allocation based on: Calculate per-account allocations based on the Cash Balance or Buying Power
multiplied by a user-specified number (between 0 and 100). The system calculates ratios for all selected
accounts based on the specified value and allocates based on these ratios.
Allocate total: Use this option to allocate the total Quantity or Cash Quantity of a user-specified value,
either:
Proportionally, based on position, cash balance or buying power, or
Equally
Allocate: Enter a percentage of recent trades (over the past seven days) that will be used to determine
allocation values, based on the absolute value of the cash value allocated to each account. Click Select to
open the Trades window and use checkboxes to select the trades to use.
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If you select multiple trades, the system will use the sum of the cash values. When you have checked all
desired trades, click Select to allocate.
NOTE: In cases where you check trades that allocated to accounts not selected in the Accounts table, you
can add them by clicking Add from the message "The selected trades include some accounts that are
missing from selected accounts. Would you like to add missing accounts?"
When the allocation calculation is complete, click Apply to populate the Quantity and Cash Quantity values
in the Accounts table.

Manage Accounts for Allocation
The Accounts table includes all of the accounts that you can include in the order allocation. Check each
account that you want to include.
The list of accounts shown in the table comes from the group or profile selected in the Allocation dropdown list, and may then be modified further by the applied Filters. To remove filter criteria and see all
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accounts from the chosen Allocation, elect to Reset All in the filter section.
The first row shows calculated totals. You cannot edit these Total values.
We calculated values in the Quantity and Cash Quantity allocation fields using the applied Allocation
method, but you CAN manually edit these values per account row.
If you edit the values of these allocation fields in a way that changes the total, we will update the
Total value. We will not recalculate allocations for other accounts and redistribute shares.
Optionally elect to Save as, Export or Copy the list of accounts and allocations.
Save As: Use this feature to save the list of accounts and allocations as a new Allocation Profile. Elect
to save as “Shares” which will use the value in the Quantity field, or as “Cash Quantity.”
Export: Lets you export the table in .csv format and save the file to your machine.
Copy: Copies the table to the clipboard.
Once you have checked all accounts and defined the allocation method, use the Set Allocations button at
the bottom of the table to create an order in TWS that will apply the order allocation.

You must submit the order manually.

Allocating Shares
We provide several ways to distribute shares among accounts when you create an order. You can select
an Account Group, which comprises a pre-defined subset of accounts and an associated allocation
method. The Account Group allocates shares based on a ratio calculated by the system, or by a
percentage. The numbers used to calculate the ratio derive from the method you chose when you created
the group, or by the percent change you set.
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A second way to allocate shares is through an Allocation Profile, which distributes shares to each
account in a profile based on a percentage, ratio or absolute number that you define. Both of these
methods require that you create a group, assign accounts to the group, and define the group's allocation
method.

You can also direct an order to a single account by selecting that account number or alias from the
Allocation field on the order management line, or to all accounts by selecting All from the Allocation field.
Set a default allocation from the Advisor Setup screen.

Rebalance for Advisors
Advisors can elect to have TWS automatically Rebalance ALL accounts, a single subaccount, or a userdefined Account Group, which includes a subset of accounts, by redistributing percentages of positions in
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their subportfolio(s) that make up the current (signed) net liquidation value. TWS opens and closes
positions to rebalance the selected accounts' portfolio based on the new percentages you enter. You can
add contracts and create orders just as you would from the main trading screen.

Rebalance a SubPortfolio
1. Open the Rebalance window by clicking the Rebalance icon on the trading toolbar.
2. In the Account dropdown, select: All to rebalance All accounts; Master to rebalance the master
account, an account number to rebalance that account, or an Account Group to rebalance all
accounts in the group.
3. The Rebalance window shows three columns that are different from those on your trading screen:
Deliv Value - this is the deliverable value of the position, which is the same as the Market Value
for the position shown in the Portfolio section of the Account window.
Current % - this is the current signed percent of the position to your net liquidation value shown in
the Balance section of the Account window. This figure is calculated by dividing the DLV by the
NLV (Net Liq. Value).
Rebal% - Percentages are entered in terms of deliverable value.
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Note: Please note that puts have a negative deliverable value since they deliver a short
position. Consequently, to increase your put position, you must enter a negative deliverable
value percentage.
4. In the Rebal % field, enter the new percent of the Net Liquidation Value that you want the position to
have.
If you have selected "All" in the Account dropdown, the rebalance percent for the instrument will be
applied to all of your sub accounts' portfolios.
5. Click the Create Orders button to instruct the application to automatically create the orders to
achieve the percent change.
6. Use the Transmit All button to send all orders, or click "Transmit" on an order line to transmit a
single order.
Note: For options, the rebalance% is based on the value of the underlying stock price.
Open positions from the Rebalance window
1. First, add a ticker line to the Rebalance window by selecting the market data line on your trading
screen, and then clicking the selection arrow attached to the Rebalance icon on the trading toolbar.
Click Add to Rebalance Window. Or, enter an underlying symbol into a blank row on the
Rebalance screen as you would on the main trading window.
2. Enter a value in the Rebal % column and click the Create Orders button.
3. Transmit the order.

Edit Inline Profile on Rebalance
Advisors using the Rebalance Portfolio window to simultaneously reset the Target % allocation for multiple
accounts can edit the inline profile for rebalance orders before submitting. The inline profile for each order
identifies the accounts that will be affected by the rebalance order and allows you to delete accounts from
the profile based on user-selection or specified "shares to trade" criterion.
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To edit an inline profile
From the Rebalance account selector choose Group>All.
Reset target percents as needed and click Create Rebalance Orders.
Double-click the Allocation field on an order line to view and edit the Inline Profile.
Specify criteria that will result in certain accounts being omitted.
Click OK when finished.

Create an Account Group for Share Allocation
You can use an Account Group to automatically calculate ratios and allocate shares to a pre-defined group
of accounts based on a selected allocation method. When you create an order and choose a group, the
order uses the default method to allocate shares among the accounts in the group.
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To create an Account Group
1. On the Edit menu select Global Configuration.
2. In the left pane select Advisor, then select Account Groups.
3. Click the Create button on the right side of the window.
4. Enter an Account Group name. Do not use the name "All" since this is reserved by the system.
Note: When you create an order, the choices displayed in the Allocation list are grouped first
by Account Group, then Allocation Profile, and then individual accounts. However, they are
not identified in any other way. When you create an account group, you may want to include
a prefix such as "AG" in the name to identify the choice as an Account Group.
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5. Select a default allocation method. You can change the allocation method for each order.
EqualQuantity - Requires you to specify an order size. This method distributes shares equally
between all accounts in the group.
Example: You transmit an order for 400 shares of stock ABC. If your Account Group includes four
accounts, each account receives 100 shares. If your Account Group includes six accounts, each
account receives 66 shares, and then 1 share is allocated to each account until all are distributed.
NetLiq - Requires you to specify an order size. This method distributes shares based on the net
liquidation value of each account. The system calculates ratios based on the Net Liquidation
value in each account and allocates shares based on these ratios.
Example: You transmit an order for 700 shares of stock XYZ. The account group includes three
accounts, A, B and C with Net Liquidation values of $25,000, $50,000 and $100,000 respectively.
The system calculates a ratio of 1:2:4 and allocates 100 shares to Client A, 200 shares to Client B,
and 400 shares to Client C.
AvailableEquity - Requires you to specify an order size. This method distributes shares based
on the amount of available equity in each account. The system calculates ratios based on the
Available Equity in each account and allocates shares based on these ratios.
Example: You transmit an order for 700 shares of stock XYZ. The account group includes three
accounts, A, B and C with available equity in the amounts of $25,000, $50,000 and $100,000
respectively. The system calculates a ratio of 1:2:4 and allocates 100 shares to Client A, 200 shares
to Client B, and 400 shares to Client C.
PctChange - Do not specify an order size. Since the quantity is calculated by the system,
the order size is displayed in the Quantity field after the order is acknowledged. This
method increases or decreases an already existing position. Positive percents will increase a position, negative percents will decrease a position.
BUY

Positive

Negative

ORDER

Percent

Percent

Long

Increases

No effect

Position

position
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No effect

Position

Decreases
position

SELL

Positive

Negative

ORDER

Percent

Percent

Long

No effect

Decreases

Position

position

Short

Increases

Position

position

No effect

Example 1: Assume that three of the six accounts in this group hold long positions in stock XYZ.
Client A has 100 shares, Client B has 400 shares, and Client C has 200 shares. You want to
increase their holdings by 50%, so you enter "50" in the percentage field. The system calculates that
your order size needs to be equal to 350 shares. It then allocates 50 shares to Client A, 200 shares
to Client B, and 100 shares to Client C.
Example 2: You want to close out all long positions for three of the five accounts in a group. You
create a sell order and enter "-100" in the Percentage field. The system calculates 100% of each
position for every account in the group that holds a position, and sells all shares to close the
positions.
6. The list of accounts in the Non Group Account section includes all accounts available to you. To add
an account to the group, select a Non Group account and click Add.
7. Click Create to save the group and its settings.

Create a Share Allocation Profile
You can create profiles that allocate specific percentages or shares of each order to individual accounts
based on the rules you set and values you input.
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To create a share allocation profile
1. From the Account menu, select Advisor Setup.
2. From the Advisor Setup top menu, select Profiles.
3. Click Create and enter a profile name, preferably one based on the way you plan to allocate shares
between clients.
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When you create an order, the choices displayed in the Allocation list are grouped by Account
Groups, then Allocation Profiles, and then individual accounts. However, they are not identified in
any other way. When you create a profile, you may want to include a prefix such as "P" in the name
to identify the choice as a profile.
4. In the Usesection, select a method of allocating shares between accounts:
Percentages - The Percentages method will split the total number of shares in the order
between listed accounts based on the percentages you indicate. For example, an order for 1000
shares using a profile with four accounts at 25% each would allocate 250 shares to each listed
account in the profile.
Ratios - The Ratios method calculates the allocation of shares based on the ratios you enter.
For example, an order for 1000 shares using a profile with four accounts set to a ratio of 4, 2, 1, 1
would allocate 500, 250, 125 and 125 shares to the listed accounts, respectively.
Shares - The Shares method allocates the absolute number of shares you enter to each account
listed. If you use this method, the order size is calculated by adding together the number of
shares allocated to each account in the profile.
5. From the Allocation section, include accounts by clicking in the Account drop down and selecting an
account. Tab over to the Value field.
6. Enter the percent, ratio or number of shares to be allocated to the selected account. Be sure to first
delete the current value. Tab again to create a new account line.
If you use percentages to allocate shares, percentages allocated must equal 100. If you use ratios,
the system automatically calculates these percentages.
7. Continue until you have listed all the desired accounts for the current profile, and click Create.

Import and Export Groups and Profiles
Advisors and other multi-client account users can import and export Account Groups and Allocation
Profiles to and from an Excel .csv file.
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To export account groups and allocation profiles
1. From the Account menu, select Advisor Setup.
2. From the Advisor Setup top menu, select Groups or Profiles.
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3. Click Export.
4. In the Export Groups and Profiles window, use checkboxes to choose the Groups or Profiles to
export.
5. Modify the file name and location if needed using the Filename field. A default directory and filename
are included.
6. Click OK to export the data.
The resulting file will display similar to the snippet shown below. Fields are required in the Excel file only if
they are populated.
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To import account groups and/or allocation profiles, create a .csv file following the same format as the
images above and below. The image below is only for a new account group called ImportTest.

To import account groups and/or allocation profiles
From Excel:
Open Excel, and create a new file that defines:
For Account Groups, the file contains the Group Name, Default Method, Group and
Account fields.
For Allocation Profiles, the file contains the Profile Name, Type, Profile and Account fields
(additional fields are required for Ratio and Percentages.
Save the file with the .csv file extension.
From within TWS:
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1. From the Account menu, select Advisor Setup.
2. From the Advisor Setup top menu, select Groups or Profiles.
3. Click Import.
4. Find the directory where you saved the Excel file, and open the file to import.
5. Click OK to complete the import.

Edit a Share Allocation Profile
After you have created share profiles, you can select one when you create an order.
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To edit a share allocation profile
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1. From the Account menu, select Advisor Setup.
2. From the Advisor Setup top menu, select Profiles.
3. Select a Profile Name and click Edit.
4. In the Edit Profile window, you can add or delete accounts, select a different allocation method, or
modify the allocated percentage or ratio for any accounts.
5. Click Save Changes to save the edited profile.
Percentages allocated must equal 100. If you use ratios, the system will automatically calculate share
percentages based on the ratios.

Use Presets for Default Allocations
A default allocation is used automatically when you create an order. You can modify the allocation on a per
order basis, and change the default allocations and presets at any time.

To set default allocations

TWS Guide

1566

Chapter 1

Define settings described below:

1. From the Account menu select Advisor Setup.
2. From the Advisor Setup top menu select Presets .
Define settings described below:

No default accounts - you will have to select an account for allocation for each order.
Use currently subscribed account - check this button to automatically allocate trades to the account or
group selected in the Account dropdown on a trading screen, as shown above.
Use specified default - check this button to set a specified default allocation:
Automatic Allocation - choose a user-defined Account Group and method to use for default allocation.
EqualQuantity - Requires you to specify an order size. This method distributes shares equally
between all accounts in the group.
Example: You transmit an order for 4000 shares of stock ABC. If your Account Group includes
four accounts, each account receives 1000 shares. If your Account Group includes six
accounts, each account receives 667 shares, and then 1 share is allocated to each account
until all are distributed.
NetLiq - Requires you to specify an order size. This method distributes shares based on the net
liquidation value of each account. The system calculates ratios based on the Net Liquidation value in
each account and allocates shares based on these ratios.
Example: You transmit an order for 700 shares of stock XYZ. The account group includes three
accounts, A, B and C with Net Liquidation values of $25,000, $50,000 and $100,000
respectively. The system calculates a ratio of 1:2:4 and allocates 100 shares to Client A, 200
shares to Client B, and 400 shares to Client C.
AvailableEquity - Requires you to specify an order size. This method distributes shares based on the
amount of available equity in each account. The system calculates ratios based on the Available Equity
in each account and allocates shares based on these ratios.
Example: You transmit an order for 700 shares of stock XYZ. The account group includes three
accounts, A, B and C with available equity in the amounts of $25,000, $50,000 and $100,000
respectively. The system calculates a ratio of 1:2:4 and allocates 100 shares to Client A, 200
shares to Client B, and 400 shares to Client C.
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PctChange - Do not specify an order size. Since the quantity is calculated by the system, the
order size is displayed in the Quantity field after the order is acknowledged. This method
increases or decreases an already existing position. Positive percents will increase a position, negative
percents will decrease a position.
Manual Allocation - choose an Allocation Profile to use as the default.
Single Account Allocation - choose an individual account to use as the default allocation. NOTE: To allow
the last selected individual account to be used for the default allocation going forward, select the Use
currently subscribed account radio button at the top of the page.
Preserve default - select to always use the default set up in the Default Allocation window regardless of
changes you make on a per-order basis. If this is checked, you will need to use this window to modify the
default allocation.
Use last submitted as a default - select if you want the default allocation to change to the allocation you
set on a per-order basis. If this is checked, the default allocation automatically changes when you change
the allocation on an order.
If one or more accounts fails to meet the margin requirements when an order is submitted...
For each order, all accounts designated for order allocation are vetted before the order is submitted, to
ensure that each account has the capacity to support the designated allocation. In cases where one or
some account(s) cannot hold the allocation as specified, the advisor can elect to:
Reject the entire order - The entire order is rejected.
Reduce the size of the order - The order size is reduced by the quantity that cannot be held, and this
quantity is deactivated.
Note that once the order has been submitted and is working, the quantity of the working order may still
change. For example, if an unrelated fill results in one or more of the accounts no longer being able to
support the allocation, the order size will be reduced by that quantity. In an opposite scenario, if an account
whose allocation was deactivated can now support the allocation, a quantity that was deactivated during
the initial order submission may be reactivated and submitted.
When closing positions: Applies only to orders that use the Available Equity or NetLiq automatic
allocation methods described above.
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Make positions be proportional based on method - Based on the selected method (Available Equity or
NetLiq) shares are allocated first to the account where the position would be closed prior to opening
new positions. New positions will be proportional based on the specified method.
Distribute shares based on method selected - Shares are allocated strictly based on the selected
allocation method (Available Equity or NetLiq), but will first be allocated to an account where a position
will be closed before any new positions are opened.
Distribute shares based on method selected. Do not prioritize accounts that are closing position Shares are allocated strictly based on the selected allocation method (Available Equity or NetLiq), but a
new position may be opened before an existing position is closed as no priority is given to accounts that
would close positions.

Default Clearing for Allocation Profiles
You can set up a default clearing profile as part of a manual Allocation Profile. The clearing defaults will be
validated when you create an order.
To define a default clearing profile
1. From the Advisor configuration group, select Allocation Profiles.
2. In the top half of the window, choose the Allocation Profile for which you want to define clearing
defaults.
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3. In the Clearing Defaults section at the bottom of the window click Create.

By default, all security types and all exchanges are included, indicated by the asterisk (*) in each
selection field. If you prefer to define a clearing profile for a certain security type/exchange pair,
select them from the dropdown lists.
4. Select a security type and exchange if desired. Otherwise, the asterisk indicates “all.”
5. For each account in the Allocation Profile, choose a Clearing selection, and click OK.
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Note that the clearing rules are only received when an order is created. Consequently some clearing
defaults will be invalid for some security type/exchange pairs. If the clearing rule is not valid for an order,
you will receive an information message with a link that allows you to modify the clearing defaults.
Using the Clearing Profile
If you are selecting an allocation, the clearing profile will not be active. You must either have the Manual
Allocation selected in Global Configuration as the specified default, or you must select the Manual
Allocation radio button from the Advisor tab of the order ticket on a per order basis. If you choose an
Allocation Profile from the Allocation dropdown list of an order line, you must also choose the clearing.
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To set Manual Allocation as the default
1. From the Edit menu, select Global Configuration.
2. In the left pane, select Advisor then select Default Allocation.
3. From the Default Allocation window, select Use specified default.
4. Select Manual Allocation, and choose the Allocation Profile for which you defined the clearing
defaults. Click OK.
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To select Manual Allocation on a per-order basis
1. From the order line, use the right-click menu to select Modify and then select Order Ticket.
2. On the Advisor tab, choose Manual Allocation, and then select the Allocation Profile for which you
have defined the clearing defaults you want to use.
The clearing defaults in the Allocation Profile drive the default entry in the Clearing dropdown field. This list
only contains clearing choices that are valid for ALL accounts in the profile.
If all clearing choices in the profile are valid but different, the Clearing entry reads Per Account and
each individual clearing entry shows the clearing destination.

TWS Guide

1573

Chapter 1

Advisor Model Marketplace

If all clearing entries are the same and valid, the Clearing entry shows the clearing destination, and the
each individual clearing entry reads Same, indicating it is the same as the main Clearing entry.
If there is no common, valid clearing choice for all accounts in the Allocation Profile, the Clearing field
becomes inactive, and each individual clearing entry shows either the valid clearing destination from
the profile, or the valid default - in the image above it would display the last valid submitted clearing destination, since Use last submitted as default is selected.

Advisor Model Marketplace
The Model Marketplace provides a collection of investment models designed by third-party vendors.
Search, download and then use selected models in TWS Model Portfolios to manage your client's
investments.
To use the Model Marketplace
To use models and access the Model Marketplace, you must first enable both Model Portfolios and Model
Marketplace via Client Portal.
Log into Client Portal.
From the menu, select Settings and then select Account Settings.
In the configuration panel, click the icon next to Model Portfolios and then Model Marketplace to
subscribe to these services.
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Once you are subscribed, log into TWS to browse the marketplace and use Model Portfolios.
To use theModel Marketplace
In TWS, open the Advisor Setup window.
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From the Models tab in Advisor Setup, click Browse Vendor Models.
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Browse models or use filters to find the model that fits your criteria. Click a selected model.

If the model composition is satisfactory, download the model by clicking Download composition. The
composition of the selected model is saved to a .csv file in your default "download" directory (could be
c:\users\username\downloads) or to the specific directory you set for downloads. The file name is shown in
the download.
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Back in the Models tab in the Advisor Setup window, create a new model name based on the downloaded
vendor model.

Select the new model then click Set Target Allocation to open the Rebalance window.
Confirm that your new model is selected in the Rebalance Select Account list. Click Import in the bottom
left corner and navigate to your downloaded model composition file.

Modify percentages and fine-tune the model composition to invest your clients.
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Find out more about using Model Portfolios.

Model Portfolios
Models provide an efficient process for managing multiple trading strategies for your clients without
requiring them to open multiple accounts. Client investments are allocated among instruments in a Model
based on the Model's allocation ratios as defined by the account manager.
To use Model Portfolios, log into Client Portal and from the Settings > Account Settings page subscribe to
Model Portfolios.
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Set up a Model Structure
Create and manage Models from the Portfolio tab. To get started, first create the structure for the Model by
providing a name and code.
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To set up a Model
1. From the Portfolio tab select Model Setup from the Display Selector.
2. Click Create Model to specify a name and code.
3. Enter a name and code, and click OK.
The code cannot be changed once it has been created.

The structure for the new Model displays in the Models section of the Portfolio page. At this point the Model
has no funds, no assets and no investors.
Next step: Fund and Populate the Model
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Initial Funding and Populating
When you initially fund a model and populate it with investment instruments, the model's allocation targets
for future investments are created. There are two ways to specify the model's instrument allocation
percents with initial funding:
You can specify the target percent allocation for each investment instrument first and fund the model
second. In this case the system will automatically create orders to purchase assets in proportion to the
defined target percentages when the model is funded.
You can fund the model first and then trade the investment instruments (and consequently define the
allocation percents) second.
Regardless of the method you use for initial funding, subsequent client investments are allocated based on
these specified percents. To change the target allocation percents, use the Rebalance window.

Establish Target Percent Allocations
Once you define target percent allocations, the initial investment is allocated automatically among the
investment instruments through orders created to achieve the target percents.

To Set Target Allocations
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1. Select Model Setup from the Display Selector.
2. Choose the model you want to fund, and click Set Target Allocations. The Rebalance window
opens.
3. Add ticker lines for each asset you want to include in the model.
4. Specify the percent of allocation for each asset.
5. Click Save Target %.

Next Step: Fund the model.

Fund a Model
If you have defined target percent allocations, the initial investment will be automatically allocated based on
the defined allocation percents. If you haven't defined target percent allocations, you will need to populate
the model after it has been funded.
To fund a model
1. From the Display Selector, choose the client account that will be investing in the Model.
2. Right-click the Model in which the client wants to invest, and click Invest in [MODEL NAME].
3. Enter the investment amount and click Submit.
If no target percents have been defined, the model will receive funds that will be available to
trade investment assets. Populate the model with tradable assets.
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If you have defined target percent allocations, this action will create investment orders in the
lower panelthat you can transmit to achieve your target percent allocation.
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If you have defined target percent allocations, the funds will automatically be allocated among the
investment instruments and the appropriate orders will be created. Click "Transmit All" to submit the
orders.

Purchase Model Investments
If you specified Target Percent Allocations before you funded with an initial investment, your model is
already populated.
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Once you have received an initial cash investment in a model, you can populate a model with investment
instruments. Perform this action as if you were purchasing shares for a client account but select the Model
as the allocation.
To populate a Model
1. From the Select Account dropdown, select the Model you want to populate.
2. In the Quote Monitor, create orders for all assets that you want to include in the selected Model.
3. Transmit the order(s).
The units are allocated amongst all invested accounts according to the percentage each account has
invested in the Model. This also sets up the Model allocation ratios for all subsequent client investments.
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Next Step: Invest in the Model

Models and Positions
You can view models, accounts and positions sliced in many different ways.
To see the total positions per Model
1. Open the Portfolio tab.
2. From the Display Selector, choose All.
3. Select My positions by model.
4. Click the "+" sign in the Models list to display the drill-down list of all investments per model.

To see model positions per account
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1. Open the Portfolio tab.
2. From the Display Selector, choose an account.
3. Click the "+" sign in the Models list to display the drill-down list of all investments per model.
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Invest in a Model
When you invest new client funds into an existing, populated Model, the new capital is invested using the
Model's existing allocation ratios.
The TECH Model has the following investment allocation structure, as shown below. If another client
invests 50,000 in the TECH Model, the investment is allocated to achieve the same percentages.

:

Invest in Multiple Models
A client can elect to allocate their investment across multiple Models.
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To invest in multiple Models
1. From the Display Selector, choose the client account that will be investing in multiple Models.
2. Right-click the Models header row and select Invest in Models.
3. Specify the amount you want to invest in each available model. You can enter values by:
Entering an investment amount or percentage in the entry field for each model. The system will
total the investment in the header row.
Entering a total investment amount in the header row entry field and allowing the system to
evenly allocate the total amongst all models. This method allows you to manually adjust percentages. Enter 0% for any model in which the client does not want to invest.
The investment is distributed amongst the selected Models based on the existing structure of each.
If the Model is not yet funded, the investment serves as the initial cash investment.
If the Model is funded with cash only, the investment is added to the current funding and will be used to
purchase investment instruments.
If the Model has positions, the investment is used to purchase units in the same ratios currently held in
the Model.
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OR
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Divest Funds from a Model
Quickly divest client funds from a Model.
To divest from a Model
1. From the Display Selector, choose the client account that will be divesting from the Model.
2. Right-click the Model from which the client wants to divest, and click Divest from [MODEL NAME].
3. Enter the divestment amount and click Submit. This action triggers orders to sell assets in the Model
equal to the value being divested, in the same proportion they are held in the Model.
The model's available funds is decreased by the divestment amount.
The client's cash balance is increased by the divestment amount.
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Withdraw Cash from a Model
You can withdraw cash from a model and transfer it to the independent holdings for all accounts invested in
the model.
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To withdraw cash from a model
1. From the Display Selector on the Portfolio page, select Model Setup.
2. Select the model from which you want to withdraw cash.
3. Click "Withdraw Cash from Model."
4. Enter the percentage of cash to withdraw. Cash will be transferred to the independent holdings of all
accounts that have invested in the model, based on the current amount of cash in the account.
If account A has 10,000 cash and account B has 20,000, a withdrawal of 25% would transfer 2,500 to
Account A and 5,000 to Account B.
5. Click Finish to initiate the transaction(s).

Rebalance a Model
You can rebalance the investments within a model at any time using the Rebalance window.
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To rebalance a model
1. From the Display Selector on the Portfolio window, select the model you want to rebalance.
2. Click the Rebalance icon on the right side of the window.
3. In the Rebalance window, review and revise the Target percents for each instrument.
The target percents were established with the initial funding of the model.
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4. Define the new target percents for allocation several ways:
Enter a new value in the desired Target % field by clicking the field and entering a number value
representing the percentage (i.e. enter 5 for 5%).
Enter new values in all Target % fields by clicking the Clear Target % button.
Use the "Current %" values by clicking the Set Target % button. Once the target percents have
been set to the current percents, you can make any modifications by clicking in the Target % field.
5. Click Create Rebalance Orders. Orders are created in the panel below the Rebalance window.
6. Confirm or modify the order parameters and click Transmit All to submit rebalance orders.

Reallocate Client Funds Among Models
Use the "Reallocate" feature from the sub account window to quickly redistribute invested funds among
Models.
To reallocate funds among Models
1. From the Portfolio tab, select the client whose investments you want to reallocate.
2. Right-click the Models header row.
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3. Select Reallocate.
4. Modify the Percent of Allocation as desired for the existing models.
5. Click Submit to transmit reallocation orders.
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Monitor Model Activity
You can monitor all aspects of your models and investments using the Display Selector and Model
information dropdown lists.

From the Display Selector, choose a Model and see:
Accounts: Invested accounts and the percentage of each account's total investment invested in the
Model.
Positions: All Positions held in the selected Model, along with the market value and the allocation
ratios.

From the Display Selector, choose an account and see:
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My positions by Model: All positions held in each Model for the chosen account.
Total ungrouped positions: All positions held outside of the Models (ungrouped positions) for the
chosen account.

From the Display Selector, choose All and see:
My positions by Model: All positions held by all accounts, sorted by Model.
Total ungrouped positions: All positions held outside of the Models (ungrouped positions).
Models by account: For each account, shows the market value invested in each Model and the
account's percentage of total market value invested in each Model.

Delete a Model
If you elect to delete a Model, all holdings will become "Independent" positions for all clients who are
invested in the Model being deleted.
To delete a Model
1. Select Model Setup in the Display Selector.
2. Select the Model you want to delete.
3. Click Delete Selected Model.
Model holdings become "independent positions" for clients invested in the Model, in the proportion they
were held in the Model. In the example below, holdings were held equally between three accounts.
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Preset 262
Quote Panel 1375
Rapid Order Entry 1400
Sound Manager 1350
Trader Dashboard 904, 1411
Configure Auto Export 1339
Configure Chart Alert dialog 1168
Configure Chart Colors 1163
Configure Columns 1395
Configure Final Option Exercise Requests 1519
Configure Hotkey 254
Configure Lock 1347
Configure Market Depth 1407
Configure menu 262, 391, 1439
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Configure News Feeds 1409
Configure Order Presets 257, 1499, 1506
Configure Settings 1387
Configure SmartRouting 1431
Configure Table Variables 383
Configure Volatility 1352
Configure Volume Condition 892
Confirm short sell 1544
Connect 1355, 1359
API 1358
eSignal 1355
Consider Cost 354, 832
Consolidated quote 718
Constrain 582
Query Results 582
Continuous futures 1104
Continuous Update 243, 349, 413, 416, 418, 676, 697, 830-831, 1353, 1359
Continuous update setting 1352
Continuously Update Limit Price 417
Contract Description 767, 826, 1073, 1086, 1490
Contract Description Detail 1481
Contract Description Pane 1074
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Contract Display Mode 1499
Contract Info 726, 1499
Contract Info menu 726
Contract Selection 314, 388, 746-747, 751, 753, 1480, 1498
Conversion Rate 1007
COP 704
Copying 283, 711, 1388, 1391
Default 1388, 1391
Cost Basis 770, 870, 1369
Coupon 746-747
Create a Generic Button Set 309
Create an Asset-Type Specific "Auto" Button Set 310
Create an Instrument-Specific Button Set 311
Create audit trail configuration 1336
Create Group Header 1480, 1499
Create Multiple Algo Orders 454
Create Option Spreads 382
Create Order Presets 1439
Create Orders 254, 314, 370, 375, 395, 1552
Create Portfolio Page 860
Create Shortcut 1342
Create Ticker 858
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Create TWS Window Groups 70
Crossfinder 487
crosshair 921, 1029, 1044
Crosshair 1159
Switch 1159
Crosshair Mode 1415
Csv Excel 928
Csv file 239, 373, 730, 929
Cumulative Bid 246
Currency 752, 769
Trading 769
Currency Conversion 851
Current 371, 843
Current Ask Yield 786
Current Available Funds 847
Current Bid Yield 786
Current Conditions 351, 643
Current Conditions list 351, 643
Current Excess Liquidity 847
Current Initial Margin 844
Current Key Shortcut 1342
Current Language 1339
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Current Maintenance Margin 845
Current Price 828
Current Security 1153
Curve plot 1082
Cushion 883
CUSIP 747, 785, 1356
Custom 1045, 1153
using 1045
Custom Columns 864, 1341
Custom indicators 1184
Custom Scenario 1045, 1047
create 1046
Custom Scenario Examples 1047
Customer Service 257, 1476, 1485, 1495, 1514
Customer Service Chat 1476, 1495, 1514
Customer Service Info 1476, 1495, 1514
Customize Layout 407, 669, 767, 824, 867, 1394, 1398, 1460
D
Daily 347, 412, 695, 830, 869, 1353
Daily or Annual 324
DARK BLUE 877
DARK GRAY 875
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Dark Green 769, 878
Dark ice 434
Dark Ice 434
Dashboard 904
Data Source 768
Day 334, 348, 398, 412, 696, 699, 1430
Day Trades Left 849
DDE 1359
Decrease Bar Width 1162
Decrease BookTrader Order Size 254
Decrease Price 255
Deep Book 262, 1379, 1408
Deep Book Buttons 262, 296, 303, 1408
Use 261
Deep Button 246, 305
Default 347, 412, 695, 1374, 1388, 1390-1391, 1399, 1404, 1406, 1443, 1456, 1459
Alerts 1403, 1405
Bid 1444
change 1388, 1391
copying 1388, 1391
Size Limit 1456
Total Value Limit 1455
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VOL 346, 411, 695
Default Allocation 1566, 1572
Default Allocation window 1568, 1572
Default Clearing 1569
Allocation Profiles 1569
Default Column 864, 1341
Default Display Settings 1457
Default give-up 1542
Default order 1439
Default Settings 1428
Define 448, 452, 663, 1236, 1431
Algorithm 448
Stop Price 663
Define Algo Conditions 452
Define algo parameters 448
Define Order Preset Values 1442
Define Precautionary Settings 1455
Delay in submitting order 448
Delayed market data 743
Delete 1178, 1360
Fibonacci 1177
Delete a Model 1602
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Delete Dividend 736
Delete Lines 713
Quote Monitor 711
Delete Rows 256, 714, 1480, 1496, 1499
Delete Timeout 1404, 1406
Deliverable Value 362, 370
Delta 582, 653, 655, 941, 1009, 1048
Delta Hedge 348, 413-414, 674, 697
attach 348, 413-414, 674, 697
Delta Hedge Order 414, 674
Attach 414, 674
Delta Neutral 268
DeMark Pivot Points 1209
Departure Chart 1227
DepthTrader window 1409
Description 253, 327, 380, 746, 1118, 1363, 1386, 1393
Displays 255
Destination 70, 215, 220, 399, 827, 851, 1430
using 215
Destination list 301, 400
Use 301
Destination window 70, 394
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Detail 720, 1359
API 1358
Determine Order Quantity 360
Detrended Price Oscillator 1226
Differentiate 1009
IB Risk Navigator 935, 955, 963, 970, 977, 986, 1004
Diluted Earnings Per Share 792
Dimensions 942
Use 941
Directed 217, 664
selecting 217
Directional 1185
Directional Index 1186
Directional Indicators 1186
Disabled Items 730
Discard 224
Disconnecting 1359
API 1358
Discontinued Operations 791
Discretionary 244, 682
create 683
Display 682
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Discretionary Amt 683, 828
Discretionary Order 682
Display ChartTrader button 1419
Display Deep Book 1408
Display Deep Book Buttons 1378, 1408
Display Market Data Columns 1393
Display model history in Model Navigator 1071
Display Model Navigator fields on a trading page 1071
Display Order Management Columns 1396
Display Orders 404
Display Quote 326, 1384, 1386, 1408
Display Setting 1457
Display Size 434, 645, 828, 1380
Show 645
Display Statistics 327, 1386
Display TWS 1477, 1496, 1515
Display TWS Messages 1349
Distribute 315, 446, 450, 452, 454, 456, 1375, 1476, 1495, 1514
Distribute window 447
Distribution 1188, 1204
Distribution Line 1188, 1204
Div Per Share 1123
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Divergence Indicator 1264
Divest Funds from a Model Portfolio 1594
Dividend Amount 736
Dividend Date 737
Dividend editor 735
Dividend Editor 735
exit 737
Dividend Offset 1080
Dividend Payables 843
Dividend Schedule 1078-1079, 1499
Dividend Schedule Editor 1079
Dividend Schedule Navigator 1079, 1081
Dividends 357, 1079, 1081
select 1081
DLV 371, 376, 1553
dividing 371, 376, 1553
DLV Amount 362
DMI 1186, 1228
DMI Indicator 1184
Donchian Channel Width 1231
Donchian Channels 1229
Double exponential moving average 1232
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Double Last 1463
DQUOTE 649
Draw Chart 1178
Drill Through 997
Dual fx presentation 851
Duration 383, 1404, 1406
DVO1 785
DVPs 849, 855
initiates 858
Dynamic colors 1395
E
Early exercise 1520
Earnings 179, 258, 1093, 1122
displays 255
Price 1118
Earnings Call Information icon 181, 1096
Earnings estimates 179, 1093
Earnings Per Share 791, 1117
rate 791
Ease of Movement 1233
Ease of Movement indicator 1233
Edit 265, 284, 400, 711, 721, 998, 1029, 1075, 1077, 1081-1082, 1135, 1163, 1358, 1376, 1388, 1391,
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1401, 1556, 1564, 1572
Charts 1163
choosing 1075
Lending Yield 1081
Page Layout 1391
Quote Monitor 711
Share Allocation Profile 1564
Volatility Profile 1082
Edit Beta Calculation Method 1021
Edit Chart 1160
Edit Combo button 619
Edit dividend schedule 735
Edit Dividend Schedule 735, 1481
Edit Dividends 1079
Edit Dividends in Model Navigator 1079
Edit Interest Rates 1078
Edit Interest Rates in Model Navigator 1078
Edit menu 368, 388, 586, 635, 733, 738, 743, 747, 751, 902, 904, 1029, 1062, 1077-1079, 1147, 1163,
1184, 1188, 1195, 1201, 1204, 1225, 1236, 1238, 1252, 1263, 1267, 1274-1275, 1282, 1290,
1292, 1297, 1300, 1309, 1322, 1325, 1335-1336, 1339, 1341, 1347, 1349-1350, 1352, 13551356, 1358, 1361, 1365-1366, 1373, 1377, 1382, 1387-1389, 1391, 1399, 1403, 1405, 1407,
1409, 1411, 1413, 1428, 1431, 1461, 1465, 1480, 1516
IB Risk Navigator 584
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Edit the Volatility Profile 1082
EFP Columns 830
EFP Futures Spreads 285, 380
EFPs 241, 266, 270, 283, 286, 382, 618, 826, 830-831, 1125, 1131, 1358, 1428, 1488
create 270, 285, 381
Elder-Ray Indicator 1234
Election 826, 829
reflects 826
EMA 1201, 1238, 1251, 1263, 1300
Email 862, 881-883, 886, 888-889, 891, 893, 895
Enter 864
Email Trade Reports 862
Email trades 863
Enable 733, 1349
Quick Stock Entry 733
TWS 1349
Enable Active 1359
Enable DDE 1359
Enable features 1467
Enable Features through Menus 1467
Enable News 1134
Enable Quick Stock Entry 734
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End time 450
End Time 432, 434-436, 441-442
Enter an order 75, 219
Enter Orders using Rapid Order Entry 364
Envelope 1236
EOD 432, 434, 445
EPS 1122
display 1119
EPS Growth 791
EPtradex SARt 1275
Equation builder 1114
Equity 793, 841
Equity Options Margin Requirements 270
ESignal 772, 779, 805, 1355
connect 1355
Host Address 1355
Use 1355
ESignal application 1355
install 1355
ESignal Market Data 1355
EST 451
Estimated for 324, 784, 1125
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Estimated Price Range 1150
ETF 673
Events 179, 1093, 1350
Assign Sounds 1350
Events calendar 179, 1093
Events Calendars 179, 1093, 1489
view 180, 1094
Excel 371, 730, 737, 864, 928
Create 928
Excess Liquidity 846
Exchange 266, 283, 285, 380, 400, 682, 730, 1124, 1393
Futures 266
Physical 285, 380, 1125
Using 283
Exchange Listed 786
Exchange Rate 850
Exclamation point in P&L 770
Excluded Quotes 1432
Excluding 791
Executing 750
transaction in 750
Execution 273, 287
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Execution Style 494
depending 494
Execution Window 273, 1361
Legs 272
Exercise 1520
Exercise Options 1520
Existing Position 611
Exit 721, 737, 1347
Dividends Editor 737
Exit Edit 1085
Exit Options 1347
Exp 700, 827, 1007
Exp Mov Avg 449
Expand 740, 907, 1073, 1409, 1499
News Configuration 1409
Order 738
Order Presets 701
Expired 1155
Expired Contracts 1155
Charting 1155
Expiring Futures Contracts 1516
Automatic Rollover 1516
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Expiry 366, 1082
enter 364
Expiry is 1125
market implied volatility for 1125
Exponential 1236
Exponential Moving Average 1238, 1251, 1264
Export 371, 731, 1339
exist 372
Rebalance file 371
Export icon 371
Export Positions 371
Rebalance 371
Export Today's 864
Export Trade Reports 864
ExpV 1046
Extended Form 864, 1341
Extension 1177
F
FA 1546
Fast Stochastic Oscillator 1239
Feature Search 727
Use 727
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Feature Selector 769, 1465, 1467, 1481
includes 1481
Open 1465
using 1466
Features 1134, 1465
Features Poll 1476, 1495, 1514
Use 1476, 1495, 1514
Federal Regulation 842
applying 842
Fee Rate 1371
Fibonacci 1177, 1417
delete 1178
Fibonacci Pivot Points 1211
Fibonacci Retracement 1177
Field headings 1460
File menu 574, 720, 731, 860, 1152, 1154, 1478
Use 1478
File Name 929
Filename 865
Fill 354, 616, 688, 701, 703, 833, 1364
Sweep 688
Fill outside of regular trading hours 448
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Fill/trigger 701
Filled Initial Component Size 611
Filter 145, 218, 382, 404, 1115, 1395, 1398
Find 405
Use 146, 405, 1116, 1395, 1398
Filter Criteria 404
final and cannot be canceled 1519
Find 405, 729, 1338
Filter 404
Fixed Income Minimum Size Increment 1368
Fixed Value 382
Float 489
Floor Pivot Points 1213
FOK 241, 701, 704
Font 1365
Font Size 1374
FOPs 850, 1074
For You Notifications 880
Force 220, 254, 368, 396, 398, 595, 599, 604, 609-610, 699, 702, 704, 827, 1343
Orders 699
Force Columns 827
Force Fields 241
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Forex 286, 729, 752, 858, 1418
Midpoint 1418
selecting 753
Use Quick Data 729
Forex Products 754
see 752
Forex Size Display Settings 1369
Forward Rate 1079
Fox River Alpha 459
Fox River Blaster 462
Fox River Dark Attack 463
Fox River Dark Sweep 458
Fox River Pyramid 465
Fox River Smart Router 469
Fox River Spotlight 471
Fox River TWAP 474
Fox River VWAP 481
Fox River VWAP Enhanced 479
Free Delayed Data 743
clicking 743
Freeze 584
elected 584
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Freeze Updates 583
Friends and family 1546
Front 383
Column Variable 383
FTP away 1531
FTP file instructions 1531
Funari 643
Functions 261
BookTrader 261
Fund Value 841
Fundamentals 197, 200, 796, 1091
Future EFP 273
Future price 1125
Futures 266, 270, 274, 283, 729, 942, 958, 965, 972, 978, 990, 1155, 1458, 1501
Exchange 266
Physical 283
Futures Delta 1009
Futures Open Interest 783
Futures rollover 1516
Futures Settlement 843
Futures Spreads 270, 377, 618
Futures Term Structure 1056
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FX 288, 676, 730, 752, 838, 849, 851, 1359, 1488
display 1486
Enter 730
sell 853
submit 855
want 855
FX Hedge order 676
FX icon 676
FX Matrix 131
FX Order 676, 1505
Attach 676
FX Portfolio 851
condense 851
FX Trader 256, 288, 854, 1384
configure 288
FXCONV 850-851
use 851
using 850
FXTrader 287-289, 752, 1382, 1488
set 288
Using 289
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FXTrader icon 289
Trading toolbar 289
FXTrader menu 1384
FXTrader toolbar 1384
FXTrader Trading Cell 288
FXTrader Window 286-287
G
Gainers 146, 1116, 1118
Gamma 582, 941, 1010
GAT 700, 703
General configuration 1336
General Configuration 1336
Generic Combo, 273, 1496
Give-up 1539-1540
Give up 1541
Give up if conditions are false 452
Global Configuration 220, 249, 346, 366, 368, 390, 393, 397, 408, 411, 635, 638-639, 658, 695, 721,
735, 740, 744, 855, 902, 904, 1135, 1160, 1166, 1335, 1340, 1342, 1347, 1349, 1352, 1355,
1357-1358, 1361, 1365, 1376-1377, 1384, 1387, 1389-1390, 1392-1393, 1396, 1399, 1401,
1403, 1405, 1407, 1409, 1412-1413, 1429, 1432, 1461-1462, 1466, 1481, 1517, 1541-1542,
1556, 1571
Global risk in Risk Nav reports 1017
Good After Time 702, 827
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GPV 842
Grab chart 1146
Graphic Change 805
Graphic Prices 804
Greeks 317, 584, 1009, 1486
view 317
GREEN 258, 874-875, 878, 909
Gridlines 1365
showing 1365
Gross Position Value 849
Group 70, 242, 394, 839, 998
display 394
Select 71
using 767
Group header 721
Group Header 721
Create 721
Group icon 71
Group list 71
Group Name 352
Growth Rate 1122
GTC 241, 398, 595, 599, 604, 609-610, 700, 902, 1430
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GTD 241, 398, 700, 827
Guerrilla 494
H
Header Field 240
Header row 721
Hedge Aux 348, 413, 696
Use 347, 412, 695
Hedge Aux Price 830
Hedge Auxiliary Price 418
Use 417
Hedge Delta 418
Hedge Order Type 346, 411, 418, 695, 830
Select 416
HedgeAuxPrice 243
HedgeOrderType 243
Hedging 416, 925
Display 925
Hedging Ratio 678
enter 678
Heikin-Ashi 1136
Help Chat 257
Help menu 1494
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Hidden 684
Check 684
create 684
Display 684
Hidden Feature 238
Hide Indicator 1165
Hides 294, 1062, 1157
Arbitrage Meter 1062
Quote 294
Volume 1159
Hierarchy 1436
High 259, 1118, 1185, 1276, 1322, 1380
High Dividend Yield 1119
High Growth Rate 1122
High Low Bands 1243
High Low Bar 1136
High Opt Volume 1121
High Option Imp Vol Over Historical 1117
High Option Open Interest 1121
High Price 1124
High Quick Ratio 1123
High Return on Equity 1123
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High Synth Bid Rev Yield 1124
High/Low 1140
High/Low/Volume 775
Highest Option Imp Vol 1120
Historical Vol 324
Historical Volatility 1136
Hollow candles 1136
Home Exchange 1368
Home Exchange Group 1368
Set 1366
Hot Buttons 1168, 1173, 1415
Hot Contracts 146, 1116, 1119
Hot Keys 368, 1342
Hotkeys 368, 1341, 1378, 1403, 1405
Hour 703
I
IB OMS 385, 403
IB Risk Navigator 257, 583-584, 742, 913, 928, 935, 942, 955, 963, 970, 977, 986, 1004, 1493
differentiate 1009
Edit menu 586
Open 913
IB Risk Navigator's Portfolio Relative 741
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IB Risk Navigator Reports 995
IB Risk Navigator window 1030
IB SmartRouting 1431
IBAlgos 433, 435-436, 441, 443, 445
IBDARK Order Destination 644
IBEFP 240, 286, 382
IBExecution Services 1540-1541
Order Ticket 1540
IBKR Quant 194
Iceberg 244, 645
create 244, 645
Iceberg/Reserve 645
IDEALPRO 855
selecting 855
Ignore Opening Auction 1433
Imbalance 355
Immediate 701, 832
support 832
Immediate-or-cancel 355, 451, 1453
Imp 1071, 1087
select 1072
Imp Vol 348, 412, 417, 696, 784, 1072, 1075, 1081, 1087
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Implied Vol 783
Closing 783
Implied Vol Calculations 1076
Implied Volatility 346, 411, 416, 676, 695, 1077, 1082, 1120
Implied Volatility Viewer 1064
Import 371, 730, 928
display 731
Import icon 374
Import indicators 1184
Import Tickers 730
Import/Export 1478
Increase 1118, 1343
Increase Bar Width 1162
Increase BookTrader Order Size 254
Increase Memory Size for TWS 929
Increase Price 255
Increment 448
Increments 448, 451, 739
Index 1062, 1159
Compare 1159
Index Arb 1133
Index Arbitrage Meter 1062

TWS Guide

1662

Chapter 1

Index

Index Correlated Price Estimate 944
Index Option 347, 412, 696
Index Price 1133
Indicates 876
BUY 876
SELL 876
Indicators 1186, 1196, 1229, 1231-1232, 1234, 1243, 1253, 1265, 1270-1271, 1285, 1302, 1304, 1315
Industry 925, 936, 949, 977, 987, 998
Industry Editor 998
Use 998
using 998
Industry Editor Edit menu 998
Use 998
Industry Report 936, 949, 977, 987
Initial Component 600, 603, 615
Initial Component Size 600, 603, 610-611, 616, 618, 1447, 1449
set 618
use 600
Initial Margin 847
Initial/Subsequent Component Size 595, 599, 604, 609
Initiate 359, 635, 644, 650, 652, 657, 666-667, 858
BUY 635, 649, 651, 656
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DVP 855
SELL 635, 649, 651, 657, 665, 667
Insert 711
Market Data 711
Insert Dividend 736
Insert row 1480
Insert Row 713, 1480, 1499
Install 1355
eSignal application 1355
Instantaneous Order 266
Instantaneous Transmit 297, 306, 368
Instantaneously Transmit 297
set 297
Instrument 145, 283, 1115, 1117
Instrument-level 1441
Instrument Type 745, 1441
Instruments list 1117
Integrated Stock Window 256, 1487, 1506
Interest 832
Interest Rate 1077-1078
modify 1078
Interest Rate Navigator 1078
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Interest Rate Offset 1079
Intermarket 274
Intraday Intensity 133, 799, 1250
Intraday Intensity % 1248
Intraday Intensity Percent 1248
Invest in a Model Portfolio 1584
Invest in multiple models 1591
Investment 1591
Investment Allocation Within a Single Model 1591
IOC 241, 355, 398, 451, 701, 832, 1453
becomes 355, 1453
IP 1359
IR 1079
Iron Condor 268
ISE 282, 312, 682, 731, 908
ISE Midpoint Match 354
ISE MPM 832, 1453
ISE Order Type 832, 1453
ISE Stock Exchange 831
ISLAND 651-652, 730, 733
routed 651-652
Issue Date 746-747
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ISW 246, 256, 297-298, 304, 1506
ISW Buttons Panel 297
ISW Configuration Settings 295
ISW Order Entry Sub Panels 301
J
Java 1359
including 1359
JEFFALGO 549, 552, 557, 561, 564
Jefferies 549, 552, 557, 561, 564
Jefferies Seek 546
Jefferies strike 550
Jefferies TWAP 554
K
Keep on top 1336
Keltner Channel indicator 1251
Keltner Channel Indicator 1251
Know Sure Thing Indicator 1253
KST Indicator 1253
L
Lane's Stochastic Oscillator 1256
Large font 1365
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Last 259, 366, 441, 752, 772, 804, 897, 1344, 1368, 1380, 1444
Matching 441
Last price condition 452
Last settlement 850
Last Size 774
Last Spinner 805
Last Trade Price 449
Last Yield 786
LastTradePrice-prevClose 1119
Layout 1388-1389
Layout Editor 1399
using 1399
Least Square Indicator 1260
Leaves 398
Left 297, 1047
Scenario Editor 1046
Leg 266, 272, 274
Execution Window 273
Pair 267
Leg Combo 277
Leg Query 273
Leg Type 276

TWS Guide

1667

Chapter 1

Index

Lending yield 1081
Lending Yield 1081
Edit 1081
using 1081
Level 262, 295, 303, 1359
Logging 1359
Level II 295, 298, 303, 1486
Lieu 357, 843
Dividends 357
LIGHT BLUE 874, 877
LIGHT BROWN 876
LIGHT GRAY 877
Light Green 769, 878
Limit 251, 302, 366, 448, 626-627, 635, 646, 649, 655-656, 667, 669, 671, 738, 826, 1443
applied 302
Check Convert Market 366
create 626-627, 738
Enter 635
including 826
Trailing 669, 671
Trigger Price 1446
Limit-On-Close 628
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Limit-On-Open 706
Limit Offset 667
Limit order 637
Limit Price 398, 666, 1344, 1448
Limit price calculation 448
Limit Price OR Limit Offset 667, 670
Limit, Market 416, 676, 926
Line 297, 377, 1150, 1554
OEP 297
Rebalance window 376, 1553
Line Chart 1176
Create 1176
Linear Regression 1258-1259, 1261-1262
Linear Regression Indicator 1260
Lines meet at 1150
Link Blotter 394
Use Windows Grouping 394
Links 179, 325, 1093, 1385
Order Ref 327, 1386
Liquidate Last 854, 857
LIT 627, 635, 1430
LMT 241, 251, 261, 449, 614, 627, 634, 646, 655, 706, 826
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Lmt Offset 667, 669, 828
Lmt Price 627, 635, 738, 752, 1344
LmtPrice 241
Load 319, 1520
Option Chains 319
Load Template 452
Load the closest N strikes to the money 327, 1387
Loan 1488
Loan Market 356
Loan Value 841, 847, 884
LOC 628
create 628
Local Symbol 865
Location 1117
Lock 721, 1347
Use 1347
Lock Application 1348, 1479
selecting 1348
Lock Trader Workstation 1347
Log 257, 264, 447, 1139, 1359
Clears 257
Level 1359
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Log In
TWS 57
Logging Level 1359
Use 1358
Logic 883, 885, 887, 889-890, 892, 894, 896
Login 1062
Long Position 1557
LOO 700, 706
create 706
Look Ahead Available Funds 848
Look Ahead Excess Liquidity 848
Look Ahead Initial Margin 845
Look Ahead Maintenance Margin 845
Look Ahead Next Change 848
Losers 1118
Low Dividend Yield 1123
Low Growth Rate 1122
Low Opt Volume 1121
Low Option Imp Vol Over Historical 1117
Low Option Open Interest 1121
Low Price 1124
Low Quick Ratio 1123
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Low Return on Equity 1124
Low Synth Bid Rev Yield 1125
Lower Band 1236
Lowest Option Imp Vol 1120
M
MA 1236, 1263
MACD 1263
MACD Histogram 1264
MAGENTA 874
Maintenance Margin 884
Manage 403
Blotter 404
Manage Orders 396, 403
Mandatory Columns 826
Manual 735, 1077-1079, 1083
Select 1078-1079
Manual Allocation 1568-1569
select 1569
Manual File 1520
Manual Order Time 1538
Manual Ticket Entry 387-388, 391, 394
Blotter 394
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using 387
Manual Vertical Scale 1137
Manually Create 238
Basket File 238
Margin 840, 843, 871
Margin Account 841
Margin Alerts 883
Margin for single position 726
Margin requirements 726
Margin Requirements 843
Use 843
Margin Sensitivity 994
Margin Trading 854, 857
Marginable Equity 841
Mark Price 449, 774
Market 255, 388, 629-630, 646-647, 650, 658, 668, 671-672, 739, 1446
Change Order 255
create 629-630
Trailing 668
Market-On-Close 630
Market-on-Open 705
Market-to-Limit 631
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Market Cap 792
Market Data 215, 303, 711, 875, 908, 1071, 1355, 1371, 1387, 1393, 1409, 1499
drop 711
insert 711
see 304
Use eSignal 1355
Market Data Colors 258
Market Data Columns 409, 1393
Use 1391
Market Data Fields 766
Market Data Line 875, 1499
Background colors 875
Right-click 1499
Market Data Subscription Manager 1484
Market Data Subscriptions 1484
Market Depth 246, 256, 303, 312, 1407, 1467, 1486
transmitting 312
Use 1407
Market Depth Buttons Panel 306
Market Depth menu 1407
Market Depth toolbar 1408
Market Depth window 303, 312, 873, 879, 1467
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Market implied volatility for 1125
expiry is 1125
Market Price 853, 856
Market Scanner 283, 1115, 1118, 1126, 1490
Create 1115
Market Scanner Parameters 1118
Market Scanner Types 1117
Market Scenario 1045, 1048
adjoining 1048
Market Scenario Drill Through 997
Market statistics 143
Market Statistics 1124
Market Value 376, 722, 770, 849, 851, 856, 869, 1369, 1387, 1553, 1591
including 722
refer 854
MarketWatch Chart 1178
MAROON 879
Mass Index Indicator 1265
Master 376, 839, 861, 1553
including 839, 860
Master API 1359
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Matching 441
Last 441
Midpoint 441
Same Side 441
Maturity 746-747, 914, 940
use 746
using 747
Max 146, 1117
using 146, 1117
Max Percentage 432, 434, 442-444
Measure 585, 914, 933-934, 936-937, 940-941, 947, 950, 953-954, 956, 961-963, 968-970, 975-978,
985, 987-988
Portfolio 933, 953, 961, 968, 975, 985
Risk 934-936, 947, 949, 954-955, 962-963, 969-970, 976-977, 985-987
view 941-942
MEDIUM BLUE 875
Menu bar 905
Menus 1469, 1478
Merger Arb 314
create 314
Merger Arb window 1487
Use 1487
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Merger Arbitrage 314, 1487, 1498
Merger Arbitrage Window 314
Use 314
Messages 855, 1349
using 1349
Method 242, 881, 1168
Metrics 925, 935, 937, 948, 950, 955, 962-963, 969-970, 976-978, 986, 988, 1004
Middle 1426
Select 1427
Middle Line 1251
Midnight when 1431
Midpoint 366, 441, 651, 1136, 1418
Forex 1418
Matching 441
Pegged 651
Midpoint Match 832
MidPrice 632
Min Quantity 648, 828
Show 648
Minimize Impact 443
Minimum Quantity 647
create 648
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Use 647
Misc 1540
Miscellaneous 352, 681, 1434, 1461
Use 352
Miscellaneous Defaults 1451
Miscellaneous Fields 243
Mistrade Request Form 1484
Mistyped 1455
MIT 630
MKT 243, 449, 614, 629, 646, 658, 671-672, 705
MKT PRT 647
ML 1202
MM 701, 827, 1341
MMM 733
MOC 630
create 630
Model 1071, 1074, 1077, 1081-1082, 1086
calculate 1077, 1082
Model History 1084
using 1082
Model IV 784
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Model Navigator 257, 1071, 1074-1075, 1077, 1081-1082, 1491
open 1071
Model Navigator change pricing assumptions 1082
Model Navigator window 257, 1074
Model Portfolio Share Allocation 1591
Model Portfolios 1581, 1591
Create 1581
Model Price 1078
Model Price Color Key 1086
Modify 221, 235, 351, 455, 642, 658, 1045, 1078, 1344, 1384, 1461, 1571
Algo 455
Date 1046
Interest Rates 1078
Multiplier 235
Order 221
Price 1046
Stop Trigger Method 1461
Modify Multiple Orders 366, 1483, 1510
Modify Order Type 255, 1345
Modify Rapid Order Entry Settings 1400
Modify Time 255, 1345
Modify/Transmit Orders 255
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Momentum 1267, 1290
Momentum Indicator 1267
Monitor 456
Order Progress 456
Months whose 328, 1387
MOO 700, 705
create 705
Moody's 747
Mosaic font size 1366
Most Active 1118
Mouse Shortcuts dialog 1378, 1403, 1405
Mov Avg 449
Mov VWAP 449
Move 448, 453, 615, 721, 1166, 1236
Average 1236
Bottom Price 614
Pending 721
Quote Monitor 721
Right Margin 1166
VWAP 449, 454
Move Down 1374
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Move Up 1374
using 1374
Moving average condition 452
Moving Average Convergence 1264
Moving Average Convergence/Divergence 1264
moving average indicators 1232
Moving Standard Deviation 1270
Moving VWAP condition 452
MPID 242
MS Excel 237, 373, 730, 737, 864
MTL 631
Multiple 267, 274
Use 274
Multiple Clients 1546
Multiplier 235, 730
Modify 235
Muni 748
Select 749
Munis 749
Mutual Fund Replicator 1107
Mutual Fund Selector 752, 1480, 1498
Mutual Funds 751
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Mutual Funds icon 751
Mutual funds to ETFs 1107
My Last Trade 449
My Portfolio 179, 586, 1093
N
Name - Description 1414
National Best Bid 649, 651, 656
NBB 243, 349, 413, 418, 649, 656, 697, 1353
use 417
NBBO 345, 595, 599, 604, 609-610, 649, 651, 653, 656, 830-831, 1431
added 651
Define 1431
NBO 243, 349, 413, 418, 649, 656, 697, 1353
Nearest Valid Price 1458
Negative Percent 1557, 1568
Negative Volume Index Indicator 1271
Net Liq 371, 375, 1552
Net Liquidation 362, 847, 1557, 1567
Net Liquidation Value 362, 371, 373, 375, 841, 850, 884, 1552
NetLiq 242, 1557, 1567
Neutral 243
New Chart 263, 1145, 1157, 1170, 1175-1176

TWS Guide

1682

Chapter 1

Index

New Chart window 257, 1170
New Position 869
New Tab icon 319
News 188-189, 1409
News condition 452
News Configuration 1409
expand 1409
News Suppliers 1409
News Time 769
News Title 769
News Topic Chooser 1489, 1498
News Topics 1492, 1498
Next 865, 883-885, 887-888, 890, 892, 894, 896
Next button 382
Hit 383
Next Expiry 1501
Next Strike 1502
NLV 362, 371, 373, 376, 1553
NLV calculation 1026
Non 266
Create 264
Non-Cleared Fields 242
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Non-Guaranteed 354, 832
Non-subscribed scanner 1130
Non-Subscribed Scanner Locations 1130
Non Group 1558
select 1555
Non Group Account 1558
None 261, 354, 681, 832, 1149, 1344, 1404, 1406, 1417, 1445, 1448, 1450, 1458
Round 1458
Not Available 791
Notes 246, 747, 768, 1481, 1498
Notes on Combination Orders 282
Notified 359
Num Ticks 1344
Enter 1343
Set 1343
NYSE Closing Auction 649
NYSE Retail Liquidity Program 659
NYSEFLOOR 649
O
OATs Order Time Reporting for Manual Orders 1538
OBV 1274
forms 1274
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OCA 298, 352, 639, 687, 1454
create 687
handling 352
part 354, 687
rules 352
transmit 688
OCA Group 352, 639, 687, 832
display 639, 687
OCA Group Defaults 1454
OcaGroup 244
OCO 685
OEP 297-298
line 297
Offer 649, 651, 656
Offered/available 688
Offset Amount 826, 1444, 1448
Relative 826
Offset Price 650
Offsets 416, 1172
autofits 1172
Relative 418
OMS 385
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On Balance Volume 1274
On Balance Volume Indicator 1274
One-Cancels-All 687
One Cancels Other 685
Online Users 1476, 1495, 1514
Opaque Positions list 943, 959, 966, 973, 979, 991
Open BookTrader 245
Open Chart Template 1155, 1157
Open ChartTrader 263
Open Interest 783, 1136
Open Interest Change 324
Open Message Center 1476, 1495, 1514
Open ScaleTrader 341
Open Settings File 720, 1479
Open SpreadTrader 377
Open the Model Navigator 1071
Open Window 729
Open/Close 832, 1452
OpenClose 242
Opening 371, 616, 720, 832, 860, 913, 928, 1120, 1387, 1415, 1465, 1503, 1540-1541
Chart Parameters window 1415
Feature Selector 1465
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IB Risk Navigator 913
Order Ticket 1506
Order Ticket window 832
Orders 1387
Trades 1387
Use 1540-1541
Opens TWS Javahelp 1476, 1495, 1514
Operator 881, 883-885, 887, 890, 892, 894, 896, 1168
OPG 241, 398, 700, 705-706
OPT 731
Opt Implied Vol 324
Opt Open Interest 324, 1117
Opt Volume 324, 1121
Opt Volume Change 324, 784
Option Analytics 257, 1053, 1354
Option Analytics Window 1053
view 170, 175, 1054
Option Bid 785
Option Chains 319
Loading 319
Option Combos 382, 618
XXX 383
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Option Exercise 1483, 1510
Option Exercise window 1483, 1510, 1520
Option Implied Volatility 1136
Option Model Editor 784
using 784
Option Open Interest 1136
Option Portfolio 574, 582, 584, 1488
Option Portfolio window 574
underlying 574
Option Pricing 908
Option selector 128
Option Spreads window 383
Option strategy lab 167
Option Strategy lab 161
Option Trader toolbar 326, 1386
Option Value Curve 1354
Option Volume 1121, 1136
Option Wizard 382
Optional conditions 452
OptionPrice 268
Options 247, 327, 364, 443, 729, 744, 783, 942, 958, 965, 972, 978, 990, 1386, 1433, 1541-1542
applies 443
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Expand 1073
Routing 1431
Use Quick Data 729
Options Colors 1365
Options Setting 365
Options Settlement 843
Options Spread Matrix 383
create 382
Options Strategy 1434
Options using SmartRouting 908
Best Price 908
Options Wizard button 384
toolbar 383
OptionTrader 219, 256, 317, 325, 394, 729, 1072, 1075, 1385, 1488, 1501
OptionTrader automatically loads option chains 327, 1387
OptionTrader Configure menu 323
OptionTrader menu 326, 1386
OptionTrader Statistics 323
configure 323
display 323
OptionTrader toolbar 323
OptionTrader window 317, 395, 729
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ORANGE 874, 878, 909
Order Attributes 681-682, 684, 831
Order Attributes Columns 831
Order Attributes list 645
Order Columns 362, 407, 409, 655, 669, 1376, 1381, 1393, 1397, 1405, 1407
use 667, 669
Order Confirmation 253
Order Defaults 667, 670, 1541-1542
Order Display 1414
Order Entry Panel 298
Use 298
Order Entry window 75
Order ID 862
Order increment 448
Order Line 674, 676-677, 1541
Order Management 119, 283, 362, 365, 824, 876, 1387, 1396, 1503
Order Management Fields 824
Order Management line 639, 876, 1503, 1541
Background colors 876
create 640
Right-click 1503
Order Origin 1453
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Order Presets 325, 639, 701, 1385, 1439, 1460
using 639
Order price 448
Order Progress 456
Monitor 456
Order quantity 448
Order Quantity 361, 398
Order Ref 327, 353, 862, 1386, 1453
link 327, 1386
Order Reference 241
Order Row 1400
Order Selection 314
Order Sharing Modes 406
Order status 873, 879
Order Status Colors 876
Order Ticket 255, 611, 654-655, 704, 751, 862, 1434, 1461, 1501, 1506, 1540-1541, 1571
IBExecution Services 1540
Opens 1504
Order Ticket Scale 611
Order Ticket window 281, 832, 1497
opening 832
Order Type Select 261
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Order Types 219, 340, 398, 594, 598, 603, 608, 610, 627-632, 634-635, 640-641, 645, 647, 649-652,
654, 656, 664, 666, 668, 681, 684-685, 688-690, 692-693, 695, 703-707, 1341, 1443, 1448-1449
Adjust 338
Order Volatility 346, 411, 695
Order Wizard 1493
Orders 220, 223, 225, 235, 246-247, 250, 262-264, 286, 303, 306, 312, 327, 352, 361, 380, 382, 386,
389, 395, 397, 400, 404, 406, 415, 446, 598, 608, 611, 635, 638, 675, 699, 738, 742, 901, 1139,
1173, 1341, 1375, 1379, 1384, 1386-1387, 1391, 1396, 1405, 1407, 1409, 1427-1428, 1439,
1546, 1558
Blotter 388
Cancel 224
Client 404
Create 219, 312, 1546
Displays 264, 1138
Expand 740
Force 699
includes 447
Modify 221
Opens 1387
Pending 221
populate 1343
Transmit 222
Use 638, 1378, 1428
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Volatility 414, 674
Orders Page 901
Pending 901
Orders window 76
Orders, Log 287
OrderType 241
Organize Data 721
Page 721
Oscillator 1196, 1309, 1322
OSMA 1264
Other Layouts 1399
Others 262, 296, 303, 1143-1144
Use 1144
Others button 296
OutsideRth 244
Overfill Protection 356
Overnight Available Funds 848
Overnight Excess Liquidity 848
Overnight Initial Margin 845
Overnight Maintenance 848
Overnight Maintenance Margin 846
Ownership 200, 1091
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P
P&L 770, 868, 918, 945, 959, 966, 973, 1006, 1041
P&L calculations 870
P&L Pie Chart 945, 959, 966, 973
P&L Summary 991
P/E 792
Page 220, 688, 720-721, 1389
Organize Data 721
using 220
Page Down 226, 709
Page Layout 1381, 1388-1389, 1391, 1405, 1407
Create 1388
Edit 1391
Page Layout Manager 1400
Page Settings dialog 733
Page Up 226, 709
Pair 267, 272, 277, 612
Leg 266
ScaleTrader 612
Use 274
Pair trade 677
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Pair Trade 677, 1505
Attach 677
PALE PURPLE 877
PALE RED 876
Panels 1468, 1493
Parabolic SAR 1275
Parameter 145, 283, 1115
Part 354, 687
OCA 352, 687
Passive 243, 432, 434, 444, 494
Passive Relative 649
enter 650
PASSV REL 650
Pathfinder 503
Pause Execution 118, 1483, 1510
Pct Offset 650, 656
PctChange 242, 1546, 1557, 1568
choose 1546
PD 160
PEG MID 652
PEG MKT 651
PEG STK 653, 655
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Pegged 345, 416, 650-652, 656, 658, 676, 831, 1362
create 651, 653
Midpoint 651
range 831
Relative 658
Stock 345, 652
Stock Columns 831
supporting 653
Use 653
used 831
Pegged-to-Market 650
Pegged-to-Stock 831
Pegged Orders 345
Pegged to Benchmark 654
Pegged to Market order 691
Pegged to Midpoint order 692
Pegged to Primary 689
Pegged to Surface 694
Pegged to Surface Volatility Order 693
Pending 221, 223, 246, 712, 721, 768, 901, 1363
including 767
move 721
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orders 220
Orders Page 901
rename 712
Per Account 1573
Percent 1079-1080
select 1078-1079
Percent B 1279
Percent difference in price movement 452
Percentage 435, 1455, 1546, 1558
Like 1456
Volume Strategy 435
Percentage Column Calculations 1026
PercentOffset 241
Perfect Correlation 944
Performance 872, 1112
Performance Profile 872, 1112
Physical 266, 283, 285, 380, 1125
Exchange 285, 380, 1124
Futures 283
Pie Chart 945, 959, 966, 973
Pie Chart shows 945, 959, 966, 973
Pin first row 1016
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PINK 878
Pivot points 1282
Pivot Points 1282
add 1283
Populate 289, 1343
Order 1341
Orders 235
Quote Panel 289
Portfolio 226, 264, 287, 370, 375, 584, 710, 768, 855, 928, 933, 953, 961, 968, 975, 985, 1139, 1369,
1484, 1552, 1581
Creates 1484
measures 933, 953, 961, 968, 975, 985
Upload 928
view 933, 953, 961, 968, 975, 985
Portfolio Analysis columns 1007
Portfolio Analyst 1493
Portfolio Builder 135
Portfolio Events Calendar 180, 1095
view 180, 1094
Portfolio Margin 356, 837, 844
Portfolio menu 857, 928, 1029
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Portfolio Page 226, 710
add 226, 709
Portfolio Performance Profile 138
Portfolio Relative 742, 918, 1041
Portfolio Report 933, 953, 961, 968, 975, 985
Portfolio Statistics 914, 942, 958, 965, 972, 978, 990
view 943, 959, 966, 973, 979, 991
Portfolio Statistics Report 942, 958, 965, 972, 978, 990
Portfolio Value 943, 959, 966, 973, 979, 991
Portfolio window 77
Portfolio Window 226, 584, 709, 1387, 1484
Configure 1387
Position 283, 362, 450, 453, 611, 726, 770, 837, 851, 855, 869, 902, 934, 947, 954, 962, 969, 976, 985,
1005, 1368
Close Portion 858
displaying 902
Existing 611
remove 1005
Single Stock Future 283
View Margin Requirements 726
Position-related condition 452
Position Information 1384
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Position quantity
edit 1029
Position Report 934, 947, 954, 962, 969, 976, 985
Positive Percent 1557, 1568
Positive Volume Index 1285
Post 544
Post algo 544
Post only 1453
Post Trade Allocation 1541-1542
selecting 1541-1542
Power 846
Buying 846
Pre-Borrow Returns 359
Pre-Trade Allocations 1545
Pre-trade Give Up 1541-1542
Precautionary Settings 417
Preceding 700
Friday 700
Predefined Watchlist 121
Prefer SMART 1453
Preserve default allocation 1566
Preserve Time Priority 354
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Presets 220, 257, 261, 312, 701, 1430, 1436, 1439, 1459, 1462, 1506
configuring 262
Display 701
Preview 883, 885, 887, 889-890, 893-894, 896
Preview Orders 1503
Preview window 871
Previous Day's 864
Previous Day Equity 841, 848
Previous Expiry 1502
Previous Strike 1502
Price 146, 220, 281, 595, 599, 604, 609-610, 649, 656, 682, 737-738, 771, 881, 1046-1047, 1116,
1118, 1167, 1343, 1352, 1379, 1415, 1430
Earnings 1122
modify 1045
Starting 595, 599, 604, 609-610
Underlying 775
Price-based Columns 828
Price Change 914, 941
Price colors 1395
Price Field 259
Price Improvement Auction 655
submit 655
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Price Increment 595, 599-600, 604, 609-610, 614, 1447, 1449
Price Ladder 251, 1379
Price Ladder Order Control 1379
Price Ladder Status Column 1379
Price Monitoring 418
Underlying 417
Price movement alarms 897
Price Offset 1075
Price Offset in Model Navigator 1075
Price Range 1119
Price range condition 452
Price Wand 738
Price/Book 792
Primary Exchange 1402
Print account summary 837
Print Summary 840
selecting 840
Prior Day SMA 842
Probability Distribution 160
Probability Lab 159
Profile 872, 1112
Profit 595, 598, 600, 603, 868
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Profit and Loss 869
Profit Offset 610-611
Profit Orders 595
Progress 456
Accumulate 456
Propagate Settings 1437
using 1437
Protection 647, 663
PSE 908
Purchase 267
Buy Write 268
PURPLE 874, 877, 909
Purple order status 876
PUT 730
Put/call 1121
Put/Call Interest 784
Put/Call Open Interest 324
Put/Call Volume 324, 784
Puts 730, 785, 1402
checked fields 1402
IV 784
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Q
QB Bolt 564
Quantity 220, 361, 388, 397, 647, 738, 752, 1368, 1430, 1456, 1557, 1567
Quantity Columns 828
Quantity Type 361, 828
display 362
Use 361
Quantity Value 361, 828, 1430
Query List 583
Query Results 582
Constrain 582
Vega 582
Query Results list 576, 585
contains 585
hold 576
Quick Entry 1356
Quick list 1499
Quick menu 1499
Quick Ratio 793, 1123
display 1119
Quick Start Guide 1475, 1495, 1514
Quick Stock 733, 1356
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Quick Stock Entry 733, 1357
enabled 733
use 734
Quick Stock Entry Exchanges 735
Quick Stock Entry Exchanges button 733
Quote 263, 265, 294, 326, 380, 447, 455, 1174, 1384, 1386, 1408, 1415, 1427
hide 294
Quote details 129
Quote Details 1490, 1501
Quote monitor 226, 709
Quote Monitor 72, 118, 124, 180, 215, 219, 226, 238, 646, 659, 671-672, 709, 711, 719, 721, 728, 767,
824, 1073, 1081, 1094, 1109, 1142, 1145, 1368, 1486
Add 226, 709
Delete Lines 713
Edit 711
move 721
Quote Panel 289, 294, 318, 326, 380, 1138, 1375, 1381, 1386, 1408, 1411
Configure 1375
Quote zone 1426
Quote Zone 1135, 1415, 1426
R
Raff Channel 1288
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Randomize size 450
Range 346, 418, 805, 830-831
Pegged 831
Underlying 346, 417
Volatility 830
Range 3D 805
Range 3D Alert 805
Rapid Order Entry 364, 1347, 1400, 1493
configures 1402
displays 1402
make 1400
rapid order entry settings 1400
Rapid Order Entry Settings 1400
Rapid Ticket Entry 387
Rate 791, 1290
Change 1290
Earnings Per Share 791
Rate of Change 1290
Ratio 1120, 1171
use 1170
Real FX Balances 854
Real FX Position 849
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Reallocate all 375, 1552
Reallocate Client Funds Amongst Models 1599
Realtime Activity Monitoring 257
Rearrange Trading Page Columns 1398
Rebalanace 371
Rebalance 371, 375, 1552
Advisors 375, 1552
clicking 376, 1553
Export Positions 371
Use 369
Rebalance ALL 376, 1553
Rebalance file 371
export 371
Rebalance icon 377, 1554
attached 377, 1554
Rebalance multiple accounts 375, 1552
Rebalance Portfolio 370-371, 1488
Rebalance Portfolio window 370, 373
Rebalance Window 256, 371, 376, 1553
Add 375, 1552
contract 254
line 377, 1554
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Rebate Rate 1371
Recall
using 359
Receive 71
Receive Delayed Market Data 743
Receive Electronic Tickets 391
Recognia® Technical Indicator Data Points 763, 811
Record 1342
Buy 1341
RED 259, 874-876, 1174, 1368, 1380
Refer 854
Market Value 851
Reference Contract 348, 412, 418, 696, 1353
Reference Portfolio 583
Reference Price Type 346, 411, 418, 695, 830
Refit 1084
Refresh Intervals 1411
Regular Trading Hours 701
Reject 392
Reject All 392
Relative 302, 416, 418, 448, 652, 655-656, 658, 672, 676, 826, 926, 1445, 1449
enter 657
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offset 418
Offset Amount 826
pegging 658
Stock 652
Trailing 672
Relative Order Modification 658
Relative Strength Index 774, 805
Relative Strength Indicator 1292
Relative Volume 779
Relative Volume 3D 779
Relative/Pegged-to-Primary 656
Relevant EFPs 283, 1125
Relevant EFPs Market Scanner 283
Remove All Filled Orders 1506
Remove All Trendlines icon 1177
Remove Bar 1165
Remove button 1374, 1427
Use 1373, 1427
Remove columns 867
Remove Fields 72, 719
Remove Horizontal Space 1162
Remove Row 999
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Remove Selected 1079-1080
Remove Selected Trendline 1161
Remove Vertical Space 1162
Rename 712
Pending 712
Rename Page 226, 709, 712
Rename Relative 1362
Repeat Count 393
Replace Bar Data 1165
Replaceable 1155
Replicator 1107
Report 585, 933-936, 940-943, 947, 949, 953-955, 958, 961-963, 965, 968-970, 972, 975-978, 985987, 990
Report Metrics 1004
Report Selector 919, 940, 947, 961, 968, 975, 1026, 1041
Report Trade 399
see 402
Report Viewer 935-937, 941-943, 948, 950, 955-956, 959, 962-963, 966, 969-970, 973, 976-979, 986988, 991
Reposition 1146
Reposition charts 1146
Reposition Charts 1146
reposition columns 1398
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ReqAutoOpenOrders 1359
ReqOpenOrders 1359
Request 359
Request Ticker 711, 744, 1497
Request Trade Cancellation 258
Rerate
initiate 359
notified 359
request 359
Research analysis 204, 1089
Reserve 505, 645
Reset 277, 319, 1374
Reset Margin 1167
Reset Scenario 998
Reset Short Sell Locations 1430
Reset Subscription 744, 1371
Restart ScaleTrader 610-611
Activate 612
Restore 57, 605, 720, 1448
Restore Defaults 1426
clicking 1426
Restore Settings 1479

TWS Guide

1711

Chapter 1

Index

Restore Size 605, 608, 610-611
Resume if conditions become true 452
Retail Price Improvement 659
Retracements 1177
Return
using 359
Return on Equity 1123
Return Shares 359-360
Reuters 453, 1122
Reuters Fundamentals 257
Reuters News 1409
Reuters News Service 1409
Reverse 238
Reverse Position 255, 306
RFQ 750, 1483, 1498, 1510
Submit 750
Right-click 1496, 1499, 1503
Market Data Line 1499
Order Management Line 1503
right-click menu 1496, 1499, 1503
Right Margin 1166
Move 1166
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Risk 444, 584, 854, 857, 913, 925, 933-936, 943, 947, 949, 953-955, 961-963, 968-970, 975-977, 985987, 998, 1004
measures 934-935, 937, 947-948, 950, 954-955, 962, 969, 976, 978, 985-986, 988
view 935-937, 948, 950, 955-956, 962-963, 969-970, 976-978, 986-988
Risk Analytics 1071, 1352
Risk by Country 937, 951
Risk Navigator 584, 742, 913, 926, 935, 937, 941, 943, 947-948, 950, 955, 959, 961-963, 966, 968970, 973, 975-979, 986, 988, 991, 1493, 1502, 1506
Risk Navigator orders 1035
Risk Navigator Volatility Products 980
Risk Report 943
Risk tabs 913
ROC 1290
Rollover Options 1488
Rollover Options tool 419, 1488
Use 419
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Use 377
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Trin 1132
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